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[1] INTRODUCING ALTAIR MONARCH

Monarch is a market leading desktop-based self-service data preparation solution. Monarch connects to multiple data
sources, including structured and unstructured data, cloud-based data, and big data, and allows you to cleanse and
manipulate data without the need for coding.

WHAT IS THE ALTAIR MONARCH
APPLICATION?

Altair® Monarch® (Monarch) is a multi-component application that allows you to model and extract analytical assets
from both structured and less-than-structured sources, such as PDFs, reports, and EDI streams, and then use the
data obtained in a self-service manner on your desktop for broader analytical use. The two main components of
Monarch are Monarch Classic and Data Prep Studio.

The complete features of your Monarch application depend on the license you purchased. Click here to learn more
about the different Monarch licenses available.

Monarch Classic

When a computer generates a report, it creates a report file that contains all of the characters and control codes

required by a printer to produce the actual report printout. Monarch Classic reads that same report file. Instead of
producing a hardcopy printout with words and numbers frozen on the page, however, it creates a softcopy of the

report on screen, with live data you can work with.

Monarch reads report files created within any computing environment. These files are commonly known as print or
spool files, but they are also referred to as text (TXT), formatted text, PRN, PDF, and SDF files. Monarch can also
read a wide variety of input files, such as delimited (e.g., pipe, comma, semi-colon, etc.) text, HTML, MS Excel, MS
Access, dBase, PDF, and XPS, among others, and is able to connect to OLE DB and ODBC sources.

Monarch Data Prep Studio

Data Prep Studio is a Monarch component intended to provide users with rapid data preparation (data prep)
capabilities. As a quick data prep solution, Data Prep Studio offers several powerful features, including:

0O Access to a wide range of data sources

Drag and drop parsing and extraction

0  Report discovery and data combination
0O Real-time data preparation
0O Export capability to several file types
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Data Prep Studio provides easy-to-use interfaces for you to:

a

Add data sources

Data Prep Studio allows you to easily load information from databases, reports, and even HTML pages. Special
Preview functionality allows you to review the information and improve data quality before committing these into
the Data Prep Studio workspace.

Combine disparate data sources
Data Prep Studio allows you to easily integrate information from various data sources.
Clean and transform your data

Data Prep Studio’s data preparation capabilities include pre-built functions to quickly and consistently transform
your data into clean, analysis-ready information.

Create summaries of your data
Data Prep Studio allows you to create summaries of your data for improved analysis and decision-making.
Export data to various file types and applications

Once prepped, data can be exported to several of the most popular formats, including XLSX, CSV, ACCDB, and
JSON, among others. You can also export to applications such as IBM Cognos Analytics and Tableau
Hyper/Server.

NEW FEATURES AND ENHANCEMENTS IN
MONARCH CLASSIC

Monarch Classic version 2024.1 includes the following new features and enhancements:

a
a
a

Upgrade of Tableau TDE exports to .hyper when opening projects
Replacement of exports to Tableau TDE and Server with .hyper

Various bug fixes and UX/UI enhancements

NEW FEATURES AND ENHANCEMENTS IN
DATA PREP STUDIO

Monarch Data Prep Studio version 2024.1 includes the following new features and enhancements:

0O 00O 00 O

Import and export support for SAS Transport V8 files

Multiselect change operations - Split, Duplicate, Alignment, Extract, Compute
Replacement of exports to Tableau TDE and Server with .hyper

Inclusion of column counts, including hidden and visible columns, in the Prepare window
Support for changing the number of vertical lines in title rows in the Prepare window
PDF Document Options - Expert Engine - Ability to undo/redo alignment changes

Various bug fixes and UX/UI enhancements
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THE MONARCH CLASSIC WORKFLOW

Figure 1-1 shows how report data flow through a typical Monarch Classic session. A Monarch session begins when
you load a report file into Report view. As the session unfolds, you can produce a variety of outputs from each
window. The lessons in this guide correspond to the flow chart. You'll learn how to bring a report into Monarch, and
you will progress step-by-step through the tasks performed in each window.

INPUT OUTPUT
' Report File
Report View
e  View and explore report e Hardcopy printout of pages
e  Lookthings up (Find) e  Clipboard image of data copied from the
e  Use Report Index report, with automatic formatting of the
e Print pages ' data when pasting into a worksheet

e  Copy to clipboard e  Exportfile in fixed width text or PDF format

e  Define data extraction template

' Extracted Data

Table View
e  View extracted data e Hardcopy printout of selected data in
e Apply filters to extracted data # columnar report format
e  Sortdata e  (Clipboard image of data copied from the
e  Calculate new fields table, in both text and worksheet formats
e  Copy to clipboard e  Export file containing selected datain
° Export selected records several formats, including XLS, XLSX, XLSM,
° Print selected records PDF, ACCDB, MDB, DBF, HTML, TXT, XML,

and delimited text.

' Extracted Data

Summary Window

e  Analyze selected data e Hardcopy printout of summary report

e  Copy data to the clipboard » e  Clipboard image of summary (in both text
e Export analysis and worksheet formats)

e  Print analysis e Exportfile containing selected data in

several formats, including XLS, XLSX, XLSM,
PDF, ACCDB, MDB, DBF, HTML, TXT, XML,
and delimited text.

Figure 1-1. The Monarch flow chart.

Monarch reads both report files and data from database files and OLE DB/ODBC databases, and information from
databases can be extracted, manipulated, analyzed, and transformed. It also allows users to access data from
additional sources, share user-defined functions, and access data from files that are of the types XLS, XLSX, XLSM,
PDF, XPS, DBF, DB, MDB, HTML, and delimited text, as well as any OLE DB- or ODBC-compliant data source, such
as SQL Server, Oracle, and DB2 database management systems.
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INPUT

‘ Database Data

Table View

° Import data from any XLS, XLSX,
XLSM, MDB, DBF, delimited text file,
or from any OLE DB/ODBC
compliant data source

e View imported data

e  Apply filters to data

e Sortdata

e  Calculate new fields

e  Copy to clipboard

e  Export selected records

° Print selected records

l' Imported data

Summary Window
e  Analyze selected data
e  Copy data to clipboard.
e  Exportanalysis

e Print analysis

OUTPUT

e  Hardcopy printout of datain columnar
report format

e  Clipboard image of data copied from the
table, in both text and worksheet formats

e  Exportfile containing selected data several
formats including XLS, ACCDB, MDB, DBF,
HTML, XLSX, XLSM, TXT, PDF, XML, and
delimited text.

° Hardcopy printout of summary report

e  Clipboard image of summary (in both text
and worksheet formats)

e  Exportfile containing selected datain
several formats, including XLS, XLSX, XLSM,
PDF, MDB, DBF, TXT, XML, and delimited

text.

Figure 1-2. The Monarch flow chart showing data imported from a database.

Figure 1-2 shows how data imported from a database flow through Monarch Classic. You may begin a Monarch
session by either opening an XLS, XLSX, XLSM, MDB, ACCDB, DBF, or delimited text file or by importing data from
an OLE DB/ODBC data source. When importing from a database, you can use all of Monarch’s Table and Summary
View capabilities to manipulate, transform, and analyze data.

You can even combine data extracted from report files with database data through a mechanism called an external
lookup.

Note that as the capabilities of newer versions of Monarch improve, the expected outputs presented in this section
may vary. The basic data flows, however, remain the same.
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THE DATA PREP STUDIO WORKFLOW

Figure 1-3 illustrates a typical Data Prep Studio workflow.

Acquire
Data

A
h ./': Al
o Y , i
- Maonarch
'i% Database Excel Worksheet PDF Report Tex! Report File
L] Y Y
Worksheet Table Report
Design Extractor > Design
Y

Y
- Select & I
- Fioview Load §
Tables
Y i L L L Y
Combine - Prepare Analyze
{JoiniAppend | i Columns Columns
Tables) I -

Save
Workspace

—

WORKSPACE

Figure 1-3. The Data Prep Studio workflow.

Tables from a variety of sources, such databases, Excel worksheets, PDF/Text reports, and Monarch files, may be
previewed before they are brought into Monarch Data Prep Studio. If the data source contains multiple tables, you
may select which table(s) to open. Once in Monarch Data Prep Studio, your data can be prepared, combined,
transformed, and analyzed. These operations are carried out in what is called a workspace. When ready, you can
either save your data to the workspace or export them to a variety of formats.

USING THE MONARCH DOCUMENTS

The Altair Monarch documentation consists of a Learning Guide and a Help file. This documentation is available
upon installation of the software and here.

Monarch Learning Guide

This Learning Guide contains a short introduction to Monarch Classic and Data Prep Studio, collectively called
Monarch Complete, along with a series of lessons designed to quickly acquaint you with the program. The lessons
will first introduce you to Data Prep Studio and continue with each of the Monarch views: Report, Table, Summary,
and Export.

Each of the chapters describes a major area of Monarch. More specific lessons on unique functionalities, such as
Report Design, Worksheet Design, and PDF Table Extractor are also provided. First-time users will be well rewarded
for the time they spend working through these sections. Advanced topics should be tackled after you become familiar
with the basic concepts of Monarch, as these topics will leverage what you learned in previous sections. Each lesson
should take 20-30 minutes to complete.
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Monarch Help File

The Monarch Help file provides detailed information and step-by-step instructions for performing numerous tasks in
Monarch Classic and Data Prep Studio. To access the file while within Monarch, select File > Help > Help Topics.
You can also launch relevant help topics from within the Monarch windows by clicking the ? button located on the
upper right-hand corner of most views.

Monarch Training

Altair provides Monarch training courses to help anyone in your organization rapidly improve his or her Monarch
proficiency skills. Available in various locations around the country, these training classes are designed for all levels
of expertise. Whether you are just getting started and need the basics or would like to hone your skills and learn new
ways to use Monarch, Altair is ready to help you reach new levels of Monarch proficiency. Our objective is to help
Monarch users succeed as quickly as possible.

Taught by Altair's seasoned staff of Monarch experts, the training courses guide you through all aspects of Monarch’s
features and capabilities, including tips and techniques on effective, timesaving shortcuts. There is also a lab session
at the end of class where you can bring in your own files and receive individual instruction and suggestions for using
Monarch to meet your specific requirements.

Monarch onsite training and personal web-based training courses are also available.

To learn more about training, reach out to Altair Support.

Monarch Model Building Service
Altair provides a model building service for its Monarch customers. Altair's highly trained team of Monarch experts will
work with you one on one to create a model that meets your specifications and satisfaction.

When you view your new Monarch model, you will be able to learn from the experts by viewing the way they have
trapped your report, created calculated fields and filters, defined summaries, and more. Best of all, this is all done
using your own reports.

To learn more about the Monarch Model Building Service, reach out to Altair Support.
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[2] THE MONARCH USER
INTERFACES

THE MONARCH CLASSIC USER INTERFACES

Monarch Classic provides three distinct views of report data, each with its own interface. Each view provides a
specific set of functions and operations that will allow you to extract, view, and summarize data. A fourth view allows
you to create exports.

Report View

When you load a report file, a soft copy of the report is displayed in Report view.

File Home  Report  Table  Summary  Export
:’ a Select All & Previous Report B Next Report I T:. ri"
g F H
< N evious Pat ] ookmark
Report Auto. ‘@ Zoom To Fit [£] Copy Search  Find in ] Previous Page & NextPage Bookmark Report Chunk
Design Define able - i o
< El Greenbar ° 3\ Go To Page Go To Chunk
Home m ~
Report Files By 02/01/10 CLASSICAL MUSIC DISTRIEUTORS PAGE 01 -
10:17 MONTHLY SHIPPING REPORT
,O MSR94 FROM 01/01/10 TO 01/31/10
B Classlanpm
E ClassFebpm CUSTGMER: Betty's Music Store
Muscatine Plaza
B ClassMarpm 200 Lower Muscatine
Cedar Falls, IA 50613
Usa
IACCOUNT NUMBER: 11887
CONTACT: Betty Yoder
MEDIA QTY DESCRIPTION LABEL/NC. UNT_PRC AMOUNT
ORDER NUMBER: 536017 SHIP DATE: 01/10/10
cD 4 Bartok, Sonata for Solo Violin MK-42625 8.99 35.96
7 Mozart, Mass in C, K.427 420831-2 9.00 €3.00
2 Luening, Electronic Music CD &11 10.1%2 20.38
ovD 2 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
ORDER NUMBER: 536038 SHIP DATE: 01/21/10
CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.82
10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90
LP 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
ovD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
02/01/10 CLASSICAL MUSIC DISTRIBUIORS PAGE 02
10:17 MONTHLY SHIPPING REPORT
MSR94 FROM 01/01/10 TO 01/31/10

CUSTOMER:

‘

Bluegrass Records
Hwy 17 at the 9 mile marker

Pagel t00% ——h———+

Figure 2-1. The Report view of Monarch Classic.

Report view displays opened reports and includes all of the tools you will need to work with them. It also allows you

access to Report Design view, an interface through which you can create templates to extract data and create

tables.

Altair Monarch 2024.1 Learning Guide



Table View

Data extracted from the report display in Table view.

File Home Report Table Summary Export ?
z Bsertit s e o i B O s “a
Table R €] Copy o Seach  Goto  findin Rebuild Spowfield  Freeze
e *i4 Autosize Columns ECR i Eno Eatallie
~
Home  Report View m v
Page Order.. Ship Date Account Number Contact Media  Quantity Description Label Number  Unit Price  Amount =
o ! Jo1 536017 4/1072010 11887 Betty Yoder (o) 4 Bartok, Sonata for Solo Violin MK-42625 899 3596
2 01 536017 4/10/2010 11887 Betty Yoder 7 Mozart, Mass in €, K.427 4208312 9.00  63.00
Main 3 01 535017 4/10/2010 11887 Betty Yoder 2 Luening, Electronic Music CD 611 1019 2038
4 01 536017 4/10/2010 11887 Betty Yoder DVD 9 Scarlatti, Stabat Mater SBT 48282 599 5391
5 01 535039 4/21/2010 11887 Betty Yoder [o0) 11 Beethoven, Pathetique Sonata, Arau 420153-2 599 6589
6 01 536039 4/21/2010 11887 Betty Yoder 8 Mendelssohn, War March of the Priests SMK 47592 899 7192
7 01 536039 4/21/2010 11887 Betty Yoder 10 Pizzett, Messa di Requiem CHAN 8964 959 9590
8 01 535039 4/21/2010 11887 Betty Yoder Lr 6 Misc., Modem Trombone Masterpieces ADA 581087 1079 6474
9 0 536039 4/21/2010 11887 Betty Yoder DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
10 02 536016 4/5/2010 17959 Marvin Mabry [o0) 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 899 5354
11 02 536016 4/5/2010 17959 Marvin Mabry 1 Schubert, Sonata in &, D.566 AS-325 9.00 9.00
12 02 536016 4/5/2010 17959 Marvin Mabry 3 Maozart, Symphony No.23 in D C0-77884 899 2697
13 02 536016 4/5/2010 17959 Marvin Mabry 6 Schoenberg, Ode to Napoleon CHAN 9116 959 5754
14 02 536029 4/14/2010 17959 Marvin Mabry o) 2 Shostakovich, 24 Preludes for piano. CDA 66620 539 1078
15 02 536029 4/14/2010 17959 Marvin Mabry SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 959 8531
16 02 536029 4/14/2010 17959 Marvin Mabry DVD 5 Holst, St. Paul's Suite for Orch. CBT-1020 599 2895
17 03 536020 4/10/2010 10929 [5o) 3 Faure, 28 Songs, Stulzmann RCA 614202 1708 5394
18 03 536020 4/10/2010 10929 3 Takemitsu, Music of Takemitsu SMK 53473 360 1080
19 03 536020 4/10/2010 10929 6 Messiaen, Quatour pour la fin de temps CDC 54935 960  57.60
20 03 536020 4/10/2010 10929 SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 899 7L92
21 03 536020 4/10/2010 10929 DVD 9 Schumann, Manfred Overture, Bav SO SBT 48270 599 5391
22 04 536012 4/1/2010 18635 Alain Lebon [} 10 Milhaud, 3 Rag Caprices, pn. & orch. 76560 960  95.00
23 04 536012 4/1/2010 18635 Alzin Lebon S Strauss, Le bourgeois gentilhomme CDD 448 960  48.00
24 04 536012 4/1/2010 18635 Alain Lebon 5 Scriabin, Preludes, Op. 8 oY 1123 779 3895
25 04 536012 4/1/2010 18635 Alain Lebon 6 Rogers, Slaughter on Tenth Avenue DD 275 960  57.60
26 04 536012 4/1/2010 18635 Alain Lebon BLU 10 Paganini, 24 Caprices for violin. BLU 120 959 9500
27 04 536012 4/1/2010 18635 Alain Lebon DVD 8 Vivaldi, Concertos for Recorder ABTD-1156 599 47.02
28 04 536012 4/1/2010 18635 Alain Lebon [o) -10 Linek, Epiphany Carol SUP 10 4154 599  -59.90
20 04 536012 4/1/2010 18635 Alain Lebon 7 Casell3, Paganiniana, NBC SO AS 510 9.00  -63.00
30 04 536012 4/1/2010 18635 Alain Lebon DVD -11 Lambert, Airs de Courm (1689) HMA 431123 599 6589 ~
‘ »
Report Date - Date/Time - Page Header (Page Headsr) Filter: Mo Filter SortNoSort  149Rows  100% ——H——+

Figure 2-2. The Table view of Monarch Classic.

Table view allows you to work with the table produced by your report templates. You can click Table Design to edit
your table and its fields. All of the changes you make to a table (e.g., filters, sorts, functions, etc.) display in this view.

Some of the other activities you can perform in Table view include:
0 Set the active filter to limit the fields displayed

Set the active sort to sort fields

0 Auto-size columns
0O Hide or display fields
O Find a specific field value
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Summary View

User-defined summaries, which analyze report data, are displayed in Summary view.

File Home Report Table Summary Export ?
E,‘? Select Al M v g Active Measure - a
Summary % ZeomTofFit 101 Copy Search  Goto  Findin i Drill up Dril Down Freess
2z ¥4 Autosize Columns Row  Table Panes
~
Home  ReportView  Tableview [eceepewnpd
Summary Defintions v 4 ‘Cusomer  Meda  Quamtty Deserpion  Amount E
1 O 1 Bettys Music Store [=3) 2 Luening, Electronic Music 20.38
2 Betty's Music Store D 4 Bartok, Sonata for Solo Violin 35.96
# Summary 3 Betty's Music Store D 7 Mozart, Mass in C, K.427 63.00
& Sales by Media 4 Betty's Music Store D 8 Mendelssohn, War March of the Priests 71.92
&' Sales by Customer and Media 5 Betty's Music Store D 10 Pizzetti, Messa di Requiem 95.90
6  Betty's Music Store D 11 Beethoven, Pathetique Sonata, Arau 65.89
& Sales by Customer and Madia_2 7 Betty's Music Store DVD 6 Gershwin, An American in Paris 35.94
8  Betty's Music Store DVD 9 Scarlatti, Stabat Mater 53.91
9  Betty's Music Store LP 6 Misc., Modern Trombone Masterpieces 64.74
10 Subtotal Betty's Music Store 507.64
1
12 Big Shanty Music @ 1 Schubert, Sonata in e, D.566 9.00
13 Big Shanty Music D 2 Shostakovich, 24 Preludes for piano. 10.78
14 Big Shanty Music D 3 Mozart, Symphony No.23 in D 26.97
15  Big Shanty Music D 6 Schoenberg, Ode to Napoleon 57.54
16  Big Shanty Music D 6 Stravinsky, Dumbarton Gaks Concerto 53.94
17  Big Shanty Music DVD S Holst, St. Paul's Suite for Orch. 29.95
18  Big Shanty Music SACD 9 Balakirev,Symphony no. 1 86.31
19 Subtotal Big Shanty Music 274.49
20
21 Bluegrass Records D 3 Faure, 28 Songs, Stulzmann 53.94
22 Bluegrass Records D 3 Takemitsu, Music of Takemitsu 10.80
23 Bluegrass Records @ 6 Messiaen, Quatour pour la fin de temps 57.60
24 Bluegrass Records DVvD 9 Schumann, Manfred Overture, Bav SO 53.91
25  Bluegrass Records SACD 8 Strauss, Ein Heldenleben, Op.40 71.92
26  subtotal Bluegrass Records 248.17
27
‘28 Canrianes n ? Handel_ Tl nastar fidaloneral 2156 K -
Customer - Asc by key value - All - Dowin FiterNoFiter 189Rcws  100% — — -+

Figure 2-3. The Summary view of Monarch Classic.

Summary View allows you to work with summaries. From this View, you can also click Summary Design to create or
edit summaries.

From within Summary View, you can also do the following:
Navigate a summary

Zoom in or out

Automatically adjust column widths

Freeze panes

Collapse or expand a summary

0O 0 0 0O O

Customize summary font and background

Altair Monarch 2024.1 Learning Guide 9



Export View

Exports defined may be viewed in Export view.

File Home Report Table Summary Export ?
; [ &
id o a3 & P @
Export Select Al Clear Clear Create Run
Design Exports  Selectzd Jobs  Job List Export  Exports
A~
Home  ReportView  TableView  Summary View v
PO Job LISE 5055505000 000 000 B B wiow I
&0 2| Export Name | View Export Target
B Excel Table Classic Export1 Summary View CA\Users\Public\Documents\Altair Monarch\Export\SAS_Summary_Classicxpt
B Export] Export2 Summary View C\Users\PubliciDoc Altair Monarch\Expor _Customeralsc
M Export2 Exportd Table View CUsers\Public\Documents\Altair Monarch\Export\CSV_Table.csv
B Export

Export Results v R

| Clear Results

oo ————+

Figure 2-4. The Export view of Monarch Classic.

From this window, you can also do the following:
0O  Run exports

0 Create a new export

Monarch Classic Hotkeys

Keyboard shortcuts (hotkeys) for the main toolbar are enabled in Monarch Classic to help you quickly access the
different views. The following table describes the main hotkeys available in Monarch Classic.

ALT + F Open the File menu

ALT +H Access the Home Page

ALT +R Access Report View

ALT +T Access Table View

ALT + S Access Summary View

ALT + E Access Export View

ALT +1 Access the Open Document menu
ALT +L Launch the Monarch Help File

A detailed list of the keyboard shortcuts available in Monarch Classic may be found here.
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THE DATA PREP STUDIO USER INTERFACES

Similar to Monarch Classic, Data Prep Studio includes several windows, each of which allow you to analyze, open,
prepare, and export your data.

The Getting Started Video
First-time Data Prep Studio users will find the Getting Started video especially helpful in learning about this
component’s capabilities.

This video displays the first time Monarch is launched as well as every time the application is started thereafter
unless the Show at start up box located at the lower left-hand corner of the screen is unchecked.

Select Exit Tutorial to close this video window.

Getting Started - Quick View Tutorial Silent Videos

:‘"‘7 Acquire - Start Page Preview Prepare Transform ‘I Combine Analyze Export Automate
L Acq g P yZS P

Acquire - Start Page

Connect to all major databases
and automatically extract data

from multi-structured sources

and web pages

Ty onenaTa

| Show at start up EXIT TUTORIAL

Figure 2-5. The Getting Started video.
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The Start Page

The Start Page displays when the application is launched and the Getting Started video is closed (by clicking Exit
Tutorial)/disabled. Besides providing access to video tutorials and related documentation and support, the Start
Page is your primary jumping-off point for bringing data into the current data prep session.

= [11 START (&) pReviEwW [ | pRePARE

57

Getting Started
Videos installed on this machine to help you get started

< ®

RECENT FILES

Video Tutorials

" . ‘k How-to videos on our YouTube channel
g = -
. ’ Documentation

Quickstart, Help, and Tutorial on the Altair website

Drag files or click below to load data

Altair Data Analytics
Prepare, Automate, Predict

@

Support

Get technical assistance

Figure 2-6. The Data Prep Studio Start Page.

Data Prep Studio features one toolbar and several main screens.

PREVIEW [ | PREPARE & (¢) comeine [ AnAwzE [ ExPORT

Figure 2-7. The Data Prep Studio toolbar.

Each of these tools opens a unique window, dialog, or stage through which Data Prep Studio’s functions may be
realized.
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The Application Menu

The Application Menu H button displays a list of other Data Prep Studio commands you may wish to apply to the
current Data Prep Studio session.

New Workspace
Open Workspace
Close Workspace

Save Workspace

Open Data

Import Workspace Tables

Help

Exit Monarch Data Prep Studio

Figure 2-8. The Application Menu of Data Prep Studio.

Using this menu, you can:
0O  Open a new/existing workspace Import/export change lists
Save a workspace Import workspace tables

Open the Data Prep Studio help file

0O 0 0O O

a
O Close aworkspace
a

Open a data source Exit Monarch Data Prep Studio

The Settings Dialogs

You can specify application default or current workspace settings by clicking the Settings button located to the

far right of the toolbar and selecting the appropriate option.

Note that some application settings, folder tracking, for example, are applied only when Data Prep Studio is restarted.
Also, settings are serialized from the last closed Data Prep Studio session. This means that when two concurrently
running sessions of the application are closed, only settings from the session closed the last are saved and reflected
when a new session is started.
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The Application Default Settings dialog allows you to specify row limits, default folders, conversion settings, and the
like on a global level. You can also configure license settings and create new library files using this dialog.

Application Default Settings m] X
General Excel Worksheet Design  Delimited Text Reports
Export
Default source row limit
Default Path
clauit Faths No Limit v 100000
Conversion
' Automatically sync columns with source data on load or refresh for supported data sources. o
Display
Default Excel Importer
Time Intervals Prompt for choice v o
Server Default PDF Importer
Page Setup Open in Report Design ~ e
Advanced
Security

Runtime Parameters

About
Apply to current Workspace

Figure 2-9. The Application Default Settings dialog of Data Prep Studio.

The Current Workspace Settings dialog allows you to specify workspace-level settings.

Current Workspace Settings m] X
General Excel Worksheet Design  Delimited Text Reports
Export
Default source row limit
e No Limit W 100000
Display

+ Automatically sync columns with source data on load or refresh for supported data sources. e

Time Intervals

Page Setup

Security

Runtime Parameters

User-Defined Functions

Apply to existing tables

Figure 2-10. The Current Workspace Settings dialog of Data Prep Studio.

Details on each of these settings may be obtained here.
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The Preview Window

The Preview window allows you to:
0  Open afile or a data source

0 Preview and confirm the data in the data source

0 Load atable into your workspace

PREVIEW E PREPARE™ “1’71 COMBINE [ﬂ ANALYZE | EXPORT
. -+ NEW X CLOSEALL {3} CLOSE SELECTED {8 OPEN SELECTED
=
| [=] Name VT Type VT SourceName S/t Path e
5]
& -
Accounting Access Beantown.mdb Source = CAUsers\Public\Documents\Altair Monarch\Data\Beantown.mdb @ PREVIEW OPEN
Data Processing Access Beantown.mdb Source = CAU db @ PREVIEW OPEN
Marketing Access Beantown.mdb Source = C:\Users\Public\Documents\Altair Monarch\Data\Beantown.mdb @ PREVIEW OPEN
Compensation Access Payroll.mdb Source = CAUsers\Public\Documents\Altair Monarch\Data\Payrollmdb @ PREVIEW OPEN
= Preview
Preview: Classic (Classic) 91Rows 5Columns No source row limit configured. £ @D CLOSE PREVIEW
. “ 1)
Column Information - Media Order By Count Descending < File Info .
v Name 7 Type 17 # Unique % Missing © «
& @ 66 | File Size 278 =
v Y Media Ab 5 0% = ow 1 Updated 91162024 11:15:18PM |
° e
7Y ay # 1 00% g I s Date Created 911612024 11:15:18 PM
z| ™ 4 Column Statistics
V| Y Description Ab El 0% E oy
3 #Row s -
A t 62 0.0% 8
s amoun # v # Hull 0
v v Ship Date & 13 0.0% . #Blank 0 -
# aty Ab  Description # Amount ) ship Date -
4 Bariok Sonata for Solo Violin 3598 11072020 12.00-00 AW
2 o 7 Mozar, Mass in C, K427 & 11072020 12.00-00 AW
3 o 2 Luening, Elecironic Music 2038 11072020 12.00-00 AW
1 ow 9 Scarlatt, Stabat Males 5391 11072020 12.00-00 AW

Figure 2-11. Data Prep Studio’s Preview window.

Several tools are provided to enable you to open/preview more tables, select one or a group of tables, and close one
or a group of tables.

< CLOSEALL i} CLOSE SELECTED OPEN SELECTED

Figure 2-12. The Preview window tools.

The Transform Pane

You can quickly transform any table in the Prepare window by clicking on the Transform button of the Data Prep
Studio toolbar. Doing so displays the Transform pane that will allow you to sort field, extract empty rows in the table,
pivot/unpivot columns, group by specific columns, and remove duplicates.

sort T l-_ Group Maadl
Sort on one or more columns - Group and summarize values Ly
Pivot - Duplicates [‘
Pivot row values to new columns H [ Remove, keep or flag duplicate values @
Unpivot == Extract Rows :Q:
Convert columns to attribute/value pairs H n Removes rows with nulls, blanks, and whitespace =g
Transpose

Swap rows and columns EJ

Figure 2-13. Data Prep Studio’s Transform pane.
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The Prepare Window

The Prepare window allows you to transform columns. Pre-defined functions include convert, extract, clean, replace,
and split capabilities, among others.

= [ smrr @ PREVIEW PREPARE® % TRANSFORM ‘E; COMBINE [52] ANALYZE [ EXPORT

=]
C) 18 9| Nz Ao cstomer v # Acounthumber  vAb Contact v # Order Number ~© shppate v °| ©
PP g 1 Betty’s Music Store 11887 Betty Yoder 536017 4000 | | 5 Tehom2 Ml |
RTL | searc a 2 2 BettysMusic Store 11887 Betty Yoder 536017 4102000 | | 2
) - 3 Bettys Music Store 11887 Betty Yoder 536017 4/10/2010 ) a mp e e o
Accounting 5 4 Betty's Music Store 11887 Betty Yoder 536017 4102010 | | o ST RS A &
5 Betty's Music Store 11887 Betty Yoder 336039 4/21/2010 s
Data Processing - 6 Betty's Music Store 11887 Betty Yoder 536030 4/21/2010 % || customer (+10 more) ip)
7 Betty's Music Store 11887 Betty Yoder 536039 4212000 | | T i
Marketing 7 8 Betty's Music Store 11887 Betty Yoder 536039 4/21/2010 8 Change display widths.
3 Bettys Music Store 11887 Betty Yoder 536039 4o | £
m 10 Big Shanty Music 17959 Marvin Mabry 536016 45200 | S
H 11 Big Shanty Music 17959 Marvin Mabry 536016 4/5/2010
- Classic.pdf 12 Big Shanty Music 17959 Marvin Mabry 536016 4/5/2010
13 Big Shanty Music 17959 Marvin Mabry 536016 4/5/2010
DragDropCsV < 14 Big Shanty Music 17959 Marvin Mabry 536029 4/14/2010
15 Big Shanty Music 17050 Marvin Mabry 536020 4/14/2010
16 Big Shanty Music 17959 Manvin Mabry 536029 4/14/2010
17 Bluegrass Records 10929 Roberto Gl 536020 4/10/2010
18 Bluegrass Records 10929 Roberto Gl 536020 4/10/2010
19 Bluegrass Records 10929 Roberto Gl 536020 4/10/2010
20 Bluegrass Records 10929 Roberto Gil 536020 4/10/2010
21 Bluegrass Records 10929 Roberto Gl 536020 4/10/2010
2 Musique du Monde 18635 Alain Lebon 536012 4/3/2010
23 Musique du Monde 18635 Alain Lebon 536012 4/1/2010
24 Musique du Monde 18635 Alain Lebon 536012 4/3/2010
25 Musique du Monde 18635 Alsin Lebon 536012 4/3/2010
2 Musique du Monde 18635 Alain Lebon 536012 4/3/2010
27 Musique du Monde 18635 Alain Lebon 536012 4/3/2010
28 Musique du Monde 18635 Alain Lebon 536012 4/1/2010
29 Musique du Monde 18635 Alain Lebon 536012 4/1/2010
30 Musique du Monde 18635 Alain Lebon 536012 4/1/2010
31 Musique du Monde 18635 Alain Lebon 536034 4/18/2010
32 Musique du Monde 18635 Alain Lebon 536034 4/18/2010
33 Musique du Monde 18635 Alain Lebon 536034 4/18/2010
3¢ Musique du Monde 18635 Alsin Lebon 536034 4/18/2010 METADATA COLUMNS
35 Fandangos Records 17658 Lionel Sampson 536045 4/28/2010
3 Fandanans Records 17658 1innel Samnsan 38045 o EDIT IN REPORT DESIGN
Columns: 11

Figure 2-14. Data Prep Studio’s Prepare window.

The panel to the left of the Prepare window is called the Table Selector and allows you to select tables. Right-clicking
on any table in this panel or clicking on the drop-down button launches a context menu that allows you to:

Object Description Clicking on the Object Description icon launches a text field into which you can
enter a comment or description of the selected table.

Edit in Report Design Allows you to modify templates created to capture data from report files

Edit Append/Join/Transform  Allows you to modify tables created from appends, joins, and transform
operations

Edit Load Options Allows you to specify how tables from some file types should be imported into
the application. Some of these settings are as follows:

For MS Excel tables:

0O Indicate if the first row of an Excel file contains column names. This is
active by default.

Ignore blank rows

0 Skip n number of lines. Using this option, you can, for instance ignore lines
with containing spreadsheet titles.

O  Switch table - Replaces the contents of the original table with the data in
the replacement table selected from the drop-down.

O  Import columns as text

For MS Access tables:

0O  Switch table - Replaces the contents of the original table with the data in
the replacement table selected from the drop-down.

For delimited text tables:
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a

Edit Table Info
Edit Credentials

Edit File Path
Edit All File Paths

Map Columns

Rename

Duplicate

Delete

Pin

Row Limit

Refresh Data From Source

Quick Export

Create Workspace from
Table

Save in Library

Ignore blank rows

First row has columns names
Allow embedded line breaks
Delimiter

Lines to skip

Text qualifier

Rows to scan for columns

0O 00O 00 0 D

Set data types for individual fields or a bulk data type for all fields

For HTML tables:
O Indicate if the first row of the table contains column names.

0 Lines to skip - Specify a number of lines starting from row 1 to ignore. The
table will begin with the n+1 row.

Allows you to select a different table from a given datasource.

Allows you to provide the necessary details for tables requiring security
credentials that were cleared when the workspace was saved.

Allows you to change the path to a data source.
Allows you to change the path to all open data sources.

Allows you to map the columns of two tables with dissimilar schemas without
breaking an existing change list.

Allows you to change the name of a table.

Allows you to create a new instance of the table.
The duplicate is initially named <TableName>n, where n is number that

indicates how many instances of the table are currently in use. You can rename
the table after duplication.

Allows you to delete the selected table.

Allows you to pin a table. When you do so and the workspace is saved, a user
without direct access to the table source may open the pinned table when he
opens the workspace.

Allows you to increase or decrease the rows displayed by Monarch Data Prep
Studio for the current table.

Decreasing the row limit can speed up the load time of the table and improve
the response time when carrying out operations. However, this may allow you to
miss exceptions and problematic rows, if these are not included in the limited
row set.

Allows you load the latest data from your data source. Use this option if the
values in your table are changed via an external application and you want these
changes reflected in your workspace.

Allows you to quickly export the selected table into a number of formats via the
Select an Export Type dialog.

Allows you to export tables to a new workspace.

Saves the data source in the Data Source Library.
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You can use the Data Source Library to easily access and include commonly-
used data sources as you define workspaces without having to open the data
source and load tables.

Swap with Library Table Allows you to replace the selected table with one from the Data Source Library.
Undock Undocks the table from the Monarch Data Prep Studio work area so that you
can:

Move the table around (for instance, to a secondary monitor)
Float one more tables and view their records simultaneously.

The Combine Stage

The Combine stage has a switch on/switch off function and allows you to join or append two or more tables to create
a new one. The default view when this tool is clicked is the Join stage.

PREVIEW PREPARE" &% TRANSFORM () cOMBINE AnAvzE SI=N
@ @
EEETE C G o =
7y R o data using join anatyss and tuzzy matchng Vertically append data 1o create a combined rowset -
A Q 2
¥ H
F Accounting -
Compensation -
Data Processing -
Marketing -
— Classic -
Classic.pdf ccomeion Companmtion.
DragDropCsV >
‘ =22 Ab Department ¥ Ab Last_Name ¥ Ab First_Name ¥ Ao Emp_ID &
T Accounting Adndge seft 1552784 . | Thoma, Al | R A
Accounting Daley Wiliam 1587390 2
3 Accounting Georoes wikam 1596792 o R AT B R
4 Accounting Guck Anna 1593309 o w7 =
s Accountng Jacobson [ 1601562 g
6 Accounting Marshal Aana 1558264 G
7 Accounting Mactins Wayne 1554566 =
5 Acounting Poretsky Teress 1588940 g
9 Accounting Rosenberg Ky 1590228 E
10 Accounting Russo paula 1586456 &
" Accounting Sancowicz Mary Beth 1593599
2 Accounting Visodruft Elzzbeth 1600325
EDITJOIN

Join Tables o
Join data using join analysis and hazzy malching
- Jain -
Accounting -
Compensation - 1 Data Procassing x
2 Marketing X
Data Processing -
Marketing -
~ Classic -
Classic.pdf
DragDropCSV - ﬂ; Ab Department ‘w Ab Last Name - Ao Emp_ID W
1 Data Processing 1593211 5 Tahoma I
2 Data Processing 1597506 g
3 Data Processing 1604183 @ -
4 DataProcessing 1507266 . B 3w &
5 Data Processing 1590085 =
& DataProcessing 1598507 &
Data Processing 1592913 E
§ Data Processing 158470 8
9 Data Processing 158482 ES
W Deta Processing 1588939 3
T Data Processing 153318
12 Data Processing 1554545
3 Data Processing 1601801
4 Data Processing 1593184
0
2O lwown L] EOIT APPEND

Figure 2-16. Data Prep Studio’s Append stage is accessed by clicking Append Tables.
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The Report Design Window

The Report Design window allows you to open PDF and PRN report files and extract specific fields from this report to
create a table, which then becomes available in the Prepare Window.

ACCEPT X CANCEL B e =) REPORT VERIFY ULTI-COLUMN REGION
Templates - £ RESETTRAP £ RESETFIELDS ¥ REDACT SAMPLE TEXT CLEARING TEMPLATE
8
Name Role + H Standard v AR 8| @ | e -
@
Page Header  (£) Page Header 5
H it/
Order Numb... Append =
05,/01/98) CLASSICAL MUSIC DISTRIBUTORS PAGE ©1]
Customer Le... Append » @5/e1/1e CLASSICAL MUSIC DISTRIBUTORS PAGE @1 -
10:17 MONTHLY SHIPPING REPORT
Account Nu.. Append MSR94 FROM @4/81/10 TO 04/30/10
Line Item Det... Detail

CUSTOMER: Betty's Music Store

[ AUTO DEFINE > CLEAR Muscatine Plaza

200 Lower Muscatine

Cedar Falls, IA 50613
Edit Field Properties UsA

Advanced /ACCOUNT NUMBER: 11887

CONTACT: Betty Yoder

Name Page
Template Width | 7 : MEDIA QTY DESCRIPTION LABEL/NO. UNT_PRC AMOUNT
Type Character - ORDER NUMBER: 536017 SHIP DATE: 04/10/10 .
Decimals (2] A~ v [l Wep [l Match Case Page:1 Selected Line: Position:
Format © ReportDate  Ab Order Number & Ship Date Ab Page # Account Number Ab Contact  Ab Customer_Full Al ~
Betty's Music Store
Muscatine Plaza
Copy Value from Previous Record 1 5/1/2010 536017 4/10/2010 PAGE 01 11887 Betty Yoder 200 Lower Muscatine cC
Cedar Falls, 1A 50613
VERIFY UsA
.y Betty's Music Store
| Left Side | RightSide ' Type Muscatine Plaza
2 5/1/2010 536017 4/10/2010 PAGE 01 11887 Betty Yoder 200 Lower Muscatine cC
Cedar Falls 1A 50613
+— PREVIOUS FIELD — NEXTFIELD usA
Betty's Music Store
Muscatine Plaza
3 5/1/2010 536017 4/10/2010 PAGE 01 11887 Betty Yoder 200 Lower Muscatine cC
< DELETE FIELD Cedar Falls, 1A 50613

usa
Rath'c Micic Sinre

Figure 2-17. Data Prep Studio’s Report Design window.

You can also open reports, especially those that are text-heavy but contain tables you wish to bring into Data Prep
Studio, in PDF Table Extractor. More information on this component is available here.

Work in the Report Design window follows a system that closely mimics the report trapping steps in Monarch Classic.
Details of each of the tools available in the Report Design window, as well as how they are used to create tables from
PDF and PRN files are available here.

The Analyze Drop-Down

The Analyze drop-down is your take-off point for creating, viewing, modifying, and managing summaries.

e e @ Summary Drill Level Filter: e @
Active Measure: e 6 0 =1 o 9 Sort: e @ e

Figure 2-18. Data Prep Studio’s Analyze drop-down.
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The Export Window

The Export window allows you to export table data, summaries, and reports from Data Prep Studio to a humber of

different file types.

(D) smarr @ preview [ ] pRepaRe"
Orly show exports from selected tables

— Join 1Eport 4 -
B Join - Microsoft Fxcel

Accounting +
Lessong - Altair Knowledge Studio

Compensation +

Data Processing +

Marketing +

EXPORT ALL

Manage Exports

(&) comeme [5] anavze [ ExpoRT®

Z Join - Microsoft Excel

Table: Join

Export Type: Microsoft Excel

Export File System:

Local or Mounted Disk

Excel Export Format

Excel XLSX (xdsx)

[ELLLEIN Advanced

Export Location:

C\Users\Public\Documents\Jain.xlsx BROWSE

File €, \Documents\Join xisx does

Table Name:

Join

Filter
No Filter
Sort:

No Sort

' Include Column Headers

When file exists:
Overwrite

When table exists:

01 exist

EXPORT

EXPORT RESULTS v [l

Figure 2-19. Data Prep Studio’s Export window.

You can export table data to:
Microsoft Excel

Csv

IBM Cognos Analytics
Microsoft Access
Microsoft Power Bl
Fixed Text

PDF

0O 00 0 o0 0 0o

Altair Panopticon

You can export summaries to:

0O Microsoft Excel

CSV
0O  Microsoft Access
0 Fixed Text
o  PDF

You can export reports to:

0 Text
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Tableau Server

Tableau Hyper

Qlik

SAS Transport File Format V5
SAS Transport File Format V8
XML

JSON

Altair Knowledge Studio

Tableau Hyper

Qlik

SAS Transport File Format V5
JSON

XML

PDF
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The Excel Worksheet Design Window

The Worksheet Design window displays if you opt not to open Excel files as a database. Worksheet Design is
especially useful for capturing data from Excel files containing worksheets that do not have a tabular form.

/' ACCEPT < CANCEL 1} APPLY TO..

Templates : J] ADD coLumn [ DELETE TRAP = EXCLUDE ROW TT CAPTURE THIS DATA AS AN AP ': Cell Information
& 5
Name Role 5 B c D E |+ B ] 35.96
E = £
Detsil @ 2 S
16 Bexty Yoder £ Location 21. 7]
17 =
18 [rp— i Y 4 Alignment  Right
19 o 1/10/2020
20 o om [t [ Do — V. Alignment  Bottom
Py N . ‘._.,... Soto Violin Has Background No
22 © \J 7 \J Maozart, Mass in C, K427 \J [] s o
NEW TEMPLATE ~ X CLEAR 23 @ N n Lusning, Electronic Music Y 4
24 oo B\ S— 581 Merged No
25 2 173
Torat o
N 26 Font Name Calibri
&‘ Traps(4) D Columns = E3c030
Order Number - e 1
C Value, Al , Font @ 28 o De -
alue, Alignment, Font D 29 |quia qIu.,, Description %mm Font Color n
_ N N A
E Value, Alignment, Font @ 31 €0 Mendelssohn, War March of the Pr._. 7192
32 o N 10 pizaets, Messa di Requiem N s Italicized No
F Value, Al t, Font )
Che i @ - 33 (L3 W Misc., Modern Trombane Masterpi... w 6474 ‘
N Y| A | Bold No
34 DVD 6 Gershwin, An American in Paris 3534
15 Toral ar 33439 .
Column Type: ~ Numeric
36
37 €3 507.64. Borders None
38
39
40 Bluegrass Records -
. y
Jan Sales | Feb Sales | Mar Sales
GUIDE ME Q

Figure 2-20. Data Prep Studio’s Worksheet Design window.

A lesson on the use of Worksheet Design is provided in Chapter 4 — Working with Worksheet Design of this Learning
Guide.
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The PDF Table Extractor Window

The PDF Table Extractor window displays when you open a PDF file in Data Prep Studio by selecting Open Data >
PDF & Text > PDF Table Extractor from the Start window or Add > PDF & Text > PDF Table Extractor from the
Prepare window. This interface provides an easy means to identify tables in text-heavy PDF files, select them, modify
them if you wish, and then import them into Data Prep Studio for further data preparation.

EXTRACTALL  EXTRACT SELECTION  CLOSE | & & Page:olg — —>| ) erowse CANACCORD 042215PDF E

Tables S : % DELETE SELECTED 4 2
o
I: s vanamymes x| s | | exnsrssez i)
AUTO DEFINE ~ < CLEAR = o
Raising Target Price E]
Page: 1 . . . .
v L %) Refocusing, re-orienting and rebooting; a good
Canaccord 042215 - Page: 1 - Table 1 ) Stal‘t, blll Still Work to be done
Canaccord 042215 - Page: 1-Table2 (7} (%) — thesis

bug Daty Vol (M) = 0 Datawatch introd uced several new marketing vectors as the firm announced senior
Canaccord 042215 - Page: 1 - Table 3 ) hares Out. (M) n intermediate level staff changes. The fact is that robust market opportunities - in th

et Cap. l\lilllt‘ 861 case next: ion analytics and visuali - do not last forever, so the clock is|
Enterprise Vaiue (USSM); 47 i
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Figure 2-21. Data Prep Studio’s PDF Table Extractor window.

A lesson on the use of Worksheet Design is provided in Chapter 4 — Working with PDF Table Extractor of this
Learning Guide.

Data Prep Studio Hotkeys

Similar to Monarch Classic, keyboard shortcuts (hotkeys) for the main toolbar are also enabled in Data Prep Studio to
help you quickly access the different windows. The following table describes the main hotkeys available in Data Prep
Studio. A detailed list of the keyboard shortcuts available in Data Prep Studio may be found here.

ALT +S Access the Start Page

ALT +V Access the Preview window

ALT + P Access the Prepare window

ALT +T Launch the Select Transform Type dialog
ALT +C Access the Combine stage

ALT + A Access the Analyze drop-down

ALT + E Launch the Export window

ALT + G Launch the Application Default Settings dialog
ALT + F Launch the Application Menu
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[3] LAUNCHING THE MONARCH
APPLICATION

Depending on where you begin, the different components of the Monarch application can be launched in different
ways.

LAUNCHING MONARCH DATA PREP STUDIO

Data Prep Studio may be launched by selecting Start > All Programs > Altair Monarch 2024 > Monarch Data Prep
Studio 2024

LAUNCHING MONARCH CLASSIC

Monarch Classic may be launched in two ways:
0O Launching Monarch for the first time after installing and licensing it.

0 Selecting Start > All Programs > Altair Monarch 2024 > Monarch Classic 2024
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[4] DATA PREP STUDIO LESSONS

Because most data prep needs may be addressed by Data Prep Studio, we begin this Learning Guide with lessons
on how to work with this exciting add-on.

= ) samr @ ereview [ prepae

RECENT FILES =

Getting Started
Videos installed on this machine to help you get started

-
: Video Tutorials
.‘ . ‘k How-to VouTube channel
g - [
g ’ Documentation

Quickstart, Help, and Tutorial on the Altair website

Drag files or click below to load data

&

Altair Data Analytics
Prepare, Automate, Predict

@

Support

Get technical assistance

Figure 4-1. The Data Prep Studio Start Page.

Data Prep Studio supports a number of main functions:
Add data from a wide variety of data sources

Add data using the Altair Data Connectors

Join and append table data to create new data tables
Clean and transform tables for further operations

Create summaries

0O 0 0 0 O

Export tables
Save and load workspaces

The lessons described in this section demonstrate how to use Data Prep Studio and aim to provide users with a basic
overview of the application’s capabilities. If you wish to learn about Data Prep Studio’s functions in greater detail,
consider consulting the application’s help file.
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BEFORE YOU BEGIN

Throughout the lessons, we make the following assumptions:

O Monarch Complete is properly installed and the Monarch Classic and Data Prep Studio program items are
available when you start Windows.

0 The lesson files are installed and Monarch’s default Report, Model, and Project folders are configured to point to

the lesson files (the Setup program ideally automatically assigns these defaults the first time you install the
product but you may want to assign other folders instead).

You are using an operating system for which Monarch is certified.

0 The Date Format setting in Monarch has been set to M/D/Y to handle dates in the sample reports correctly.

NOTE If you use a different OS, some slight deviations from the steps listed in the lessons will
occur (e.g., the default paths, the appearance of screens, and other minor differences), but
you can effectively complete the lessons on all versions of Windows that Monarch supports.

This Learning Guide also assumes that you have copies of the following files stored in your computer:
Beantown.mdb

Payroll.mdb

Classic.pdf

Patient.pdf

0O  Canaccord 042215.pdf

These files are typically installed along with Monarch and are found in C:\Users\Public\Documents\Altair
Monarch\Data and C:\Users\Public\Documents\Altair Monarch\Reports. If you do not have these files, you can
download them from here.

0O 0 O

We begin our lessons by adding data to a Data Prep session.
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ADDING DATA TO A DATA PREP SESSION

A Data Prep session begins by placing data, either from a preexisting table or from a table created through the
Report Design window, in the Prepare window.

The following are some file types that may be opened in Data Prep Studio:

O

Delimited text files (.csv) O  Print files (.dat, .prn, .rpt, .txt)

Fixed text files (.txt) 0O PDF files (.pdf)

XPS files (.xps)

HTML files (.htm, .html, .asp, .aspx)

Microsoft Excel files (.xls, .xIsx, .xlsm, .xIsb)
Microsoft Access files (.mdb, .accdb)

JSON files (.json)

XML files (.xml)

Log files (.log)

0O 0 0 O

Data Prep workspace files (.dpwx)

Monarch files (.dprj, .xprj, .dmod, .xmod)

Adding Data from a Database File

STEPS:
1. Launch Data Prep Studio.
2. Select Open Data to display the Select Data Source to Open dialog.
Select Data Source to Open o X
Filter by name or file extension (xls, csv, txt) O\
E A Moot e @
MONARCH FILE
PDF & TEXT ;? Monarch Project
SPREADSHEET ;? Monarch Workspace
DATABASE
APPLICATION
BIG DATA
WEB
ALL
| OPEN FILE H " OPEN WEB FILE || +'| OPEN LIBRARY CANCEL
Figure 4-2. The Select Data Source to Open dialog.
3. Select the data source option Database and then double-click on Microsoft Access.
4. In the Open dialog that displays, navigate to the folder in which you stored Beantown.mdb, select this file, and

then click Open.
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The Access Explorer displays.

Access Explorer o X
Beantown.mdb

Table Name

Accounting

Data Processing

@6

Marketing

PREVIEW SELECTED LOAD SELECTED CANCEL

Figure 4-3. The Access Explorer.

The Access Explorer displays each time you load a Microsoft Access data source; using this explorer, you can
select which tables to load to your workspace and even preview these tables before loading if necessary. A
similar explorer is available for Excel files.

5. Since we want to load all three tables within the file, tick the box to the left of Table Name and then click Load
Selected.

You are brought to the Prepare window. Each of the tables that make up the database displays in this window.

TRANSFORM (2 COMBINE [5}] ANAVZE [ EXPORT

S ADD @ Ab Department ¥ AD Last Name ¥ Ab First Name ¥ Ab Emp_ID ¥ &) HireDate *

—— Marketing April Anne 1597429 1wy Z | TPhoma Vs
Ty | s Marketing Banning David 1607768 1287} £

- Marketing Bartholemew Anne 1503642 1718/, ¢ . e o
SEETIIY b Marketing Bradford Eugene 1605798 7124/, 7 &

Marketing Carlson Stephen 1588509 3/4/]

Data Processing = Marketing Carpenter Rae Ann 1598609 6/30/,

. Marketing Chandler Liz 1586201 /41,

9 Marketing Connely william 1593726 3/12/]

10 Marketing Desmarais Jeff 1503210 44/

# Marketing Fallon Joshua 1596297 1/s].

2 Marketing Hampsted Armstrong 1593898 3/18/

13 Marketing Hendrickson Robert 1589538 9/2/]

14 Marketing Hil Francis 1606310 9/30/,

15 Marketing Horgan Maggie 1598135 2/28/;

16 Marketing Ingles George 1589165 52|

17 Marketing Leiberman Teresa 1590496 7/3/]

18 Marketing Manfretti Joseph 1508740 8/23/,

19 Marketing Marshall Alex 1597890 10/23/|

20 Marketing Mendleson Paulz 1593345 7/18/]

21 Marketing Palentier Joshua 1503374 7/18/]

22 Marketing Pappas Julie 1508131 8/20/,

23 Marketing Pascurell Mary 1586229 4/3/

24 Marketing Stratton Marlena 1599780 6/14/]

25 Marketing Ungermann Norman 1590227 5/17/]

2 Marketing Valensuela George 1505576 4/20//

EDIT LOAD OPTIONS

&« Row:nmzf- > > Columns:6 T

Figure 4-4. Tables brought into the Prepare window.
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NOTE Letters beyond the 64t character are truncated when opening tables from Excel files
with column names exceeding 64 characters because the Access driver used to read
these files imposes a 64-character limit.

Let's take a moment to explore the Prepare Window.

The Prepare Window is mainly divided into three views: the Table Selector on the left, the Data Preview in the middle,
and the Change History panel on the right. The Table Selector and Change History panels can be hidden and

displayed by clicking on the Hide “*' and Display "*. buttons, respectively.

Clicking on the drop-down buttons located to the right of a table in the Table Selector displays a context menu that
will allow you to perform table operations, including change row limits, edit file paths, pin tables, and the like.

The bottom of the Prepare window presents several options that will allow you to navigate through your tables easily.

Note that while a database may contain any nhumber of tables, only those tables you selected and loaded display in
the Prepare window.

Limiting Rows

You can change the default number of rows Data Prep Studio loads on a global basis when it opens tables by

e

selecting Settings B from the Data Prep Studio toolbar and then selecting Application Default Settings from the

options that display. This setting may be found in the Import > General tab. Note that while decreasing the row limit
when opening tables can improve the performance of Data Prep Studio and speed up response times, this may also
result in missed exceptions and problematic rows, particularly if these rows are not included in the limited row set.

If you wish to change the row limit of a specific table that has been opened in the Prepare window, click on the drop-
down button located to the right of the table from the table selector and, from the options that display, select Row
Limit.

If you wish to change the row limit of a table while it is in Preview mode, select the Edit Source Row Limit # putton
and use the Edit Source Row Limit dialog that displays to do so.

Changing File Paths

You may wish to change the file path of an open table in the Prepare window (e.g., a file with the same name is
located in a different folder in your machine or network). To do so, click on the drop-down button located to the right
of the table from the table selector and, from the options that display, select Edit File Path or Edit All File Paths
according to your needs. In the Edit (Workspace) File Path(s) dialog that displays, navigate to the file you wish to use
and then click Open. You can only replace the contents of a table with those of another table with the same file
extension. Data Prep Studio automatically detects the file extension of the open table to help guide your replacement
choices.

Editing Load Options

When your table is one of several tables in an Access database or one of several worksheets in an Excel file, for
example, you can select a different table to open by clicking on the drop-down button located to the right of the table
from the table selector and, from the options that display, selecting Edit Load Options. When applicable, load
options can also be accessed from the Column Information panel that displays when a table is previewed.
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MICROSOFT ACCESS DATA SOURCES

For Access data sources, the following dialog displays:

Access Options (m] X

Table: | Accounting v

Figure 4-5. The Access Options dialog.

Select the new table you wish to load from the drop-down list provided and then click OK.

MICROSOFT EXCEL DATA SOURCES

For Excel data sources, the following dialog displays:

Excel Options [m] *
Sheet:  "ImillionrowsExportMP131%’ v Lines to skip: | 0
+ | First Row Has Column Names Ignore Blank Rows Import all columns as text
Automatically sync columns with source data on load or refresh 0 Input Connector: | Monarch Excel Table ~
‘ SCAN AND DEFINE COLUMNS ‘ ‘ BULK TYPE EDIT v @ ReportDate  Ab  OrderNumber (3 Ship Date
1 | 5/1/2006 12:00:00 AM | 536017 4/6/2006 12:00:00,
f Eelumm e Type 2 | 5/1/2006 12:00:00 AM | 536017 4/6/2006 12:00:00.
3 | 5/1/2006 12:00:00 AM | 536017 4/6/2006 12:00:00.
' Report Date @ v 4 | 512006 12:00:00 AM | 536017 4/6/2006 12:00:00.
5 | 5/1/2006 12:00:00 AM | 536039 4/21/2006 12:00:00.
| Order Number Ab v 6 | 5/1/2006 12:00:00 AM | 536039 4/21/2006 12:D0:00.
7 5/1/2006 12:00:00 AM | 536039 42142006 12:00:00.
/| Ship Date @ v 8 | 5/1/2006 12:00:00 AM | 536039 4/21/2006 12:00:00.
9 | 5/1/2006 12:00:00 AM | 536039 4/21/2006 12:00:00.
' Account Number # ~ 10| 5/1/2006 12:00:00 AM | 536016 4/5/2006 12:00:00.
11| 5/1/2006 12:00:00 AM | 536016 4/5/2006 12:00:00,
| Contact Ab v - 7B I E R T

Figure 4-6. The Excel Options dialog.

From the settings provided, specify those most applicable to the table you wish to open and then click OK.

HTML DATA SOURCES
For HTML tables, the following dialog displays:

HTML Load Options P

First Row Has Column Names

Lines to skip: 0

Figure 4-7. The HTML Load Options dialog.
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After specifying the necessary details, click OK.

DELIMITED TEXT FILES
For delimited text files (e.g., CSV), the following dialog displays:

Delimited Text Options a X
[hTeligelo (i Conversion Options
Delimiter: Comma ~ Lines to skip: 0
Text Qualifier: Double Quote Rows to scan for columns: 1000 :
« First Row Has Column Names Ignore Blank Rows Allow Embedded Line Breaks

Automatically sync columns with source data on load or refresh 0

Encoding: | UTF-8 ~  Code Page:
Ab Customer Ab Contact Ab Address 1 Ab *
< = 1 Mo Town Tunes Mo Malone 1709 Arbor Parkway
2 [rowssovoares [omsoman [ooemt v
| Customer Ab v 3 Bluegrass Records Roberto Gl Hwy 17 at the 9 mile marker
4 Classic Exchange Mike Kelly 57 Market Street
+| Contact Ab v 5  Die Harmonie Maria Seefeld Georgstraze 21
| Address 1 Ab - 6 Belly's Music Store Betly Yoder Muscaline Plaza 200
7 The Glass Harmonica Howie Frankiin 197 Putnam Street
| Address 2 Ab v 8  Canciones Lidia Rosado Paseo de las Paimeras
9 Die Melodie Thomas Kurze Einkaufszentrum am Petrus  Ger
v City Ab v 10 Notas Musicales Braulio S?nchez  Calle del Deseo, 80
| Postal Code Ab - 11 Chez Rudy Marie Thibedeau 1 Rue du Rivage
12 Spinning Records Terry McDowell 12 Duke Street =1
/| State Ab v 13  The Record Store Kies van Der Houwe | Jacob Obrechistraat 22a
14 Relner's Symphonic Sounds | Thomas Martinez 363 Park St.
+| Country Ab v 15  Fandangos Records Licnel Sampson 555 Elisabeth
| Account Number [T 16 Big Shanty Music Marvin Mabry 3658 Springs Ferry suit _
1 3

Figure 4-8. The Delimited Text Options dialog.

Using this dialog, you can specify whether to ignore blank rows or allow embedded line breaks. You can also define a
delimiter by clicking on the drop-down button beside this field and choosing from several common delimiters which to
apply to your table. If the delimiter you are looking for is not on this list (e.g., »), simply type it into the field. Define a
text qualifier by selecting one from the drop-down list provided. If you need to modify Encoding Options, click on the
button provided to launch drop-down lists that will allow you to select an encoding type and code page, if applicable.

More information on editing table load options can be found here.

Pinning Tables

When a table is pinned in the Prepare window (i.e., click on the drop-down button located to the right of the table from
the table selector and, from the options that display, select Pin Table from the options that display) and the
workspace is saved, a user without direct access to the table source may open the pinned table by opening this same
workspace. When pinning a table, a user may also choose to pin the current rows opened (when a row limit has been
set) or pin the entire data set. This functionality allows data-sharing with users who do not necessarily have rights to
the data source systems required to create working tables. Note, however, that the pinned table cannot be refreshed
by a user without access to the data source.

Accounting

Figure 4-9. Pinning a table in the Prepare window.
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Refreshing Table Data

When a table (e.g., an Excel worksheet) is open in the Prepare window of Data Prep Studio, you essentially have a
snapshot of the current state of this table. When you or another user makes changes to this table, your table
“snapshot” must be rebuilt to reflect these changes. To do so, click on the drop-down button located to the right of the
table from the table selector and, from the options that display, select Refresh Data From Source.

Tables obtained from drag-and-drop operations in web pages cannot be refreshed because such tables are not
sourced from a file path or URL. Moreover, the Edit File Path, Edit Workspace File Paths, and Refresh Data From
Source buttons are not available for such tables.

Adding Data from a Report File

PDF and PRN reports, when first opened in Data Prep Studio, display in the Report Design window, which will allow
you to create templates and traps to enable consistent extraction of data from similarly structured report files. In the
following example, we use the Report Design window’s Auto-Define feature to create traps and fields from our report.
Note, however, that one should not depend solely on this feature as the application may be unable to process reports
with more complex structures or irregularly arranged lines.

To learn how to create templates and trap fields in the Report Design window in greater detail, click here. You may
also want to review how trapping is done in Classic.

STEPS:

1. Inthe Prepare Window, click the Add button.

2. In the Select Data Source to Open dialog that displays, click PDF & Text and then double-click on PDF Report
to display the Open dialog.

3. Navigate to the folder in which you stored Classic.pdf (typically C:\Users\Public\Documents\Altair
Monarch\Reports), select this file, and then click Open. The report opens in Document Options view.

4. No changes to the document options are needed for now. Click Accept to open the report in the Report Design
window.

. ) ) _ . B AUTO DEFINE _ )
5. Automatically define fields by selecting the Auto Define " button in the Template and Field

Properties panel.

Templates £ RESET TRA £ RESET FIEL REDACT SAMPLE TEXT CLEARING TEMPLATE

rrrrr

aic Store

AUTO DEFINE CLEAR

Edit Field Properties

DELETE FIELD

Figure 4-10. Loading Classic.pdf into the Report Design window.
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6. Click Accept on the Report Design toolbar to close the window and add the table extracted from the report to the
Prepare window.

COMBINE ANAWZE [ EXPORT

@ Ab Customer v # f Ap Contact v i order) ShP v AD g # - Ab Description g
o g 1 Betty's Music Store 11867 Betty Yoder 536017 4/10/2010 CD 4 Bartok, Sonata for Solo| | Z | '2Moma Ml |
a2 2 Betty's Music Store 11887 Betty Yoder 536017 4/10/2010 7 Mozart, Mass in C, K427 | 2
= 3 Betty's Music Store 11887 Betty Yoder 536017 4/10/2010 2 Luening, Electronic Musi = =
Accounting ~ 4 Betty’s Music Store 11887 Betty Yoder 536017  4/10/2010 DVD 9 Scarlatti, Stabat Mater =7 =
5 Betty's Music Store 11887 Betty Yoder 536030 4/21/2010 D 11 Beethoven, Pathetique §
Data Processing v B Betty's Music Store 11887 Betty Yoder 536039 4/21/2010 8 Mendelssohn, War Mard|
B 7 Betty's Music Store 11887 Betty Yoder 536039 4/21/2010 10 Pizzetti, Messa di Requie
Marketing & 8 Betty's Music Store 11887 Betty Yoder 536039 4/21/2010 LP 6 Misc., Modern Trombone
9 Betty’s Music Store 11887 Betty Yoder 536030 4/21/2010 DVD 6 Gershwin, An American |
H 11 Big Shanty Music 17959 Manvin Mabry 536016 4/5/2010 1 Schubert, Sonata in e, D
- Classic.pdf 12 Big Shanty Music 17959 Marvin Mabry 536016 4/5/2010 3 Mozart, Symphony No.2!
13 Big Shanty Music 17959 Manvin Mabry 536016 4/5/2010 6 Schoenberg, Ode to Nap
1 Big Shanty Music 17959 Manvin Mabry 536029 4/14/2010 CD 2 Shostakovich, 24 Prelud:
15 Big Shanty Music 17959 Marvin Mabry 536020  4/14/2010 SACD 9 Balakirev,Symphony no.
16 Big Shanty Music 17959 Marvin Mabry 536020 4/14/2010 DVD 5 Holst, St Paul's Sute for
17 Bluegrass Records 10929 Roberto Gi 536020  4/10/2010 CD 3 Faure, 28 Songs, Stulzm
& Bluegrass Records 10929 Raberto Gi 536020 4/10/2010 3 Takemitsu, Music of Tk
18 Bluegrass Records 10929 Roberto Gi 536020 4/10/2010 6 Messiaen, Quatour pour
20 Bluegrass Records 10929 Roberto Gi 536020  4/10/2010 SACD 8 Strauss, Ein Heldenleber
21 Bluegrass Records 10929 Roberto Gi 536020  4/10/2010 DVD 9 Schumann, Manfred Ove
22 Musique du Monde 18635 Alain Lebon 53012 4/1/2010 D 10 Milhaud, 3 Rag Caprices,
23 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 5 Strauss, Le bourgeois ge
24 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 5 Sariabin, Preludes, Op. &
25 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 6 Rogers, Slaughter on Te
26 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 BLU 10 Paganini, 24 Caprices fol
27 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 DVD 8 vivaldi, Concertos for Re
28 Musique du Monde 18635 Alain Lebon 53012 4/1/2010 D 10 Linek, Epiphany Carol
29 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 -7 Casella, Paganiniana, NE
30 Musique du Monde 18635 Alain Lebon 536012 4/1/2010 VD -1L Lambert Airs de Courm
31 Musigue du Monde 18635 Alain Lebon 536034 4/18/2010 CD 3 Huggett, Sute for Accon
32 Musiue du Monds 18635 Alain Lebon 536034 4/18/2010 9 Peterson, Quartet No. 1
35 Musigue du Monde 18635 Alain Lebon 536034 4/182010 4 Ricd, Crispino e la Coma
3¢ Musique du Monde 18635 Alain Lebon 53034 4/18/2010 4 Selmay Salaverde, Canz
35 Fandangos Records 17658  Lionel Sampson 536045 4/28/2010 CD 6 Kodaly, Choral Music, Sz
3 Fandangos Records 17658 Lionel Sampson 536045 4/28/2010 10 Gibbons, Instrumental &
57 Fandangos Records 17658  Lionel Sampson 536045 4/28/2010 11 Dvorak, Vanda Overture
35 Fandangos Records 17658  Lionel Sampson 536045 4/28/2010 3 Elgar, The Apostles Orat
39 Fandangos Records 17658  Lionel Sampson 536045 4/28/2010 DVD 2 Handel, Royal Fireworks METADATA COLUMNS
4 Die Melodie 13487 Thomas Kurze 536028 4/14/2010 CD 6 Syberg, Adagio for Strin{ T R RO DESE
| ¥
Columns: 11

Figure 4-11. The table extracted from Classic.pdf via the Report Design Window is added to the Prepare window.

If you wish to make changes to your newly defined table after bringing it into the Prepare window, click on the
drop-down arrow beside its name in the table selector and then select Edit in Report Design.

Doing this will bring up the Report Design window once more and allow you to make additional changes to your
table.

NOTE You can perform some changes to the table extracted from a report, including change its
column names and fill nulls with the value preceding the empty cell, in the Report Design
window.

These changes do NOT form part of the session’s Audit Trail (Change History) because the
Report Design window is a settings panel that creates a new table from the settings
selected. The Change History function of Data Prep Studio only tracks changes to existing
tables.

If you wish to apply more changes to a table you extracted using the Report Design window
and have these changes tracked, open the table in the Prepare window instead.
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Adding Data from a Website

Data Prep Studio is unique from other data prep software because it is capable of intuitively determining tables from
webpages and recreating these in the Prepare window.

STEPS:

1. Onyour browser, go to the webpage https://www.nasdag.com/market-activity/stocks/altr/earnings.

This webpage displays, among others, a table of Altair's quarterly earnings surprise amounts over the last four
quarters.

I Quarterly Earnings Surprise Amount

Fiscal Quarter End Date Reported Eamnings Per Share* Consensus EPS* Forecast % Surprise
Mar 2024 5/2/2024 0.27 018 50

Dec 2023 2/22/2024 0.29 0.22 31.82
Sep 2023 11/2/2023 0.01 -013 107.69
Jun 2023 8/3/2023 -015 -0.07 -114.29

Figure 4-12. Altair’s quarterly earnings surprise amounts reported in NASDAQ.

2. Use your mouse to highlight this entire table and then drag and drop the contents of the webpage into the
Prepare window of Data Prep Studio.

Data Prep Studio intelligently detects tables in webpages and recreates them.

_* ransrorm () comeme [5] amaze [

=22 Ab Fiscal Quarter End ¥ & Date Reported > # Earnings PerShare* ¥ # Consensus EPS® Fore... ™ # *

Mar 2004 2 May 2024 12:00:00 am 027 018 | g | Tahomo

2

€

s T
TABLES

2 Dec 2023 22 Feb 2024 12:00:00 am 029 022 | =
Accounting - 3 Sep 2023 2 Now 2023 12:00:00 am 0.01 0.13

%5
4 un2023 3 Aug 2023 12:00:00 am 0.15 0.07
Data Processing -

=
E

Marketing -
= Classic -
Classic pdf

| |

Figure 4-13. The newly defined table in the Prepare window.

Data Prep Studio allows you to open files stored on a web repository, such as Amazon S3, FTP, SFTP, and the like.

To do so, launch the Select Data Source to Open dialog and then click the Open Web File button located at
the bottom of this dialog. This action launches an Open Data Source from Web dialog wherein you can enter the URL
of the webpage containing the table you wish to bring into Data Prep Studio.

Dragging and Dropping Webpage Content Versus Using the Open from Web Dialog
You can drag and drop tables from HTML files/pages directly into the Prepare window.

The browser is not only a rendering engine but also a scripting engine. For HTML with no Javascript that is delivered
in its complete form and rendered in the browser, the copy/drag/drop content will be the same as the content
obtained directly from the URL.
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However, if the HTML contains Javascript, which dynamically inserts the tables as HTML when rendered on the
browser, only the copy/drag/drop will contain dynamically created tables; the HTML obtained directly from the URL
will not contain these tables.

Adding Data from XML and JSON Files

Data Prep Studio allows you to explore and open JSON and XML files.

STEPS:

1. Navigate to the location of the JSON or XML file you wish to open, select the file, and then drag and drop it into
the Prepare window.

The XML/JSON Explorer displays.

XML/JSON Explorer o X
Flora_and_Fauna.JSON

. ® Row Expand Arrays f - . -
Rows: 0 Column Expand Arrays | Use Simplified Column Names Encoding Options

« Root
~ Catalog-B

~ Plant
COMMON
BOTANICAL
ZOMNE
LIGHT
PRICE
AVAILABILITY

+ ANIMAL
COMMON
BOTANICAL
ZOME
LIGHT
PRICE
AVAILABILITY

CANCEL

Figure 4-14. The XML/JSON Explorer. A similar explorer is made available when opening XML files.

XML and JSON files present a hierarchical arrangement of nodes or tables. Selecting a node (table) displays all
of its fields on the right-hand side of the explorer and a preview of the data contained within it.

When checked, the Use Simplified Column Names box located on the upper middle part of the explorer
instructs Monarch to eliminate extraneous characters (e.g., the @ sign) from column names. Use the Encoding
Options drop-down to select a character encoding system different from the default (UTF-8) if necessary.
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XML/JSON Explorer

Flora_and_Fauna.JSON

Rows: 5 @ g:mﬁf‘;:gﬁig?‘;ﬂys | Use Simplified Column Names
Column Name Type
~ Root COMMON Ab
~ Catalog-B
" BOTANICAL Ab
COMMON
BOTANICAL ZONE #
ZONE
LT LIGHT Ab
PRICE PRICE #
AVAILABILITY
- ANIMAL AVAILABILITY #
COMMON
BOTANICAL Common’ Ab
ZONE Color Ab
LIGHT
PRICE
AVAILABILITY

Ab COMMON  Ap  BOTANICAL # ZONE Ap  LIGHT

#  PRICE

1 Crown of thords Eupharbia milii
2 Crown of thords Eupherbia milii
3 Crown of thords Eupherbia milii
4 Crown of thords Euphorbia milii
5 Columbine Aguilegia canadensis

wow oW ow v

Mostly Sunny §11.26
Mestiy Sunny §11.26
Mostly Sunny $11.26
Mostly Sunny 511.26

a X

#f  AVAILABILITY
039599
039599
039599
039599

Meostly Shady 5937 030699

Figure 4-15. The XML/JSON Explorer with a node selected.

Selecting a node also shows the number of rows it contains if this number is more than one.

2. Select a node to open by clicking on it.

3. Select Row Expand Arrays or Column Expand Arrays to display JSON arrays into rows or columns,
respectively.

4. Select an Encoding Option if necessary.
Click OK.

Your table is loaded in the Prepare window. You can select and add this table to your list of open tables as usual.
For the rest of the exercises, however, this is not necessary.

Adding Data from Monarch Classic Files

Data Prep Studio allows you to work with existing Monarch Classic models and projects.

This means you can take advantage of the robust templating and extraction capabilities of Monarch Classic and use
the pre-defined models to work with reports.

However, note that tables that come from Monarch files behave differently from tables that come from other sources:
0 Tables associated with a Monarch Classic file are not displayed in the Preview window.

0 Data from reports associated with a Monarch file table are displayed as tables in the Prepare window but cannot
be prepped.
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The following Monarch Classic features are translated in Data Prep Studio when you open a Monarch file:

a
a

0o 00 o o

Data captured by all trap types 0O  External lookups
Multi-column regions 0O Runtime parameters

Formula-based calculated fields using all built-in Named filters

Monarch functions
Named sorts

Lookup table-based calculated fields L
Summary definitions

Multiple reports User-defined functions

PDF reports Bookmarks

0O 0 0O 0O 0 O

Projects that use databases
Report colors

Projects with named exports (with some
exceptions)

The following Monarch Classic features are currently not supported in Data Prep Studio:

a

External Models — External model definitions within a Monarch model are simply ignored when the model is
imported into Data Prep Studio.

User-edited fields — User-edited fields are displayed in Data Prep Studio with null values.

Redaction of report fields — Data Prep Studio does not support Consistent Alias Replacement (CAR)-type
redactions. Inthe case where the Monarch model specifies a CAR redaction for some field, the Data Prep Studio
substitutes a non-CAR redaction change that best emulates the CAR redaction specified.

Projects with inputs and models from S3, HTTPS, and FTPS (i.e., web sources that require authentication)

Report index — Any report index definitions present in the Monarch model are ignored in DPS

To open Monarch Files in Data Prep Studio, the following steps are applied.

STEPS:

1.
2.

Launch the Select Data Source to Open dialog.

Click Monarch File and then double-click on Monarch Model or Monarch Project. From the Open dialog that
displays, navigate to the folder in which your Monarch file resides, select it, and then click Open.

If you open a Monarch model only, the model is displayed as a table in the Prepare window. To view data, you
must add at least one report that is compatible with this model. To do so, in the Prepare window, click on the
drop-down located to the right of this main table and select Report Options > Add Report.

If you open a Monarch project, the model is displayed as the main table in the Prepare window and all other
tables obtained from the report associated with the project are displayed as sub-tables.

More information on working with Monarch Classic files in Data Prep Studio can be found here.

Adding Data from Excel Files

Excel files may be added to your workspace via the Select Data Source to Open dialog or simply dragging and
dropping the file into the Start Page, Preview window, or Prepare window.

You can open Excel files by using Worksheet Design, which allows you to capture data from Excel files with multiple
levels of detalil or the Excel Explorer.
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Excel Explorer o X

2KrowsExportMP131.xlsx
Excel Import Connector

Monarch Excel Table v Show Mamed Ranges Import all columns as text

Automatically sync columns with source data on load or refresh o

First Row Has Column Names  Ignore Blank Rows  Lines to skip:

Table Name vy 0

"ImillionrowsExportMP131§'

PREVIEW SELECTED LOAD SELECTED CANCEL

Figure 4-16. The Excel Explorer dialog.

This dialog is used to specify which tables to open and how the data should be displayed. When the necessary
specifications have been provided and Load Selected is clicked, the table(s) open as usual in the Prepare window.

More information on the Excel Explorer dialog may be found here.

Trapping Data from Report Files

Many of today’s reports come in the form of PDF, PRN, and TXT files. You could simply read these files off your
computer screen and learn about whatever they contain, but what if you wanted to use the data in these reports to
perform further analysis? Let's say you had a 150-page PDF report listing individual patient visits over a span of 8
months and want to find out which three symptoms are the most common among these patients. Before you can do
any such analysis, you clearly have to get data off the PDF and into your computer.

Preparing Traps

When you bring a report file into Data Prep Studio, you must create a model to extract data from it. A model is a
collection of data extraction templates, and modeling is the process of creating these templates. You can define data
extraction templates to quickly and consistently select data from a report and arrange them into an orderly table.

STEPS:

1. Open Patient.pdf in Data Prep Studio and accept the current document options. The report displays in the
Report Design window.
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TRAPPING

Templates .'
w
=]
Name Role + — -
@
H
AUTO DEFINE = 06/01/10 Stitches Health Care Centers Page @1 -
Z Outpatient Treatment Log
Period: @5/01/16 - @5/31/1@

PATIENT INFORMATION SVC_CODE SYMPTOMS
Michael Canton 40028 Son had Funny Bone Surgery
RR 1 Box 22 and Minor attitude problem
Elmberry MO 63343 BILL: 1838.39
Charles Bergan ce543 Came to pay bill &
9501 Moody Park got sick
oOver Park KS 66212 BILL: 7995.12
Eric Dryson A0032 Hang nail extraction
119 Washington St
Cleveland OH 45215 BILL: 192.00
Jim Handley £A0048 Daughter had grape juice
R 2 Box 399 stain on upper lip
Artica IN 47452 BILL: 99.00
Marshall Briar A0882 De-odorized feet
PO Box 7867
Amarillo TX 79114 BILL: 97.25
Henry Thornton A0896 Son sat on frog
Rt 3 Box 463
Fairmont WV 26554 BILL: 92.08
Louis Mc Nally ceado Daughter has stomach
PO Box 293 full of Tootsie Rolls
Bramwell WV 24715 BILL: 238.80
Kurt Grady 40179 Dog was hysterical
Rt 1 Box 241 -

Figure 4-17. Opening Patient.pdf in the Report Design window.

2. Click on the line selection area of the line beginning with EImberry MO 63343 so that it is selected. Then, in the
Template Properties panel, click + Detail. This instruction tells Data Prep Studio that we are creating a detail

template.
TRAPPING

Templates Y

g
Name  Role + = i
4
AUTO DEFINE g e6/01/10 Stitches Health Care Centers Page 01 -

E Outpatient Treatment Log

Period: @5/01/10 - @5/31/10

PATIENT INFORMATION SVC_CODE SYMPTOMS

Michael Canton 40028 Son had Funny Bone Surgery

RR 1 Box 22 and Minor attitude problem

Elmberry MO 63343 BILL: 1838.39

Charles Bergan ce543 Came to pay bill & Line selection area

9501 Moody Park

— Click here to
select a line to use
as a basis for

got sick

Eric Dryson extractid

119 Washington St

Hang na1

Cleveland OH 45215 BILL: 192.00 trapping
Jim Handley AR@48 Daughter had grape juice
R 2 Box 399 stain on upper lip
Artica IN 47452 BILL: 99.00
Marshall Briar AB@82 De-odorized feet

PO Box 7067

Amarillo TX 79114 BILL: 97.25

Henry Thornton ABB96 Son sat on frog

Rt 3 Box 463

Fairmont WV 26554 BILL: 92.00

Louis Mc Nally cod40 Daughter has stomach

PO Box 293 full of Tootsie Rolls
Bramwell WV 24715 BILL: 238.80

Kurt Grady 40179 Dog was hysterical

Rt 1 Box 241 h

Figure 4-18. Selecting a line to trap.
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The Template Editor is activated.

CANCEL EE TRAPPING
Templates
g
Name Role + 3
Detail @ Detail v 5.
3|7
&
o

AUTO DEFINE > CLEAR
»

Standard v | AR

Elmberry MO 63343
e6/01/10

PATTENT INFORMATION

Michael Canton
RR 1 Box 22
Elmberry MO 63343

Charles Bergan
9581 Moody Park
Over Park KS 66212

Eric Dryson
119 Washington St
Cleveland OH 45215

Jim Handley
R 2 Box 399
Artica IN 47452

Marshall Briar
PO Box 7867
Amarillo TX 79114

Henry Thornton
Rt 3 Box 463
Fairmont WV 26554

=t REPLACE SAMPLE TEXT & REDACT SAMPLE TEXT

BILL:  1838.39
Stitches Health Care Centers
Outpatient Treatment Log

Page 01 -

Period: ©5/01/10 - 95/31/18

SVC_CODE SYMPTOMS

A0@28 Son had Funny Bone Surgery
and Minor attitude problem
BILL:  1838.39

@543 Came to pay bill &
got sick
BILL:  7995.12

40032 Hang nail extraction
BILL: 192.00

ABa48 Daughter had grape juice
stain on upper lip
BILL: 95.00

ABO82 De-cdorized feet
BILL: 97.25

ABA9E Son sat on frog

BILL: 92.00

Match Ca Page:

Selected Line: 10 Positi

Figure 4-19. The activated Template Editor.

Click into the trap line right above the word BILL and then, using your keyboard, type out the word BILL. Notice
how all similar lines (i.e., those with the word BILL in the exact same position in the report) are highlighted.
Guillemets also appear in the line selection area next to lines containing data that match the trap.

ACCEPT UMENT OPTIONS
Templates A £ RESETTRAP X REPLACE SAMPLE TEXT & REDACT SAMPLE TEXT
4
Name Role + 3 Standard v AN |1 e -
Detail Detail v 5
® 3 BILL
g
o/ Elmberry MU 6334 BITT: 183839

> CLEAR

AUTO DEFINE

06/01/10

PATIENT INFORMATION

Michael Canton
RR 1 Box 22
Elmberry MO 63343

Charles Bergan
9561 Moody Park
Over Park KS 66212

Eric Dryson
119 Washington St
Cleveland OH 45215

Jim Handley
R 2 Box 399
Artica IN 47452

Marshall Briar
PO Box 7067
Amarille TX 79114

Henry Thornton
Rt 3 Box 463
Fairmont WV 26554

Stitches Health Care Centers
Outpatient Treatment Log

Page @1 -

Period: ©5/01/10 - ©5/31/10
SVC_CODE syl Trap Line — Enter
P son | trap characters
and
sl here
0543 Came to pay bill &
got sick
BILL: 7995.12
ARB32 Hang nail extraction
BILL: 192.00
70048 Daughter had grape juice
stain on upper lip
BILL: 99.00
hees2 De-odorized feet
BILL: 97.25
ABB96 Son sat on frog

BILL: 92.00

Match Ca Page:

Selected Line: 10 Position: 86

Figure 4-20. Specifying characters to create atrap.

You have just manually defined atrap, in this case, an exact trap. Let's move on to defining fields.
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4. In the sample text line, highlight the numbers 1839.39.

The Data Preview at the bottom of the Template Editor displays what would make the first column of your table.
The rows of this table are populated with the bill amounts you have just instructed the application to pick up.

E e

Templates £ RESET TRAP £ RESET FIELDS w1 REPLACE SAMPLE TEXT & REDACT SAMPLE TEXT
Name Role + Standard w A L] ] [} @
Derail @ | Detail v
Elmberry MO 63343 sron:  [EEECEER
AUTO DEFINE < CLEAR e —_— ———r .
Gutpatient Treatment
period: 05/01/10 - 05/%
Edit Field Properties
[l Advanced Sa mp|e text line f---—--—-—--—--—---
Michael cCanton ) ) ¥
ER 1 Box 22 — Highlight text =
Name eq 1838 39 - Elmberry MO 63343
here to create
Template Width 8 * charles sezgan chaes .
e - 9501 Moody Park fields for your
» Ower Park KS
Type Numeric ~ table
Eric Dryson A0D3Z
Decimals 2 | oseral @ 119 Washington St
- Cleveland OH 45215 BILL: 192.00 -
Format General ~ | sETal
Display Width 8 5 u u Page:1 Selected Line: :
# eg_1... =
Alignment Left ~ 1 183839
Copy Value from Previous Record 2 [1sesaz
3 1szoo
VERIFY T
| Left Side | Right Side o Type 5 ar08
6 9200
7 23880
- 8 17800 -

Figure 4-21. Highlighting fields.

Note also that a Field Properties section is added to the Template Properties panel. We'll use this panel to give
our field a more meaningful name.

5. Highlight the text in the Name field of the Field Properties section of the Template and Field Properties panel,

rename the field Bill Amount, and then click the Accept icon that displays next to the field name.

CANCEL

Templates £ RESET TRAP £ RESET FIELDS % REPLACE SAMPLE TEXT & REDACT SAMPLE TEXT
Name Role + Standard - AR ]
Detail @ Detail v
Elmberry MO 63343
AUTO DEFINE CLEAR 06/01/10 Page 01 n

Period:

Edit Field Properties

[E eIl Advanced
M

and Minor attitude prob.

RE 1 Box 22
Name »

Elmberry MO €3343
cha
Template Width 8 3

les Bergan c0543

9501 Moody Park
» Over Park KS 66212
Type Numeric ~
Eric Dryson R0032
Decimals 2 ~ SETALL (@ 119 Washington st
» cleveland OH 45215
Format General ~ | SETALL
Display Width s .
# eg_1-..
Alignment Left ~ 1 18339
Copy Value from Previous Record 2 |men2
3 19200
VERIFY 4 w00
| LeftSide || Right Side || Type 5 mas
6 w200
7 23880
- 8 17800

BILL: 1838.39
came to pay bill &
7995.12
Hang nail extracticn

192.00

BILL:

Figure 4-22. Specifying a field name.
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The name of the field indicated in the Data Preview panel changes.

TRAPPING

Templates

Name Role + Standard

Detsa @ | Dei
AUTO DEFINE CLEAR

Edit Field Properties

Advanced

£ RESET TRAP

£ RESET FIELDS

Elmberry MO 63343
06/01/10

PATIENT INFORMATION

SYMPTOMS

Page

1 Canton
RR 1 Box 22
Elmberry MO 63343

Charles Bergan C0543
9501 Moody Park

Over Park KS 66212

Eric Dry R0032
119 ¥ i 5t

Clevelan 45215

# Bill Amount

1183830

DELETE FIELD

a Minor at
BILL:

BILL:

1 had Funny Bone gery
tude problem

1838.39

Came to pay bill &
got sick
BILL: 79

5.12

Hang nail extraction

192.00

Figure 4-23. A new field created from our trapping operation.

Let's capture more data from the report.

6. Click on the line selection area next to the line beginning with Michael Canton and then, in the Template

Properties panel, click + Append.

The contents of the trap line and sample text line are updated with your selection.

ACCEPT CANCEL
Templates
Name Role -+
Detal Detail
Append @ Append v

UTO DEFINE

> CLEAR

TRAPPING REPORT VERIFY
-l @
g
H Standard M A i
& |
Michael Canton
» e6/01/10
2
»
»
»
» PATIENT INFORMATIONM
I
» Michael Canton
» RR 1 Box 22
» Elmberry MO 63343
2
» Charles Bergan
» 9501 Moody Park
» Over Park KS 66212
»
» Eric Dryson
» 119 Washington St
» Cleveland OH 45215

Bill Amount
183839
799512

JMN REGION DOCUMENT OPTIONS
t REPLACE SAMPLE TEXT = REDACT SAMPLE TEXT CLEARING TEME
e |1 |8 —

hoo28 Son had Funny Bone Surgery
Stitches Health Care Centers
Outpatient Treatment Log

Page 01 -

Period: 05/01/10 - 85/31/10
SVC_CODE SYMPTOMS
Aeo28 Son had Funny Bone Surgery
and Minor attitude problem
BILL: 1838.39
0543 Came to pay bill &
got sick
BILL: 7995.12
ABB32 Hang nail extraction

BILL:

192.00

Figure 4-24. Creating a new template to gather more data from the report.
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7. Let's trap Service Code data. Click into the trap line directly above A in the service code A0028. Using the trap

characters located above the trap line, create the following trap:

£ RESETTRAP

Standard v 'y
b Michael Canton
e6/e1/10

#* REPLACE SAMPLE TEXT i

ABO28
Stitches Health Care Centers
Outpatient Treatment Log
Period: @5/e1/18 - @5/31/10

REDACT SAMPLE TEXT

CLEARING TEMPLATE

Son had Funny Bone Surgery

Page 01 -

Figure 4-25. Creating a new trap to capture the SVC_CODE field.

In the present case, we cannot use an exact trap to capture field data because we expect service codes to
change for each customer. However, we are sure that the service code will always begin with an alpha character

followed by four numeric characters. The trap characters ANNNN instruct Data Prep Studio to search all of the
lines of the report that this specific pattern of characters at the specific location in which it is located. Notice that
all lines containing data corresponding to this trap are highlighted in the report. Guillemets also appear in the line
selection area beside these lines.

£ RESET TRAP

Standard v A
b Michael Canton
a6/e1/1@

PATIENT INFORMATION

% REPLACE SAMPLE TEXT &

B @ | e
Efifufifi
hee28 Son had Funny Bone Surgery

Stitches Health Care Centers
Outpatient Treatment Log

REDACT SAMPLE TEXT

CLEARING TEMPLATE

Page 01 -

» Michael Canton
RR 1 Box 22
Elmberry MO 62343

» Charles Bergan
951 Moody Park
Over Park K5 66212

» Eric Dryson
119 Washington St
Cleveland OH 45215

» Jim Handley
R 2 Box 399

Awtisn TM ATACY
1

Period: @5/@1/1@ - @5/31/1@

SWC_CODE SYMPTOMS

ARB28 Son had Funny Bone Surgery
and Minor attitude problem
BILL: 1838.39

@543 Came to pay bill &
got sick
BILL: 7905.12

ABB32 Hang nail extraction
BILL: 192.6@

ABB43 Daughter had grape juice

stain on upper lip
BT - an on

Figure 4-26. Rows are highlighted if they include data corresponding to the trap characters indicated.

8. Highlight the text Michael Canton, A0028, and Son had Funny Bone Surgery. You can extend your
highlighting a bit to capture names and symptoms that might be slightly longer than you are currently seeing.

All of the data captured by the fields you have just defined display in the Data Preview panel.

Editing Field Properties

When fields are captured during report trapping, you can modify each field’s properties. Renaming fields, which we
did for the first field we captured in this lesson is just one of several properties you can modify.

STEPS:

1. Inthe Data Preview panel, click on header of the field containing the entry Michael Canton so that its properties
display at the bottom of the Template and Field Properties panel. Change the name of this field to Patient Info.
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2. Click Next Field to define a new name for the field containing the entry A0028.

Change the name of this field to Service Code.

4. Repeat Step 2 and then rename the next field Symptoms. Your Data Preview panel should display as follows.

# Bill Amount
]

1835839

2 7995,12 Charles Bergan C0543 Came to pay bill &

3 192.00 Eric Dryson AQ032 Hang nail extraction
4 99.00 Jim Handley AQ045 Daughter had grap...
5 97.25 Marshall Briar AD0E2 De-odorized feet

6 92.00 Henry Thomton AD0S6 Son sat on frog

7 23580 Louis Mc Nally Co440 Daughter has stom...
8 176.00 Kurt Grady ANTY Dog was hysterical

9 241.78 Leo Masterson AQET Tests for chest hair
10 240007 Richard Waite Ales Family had two nee...
11 166.94 Charles Arlo ADZ223 Was studying for

12 211.20 Derrick Thomas A0243 Burping and burping

Ab Patient Info

Michael Canton

Ab Service Code
ADD23

Ab Symptoms

Son had Funny Bon...

Figure 4-27. Newly captured and renamed fields added to our table.

Now, note how, in the original report, the Symptoms field can span one or two lines. The Bill amount
consistently begins on the third line of the record. Unless we make adjustments to the Symptoms field, we will be
unable to capture all of the symptoms written in the original report.

5. Click on the Advanced tab of the field definition for Symptoms. This tab displays several options that will help
you address multiple-line fields. At the moment, all we are concerned with is the end of the multiple-line field.

6. Locate the option End Field On > Line Count.

7. Ensure that the radio button for the option is selected and then use the counter to increase the line count to 2.

Edit Field Properties

START FIELD ON
® Line Number 1

String : anywhere in previous line
Preceding string: in current line

After last defined field in template
END FIELD ON
@® Line count: 2 :
Monblank preceding string of characters
Blank field values:

End of left justification

Any template hit

" DELETE FIELD

Figure 4-28. Specifying advanced settings for a field.
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Note the immediate change in the Symptoms field.

|:| # Bill Amou
1

(= - S R = R L

[
.

12

nt

183839
7995.12
192.00
99.00
97.25
92.00
238.80
176.00
24178
240007
166.94
211.20

Ab Patient Info Ab Service Code
Michael Canton ADDZE
Charles Bergan C0543
Eric Dryson ADO32
Jim Handley ADO4E
harshall Briar AD0B2
Henry Thomton AD09G
Louis Mc Nally C0440
Kurt Grady ANTS
Leo Masterson ADTET
Richard Waite A195
Charles Arlo AD225
Derrick Thomas AD243

Ab Symptoms

Son had Funmy Bone Surgery and Miner attitude problem
Came to pay bill & got sick

Hang nail extraction

Daughter had grape juice stain on upper lip
De-odorized feet

Son sat on frog

Daughter has stomach full of Tootsie Rolls
Dog was hysterical

Tests for chest hair

Family had two needs food & money

Was studying for urine test

Burping and burping and keeps burping

Figure 4-29. Specifying advanced settings can help capture fields completely.

We're almost done!

8. Click Accept on the Report Design toolbar to save the table you have just created and display it in the Prepare

window.

10

1

12

# Bill Amount

w Ab Patientinfo w Ab  ServiceCode w Ab  Symptoms -
N Son had Funny Bone Surgery
1838.39 Michael Canton Ad025 2nd Miner attitude problem
799512 Charles Bergan C0543 Lame to pay bill &
got sick
192.00  Eric Dryson ADO32 Hang nail extraction
. . Daughter had grape juice
99,00 Jim Handley AD045 stain on upper lip
97.25 Marshall Briar ADOB2 De-odorized feet
92.00 Henry Thomton ADD%6 Son sat on frog
. Daughter has stomach
235.80 Louis Mc Nally o440 full of Taots'e Ralls
176.00  Kurt Grady AMITS Dog was hysterical
241.78 Leo Masterson ADIET Tests for chest hair
2400.07 Richard Waite AD195 Family had two needs
food & money
‘Was studying for
166,84 Charles Arlo ADZ25 urine kest
21120 Derrick Thomas AD243 Surping and burping

and keeps burping

Figure 4-30. A new table created from Patients.pdf.
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Using the Recent Files Panel to Load Data

Clicking on the Recent Files button located on the upper left-hand corner of the Start Page or Preview window
displays a panel from which you can view all recently opened workspaces, files, and tables.

Recent Workspaces ~
‘Warkspace_2_Working

Wiarkspace_ 1

RECENT FILES =

Recent Fees A

Beantcwnmdb

Classic-ExeMrapieg six

At Crait_Aress Busin_
dea Tutorisls

] Hima iy wtders o s VeuTube charnel
Recent Connections: »

Documentaticn
Qrickatan |, Helg, andd Tuberial on Ure At secioitc

Altair nalytics
Autcrmals, Shars, Pradicl

pport

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
| Gk g o e Alak Commmusity and Altai Sugpor
]

]

Figure 4-31. The Recent Files panel.

NOTE The Recent Files panel is populated with workspaces, files, and data connections opened
from previous and the current data prep sessions. If you are using Data Prep Studio for the
first time, no data sources and tables will display when you expand this panel.

Selecting any item in this panel opens the related data source or table. This functionality allows you faster access to
your data and eliminates the need for repeated launching of the Select Data Source to Open dialog just to load more
data to the current data prep session.

When clicking on an item in the Recent Files panel, say, an MDB file, all of the tables included in this file are loaded
into the Preview window and made available for bringing into the Prepare window. In Figure 4-32, we selected
Beantown.mdb from the Recent Files panel. The Access Explorer displays. From here, you can select which table(s)
to open in the Prepare window as usual.

Altair Monarch 2024.1 Learning Guide 45
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Figure 4-32. Opening Beantown.mdb from the Recent Data Sources Panel.

Items in the Recent Files panel may be closed (i.e., removed from the data sources list) by hovering your mouse on
the data source you want to close and then clicking on the Remove & button that appears to its right.

Displaying Recent Data Sources in the Select Data Source to Open Dialog

You can view and open recently opened data sources in the Select Data Source to Open dialog.

Select Data Source to Open [m] X
Filter by name or file extension (xs, csv, txt) O\
FAVORITES

DB2 —
= €] £ GET DATA
MONARCH FILE
Informix o - o
PDF & TEXT by e ReceniDalas

Beantown.mdb

SPREADSHEET

- =" Payroll.mdb
DATABASE

Microsoft Access

APPLICATION ;'P Mysat @
BIG DATA ﬁ ODBC @
WEB
ALL i} OLEDB @
[ 5 omme || o ovvwarue ][ 5 oven o | e

Figure 4-33. Viewing recently opened data sources via the Select Data Source to Open dialog.
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Select any item on this list to load it into the Prepare window. Close data sources (i.e., remove them from the list) by

hovering your mouse on the data source file you want to close and then clicking on the Remove & button that
appears to its right.

Select Data Source to Open

Filter by name or file extension (xls, csv, txt)

o Xx
Q

FAVORITES & om2 ®
MONARCH FILE
PDF & TEXT S‘P Informix @ Recent Data Sources
Beantown.mdb X I
SPREADSHEET <  Microsoft Access \
¥ Get Data from Access = Payroll.mdb
DATABASE
MysqL
APPLICATION s @
BIG DATA
ODBC =
5 e
WEB
OLEDB
ALL x? @

‘ OPEN FILE H ‘OPEN WEB FILE H [ | OPEN LIBRARY | CANCEL

Figure 4-34. Closing a recently opened data source via the Select Data Source to Open dialog.

Now that we know how to open data from a table, report, and webpage into the Add Window, we’'ll explore how to
open data from other database types using the Altair Data Connectors. Let's save our current workspace and open
a new one.

SAVING DATA SOURCES TO THE DATA
SOURCE LIBRARY

Data Prep Studio can save tables you opened in the Prepare window the Data Source Library.

When you save a data source or table to this library, Data Prep Studio “remembers” the path or location of this source
and applies it when the same is opened in another data prep session. Thus, you can use the Data Source library to
access commonly-used data sources quickly and seamlessly without using the Open Data Source dialog, previewing
the data source, and selecting individual tables to open.

Let’'s save the Accounting table to the Data Source library.

STEPS:

1. Inthe Prepare window, go to the table selector, and then click on the drop-down arrow to the right of the
Accounting table to display a context menu.
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Figure 4-35. Saving a data source to the Data Source Library.
The Data Source Library displays your newly saved data source.
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Figure 4-36. The saved data source displays in the Data Source Library.

To load a data source from the library, select the Open Library icon from the Data Prep Studio toolbar or Open
Library from the Select Data Source to Open dialog. This action launches the Library dialog. Select the table you
wish to add to your workspace and then click Load Selected.

To perform an action on any data source in this list, select it to activate it and then choose an operation to execute.
You can edit the table path, load the data source, preview the data source, or delete the selected data source.

More information on the Data Source Library may be found here.
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SAVING A WORKSPACE

Your workspace includes:

The data tables you have loaded

The join and append definitions you have created
The transform operations you have carried out

The change histories of the tables you opened

0O 0 0O O

All summaries you have prepared
0O All named exports you have created

You can save your workspace anytime as a Data Prep Workspace file (*.dpwx), and you can load this workspace in
future Data Prep Studio sessions to continue working with your data.

Learn more about your workspace here.

STEPS:

1. Click the Application Menu E button on the Data Prep Studio toolbar and, from the menu that displays, select
Save Workspace.

2. Select one of the following:
Save the workspace on your computer
Save the workspace on your computer with a different name
Save the workspace with a password
Save the workspace with a different name and password
Save to Monarch Server

3. Inthe Save As dialog that displays, navigate to the folder in which you want to save the workspace, enter
Workspacel into the File name field, and then select Save.

4. If you opted to save the workspace with a password, enter and confirm this password in the next dialog that
displays. Select OK when you are finished.

5. If you opted to save your workspace to a Monarch Server container, choose the Container in which to save your
workspace from the dropdown list, enter the new workspace name in the appropriate field of the Save
Workspace to Monarch Server dialog, and then click OK.

Note that this option requires that you have correctly set up a Monarch Server connection in Application Default
Settings > Server.

6. Close the current workspace by selecting Application Menu E > Close Workspace.
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USING THE ALTAIR DATA CONNECTORS

Data Prep Studio allows you direct access to a wide variety of database types through a set of built-in data
connectors.

Select Data Source to Open a X
Filter by name or file extension (xls, csv, txt) O\
FAVORITES

&>  Active Directory ’
y Get Data from Microsoft Active Directory = ! \E GET DATA
MONARCH FILE

Altair Monarch Report Warehouse i
PDF & TEXT ;’} @ Recent Connections
SPREADSHEET ;? Altair Monarch Server Library @
DATABASE

Amazon 53
APPLICATION 55 LO)J
BIG DATA ;? Azure Blob Storage ®
WEB

Azure Data Lake Storage Gen2
ALL 5 9

‘ =) OPEN FILE H 5" OPENWEBFILE || [='| OPEN LIBRARY CLOSE

Figure 4-37. The Altair data connectors.

Data Prep Studio allows you to access data from the following database sources and applications:

0O  Active Directory 0O Microsoft Access 0O  SharePoint
O Altair Monarch Report o MySQL O Snowflake
War.ehouse _ 0 NetSuite O Splunk
a Altafr Monarc.h Server Library 2 ODBC 0 SQL Server
O Business Objects 2 OLEDB 0 SOL Azure
4 DB2 u  Oracle 0 Sybase IQ
- Google Analytics 0  PostgreSQL 0 Amazon S3

- Google Sheets 0O  Salesforce 0O Teradata
- HubSpot O ServiceNow O Vertica

O Informix
It also allows you to access data from the following big data sources:
O  Amazon EMR Hive 0 Hadoop Hive
Amazon Redshift 0 Hortonworks Hive
0 Cassandra 0 IBM Cloudant
0 Cloudera CDH Hive 0 MapR Hive
0O Cloudera Impala 0  MongoDB
0  Google BigQuery 0 Spark SQL
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Finally, data from other sources, such as SAS Transport File Format Versions 5 and 8 and OData, as well as those
from cloud-based storage systems, such as Azure Data Lake Storage Gen2, Azure Blob Storage, Oracle Cloud
Infrastructure, and Google Cloud Storage, are also supported in Data Prep Studio.

To connect to any of these sources quickly and successfully, Data Prep Studio makes use of data connectors.

To obtain access to data using these connectors, specific information, including host name, server name, user ID,
password, and database name, among others, is necessary. Which information you need will depend on the
database to which you are attempting to connect. If you wish to use any of the data connectors, contact your
database administrator to obtain the necessary connection details.

While connections to these data sources are beyond the scope of this Learning Guide, the Monarch Help file provides
detailed information on what you'll need to be able to gain access to data residing in these sources. Click here to
learn more.

NAVIGATING TABLES

Tables opened in the Prepare window may be easily navigated in a number of ways.

Navigation Controls

The following controls have been enabled in Data Prep Studio to allow quick movement through a table.
0 Ctrl + Home — Go to first cell of the first row of the table

O  Ctrl+ End — Go to the last cell of the last row of the table

0 Ctrl + Right arrow — Go to right-most cell in the current row
a

Ctrl + Left arrow — Go to the left-most cell in the current row

Working with Rows

The row number of any given table is provided at the bottom of your workspace. To go to a specific row in your table,
simply enter the row number you wish in the row field provided. To go to the first and last rows of the table, click on

the First Row M and Last Row B8l buttons, respectively. The Previous Page and Next Page buttons take
you to views of previous and next pages of data, respectively.

\— Row: “ of 149 %

Figure 4-38. Viewing the row count of a table.

You can increase row heights by selecting the Row Height button to fit multi-line data into your rows.

Searching for Data

You can search for specific data in tables by using the Search field located at the bottom of your workspace. Enter

the string you would like to search for and then either press Enter on your keyboard or click the Search for Next i
button located to the right of this field. The first cell including the string you are searching for is highlighted. Keep

pressing Enter or clicking the Search for Next Bl button to locate all instances of this string. To reverse the search

direction, click on the Search for Previous button. If you wish, you can also cancel a search that has not been
completed by clicking the Cancel button that displays during a search operation.
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Figure 4-39. Searching for data in a table.

Showing Nulls and Whitespace Characters

Two buttons, which appear at the lower right-hand corner of the Prepare window, have been enabled in Data Prep

Studio to help you visualize your data better. The Show Nulls
fields). Clicking on the Show Whitespace Characters i

between text characters; these whitespace indicators display as ®, —, and <J, respectively.

Docking/Undocking Tables

button helps you see null values (i.e., empty

button displays spaces, tab indents, and line breaks

Docking a table helps you view multiple tables at once or move them to a different location, for example, a second
monitor. To undock a table, right click on it from the Prepare window table selector and then select Undock Table
from the options that display. You can also just drag the table anywhere on your screen. This action undocks the

table and allows you to move it anywhere you wish. To dock a table, select the Dock Table

the upper right corner of an undocked table. This table is returned to the main interface.

Viewing Column Counts

oy

icon that appears on

The number of columns, both visible and hidden, in a data source is shown at the bottom-right of the Prepare

window.
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LOADING A WORKSPACE

Let’'s load the workspace we saved as Workspacel to continue with our tutorial.

STEPS:

1. Select Application Menu E > Open Workspace.

2. In the Open dialog that displays, go to the folder in which you saved Workspacel, select this file, and then click
Open.

All of the tables you loaded into Data Prep Studio, joins and appends you created, and transform operations you
performed are displayed.
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Figure 4-40. All transformations to tables saved into a Workspace file are automatically performed when the file is
loaded into Data Prep Studio.

NOTES When a saved workspace is opened, Data Prep Studio attempts to load all of the tables
added to the workspace using the file paths provided in a previous session. But what if the
paths to these tables are changed or the table are renamed? Learn more about file
reconciliation here.

Several data sources available in previous versions of Monarch Data Prep Studio (i.e.,
versions 2022.1 and older) were deprecated in the 2023 version of the application and
replaced with new ones. Thus, workspaces and library files containing tables obtained using
older data connectors will not open properly unless these connectors are upgraded. You
can perform either a manual upgrade of these deprecated tables as described here or a

bulk upgrade using Monarch Utility.
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JOINING DATA IN A DATA PREP SESSION

Data Prep Studio allows the following join types:

a O Left outer join

A left outer join retains all of the rows of the “left” table, regardless of whether or not there is a row that matches
on the “right” table.

a O Right outer join

A right outer join retains all of the rows of the “right” table, regardless of whether or not there is a row that
matches on the “left” table.

a Full outer join

A full outer join returns all rows from the left and right tables. The full outer join combines the results of both left
and right joins.

-~ Inner join

An inner join yields the intersection of two tables, i.e., only the rows they have in common.

These joins essentially allow you to create new tables from preexisting ones so that you can get more information out
of your data and more detail into future visualization or analytics work.

But what if you wanted more information on the data that can’t be joined? In this case, negative joins are what you
will need to generate. You can create a left negative join, which shows all rows from the right table for which the join
keys do not match, or a right negative join, which shows all rows from the left table without matching join keys. If
you want to create lookups, you can do so using the Join Configuration dialog too. More information on this topic is
available here.

In this exercise, we will join data from two tables. Following the steps outlined in Adding Data to a Data Prep Session
— Adding Data from a Database, load the table in Payroll.mdb into Data Prep Studio.

STEPS:

1. Select Combine from the Data Prep Studio toolbar to launch the Combine stage.

All of the tables you loaded are displayed on the table list to the left of the screen. Note that the table
Compensation must display at the bottom of this list if you successfully opened Payroll.mdb in Data Prep
Studio.

2. Drag Accounting from the table list and into the first Drag a Table box. This table will be the “left” table of the
join.

3. Drag Compensation from the table list and into the second Drag a Table box. This table will be the “right” table
of the join.

4. Select the Click to Join button that displays on top of these tables.

The Join Configuration dialog displays.
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Figure 4-41. The resulting Join Configuration dialog.

In this exercise, we will join the two tables via an inner join (i.e., we only want to see rows where key fields from
both tables match).

5. Ensure that Standard displays in the Type drop-down and then select the Inner Join icon
available icons located below the Type field in the Join Configuration dialog.

6. Select Emp_ID as the key field for the Accounting table.
7. Select Emp_ID as the key field for the Compensation table.

8. Click on the check mark to the left of Emp_ID in the Compensation column section to deselect it. This step
instructs Data Prep Studio to exclude the column in the table output.

9. Select OK.

The resulting table is created and added to the table list. A preview of the table resulting from this join also
displays in the Join stage workspace.
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In the Prepare window, the joined table is named, by default, Join. Succeeding joins will be named Join(1),
Join(2), and so on. These tables can be renamed to whatever you wish.
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Figure 4-42. The results of our join operation.

10. Selecting Prepare on the Data Prep Studio toolbar shows the full contents of this new table.
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Figure 4-43. The newly defined table in the Prepare window.
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Analyzing Joins
Data Prep Studio includes Join Analysis functionality to help you decide which joins will likely produce the best
results. This functionality may be accessed by selecting Recommend Keys in the Join Configuration dialog.

The Join Analysis dialog that displays provides suggestions as to which join fields may be combined to yield the most
number of results.

Join Analysis: Accounting + Compensation O X
D]
T Choose a type of join to see -
(+) Standard
Type &) Standar v the list of options E

Only rows for which the join keys match will be kept from either table.

Ab Ab Ab
63% 34% 27%

Ab Ab
27% 27%

Figure 4-44. The Join Analysis dialog.

Hovering over each of the boxes in the dialog displays more information about the suggested join.

Join Analysis: Accounting + Compensation o X

w4

Choose a type of join to see

RS () Standard M the list of options

\

\

1

i

;

\

\

1

!
Options

Only rows for which the join keys match will be kept from either table.

Ab Ab Ab
63% 34% 27%
Left join key: Emp_ID
Ab Right join key: Emp_ID
Accounting row count: 6
27 Compensation row count: 100
63% confidence
6 rows

Click to add join key pair.

Figure 4-45. Viewing information of the suggested join.

If you are satisfied with the projected join result, simply click on the box corresponding to the proposed join. The Join
Configuration dialog displays and you can proceed with Step 8 of the instructions described above.
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Creating a New Join

If you would like to create a new join after completing a previous one, select the Create New Join Gb button located
on the upper right-hand corner of the Join stage. Doing so removes all tables already placed in the Join stage, as well
as any previous join defined. You can now begin creating a new join.

Using Fuzzy Joins

When joining data, Data Prep Studio makes an allowance for potential errors in spelling that would result in a
mismatch even when the keys are highly similar (e.g., "bond" vs. "bund"). Such issues are addressed by using fuzzy
joins.

Fuzzy joining is activated by ticking the Use Fuzzy Matching for Text Column Pairs checkbox located near the
bottom of the Join Configuration dialog.

Edit Join O X
Name Join

Type () Standard ~ Choose a type of join to see the list of options

Only rows for which the join keys match will be kept from either table.

Accounting Rows: 12 Compensation Rows: 100
Emp D Emp_ID P
&
Search Columns Q, || Search Columns Q
W Select columns W Select columns
/ Department Abgf | of EmeID Ab o
o/ lastName Abgf | f Salary # &
J First Name Ab Ef J Bonus # d/;
 EmpID Ab of
J Hire Date @ },)4
J Gender Ab @4!
Always include all columns 9 Always include all columns e
Case-sensitive for Text Column Pairs
' Use Fuzzy Matching for Text Column Pairs Accuracy Threshold: 80%
Add Columns for Fuzzy Matching Results *

# Row: 453 RECOMMEND KEYS “ CANCEL

Figure 4-46. Activating Fuzzy Matching in the Join Configuration dialog.

The options that display when fuzzy matching is employed allow you to specify an accuracy threshold for matching
and whether or not to include columns detailing the fuzzy matching results in the table obtained from the join.

Note that join keys MUST be defined before fuzzy matching can be accomplished.

More information on fuzzy matching may be found here.
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WORKING WITH LOAD PLANS

When you join, append, or transform tables, the resulting table displays in the table selector of the Prepare window as
follows:

Accounting -

Compensation -

Figure 4-47. The Load Plan of a table resulting from join, append, or transform operations.

Clicking on the = icon of the main table minimizes the table display as follows:

Figure 4-48. The minimized table display.

The tables that display under a joined, appended, or transformed table (i.e., the “parent” tables) enable you to
visualize which specific tables were employed to obtain the newer table (i.e., the “child” table). This functionality is
called load plan visualization.

Because joins, appends, and transforms are NOT recorded as changes, these operations will not display in a table’s
change history and you may be unable to recreate child tables easily, especially when working with the same
workspace at a later date. Load plan visualization addresses this issue by allowing you to recreate new tables from
previously existing ones: you'll know exactly which tables to use and what operation to apply to obtain a desired
table.

Note that when pre-existing tables are combined to create new ones, the former are displayed below the latter.

Accounting -

Data Processing - Accounting -
Marketing - Compensation -
— Classic - Data Processing -
- Classic.pdf Marketing -
DragDropCSV - — Classic -
Compensation : |_) - Classic.pdf

DragDropCSV -

Figure 4-49. Movement of tables in aload visualization plan.

As with any other table in the Prepare window, clicking on the drop-down icon located to the right of child tables
allows you to edit the operation and pin and refresh the table. You can also rename or close the table, duplicate the
table (including all other tables used to achieve it), and discard the operation. In case of the latter, the child table
disappears and only the parent tables remain.

Altair Monarch 2024.1 Learning Guide 59



APPENDING DATA IN A DATA PREP SESSION

When working with reports that are generated periodically, such as monthly sales receipts, you may wish to combine
them to produce a larger dataset on which you can base future business decisions. Data Prep Studio provides a
convenient means to combine tables with an identical schema via appends.

Appending Data in the Prepare Window

You can append tables in the Prepare window through two routes: via the table context menu or the Edit Append
dialog.

Appending Data via the Context Menu

For this exercise, open and load the tables of Beantown.mdb.

STEPS:

1. Using CTRL+click, select the tables Data Processing and Marketing in this order.

NOTE You can select multiple tables from the table selector only if they are of the same rank (e.g.,
they belong to the same hierarchy in their respective load plans).

2. Right-click on your mouse and then select Append Tables >.
You may opt to:
Match columns on name
This option appends all tables based on name.
Match columns on name and type
This option appends your tables first according to their field names and then according to their field type.
Match columns on order

This option appends your tables according to the order in which you selected them regardless of name or
type. If the data types do not match, the data types of the first table are carried over to the appended table. If
the first table selected has fewer columns than the second table, the number of columns of the first table are
retained.

Match columns on order, name, and type

This option appends your table first according to the order in which you selected them and then according to
their field names and types. This type of append is also called a strict append.

3. Asyour tables are exactly matched, select any of these options listed above.

A new append table, named Append, is created and added to your table selector. Succeeding appends will be
named Append(1), Append(2), and so on. These tables can be renamed to whatever you wish.
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Appending Data via the Edit Append Dialog

The Edit Append Dialog can help you in customizing the append operation. Unlike other append methods, you can
"force" Data Prep Studio to match columns even if they do not have the same location, name, and/or data type.

T) Ab Department w Ab Last Name w Ab First Name w Ab Emp_ID w (%) Hire Date w Ab Gender -
1 Accounting Aldridge Jeff 1552784 10/13/1995 12:00:00 AM M
2 Accounting Daley William 1587390 1/30/1993 12:00:00 AM M
3 Accounting Georges William 1596792 6/4/2005 12:00:00 AM M
4 Accounting Gluck Anna 1593309 3/12/2000 12:00:00 AM F
5 Accounting Jacobson Doug 1601562 10/26/1998 12:00:00 AM M
[ Accounting Marshall Alana 1598264 11/18/2003 12:00:00 AM F
7 Accounting Martins Wayne 1594566 4/12/2001 12:00:00 AM M
8 Accounting Poretsky Teresa 1588940 1/4/1996 12:00:00 AM F
9 Accounting Rosenberg Kelly 1590228 9/2/1997 12:00:00 AM F
10 Accounting Russo Paula 1586498 1/5/1993 12:00:00 AM F
1 Accounting Stancowicz Mary Bath 1503500 10/11/1997 12:00:00 AM F
12 Accounting Woodruff Elizabeth 1600325 6/23/2003 12:00:00 AM F

Figure 4-50. The original Accounting table.

For this exercise, double-click on the Last Name field header of the Accounting table and rename it to “Surname.”
Click on the drop-down button beside this header and then select Column List from the menu that displays to launch

the Column List dialog. Using your mouse, click on the drag-and-drop handle of Surname, drag the field, and
drop it after First Name. Do the same for the Department column and drop it after Gender. Click OK on the dialog
when you are finished.

Your Accounting table should now look as follows:

T’ Al First Name * Ab Surname * Ab Emp_ID w %) Hire Date * Ab Gender w Ab Department -
1 Jeff Aldridge 1592784 10/13/1995 12:00:00 AM M Accounting
2 William Daley 1587390 1/30/1993 12:00:00 AM M Accounting
3 William Georges 1595792 6/4/2005 12:00:00 AM M Accounting
4 Anna Gluck 1593309 3/12/2000 12:00:00 AM F Accounting
5 Doug Jacobson 1601562 10/26/1998 12:00:00 AM M Accounting
[ Alana Marshall 1598264 11/18/2003 12:00:00 AM F Accounting
7 Wayne Martins 1554566 4/12{2001 12:00:00 AM M Accounting
8 Teresa Poretsky 1588940 1/4/1996 12:00:00 AM F Accounting
9 Kelly Rosenberg 1590228 9/2/1997 12:00:00 AM F Accounting
10 Paula Russo 1586498 1/5/1993 12:00:00 AM F Accounting
1 Mary Beth Stancowicz 1553599 10/11/1997 12:00:00 AM F Accounting
12 Elizabeth Woodruff 1600325 6/23/2003 12:00:00 AM F Accounting

Figure 4-51. The modified Accounting table.

Because we've made changes to the Accounting table, it is no longer an exact match to the Data Processing table (to
check, select both tables and then append by order, name, and type — failure of the append indicates some difference
between tables).

Let's use the Edit Append dialog to match these tables and produce a table with only the Department, First Name,
and Surname fields.
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STEPS:

1. Select the tables Accounting and Data Processing. Right-click on your mouse and then select Create New
Append.

Edit Append o X

AUTO MATCH COLUMNS

@® by Name by Name & Type by Order

Target Schema: Accounting Data Processing -— Output Columns =+
Ak First Name Ak First Name v v Ab v Z First Name

Ab Surname -—- d Ab

Ab Emp_ID Ab Emp_ID v VA v 2 EmpiD

¥ Hire Date £} Hire Date v VRN Z Hire Date

Ab Gender Ab Gender v v Ab v Z Gender

Ab Department At Department N4 V| oAb v Z Department

Include Source Name Output Column

Figure 4-52. Edit Append dialog.

The Edit Append dialog is divided into three main panels.

The Target Schema panel displays the columns of the first table, in this case Accounting. The panel in the
middle displays the columns of the second table, in this case Data Processing. Note that if you had selected
Data Processing first and then selected Accounting, the tables in these two panels would be reversed. The
Output Columns panel displays the columns your appended table will have.

The Append operation will automatically attempt to match the columns of your two tables. As seen in the figure
above, most of the columns have been matched correctly by name and type. Columns in the first table selected
that cannot be matched to the columns of the second table must be mapped manually.

2. Under the columns of Data Processing, click on the drop-down of the column labeled “----" and then click Last
Name from the options that display.

This action tells the Edit Append operation that the contents of this column match those of the Surname column
even if they do not have the same name.

3. In the Output Columns panel, tick the box for Surname and then deselect the boxes for Emp_ID, Hire Date, and
Gender. Click OK when you are finished.
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The new table, named Append(1), displays in the table selector.

ANAVZE
EETI C - T ——
b4 Aldridge Accounting Tahoma Ml B
T | Sea Q2 Daley Accounting
- = Georges Accounting Py =
= Join b Gluck Accounting 7 &
. Jacobson Accounting &
Accounting 5 @ Marshall Accounting &
- Martins Accounting =
TR & Poretsky Accounting v}
Rosenberg Accounting z
Append(1) Russo Accounting S
~ Stancowicz Accounting
ST = v Woodruft Accounting
Bass Data Processing
Data Processing < Bittmer Data Processing
Bittner Data Processing
= Ly 0 Condon Data Processing
condon Data Processing
Data Processing < Curtis Data Processing
~ Evans Data Processing
Marketing v Finn Data Processing
Horton Data Processing
= (EE= 5 Howard Data Processing
i Hubbard Data Processing
s Classic.pdf Tsenberg Data Processing
Johnston Data Processing
DragDropCsV v Kelley Data Processing
Lavois Data Processing
Matuso Date Processing
Matuso Data Processing
McPherson Data Processing
Miller Data Processing
Pederson Data Processing
Rivera Date Processing
Ross Data Processing
Talberth Data Processing
Tray Data Processing
Valente Data Processing
Valesquez Date Processing
williams Data Processing
40 Elizabeth Woodley Data Processing T AT

Figure 4-53. The newly appended table.

Appending Data via the Append Stage

Besides joining tables, the Combine button on the Data Prep Studio toolbar also allows you to append tables. In this
case, the tables are joined by name and data type.

STEPS:

1. Onthe Data Prep Studio toolbar, click Combine > Append Tables. The Append Stage displays.

eReview [ PREPARE 4 ® TRANSFORM (g cOMBINE (5] AnAnZE [ ExPoRT

. | Join Tables Qe /ppend Tables
g Join data using join analysis and fuzzy matching Vertically append data to create a combined rowset
2
~ Join -
I: Accounting e
Compensation -
J—
Accounting =
Data Processing -~
~ Append -
I: Data Processing -~
Marketing -
= Classic e Ab First Name ~ Ab Sumname ~ Ab Department - =1 o)
Classicpdf Jeff Aldridge Accounting Tahoma Ml | K
William Daley Accounting
DragDropCSV - William Georges Accounting - -
Gluck. Accounting >7 =f
Jacobson Accounting
Marshall Accounting
Martins Accounting
Poretsky Accounting
Rosenberg Accounting
Russo Accounting
1" Stancowicz Accounting
12 Woodruff Accounting
13 Bass. Data Processing
14 Bittner Data Processing
15 Bittner Data Processing
1% Condon Data Processing
17 Condon Data Processing
1 Curtis Data Processing EDIT APPEND

Figure 4-54. The Append stage.
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Drag and drop the tables Data Processing and Marketing into each of the fields marked Drag a Table in the
Append stage workspace. You can add as many tables as you wish to the append provided that these tables
feature identical schema.

NOTE When creating a new append, you cannot select the exact two (or n) tables used to create a
previous append.

2. Click the Click to Append button that displays to the right of these tables and select Prepare from the Data Prep
Studio toolbar.

COMBINE ANALYZ » EXPORT

b Join Tables PSR /prend Tabies =
P o Join date usivg join analysis and Rizzy matching Verlicalty append data o create a combined rowset il
+
— Join -
|: e =
Compensation -
1 Data Processing X
— Append(1) -
t Accounting - 2 Marketing X
Data Processing -
— Append -
I: Data Processing -
- Classic v - Ab Last Name - A First Name. - Ab Emp_ID & Hied
Classic pdf April Anne 1507429 Tehema | i
2 Eanning David 1607768
DragDropCsV - 3 Marketing Bartholemew Ame 1599642 =
4 Markatng Bradford Eugene 1605796 v =
5 Markemng carksan Stephen 1588509
s Carpenter Rae A 1598699
7 Chandler Lz 1588291
3 Cohen Danmy 1595025
s Connely wilizm 1503726
) Desmaras: 3ot 1503218
1 Marketng Fallon Joshua 1506297
2 Marketng Hampsted Armstrong 1593898
15 Marketng Hendridson Robert 1589538

1 Marketng Hil Francis 1606310 L
Horgzn Maggie 1508135 2%
Ingles George. 1589165 5
Leiberman Teress 1500496 7t
Manfresti Insenh 150R740 3T EDIT LOAD OPTIONS

Figure 4-55. Completing the append operation.

The appended table is added to the table list panel.

#) comBINg AMALYZE > EXPORT

“O & © At Department  Ab Last Name - A First Hame - Ab Emp_ID
- 4 Data Processing Bass Androw 1593211 |
I a 2 2 Data Processing Bittner Herb 159759
" 3 Data Processing Bittner Martha 1604193 - =
= Jain - 4 Data Processing Condon James 1597266 > =)
- 5 Data Processing Condon Roberta 1590086
Accounting - 6 DataProcessing curtis M 1599507
7 Data Processing Eans Marena 1592913 CRE-
Compensation ~ & Data Processing Finn Amald 1504470 E ]
] Data Processing Hortan Alice 1598482 W | T
—  Appendl(1) - 10 Data Processing Howard Rae Ann 1588939 u |3
_ n Data Processing Hubbard Lynn 1593319 L&
Accounting ~ 12 Data Processing Isenbery Giwen 1584545 42
13 Data Processing Johnston Banry 1601801 1217
Duta Processing = te Data Processing Kelley Mary Beth 1593184 3
il Data Processing Lavos Francis. 1603243 1042
16 Data Processing Matusa Linda 1587768 12/
1 Data Processing Matuso Mtz 1582711 1011
Data Processing hd "® Data Processing McPherson Stephen 1596204 &1
1 Dats Processing Miller George 1590305 £l
iacketing s 20 Data Processing Pederson Liz 1598320 &2
1 Data brocessing wnera Barry 1567812 v
= Append = 22 Data Processing Ross Dan 1589748 9
23 Data Processing Taberth Chis 1592816 5
Data Processing = 34 Data Processing Tracy Robert 1504225
25 Data Processing Valente Hex 159309
== ~ 25 Data Processing Valesquez Marietta 1602228
1 Data Procassing Wilkams Doug 1594447
= Classic - 2 Data Processing Woadiey Eizabeth 1597197
] 2 Marketing Rl Anae 1557429
Classicpdf 1 Marketing Banaing David 1607768
3 Marketing Eartholemew Anne 1593642
DragDropCSV v 2 Marketing Bratfond Fugene 160579
] Marketing Carksan Stephen 1588509
34 Marketing Carpenter Rae Ann 1598599
3 Marketing Chandier Lz 1588291
3 Marketing Cohen Dany 1595028
31 Marketng Connely vallzm 1593726
¥ Marketing Desmaras 2eff 1593219 1
® Marketing Fallon Joshua 1596297 L
a Marketing Hampsted Armstrong 1593898 31,

EDIT APPEND

Figure 4-56. The resulting appended table.
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TRANSFORMING DATA

L s
A Transform pane is launched when you cIick on the Data Prep Studio toolbar. This panel provides
further options that will allow you to quickly change how your tables look and how your data are grouped. To reverse
a transformation, click on the drop-down arrow to the right of the transformed table and then choose Discard
Transform from the options that display. To edit a transformation, repeat these steps but select Edit Transform
instead.

Sorting Columns

Sorts allow you to arrange the records on a table according to the ascending or descending values of one or more
columns.

Data Prep Studio allows you to sort columns from several points:
0 From the context menu of a column
0O  From the context menu of a table (via the Sort dialog)

Sort O X

New Table Name

Sort

Sort Name Sort Type Change Order

Select columns to sort by clicking the key icons

(A
o)
»

\Z

Department

>0
o)

Last Name

-

Q)
=

First Name

AN

!

CANCEL

Figure 4-57. The Sort dialog.

More information on sorting columns can be found here.

Pivoting Columns

Pivots allow you to transform column values into column headers, thereby changing the look of your data from
tall+skinny to short+wide.

For this exercise, open Classic.pdf. In the Report Design window, we create the following traps to extract the
indicated fields:
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0  Media

-la
Templates “ £ RESET TRAP £ RESET FIELDS i REPLACE SAMPLE TEXT 7 REDACT SAMPLE TEXT
8
Name Role + ; Standard v i N e @ | e
@
Detail @ Detail v g i
2 4 Bartok, Sonata for Seclo Vieolin MR-42625 8.5% 35.5%6
AUTO DEFINE > CLEAR = USE -
Edit Field Properties ACCOUNT NUMBER: 11887
CONTACT: Betty Yoder
Advanced
MEDIA QTY DESCRIFTION IABEL/NO.  UNT_PRC  AMOUNT
Name Media ORDER NUMEER: 536017 SHIF DATE: 04/10/10
Template Width | 4 - » cD 4 Bartok, Sonata for Solo Violin MR-42625 8.99 35.96
v » 7 Mozart, Mass in C, K.427 420831-2 5.00 €3.00
» 2 ZLuening, Electronic Music €D €11 10.19 20.38
Type Character ~
» DVD S Scarlatti, Stabat Mater SET 48282 5.89 53.81
Decimals (7]
ORDER NUMBER: 536039 SHIP DATE: 04/21/10
Format » cn 11 Besthoven, Pathetique Sonata, Arau 420153-2 5.39 €5.89
» 8 Mendelssohn, War March of the Priests SMR 47552 8.39 71.%2 -

Display Width 5

Match Cas

Alignment Left ~

Ab Media -
| Copy Value from Previous Record

VERIFY
| Leftside | Right Side /| Type

> DELETE FIELD

Figure 4-58. Extracting the Media field from Classic.pdf via Report Design.

0 Amount
BIG)
Templates . £ RESET TRAP £ RESET FIELDS i+ REPLACE SAMPLE TEXT = REDACT SAMPLE TEXT
&
Name Role + H Standard v A R |[s| 8| | |e - |=
a
Detsil @ Detail v g T
= 4 Bartok, Sonata for Solo Violin MR-42625 8.99
AUTO DEFINE % CLEAR = usa -
Edit Field Properties ACCOUNT NUMBER: 11887
CONTACT: Betty Yoder
Advanced
MEDIA QTY DESCRIFTICN LABEL/NO. UNT_FRC AMOUNT
Name Amount ORDER NUMBER: 536017 SHIP DATE: 04/10/10
Template Width | 8 - » cD 4 Bartok, Sonata for Solo Violin MR-42625 8.99 35.96
he » 7 Mozart, Mass in C, R.427 420831-2 5.00 €3.00
» 2 Luening, Electremic Music cD €11 10.13  20.38
Type Numeric ~
» DVD 3 Scarlatti, Stabat Mater SBT 48282 5.99 53.51
Decimals 2 v [ sean |@
ORDER NUMBER: 536039 SHIP DATE: 04/21/10
Format General v | SETALL | » cn 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.39 €5.89
» & Mendelssohn, War March of the Friests SMR 47592 8.99  71.92 -
Display Width s &
Alignment Right -
) Ab Media # Amount -
Copy Value from Previous Record s 55
VERIFY 2 63.00
| LeftSide /| RightSide | Type 3 co 20.38
4 DVD 53.91
« PREVIOUS FIELD — NEXT FIELD 5 co 65.69
6 CD 71.92
< DELETE FIELD 7 co 95.90
§ LP 64.74
- 9 DV 35.94 -

Figure 4-59. Extracting the Amount field from Classic.pdf via Report Design.
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0 Customer

b

Templates - %> RESET TRAP £ RESET FIELDS it REPLACE SAMPLE TEXT & REDACT SAMPLE TEXT CLEARING TEMPLATE
8
Name Role + H Standard v A R 8 -] | e
@
Detail Detail 5
= customer
=
Append @ Append v €] & eoEe Tl -ty s Music Store

05/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01 N
. 10:17 MONTHLY SHIPPING REPORT
AUTO DEFINE X CLEAR MSR94 FROM 04/01/10 TO 04/30/10

Edit Field Properties

» CUSTOMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
General T Cedar Falls, IA 50613
usa
Name Customer ACCOUNT NUMBER: 11887
s
Template Width | 35 CONTACT: Bstty Yoder
Type Character M
MEDIA QTY DESCRIFTION IABEL/NO. UNT_FRC  AMOUNT
Decimals Q ORDER NUMBER: 536017 SHTP DATE: 04/10/10
Format ~n 4 Ravrnb  Sanata far =ala wialin ae—anEas 2 as 25 ac hd
58 age: 1 Selected Line: TR | ———
Display Width 35 4 A~ ~ || wap ] Match Ca: Page: 1 Selected Line:6 Position: 9
Ab Media # Amount Ab Customer -
Alignment Left e 1 oo 35.96 Befty's Music Store
Copy Value from Previous Record 2 oo 63.00 Befty's Music Store
3 o 2038 Befty's Music Store
VERIFY
4 Dw 5391 Befty's Music Store
V| LeftSide || Right Side |« Type 5 cD 6589 Befty's Music Store
6 ©D 7192 Betty's Music Store
7 ©D 95.90 Betty's Music Store
8 P 6474 Befty's Music Store
~( DELETE FIFLD 3 DvD 3594 Befty's Music Store =

Figure 4-60. Extracting the Customer field from Classic.pdf via Report Design.

The resulting table should look as follows in the Prepare window.

Ab Mediaw # Amount w Ab Customer -

1 cD 35.96 Betty's Music Store
2 cD 63.00 Betty's Music Store
3 cD 20.38 Betty's Music Store
4 DVD 53.91 Betty's Music Store
5 cD 65.89 Betty's Music Store
8 cD 71.92 Betty's Music Store
7 D 05.90 Betty's Music Store
g LP 54.74 Betty's Music Store
9 DVD 35.94 Betty's Music Store
10 D 53.94 Big Shanty Music

1 cD 9.00 Big Shanty Music

12 cD 26.97 Big Shanty Music

13 D 57.54 Big Shanty Music

14 cD 10.78 Big Shanty Music

15 SACD B6.31 Big Shanty Music

16 DVD 20,95 Big Shanty Music

17 cD 53.94 Bluegrass Records
18 cD 10.80 Bluegrass Records
19 cD 57.60 Bluegrass Records
20 SACD 71.92 Bluegrass Records
21 DVD 53.91 Bluegrass Records
22 cD 96,00 Musique du Monde
23 cD 48,00 Musigue du Monde
24 cD 38.95 Musique du Monde

Figure 4-61. The resulting table extracted from Classic.pdf.
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Now we'’re ready to pivot your columns.

STEPS:

1. From the Prepare window, select Transform > Pivot to display the Pivot Column dialog.

=
2. Inthe Choose Columns portion of the dialog, click the Pivot '@ icon to the left of the Media column.
In the Group Columns portion of the dialog, tick the box for Group on all columns.

4. Inthe Choose Columns portion of the dialog, tick the box of the Amount column and ensure that the Aggregate
Type assigned is Sum.

5. Tick the box for Disable column suffix.

X

Pivot (m]

MNew Table Name

Pivot

Pivot | Case Sensitive Sort pivot columns

Pivot Group Type Name Change Order

@ Ab Media

Group Columns | Group on all columns
Choose Columns | Aggregate | Disable column suffix
Q,
. Pivot Group Type Name Aggregate Type
v '\[% f}"‘ Amount Sum e
'@ Ab  Customer Check to include

Figure 4-62. The Pivot Column dialog.

6. Select OK when you are finished.
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Your table should be transformed as follows.

EE Ab Customer - # CD v # DVD < # LP w # SACD « # BLU -
1 Betty's Music Store 353.05 89.85 64.74
2 Big Shanty Music 158.23 29.95 86.31
3 Bluegrass Records 122.34 53.91 71.92
4 Canciones 379.14
5 Chez Rudy 275.51 44.95
[ Classic Exchange 209.08
7 Das Piano 225.93 41.93 111.46 161.82
8 Die Harmonie 100.04 64.46
9 Die Melodie 362.56 23.96 86.31
10 Fandangos Records 213.80 11.98
" Hope's Sweet Notes 481.06 59.90 43.11 77.90
12 Mo Town Tunes 211.03 23.96
13 Musigue Royale 515.17 B0.26
14 Musigue du Monde 405.91 47.92 95.90
15 Notas Musicales 168.94 10.78 62.16 83.08
16 Reiner's Symphonic Sounds 361.29 68.28 32.95
17 Spinning Records 317.66 B9.85 11.98
18 The Glass Harmonica 211.56 67.20 9.59
19 The King's Place 203.02 25.13 105.49
20 The Record Store 250.59 £0.00 17.97

Figure 4-63. The pivoted table.

Unpivoting Columns

Unpivoting All of the Pivoted Columns of a Table

When all of the pivoted columns of a table are unpivoted, the data are returned to their tall+skinny look.

STEPS:

1. Click on the table you pivoted in the previous lesson in the Prepare window and then select Transform >
Unpivot.

2. Inthe Attribute Columns portion of the Unpivot dialog that displays, ensure that all columns are selected.

g5y

3. Click the Unpivot r;“_g/ icons to the left of the columns CD, DVD, LP, SACD, and BLU. These columns should
move to the Unpivot Columns portion of the dialog.

3. Click OK.

Your table returns to its original schema.

Now you can use Data Prep Studio’s Split or Extract functions to revert entries in the Value column to their
original values.

NOTE If you are unpivoting all of the columns you pivoted in a table, effectively completely
reversing your change, you can also simply click on the drop-down icon located to the right

B8

of the pivoted table and, from the options that display, select Discard Transform m,
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Unpivoting Select Columns of a Pivoted Table

When you opt to unpivot select columns of a pivoted table, you are effectively instructing Data Prep Studio to display
the data (values) of these columns (attributes) in a left-to-right manner but keep all other fields and their associated
data in their top-bottom form.

In this case, an Attribute column, which will contain the name(s) of the column(s) you unpivoted, and a Values
column, which will contain all of the data corresponding to these columns, are created. Depending on the number of
columns you choose to unpivot, the new table created could be much shorter than the original pivoted table.

STEPS:

1. Repeat the Pivoting Columns exercise to obtain a pivoted table. Ensure that this table is displayed in the Prepare
window.

2. From the Data Prep Studio toolbar, select Transform > Unpivot.
The Unpivot Columns dialog displays.
3. Inthe Attribute Columns portion of the Unpivot dialog that displays, ensure that all columns are selected.
4. Click the Unpivot @ icon to the left of the column BLU. This column should move to the Unpivot Columns
portion of the dialog.
5. Check the box for BLU and then select OK.

The newly transformed table displays as below.

E; Ab Customer v # CD w# DVD w # LP w # SACD w Ab Attribute * # Value
1 Hope's Sweet Notes 481.06 39.90 43.11 BLU 77.90
2 Musique du Monde 405.91 47.92 BLU 95,90
3 Notas Musicales 168.94 10.78 62.16 BLU 85.08
4 The Glass Harmonica 211.56 67.20 BLU 9.59
5 The Record Store 250.59 60.00 BLU 17.97

Figure 4-64. The newly transformed table.

Transposing Columns

The Transpose transformation allows you to use the rows of a column (vertical display) as column headers
(horizontal display).

STEPS:
1. Inthe Prepare window, select the table you wish to transform.
Click Transform > Transpose to display the Transpose dialog.
3. Select the corresponding radio button if you wish to:
Transpose on first column
Transpose with generic column headers

The dialog shows examples of what column changes occur when either option is selected.
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Transpose O X Transpose a
MNew Table Name MNew Table Name
Transpose Transpose
@® Transpose on first column Transpose on first column
Transpose with generic coelumn headers @® Transpose with generic column headers
A B A 1 3 A B F1 F2 F3
EG 1 2 2 4 E.G 1 2 A1 3
34 34 B2 4

Figure 4-65. The Transpose dialog.

4. Click OK when you are finished.

Grouping Data

The Group By transformation allows you to classify or consolidate rows that belong together according to some

common value within the row. When you consolidate the records, you can also select column values to aggregate.

Let’s use the original table in the Pivoting Columns exercise to group our data.

= A Media+ # Amount w Ab Customer -
1 cD 35.96 Betty's Music Store
2 cD 63.00 Betty's Music Store
3 cD 20.38 Betty's Music Store
4 DVD 53.91 Betty's Music Store
5 cD 65.89 Betty's Music Store
8 cD 71.92 Betty's Music Store
7 cD 95.90 Betty's Music Store
8 LP 64.74 Betty's Music Store
9 DVD 35.94 Betty's Music Store
10 cD 53.94 Big Shanty Music
1 cD 9.00 Big Shanty Music
12 cD 26.97 Big Shanty Music
13 cD 57.54 Big Shanty Music
14 cD 10.78 Big Shanty Music
15 SACD B6.31 Big Shanty Music
16 DVD 29.95 Big Shanty Music
17 cD 53.94 Bluegrass Records
18 cD 10.80 Bluegrass Records
19 cD 57.60 Bluegrass Records
20 SACD 71.92 Bluegrass Records
21 DVD 53.91 Bluegrass Records
22 cD 96.00 Musigue du Monde
23 cD 48.00 Musigue du Monde
24 cD 38.95 Musigue du Monde

Figure 4-66. Data to be grouped.

Altair Monarch 2024.1 Learning Guide

71



STEPS:

1. From the toolbar, select Transform > Group to display the Group dialog.

For the table above, let's group all media sales so that only the total amounts for each customer are displayed.

. o). . . .
2. Click the Group @f icon of the Customer column so that it moves to the Group Columns portion of the dialog.

3. In the Value Columns portion of the dialog, ensure that the box to the left of the Amount column is ticked and

that its Aggregation Type is Sum.

4. Ensure that the box to the left of the Media column is unchecked.

Group

MNew Table Name

' Case Sensitive

Group Columns

[m] X

Group Type Name

@ Ak Customer

Value Columns

a

. Group Type Name Aggregate Type

(& Ao Meda
4 @ ff Amount

Check to include

Sum ~

Figure 4-67. The Group By dialog.

5. Select OK when you are finished. Your new table displays.

Betty's Music Store
Big Shanty Music
Bluegrass Records
Canciones

Chez Rudy

Classic Exchange
Das Piano

Die Harmonia

Die Melodie
Fandangos Records
Hope's Sweet Notes
Mo Town Tunes
Musigue Royale
Musigue du Monde
Notas Musicales
Reiner's Symphonic Sounds
Spinning Records
The Glass Harmonica
The King's Place

20 The Record Store

E; Al Customer
—
2
3
4
5
6
7
8
9

[ Y () Y T R T R g
W e~ s W MN= O

w # Sum{Amount)

507.64
274.49
248.17
379.14
320.46
209.08
541.14
164.50
472.83
225.88
661.97
234.99
595.43
549.73
326.96
462.52
419.49
288.35
333.64
328.56

Figure 4-68. The table resulting from a Group By operation.
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Removing/Showing Duplicates

You can remove or show duplicate rows from tables by selecting Transform and, in the dialog that displays, clicking
the Duplicates option.

STEPS:
1. In the Prepare window, view the table from which you want to remove duplicate rows to remove and then select
Transform > Duplicates. The Duplicates dialog displays.
2. Select the deduplicate operation to apply to your table from the drop-down provided
You can:
Remove Duplicates - Keep first row
Show Duplicates - Show all except first row
Flag Duplicates - Mark with new column
3. Select the columns to evaluate for the deduplication operation by clicking on the Key icon located to the left of

each column of interest.

Duplicates m] X
New Table Name

Duplicates
Deduplicate Operation

Flag Duplicates - Mark with new column ~

' Case Sensitive

Use All Columns as Keys @ Use Selected Columns as Keys (click key icons to select)

Q

<

v [: )l Ab Customer -
v f@l # Account Number
v f@l Ab Contact
= m
v &) ra Order Number
v (@& © shipdae
v (@ s Medaay
v f:D\:' * Media Qtvl M

CANCEL

Figure 4-69. The Duplicates dialog.

Tick the boxes of the columns you wish to display in the table resulting from the deduplication operation.
Click OK.
The resulting table displays.

More information on how to remove duplicates from tables may be found here.
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Extracting Rows

To extract empty rows or rows with empty values in a table, select Transform from the toolbar and then click Extract
Rows.

You can:

0  Exclude all rows where all key columns contain no content, nulls, or whitespace only

0O  Exclude all rows where any key column contains no content, nulls, or whitespace only

0 Include all rows where any key column contains no content, nulls, or whitespace only

Extract Rows a X

New Table Name

Extract Rows

Extract Operation

EXCLUDE all rows where ALL key columns contain: ~

| No Content || Nulls |/ Whitespace Only

Use All Columns as Keys @ Use Selected Columns as Keys (click key icons to select)

Q,
e Type Name
l’gﬁ/\l Ab Customer
(@) Ab  Media gty
l?-)/\l # Amount
CANCEL

Figure 4-70. The Extract Rows dialog.

Learn more about this topic here.
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WORKING WITH CALCULATED FIELDS

The ability to create calculated fields is among the more important data prep operations you can perform. Calculated

fields can be created from text, date/time, and numeric fields.

A complete list of the functions available in the New Formula Column dialog, as well as their definitions and

examples, may be found here.

New Formula Column

Field Name: Formula Column

Fields Functions Operators
All All Functions +
Ab Last Name Acos()
Ab First Name Agel,)
Ab Emp_ID Ascl)
74 Hire Date Asing) =
Ab Gender Atan() e
Atan2(} <
Basef4Decode() =
BasebdEncode()
CalendarWeek() =
Ceiling() (date}
CharToSeconds() ‘Regex
Chr() ()
Cos{) [1
Cot) - -
Expression
| -
Department
®

CANCEL

Figure 4-71. The New Formula Column dialog.

For this exercise, let's compute what the unit prices of various media from the Classic.pdf report would be if we
applied a 10% discount to them.

STEPS:

1. From the Classic.pdf report, extract the fields marked by Betty’s Music Store (Customer), Bartok, Sonata for
Solo Violin (Description), MK-42625 (Label/No.), and 8.99 (Unt_Prc). Load this table into the Prepare window.

Click on the drop-down button beside the Unt_Prc column and then select Column > New Formula Column.
In the New Formula Column dialog that displays, enter Discounted Prices in the Field Name box.
Double-click on Unt_Prc field in the Fields panel so that the field name appears in the Expression box.

In the Operators panel, double-click on the multiplication operator. This operator appears in the Expression box.

o o M WD

Using your mouse, click to the right of the multiplication operator in the Expression box and then type in 0.90.
Select OK when you are finished.
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The New Formula Column dialog closes and a new column is added to your table.

7. Select the drop-down button of the Discounted Prices column and then click Format. In the Format Discounted

Prices dialog that displays, select Financial and then click OK.

Your table is rebuilt.

Ab Customer w Al Description w Ab Label/No. w # Unt_Prc w # Discounted Prices -
Betty's Music Store Bartok, Sonata for Solo Violin MK-42625 8.99 8.09
Betty's Music Store Mozart, Mass in C, K.427 420831-2 9.00 8.10
Betty's Music Store Luening, Electronic Music CD 611 10.19 9.17
Betty's Music Store Scarlatti, Stabat Mater SET 4828 5.99 5.39
Betty's Music Store Beethoven, Pathetique Sonata, Arau 420153-2 5.90 5.39
Betty's Music Store Mendelssohn, War March of the Priests ~ SMK 4759 8.99 8.09
Betty's Music Store Pizzetti, Messa di Requiem CHAN 896 9.59 8.63
Betty's Music Store Misc., Modern Trombone Masterpieces  ADA 5810 10.79 9.71
Betty's Music Store Gershwin, An American in Paris ACS 8034 5.99 5.39
Big Shanty Music Stravinsky, Dumbarton Oaks Concerto SMCD 512 8.99 8.09
Big Shanty Music Schubert, Sonata in e, D.566 AS-325 9.00 8.10
Big Shanty Music Mozart, Symphony No.23 in D CO-77884 8.99 8.09
13 Big Shanty Music Schoenberg, Ode to Napoleon CHAN 911 9.59 8.63
14 Big Shanty Music Shostakovich, 24 Preludes for piano. CDA 6662 5.39 4.85
15 Big Shanty Music Balakirev,Symphony no. 1 ENTPD 41 9.59 8.63
16 Big Shanty Music Huolst, St. Paul's Suite for Orch, CBT-1020 5.99 5.39
17 Bluegrass Records Faure, 28 Songs, Stulzmann RCA 5142 17.98 16.18
18 Bluegrass Records Takemitsu, Music of Takemitsu SMK 5347 3.60 3.24
19 Bluegrass Records Messiaen, Quatour pour la fin de temps  CDC 5493 9.60 8.64
20 Bluegrass Records Strauss, Ein Heldenleben, Op.40 SMSACD-5 8.99 8.09
21 Bluegrass Records Schumann, Manfred Overture, Bav SO SET 4827 5.99 5.39
22 Musigue du Monde Milhaud, 3 Rag Caprices, pn. & orch. Z-6569 9.60 8.64
23 Musique du Monde Strauss, Le bourgenis gentilhomme CDD 448 9.60 8.64
24 Musigue du Monde Scriabin, Preludes, Op. 8 CY 1123 7.79 7.01

Figure 4-72. Adding a calculated field to a table.

FILTERING DATA

You can choose how much data to import from a table into your Data Prep Session by filtering your table and
selecting the data you want to view. Let’s find out how using the table we produced from a PDF report. In this
example, instead of viewing data for 20 customers, we’ll select only 5 customers and load their data into a new table.

STEPS:

1. Open Classic.pdf and then use the Auto-Define button in the Report Design window to extract data from the
report.

2. View the resulting table in the Prepare window.
3. Click the drop-down button beside the Customer column and then select Filter > Define Filter.

The Define Filter dialog displays.

Define Filter O X
Column: Customer v
Expression: Contains ~ ' | lgnore Case

Action: Include ~ | rows that match expression

Figure 4-73. The Apply Filter dialog.
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4. Click on the Expression drop-down and, from the options that display, select Multiple Selection.

A list of all unique values (i.e., Customer names) displays.

5. Using this list, tick the boxes (i.e., Include) for Betty’s Music Store, Big Shanty Music, Bluegrass Records,
Canciones, and Chez Rudy.

6. Select OK when you are finished. The resulting table displays in the Prepare window.

Ab  Customer

Betty's Music Store
Betty's Music Store
Betty's Music Store
Befty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Big Shanty Music
11 Big Shanty Music
12 Big Shanty Music
13 Big Shanty Music
14 Big Shanty Music
15 Big Shanty Music
16 Big Shanty Music
17 Bluegrass Records
18 Bluegrass Records
19 Bluegrass Records

20 Bluegrass Records
21 Bluegrass Records
22 Canciones

23 Canciones
24 Canciones
25 Canciones
26 Canciones
27 Canciones
28 Canciones

29 Canciones
30 Canciones
31 Classic Exchange
32 Classic Exchange

33 Classic Exchange
34 Classic Exchange
35 Classic Exchange
38 Chez Rudy
37 Chez Rudy
38 Chez Rudy
39 Chez Rudy
40 Chez Rudy

‘w # Account Number

¥ Ab Contact

11887
11887
11887
11887
17959
17959
17959
17959
17958
17958
17958
10928
10929
10929
10929
10929
12705
12705
12705
12705
12705
12705
12705
12705
12705
11433
11433
11433
11433
11433
15001
15001
15091
15091
15091

Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Roberto Gil
Roberto Gil
Roberto Gil
Roberto Gil
Roberto Gil

Lidia Rosado
Lidia Rosado
Lidia Rosado
Lidia Rosado
Lidia Rosado
Lidia Rosado
Lidia Rosado
Lidia Rosado
Lidia Rosado
Mike Kelly

Mike Kelly

Mike Kelly

Mike Kelly

Mike Kelly

Marie Thibedeau
Marie Thibedeau
Marie Thibedeau
Marie Thibedeau
Marie Thibedeau

‘w # Order Number

w (% Ship Date

536017
536017
536017
536017
536039
536039
536039
536039
536039
536016
536016
536016
536016
536029
536029
536029
536020
536020
536020
536020
536020
536018
536018
536025
536025
536025
536025
536035
536035
536035
536030
536030
536030
536030
536030
536033
536033
536033
536033
536033

4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/21/2010
4/21/2010
4/23/2010
4/23/2010
4/21/2010

4/5/2010

4/5/2010

4/5/2010

4/5/2010
4/14/2010
4/14/2010
4/14/2010
4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/13/2010
4/13/2010
4/13/2010
4/13/2010
4/18/2010
4/18/2010
4/18/2010
4/15/2010
4/15/2010
4/15/2010
4/15/2010
4/15/2010
4/18/2010
4/18/2010
4/18/2010
4/18/2010
4/18/2010

¥ Ab Media Qty

o

o

WD
D

aQ

]

VD
D

a

fal

D
SACD
WD
D

ag

SACD
VD
D

ao

fal

D

fal

D

Q

D

a

D

v # Media Qtyl

¥ Ab Description

4
7

AT
Baobown

LoNNBNE @O WL NN WO oo

5

IR NI

Bartok, Sonata for Solo Violin

Mozart, Mass in C, K.427

Luening, Electronic Music

Scariatti, Stabat Mater

Beethoven, Pathetique Sonata, Arau
Mendelssohn, War March of the Priests
Pizzetti, Messa di Requiem

Misc., Modern Trombone Masterpieces
Gershwin, An American in Paris
Stravinsky, Dumbarton Oaks Concerto
Schubert, Sonata in e, D.566

Mozart, Symphony Ne.23 in D
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Balakirev, symphony no. 1

Holst, St. Paul's Suite for Orch

Faure, 28 Songs, Stulzmann
Takemitsu, Music of Takemitsu
Messiaen, Quatour pour |z fin de temps
Strauss, Ein Heldenleben, Op.40
Schumann, Manfred Overture, Bav 50
Mozart, Symphony in D, K.202

Ravel, Daphnis et Chioe

Handel, Tl pastor fido(opera)

Milhaud, Pastorale for Ob. & Bsn.
Koday, Marosszek Dances

Foss, Capricio for cello and pizno
Fucik, Marinarella, Czech PO

Zappz, The Dog Breath Variations
Telemann, 12 Fantasies for Violin
Reich, The Desert Man, Brookiyn PO
Cowell, Adagio for vc & Thunderstick
Copland, Songs, DeGaetani, Smit
Rimsky-Korsakov, At the Tomb
Purcell, Birthday Ode for Mary IT
Xenakis, Pleiades for Perc. Sextet
Gounod, Romeo et Juliette

Parry, An English Suite

Wert, Sacred Music, Ars Nova
Persichetti, Night Dances, Orch.

¥ Ab Label/No#

MK-42625
4208312
CD 611

SBT 48282
420153-2
SMK 47592
CHAN 8964
ADA 581087
ACS 8034
SMCD 5120
AS-325
CO-77884
CHAN 9116
CDA 66620
ENTPD 4110
CBT-1020
RCA 61428-2
SMK 53473
CDC 54935
SMSACD-5036
SBT 48270
CD-80186
425997
2-HOD12912
CHAN 6536
2-KPT 32153
KIC 7070
C-147861
MCD 1116
AN28708
79101-2

CD 6851
BCD 9046
SUCD 10-0018
HMA-190222
CD 482
2-1011
SRCD.220
32001
80396-2

Figure 4-74. The table obtained from a filter operation.

Note that the data of only five customers are displayed.

Different filter operations are available for different field types. Numeric fields, for example, may be filtered by
using ranges or specifying less than or greater than values. To filter date fields, you can specify a date range or

before/after date. For text fields, you can specify strings or select discrete values.
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PREPARING DATA

You can prepare columns in a table to prepare them for future visualization or analytics operations. Data Prep Studio

includes pre-built functions that allow you to quickly and consistently clean your data, turning them into analysis-ready

information. Preparing data in Data Prep Studio is as easy as clicking on the drop-down '™ button located to the

right of each column header. Doing so displays a list of prep operations you can perform on that column.

& Ship Date — — ==l
WApragg  oeach a L
10 Apr 2[][ .;? Collapse Changes Unrelated to This Column s
10 Apr 20k % Copy I§c
10 Apr 2[][ @ Copy with Headers it
m[ "2  Create Table from Selection P
O tap 0 anz Filter Y
2rpr2gy - " N

*21 Apr 20[ :E|: Column » 1

e ] |:'/ Column List...

ﬂ[ |<- Alignment » T
> Apr 20[ 9% Convert .
SAPEA B bt e
5 Apr 20§ [ % Merge.. y I8
5Apr 200 =7  Redact... q

14 Apr 200 ¢+ Replace » ¢h
14 Apr 20§ <> Split i
14 Apr 2[][ E_ Statistics [ 1
m[ & Macros - ¥
10 Apr 208 E& Delete Column M

Figure 4-75. Available prep operations for Date/Time fields in the Prepare window.

Summary of Data Prep Operations

The following table summarizes the data prep operations possible in Monarch Data Prep Studio.

Details of each operation may be obtained by consulting Working with Data Prep Studio > Prep Data Column
Operations in the Monarch Help file.

COPY

Copy/Copy with headers Copy either column values only or column values and headers
Create table from selection Create a new table from the cells selected in an existing table
FILTER

Define filter Create a filter for the selected column

Discard all filters Remove all filters applied to a table

SORT

Sort selected columns Sort the column in ascending order
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Use this transformation

Define sort

COLUMN

New formula column

New constant value column

New lookup column

New row number column

New runtime parameter column
Add or remove metadata columns
Rename column

Duplicate column

Show hidden column

Hide column

Delete column

ALIGNMENT
Left

Center

Right

CASE
Make proper case
Make lower case

Make upper case

CLEAN

Remove leading and trailing
spaces

Remove consecutive spaces

Remove specified characters

Remove non-alphanumeric
characters

Remove numeric characters

Remove alpha characters

Altair Monarch 2024.1 Learning Guide

Launch the Sort dialog to create a new sort definition

Add a new formula column to the table

Add a new constant-value column to the table
Add a new lookup column to the table

Add a new row number column to the table

Add a new runtime parameter column to the table
Add metadata columns to your table

Rename the column you selected

Produce a duplicate of the column you selected

Show a list of hidden columns. Selecting a column from this list
displays it in the table once more.

Hide the selected column

Remove the selected column from the table

Align text to the left
Align text to the center

Align text to the right

Convert to uppercase the first letter of each word in a string
Convert the entire string to lowercase letters

Convert the entire string to uppercase letters

Remove all leading and trailing spaces from a string

Collapse multiple consecutive spaces into one space

Remove the sequence of characters from the values of the
column you apply this operation to

Remove all characters that are not numbers or letters (e.g.,
periods, commas, other symbols) from the selected fields

Remove all numerals from the selected fields

Remove all alpha characters from the selected field

79



Use this transformation

CONVERT

Text to number

Text to date/time

HH:MM:SS to number of secs
Date/time to text

Date/time to number

Number to text

Number to date/time

Advanced text to number

EXTRACT

Starting from left

Starting from right

Using position and length

Between start and end text
Line of a text block by line number

Line of a text block by search term

INSERT TEXT

Insert text

FORMAT (for Date/Time fields)
Short date

Long date

Short date/time

Long date/time
Time

Custom

FORMAT (for Numeric fields)
Fixed

Number
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Convert the data type Text into Number

Convert the data type Text into Date/Time

Convert HH:MM:SS strings into a number of seconds
Convert the data type Date/Time to Text

Convert the data type Date/Time to Number

Convert the data type Number into Text

Convert the data type Number into Date/Time

Converts text fields with the values “X B,” “X M,” and “X K,”
where “X” is any number, into “X,000,000,000,” “X,000,000,”
and “X,000,” respectively

Extract n characters from the beginning of a string
Extract n characters from the end of a string
Extract n characters from the xt" position from the start

Extract n characters starting from the start and end positions
indicated by a string of characters

Extract a line from a text block based on the number of the line
in the block

Extract a line from a text block based on a given search term
Insert a text string at a specific location in the field

Apply the MM/DD/YYYY form of a date/time field
Apply the Day, Date form of a date/time field

Apply the MM/DD/YYYY HH:MM AM/PM form of a date/time
field

Apply the Day, Date HH:MM AM/PM form of a date/time field
Apply the HH:MM AM/PM form of a date/time field

Specify a custom form (e.g., year, month, day, hour, minute,
etc.) for the date/time field

Format the number without a thousands separator

Format the number with a thousands separator and two decimal
places
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Use this transformation

Financial
Currency
Percent

Scientific

Custom

REPLACE

Using position and length

Using find and replace

Ditto

Blank values
Nulls

SPLIT
Into parts from the Left
Into Parts from the Right

Names Into Parts

Addresses Into Parts

Date/Time into Parts

Date/Time into ISO 8601 Parts

Date/Time into Fiscal Parts

COMPUTE

Round with Precision...

Round Up (Ceiling)

Round Down (Floor)
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Format the number with thousands separator and two decimal
places. Negatives are enclosed in parenthesis.

Format the number with thousands separator and two decimal
places. Adds a currency, and negatives are enclosed in
parenthesis.

Multiply the number by 100 and add a % sign

Format the number in exponential form

Specify a custom form (e.g., 000,000, #0.0EOQ, # ‘degrees,” etc.)
for the number field

Replace strings of a certain length and located at a certain start
position with another string

Replace specific strings with another string

Copy non-null values down to fill null values in subsequent rows
in a column

Replace blank values with a specific string

Remove null values and replace with a specific string

Start from the left and split a column into two or more columns,
depending on a separator you define. The separator may be a
single character or substring

Start from the right and split a column into two or more columns,
depending on a separator you define

Split the value of a name column into its name parts.

Split the value of a single address column into its component
address or postal parts

Split a date/time column into two or more parts according to the
date/time components you select. Parts include Year, Quarter,
Month, Day, Hour, Minute, Second, Date, Time, DayofYear,
HalfYear, and Week.

Split a date/time field into two or columns according to the ISO
8601 date/time components you select

Split a date/time field into two or more columns according to the
fiscal parts selected

Round numbers to a specified number of places to the right (or
left) of the decimal point

Round numbers up to zero decimal places

Round numbers down to zero decimal places
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Remove Negative Signs (Abs) Return the absolute values of numbers

Remove Decimals (Int) Return the integer portions of nhumbers

Calculator Creates a calculated field using other numeric fields in the table
OTHERS

Macros Add and manage macros and apply the same to columns

Text Field Operations

For text fields, the following data prep operations may be applied:

Filter Define filter
Discard filter

Sort Sort selected columns
Define sort
Column New formula column

New constant value column

New lookup column

New row number column

New runtime parameter column
Add or remove metadata columns
Rename column

Duplicate column

Hide column

Delete column

Alignment Left
Center
Right
Case Make proper case

Make lower case
Make upper case

Clean Remove leading and trailing spaces (Trim)
Remove consecutive spaces (Collapse)
Remove specified characters
Remove non-alphanumeric characters
Remove numeric characters
Remove alpha characters

Convert Text to number
Advanced text to number
Text to date/time
HH:MM:SS to number of seconds
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Extract

Insert text
Merge
Redact

Replace

Split

Date/Time and Numeric Field Operations

Starting from left

Starting from right

Using position and length

Using start and end strings

Line of a text block by line number
Line of a text block by search term

Ditto

Nulls

Blank values

Using find and replace
Using position and length

Into parts from the left
Into parts from the right
Names into parts
Addresses into parts

For date/time and numeric fields, the following data prep operations may be applied:

Filter

Sort

Column

Alignment

Convert

Define filter
Discard filter

Sort selected columns
Define sort

New formula column

New constant value column
New lookup column

New row number column

New runtime parameter column
Rename column

Duplicate column

Hide column

Delete column

Left

Center

Right

Date/Time
Date/time to text
Date/time to number
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Data Prep Operation

Format
Merge
Redact

Replace

Split (Date/time)

Compute (Numeric)

Changing the Data Type of a Column

Numeric
Number to text
Number to date/time

Ditto

Nulls

Date/time into parts
Date/time into 1SO 8601 parts
Date/time into fiscal parts

Round with precision

Round up (Ceiling)

Round down (Floor)

Remove negative signs (Abs)
Remove Decimals (Int)
Calculator

Besides data prep operations, you can also change the field type of each of the columns in your table (e.g., change a
numeric field into a date/time field). To do so, simply click on the field type icon found to the left of the column name

and, from the options that display, select the new field

£ | Hire Date  w
#
Ab
(7]

type you wish to apply.

Figure 4-76. Available prep operations for Text fields in the Prepare window.
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Searching for a Data Prep Operation

If the data prep operation you are looking for is not immediately obvious, simply type in the operation into the Search
field provided in the drop-down. Doing so filters the prep operations according to your search criteria and displays the
results, if any.

Ak Last Name

Aldridge split b4
TEEY ] split - Into Parts from the Left.
Georges 3 Split - Into Parts from the Right...
Gluck ¢n B

Jacobson :::. Split - Names Into Parts...
Y <:.:__. %plit - Addresses Into P.a_r_lz_;:._ .
Martins Wayne 1594568
Poretsky Teresa 1555240
Rosenberg Kelly 1390228
Russo Paula 15564598
Stancowicz Mary Beth 1593599
Woodruff Elizabeth 1600325

Figure 4-77. Available prep operations for Text fields in the Prepare window.

Copying Table Data

A number of copy operations can be done in Monarch Studio. Once copied, the data can be pasted to some other
word processing application.

0O To copy all of the data in a single column, click on the drop-down button to the right of the name of the column
you wish to copy and then select Copy from the options that display. If you wish to copy all of the data including
the header of the column, choose Copy with headers instead.

0O To copy a portion of the data in a single column, highlight the data you wish to copy, right-click on your mouse
and then select Copy from the options that display. If you wish to copy the data including the column headers,
choose Copy with headers instead.

0O To copy data from two or more adjacent columns, highlight the data you wish to copy, right-click on your mouse
and then select Copy from the options that display. If you wish to copy the data including the column headers,
choose Copy with headers instead.

O To copy data from a single column in Monarch Studio and automatically create a new table in your workspace
from the selected data, click on the drop-down button to the right of the name of the column you wish to copy and
then then select Create table from selection from the options that display. The headers of the columns from
which you obtained the data are used as headers for the newly generated table.

O To copy data from adjacent columns in Monarch Studio and automatically create a new table in your workspace
from the selected data, highlight the data you wish to copy, right-click on your mouse and then select Create
table from selection from the options that display. The headers of the columns from which you obtained the
data are used as headers for the newly generated table.
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Modifying Column Information

Column information (e.g., type, name, order, hide/unhide) can be modified via the Column List dialog. Select the
drop-down button located to the right of each column and, from the options that display, click on Column List. Doing
so displays the Column List dialog, which provides details of all of the columns included in your table. Here, the first
name on the list represents the first column of your table, the second name represents the second table, and so on.

Column List m} X
Name Hide Format Width Alignment © Report Date Ab Customer # Order Number # Ac...Ab Conta
N 2l 1 10 Apr 2010 Betiy's Music Store 536017 11887 Betty Yoder
£ Report Date
2 10 Apr 2010 Bety's Music Store 536017 11887 Betty Yoder
§ & customer Ab 25 : Left v 3 10Apr2010 Betty's Music Store 536017 11887 Betty Yoder
4 10Apr 2010 Bety's Music Store 536017 11887 Betty Yoder
i m a :
{i & Order Number #ov 123457 14 5| Right e 5 21Apr2010  Betty's Music Store 536039 11887 Belty Yoder
o — ry Ny 6 21Apr2010  Betty's Music Store 536039 11867 Betty Yoder
i Z AccountNumber = # 123457 5 5 Right v
® 7 21Apr2010  Betty's Music Store 536039 11867 Betty Yoder
i ¢ contact Ab v 18 : Left v 8 21Apr2010 Betiy's Music Store 536039 11887 Betty Yoder
9 21Apr2010 | Betty's Music Store 536039 11887 Betty Yoder
a
Ab 12 5| Left ~ 10 5Apr 2010 Big Shanty Music 536016 17959 Marvin Mabry
. 1 5Apr2010  Big Shanty Music 536016 17959 Marvin Mabry
i - m a :
i 2 Media Qiyt # - 123457 | 12 | Right v
" 12 5ADr2010. Big Shanty Music 536016 17959 Marvin Mabry
MKl

‘ HIDE ALL H UNHIDE ALL H SET NAME CASING || APPLY SELECTED FORMAT TO ALL | Column Count: 11

I:\J/ I:& Applied Macros: None
Shared o ADD OR EDIT MACROS
Ab
©

“ CANCEL

Figure 4-78. The Column List dialog.

Using this dialog, you can:

0 Rename a column — Click on the Edit button to the left of a column name and then enter a new name into the
activated field.

0O Change the data type of a column — Select a new data type from the Type drop-down located to the right of the
column.

U Hide a column — Tick the Hide box located to the right of a column you wish to hide. Untick the box to display a
hidden column. If you wish to hide all columns, click the Hide All button. To display all hidden columns, click the
Unhide All button.

0 Format date/time and numeric columns — An Edit button displays to the right of date/time and numeric columns.
Click this button to bring up the Format dialog and select a different format for the column.

Adjust column width — Set the width of a column by using the up and down arrows.

0O Set alignment — Align the content of a column to the left, center, or right. Choose your preferred alignment from
the dropdown menu.

0 Reorder columns — Select the drag-and-drop handle ** to the left a column name and then drag and drop it to

its new location. Alternatively, use the i ‘ | T | | 4 | and | ~_| puttons to move the column to the top of
the list, one row up the list, one row down the list, and to the end of the list, respectively.

A preview of your changes is provided at the right-hand side of the dialog.

You can also work with macros in the Column List dialog.
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Setting a Row as a Column Header

To change the table header and use values from a certain row as column names instead, click on the number of the
row you would like to use as a header, effectively highlighting it, right-click on your mouse, and then select Set Row
as Column Headers from the options that display. Note that when this operation is done, all rows above the row you
selected as the column header are removed from the table and a new table (i.e., a transformation) is created.

To reverse (undo) this transformation, in the table selector, right-click on the newly created table and then select
Discard Transform from the options that display.

Adding Metadata Columns to a Table

You can add metadata from Excel, delimited text, and PDF/PRN reports as new columns to tables. This is done by
clicking the Metadata Columns button that appears at the bottom of the Change History panels of tables opened
from these file types.

METADATA COLUMNS

EDIT IN REPORT DESIGN

Figure 4-79. Adding metadata columns to a table opened from Excel, delimited text, and PDF/PRN reports.

Alternatively, you can expanding the context menu of any column in the table and selecting Column > Add or
Remove Metadata Columns from the options that display.

TRACKING CHANGES

A change history is the record of all changes that have been made to a table. This list can be reapplied to any table
that has columns of the same names and data types in the same order. Change histories may be imported and
exported and applied to tables similar to that from which the imported/exported change history was created.

Data Prep Studio features a nifty tool through which you can track your data transformations in a stepwise manner.
This tool is called Change History and is found as a panel on the right-hand side of the Prepare window.

P R AE

@

o=

&

% 3 :,ljf’c Bonus z g )
E Format column Bonus

LD o

g 2 % salary VARLES
U Format column Salary

AN

RS

1 9% Hire Date

Format column Hire Date

Figure 4-80. Accessing the Change History panel.

This panel shows each of the changes we performed in the previous exercise.
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A

If you want to undo an operation, select the Undo Change button beside that operation. If you'd like to edit it,

select the Edit 4 button.

Note that selecting Undo for one operation will also undo all operations after it and that the Change History
functionality is only available in the Prepare window.

A complete discussion on Change History is provided here.

Adding Changes to a Table

Let’s transform the Hire Date column of the table Join so that only the hire date and not the hire time displays. In this
exercise, we will also transform the Salary and Bonus fields so that the values in these fields resemble monetary
values more closely.

STEPS:

1. Inthe Prepare window, load the Join table, which we created in an earlier lesson.

e

2. Click on the drop-down button located to the right of the Hire Date column header.
From the menu that displays, select Format.

From the Format Hire Date dialog that displays, select Short Date.
Format Hire Date a *

%/ Select Format

Leng Date Short Date/Time

Long Date/Time Time Custom

&> Format Sample
@ Original Column Value

10/13/1995 12:00:00 AM 10/13/1995
1/30/1993 12:00:00 AM 1/30/1993
6/4/2005 12:00:00 AM 6/4/2005
3/12/2000 12:00:00 AM 3/12/2000
10/26/1995 12:00:00 AM 10/26/1998
11/18/2003 12:00:00 AM 11/18/2003
4/12/2001 12:00:00 AM 4/12/2001
1/4/1996 12:00:00 AM 1/4/1996
9/2/1997 12:00:00 AM 9/2/1997
1/5/1993 12:00:00 AM 1/5/1993
1071171997 12:00:00 AM 1071171997
6/23/2003 12:00:00 AM 6/23/2003

Figure 4-81. The Format Hire Date dialog.

5. Select OK when you are finished
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The new column displaying only the hire date (without the hire time) displays. Note that the column header has
been changed to reflect at least part of the transformation we performed.

% Hire Date -

10/13/1995
1/30/1993
6/4/2005
3/12/2000
10/26/1998
11/18/2003
4/12/2001
1/4/1996
9/2/1997
1/5/1993
10/11/1957
6/23/2003

Figure 4-82. The transformed Hire Date column of the Join (Accounting + Compensation) table in the Prepare window.

e

6. Click on the drop-down
displays, select Format.

button located to the right of the Salary column header and, from the menu that

7. In the Format Salary dialog that displays, select Currency and then click OK.
8. Perform Steps 6 and 7 to transform the Bonus field.

Your table should now look as below.

= Ab First Name w* Ab Surname w A Emp_ID w (¥} Hire Date w Ab Gender w Ab Department w # Salary ¥ # Bonus ¥
1 Jeff Aldridge 1592784 10/13/1995 M Accounting $62,900.00 $1,800.00
2 william Daley 1587390 1/30/1993 M Accounting $58,480.00 $1,800.00
3 William Georges 1596792 6/4/2005 M Accounting $58,480.00 $1,800.00
4 Anna Gluck 1593300 3/12/2000 F Accounting $62,380.00 $1,800.00
5 Doug Jacohson 1601562 10/26/1998 M Accounting $70,050.00 $2,400.00
6 Alana Marshall 1598264 11/18/2003 F Accounting $42,750.00 $900.00
T Wayne Martins 1594566 4{12/2001 M Accounting $62,900.00 $1,800.00
8 Teresa Poretsky 1588940 1/4/1996 F Accounting $60,690.00 $1,800.00
9 Kelly Rosenberg 1590228 9/2/1987 F Accounting $60,690.00 $1,800.00
10 Paula Russo 1586498 1/5/1993 F Accounting $42,750.00 $900.00
" Mary Beth Stancowicz 1593599 10/11/1997 F Accounting $62,380.00 $1,800.00
12 Elizabeth Woodruff 1600325 6/23/2003 F Accounting $70,050.00 $2,400.00

Figure 4-83. A completely transformed Join (Accounting + Compensation) table in the Prepare window.
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Applying a Change List to a Different Table

You can drag and drop single changes (using the header of a change) or whole change lists (using the drag-and-drop
handle of the Change History panel) to other tables. When you do so, each of the changes specified in the change list
are automatically applied in sequence to the new table if the latter has no change history.

o 5 s

3 D/_? Bonus & E oy

Format column Bonus

2 D/_? Salary & E oy

Format column Salary

1 D?j Hire Date & E oy

Format column Hire Date

CHANGE HISTORY

Figure 4-84. The drag-and-drop handle of the Change History panel.

In Figure 4-85, the change list of the table Join (Accounting + Compensation) has been dragged to the table Join(1)
(Data Processing + Compensation). If both tables contain the same fields but the latter has a different change list,
you are asked if you would like to replace the Change History of the latter table.

START PREVIEW PREPARE* ansiorM (g comBINE [ ANAZE [ ExpoRT
ADD G ‘ g ‘ m Ab Department w Ab Last Name w Ab First Name: ¥ Ab Emp_ID w ) Hire Date
Py ] 1 Data Processing Bass Andrew 1583211 3/18/1099 12:00:00 A1 = | 'ahoma v
ATy searc - 2 Data Processing Bittner Herb 1567596 3/18/2005 12:00:00 A
- p— = 3 Data Processing Bittner Martha 1604193 12/18/2001 12:00:00 Al wp o e o
= o - 4 DataProcessing Condon James 1557266 6/4/2005 12:00:00 A Ap) T 2 P :_f
- - 5 DataProcessing Condon Raberta 1590086 2/28/1995 12:00:00 A
Accounting Hi 6 Data Processing Curtis Neil 1599507 8/14/2002 5 \H\ Department (+7 more) ip)
. 7 DataProcessing Evans Marlena 1592913 6/4/2000 T Change display widths
Compensation - B Data Processing Finn Amold 1594470 2/24/2001 % R
B Data Processing Horton Alice 1598482 9/30/1997 12:00:00 A1 I
= Append(1) v 10 Data Processing Howard Rae Ann 1588030 1/4/1096 12:00:00 A1 5
= 11 Data Processing Hubbard Lynn 1503310 6/30/1995 12:00:00 A
Accounting Hig 2 Data Processing Isenberg Gwen 1594545 4/30/1899 12:00:00 A
- 13 Data Processing Johnston Barry 1601801 12/28/1996 12:00:00 Al
Data Processing v 44 Data Processing Kellev Marv Beth 1593184 3/12/2000 12:00:00 A
Change List Drop X
Data Processing =
Compensation - @ Join(1) already has a Change List. Would you like to replace or append to the existing Change List?
— Append(2) -
Data Processing - REPLACE APPEND CANCEL
- IR — . rmrmeem . 0:00 A
Marketing v 26 Data Processing Valesquez Marrietta 1602228 12/18/2003 12:00:00 Al
27 Data Processing Willams Doug 1594447 2/26/2000 12:00:00 A
— Append <7 28 Data Processing Woodley Elizabeth 1567197 8/14/2002 12:00:00 A
|: Data Processing -
Marketing -
— Classic -
Classic.pdf
DragDropCsV -
EDIT JOIN
v
v 1& & Row of 28 —» Coumns:8 | § () i —t—

Figure 4-85. The change list created from the Join (Accounting + Compensation) table was dragged and dropped to the
Join(1) (Data Processing + Compensation) table.

If you select Replace in the Change List Drop dialog, the exact same changes in the former table are applied to the
latter one. If you select Append, the change list of the former is appended to the change list of the latter. If a field is
hidden and a change must be applied to it, the hidden field is displayed and the change operations are completed.

In another example below, the Change List of the Join table (Accounting + Compensation) has been dragged and
dropped to the table Marketing. Because the Marketing table does not contain Salary or Bonus fields, the error
shown in Figure 4-86 displays.
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TRANSFORM (2 COMBINE [5] ANAVZE [ EXPORT

A G e
AT al g
— Join D~
|:Ac=ouming e -
Compensation -
—  Append(1) -
|:Acmuming EHIR
Data Processing -
= Join(1) r:_;_": -
|: Data Processing -
Compensation -
— Append(2) -
Data Processing -

1 Marketing
2 Marketing
3 Marketing
4 Marketing
5 Marketing
6 Marketing
7 Marketing
&  Marketing
8 Marketing
10 Marketing
11 Marketing
12 Marketing
13 Marketing
14 Marketing
15 Marketing
16 Marketing
17 Marketing
18 Marketing
19 Marketing
20 Marketing
21 Marketing
22 Marketing
23 Marketing

4 Marketing

Ab Department

Error in "Apply the format C2 to column Salary": Column

25 Marketing
26 Marketing

“Salary" not found.

|i Data Processing -
Marketing -
— Classic -

: Classic.pdf

DragDropCSV -

¥ Ab Last Name

april
Banning
Bartholemew
Bradford
Carlson
Campenter
Chandler
Cohen
Connely
Desmarais
Fallon
Hampsted
Hendrickson

Ingles
Leiberman
Manfretti
Marshall
Mendleson
Palentier
Pappas
Pascurell
Stratton
Ungermann
Valensuela

¥ Ab First Name

Anne
David
Anne
Eugene
Stephen
Rae Ann
Lz
Danny
William
Jeff
Joshuz
Armstrong
Robert
Francis
Maggie
George
Teresa
Joseph
Alex
Paulz
Joshuz
Julie
Mary
Marlena
Norman
George

v Ab Emp_ID

1597429
1607768
1593642
1605798
1588509
1598599
1588201
1595028
1593726
1593219
1596257
1593898
1589538
1606310
1598135
1589165
1590486
1598740
1597890
1593345
1593374
1598131
1586229
159780
1590227
1595576

FONT =

Tahoma ~ 9 v
D) "2 A EH
¥ satary 21X

Format column Salary

737 Hire Date

Format column Hire Date

EDIT LOAD OPTIONS

Columns: 6 | ]

Figure 4-86. Error arising from incompatible changes between two tables.

Exporting a Change History List

Change History lists may be exported for use in a similar table in another Data Prep Studio session.

STEPS:

1. Select Application Menu E > Export Change List.

Alternatively, you can select the Export Change List

icon on the Change History panel.

In the Save As dialog that displays, use the File Location drop-down to navigate to the folder in which you want

to save the exported change list and then enter ExportChangel into the File name field.

Click Save when you are done.

The export list is saved into the nominated folder with the extension .dpcl.

Importing a Change History List

Importing Change History lists allows you to quickly and easily apply changes made to a previous table to a similar

table.

STEPS:

1. Following the steps outlined in Joining Data in a Data Prep Session, join the tables Marketing and
Compensation using an inner join and Emp ID as the key.

Altair Monarch 2024.1 Learning Guide

91



The following table is created.

Marketing
Marketing
Marketing
Marketing
Marketing
Marketing
Marketing
Marketing
Marketing
Marketing
11 Marketing
12 Marketing
13 Marketing
14 Marketing
15 Marketing
16 Marketing
17 Marketing
18 Marketing
19 Marketing
20 Marketing
21 Marketing
22 Marketing
23 Marketing
24 Marketing
25 Marketing
26 Marketing

1
2
3
4
5
6
7
8
9

H

Ab Department

¥ Ab Last Name

April
Banning
Bartholemew
Bradford
Carlson
Carpenter
Chandler
Cohen
Connely
Desmarais
Fallon
Hampsted
Hendrickson
Hill

Horgan
Ingles
Leiberman
Manfretti
Marshall
Mendleson
Palentier
Pappas
Pascurelli
Stratton
Ungermann
Valensuela

¥ Ab First Name

Anne
David
Anne
Eugene
Stephen
Rae Ann
Liz
Danny
William
Jeff
Joshuza
Armstrong
Robert
Francis
Maggie
George
Teresa
Joseph
Alex
Paula
Joshua
Julie
Mary
Marlena
Norman
George

¥ Ab Emp_ID

1557429
1607768
1593642
1605798
1588509
1598699
1588291
1595028
1593726
1593219
1596297
1593898
1589538
1606310
1558135
1589165
1590496
1598740
1597890
1593345
1593374
1598131
1586229
1599780
1590227
1595576

w (5 Hire Date

10/23/1993 12:00:00 AM
12/18/2003 12:00:00 AM
11/18/1992 12:00:00 AM
7/24/2005 12:00:00 AM
3/4/1995 12:00:00 AM
£/30/1995 12:00:00 AM
5/4/1994 12:00:00 AM
12/12/1997 12:00:00 AM
3/12/2000 12:00:00 AM
4/4/2001 12:00:00 AM
1/5/2005 12:00:00 AM
3/18/1999 12:00:00 AM
9/2/1996 12:00:00 AM
9/30/1997 12:00:00 AM
2/28/2004 12:00:00 AM
5/2/1996 12:00:00 AM
7/3/1997 12:00:00 AM
8/23/199 12:00:00 AM
10/23/1993 12:00:00 AM
7/18/1995 12:00:00 AM
7/18/13095 12:00:00 AM
£/20/1996 12:00:00 AM
4/3/1992 12:00:00 AM
6/14/2004 12:00:00 AM
5/17/1995 12:00:00 AM
4/30/1999 12:00:00 AM

¥ Ap Gender

-

ZETMTTMEZAMEZEZTETZINTNEZEZEZEZIZENITEZEZNE

¥ Ap Emp_ID(1)

1597429
1607768
1593642
1605798
1588509
1598699
1588201
1595028
1593726
1593219
1596297
1593898
1589538
1606310
1598135
1589165
1590496
1588740
1597890
1593345
1593374
1598131
1586229
1599780
1590227
1595576

v # Salary ¥ # Bonus ¥

75900
92150
62640
87950
69452
89290
83570
63940
65900
40550
79290
68240
57775
82150
71100
52510
59725
57775
68240
59452
59725
77990
71100
73570
40350
52510

25200
32400
19200
30600
22200
31200
28500
19800
25200
13800
31200
26100
21600
32400
27600
19200
22500
21600
26100
22200
22500
30600
27600
28500
13800
19200

Figure 4-87. The results of joining tables Marketing and Compensation.

2. Select Application Menu E > Import Change List.

Alternatively, you can select Import Change List

icon on the Change History panel.

3. Using the Open dialog that displays, navigate to the folder in which you stored ExportChangel, select this file
and then click Open.

The Hire Date, Salary, and Bonus fields of the joined table immediately reflect changes.

&  Hire Date

10/23/1993
12/18/2003
11/18/1993
7/24/2005
3/4/1995
6/30/1995
5/4/1994
12/12/1997
3/12/2000
4/4/2001
1/5/2005

v # Salary w #

$75,900.00
$92,150.00
$62,640.00
$87,990.00
$69,452.00
$89,290.00
$83,570.00
$63,940.00
$65,900.00
$40,550.00
$79,290.00

Bonus w
$25,200.00
$32,400.00
$19,200.00
$30,600.00
$22,200.00
$31,200.00
$28,500.00
$19,800.00
$25,200.00
$13,800.00
$31,200.00

Figure 4-88. The results of our Import Change List operation.
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Viewing the Change List history of the joined table yields the following results:
D) 2 7 &

3 2{9 Bonus i g 9
Format column Bonus
2 9% salary ARES
Format column Salary
1 15_3' Hire Date Z g o

Format column Hire Date

)

AHOLSIH IDNYHD

Figure 4-89. The Change List History of the newly joined Marketing and Compensation tables.

Modifying Items in a Change List

Now that you know that you can reverse changes you have applied to your tables by using the Change History
functionality, what happens if you simply want to modify — not reverse — a change, such as a formula field? You can

modify changes, such as filters and calculated field definitions, by clicking on the Edit icon that displays to the
right of an editable change in the Change History list. Note that if this icon does not appear, the change cannot be
modified.

Clicking the Edit A icon launches the relevant dialog to enable you to modify your change.

WORKING WITH SUMMARIES

Clicking the Analyze tab in the Data Prep Studio toolbar launches a drop-down panel that allows you to create and
manage summaries.

A summary tabulates information for selected fields and presents the results in a one- or two-dimensional matrix,
thereby allowing deeper analysis of your data. For example, suppose you had a table that listed the details of items
purchased by various customers over a span of three months from a record store. You can sort this table and see
who bought how many copies of what each day but you wouldn't know how much in total sales each customer
produced for the quarter or what percentage their purchases made up in total sales.
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o

Customer

Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Bluegrass Records
Bluegrass Records
Bluegrass Records
Bluegrass Records
Bluegrass Records
Canciones
Canciones
Canciones

DVD
SACD
CcD
CD
CD
DVD
SACD
CD
CD
CD

Media Qtyl Description

2 Luening, Electronic Music

4 Bartok, Sonata for Solo Violin

7 Mozart, Mass in C, K.427

8 Mendelssohn, War March of the Priests
10 Pizzetti, Messa di Requiem
11 Beethoven, Pathetique Sonata, Arau

6 Gershwin, An American in Paris

9 Scarlatti, Stabat Mater

6 Misc., Modern Trombone Masterpieces
1 Schubert, Sonata in e, D.566

2 Shostakovich, 24 Preludes for piano.

3 Mozart, Symphony No.23 in D

6 Schoenberg, Ode to Napoleon

6 Stravinsky, Dumbarton QOaks Concerto
5 Holst, 5t. Paul's Suite for Orch.

9 Balakirev,Symphony no. 1

3 Faure, 28 Songs, Stulzmann

3 Takemitsu, Music of Takemitsu

6 Messiaen, Quatour pour la fin de temps
9 Schumann, Manfred Overture, Bav SO
8 Strauss, Ein Heldenleben, Op.40

2 Handel, Tl pastor fido(opera)

2 Milhaud, Pastorale for Ob. & Bsn.

2 Mozart, Symphony in D, K.202

Amount

20.38
35.96
63.00
71.92
95.90
65.89
35.94
53.91
64.74

9.00
10.78
26.97
57.54
53.94
29.95
86.31
53.94
10.80
57.60
53.91
71.92
21.56
19.18
13.18

Figure 4-90. An ordinary table, especially very large ones, does not allow deeper analysis of your data.

In this lesson, we'll learn how to create and work with summaries to address such issues.

Customer

1 [Betty's Music Store

[ = T STV )

Big Shanty Music
Bluegrass Records
Canciones

Chez Rudy

Classic Exchange
Das Piano

Die Harmonie

Die Melodie
Fandangos Records
Hope's Sweet Notes
Mo Town Tunes
Musique du Monde
Musique Royale
Notas Musicales

Reiner's Symphonic Sounds

17 Spinning Records

12 The Glass Harmonica

19 The King's Place
20 The Record Store
21

22 Grand Total:

Amount

507.64
274.49
248.17
379.14
320.46
209.08
41.14
164.50
472.83
225.88
661.97
234.99
360.94
595.43
326.96
462.52
419.49
288.35
333.64
328.56

7356.18

Pct(Amount)

0.07
0.04
0.03
0.05
0.04
0.03
0.07
0.02
0.06
0.03
0.09
0.03
0.05
0.08
0.04
0.06
0.06
0.04
0.05
0.04

1.00

Figure 4-91. A summary of total sales and percentage of sales for each customer.

Summaries tabulate information about a single key field (i.e., row). In this summary, the key field is Customer. Any
field that is tabulated (or summed) is called a measure. In each the summary shown above, the Amount field is used

as the measure.

The most basic summary requires a single key field, in this case, a row (if you are a Monarch Classic user, you will
recognize rows as down keys), and a single measure. However, you can create summary reports that include

multiple key fields, items, and measures.
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You can also add column fields (Monarch Classic users will recognize these as across keys) to your summary such
as in the following summary.

Creating Summaries

The following steps describe how to create a simple summary. Here, we’'ll create the summary we saw in Fig. 4-91.

STEPS:

1.

Select the table Classic from the Prepare window, go to the column Media Qty, right-click on your mouse, and
select Replace > Ditto from the options that display. This step replaces empty cells with the value of the first
non-empty cell above it.

Select and then click Analyze from the Data Prep Studio toolbar.

The Analyze drop-down displays.

[
Click the Add Summary \Jf) icon to launch the Add Summary dialog.

Edit Summary O %
Mame: | Summary Default style:  AaBbCcDd PAGE SETUP...
Filter: | Default Filter v Title row style: AaBbCeDd = coi7

Font | Tahoma w 12~

Source Fields Rows Measures ADD COUNT |

Type Name Row Column Kem Measure Edit Source Field Sorting Order Remove Edit Label Calculation Order Remove
" = -
¥ Account.. @ i) (-’I

m = ™Y T
# Amount @ i) (J'

Ab Contact @ QD (j'

N/A

Ab Customer @ \JD (j' N/A

. . =Ny i
Ab Descript. () (i) (i) wa

A = Y Items
Ab  Label/N... = i) I:‘/' N/A

Columns Edit  So Field Sorti Ord Re
. . = it Source Fiel rting Order Remove
Ab  Media... =) i) ( N/A

2

Edit Source Field Sorting Remove
mn . = ™) T
v @ @ @
AN AN N = ¥
| Insert total line Lines in column title row: 1 04
Label: | Grand Total: Style:  AaBbCeDd EDIT Lines in data rows: 104
Insert | 0 * blank lines before total line. Apply label style to measure columns

CANCEL

Figure 4-92. Creating a new summary.

In the Name field, replace Summary with Sales by Customer.

From the Source Fields panel, click on the Row icon for Customer. This field is transferred to the Rows panel
of the dialog.

From the Source Fields panel, click on the Measures icon for Amount. This field is transferred to the Measures
panel of the dialog. Use the Calculation drop-down provided to the right of the field to select the SUM operation.

Repeat Step 5 but this time, choose PCT as the calculation operation.
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8. Ensure that the box for Insert total line is ticked and then specify 1 in Insert n blank lines before total line.

9. Click OK at the bottom of the dialog to accept your summary definition.

Editing Summaries

You can edit your summaries in the following ways:
Select new/remove rows, columns, and measures
Modify the field names of individual columns
Suppress duplicate field values

Insert blank lines to the summary

Insert total lines to the summary

0O 0 0O 0 o

Modify the calculation assigned to a given measure
0 Select different types of filters to apply to your summary to stratify your data even further

In the following example, let's add Column fields to our summary.

STEPS:

1. Use the Summary drop-down to ensure that the summary Sales by Customer is selected.

2. Click the Edit Summary @) icon to display the Edit Summary dialog.

Columns
— Edit Source Field Sorting Order Remove
Ab MedisQy  (E) (i) N/A

. Edit Source Field Sorting Remove

# Medalnl ()

Edit Summary o X
Name: | Sales by Customer Default style: ~ AaBbCcDd | eom PAGE SETUP...
Filter: | Default Filter ~ Title row style: AaBbCeDd ‘ EDIT |
Font | Tahoma ~ 12 v
Source Fields Rows Measures ADD COUNT |

Type Name Row Column Hem Measure Edit Source Field Sorting Order Remove Edit Label Calculation Order Remove
#  AccountN.. @%\ !\ED O & Customer J’ & Amount | Sum v o
m = -
# Amount =) il ) O Z Pct(Am... |Pct ~

B P ey

Ab Contact =) i) N/A

Ab  Customer e '\Tu) N/A

A it = G G

Ab  Description =) i) O N/A

A = AN o Items

A Lbenet (D) Gi) () wa

(i
®
[=0]

(s

fam N S N = T
| Insert total line Lines in column title row: 1 0+
Label: | Grand Total: Style:  AaBbCcDd | eoim Lines in data rows: 1 4
Insert | 1 : blank lines before total line. Apply label style to measure columns

Figure 4-93. The Edit Summary dialog.

3. Click on the Column icon of the field Media Qty and then click OK.
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Your summary should display as follows in Summary view:

Customer BLU CcD DVD P SACD Sum(Amount)
1 Betty's Music Store 353.05 89.85 64.74 507.64
2 Big Shanty Music 158.23 29.95 86.31 274.49
3 Bluegrass Records 122.34 53.91 71.92 248.17
4 Canciones 379.14 379.14
5 Chez Rudy 275.51 44.95 320.46
6 Classic Exchange 209.08 209.08
7 Das Piano 22593 41.93 111.46 161.82 541.14
& Die Harmonie 100.04 64.46 164.50
¢ Die Melodie 362.56 23.96 86.31 472.83
10 Fandangos Records 213.90 11.98 225.88
11 Hope's Sweet Notes 77.90 481.06 59.90 43.11 661.97
12 Mo Town Tunes 211.03 23.96 234.99
13 Musique du Monde 95.90 283.01 -17.97 360.94
14 Musique Royale 515.17 80.26 595.43
15 Notas Musicales 85.08 168.94 10.78 62.16 326.96
16 Reiner's Symphonic Sounds 361.29 68.28 32.95 462.52
17 Spinning Records 317.66 89.85 11.98 419.49
12 The Glass Harmonica 9.59 211.56 67.20 288.35
12 The King's Place 203.02 25.13 105.49 333.64
20 The Record Store 17.97 250.59 60.00 328.56
21
22 Grand Total: 286.44 5403.11 612.01 475.57 579.05 7356.18

Figure 4-94. The modified summary showing sales as total amounts.

Now, instead of the 149-row table we extracted for Classic.pdf, we have a 20-row summary listing sales for each
customer for each media type. This table is clearly much easier to read and you can quickly tell which media type
is purchased the most by which customer.

Note that when we created our original summary, we indicated two measures: sales as total amounts and sales
as percentages. In our edited summary, only sales by total amounts display. Where did our column for sales as
percentages go?

4. Use the Active Measure drop-down to select the measure calculation PCT(Amt). The summary is rebuilt, this
time in terms of sales as percentages.

J Customer BLU CcD DVD Lp SACD Pct(Amount)
1 Betty's Music Store 0.05 0.01 0.01 0.07
2 Big Shanty Music 0.02 0.00 0.01 0.04
2 Bluegrass Records 0.02 0.01 0.01 0.03
4 (Canciones 0.05 0.05
5 Chez Rudy 0.04 0.01 0.04
6 Classic Exchange 0.03 0.03
7 Das Piano 0.03 0.01 0.02 0.02 0.07
& Die Harmonie 0.01 0.01 0.02
2 Die Melodie 0.05 0.00 0.01 0.06
10 Fandangos Records 0.03 0.00 0.03
11 Hope's Sweet Notes 0.01 0.07 0.01 0.01 0.09
12 Mo Town Tunes 0.03 0.00 0.03
13 Musique du Monde 0.01 0.04 0.00 0.05
14 Musique Royale 0.07 0.01 0.08
15 Notas Musicales 0.01 0.02 0.00 0.01 0.04
16 Reiner's Symphanic Sounds 0.05 0.01 0.00 0.06
17 Spinning Records 0.04 0.01 0.00 0.06
18 The Glass Harmonica 0.00 0.03 0.01 0.04
12 The King's Place 0.03 0.00 0.01 0.05
20 The Record Store 0.00 0.03 0.01 0.04
21

22 Grand Total: 0.04 0.73 0.08 0.06 0.08 1.00

Figure 4-95. The modified summary showing sales as percentages.

When multiple measures are defined for an across-key summary, you can only view one measure at a time.

As seen in the above examples, summaries provide you with a global view of your data, and they can be created
quickly and easily. You can even apply filters and sorts to them. If you would like to learn more about how to
create, modify, and manage summaries, click here.

Altair Monarch 2024.1 Learning Guide 97


https://help.altair.com/2024.1/monarch/help/Overview_Creating_Summaries_DPS.htm

WORKING WITH EXCEL WORKSHEET DESIGN

This next lesson provides a simple demonstration of how to work with Excel Worksheet Design. We will make use of
the file Classic.xIsx, which is typically installed along with your Monarch sample files (typically in
C:\Users\Public\Documents\Altair Monarch\Data). If you do not have access to this file, you can download it here.

In many instances, the data included in Excel files are arranged in neat tables. Thus, when an Excel data source is
added to Data Prep Studio, for example, by dragging and dropping, the form you see in the worksheet is identical to

the form you see in the Prepare window. However, many other Excel files may contain multiple levels of data that

cannot simply be brought into Data Prep Studio to form tables via drag and drop. In this case, further work by using
Worksheet Design is necessary.

To better understand the power of Worksheet Design, compare a worksheet with a standard format like this...

4 A | B (3 D E F G H I J

1 Meda| Qyescrpton Label | UnitPrce| Amount Ship Date | Contact | Acct Number Customer

2 C 6 Stravinsky, Dumbarton Oaks Concerto  SMCD 5120 8.99 53.94 02/04/2010 Marvin Mabry 17959 Big Shanty Music
3 ico 1 Schubert, Sonata in e, D.566 AS-325 9.00  9.00 02/04/2010 Marvin Mabry 17959 Big Shanty Music
4 ico 3 Mozart, Symphony No.23 in D CO-77884 8.99 26.97 02/04/2010 Marvin Mabry 17959 Big Shanty Music
5 lco 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54 02/04/2010 Marvin Mabry 17959 Big Shanty Music
6 ico 2 Shostakovich, 24 Preludes for piano. CDA 66620 5.39 10.78 02/13/2010 Marvin Mabry 17959 Big Shanty Music
7 |SACD 9 Balakirev, Symphony no. 1 ENTPD 4110 9.59 86.31 02/13/2010 Marvin Mabry 17959 Big Shanty Music
8 ) 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.99 29.95 02/13/2010 Marvin Mabry 17959 Big Shanty Music
9 'co 7 Sibelius, Tapiola, 0p.112, Ashkenazy 417762-2LM 5.99 41.93 02/01/2010 Alain Lebon 18635 Musique du Mong
10 o 8 Argento, Postcard from Morocco CRI 2-614 20.38 163.04 02/01/2010 Alain Lebon 18635 Musique du Monc
1 ‘co 1 Bach, Fantasia in G for Organ CD-80038 6.59 6.59 02/01/2010 Alain Lebon 18635 Musique du Monc
121p 2 Desprez, Missa de Beata Virgine LY 881 7.79  15.58 02/01/2010 Alain Lebon 18635 Musique du Monc
13 co 2 Reich, Music for Pieces of Wood HCD 31358 8.99 17.98 02/17/2010 Alain Lebon 18635 Musique du Monc
14 lco 4 Glass, Einstein on the Beach M4K-38875 35.95 143.80 02/17/2010 Alain Lebon 18635 Musique du Monc
15 lco 6 Cage, Music of Changes WER 60099- 8.99 53.94 02/17/2010 Alain Lebon 18635 Musique du Monc
16 ovD 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.99 29.95 02/17/2010 Alain Lebon 18635 Musique du Monc
17 8L -6 Beethoven, Pathetique Sonata, Arau 420153-5 5.99 -35.94 02/04/2010 Lionel Sampson 17658 Fandangos Recor,
18 lco 7 Chopin, 4 Scherzos for piano Tudor 720 5.39 37.73 02/27/2010 Lionel Sampson 17658 Fandangos Recor
19 lco 3 Salieri, Falstaff, Opera in 3 acts HCD 12789 16.16  48.48 02/27/2010 Lionel Sampson 17658 Fandangos Recor
20 :CD 4 Brahms, Sonata for 2 pianos CAL 50893 7.79 31.16 02/27/2010 Lionel Sampson 17658 Fandangos Recor

Figure 4-96. A standard worksheet.

... and a worksheet that displays levels of information via formatting like this:

Customer

Contact

Betty's Music Store
Muscatine Plaza

200 Lower Muscatine
Cedar Falls, 1A 50613
USA

Account Number 11887

Betty Yoder

Order Number 536017

ship Date 01/10/2020
[Media  aty  [Descrip IR
cD 4 Bartok, Sonata for Solo Violin 35.96
co 7 Mozart, Mass in C, K.427 63
co 2 Luening, Electronic Music 20.38
DVD 9 Scarlatti, Stabat Mater 53.91
Total 22 173
Order Number 536039
Ship Date 01/21/2020
[Media  laty  Description {Amount
cD 11 Beethoven, Pathetique Sonata, Arau 65.89
cD 8 Mendelssohn, War March of the Priests 71.92
cD 10 Pizzetti, Messa di Requiem 95.9
e 6 Misc., Modern Trombone Masterpieces 64.74
DVvVD 6 Gershwin, An American In Paris 35.94
Total 41 334.39
Betty's Music Store Total 63 507.64

Figure 4-97. A worksheet with groupings (or levels of detail).
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For standard worksheets, you can just use the standard Excel connector (Open Data > Spreadsheet > Microsoft
Excel) to easily load all your data. However, this method will not always work for worksheets with formatted levels of
information.

Worksheet Design was developed to extract levels of information from "complicated" worksheets. To do this, we
define trapping logic using data extraction templates.

How Templates Work
To understand how templates work, consider again the Classical Music Distributors Monthly Shipping Report
(Classic.xlsx), which shows information grouped into several levels:

Customer is the highest sort level, followed by Contact, Order Number, and then Ship Date. The columns comprising
the transactions are at the detail level.

Now, imagine taking a piece of cardboard and cutting holes in it at specific locations to only show specific information.
You can create cutouts for the following:

0 Customer (purple),
Contact (yellow),
Order Number (green)
Ship Date (blue)
Details (red)

0O 0 00

's Music Store i

i
3
Yoder
36017 +
1/10/2020
4|Bartok, Sonata for Solo Violin 35.96
7|Mozart, Mass in C, K.427 63
CO 2|Luening, Electronic Music 20.38
DVD 9|Scarlatti, Stabat Mater 53.91
§
36039 i i
1/21/2020
CD 11|Beethoven, Pathetique Sonata, Arau 65.89)
cD sll‘ delssohn, War March of the Priests 71.92
| co 10[Pizzetti, Messa di Requiem 95.9)
i LP GIMIsc., Modern Trombone Masterpieces 64.74
DVD 6|Gershwin, An American in Paris 35.94

Figure 4-98. The Excel worksheet, with only selected data showing through the "holes."
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Worksheet Design uses electronic templates to extract data from your Excel file. Instead of cutting holes, you define
the traps and columns to be extracted.

If your report file has multiple sort levels, you will define a separate template for each level that contains data you
want to extract.

In this tutorial, we will learn how to extract columns from Classic.xIsx.
We will first learn how to define a detail template and include the columns that belong to the detail.
i‘w‘}gﬁ%ﬁ%ﬁ@ﬁf{ﬁig%ﬁ% T

APPEND 4

i
i

B
i L

il

Bartok, Sonata for Solo Violin X i ﬁ |
Mozart, Mass In C, K.427 galiiii
Luening, Electronic Music : DETAIL

L i
e
T

8[! delssohn, War March of the Priests
10[Pizzetti, Messa di Requiem
slMlsc, Modern Trombone Masterpleces

Figure 4-99. The data extracted by a worksheet template.

We then build up the append templates to create a table that looks like this:

DETAIL APPEND 1 APPEND 2 APPEND 3 APPEND 4

. AbMedin  # Qy Ab Description # Amount  ©iDate  # OrderNumber Ab Contact

(1 o 4 Bartok, Sonsta for 500 Viorn 3596 01/10/2020 1... 536017 Betty Yoder Betty's Music Store
2 @ 7 Mozant, Mass in C, K427 63 01/10/2020 1... 536017 Betty Yoder Betty's Music Store

|3 c 2 Luening, Biectronic Music 2038 01/10/2020 1... 536017 Betty Yoder Betty's Music Store
4 DVD 9 Scaratti, Stabat Mater 339 01/10/2020 1... 536017 Betty Yoder Betty's Music Store
5 @ n Beethoven, Pathetique Sonata, Arau 65.89 01/21/2020 1... 536039 Betty Yoder Betty's Music Store
6 o 8 Mendelssohn, War March of the Priests .82 01/21/2020 1. 536039 Betty Yoder Betty's Music Store
7 C© 10 Pizzett|, Messa al Requiem 959 01/21/2020 1. 536039 Betty Yoder Betty's Music Store
8 P é Misc, Modern Trombone Masterpleces 8474 01/21/2020 1... 536039 Betty Yoder Betty's Music Store
9 DVD [ Gershwin, An American in Paris 3594 01/21/2020 1... 536038 Betty Yoder Betty's Music Store

Figure 4-100. The results of successfully trapping data in Worksheet Design.
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Working with Traps

A trap is a set of properties that uniquely identify a cell (or column of cells) among all others in the worksheet.
Property sets include the following:

0 Value

0 Font

O Alignment

O  Cell Properties

For example, traps can be defined as discussed below given the sample data in this worksheet:

A B C 3] E F
13
14 |Account Number 11887
15
16 |Contact Betty Yoder
17
18 Order Number 536017
19 Ship Date 01/10/2020
20 [Media |ary Description Amount
21 D 4|Bartok, Sonata for Solo Violin 35.96
22 cD T|Mozart, Mass in C, K427 63
25 cD 2|Luening, Electronic Music 20.38
24 ovD 9|Scarlatti, Stabat Mater 5391
25 Total 22 173
7h

Figure 4-101. Examining the report to identify traps that can be created.

Order Number

We can trap Order Number (cell C18) with the following properties:
0 Value: is number and non-blank

O Font: name = Calibri, size = 11, color = black

0 Alignment: horizontal alignment = left

Ship Date

O  We can trap Ship Date (cell C19) with the following properties:
0 Value: is date

O Font: name = Calibri, size = 11, color = black

a

Alignment: horizontal alignment = left

Media

We can trap Media (cells C21-C24) with the following properties:
0 Value: is non-blank

0 Font: name = Calibri, size = 11, color = black

0 Alignment: horizontal alignment = left

Worksheet Design normally defines the trap for you initially, but you can tweak the resulting templates to trap just the
columns that you want.
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Loading a Report

To open a worksheet, go to Start > Open Data > Spreadsheet > Excel Worksheet Design or drag the file to Data
Prep studio.

STEPS:

1. Goto the location of Classic.xIsx and drag the file to Data Prep Studio. The Excel Import Options dialog displays:

Excel Import Options X

Open C:\Users\Public\Documents\Altair Monarch\Data\Classic.xlsx in Excel Worksheet Design mode?
This mode is recommended for capturing data from non-tabular sheets

@ Click No to open the Excel file as a database.
The default opening action can be changed via the application settings

mE -

Figure 4-102. The Excel Import Options dialog.

2. Click Yes.
The file is loaded into Worksheet Design:

< CANCEL 222 APPLY TO...

Templates 1 Selecta cellfirst and then add an appropriate trap or column

A B C -
CLASSICAL MUSIC DISTRIBUTORS
MONTHLY SHIPPING REPORT

Name Role

Detail @

Templates &
Cell Information )

From 1/1/2020

1 1/31/2020

Customer Betty's Music Store
Muscatine Plaza

10 200 Lower Muscatine

NEW TEMPLATE < CLEAR
n Cediar Falls, 1A 50613

&_ Traps D Columns A 12 usa

14 ccount Number 11887

No traps have been defined for this template
15 Select a cell to display its properties

16 contact Betty Yoder

X

s26017
18 Ordor Number
1/10/2020
1 Ship Date
Wadis

36038

GUIDE ME

Figure 4-103. An open Excel report in Worksheet Design.

Initially:
The left panel is bare. Eventually this will display the templates, traps, and columns that will be defined.
The middle panel shows the worksheet.

The right panel shows cell information. We can close/hide this panel for now to maximize our view of the
worksheet.
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Defining the Detail Template

In this section, we will define the detail template and its columns.

A detail template extracts columns from the lowest sort level in the report, referred to as the detail level (also known
as the transaction level or itemized level).

You need to define the detail template first, and Worksheet Design actually forces you to do so; you cannot define
other templates unless you have defined the detail first.

To define the template, we trap the columns that we want to include.

STEPS:

1. Select the column value you want to trap. In our example, select column C21:

14 Account Number 11887
15
16 Contact Betty Yoder
17
18 Order Number Be0
19 srip Date 1/10/2020
20 Media Jary | Description | Amount

CD 4 Bartok, Sonata for Solo Violin 35.96
22 co 7 Mozart, Mass in C, K.427 83
23 co 2 Luening, Electronic Music 2028
24 DvD 9 Scarlatti, Stabat Mater 53.91
25 Tore “ "
26

Figure 4-104. Selecting a column to create a trap.

] ADD coLumn )
2. Select Add Column from the Context Menu Action Panel.

The column is added, and a trap is automatically defined based on the column’s properties:

" ACCEPT

Templates @ ™ DEFINE HEADERS «[] DELETE COLUMN /. DELETE TRAP . COPY TRAP = EXCLUDE ROW <1 CAPTURE THIS DATA AS AN APPEND &
g H
Name Rale 3 A B D el %
et ® é 1 CLASSICAL MUSIC DISTRIBUTORS 3
2 MONTHLY SHIPPING REPORT =
3 rom 13en2020 3
4 31.J3n 2020
5
6
7
8 customer Betty's Music Store
NEW TEMPLATE ~ CLEAR 9
10
n cedarrall, ia 5061
13
Ab C @ X 14 sccount Humber 11887
15
CLEAR ALL COLUMNS 16 conact ety Yoder -
. 3
E Classic Sales
AbC -
1o
2 €D
3 <
4 DvVD

co

GUIDE ME Template: Detail Trap: C  Column: C

Figure 4-105. The first column obtained from a trap.
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Note the following:
A trap is added to the Traps List.
The initial entry says there is a trap based on column C based on value, alignment, and font.
A column is added to the Columns List.

The initial entry says the column has a data type text, and the column name is currently C (the default name,
assigned based on the Excel column name).

The columns that were trapped have solid triangles with a pink outline.
This means that their formatting matches the trap criteria, and their values are added to the Preview Grid
The sample extracted data are shown in the Preview Grid,

3. Do the same for the other columns on the detail

Follow the steps above to add the columns Qty, Description, and Amount. After doing so, your work area
should look as follows:

Templates 1 T%. DEFINE HEADERS . ADDTRAP {] DELETE COLUMN » EXCLUDE ROW CAPTURE THIS DATA AS AN APPEND

g 5
Name Role 2 A 3 D E I - E
Detai @ &ln S
12 5 =
13 ki
oot mumber s
15
16 cornacr [—
17
. P— s
o — s 320
NEW TEMPLATE < CLEAR = = r
) 21| ® I
22 @ =
3 3 @ h
E3 B . 5
26
# o - 27 o uamter ‘i:"u
28 Srip Date
Ab E «
~ Eclisﬂ(salcs
# F @ =
CLEAR ALL COLUMNS 1 o 4 Bartok, Sonata for Solo Viokn 3.6
2 CD 7 Mozart, Mass in C, K427 =]
3 oo 2 Luening, Elecironic Music 2038
ovD 9 Scarlat, Stabat Mater sa91
5 CD " Beethoven, Pathetique Sonata, Arau 65.89
s co 8 Mengissahn, War March of e Prests | 71,92
7 co 10 Plzzet, Messa di Requiem %9
GUIDE ME Template: Detail Trap: C

Figure 4-106. Four columns are extracted from our trapping operations.

Note that, as you add a column, a new entry is added to the Columns list and new preview data are displayed.
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Defining a Trap
A trap is a set of properties that uniquely identify a cell (or column of cells) among all others in the worksheet.

Defining a trap is as easy as adding a column.

STEPS:

1. Right click on the Amount value (F21) and select Add Trap from the context menu or Action Panel:

536017
10Jan 2020
Media |Qty Description Amount
cD N 4 N Bart-le Srmete for Colo tiinlie
o ‘ B q Define Headers o3
- < M Add Trap <
o 2 T Add Value Trap ’ 20.38
DVD N 9 N Scat || Delete Column 53.91 N
2 === Exclude Row s
=1 Capture this data as an append
536039
21Jan 2020

Figure 4-107. Adding a trap.

A new trap is added to the Traps List, and the trapped cells now have solid triangles at their top right corner.

' ACCEPT
Templates @ T7. DEFINE HEADERS ] DELETE COLUMN [ DELETE TRAP 5. COPYTRAP = EXCLUDE ROW I CAPTURE THIS DATA AS AN APPEND ¥
2 5
o P
Neme Rale H c D E G H 3
Detail @ &N asons Te:
12 =
13 v
14
15
16
17
o T sseot7
NEW TEMPLATE < CLEAR = per I
20 Media aty Description
- @ N s aunok, sonatsfor solovioin
Sl 22 o I [Py ———
. 23 ® N 2 ™ wuering, Bertroni: Misic
f o e — 24 oo A 5 scaram, suaat eser
F Value, Alignment, Font @ & | 25 ”
= :
CLEAR ALL TRAPS E Classi Sates
Ab€ #0D AbE -
1o . Barok, Sonaa for Soio Vol 5%
2 o 7 Mozart, Mass in C, K427 €3
) 2 Luening, Electronic Music 238
4 DVD 9 ‘Scanat, Stabat Mater 29
5 " Beethoven, Pathetaue Sanata, Ara 66,89
6 €D & Mendeissohn, War March of the Priests | 71.92
7 €D 10 Pizzetli, Messa di Requiem 259

GUIDE ME

emplate: Detail  Trap: F Column: F

Figure 4-108. The results of a successful trapping operation in Worksheet Design.
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To view or edit the trap, select the edit icon beside the trap:

C Value, Alignment, Font Z

F Value, Alignment, Font

Figure 4-109. Editing a trap.

The trap properties display on an overlay panel:

< Detail\Traps\F

(P ./ Font || Align Cell
Cell Value Rules Case Sensitive Negate
4 Is Number ~ v

‘ ADD NEW VALUE RULE ‘

Figure 4-110. Trap properties in an overlay panel.

This panel shows that:

Traps have been defined for Value, Font, and Alignment as indicated by the checked boxed.

For the Value trap, include the column if the value is a Number.

Select the Font trap to view the definition:

¢ Detail\Traps\F

V| Value Font  [EVARE Cel

Font Rule Negate

+ Font Name Calibri v
+/ Font Size mog

Font Color

Bold
Italicized

Underlined

Figure 4-111. Viewing details of the Font trap.
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The panel indicates that column is included if it follows the following font properties:
¢ Font Name is Calibri
* Font Size is 11
»  Font Color is black
You can refine the trap by selecting or unselecting other properties.
4. Select the back icon to go back to the main interface:

< Detail\Traps\F

Figure 4-112. Return to the main interface by selecting the back icon.

Defining a Header

By default, Worksheet Design uses the Excel column name as the default column names. You can define better
headers.

STEPS:

1. Select the header cells on your worksheet. In our example, this will be C20-F20:

B AUTO DEFINE TABLE 22: ADD COLUMNS = DEFINE HEADERS =]
A B C D E F G
15
16 Contact Betty Yoder
17
18 Order Number e
19 i 01/10/2020
2l @ M " Bartok, S.. 35.96
22 CD q 7 q Mozart,... Q 63 ‘
23 D q 2 Q Luening,... .w 20.38 ‘
24 DvD n q Scarlatti,... q 53.51 ‘
25 Total : "

Figure 4-113. Selecting a row to define headers.

*. DEFINE HEADERS

2. Select Define Headers from the Action Menu.

The headers are applied to the to the Columns List and the Preview Grid.
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CANCFL

Templates
Name Role
Detail @
NEW TEMPLATE -~ CLEAR

Iﬁ Traps{2)

Amaunt

CLEAR ALL COLUMNS

‘GUIDE ME

Templates =

n

B AUTO DEFINE TABLE

ruscamne

A 50612

E Classic Sales

Al Media
co
co

§ ADD COLUMNS . DEFINE HEADERS «{] DELETE COLUMNS = INCLUDE ROW

C

3367

10Jan 2020

L= A
(=] N
DvD N

Prse—

Bariok, Sonata for Solo Violn ETS
Mozart, Mass in C. K 427 &

Luening, Electroni Music mas
Scanizm, Stant Mater Ty

Beethoven, Pathebque Sonsta, A 65,89
Mendelssohn, War March of the Priests  71.92

Pizzetl,

558 di Requiem 959

D E F

Barsek, Sensta for solo viclin

T vq\‘!E.zafLMss.;inC‘Kﬂ:) N &3 A
[ [Fp—— AT
5 scartat, sttt it AT

Cell Information

Figure 4-114. Defining headers in Worksheet Design.

Checking Traps and Including Rows

Worksheet Design will do its best to apply the specified traps to all columns. However, some data may not be

captured by this approach, so you need to check that all columns you want are included.

If arow is not included in a trap, you can use the Include Row tool.

STEPS:

1. Scroll down the worksheet and check if rows you want to capture were not, in fact, captured.

CANCEL
Templates
Name Role

Detail @

NEW TEMPLATE CLEAR
lk Traps(2) D Columns(4)
Ab Media @

# ay
Ab Description
# Amount @

CLEAR ALL COLUMNS

GUIDE ME

Templates

a9
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64

7, DEFINE HEADERS x| DELETE COLUMN s DELETE TRAP di~ COPY TRAP == INCLUDE ROW CAPTURE THIS DATA AS AN APPEND

Order Number s36000

Ship Date 10an 2020
Media aty Descrigtion J‘""'"'
@ 3 faure, 28 Songs, Stuzmenn EEn
< 2 Tabermitsu, Music of Tokertsi 1080
@ & Messlazn, Qustour peur s fin de temas 5740
s & Strauss, En Heloenleben, OpA0 nm
oo 5 Schumann, Manired Overture, By SO EEES

Tatal » ma

2 2817

Wusique du Monde
170 Rue de b2 Boste

45400 Fleury-les-Aubrs!s

E Classic Sales

Al Media

wovepton

Bartak, Sanata for Solo Vialin 3556
WMozan, Mass In C, K 427 63

Luening, Electronic Music 2038
Scariatl, Stabat Mater 5391

Beetnoven, Pamelue Songta, Aray | 65.89

Mendsissonn, War March of the Friests. | 7182

Pizzeti, Messa di Requiem L1

Cell Information =

Figure 4-115. Checking for rows containing data that have not been
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2. If you do find a sequential series of excluded rows, select the first of these rows (in the example above, rows 52—
56 are excluded, but you only need to select row 52) and then select Include Row from the Action Panel or
context menu.

The columns are included in the trap, and new rows are added to the Preview Grid.

ACCEPT K CANCEL
Templates 5 # AUTO DEFINE TABLE i ADD COLUMNS 7. DEFINE HEADERS «[] DELETE COLUMNS = EXCLUDE ROW
@ c
£ o
Name Rale 2 B c ] E F [l - =
£ |49 ‘Grder Number 536020 E
e @ 2 =]
51 \‘j
53 Takemitsu, Music of Takemitsu
54 @ 9 & ] Wlessizen, Quateur peur la fin de temps ] 57.60 W
55 A A & ' strauss, Ein Heldenleben, 0p.20 < na Y
56 L) < 9 ] Schumann, Manfred Owertuse, Bav S0 %] 53.91 W
NEW TEMPLATE ~ 2 CLEAR 57 Total E2 29817
58
59 S 1837
B Traps(2) 60
61
Ab Media 62 Musique du Monde
= 170 Rue de a Paste
# oy @ 45400 Fleury-les-Aub
€ 64 5400 Fleury-les-fubrais =
Ab Description @ 4 O
E Classic Sales
# Amount @ & —
foMedia Gty AbDescription
« CLEAR ALL COLUMNS 1 <o L] Banok, Sonata for Sol Vion %96
2 o 7 Mozar, Mass nC. K 427 &
3 cD 2 Luening, Electronic Music 2038
4 DVD 2 ‘Scarlatl, Stabal Mater 539
5 <D 1 Besthoven, Patheique Sonsta. Ay 55,85
6 o 5 ‘Mendetssann, Viar Marc o1 e Frests | 7192
7 CD 10 Puzetti, Messa di Reguiem 959

GUIDE ME

slate: Detail  Trap: F Column: Amount

Figure 4-116. New rows added to the Preview Grid.

Adding an Append Template

Append Templates include the columns above detail rows. In the Classical Music Distributors Monthly Shipping
Report, the append levels include:

t  Customer

0 Contact

O Order Number

0O  Ship Date

In this lesson, we will add the Ship Date.

STEPS:

1. Select arow or column you want to append. In this case, we will include the Ship Date, which is represented by
a value in C50:
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1%, DEFINE HEADERS «[| DELETE COLUMN S5 DELETE TRAP s COPY TRAP = INCLUDE ROW IT1 CAPTURE THIS DATA 4 {'-:

E
10
al &
48 E
. 5 L=
49 Order Number 536020 E
Ship Date =
i
51 Media Qty Description |Amm|m:
52 [5) N 3 %] Faurs, 28 Songs, Stulzmann | FEE |
53 co A | 3 V] Tekemitsu, Music of Takemitsu ~ 10.80 Y
54 co N & "] Messiaen, Quatour pour Ia fin de temps ] 57.60 Y
55 SACD N 8 %] Strauss, Ein Heldenlsben, Op.40 N 7192 Y
56 DVD A | 3 =] schumann, Manfred Overture, Bav30 ) z331
57 Total 23 24817
58
59 Bluegrass Records Total 23 248.17

Figure 4-117. Adding an append to the table.

2. Select Capture This Data as Append in the context menu or Action Panel.

New data are captured.

~ ACCEPT < CANCEL 422 APPLY TO...
Te'"F"ﬂtes = Ii, DEFINE HEADERS xD DELETE COLUMN J5  DELETE TRAP s COPY TRAP == EXCLUDE ROW I=1 CAPTURE THIS DATA 4 “Y
g 5
Name Role 5 A B D E F c -3
E |48 E
Detail Detail ~ B
= 49 Order Number 536020 E
Append @  Append v ® m Ship Date, =
= Nean Gy |nmam e v
52 o 3 Faure, 28 Songs, Stulzmann 5354
53 @ 3 Takemitsu, Music of Tskemitsu 1080
54 o & Messiaen, Quatour pour Ia fin de temps 57.60
55 saco § Strauss, £n Heldenieben, 0p.40 79
NEW TEMPLATE ~ >< CLEAR 56 ovD 8 Schumann, Manfred Overture, Bav 5O 5351
57 Tota! f 20817
58
50 Bluegrass Recoras Tota! f 20817
B Traps(1) [I Columns(1)
60
@ c e S 61
Customer
< CLEAR ALL COLUMNS 62 Musique du Monde
170 Rue de |a Poste -
v
Classic Sales
Ab Media # aty Ab Description Amount  KSENd -
1 C@ 4 Bartok, Sonata for Solo Violin 3396 1/10/2020 12:00:00 AM
2 o i Mozart, Mass in C, K427 63 1/10/2020 12:00:00 AM
3 D 2 Luening, Electronic Music 2038 1/10/2020 12:00:00 AM
4 DVD 9 Scarlatt], Stabat Mater 5391 1/10/2020 12:00:00 AM
5 < 1n Beethoven, Pathetique Sonata, Arau 6389 1/21/2020 12:00:00 AM
6 CD 8 Mendelssohn, War March of the Priests | 71.92 1/21/2020 12:00:00 AM
7 C 10 Pizzetti, Messa di Requiem 959 1/21/2020 12:00:00 AM
8 6 Misc., Modern Trembone Masterpieces | 64.74 1/21/2020 12:00:00 AM
§ DVD 6 Gershwin, An American in Paris 3384 1/21/2020 12:00:00 AM
10 Co 3 Faure, 28 Songs, Stulzmann 5384 1/10/2020 12:00:00 AM -

GUIDE ME Search Table Templ... Append  Trap: C(1)  Colu...

Figure 4-118. Data successfully captured via an append template.

Note the following:

A new template has been automatically defined and named, by default, Append. If you check the Templates
list at the top left-hand quadrant of the Worksheet Design interface, we now have two templates listed.

A new set of traps and columns for the new template is created.
Notice that this list changes as you select a template.

A new column is included to the right of the detail columns. By default, this column is named C.
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3. Rename the new column.

You can easily rename a column. Just double click on the name in the Preview Area to make it editable and then
enter a new name.

Ab Media # aty Ab Description # Amount

1 CD 4 Bartok, Sonata for So...  35.96 10/01/2020 12:0...
2 | CD T Mozart, Mass in C, K.... 63 10/01/2020 12:0...
3 | CD 2 Luening, Electronic M... 20.38 10/01/2020 12:0...
4 | DVD 9 Scarlatti, Stabat Mater 5391 10/01/2020 12:0...
5 CD 11 Beethoven, Pathetiqu... 65.89 10/01/2020 12:0...
6 CD 8 Mendelssohn, War M... 71.92 10/01/2020 12:0...
7 CD 10 Pizzetti, Messa di Re... 959 10/01/2020 12:0...
8

LP [ Misc., Modermn Tromb... 64.74 10/01/2020 12:0...

ol A Templ  Trap: C(1) lumn:

.

Figure 4-119. Renaming a column.

4. Rename the template.

By default, Worksheet Design renames Append templates Append, Append(1), and so on. However, you can
easily rename the template by selecting the Edit icon beside the template name. This makes the name editable,
and you can now enter a new name, in this case, Ship Date.

Templates
Name Role
Detail Detail
Append E} Append v ',:

Figure 4-120. Renaming the template.

Adding an Excel Worksheet Design Table to the Prepare Window

When you have finished extracting data from your Excel file via Worksheet Design, simply click the Accept button to
add your new table to the Prepare window. If there are multiple sheets in your Excel file, an Apply to... dialog
displays to ask you whether the traps you have just defined should be applied to these sheets as well. In this case,
simply make your selection and then click OK. The table you have just extracted from your Excel file displays in the
Prepare window.

All tables extracted by Worksheet Design can be prepared, transformed, joined, and used in summaries, similar to all
other tables in Data Prep Studio. The extracted table can also be renamed, duplicated, saved to the Data Source
Library, etc., via the context menu that displays when you select the table in the table selector and then right-click on
your mouse. If you wish to apply the same template to other sheets in your Excel data source after opting not to when
the table was originally extracted, select Apply to from the options that display in the context menu. The Apply to...
dialog displays.

If you wish to learn more about Excel Worksheet Design and how to work with its interface further, click here.

Demonstrations on how to work with Excel Worksheet Design are also provided in:

0 Trapping Data Using Worksheet Design 0 Capturing Multiline Headers
0O  Capturing and Refining Captured Data 0 Capturing Data Tables

O Applying Templates to Multiple Sheets 0 Capturing Data Tables

0O  Capturing Multicell Data
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WORKING WITH PDF TABLE EXTRACTOR

PDF Table Extractor is designed for ordinary people who wish to do extraordinary things with PDF files.

This functionality allows you to identify tables in text-heavy PDF files, select them, modify them if you wish, and then
export them to Data Prep Studio for further data preparation.

= ) smrt @ prReview [ ] PREPARE 4% TRANSF.. @) comeine [5) ANAYZE [ EXPORT

+ i Ab Customer v # A.. Ab Contact v & on”
EEEEETE C 2 = x
A e &4 1 Betty's Music Store 11887 Betty Yoder 5360 | z
BAMT aQ 2 : S
< 2 Betty's Music Store 11887 Betty Yoder 536(
— Join v 3 Betty's Music Store 11887 Betty Yoder s36C |
>
4 Betty’s Music Store 11887 Betty Yoder 536 | X
Accounting - =
5 Betty's Music Store 11887 Betty Yoder 5360 | 2
Compensation - 6 Betty's Music Store 11887 Betty Yoder 536( | =
7 Betty's Music Store 11887 Betty Yoder s | Z
Data P i - <
bl 8 Betty's Music Store 11887 Betty Yoder s | O
Marketing - 9 Betty's Music Store 11887 Betty Yoder 536(
10 Big Shanty Music 17959 Marvin Mabry 5360
= n Big Shanty Music 17959 Marvin Mabry 536(
L Classic.pdf 12 Big Shanty Music 17959 Marvin Mabry 536(
13 Big Shanty Music 17959 Marvin Mabry 536(

Bies Chant Mocie £70€0 Mo in Mahos

Figure 4-121. A typical PDF Table Extractor workflow.

PDF Table Extractor provides easy-to-use interfaces to perform the following:
0 Automatically look for and define tables in a document
within a page,
in all pages, or
in specific pages.
Modify tables that have been defined (e.g., modify headers, rename columns, and delete columns)
Create a custom table

0O  Export tables to Monarch Data Prep Studio

The lessons outlined in this tutorial provide a very brief overview of what you can do with PDF Table Extractor. To
learn more about this DPS component, click here.

Opening a Document

The following typical example describes how to open a PDF document and define tables using a file named
Canaccord 042215.pdf. If you do not have access to this document now, simply follow along with this tutorial.

STEPS:

1. Inthe Start Page, click Open Data.
2. In the Select Data Source to Open dialog that displays, click PDF & Text > PDF Table Extractor > Get Data.

3. Use the Open browser that displays to navigate to the location of Canaccord 042215.pdf, select it, and then
click Open.
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The PDF file displays in the PDF Table Extraction window.

CANACCORD 042215.PDF ~

Tables

AUTO DEFINE < CLEAR

Tables
All Pages ¥

CANACCORDGenuity ~ Datawatch *
A %

Tous there are no foreign markets.™ Enterprise Sdftware - Infrastrlicture
_ Richard Davis Jr., cra | Canaceora Genuiy Inc. [US] | RDS\S@cHnsccoragenutyoom | 6175713862
US Equity Research David Hynes Jr. | can aczars Genury Inc. (US] | DHynes@canacooragenuty.com | 6373723882
22 April 2015
Raising Target Price

e H ST Refocusing, re-orienting and rebooting; a good
Price (22-Ap Us§7.60 ;
B so start, but still work to be done
T Investmentthesis h
S2meex Range (Us$ s32-
s s Datawatoh introduced several new marketing vectors as the firm announced senior
Snares owt ) © 115 intermediate level staff changes. The fact is that robust market opportunities - in th
Varket Cap USSMI: s82  case nextgenerstion analytics and visualization - do not last forever, so the elock is
S":g”? ﬂ:ﬁiwwi ;‘: ticking for Datawatch to demonstrate that the firm can grow and make money. Once
ecCosn (us i) see some tangible signs that this firm is capable of delivering on both metrics, we w
reu i@ aeise i likely reconsider our HOLD rating.
r“— =] f.x mfjﬁ “-* » Bullish items. Software license revenues increased 23% sequentially to $3.9M (d

- - R o 11% y-0-y); & 15% reduction in force at the end of the quarter is expected to reduc
;ﬁ:i:‘w = = L0 operating expenses by roughly $4M on an annual basis; decoupling of outside/ine
= 09y (1051 pay sales reps will result in a 30% increase in selling/quota capactty without the addit
Previow 05y aon @4y of any new heads; new release of Datawatch Managed Analytics Platform for self-
BIMEN o7y mea =y service data preparation and visualization to scale from individual desktop use to
oc broad Enterprise adoption; inclusion in Gartner's 2015 Magic Quadrant for Busin¢
e @ @ @ @ Intelligance and Analytics Platforms is a positive branding event and lead-gen ool
ETy ss 80 s2 e e Bearishitems. Both total and license revenues declined y-0-y and will likely do so
e Tow 7w s 84 forthe balance of F2015; partner/ OEM revenues accounted for 8% of the revenus
EXS ECRNCCRNNECE] mix, down from 16% a year ago and the firm's 30% LT target; ASPs were §31k in t

quarter, down fram $42k a year ago, though this metric is skewed by smaller, insic

o Rl sales deals now being included in the calculation; the firm signed 5 sixfigure deal
Erry e T the quarter, down ffom  a year ago, but up from & in the December quartar; CMO -

Match Case

PREVIEW &

Figure 4-122. Loading a PDF file into PDF Table Extractor.

Defining and Working with Tables

Define one or all tables by selecting any one of the following from the Table Actions panel:
0 Auto Define > Current Page

0 Auto Define > Page Range

0O  Auto Define > All Pages

For this session, let us auto-define a page. In this section, we will auto-define tables, verify the tables, and delete one
of them.

Auto-Defining All Pages

Select Auto Define > All Pages to instruct PDF Table Extractor to look for and then automatically define all tables in
the PDF fi.

STEPS:

1. Goto the page you want to define. Use the page selectors at the top of the interface, or scroll and select using
the page thumbnails.

2. Select Auto Define > All Pages on the Table Panel.

PDF Table Extractor scans all of the pages of your document and then automatically defines tables for all
tabulated data.
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It also does the following:
« Creates alist of all the tables throughout the document. Tables are named Page <n> - Table <n>

+ Displays data on the Preview panel. You can view a table by selecting the table on the Page/Table List, or
by selecting that table's tab on the Preview panel.

All tables that have been defined are highlighted on the Document page

US Equity Research
22 April 2015

nchanged
RICE TARGET Us$8.001
US$6.50

SWeer Range (USST Taz-165
Dy ol 4] o
ares Out. (M) - 1
Market Cap [US$M): &
“nierprise Vakie (USEM): az
Met Cash (USEM): 3
FYESep 2014A 2015 2016F
Eales (USEM) 5.1 S06T ETE |
reviaus 351 305 369
o/ Sales () 11 17 16
T;J‘"‘GMP {0@s (1051 oA
reviaus (093] (1.07} 043
BT Margon (%) 273 (38.2) 1121
Quarterly Sales a1 a2 a3 04
FOLan BE B0 8= o1
hOLSE 7oa  TSA 785 84
fbo1es &6 58 _ 83 _ 8]
Quarterly EPS a a2 a3 04
Non-GAAP
FoLan T0.28]  (0.28] |0.2d) (018
hOLSE [OLSER (029)A (021 (0.7
bo16E 015] (0121 (0101 (0.06

Figure 4-123. A table captured from a PDF file in PDF Table Extractor.
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Viewing and Modifying a Table

Data from the tables are displayed on the table panel.

In addition, a Page/Table list shows the page where a table is located and all the tables defined for that page.

STEPS:

1.
table are displayed on the Preview panel.

Select Page 1 — Table 3 on the Page/Table List. The table is highlighted on the document, and the values for the

& & v il e — >

7 srowse

CANACCORD 042215.PDF

@ SET AS TABLE TI

Kerocusing, re-orienting and repooung; a gooa
start, but still work to be done

thesis

EXTRACT ALL EXTRACT SELECTION CLOSE
Tables S : = copy i CREATE TABLE FROM SELECTION
2 —
AUTO DEFINE v % CLEAR 2
w Page: 1 % Fa-wiess Aengs (USET T
Page: 1 ) eyl ) o
reres0ut ) - 213
Canaccord 042215 - Page: 1 - Table 1 o cap s ] case
neroris vake (VS =
s o S0 5
Canaccord 042215 - Page: 1 - Table 2
s ZaA osE BuieE
. e
Canaccord 042215 - Page: 1- Table 3 (2) B B B
1 1w
Canaccord 042215 - Page: 1- Table 4 o3 ot 0s
om o  oa
Canaccord 042215 - Page: 1 - Table 5 =l ==
v Page: 2
Canaccord 042215 - Page: 2 - Table 1
w Page: 4 ()]
Page: 4 X -
Canaccord 042215 - Page: 4 - Table 1 CE LML
v Page: 5 ()]

Datawatch introduced several new marketing vectors as the firm announced senior
intermeciiate |eve| staff changes. The fact is that robust market opportunities — in th
analytics and - do not last forever, so the clook is
ticking for Datawatch to demonstrate that the firm can grow and make maney. Once
see some tangible signs that this firm is capable of delivering on both metrics, we w
likely resonsider our HOLD rating.

« Bullish items. Software license revenues increased 23% sequentially o $3.9M (d
11%y-0y); a 15% reduction in force at the end of the quarter is expected 1o reduc
operating expenses by roughly $4M on an annual basis; decoupling of outside/ing
sales reps will result in a 30% increase in selling/quota capacity without the addit
of any new heads; new release of Datawatch Managed Analytics Platform for self-
service data preparation and visualization to scale from individual desktop use to
broad Enterprise adoption; inclusion in Gartner's 2015 Magic Quadrant for Busin¢
Intelligence and Analytics Flatforms is-a positive branding event and lead-gen tool

« Bearish items. Both total and license revenues declined y-0 and will likely do so
forthe balance of F2015; partner/OEM revenues accounted for 8% of the revenuc
mix, down from 16% a year ago and the firm's 30% LT target; ASPs were §31k int
quarter, down from $42k a year ago, though this metric is skewed by smaller, insic
sales deals now being included in the calculation; the firm signed 5 six-figure deal
the quarter, down from 9 a year a0, but up fram 4 in the December quarter; CMQ
Plummer, who was for E0to-market and strategio all
announced his resigation afterthe close of the quarter.

# Tha numhare: 2 shight insida t low avnactafinns Natawstch ranartad N9/15

»

PREVIEW ¥

E J[] CREATE NEW COLUN

All Pages ¥

Canaccord 042215 - Page: 1 - Tabl... | Canaccord 042215 - Page: 1 - Tabl... REURIEETFI LR TS

Ab  FYE Sep # 2014A pb 2015E #2016
1 Sales (USSM) 354 3080 %5
2 Previous 351 305 365
3 EVisales (x) 1117 16
4 EPS Non-GAAP (USS) 093 (1.05) -0.43
5 Previous 0.83 (1.07) -0.43
6 EBIT Margin (%) Non-GAAP 273 (382) 121

Canaccord 042215 - Page: 1 - Tabl... | Canaccord 042215 - Page: 1 [N ISP R TIotoR 011 METADATA COLUMNS ~

Figure 4-124. Selecting a specific table in PDF Table Extractor.

On the document, the table looks like this:

20144 20M5E 2016E
351 306t ET
351 305 36.

11 1.7 1
(033} (1.05)t (043
(0.93) (1.07) (0.43
(27.3) (38.2) 21

Figure 4-125. A selected table in PDF Table Extractor.

The table is surrounded by a dashed border with handles. Headers (which may be separate from the table) are

highlighted in pink. Columns are highlighted in blue.
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2. In the document window, right click on a table, header, or column to display context menu items.

rom LISEE. " "

rice (22-4¢

Selection Options i
&
Tables i

Create Table from Selection :E“

Set As Table Title b
u
Columns 1
P
Create new column +D al
i,
Exclude From Table E’l__‘l Ell
e
Quartetly 3al  Dyafine Headers Y
== g
15E i
Set Row as Column Headers %E il
u
m.:fpm More Options al
LA j0.28] (028 (0.24) (o.48] e
15E (0.38) (0284 (0.2 (0.17 FiL
E DAs) 1012 (040 D an
e . Th

Figure 4-126. Selecting a table to modify.

The context menu items that display will allow you to, among others:

«  Copy the selection »  Exclude values from the table
« Create a table from the selection «  Define headers
»  Set aselection as a table title »  Set row as column headers

° Create a new column

Deleting a Table

You may not need all the tables defined by PDF Table Extractor. You can easily delete tables via the context menu or
the Table panel menu.

STEPS:

1. Select Page 1 - Table 1 on the Page/Table List.
This table is highlighted:

US Equity Research
22 April 2015

HOLD

unchanged

JRICE TARGET us$s.00t
rom USS6.50

Jrice [22-Apr) UsSE7.60
ligker ______ DWCH-NASDAC

Figure 4-127. Selecting a table to delete.
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Although this looks like a table, the values are not related as columns or rows. We can delete this table.

2. Click the Delete icon “ located to the right of this table in the Page/Table list or Delete Selected from the
Table Actions menu.

Importing Tables into Data Prep Studio

After defining your tables, you can import them to Monarch Data Prep Studio. Once the tables are imported and
loaded, you can work on them using Monarch Data Prep Studio's features.

Select:

0O  Extract all to import all of the tables obtained from the PDF file into Data Prep Studio.

EXTRACT ALL EXTRACT SELECTION CLOSE

Tables e) —~ &

v

Q2

£

AUTO DEFINE ~ ¢ CLEAR =
w Page: 1 (5)

Canaccord 042215 - Page: 1 - Table 2
Canaccord 042215 - Page: 1 - Table 3

Canaccord 042215 - Page: 1 - Table 4

Figure 4-128. Importing all tables created in PDF Table Extractor to Data Prep Studio.

0O Extract Selection to launch a dialog that will allow you to specify which tables to import into Data Prep Studio

Extract Selection [m] x

D Table Name
Canaccord 042215 - Page: 1 - Table 2 Canaccord 042215.pdf 1
Canaccord 042215 - Page: 1 - Table 3 Canaccord 042215.pdf 1
Canaccord 042215 - Page: 1 - Table 4 Canaccord 042215.pdf 1
Canaccord 042215 - Page: 1 - Table 5 Canaccord 042215.pdf 1
Canaccord 042215 - Page: 2 - Table 1 Canaccord 042215.pdf 2
Canaccord 042215 - Page: 4 - Table 1 Canaccord 042215.pdf 4
Canaccord 042215 - Page: 5 - Table 1 Canaccord 042215.pdf 5
Canaccord 042215 - Page: 5 - Table 2 Canaccord 042215.pdf 5
Canaccord 042215 - Page: 6 - Table 1 Canaccord 042215.pdf 6

CANCEL

Figure 4-129. Importing specific tables created in PDF Table Extractor to Data Prep Studio.

The tables you selected are imported into Data Prep Studio and display in the Prepare window.
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EXPORTING TABLES, SUMMARIES, AND
REPORTS

You can export tables to the following formats:

O  Microsoft Excel (.xlsx, .xlsm, .xIs) 0 Altair Knowledge Studio
Microsoft Access (.accdb, .mdb) O  Microsoft Power BI

O Delimited text (.csv) 0 IBM Cognos Analytics

O  Fixed text (.txt) O Tableau Hyper (.hyper)

O PDF O Tableau Server (.hyper)

0 JSON O  Qlik (.qvx)

o XML 0O SAS Transport File Format V5

a a

Altair Panopticon SAS Transport File Format V8

For summary tables, the following export file types are supported in Data Prep Studio:

O  Microsoft Excel (.xlsx, .xlsm, .xls) O Tableau Hyper (.hyper)
0O Delimited text file (.csv) O  Qlik (.qvx)
0O  Fixed text file (.txt) 0O SAS Transport File Format V5
O PDF (.pdf) O SAS Transport File Format V8
O XML (xml) 0 JSON
0O  Microsoft Access (.accdb, .mdb)
Reports can be exported to:
O Text u  PDF

An overview of the export process and the general details required by each export is provided here.

Exporting Tables

The following example details how tables can be exported to Microsoft Excel. Although some export types may
require additional specifications, exports to delimited text, Microsoft Access, Tableau Hyper/Server, Qlik, SAS
Transport File Format V5, SAS Transport File Format V8, JSON, fixed text, PDF, XML, Altair Panopticon, and Altair
Knowledge Studio are accomplished in relatively the same manner.

STEPS:

1. Click Export on the Data Prep Studio toolbar.

The Export window displays.
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START <@ PREVIEW [J | PREPARE () commme [5] anavze [ ExeoRT

Only show exports from selected tables )
Click + to add new exports §
3
Accounting + E
Compensation + %
—  Append(n) +
|: Accounting +
Data Processing +
—  Append(2) +
Data Processing +
Marketing +
= Append +
|: Data Processing +
Marketing +
— Join@) +
|: Marketing +
Compensation +

Figure 4-130. The Export window of Data Prep Studio.

2. Click the + Add New Export button located to the right of the Join (Accounting + Compensation) table and then
select Microsoft Excel from the options that display.

START (&> PREVIEW []] PREPARE @) comeme [5] AnAvzZE [ EXPORT

Only show exports from selected tables Manage Exports # Join - Microsoft Excel

Export Type: Microsoft Excel -
|l Jcin - Microsoft Excel X Export File System
Accounting +
Local or Mounted Disk ~
Compensation +

Excel Export Format:

EXPORT RESULTS =

= Append(1
ppend(1) + Excel XLSX (*.xisx) v

Accounting +

Data Processing +

Expart Location:

— Join() +
C:\Users\Public\Documents\Join.xlsx BROWSE
|: Data Processing ar File C\.-\Documents\Join:xsx does not exist
Compensation + Teble Name:
— Append(2) o Join
Data Processing + Filter:
Marketing + No Filter ~
= [ + Sort:
Data Processing + No Sort v
Marketing + | Include Column Headers
When file exists:
Classic +
Overwrite v
DragDropCSV +

Figure 4-131. The Export Properties of the file type you are exporting to are displayed when you select an export type.

NOTE When exporting data as summaries or reports, click the + Add New Export button and then
choose Summary or Report from the options that display. Clicking the Summary and
Report options shows the file types that you can export to.

3. Use the Browse button to navigate to the folder into which you want to save your export.

Data Prep Studio will remember the export file path that you use so that you do not have to enter or select this
each time you export to the same file type.

4. Specify a filename to which your export should be saved.
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5. Specify other properties (e.g., table name, filter, sort, etc.) as necessary. Click here for a guide to these
properties.

If you are exporting multiple tables, note that you must specify export properties for each of these tables. For this
exercise, maintain default values.

6. Click Export.

When the export operation is completed, the results are displayed in the Results panel.

l‘.

CLEAR EXPORT RESULTS

Join - Microsoft Excel

Started: 5:24:08 PM

Completed: 5:24:13 PM

Exported 12 rows to CAUsers\Public\Documents\Join.dsx

EXPORT RESULTS

Figure 4-132. Example of a successful export result.

To view the exported file, simply click on the export link provided. Data Prep Studio navigates to the location of the
exported file, which you can then select and open in the appropriate application. Data exported in Data Prep Studio to
Excel files are exported as named ranges. Thus, when the table is opened, the worksheet name displayed
corresponds to that of the named range.

Exporting Summaries

In this lesson, let's export the summary we created and modified earlier in this guide. Here, we’'ll export to CSV (the
steps performed to export to Excel are similar).

STEPS:

1. Inthe Export window, click the Add Export button of the table Classic and then select Summary > CSV.

|- Data Processing + EE) Microsoft Excel

— Marketing + [;]a Microsoft Access
T, csv

— Append + T, Fixed Text
|- Data Processing + T—) PDF
T_> JSON
— Marketing + T_) XML
Export As: T_) SAS Transport File Format V8

DragDropCSV [;]_) Tableau Hyper

Classic(1) B, ik

Canaccord 042215 - Page: 1 - Table 2 + |

Figure 4-133. Exporting a summary.

2. Moaodify the properties specified in the Export Definition panel as necessary.
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Table: Classic
Export Type: CSV
Export File System:

Local or Mounted Disk ~
Export Location:

C:\Users\Public\Documents\Classic.csv BROWSE

File C\.\Classic.csv does not exist

File Extension:

Filter:

No Filter w
Summary:

No Summary ~
Measure: e

Split:

Drill Level:

Sort:
No Sort o

Include Column Headers

Delimiter:

Figure 4-134. Defining a summary export.

PROPERTY SPECIFICATION

Export Location C:\Users\Public\Documents\Altair Monarch\Classic.csv
Active Measure SUM(Amt)

Filter No Filter

Summary Sales by Customer
Measure Sum(Amount)
Include Column Headers v

Delimiter Comma

Text Qualifier Double Quote
When File Exists Overwrite
Encoding Type UTF-8

Code Page

3. Click Export.

When the export operation is completed, the Export Results panel displays. If the export was completed
successfully, an export link will appear. Clicking on this link launches the folder to which you saved the exported
summary.
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Note that data exported in Data Prep Studio to Excel files are exported as named ranges. Thus, when the table
is opened, the worksheet name displayed corresponds to that of the named range.

Exporting Reports

Exporting reports is just as easy as exporting tables and summaries.

STEPS:

1. In the Export window, click the Add Export button of the table Classic and then select Report > PDF.

2. Provide the necessary details for your export file. In addition to properties such as export file system and
location, you can specify what to do when a file of the same name exists in the export location, page setup
properties, the text encoding to use and whether access restrictions should be implemented.

3. Click Export.

Exporting to IBM Cognos Analytics

Cognos Analytics is a cloud-based application developed by IBM that allows the sharing of data and information
across workgroups as well as the creation and/or personalization of dashboards and reports on various devices.

—:: IBM Cognos Analytics Welcome
- - .
o, = Welcome to IBM Cognos Analytics
* = Getstarted by opening a report, dashboard, story, or an exploration!
[ = |
m Recent Quick reference
o |L cav |I| vlsx ~ Getstarted
Active Credit_A...s_Licenses.csv Sort.xlsx I Overview
I Get started videos
9/6/2019, 4:13 AM s 5/6/2019, 4:12 AM
> Sample data
» Support
o oxsx
Numeriguel.xlsx
9/6/2019, 4:12 AM
r————n
P
e .
[
.
Drag and drop files, open Quick launch or Browse Cookie Preferences

Figure 4-135. The Welcome page of Cognos Analytics.
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Exporting to Cognos Analytics is only possible through Monarch Data Prep Studio.
Some information is necessary to successfully export and work with your data in IBM Cognos Analytics:
0O  Acorrectly set up Cognos Analytics service

0 Server URL — The URL of your Cognos Analytics service. This URL must be entered into the field provided in the
Server tab of the Settings dialog of Data Prep Studio.

Namespace — The security connection type employed for the service

Username

Password

STEPS:

1. Goto the Server > IBM Cognos Analytics sub-tab of the Application Default Settings dialog and enter the URL
of the Cognos Analytics Service you are connecting to. Select OK to save your changes.

2. Using the steps detailed in the previous exercise, export the table Join(1) (Data Processing + Compensation) to
IBM Cognos Analytics.

3. Enter the necessary export information into the Export Properties panel.

¢ Join - IBM Cognos Analytics

Table: Join

Export Type: IBM Cognos Analytics

Table Name:

Join
Filter:

Mo Filter W
Sort:

Mo Sort W

When table exists:
Overwrite W
IEM Cognos Analytics Url: No IBM Cognos Analytics url configured.

EDIT DEFAULTS

Figure 4-136. Export file information required by the exports to IBM Cognos Analytics.

4. If you wish to edit the default URL you provided in the Application Default Settings dialog, click the Edit Defaults
button. The Application Default Settings dialog displays, and you can make the necessary revisions.

5. Select Export when you are finished.
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The IBM Cognos Analytics login page displays.
IBM Cognos Analytics o X

Server URL:

Please enter a valid URI.

Mamespaces

User Name

Password:

CANCEL

Figure 4-137. Entering IBM Cognos Analytics connection information.

6. Enter the connection information required by the dialog and then click OK.

NOTE You will need to provide your login information only once per Data Prep Studio session.
Subsequent exports to the same service will use the information you provided upon first
export to Cognos Analytics.

The table you exported should display in My Content when you log into your Cognos Analytics service.

—:: IBM Cognos Analytics Welcome W
<= Welcome to IBM Cognos Analytics
. cam
*eemm et started by opening a report, dashboard, story, or an exploration!
m Recent Quick reference
. - ~ Get started
° &, csv &, csv
Join.csv Active_Credit_A...s_Licenses.csv B Overview
B Getstarted videos
10/4/2024, 1:49 AM ee 9/6/2019, 4:13 AM wes
» Sample data
o, xsx o xsx > Support
Sort.xlsx Numeriguel.xlsx
9/6/2020, 4:12 AM wee 9/6/2019, 3:12 AM wee
p—————
2 1
1
o ———
‘
Drag and drop files, open Quick launch or Browse Cookie Preferences

Figure 4-138. The exported table displays in the My Content page of IBM Cognos Analytics.
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Exporting Data to Microsoft Power Bl

Data Prep Studio now supports exports to Power Bl by creating files that are automatically placed in your Power Bl
workspace provided that you have a Microsoft Power Bl account. Note that you must have a Microsoft Power Bl
account to execute exports of this type successfully. If you do not have one yet, you can sign up for an account here.

STEPS:

1. Using the steps detailed in the previous exercise, export the table Join (Accounting + Compensation) to
Microsoft Power BlI.

When filling out the Export Properties panel for this export, note that table names must range from 1 to 100
characters, should not be preceded or followed by whitespace characters, and cannot include any of the
following characters:

Exclamation point Round brackets
Backslash Asterisk
Quotation mark Plus sign

Dollar sign Comma
Percent sign Period
Ampersand Slash
Apostrophe

When the Export Selected button is clicked, the PowerBIforDPS login page displays.
Sign in to your account X
B® Microsoft
Sign in

Email or phone

Can't access your account?

Qh Sign-in options

Terms of use  Privacy & cookies

Figure 4-139. The PowerBIforDPS login dialog.

Altair Monarch 2024.1 Learning Guide 125


https://powerbi.microsoft.com/en-us/pricing/

2. Enter a valid email or phone number and password into the fields provided in this dialog. Select Sign in when
you are finished.

The Authorize PowerBl Export dialog displays for first-time users.

Sign in to your account

Permissions requested

PowerBiforDPS
App info

This appli

organization.

This app would like to:
View user's groups
View all groups
View all reports
Create content

View content properties

View all datasets

View all dashboards

CH KK C CR ¥ X

is not puk

Read and write all datasets

d by Mi

Add data to any of your datasets in Power Bl

Sign you in and read your profile

ft or your

Accepting these permissions means that you allow this app to use your
data as specified in their terms of service and privacy statement. The

publisher has not provided links to their terms for you to review. You

can change these permissions at https:/myapps.microsoft.com. Show

details

Cancel

X

A

Figure 4-140. First-time users must authorize Microsoft to perform a number of actions to enable access to exports to
Microsoft Power BI.

3. Click Accept.

The exported table is added as a new item in your Microsoft Power Bl account.

Power Bl My workspace Q Search Q e 4 & $
@ M K .
o 'y workspace @ Workspace settings
Create + New v T Upload v Q, Filter by keyword = Filter v = of
@) _ .
Browse
@ & Name Type Task Owner Refreshed Next refresh Endorsement  Sensitivity
OneLzke
deta i (| Classica Semantic model = Isabel Canto 10/22/24, 4:56:18 PM N/A = =
&8 ; ;
i I |5 Join Semantic model = Isabel Canto 10/23/24, 9:57:08 PM N/A = =
9 5] Marketing Semantic model = Isabel Canto 9/6/19, 8:21:58 PM N/A = =
Workspaces
$ @ Numerique1 Workbook — My workspace 9/6/19, 7:15:30 PM — — —
My
workspace @ Sort Workbook = My workspace  9/6/19, 7:15:57 PM = = =
- |:7)  Verkntipfen Semantic model = Isabel Canto 10/22/24, 4:28:23 PM N/A = =
Powier Bl
Figure 4-141. The results of the current export operation.
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Exporting to Tableau Server

Data Prep Studio allows you to export to or update existing worksheets in Tableau Server.

However, to be able to do so successfully, you need to have installed the Tableau TABCMD program first. Click here
to download and learn more about the utility. To facilitate exports to this application, provide the necessary
information (e.g., server URL, username, password, etc.) in the Server > Tableau Server sub-tab of the Application
Default Settings dialog.

STEPS:

1. Open the Export window.

2. Select the table you with to export, click + Add New Export button located to its right, and then select Tableau
Server from the options that display.

3. Provide the necessary details in the Export Properties panel, including the following:

Export location Password

Data source name Proxy address
Site Path to TABCMD
Server address Publish Type
Username When file exists

All these properties are described in detail here.

4. Export your table as usual.

Congratulations! You have just completed the Data Prep Studio lessons. We hope you have found them to be a
helpful introduction to Data Prep Studio’s capabilities. For additional information not covered by this tutorial, we
suggest you thoroughly explore Data Prep Studio’s help system. To do so, simply click here.

Other documentation on Data Prep Studio is also available here.

The previous lessons reveal that users who wish to open database tables quickly, clean them, and transform them for
further application, such as in data visualization, may find Data Prep Studio a great solution to their needs. However,
while data extraction from reports and export capabilities are also provided in Data Prep Studio, these features may
not be adequate when you want to extract data from some file types, such as .txt, or export to a specific format not
supported by Data Prep Studio. To do these, you will need to work with Monarch Classic.
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[5] MONARCH LESSONS

This chapter introduces you to the Monarch lessons.

These lessons are designed to quickly acquaint you with basic program operations. For additional material not
covered in this guide, consult the Monarch Help file by clicking File > Help and then selecting ? Help Topics.

a

Chapter 6 — Working in Report View

Shows you how to load a report file, navigate the report on screen, look up information in the report, copy
selected data to other applications, and print pages from reports.

Chapter 7 — Extracting Data from a Report

Shows you how to create a template to extract data from a simple columnar report, view the data in the Table
view, and save the template to a Monarch model file.

Chapter 8 — Special Data Extraction Techniques

Deals with special problems caused by address blocks, fields that run together in a report, and data presented in
multiple columns.

Chapter 9 — Working in Table View

Shows you how to load and navigate through a table, format fields, create headers and footers, print table data,
and copy data to other applications.

Chapter 10 — Working with Sorts
Shows you how to sort the table, create multiple sort definitions, select a sort definition, and save sort definitions.
Chapter 11 — Working with Filters

Shows you how to use a filter to select records based on any field value, create multiple filters, utilize value-
based filters, select an active filter, and save filter definitions.

Chapter 12 — Working with Calculated Fields

Shows you how to create calculated fields to add information to the table database.

Chapter 13 — Working with Multiple Instances of a Report

Shows you how data extracted from multiple reports may be sorted and analyzed in Table view.
Chapter 14 — Extracting Multiple Line Fields

Shows you how to extract a multiple line text block from a report. It also introduces memo fields, which are used
to hold the contents of a multiple line field, and covers exporting and printing memo fields.

Chapter 15— Summaries

Teaches you how to create a summary report from your Monarch data, specify summary design preferences,
and create quick summaries.

Chapter 16 — Advanced Summary Capabilities

Shows you how to reveal even more information about your data via Monarch’s advanced summary features.
Chapter 17 — Exporting Operations

Discusses how to export reports, tables, and summaries.

Chapter 18 — Importing Data from HTML and External Databases

Discusses how to import data from various external sources.

Chapter 19 — Creating External Lookups

Discusses how external lookups are performed in Monarch.
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0O  Chapter 20 — Using Digital Signatures

Discusses how digital signatures are added to some exports in Monarch and viewed in Microsoft Excel.

0 Chapter 21 — Using Pivot Tables

Discusses how pivot tables are added to some exports in Monarch and viewed in Microsoft Excel.
0O  Chapter 22 — Working with Asian (CJK) Character Sets

Discusses how to work with documents using Asian character sets

0O  Chapter 23 — Using Monarch Utility

Discusses how to use Monarch Utility to perform a number of functions.

INSTALLING LESSON FILES

When installing Monarch, the last screen of the Monarch Setup program provides a checkbox that asks whether to
install the lesson files.

When this box is ticked, the Setup program will install the lesson files in the appropriate folders under the Altair

Monarch folder in C:\Users\Public\Documents. You can change the location of these folders later on.

Note that the lessons in this Learning Guide assume that the lesson files are stored in their default locations.

THE OPTIONS INTERFACE

The Options interface allows users to configure several universal Monarch settings, including folders, input
information, views, and exports, among others.

"
Options
v X @
Accept  Cancel Folders
Folders

Report Files:
Start at default folder

Import & External Lookup Files:

Start at default folder

Model Files:
Start at default folder

Project Files:
Start at default folder

Export Files:
Start at default folder

Input

<

<

<

3

<

Modify Application Options - Altair Monarch Classic

g D 0O & il

View  Eport Clipboard  Security  Altair Monarch
Server Library

C\Users\Public\Documents\Altair Monarch\Reparts
C:\Users\Public\Documents\Altair Monarch\Reports exists

C:\Users\Public\Documents\Altair Monarch\Data
C:\Users\Public\Documents\Altair Monarch\Data exists

C:\Users\Public\Documents\Altair Monarch\Models
C:AUsers\Public\Documents\Altair Menarch\Models exists

CA\Usershadmin\Desktopieaming Guide Projects
Ci\Usershadmin\Desktop\Leamning Guide Projects exists

C\Users\Public\Documents\Altair Monarch\Export
CA\Users\Public\Documents\Altair Monarch\Export exists

"
@
Time Advanced

Intervals

Default Folder

Cache

.6. ,

Themes Help

Default Extension

datrptpdfpm;sdih v
dmod:xmod

& | dprizxpy

s ——————+

Figure 5-1. The Options window.
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Clicking specific buttons on the Options ribbon exposes settings you can modify. When you have modified the
settings as you wish, simply click Accept v to accept your changes and close the interface. You may specify

several options before selecting Accept V_ Select Cancel x to disregard any changes you made and close the
interface. In this case, none of the previous settings are modified.

The following table summarizes the functions of each of the buttons in the Options ribbon.

Use this button...

v Accept Accept the changes you made and close the interface
x Cancel Cancel the changes you made and close the interface
M Foiders Expose folder settings

E Input Expose input settings

513 View Expose view settings

E:> Export
E:l Clipboard
n Security

'“ Altair Monarch Server Library

Iml;
Time Intervals

‘\‘ Advanced

Expose export settings

Expose clipboard settings

Expose security settings

Expose Altair Monarch Server Library settings
Expose time interval settings

Expose advanced settings

Expose caching options

Cache
e )
2 Themes Expose theme settings
2 s Launch the Help file

More information on each of the settings available in the Options window is available here.
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[6] WORKING IN REPORT VIEW

In this chapter, you will learn how to work in Report view. Lesson topics include:
0  Starting a Monarch session

Opening report files

Navigating through reports

Using bookmarks

Copying data from reports

[ R R

Printing data from a report
0 Using PDF and XPS files

Most computer applications produce reports as output. Monarch is unusual because it uses reports as input. A
Monarch session begins when you open an existing report. The report displays in Report view.

The Report view gives you a scrollable view of your report. You can move around, look things up, copy data to other
applications, and print pages on your local or network printer. In this lesson, you will learn the basics of these
operations. In later lessons, you will learn how to extract and export data from reports.

OPENING REPORT FILES

In Monarch, you can open either one or several reports (up to 1,024 reports!) in a single session.

Opening a Single Report File

To begin working with Monarch, you need to open a report file. We use the term “report file” to describe any
computer report stored on disk. These files are often referred to as print, spool, TXT, PRN, SDF, PDF, and formatted
or fixed-width text files.

Several report files are provided in each Monarch install for use with these lessons. In this lesson, we will first open
single report files and then open multiple report files later.

NOTES Monarch opens a report as a “read-only” file. Monarch can write a new file with data
extracted from the report, but the original report remains safe because it cannot be altered.

You can also open reports in zip files or web and other locations.

If you have set up Altair Server Library credentials in the Options interface, you can even
open files located in the specified Altair Server Library.

Let's open a report file, in this case, ClassJan.prn.
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STEPS:

1. Launch the Monarch Classic application by clicking Start > All Programs > Altair Monarch 2024 > Monarch
Classic 2024.

2. Onthe File tab, select Open = > Report > Computer.

M Open Report X
™ < Public » Public Documents » Altair Monarch » Reports v O Search Reports el
Organize + Mew folder = 1 @
Learning Guide\ ™ Mame - Date modified Type Size ~
Projects Canaccord 042215 9/16/2024 11:15 PM Adobe Acrobat D... 529 KB
Reports ClassFeb /2024 11:15 PM Adobe Acrobat D... 20 KB
& OneDrive =_J ClassFeb 2024 11:15 PM Report File 15 KB
[ ] ClassFebxps /2024 11:15 PM XPS File 87KB
& This PC Classic 2024 11:15 PM Adobe Acrobat D... 28KB
. 3D Objects | Classic 2024 11:15 PM Report File 23 KB
[ Desktop D Classicxps 202411:15 PM #P5 File 86 KB
Irﬂ Documents Classlan 5/2024 11:15 PM Adobe Acrobat D... 19KB
* Downloads H_J Classlan 202411:15 PM Report File 14 KB
. |_1 Classlanxps 2024 11:15 PM KPS File 86 KB
b Music ClassMar 024 11:15 PM Adobe Acrobat D... 208
=] Pictures & ClassMar 2411:15 PM Report File 15KB
B videos [ ClassMarxps /2024 11:15 PM XPS File BB KB v
4. Local Disk (C:) ¥ <€ >
File name: || ~ | Report Files (*.dat, *.rpt, *.pdf, * ~

Ca " CEI

Figure 6-1. The Open Report dialog.

The Open Report dialog appears. The Files list displays all the files in the Reports folder with a DAT, PRN, RPT,
SDF, or TXT extension. If you don’t see a list of files, make sure you are viewing the Altair Monarch > Reports
folder and that the file type is set to Print Files (*.dat, *rpt, *.prn, *.sdf, *.txt), as shown in Figure 6-1.

3. Select ClassJan.prn and then click Open.

Monarch displays a softcopy of the report in Report view. The report shows customer shipments for a distributor
of classical music recordings for the month of January.
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M W < Altair Monarch Classic licensed to Altair - Classlan.pm = [m] X

Fle  Home  Report Table  Summary  Export
. . o~
= = 0~ Bl select au Previous Report Next Report n =
ﬂ’ E; [10 -] El as P P =] ]
@ T ) ookmar s
Report e Q Zoom To Fit [£1 Copy Search  Find in Previous Page [® Next Page s.,sjﬂ e r:dp;ri P’Dprif:‘? g:‘?;:s
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Figure 6-2. The ClassJan.prn shipping report.

Opening Multiple Instances of a Report

The procedure for opening multiple instances of a report is similar to that required to open a single report.

Since the January shipping report was opened in the previous lesson, we begin this lesson by opening the February
shipping report.

STEPS:

N
1. Select File > Open - - Report > Computer.
2. Click on ClassFeb.prn and then choose Open.
For each additional report you open, Monarch displays the Retention Options dialog.

This dialog prompts you to discard or retain any currently open reports and model parameters before opening the
new report.

M Retention Options X

| Retain Current Reports
+/| Retain Current Model

|- oK ] Cancel

Figure 6-3. The Retention Options dialog.

To replace the existing report and model with a new report, leave the Retain Current Reports and Retain Current
Model check boxes unchecked. Since we want to open a new report without closing the currently open one, we'll
choose to retain current reports.
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3. Ensure that Retain Current Reports is selected and then click OK.

The February shipping report is added to the Report selector. Note that Monarch does not create a separate
window to display each report. Instead, all open reports are viewed in one Report view, with a single report
displayed at a time. You can select another report to view by clicking on it in the Report selector. The document
selectors list all of the open reports, tables, and summaries in each Monarch session.

Let's open the March shipping report.
N
4. Select File > Open - - Report > Computer.
5. Click on ClassMar.prn and then choose Open.
This time the Retain Current Reports check box is already selected.

By preserving your most recent dialog settings, Monarch saves you a step each time you open a new instance of
the report.

6. Choose OK.

The March shipping report is opened and added to the Report selector.

GETTING TO KNOW REPORT VIEW

The Report View Interface

Let's take a minute to explore what you can find in the Report interface.
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Figure 6-4. The Report interface.

The Report interface is divided into three distinct areas. The Report ribbon is located on the top-most portion of the
interface and spans the entire width of the screen. This ribbon will allow you to perform many of the report functions
made available by Monarch. The Report selector displays as a panel on the left-hand side of the interface. You can
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choose specific reports to view from this selector, a functionality that is especially handy when you have multiple

reports open. Finally, the actual report is displayed on the right-hand portion of the interface.

Right-clicking in the Report selector launches a context menu that will allow you to:

Reopen afile

Close the current report
Print a report
Quick-print a report
Launch Print Preview
Create an export

Export the current report

0O 000 000

The Report View Ribbon

View file information (includes details on file path, size, last modified date)

The following table summarizes the functions of each of the buttons in the Report ribbon.

Use this button...

IEE! Report Design

l';* Auto Define

Tahomz | Eont Style
® | Font Size

‘A" Zoom to Fit

E Greenbar
Select All
[ Copy

o) Search

ETC.I! Find in Table

E Previous Report
] Previous Page
ml Go to Page

E Next Report

C Next Page
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Launch the Report Design interface
Automatically creates a template (or sets of templates, if
applicable) for an open report. Note that this feature is

only enabled in Monarch Complete and that the resultant
model is applied to all other open reports.

Select a font style
Select a font size

Automatically resize the report into the available Report
view using the best possible fit

Add greenbar shading to the report
Select all of the text in the report
Copy text from the report

Search for information from the report

Find the table entry corresponding to a specific line in the
report

Go to the previous report if multiple reports are open
Go to the previous page of a multiple-page report
Go to a specific page of a multiple-page report

Go to the next report if multiple reports are open

Go to the next page of a multi-page report
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Wi When chunking options have been defined, this button
Goto Chunk allows you to move to a specific chunk
I Bookmark Add a bookmark to a specific record

[p Next Bookmark View the next bookmark

| Srallens Ees View a previous bookmark

ﬁ Clear Bookmark Clear all bookmarks

T:. Display or define the report index
® Report Index

Specify character spacing options when openin
g PDF/XPS Options PBF/X):DS files pacing op pening

Launches the Set Chunk Options dialog, which you can
use to define smaller portions (chunks) of very large
reports

o
» Chunk Options

2 Help Launch the Help file

The Report View Context Menu

When you open a report in Report view and right-click on your mouse, a context menu displays. This menu will allow
you to:

0 Run Report Verify Zoom to fit

Copy text Print
Copy as table Print preview
Search for a record Export the report to a PDF or TXT file

Find in table Change the encoding applied to the report file

0O 0 0O o0 0 O

Add, edit, or remove bookmarks Launch the Report Design view

0O 0 0 O O

Add a new template

Each of these abilities will be discussed in detail throughout this Learning Guide.

NAVIGATING THROUGH REPORTS

Although the softcopy report looks just like its hardcopy cousin, you can use Monarch to zoom, scroll, page, jump,
and quickly find information within it. These tasks would be a lot more difficult to carry out with a hardcopy report.
Let's look at some of the benefits of viewing and exploring a softcopy report on screen using the three files we
opened previously. Make sure that you select the Report tab before you begin.
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The Report Selector

Report view opens and Monarch also displays, by default, a panel on the left side of the screen: the Report selector.

Home Report View X
Report Files v I
N be,

B Classlanprn
B ClassFeb.prn
B ClassMar.prn

Figure 6-5. The Report selector.

Clicking on any report in the Report selector opens the report in Report view.

The Search box allows you to search for open reports. This functionality would be useful if, for example, you had a
large number of open financial reports and want to search specifically for sales reports for a certain year.

Report View

N || mar D
B ClassMar.prn

Figure 6-6. The Search Selection box allows users to search for individual reports in the Report selector.

Adding Greenbar

Because Monarch operates in a graphical environment, you can adjust the display to enhance readability and suit
your own visual preferences. Monarch can display a greenbar effect on the screen, which helps your eyes track
across sparse columns in a wide report. If you prefer not to display greenbar, however, you can easily remove it.

STEPS:

1. OnClassJan.prn, select Greenbar B from the Report ribbon.

The report displays with greenbar shading.
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Figure 6-7. The report displayed with greenbar shading.

2. To remove greenbar shading, simply select Greenbar B again.

Changing Fonts and Font Sizes

Monarch allows you to change the font and font size used to display reports on screen.

STEPS:

1. To change the font, in the Report ribbon, click the drop-down '™ button on the Font Style box.

| Courier New B0 |

Consolas

Courier New
Lucida Console

I M5 Gothic

NSinSun 02/01
| SimSun—ExtB T
Figure 6-8. Changing font styles.

Only non-proportional fonts with fixed letter spacing are available because report columns may appear

misaligned if proportionally spaced characters were used.

2. Select the Lucida Console font from the list.

The font style is changed throughout the entire report.
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You may change the font size to zoom in or out or a report.

STEPS:

1. Click the drop-down " button on the Font Size box.

Courier Mew » 10 (=
Gy Zoom To Fit &
7
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. g
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15
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20

Figure 6-9. Changing font sizes.

Font sizes vary depending on the font style selected.

If the size you want isn’t available, use the font list to select another font. You can let Monarch select the font
size for you using the Zoom to Fit command. This selects the font size that best matches the report width to the
display width, so you can view the entire width of the report on screen.

2. To change the font size to match the report width to the display width, from the Report ribbon, select Zoom to
Fit ‘&
If the report is too wide to fit on screen even at the smallest available font size, Monarch will select the smallest
font size to fit as much of the report width as possible in the available display area.

Moving to the Next Page of a Report

It can be a tedious chore to dig through page after page of a big hardcopy printout. With softcopy reports on screen,
however, your computer does most of the work for you. Monarch lets you move around with just a few clicks of your
mouse.

Like most Windows applications, Monarch provides a vertical scroll bar to help you scroll through a report. You can
scroll through the report by pressing the up or down arrow on the scroll bar or by clicking and dragging the slider with
your mouse.
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For example, the following figure shows Page 8 of the ClassJan report.
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Figure 6-10. Scrolling through a report.

To move through the different pages of a report, you can:
0O  Use the Previous Page i button

0O  Use the Next Page C button
0O Use the Go to Page } button

When you select the Go to Page 3. button, the Go to Page dialog displays.

Go To Page n

Page Number (1 - 12): 1

ok || cancal |

Figure 6-11. The Go to Page dialog.

Enter the desired page (e.g., 8) into the Page Number field and then click OK. Monarch displays the specified page in
Report view.

Dotted lines indicate page breaks. Monarch relies on page break characters in the report file to determine where
breaks belong. If breaks are not explicitly defined in the report file, Monarch breaks pages after a fixed number of
lines.

To move left or right, press the left or right arrows on the horizontal scroll bar or drag the slider with your mouse.
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Moving Through Several Reports

To move through different reports when multiple reports are open, you can:
0O Use the Previous Report g button

0O  Use the Next Report B button

Finding Information in a Report

It's not always easy to find information buried deep in a hardcopy report. If you're looking for a particular invoice in a
report that is 75 pages long, for example, you can spend a lot of time and effort reading each page and you may not
even find the report you want. Fortunately, Monarch can search reports at lightning speed to find whatever you want.
Suppose you want to find all references to the composer, Mozart. You can use the Search function for this.

STEPS:

1. Select the ClassJan.prn report and ensure that you are on its first page.

2. Select Search ¢ from the Report ribbon.

A Search box displays on top of the Report view.
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Figure 6-12. The Search panel.

3. Type Mozart in the Search field and then click Find Next.

The first occurrence of Mozart in the report will be highlighted. By default, search items are returned in a top-
down manner. To search in a bottom-up manner, check the Search Up box among the Search options.
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4. Continue clicking the Find Next button to locate the next instances of Mozart.

NOTES You can make searches case-sensitive by selecting Match Case.

The option Search all reports allows you to locate all instances of the search item in all
open reports.

5. Close the panel by clicking the Close X icon to the right of the Search box.

SPECIFYING AND MOVING THROUGH CHUNKS

Large reports can be divided into more manageable "chunks." A 100-page report, for example, can be divided into 5-
page chunks. Once defined, users can select which chunk (e.g., the third chunk or pages 11-15) to load when the
report is opened in Classic. Monarch then extracts and processes only this particular chunk of the report.

Note that when a report in which chunking has been enabled is exported, the entire report is exported, as chunking is
designed to limit the data loaded in Table View, not the actual report.

STEPS:

1. Using ClassFeb.prn, click Chunk Options in the Report ribbon.
The Set Chunk Options dialog displays.

2. Tick the box marked Enable breaking report into chunks to begin defining chunks. Note that if this box is
unchecked at any time during your Monarch session, your chunk definitions will not be not applied to the report.

Set a chunk size of 2 pages and specify a chunk to load of 2.
Click OK.

Monarch loads pages 3-4 of your report only. Note how all other report pages above and below pages 3-4 are
grayed out. When performing trapping operations, you will be able to trap on these two pages only.
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ORDER NUMBER: 536147 SHIP DATE: 02/27/10
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Figure 6-13. Viewing chunk #2 as defined in the Set Chunk Options dialog.

Chunking options apply to all open reports. A quick look at ClassJan.prn and ClassMar.prn should show the
same results as in ClassFeb.prn.

displays.

Monarch loads only pages 7-8 of ClassFeb.prn (and ClassJan.prn and ClassMar.prn).

the box for Enable breaking report into chunks.

USING BOOKMARKS

Monarch allows you to set bookmarks within a session that can be used to navigate quickly between certain lines or
sections of a report. You can even annotate bookmarks.

NOTE

Move through chunks by clicking on the Go To Chunk icon in the Report ribbon. Enter 4 into the dialog that

Before moving forward with our lessons, click Chunk Options in the Report ribbon once more and then untick

Although bookmarks aren’t saved in model files, they are saved in project files. When
exporting to a PDF file while in the Report view, bookmark comments will be displayed as

comments within the PDF file.
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Let's set bookmarks for Spinning Records.

STEPS:

1. Use the search tool to locate Spinning Records in the ClassMar.prn report.

2.  Click in the left-hand margin next to CUSTOMER to highlight that line.

3. Select Bookmark R from the Report ribbon. The Add Bookmark dialog displays, and this dialog will allow you
to add a comment to your bookmark. Let’s try doing this.

M Add Bookmark

O

*

| Show when adding

OK—| |- Cancel | |

Help

Figure 6-14. The Add Bookmark dialog.

4. Type whatever text you'd like (e.g., This is a bookmark comment.) and then click the OK button. A bookmark
indicator appears on the left-hand margin next to the highlighted line of text.

5. Place your mouse pointer over the bookmark indicator. The text you typed is displayed.
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Figure 6-15. A bookmark is added to Spinning Records.
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NOTE You can click the OK button on the Add Bookmark dialog without actually entering a
comment if you wish. To prevent the Add Bookmark dialog from displaying on a specific
bookmark, clear the Show when adding check box.

You can move through bookmarks by clicking either Next Bookmark E or Previous Bookmark ‘] from the
Report ribbon. To remove a specific bookmark, select the bookmark you would like to remove and then click the

Bookmark R button from the Report ribbon. To clear all bookmarks, select Clear Bookmark H from the Report
ribbon.

COPYING DATA FROM REPORTS

Monarch makes it easy to transfer report data to other applications. Just copy and paste! When you copy data from a
report, Monarch creates both a text image and a worksheet image with separate columns and cells in the clipboard.

Let's copy a customer’s name and address into your word processor. You might use this feature, for example, if you
want to insert this name and address into a letter.

STEPS:

1. Goto the first page of the ClassJan.prn report.

2. Click at the beginning of the customer’s name (Betty’s Music Store in this case) and drag diagonally down to
the right to highlight the entire customer name and address, as in Figure 6-16.

02/01/10 CLASSICAL MUSIC DISTRIBUTORS BAGE 01
10:17 MONTHLY SHIPFING REPCRT
MSRO4 FRCM 01/01/10 TC 01/31/10

CUSTCMER: Betty's Music Store
Muscatine Plaza
200 Lower Mu=scatine
Cedar Falls, IA 50613
Usa

ACCOUNT NUMEER: 11887

CCNTACT: Betty Yoder

Figure 6-16. Copying a portion of the report.

Select Copy from the Report ribbon.
Launch your word processor.

5. Position the cursor where you want the address to appear and use your word processor’s Paste (CTRL + V)
command to insert the address into the document.
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Document1 - Word

Fle ~ Home Insert Draw Design  layout  References  Malings  Review  View  Help  ACROBAT 0O Search % Share | © Comments

. 3 == LFind ~
ﬁ][m Calioi (Body) - |11 ~| A A Aar | Ao | i = 2L | 1| nesbcenc| aasbeene AaBbCe AaBbce AP aaebcer aasbeen & Reph 0
- eplace
Pajtﬁ < Format painter BIU-@&xx A-2-A- =& F- TNormal | TNoSpac.. Heading1 Heading 2 Title Subtitle  Subtle Em.. = h(samv D‘(f“?
Clipboard & Font & Paragraph 5 Stytes 5l Editing Voice S
L i ' . 5 . P i - 2 . -3 i - 4 - -5 i - ] A -7 -
Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
1 Cedar Falls, 1A 50613
. USA
Page 10f 1 13words  English (United States) Ed B - L + 150%

Figure 6-17. Pasting to a word processor.

6. Exit your word processor without saving the document and return to Monarch.

AlSIS If you wish to copy all of the text in the report, select the Select All button on the Report

ribbon (or click CTRL + A on your keyboard) before clicking the Copy [£] button.

PRINTING FROM A REPORT

Monarch lets you print from the Report view. You can print a block of text, a page or series of pages, or the entire
report. Let’s print a single page from the report. We'll begin with Print Preview to see how the page will look before
producing the actual printout.

STEPS:

1. Return to the first page of ClassJan.prn and click File > Print '!‘ > Print Preview 'gvo. The Print Preview

window displays.
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M Print Preview - Report: Classlan.prn = O X

| .
& ém ] - fn » Brother DCP-T520W Printer "| ‘horth!—‘«mencaLetter ¥
~
02/01/10 CLASSICAL MUSIC DISTRIBUTCRS PAGE 01
10:17 MONTHLY SHIPPING REPORT
MSR94 FRCM 01/01/10 TO 01/31/10

CUSTCHMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
TSk

ACCOCUNT NUMBER: 11887

CONTARCI: Betty Yoder

MEDIA QTY DESCRIPTICN LABEL/NO. TUNTI_ERC ZMOUNT
CRDER NUMBER: 536017 SHIP DATE: 01/10/10

CcD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 35.86

7 Mozart, Mass in C, K.427 420831-2 9.00 63.00

2 Luening, Electronic Music CD &11 10.19 20.38

VD 9 GScarlatti, Stabat Mater SBT 48282 5.89 53.81
CRDER NUMBER: 536039 SHIP DARTE: 01/21/10

CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89

8 Mendel=zsohn, War March of the Priests SME 47592 8.99 T71.82

10 Pizzetti, Mesz=za di Reguiem CHRN 83964 9.59 85.80

LP & Mi=sc., Modern Trombone Masterpieces ADA 581087 10.79 64.74

VD & Gershwin, An American in Paris ACS 8034 5.99 35.94

W
< >
Page 1 Jof12 4 100% ———F——+

Figure 6-18. The Print Preview Window.

2. Examine the Print Preview window to see if your settings for font size, margins, and page orientation are
appropriate to produce satisfactory output. If not, you can change the settings until everything looks just right.
We’'ll change settings in a minute, but, first, we'll see how the Print Preview window works.

.‘mn'l

3. Click Zoom % on the upper left-hand corner of the window to zoom in or out.

4

4. Click the Next Page % or Previous Page icons located at the bottom of the window to move forward or

back.

Now, we’ll adjust our page orientation, margins, and font settings. On many printers, the Classic report prints
nicely with a portrait page orientation, half-inch margins, and a 9-point font. You may need to experiment to find
the right settings for your printer.

5. Select the drop-down button of the Page Orientation ] menu to confirm that the page orientation is set to
Portrait.

X
6. If you wish to change page margin settings, select Page Setup *" to launch the Page Setup dialog and adjust
the margin settings as necessary for your printer by double-clicking on the margin you wish to modify and
entering your desired value. Note that the Page Setup dialog can also be accessed by clicking File > Page
Setup.
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M Page Setup — O X

Preferences ~
Margins (inches) Export Pagination
Top: | 0.50 Paper Size:
| Letter (8.5 x 11 in) v
Bottom: | 0.50
Lef: | 0.50 Orientation:
Portrait
Right: | 0.50 ®) Landscape
Apply to all Views Apply to all Views
oK ] | Cancel | Help

Figure 6-19. The Page Setup dialog.

Select OK when you are finished making your changes.

7. When satisfied, close the Print Preview window by clicking the Close Es button on the upper right-hand corner
of the window.

8. Select File > Print ’!‘ > Print ’!‘ We'll print Page 5 of the current report.

= Print X
General |
— Select Printer
& Brother DCP-T520W Printer M Microsoft XPS Documen
12 Fax M OneMote for Windows 1(

™ Microsoft Print to PDF

< »
Status: Ready Preferences |
Location: hitp://192 168 254 179:80/ WebServices/Devi
B Find Printer... |
—Page Range
& Al MNumber of copies: |1 s
' Selection " Curent Page
" Pages: I ¥ Collate | |
w13l 1 hol3
Enter either a single page number or a single 1 1

page range. For example, 5-12

Print Cancel | Apply |

Figure 6-20. The Print dialog.

9. Select the printer you would like to use for this print operation.
10. Select the Pages radio button and then type 5 into the Pages box.
11. Select Print.
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The selected page will be printed. Monarch prints report pages as composed in the report file. Because Monarch
adopts pagination from the report file, you must be careful to select an appropriate font size and margin settings
to ensure that the full report image will fit on each page. Lines that do not fit will be carried over to a subsequent
page, and columns that do not fit will be truncated.

CLOSING REPORTS

During each Monarch session, you may wish to use specific report files and thus need to close other reports. Let's do
that now.

STEPS:

1. Ensure that the report ClassMar.prn is selected in the Report selector.

-
2. Select File > Close I > Report El

If you had other files open, such as a model, a database file, or a project, that you wish to close, you can also
select these from the options presented when you select Close.

3. A message box displays to confirm closure of ClassMar.prn. Click Yes if you wish to continue.
The selected report is closed and the Report selector displays the two remaining open reports.
Repeat Steps 1-3 to close the remaining reports.
If you had both report and model files open and wished to close these files at the same time, you can use the

Close All command, which is called when you select File > Close All Iﬁ When this command is called, you
will be asked whether to save model changes if you defined templates during the Monarch session.

WORKING WITH PDF AND XPS FILES

When you import a PDF file into Monarch Classic, the application performs an analysis of the file to try and determine
the optimum method of transforming the data accurately. In most cases, Monarch Classic’s auto-detection routines
will produce the best results. Under certain conditions, however, adjustments to the PDF import options may be
necessary.

Previous PDF engines used in Monarch used the idea of monospaced and free-style text flow to adjust for text
alignment. These older engines are usually adequate for:

0 PDF files containing tables with tightly compacted columns.

0 PDF files containing multiple font sizes and the data of interest is in a smaller font than most of the other text in
the PDF, thereby causing the auto-calculated font size to be too large.

PDF files containing mixed mono- and variable-spaced fonts but the data of interest uses monospaced fonts.

0 PDF files containing mixed free-form and tabular data.
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However, in newer PDF reports:

0O Textalignment on pages with sparse text is inconsistent.
0 Textwrapping may cause horizontal misalignment.

0 Alignment of centered text is unpredictable.

Moreover, PDF reports are now published by numerous software products and may show some unpredictability in
terms of their use of fonts, backgrounds, and line colors. Thus, a rendering engine that can tolerate any combination
of fonts (including both monospaced and free-form fonts) and background colors is required.

Monarch uses a new PDF engine (version 4.5) that improves the accuracy of text extraction by identifying graphical
elements, such as vertical and horizontal lines and rectangles, on rendered PDF pages and using these elements to
form grids to which text will be aligned. This new feature addresses alignment issues that render some trapping
operations in PDF files extremely difficult.

Let's examine the PDF/XPS import options more closely and see how adjusting them will affect the transformation of
data.

Using PDF Engine Version 4.5
The following text flow options are available when PDF reports are brought into Monarch Classic using PDF Engine
version 4.5:
0O  Snap Text Left
Select this option to align the text to the left of the imputed PDF grid.
0 Snap Text Up
Select this option to align the text to the top of the imputed PDF grid.
0O Always Align Left
Select this option to always align text to the left of the imputed PDF grid.
0O  Suppress Left Whitespaces

Instructs Monarch to remove all left-side whitespaces when displaying the report.

Using PDF Engine Version 4.4 and Below

The following text flow options are available when PDF reports are brought into Monarch Classic using PDF Engine
version 4.4 and below:

0  Mono-spaced

Monarch’s Report view uses mono-spaced fonts, which are fonts bearing characters with the same width. For
example, in a mono-spaced font, the “0” and “i” characters would have the same width (i.e., they would take up

the same amount of horizontal space on aline). Other terms for mono-spaced are fixed-width and non-

proportional.
NOTE The opposite of mono-spacing is proportional spacing, in which different characters have
different widths, e.g., in a proportionally spaced font, the letter “0” would be wider than the
letter “i.”

Note that the Monospaced option is selected by default in the PDF/XPS Import Options window. When you
import a PDF/XPS file into Monarch, Monarch tries to detect when mono-spaced fonts are used and optimizes
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the conversion accordingly. In some cases, Monarch may not detect that mono-spaced fonts were used for the
PDF/XPS file. When this failure occurs, it is usually due to the simultaneous presence of mono-spaced and
proportional fonts in the same PDF/XPS file. If you know that the PDF/XPS file uses mono-spaced fonts, and the
Monospaced option is not selected during the import analysis, you can select this setting to force Monarch to
optimize for mono-spaced fonts.

While proportionally spaced fonts look more appealing, mono-spaced fonts are superior for tabular data because
the uniform width of each character makes alignment of columns easier.

NOTE In general, PDF/XPS files generated using mono-spaced fonts will convert more
successfully. Thus, if you are trying to optimize your PDF/XPS-producing application for
Monarch, use mono-spaced fonts. Some of the more common fonts include Andale Mono,
Anonymous, Crystal, Bitstream Vera Sans Mono, Courier, Courier New, Elronet Mono-
space, Everson Mono Latin 6, Fixedsys, Lucida Sans Typewriter, Lucida Console, and
PrestigeFixed.

Freeform

The Freeform option tries to optimize text that is more free-form than columnar or grouped columnar. A
columnar document is a simple table format, where grouped columnar might be something similar to one of the
Monarch sample reports, such as Classic.pdf.

A typical document that might benefit from using this setting would be an academic report that is 95% text, but
which contains a few tables you want to extract. Selecting this setting will sometimes work effectively on
columnar documents when the default settings do not produce good results.

Suppress Left Whitespaces

This option instructs Monarch to remove all left-side whitespaces when displaying the report.

Other Settings

a

Stretch

The stretch option governs how much spacing is used during the conversion process. When Monarch analyzes a
PDF/XPS file, it tries to match the spacing as closely as possible to the original document. However, many
factors can make it necessary to introduce more spacing into the conversion than appears to exist in the original
file, including hidden data in the PDF/XPS file itself, i.e., data which are not visible on screen but still exist within
the file. For example, in columns with truncated data, missing data may not be apparent at first glance, but
Monarch will still convert all of the data in the PDF/XPS file, not just what might be visible in a PDF/XPS viewing
application. In this case, to try and maintain proper column justification, Monarch will recalculate and pad the text
spacing, as the original column spacing may not be adequate to hold the data safely.

In general, Monarch uses a larger amount of spacing (i.e., a higher stretch value) than that applied in the original
document, which can make the document look like it is stretched wider than the original PDF/XPS. The
application errs on the side of caution, so that columns do not run into each other in a document. This is also
done so that if a later iteration of the same report (or a similar one) contains wider data values, the model will still
“work” with it.

If you know your reports well, you can decrease the stretch value to make the reports look more presentable by
avoiding horizontal scrolling or very small font sizes in the Report view.

Stretch values may be increased or decreased via the PDF/XPS Import Options window, which is launched when

you select PDF/XPS Options g in the Report ribbon or when you open a PDF/XPS file.
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o  Crop

The crop feature allows you to crop the outer edges of a document. For example, you may have a document
printed from a website that has graphics or other non-tabular information around its edges that is unnecessary.
Using the crop feature to discard the undesired information will not only reduce the amount of data you need to
import, but also assist in the parsing of the data, ensuring the best possible alignment.

Auto-adjust

Select this button to have Monarch automatically select the optimum settings for the displayed sample page.
Note that if you have changed any of the PDF import settings, clicking this will likely restore the original settings.

NOTE The PDF Import Options window provides an easy way to open PDF files and import them
into Monarch for data extraction into tables, but it is not the only way to do so. Annual
reports, for example, may include tabular data you wish to analyze, but their text-heavy
nature cannot be properly addressed by just this window. In this case, the powerful features
described of PDF Table Extractor may be necessary.

Let’'s try importing a PDF/XPS file that will require us to modify the PDF/XPS import options into Monarch.

Customizing PDF/XPS Import Options

STEPS:
1. Close all previous reports.
-]

2. Click File > Open - - Report > Computer.
3. In the Files of type drop-down box, select Adobe PDF files (*.pdf).
4. Select and open the CustomerSummary.pdf file.

You can also perform the next steps with an XPS file. In this case, open CustomerSummary.xps instead.
5. Expand the options of the Use Engine Version drop-down list and select 4.2 from the options that display.

Monarch opens the PDF Import Options window and displays the PDF file. Let's zoom into the report (by 145%
in the following example) so that we can view more of the sample data.

Design
2 Snap Text Left -] B Use Engine Version |45 v kA 2
v Snap Text Up e ‘o = 4 '] H
1 o
Accept  Cancel = || =Tvasossang . — Auto Show these options Toggle Help
Always Left Align Adjust | automatically Maximized Mode
Suppress Left Whitespaces
Text Flow Stretch Crop
Customer Address Amount 1 Amount 2 Amount 3
Betty's Music Store Muscatine Plaza 200 1,234.00 1234.00 1234.00

Lower Muscatine
Cedar Falls IZ 50613

Big Shanty Music 3658 Springs Ferry 34,567.00 34,567.00 34,567.00
Suite C-130
Marietta GA 30067

Bluegrass Records Huy 17 at the 9 mile markef 12,987,654.00 12,987, 654.00 12,987, 654.00
Prospect KY 40059

Hope's Sweet Notes 800 East Danforth 456,789.00 458,789.00 456,789.00
Hope AR 71801

Figure 6-21. A closer look at the CustomerSummary.pdf file.
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Notice that for Bluegrass Records, the value in the Amount 1 column begins one space too far to the right, so
that it doesn'’t line up properly with the Amount 1 values for the other three customers.

Let's assume that we know the font used to generate this PDF was Tahoma, which is a proportional font. A quick
visual investigation tells us this is not a freeform document but a columnar report. Let's try adjusting the Stretch
setting to see if this improves the conversion.

6. In the Stretch size indicator, shift the marker until the size reads 7.0. You may need to resize the window to the
right to see all of the data. Monarch applies the stretch setting and shows the results on the sample page. Note
that the Amount 1 value for Bluegrass Records now lines up correctly with the Amount 1 values of the other

Design
v S IEBLCE o B Use Engine Version [45 v L3 2
Snap Text Up. w s H
Accept  Cancel Always Left Align = Goooono ot e =% . . 0 oW Auto & Show these options Toggle Help
y y Adjust automatically Maximized Mode
Suppress Left Whitespaces
Text Flow Stretch Crop
Customer Address Amount 1 Amount 2 Amount 3
Betty's Music Store Muscatine Plaza 200 1,234.00 1234.00 1234.00
Lower Muscatine
Cedar Falls IA 50613
Big Shanty Music 3658 Springs Ferry 34,567.00 34,567.00 34,567.00
Suite C-130
Marietta GR 30067
Bluegrass Records Hwy 17 at the 9 mile marker 12,987,654.00 12,987,654.00 12,987,654.00
Prospect KY 40059
Hope's Sweet Notes 800 East Danforth 456,789.00 456,789.00 456,7859.00
Hope AR 71801

Figure 6-22. Viewing the adjusted sample page.
The current adjustment will now allow you to correctly capture the data in this column, a key Monarch feature,
and place them in a table.

7. Click the Accept v button to close the PDF/XPS Import Options window and open the PDF file as a report.

A closer look at all of the options available in the PDF/XPS Import Options window may be found here.
This lesson completes Chapter 5. If you plan to go on to Chapter 6 now, you may leave Monarch open but select the

File tab and then click Close All rr. Select No when asked if you want to save changes to the model or project you
created. If you plan to go on to Chapter 6 at a later time, select File > Exit Monarch Classic.
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[7] EXTRACTING DATA FROM A
REPORT

In Chapter 6, you learned how to use the Report view to explore a report on screen. While this function is very useful,
you probably won't find anything new or useful that is different from simply reading the report off-screen.

Monarch’s technology gives you access to the data buried in your reports and allows you to analyze them to obtain
new information. By defining data extraction templates, you can extract data from any report and then analyze them
using the Table and Summary windows. In this chapter, you will learn how to extract data from a typical report. The
lesson topics include:

0 Determining what an extraction template is
Creating various data extraction templates
Displaying data in Table view

Modifying some template properties

0O 0 0 O

Saving your work to a model file

To get started on this lesson, close all previous reports and open Classic.prn.

GETTING TO KNOW REPORT DESIGN VIEW

Our jump-off point for creating data extraction templates is the Report Design interface, which is accessed by
selecting Report Design E’ from the Report ribbon.

The Report Design Interface

Let's take a minute to explore what you can find in the Report Design interface. The Report Design interface is
divided into five distinct areas:

U The Report Design ribbon is located on the top-most portion of the interface and spans the entire width of the
screen. This ribbon will allow you to perform many of the report design functions made available by Monarch.

0 The Template Selector displays as a panel on the left-hand side of the interface. You can choose specific
templates to view and modify from this selector, a functionality that is especially handy when you have defined
multiple templates. You can also float, dock, dock as a document, auto-hide, or close this panel.

0 The Template Editor is displayed in the middle of the interface. The Template Editor remains disabled until you
select a new template to create.

0 The right-hand side of the interface displays the general properties of a field in the Field Properties panel. Each
field you define in a template has its own properties. You can set new properties or edit existing ones using this
panel. Similar to the Template selector, you can also float, dock, dock as a document, auto-hide, or close this
panel.

0 Below the Template Editor is a Data Preview panel. This panel automatically generates a preview of what your
table will look like, including all of its content, while you build templates to extract the desired data from your
report. Similar to the Template selector and Field Properties panel, you can float, dock, dock as a document,
auto-hide, or close this panel.
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v X Template Name:

Accept  Cancel

Templates

1

Template Role:

Detail

v R

New
Template ~ Template

Template Editor
02/01/10

CUSTOMER:

IACCOUNT NUMBER:
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MEDIA QTY
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o
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»
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P 3

aring

Delet:
I plate v

e ed
Sample Text Sample Te

Auto-Define Auto-
Tra

CLASSICAL MUSIC DISTRIBUTORS
MONTHLY SHIPPING REPORT
FROM 01/01/10 TO 01/31/10

Betty's Music Store
Muscatine Plaza

200 Lower Muscatine
Cedar Falls, IA 50613
B

11887

Betty Yoder

DESCRIPTION

ORDER NUMBER: 536017
Bartok,
Mozart,
Luening,

Sonata for Solo Vielin
Mass in C, K.427
Electronic Music

Scarlatei, Stabat Mater

ORDER NUMBER: 536038
Beethoven, Pathetique Sonata, Arau
Mendelssohn, War March of the Priests
Pizzetti, Messa di Requiem

Misc., Modern Trombone Masterpieces

SHIP DATE:

SHIP DATE:

LABEL/NO.
o01/10/10
MK-42625
420831-2
CD 611
SBT 48282
01/21/10
420153-2
SME 47592
CHAN 2964

ADA 58108

il & | 7
Define | Multi-Column Run Report | Report Help
elds gion Verify Colors.
PAGE 01
UNI_PRC  AMOUNT
s.00 35.08
5.00 63.00
10.1% 20.38
5.88 53.81
5.89 5.3
2,02 71.92
5.59 85.90
7 10.79 64.74

~  Field Properties

Name:
Template Width: |1
Type:

Decimals 0
Format:

Display Width:

Alignment:

Copy Value From Previous Record

Hidden

Data Preview

Filter: No Fifter SortNo Sort_0 Rows.

Next Field >

wow ———————+

Figure 7-1. Launching the Report Design interface and Template Editor.

The figures below show examples of what a Data Preview panel might contain:

Data Preview
Jort Date
/2010
/2010
J2010
/2010
J2010
/2010
J2010
J2010
9 /2010
10 /2010
11 /2010
12 J2010
13 /2010
14 /2010
15 /2010

4

@~ b W e

Page
(138
0
01
(131
01
01
01
01
01
02
02
02
02
02
02

Order._.
536017
536017
336017
536017
336039
536039
536039
336039
536039
5336016
536016
536016
536016
536029
536020

Ship Date
4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/21/2010
4/21/2010
4/21/2010
4/21/2010
4/21/2010
4/5/2010
4/5/2010
4/5/2010
4/5/2010
4/14/2010
4/14/2010

Contact

Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry

Account Number
11887
11887
11887
11887
11887
11887
11887
11887
11887
17959
17939
17959
17939
17939
17939

Media
cD

ovD

DVD

Quantity Description

-
=T N

4

~

=
=

WMo WO oo

Bartok, Senata for Solo Violin

Mozart, Mass in C, K.427

Luening, Electronic Music

Scarlatti, Stabat Mater

Beethoven, Pathetique Sonata, Arau
Mendelssohn, War March of the Priests
Pizzetti, Messa di Requiem

Misc., Modern Trombone Masterpieces
Gershwin, An American in Paris
Stravinsky, Dumbarton Oaks Concerto
Schubert, Sonata in e, D.566

Mozart, Symphony No.23 in D
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Balakirev,Symphony no. 1

Label Number
MK-42625
420831-2
D611

SBT 48282
420153-2
SMK 47592
CHAN 8964
ADA 381087
ACS 8034
SMCD 5120
AS-325
CO-77884
CHAN 9116
CDA 66620
ENTPD 4110

Unit Price.  Amount =
8.99 35.96
9.00 63.00
10.19 20.38
5.99 53.91
5.99 65.89
8.99 71.92
9.59 95.90
10.79 64.74
5.99 35.94
8.99 53.94
9.00 9.00
8.99 26.97
9.5 57.54
5.39 10.78
9.59 86.31 |=

L3

Figure 7-2. The Data Preview tab provides users with a tabular

Detail template are shown.

Data Preview
Jort Date
J2010
J2010
J2010
J2010
J2010
J2010
J2010
J2010
9 /2010
10 /2010
11 /2010
12 /2010
13 /2010
14 /2010
15 /2010

4

@~ oL AW

Page
01
01
01
0L
01
0L
01
0L
0L
(123
(124
0z
124
0z
(123

Order...
536017
536017
536017
536017
536039
536039
536039
536039
536039
536016
536016
536016
536016
536029
536029

Ship Date
4/10/2010
4/10/2010
4/10/2010
4/10/2010
4/21/2010
4/21/2010
4/21/2010
4/21/2010
4/21/2010
4/5/2010
4/5/2010
4/5/2010
4/5/2010
4/14/2010
4/14/2010

Account Number
11887
11887
11887
11887
11887
11887
11887
11887
11887
17959
17959
17959
17959
17959
17959

Contact
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry

Media
[ss]

DvD

SACD

sample of their extracted data In this example, data from a

Quantity Description

[

WO W OGOy Dm0 N

-

Bartok, Sonata for Solo Violin

Mozart, Mass in C, K.427

Luening, Electronic Music

Scarlatti, Stabat Mater

Beethoven, Pathetigue Sonata, Arau
Mendelssohn, War March of the Priests
Pizzetti, Messa di Requiem

Misc., Modern Trombone Masterpieces
Gershwin, An American in Paris
Stravinsky, Dumbarton Oaks Concerto
Schubert, Sonata in e, D.566

Mozart, Symphony No.23 in D
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Balakirev,Symphony no. 1

Label Number
MK-42625
420831-2
(D611

SBT 48282
420153-2
SMK 47592
CHAN 8964
ADA 581087
ACS 8034
SMCD 5120
AS-325
Co-77884
CHAN 9116
CDA 66620
ENTPD 4110

Unit Price. Amount |«
8.00 35.96
9.00 63.00
10.18 20.38
5.99 53.91
5.99 65.89
8.99 71.92
9.59 95.90
10.79 64.74
5.99 35.94
8.99 93.94
9.00 9.00
8.99 26.97
9.59 57.54
5.39 10.78
9.59 86.31 |»

Figure 7-3. The Data Preview panel showing the data captured by an Order Number Level (append) template.
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Data Preview
Report Date Page Order_. Ship Date

Account Number
11887
11887
11887
11887
11887
11887
11887
11887
11887
17959
17959
17959
17959
17959
17959

Contact

Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Betty Yoder
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry
Marvin Mabry

Media  Quantity Description
co 4 Bartok, Sonata for Solo Violin
7 Mozart, Mass in C, K.427
2 Luening, Electronic Music
DVD 9 Scarlathi, Stabat Mater
co 11 Beethoven, Pathetique Sonata, Arau
8 Mendelssohn, War March of the Priests
10 Pizzetti, Messa di Requiem
LP 6 Misc., Modern Trombone Masterpieces
ovD 6 Gershwin, An American in Paris
co 6 Stravinsky, Dumbarton Ozks Concerto
1 Schubert, Sonata in e, D.566
3 Mozart, Symphony No.23 in D
6 Schoenberg, Ode to Napoleon
2 Shostakovich, 24 Preludes for piano.
9 Balakirev,Symphony no. 1

co
SACD

1 5/1/2010 01 536017 4/10/2010
2 5/1/2010 01 536017 4/10/2010
3 512010 01 536017 4/10/2010
4 5/1/2010 01 536017 4/10/2010
5 5/1/2010 01 536039 4/21/2010
6 5/1/2010 01 536039 4/21/2010
7 5/1/2010 01 536039 4/21/2010
8 5/1/2010 01 536039 4/21/2010
9 5/1/2010 01 536039 4/21/2010
10 5/1/2010 02 | 536016 4/5/2010
11 5/1/2000 02 | 536016 4/5/2010
12 5/1/2010 02 | 536016 4/5/2010
13 5/1/2010 02 | 536016 4/5/2010
14 5/1/2010 02 536029 4/14/2010
15 5/1/2000 02 536029 4/14/2010
[ |

Label Number

MK-42625
420831-2
CD 611

SBT 48282
420153-2
SMK 47592
CHAN 8964
ADA 581087
ACS 8034
SMCD 5120
AS-325
CO-77884
CHAN 9116
CDA 66620
ENTPD 4110

Unit Price

8.99
9.00
10.19
5.99
5.99
8.99
9.59
10.79
5.99
8.99
9.00
8.99
9.59
5.39
9.59

Figure 7-4. The Data Preview panel shows the data captured by a Page Header template.

Note that as each template is selected from the Template selector, the corresponding columns defined by this

template are highlighted in the Data Preview panel and characterized by a specific color, which we will learn to modify

later in this chapter.

The Report Design Ribbon

The following table summarizes the functions of each of the buttons in the Report Design ribbon.

Accept the new template or changes to an existing

v Accept

“ Cancel

Template Name

Template Role

New Template

Delete Template

=
=% Clearing Template

-
“% Auto-Define Trap

Sk Auto-Define Fields

Eu Multi-Column Region

EQ Run Report Verify

Replace Sample Text

Redact Sample Text

Altair Monarch 2024.1 Learning Guide

template

Cancel the new template or changes to an existing

template

Specify a new template name or modify an existing one

Display the role of the template selected

Specify a new template

Delete a template

Select a new line in the report with which to base a

template

Apply redaction to selected text. More information is

available here.

For footers and appends, remove “assumed” values
copied up (for footers) or down (for appends) when only
intermittent data are available. More information on this

feature may be found here.

Allow Monarch to automatically create traps for selected

lines in the report

Allow Monarch to automatically specify table fields based

on selected lines in the report

Specify multi-column region settings

Verify that the boundaries of fields are properly defined
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https://help.altair.com/2024.1/monarch/help/Clearing_Template.htm

Specify template colors

Q Report Colors
? Launch the Help file

The Report Design Context Menu

When you open a report in Report Design view and right-click on your mouse in the Template Editor, a context menu
displays. This menu will allow you to:

O  Copy text 0O  Add, edit, or remove bookmarks

O  Search for arecord 0 Zoom to fit

EXTRACTING DATA USING TEMPLATES

Imagine taking a piece of cardboard and cutting holes in it at certain locations. If you place this imaginary cardboard
template on a printed report, you will see only the information that shows through the holes. Monarch uses electronic
templates to extract information from your report files in a similar manner. If your report is sorted on several levels,
i.e., if you have blocks of data arranged in a repeating manner throughout your report and you want to extract the
same, you define a separate template for each sort level.

Classic.prn report a simple structure, so extracting information from it is relatively easy. The file represents a monthly
shipment report for a distributor of classical music recordings. Like many reports, Classic.prn is organized into
multiple sort levels. The entire report is sorted by customer. Within each customer, orders are sorted by ship date.
Within each order, shipments are itemized on detail lines. In addition, three header lines appear atop each page.

05/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01
10:17 MCHTHLY SHIPPING REPCRT
MSR94 FRCM 04/01/10 TC 04/30/10

CUSTCHER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IR 50613
TSR

ACCOUNT NUMBER: 11887

CONTRCT: Betty Yoder

MEDIZ QTY DESCRIPTION LABEL/NC. UNT_FRC AMOUNT

CRDER NUMBER: 536017 SHIP DATE: 04/10/10

cD 4 Bartok, Sonata for Solo Violin ME-4Z625 8.99 35.96
T Mozart, Mass in C, K.427 4Z0831-2 9.00 63.00

2 Luening, Electronic Music CD 611 10.19 20.38

DVD 9 Scarlatti, Stabat Mater SBT 48Z82 5.9%9 53.91

CRDER NUMBER: 536039 SHIP DRTE: 04/21/10

CcD 11 EBeethoven, Fathetigue Sonata, Arau 420153-2 5.9%9 65.89
8 Mendelssohn, War March of the Priests SME 47592 g.9%9 71,82

10 Pizzetti, Messa di Reguiem CHEN B964 8.59 85.9

LP 6 Misc., Modern Trombone Masterpieces LDR 5B1087 10.79 64.74
DVD & Gershwin, BEn American in Paris LCS BO34 5.090 35.04

Figure 7-5. Page 1 of the Classic.prn report.
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In this chapter, Monarch will draw data out of each level in the report based on templates that you define. You will
start by defining a detail template. Then, you'll define an append template to extract fields from each sort level and
a page header template to extract fields from the page header. Fields from the append templates and the page
header template will be appended to fields from the detail template to produce database records.

We'll use a sample line to identify all of the other detail lines throughout the report via a process called trapping. By
setting a trap, you tell Monarch which lines to capture and which to ignore.

A detail trap identifies common features shared by all of the detail lines throughout the report, but not shared by
other lines in the report, such as page header lines, lines containing labels, or lines from higher sort levels. A proper
detail trap will capture only those lines we want while ignoring lines from headers and other sort levels.

In the Classic.prn report, we need to look for features that differentiate the order information lines from the title, date,
and page number lines at the top of each page. Specifically, we need to look for characters, such as letters, numbers,
or punctuation, which always appear at the same position in the detail lines, but do not appear in any other lines.

Design
Template Name: =y - == = - W L=| =
=1 it =R = = = 7 2?
Y Xpa ) B , * 2 B2
Accept  Cancel ) New  Delete Replace  Redact  Clea Auto-Define A = | Multi-Column RunReport | Report Help
Template Role: Templatev Template | Sample Text Sample Text Te: Trap Region Verify Colors
A~
Templates s« B || Template Editor Rl Ficld Propertics [
Standard Tra) “|E N R @ 0 - « + Trapline v [¥) ResetTrap Line 50 Reset Fields Edit Field Delete Field i~
il L [standard Trap i 0 Trap L "8 Reset Trap Li Reset Field
=l Detail Name:
FD 4 Bartok, Sonata for Soleo Vielin MK-42625 g.29 35.96
»(05/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01 ) | Termplate Width: |1
2[10:17 MONTHLY SHIPPING REEORT
>MSRE4 FROM 04/01/10 TC 04/30/10 Type: -
Decimals:
= CUSTOMER: Betty's Music Store
» Muscatine Plaza P .
> 200 Lower Muscatine crme
= Cedar Falls, IA 50613
® usa
» ACCOUNT NUMBER: 11887
£ Copy Value From Previous Record
= CONTACT: Betty Yoder
> Hidden
»MEDIA QTY DESCRIPTION LABEL/NO. UNT_ERC EMOUNT . .
E = < Previous Field Next Field >
» ORDER NUMBER: 536017 SHIP DATE: 04/10/10
> CD 4 Bartok, Sonata for Sole Vielin MK-42625 g.99 35.986
- 7 Mozart, Mass in C, K.427 420831-2 2.00 63.00
> 2 Luening, Electronic Music CD 611 10.19 20.38
»
= DVD 8 Scarlatti, Stabat Mater ST 48282 5.8 53.81
- ORDER NUMBER: 536039 SHIP DATE: 04/21/10
»
=D 11 Beethoven, Pathetigue Sonata, Arau 420153-2 s.88  65.%9
4 & Mendelssohn, War March of the Priests SMK 47592 g.29 71.92 -
El »
Data Preview v R
4 » -
Trap: Position 1 Pagel  100% ——R———+

Figure 7-6. The Template Editor allows users to define templates with which to trap data.

Selecting a new template to create or opting to edit an existing one activates the Template Editor. In the Template
Editor, the Template Name and Template Role fields are automatically populated with the type of template we are
going to create. In the example above, we opted to create a new detail template. The Template selector on the left
side of the image also displays the template name. We can change this name by simply changing the entry in the
Template Name field.

Templates ~ 1
N L
=l Detail

Figure 7-7. The Template Selector.

Note also that most of the buttons that were previously deactivated in the Report Design view are activated in the
Template Editor.
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The line you select for trapping displays on a yellow background on the Editor. This line is called the Sample Text
box. Above the Sample Text box is the Trap line, which we will use to create our traps. The different trap types we
can use are found in the Action bar. To the left of the Template Editor is the Line Selection area, which we will use
extensively to select lines to trap.

Template Editor
— = — @—— Action Bar
Standard Trap < R|f| B @ | & - |« = Tapliner [¥)ResetTrapLline FO ResetFields =
| HBRE @—— Trap Line
| dQlBartok, Sonata for Solo Violin BEEE  WECETN®— sample Text Box
ORDER NUMBER: 536017 SHIP DATE: 01/10/10
> |CD 4 Bartok, Sonata for Solo Violin ME-42625 8.95 35.898
» 7 Mozart, Mass in C, K.427 420831-2 %.00 63.00
® 2 Luening, Electronic Music CD 611 10.19 20.38 . .
[ Line Selection Area
= DVD % Scarlatti, Stabat Mater S5BT 48282 Eleisiz) 53.81
CRDER NUMBER: 536039 SHIP DRTE: 01/21/10
= |CD 11 GEeethoven, Pathetigue Sonata, Arau 420153-2 ez 65.89
® 8 Mendelssohn, War March of the Priests SME 47592 B.99 71.92
S 10 Pizzetti, Messa di Reguiem CHAN £0964 St 95.90
» | LP & Mizsec., Modern Trombone Masterpieces ADA SE1087 10.79 64.74
= | DVD 6 Gershwin, An American in Paris ACS B034 ST S5ings

Figure 7-8. Specific areas of the Template Editor.

Several types of traps are available:

Trap any letter
A Alpha trap pany
fi . Trap any number
M Numeric trap P any
Trap blank spaces
& Blank trap P P
Trap any character that is not a space
e Not blank trap P any P
| . A special trap, used to trap numbers which may or may
Numeric OR trap not appear in certain positions. A good example is an
accounting report, where a number may appear in a credit
or debit column, but not both. Using two numeric OR traps
will trap a number in either position.
o Trap special characters
Character trap
- Trap any character EXCEPT the specified trap character
NOT trap P any P P
Exact match trap Trap a specific character or series of characters. Exact-

match traps are created by typing the exact characters or
series of characters in the trap line.
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Aside from simply creating traps, the Action bar allows you to perform other actions:

Standard Trap = Trap Type

Regular Expression Trap

Options
Trap Line
-—

Push Left

=
Push Right

™D Reset Trap Line

Reset Fields

xll

Delete Field

* Edit Field

Specify the trap type to create: Standard Trap, Regular
Expression Trap, or Floating Trap

Select options to apply when creating regular expression
traps: Ignore Case, Explicit Capture, or Ignore Pattern
Whitespace

Specify a different trap line on which to base a template if
the sample text is composed of multiple lines

Adjust a selected trap character or field one character to
the left

Adjust a selected trap character or field one character to
the right

Discard all changes made to the Trap line and start again
Discard all fields specified and start again
Delete a specific field

Launch the Field Definition window

To generate a table, Monarch produces one record for each detail line extracted from the report. The detail line
contains the data that changes most often in the report and is usually the report’s lowest sort level. Append templates
add, or append, information from higher sort levels to the table. In this lesson, we will extract fields from four levels in
the report: the detail level, two sort levels, and the page header.

CREATING A DETAIL TEMPLATE

A detail template extracts data from the lowest level in the report, which, in this, case are the lines representing

individual shipments.

To create the detail template, we'll select a sample detail line, use this line to identify other detail lines, and highlight
the fields to extract. For this lesson, we’ll use Classic.prn and keep the Field Properties panel auto-hidden from view

until we need it.

Selecting a Line to Trap

STEPS:

1. Inthe Report ribbon, select the Report Design IE:, button.

The Report Design view displays.
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As expected, most of the buttons in the ribbon are deactivated.

Design
Template Name: - W =
v % = B |2
Accept Cancel ) ew  Delete eplace edact  Clearing | Auto-Define Auto-Define | Multi-Column RunReport | Report Hel
Template Role: Template v Template | Sample Text Sample Text Template ~ Trap Fields gion Verify G &
Detail
Templates v R | Template Editor ~ Field Properties v
il el 02/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01 - -
10:17 MONTHLY SHIPPING REPORT Name:
MSRS4 FROM 01/01/10 TO 01/31/10

Template Width: |1
CUSTOMER: Betty's Music Store
Muscatine Plaza Type: v
200 Lower Muscatine :
Cedar Falls, IA 50613

Decimals
Usa
Format: ~
ACCOUNT NUMBER: 11887
Display Width:

CONTACT: Betty Yoder

Alignm

MEDIA QTY DESCRIPTION LABEL/NC. UNT_PRC  AMOUNT

falue From Previous Record

ORDER NUMBER: $36017  SHIP DATE: 01/10/10 Hidden
o 4 Bartok, Sonata for Solo Violim MK-42625 s.92 35,96 —— :
7 Mozart, Mass in C, K.427 420831-2 9.00  63.00 Ll ] Riextpckdbs
2 ZLuening, Electronic Music oD el 1013 20.38
VD 9 Scarlatci, Stabat Mater sBT se2e2 5.8 5391

ORDER NUMBER: 536038 SHTP DATE: 01/21/10

cD 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.88 65.28
& Mendelssohn, War March of the Priests SME 47592 2.99 71.92
10 Pizzetti, Messa di Reguienm CHAN 2964 5.59 85.90
P 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
‘. 0
Data Preview v R

Filter No Filter SorcNoSort  ORows  100% — ——f———+

Figure 7-9. Most of the buttons in the Report Design interface remain deactivated until you activate the Template
Editor.

2. Click on the line selection area to the left of the line containing the item description Bartok, Sonata for Solo
Violin.

On the Report Design ribbon, select New Template > Detail.
4. Type “Line Item Detail” into the Template Name field and then press Enter on your keyboard.
This step changes the template name. Changes are immediately reflected in the Template Selector.

5. Ensure that the Trap Type is set to Standard Trap.

Trapping the Detail Lines

Let’s create our detail trap.

STEPS:

1. Clickinthe Trap line above the number 4. If the cursor is not positioned correctly, you can use the Push Left

.
or Push Right keys to move it to the correct position.

2. Click the Numeric Trap " icon. “N” appears in the Trap line, representing any number in the designated
column position.

3. Click the Blank Trap % button twice. “RR” appears adjacent to the first trap character, representing a blank in
each column.

4. Click the Non-blank Trap e button. “@” appears in the Trap line, representing any non-blank character.
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By combining these trap characters (see Figure 7-10), we're telling Monarch to “trap only those lines with a

number, followed by two blank characters, followed by a non-blank character in the specified positions.”

Template Editor

|Standard Trap V| AN B Q| 8 - « - Trap Line ~ -5 Reset Trap Line 505 Reset Fields Edit Field Delete Field
NREE
CD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 35.96
05/01/10 CLESSICAL NMUSIC DISTRISUTORS PAGE 01
10:17 MONTHLY SHIFPING REFCRT
MSRO4 FRCM 04/01/10 TC 04/30/10
Figure 7-10. The completed trap definition.

5. Scroll through the report to ensure that the trap captured all of the detail lines and no other lines.

The results of our trap are indicated by guillemets (») appearing in the line selection area to the left of each line

that is selected by the trap, and only those lines including the data you wish to capture should display these

marks.

Template Editor

Standard Trap A N R O | &8 - - >

Trap Line ~ -‘5} Reset Trap Line

=-_'9 Reset Fields

Edit F

ela

Delete Field

oSt
tD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 35.96
-
BCCOUNT NUMBER: 11887
COMNTACT: Betty Yoder
MEDIZ QTY DESCRIPTION LABEL/NO. UNT_PRC AMCUNT
CRDER NUMBER: 536017 SHIP DATE: 04/10/10
»ICD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 B IInEe
7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
® 2 Luening, Electronic Music CD 611 10.19 20.38
= DVD S Scarlatti, Stabat Mater SBT 48282 B2z 53.91
CRDER NUMBER: 536039 SHIP DATE: 04/21/10
»CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.89 65.89
8 Mendelssohn, War March of the Priests SMKE 47552 8.99 T71.92
® 10 Pizzetti, Messa di Requiem CHAN B89&4 353 85.90
»LP & Mi=sc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
*» DVD 6 Gershwin, &n American in Paris ACS 8034 5.899 35.94
05/01/10 CLASSICAL MUSIC DISTRIBUTICRS BRGE 02
Figure 7-11. Results of the detail trap.
NOTE If you make mistakes when entering the trap characters, you can highlight the incorrect trap

Altair Monarch

characters and press DELETE on your keyboard to remove them. To delete all trap
-me

characters, click Reset Trap Lin
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Highlighting Detail Fields

When the trap you specified has captured all of the detail lines and no other lines, you're ready to highlight the fields
to extract.

Although we can manually highlight and name the fields to be extracted, let's try using the Template Editor's Auto-
Define Fields feature, which allows us to automatically highlight fields in the template. This feature uses Monarch’s
built-in parsing and data recognition capabilities to determine where fields begin and end.

The Auto-Define Fields =% button automatically highlights fields in your template. You can use this capability as a
jump-start when highlighting fields in your templates, and we will in fact use this in our lesson, but you should not rely
upon this feature exclusively, as Monarch cannot predict which fields you might want to extract and which you want to
leave out, nor can it deal with the subtleties of report design that allow fields to wrap onto multiple lines or about one
another.

STEPS:

1. Click Auto-Define Fields = on the Report Design ribbon.
Each field that is found in the detail template is highlighted.

Template Editor ~

|StandardTrap V| A i B 0 8 - + =+ Trap Line v -5 Reset Trap Line D Reset Fields S# Edit Field Sx Delete Field
NBRE
= BN

BCCOUNT NUMBER: 11887

Figure 7-12. Results of the Auto-Define Fields command.

2. Check the Data Preview panel to see what your table will look like with the information obtained by your

template.

Data Preview ~ 1
eg_4 eg_Bartok, Sonata for Solo Viol eg_MK-42625 eg_B_99 eg_35 96 eg_CD -

1 4 Bartok, Sonata for Solo Violin MK-42625 8.99 35.96 CD

2 7 Mozart, Mass in C, K.427 420831-2 0.00 63.00

3 2 Luening, Electronic Music CD 611 10.19 20.38

4 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91 DVD

3 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.09 65.89 CD

6 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92

7 10 Pizzetti, Messa di Reguiem CHAN 8964 9.59 95.90

8 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74 LP

9 6 Gershwin, An American in Paris ACS B034 5.99 35.94 DVD

10 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 8.99 53.94 CD .

:1 1 Crhubrrt Can-f- in o N SAS AC 2T 000 000 ’

Figure 7-13. Data Preview results of the Auto Define Fields command.

3. Click Accept v to accept your template definition.

Congratulations! You have just created your first template. Figure 7-14 shows changes that occur in the Report
view once a template is defined for a report.
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File Home Report  Table Summary Export ?

==, L?# Select All as = & Previous Report [ Next Report I T:= g f"r'
Report P @ Zoom To Fit [ Copy Search  Findin 4 Previous Page & Next Page Bookmark Report PDE/XPS | Chunk
e bl LA v index~ | Options | Options
& B Greenbar (. Go To Page 4" Go To Chunk
A
Home m v
Report Files. | 05/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01 -
10:17 MONTHLY SHIPPING REBORT
kel SR94 FROM 04/01/10 TO 04/30/10

Classic.pm
CUSTOMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
usa

ACCOUNT NUMBER: 11837

CONTACT: Betty Yoder

MEDIA QTY DESCRIPTION LABEL/NO. UNT_PRC  AMOUNT

CRDER NUMBER: 536017 SHIP DATE: 04/10/10

>co 4 Bartok, Sonata for Solo Violin ME-42625 £.93  35.96
> 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
> 2 Luening, Electronic Music cp 611 10.18  20.38
>DvD 9 Scarlatti, Stabat Mater SBT 48282 5.93  53.91
CRDER NUMBER: 536038  SHIP DATE: 04/21/10
>cp 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
> 8 Mendelssohn, War March of the Priests  SMK 47592 g.83  71.92
> 10 Pizzetti, Messa di Requiem CHAN 8264 .59 85.90
3 6 Misc., Modern Trombone Masterpieces 2DA 581087  10.79 64.74
P .. CErair T e toani o TN CCeNens ., nen... e
05701710 CLASSICAL MUSIC DISTRIBUTORS PAGE 02
10:17 MONTHLY SHIPPING REPORT
SRO4 FROM 04/01/10 TO 04/30/10

CUSTOMER: Big Shanty Music
3658 Springs Ferry
anire Co130

1 >

R i —1

Figure 7-14. The completed detail template.

Verifying Field Boundaries

Although you could scroll through the report to ensure that each field highlight is long enough to capture all of your
data, this method becomes tedious when you are working with large reports. Therefore, a Field Verification feature
is provided to read the entire report and verify that your fields are properly defined.

When you activate the field verification feature, Monarch scans the entire report and examines field boundaries. If any
characters are found immediately adjacent to a field, Monarch will highlight the field to alert you that the field
definition may be too short to accommodate a field value or that the field may be defined at the wrong location.

The Report Verify window displays when you select Run Report Verify E‘Q from the Report Design ribbon. The
following table describes each of the buttons in this ribbon.

v 4 Accept Accept the results of a verify operation

x Cancel Cancel the verify operation

= Adjust the highlighting of the field one character to the left
+  Adjust left

=l Adjust the highlighting of the field one character to the
*+ Adjust right right

k . . Automatically adjust all field definitions, thereby
/% Adjust all fields eliminating the need to go over an entire report to ensure
that all required fields are captured properly.

& Ignore all field-highlighting issues of the type reported in
Ignore all the template and continue with the verify operation;
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subsequent verify operations will not highlight issues of
the type previously ignored

D Continue the verify operation after correcting an issue
Continue

¥ Restart the verify operation
D Start over

@ Stop the verify operation
Stop
E‘ Reverse the Ignore all command; subsequent verify
EQ Reset Ignore Rules operations will highlight issues previously ignored
‘? Help Launch the Help file
NOTE If multiple reports are loaded, Report Verify automatically scans through all of them. When

Verify is started it always starts at the first page of the current report, and will continue to
report verify hits from that and other reports until it has cycled through all of the reports,
thereby completing a full pass.

Verification will start over from the top of the current report and re-scan for verify hits (but
with any ignores still in effect). Upon reaching the end of a pass without ever having
stopped, the dialog returns a message saying that verification has been completed. In this
way the user can clearly see when they have succeeded in making a complete "clean" pass
through the report(s).

Let's verify that our field boundaries are correct.

STEPS:

1. Return to Report Design and then click Run Report Verify EIQ

A status dialog displays the current status of the verify operation. When the verify operation is completed without
errors, Verify completed displays in this dialog. This status indicates that all of our fields are properly defined.

Report Verify >

Verify completed.

Figure 7-15. A completed Verify operation.

We can expect this result for the fields of our detail template because we used Monarch’s Auto-Define Fields
feature to define them.

2. Click OK to close the Report Verify dialog and Accept v to accept the Report Verify results.
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CREATING APPEND TEMPLATES

In the Classic.prn report, orders are sorted by order number. Also at this sort level are ship data. We'll create an

append template to extract these two fields and an additional append template to extract the account number and
contact fields that appear at the next higher level.

The procedure for extracting fields from each sort level is the same as that for extracting detail fields. First, we'll
select a sample, then we'll trap other occurrences of the sort level throughout the report, and then we’'ll highlight the
fields we want to extract.

STEPS:

1. In the same report, select Report Design E’ once more.

2. Select the line containing the words ORDER NUMBER. This line is indented and appears below the line
containing several field names and above the item details.

3. Onthe Report Design ribbon, select New Template > Append. Ensure that the Trap Type is set to Standard
Trap.

The Template Editor is activated and the line we selected is copied into the Sample Text box. Note also that the
Template Name and Template Role fields are updated to reflect our selected template tape.

Template Editor ~

Standard Trap “|A 0 B 0 | & - « -+ Trap Line -5 Reset Trap Line 55 Reset Fields Edit Field Delete Field

| ORDER NUMEBER: 536017 SHIP DATE: 04/10/10
»05/01/10 CLASSICAL MUSIC DISTRIBUTCRES PAGE 01 -
*10:17 MCHTHLY SHIPPING REPCRT
* MSR94 FROM 04/01/10 TO 04/30/10

= CUSTCHMER: Betty's Music Store
Mu=scatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
TSR

ACCOUNT NUMBER: 11887

CCNTACT: Betty Yoder

MEDIZ QTY DESCRIPTICON LABEL/NC. UNT_PRC AMOUNT

ORDER NUMBER: 536017 SHIP DATE: 04/10/10

¥ oYW OB Y OM B M B Y YN Y Y Y MY EY MY Y E Y ¥ Y

CD 4 Bartok, Sonata for Solo Violin ME-426825 8.99 35.96

7 Mozart, Ma=z=z in C, K.427 420831-2 S.00 &§3.00

2 Luening, Electronic Music CD 611 10.1% 20.38
DVD 9 Scarlatti, Stabat Mater S5BT 48282 5.9%9 53.81

CRDER NUMBER: 536039 SHIP DATE: 04/21/10

CD 11 Beethoven, Pathetigue Sonata, Araun 420153-2 5.89%9 65.89

8 Mendelssohn, War March of the Priests SME 475592 8.9%9 71.82 -
4 (4

Figure 7-16. The selected ORDER NUMBER line.

NOTE There can only be one detail template for any model you create. The total number of all
append and footer templates cannot exceed 20. For each footer template used, there is one
less append template available. For example, if you create three footer templates, then only
17 appends can be used.
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Trapping the Ship Date Lines

We'll use an exact match trap to capture all lines representing the order number level. An exact match trap looks for
an exact match of a character or series of characters.

STEPS:
1. Continuing from the previous exercise, click in the Trap line above the colon following ORDER NUMBER in the
sample line.
2. Type a colon (:) in the Trap line directly above the first colon in the Sample Text box.
Type another colon (:) directly above the second colon in the Sample Text box.
4. Highlight the fields marked by 536017 and 04/10/10 in the Sample Text box as shown in Figure 7-17.
NOTE Remember that your Date Format setting must be set to M/D/Y to properly capture date
inputs in the sample reports we'll be using for this guide.
.
AfiR oo O - <« = Teplinev [®ResctTropline 55 ResctFields S# EditFicld 3% Delete Field
ORDER N‘U‘MBER; SHIP DATE; 04/10/10
05/01/10 CLASSICAL MUSIC DISTRIBUICRS PAGE 01 -
10:17 MONTHLY SHIPFING REFORT
MSR94 FROM 04/01/10 TO 04/30/10
Figure 7-17. Highlighting the Order Number and Ship Date fields.
5. Scroll through the report to see the results. Note that, on the fourth page of the report, the “RETURN

AUTHORIZATION” and “RECEIVED” fields have been highlighted (see Figure 7-18). We don’t want to capture
these fields, so we need to edit our template definition.

Template Editor ~
Standard Trap «|A 0 R @ 8 -~ « » Traplinev [¥)ResetTrapline 0 ResetFields S# EditField S Delete Field

ORDER NUMBER: [EEIjuly] SHIP DATE: [EVFGFED]

MEDIZ QTY DESCRIPTICN LABEL/NC. UNT_PFERC AMCUNT
> ORDER NUMBER: 536012 SHIP DATE: 04/01/10
CD 10 Milhaud, 3 Rag Caprices, pn. & orch. Z-6569 9.60 96.00
5 Strauss, Le bourgeois gentilhomme CDD 448 3.60 48.00
5 Scriabin, Preludes, Op. B CY 1123 7.78 38.95
6 Rogers, Slaughter on Tenth Avenue CDD 275 9.60 57.60
BLU 10 Paganini, 24 Caprices for wviolin. BLU 120 9.5¢9 85.90
DVD 8 Viwaldi, Concertos for Recorder ABTD-1156 5.9% 47.92
» RETURN AUTHORIZATION: RA602Z1 RECEIVED: 04/10/10
cD -10 Linek, Epiphany Carol SUP 10 4154 5.88  (59.90)
-7 Casella, Paganiniana, NBC S0 AS 510 5.00 (63.00)
oD -11 Lambert, Zirs de Courm (1&89) HMER 431123 5.89 (65.89)
» ORDER NUMBER: 536034 SHIP DATE: 04/18/10
CD 3 Huggett, Suite for Accordian & Pn. MVCD 1056 9.5% 28.77
3 Peterson, Quartet No. 1 for Strings 3-7121-2 4.7%9 43.11
4 Ricci, Crispino e la Comare GR 2095 14.38 57.52
4 Selma y Salaverde, Canzoni NE 7041 8.99 35.96
05/01/10 CLASSICAL MUSIC DISTRIEUICRS PAGE 05
10:17 MONTHLY SHIPPING REPCRT
MSRS94 FRCM 04/01/10 TC 04/30/10 -
4 13

Figure 7-18. Viewing the result of highlighting fields. The data from an unwanted field are captured in this example.
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6. Inthe Trap line, place the cursor directly above the “5” that begins the order number (536017) in the sample line,
click the Numeric trap M button, and then check the highlighted fields once more.
The “RETURN AUTHORIZATION” and “RECEIVED” fields are no longer highlighted on Page 4 of the report.

Template Editor ~

Standard Trap “«|A 0 B @ | ® - <« » Tapline~ [%ResetTrapline 55 ResetFields =# Edit Field S Delete Field
I CRDER NUMBER: [EELfikl] SHIP DATE: [EFFDYET] .
MEDIR QTY DESCRIPTICON LABEL/NC. UNT_PRC RMCUNT

= CRDER NUMBER: 536012 SHIP DATE: 04/01/10
CD 10 Milhaud, 3 Rag Caprices, pn. & oxch. Z-6569 S9.80 g6.00
E Strauss, Le bourgeois= gentilhomme CDD 448 8.&80 48.00
5 Scriabin, Preludes, Cp. 8 C¥ 1123 7.7% 38.95
& Rogers, Slaughter on Tenth Avenue CDD 275 9.80 57.60

BLU 10 Paganini, 24 Caprices for wiolin. BLU 120 9.59 95.90

DVD 8 Viwvaldi, Concertos for Recorder RBTD-1156 5.89 47.92
RETURN AUTHCORIZATION: RAG021 RECEIVED: 04/10/10

cD -10 Linek, Epiphany Carol SUB 10 4154 5.99 (58.90)

-7 Casella, Paganiniana, NBC 50 RS 510 S9.00 (63.00)

DVD —-11 Lambert, Airs de Courm (1689) HMA 431123 5.8% (65.89)
® CRDER NUMBER: 536034 SHIP DATE: 04/18/10

CD 3 Huggett, Suite for Accordian & Pn. MWCD 1056 5.59 28.77

% Peterson, Quartet Ho. 1 for Strings 3-7121-2 4.79 43.11

4 Riceci, Crispino e la Comare GR 2085 14.38 57.52

4 Selma y Salaverde, Canzoni HE 7041 8.8908 35.96

05/01/10 CLASSICAL MUSIC DISIRIBUICRS PAGE 05
10:17 MONTHLY SHIPFING REPORT
MSRS4 FRCM 04/01/10 TO 04/30/10

Figure 7-19. Viewing the results of amending the current trap.

7. Replace Append 1 with Order Number Level in the Template Name field of the Template Editor.

The fields trapped by the append template we just created can be easily distinguished from those trapped by the
detail template due to the different colors that Monarch assigns them.

eg_04/10/10 eg_CD eg_4 eg_Bartok, Sonata for Solo Viol eg_MK-42625 eg B8 99 eg 35 96 eg 536017
1  4/10/2010 cD 4 Bartok, Sonata for Solo Violin MK-42625 .99 35.96 536017
2 4/10/2010 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00 536017
3 4/10/2010 2 Luening, Electronic Music CD 611 10.19 20.38 536017
4 4/10/2010 DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91 536017
3 4212010 cD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89 536039
6  4/21/2010 8 Mendelssohn, War March of the Priests SMK 47592 .99 71.92 536039
7 421/2010 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90 536039
8 4/21/2010 LP 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74 536039
S  4/21/2010 DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94 536039
10 4/5/2010 CD 6 Stravinsky, Dumbarton Ozks Concerto SMCD 5120 8.99 53.94 536016
11 4/5/2010 1 Schubert, Sonata in e, D.566 AS-325 9.00 9.00 536016
12 4/5/2010 3 Mozart, Symphony Mo.23 in D CO-77884 .99 26.97 536016

Figure 7-20. Data preview of the highlighted fields.

8. Select Accept v to accept your changes and close the Template Editor. You are returned to Report view when
you do so.
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Trapping the Account Number and Contact Lines

This time, we'll trap the account number and contact lines in another append template. Note that the “ACCOUNT
NUMBER” and “CONTACT” fields are on different lines. To capture both fields, we’ll select a multiple line sample.

STEPS:

1. Switch to the Report Design view.

2. Click down in the line selection area to the left of ACCOUNT NUMBER and drag down two lines to highlight
three lines including the CONTACT line.

3. Onthe Report Design ribbon, select New Template > Append. Ensure that the Trap Type is Standard Trap.

The three lines we selected are displayed in the Sample Text box of the Template Editor.

-
|Standard Trap v| A N R © 8 - « - Trap Line ~ -5 Reset Trap Line 55 Reset Fields Edit Field Delete Field
ACCOUNT NUMBER: 11887

®|05/01/10 CLASSICAL MUSIC DISTRIBUTCRS PAGE 01 -

®(10:17 MCNTHLY SHIPPING REPCRT

» MSR94 FROM 04/01/10 TC 04/30/10

Figure 7-21. The Template Editor showing the selected sample lines.

For a multiple line sample, you need to indicate which of the sample lines to trap. Generally, you will be able to

trap on the first line by identifying features unique to that line. Occasionally, however, there will be no unique

features that identify the first line. If it is not possible to trap on line 1, use the Trap Line drop-down to select
another line with unique features.

.
|Standard Trap “|AE R @ g8 - + - |Trap Line -5 Reset Trap Line £5 Reset Fields Edit Field Delete Field

1
ACCOUNT WNUMBER: 11887 -
2
CONTACT: Betty Yoder -
®|05/01/10 CLASSICAL MUSIC DIST 3 PAGE 01 -
®(10:17 MONTHLY SHIFPING Reewsy
= MSR94 FRCM 04/01/10 TO 04/30/10

Figure 7-22. Using the Trap Line drop-down to select a unique line from which to create a trap.

In this lesson, we'll trap on the first line of the sample, so you won’t need to adjust this setting.

Note that an “ACCOUNT NUMBER” label always precedes the account number field. Let’'s use this specific

sequence of characters as an exact match trap.

4. Type Account Number at the beginning of the trap line. By default, Monarch traps are not case-sensitive, so

you need not enter the text exactly as it appears in your sample line.

NOTE You can specify “case-sensitive” as the default case setting for traps by selecting Options

in the Home ribbon. In the Options interface that displays, select the Input tab, go to the
Trapping subtab, and then tick the Non-Regex Traps are case-sensitive box.
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5.

Click Auto-Define Fields =-*.

Template Editor

|Standard Trap

account nu.rn.ber|
R.CCOUNT NUMBER:

conTact:

COSTCMER: Big Shanty Music
3658 Springs Ferry
Suite C-130
Marietta, GR 30087

Usn

* ACCOUNT NUMBER: 17859

S
2 CONTACT: Marvin Mabry

+ =+ Trap Line v

:‘5 Reset Trap Line 50O Reset Fields

Edit Field Delete Field

Figure 7-23. Auto-highlighting the Account Number and Contact fields.

Monarch highlights the fields in the report. You may need to scroll the report to see the results.

Replace Append 1 with Account Number Level in the Template Name box, and then click the Accept v
button to accept the template definition.

Note that Monarch has assigned the same color to the fields trapped by the Account Number Level template as
to those trapped by the Order Number Level template. This is because they are both append templates.

0]

E Classicpm

Report Files - 1 IEEEET
10:17
0

MSR24

CUSTICMER:

CLASSICRL MUSIC DISTRIBUTCRS
MONTHLY SHIPPING REPORT
FROM 04/01/10 TIC 04/30/10

Betty's Music Store
Muscatine Flaza

200 Lower Muscatine
Cedar Falls, IA 50613
Usk

» ACCOUNT NUMBER: 11887

»

»|CONTACT: Betty Yoder

MEDIA QIY
=
»|CD 4
T
= z
* DVD 9
»
*|CD 11
8
> 10
*LP &
2 DVD &
05/01/10
10:17
MSRS4

DESCRIPTICN

ORDER NUMBER: 536017
Sonata for Solo Violin

Mass in C, K.427
Electronic Music

Bartok,
Mozart,
Luening,

Scarlatti, Stabkat Mater
ORDER NUMBER: 536039

Beethoven, Pathetigue Sonata, Arau

Mendelsschn, War March of the Priests

Pizzetti, Messa di Requiem

Mi=zc., Modern Trombone Masterpieces

Gershwin, An American in Paris

SHIP DATE:

SHIP DATE:

LABEL/NO.
04/10/10
MK-42625
420831-2
CD 611
SBT 48282
04/21/10
420153-2
SME 47582
CHZN B964
ADA SE81087

ACS 8034

CLASSICAL MUSIC DISTRIBUTCRS
MOWNTHLY SHIPPING REPORT
FROM 04/01/10 TC 04/30/10

PAGE 01
UNI_FRC BMOUNT
8.99 35.96
9.00 63.00
10.18 20.38
5.99 Lo ik
5.99 65.89
8.9% T1.82
=)o EE) 85.90
10.75 64.74
5.99 =i =)
PLGE 02

Figure 7-24. The results of your templating work thus far display in Report view.
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CREATING A PAGE HEADER TEMPLATE

Page headers often include useful information, such as the report date. In the Classic.prn report, the page header

includes the report date and the page number. Let's extract these two fields.

STEPS:

1. Switch to the Report Design view.
2. Select the first line of the report as the sample text.

3. Onthe Report Design ribbon, select New Template > Page Header. Ensure that the Trap Type is set to
Standard Trap.

The Template Editor is activated and the line we selected displays on the Sample Text box.

Template Editor ~
Standard Trap “\|A N R O | &8 - + - Trap Line ~ -5 Reset Trap Line 5D Reset Fields Edit Field Delete Field
prOlflO CLASSICAL MUSIC DISTRIBUTORS PAGE 01
05/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01 -
10:17 MONTHLY SHIPPING REPCRT
MSRG4 FROM 04/01/10 TO 04/30/10

Figure 7-25. The sample line selected for the page header.

Trapping the Page Header

Most reports have a form feed character (ASCII 12, HEX 0C) embedded at the page break. Monarch can use this

character to identify the beginning of a page header, so you normally do not need to set a trap to capture page

headers. However, if your reports do not include the form feed character, you will need to use a trap to capture these.
If you are unsure about your report’s internal structure, you should play it safe and create a trap. That's what we’ll do

for this lesson.

STEPS:

1. Click the Numeric Trap button @ twice and then type a forward slash (/) in the Trap line. This trap will capture

the first line of each page header (where the date is represented in MM/DD/YY format).

2. Highlight the report date and the page number, as shown in Figure 7-26.

NOTE =
The Auto-Define Fields =% button will not be able to capture the report date field due to

the logic it uses to distinguish fields from labels, headings and other static text that appears
in reports. Any text that does not change throughout the report is considered a label, even if
that text looks like, and, as in this case, is, a field.

Template Editor ~

Standard Trap “«|A N B O e - « = Trap Line ~ -5 Reset Trap Line 55 Reset Fields S¢ Edit Field S Delete Field
i/
05/01/10] CLASSICAL MUSIC DISTRIEUTORS PAGE
»05/01/10 CLASSICAL MUSIC DISTRIBUTCRS FAGE D01 -
10:17 MONTHLY SHIFPING REPORT
M5SR4 FRCM 04/01/10 TO 04/30/10

Figure 7-26. Highlighting the page header fields.
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The page header fields in the report are highlighted.

3. Click Accept v to accept the template definition.

Since you did not name the template, a default name is assigned for you. For detail and page header templates,
the default names are Detail and Page Header, respectively. For append and footer templates, the default
names are Append n, and Footer n, where n is incremented for each new append or footer template.

Note in the report that Monarch has highlighted the fields trapped by the page header template with a unique
color to distinguish them from those trapped by other template types.

WORKING WITH MODEL FILES

After you have created a data extraction template for a report, you can save it in a Monarch model file. A model file
saves all of the templates and definitions that you have applied to a report during a Monarch session, including sorts,
filters, user-defined functions, and the like. Models save work by allowing you to apply the same templates and
definitions to a periodic report every time it is generated.

In the previous lessons, for example, we created four templates that we can save to a single model file. If we had new
report files with the exact same structure as Classic.prn (e.g., ClassJan.prn, ClassFeb.prn, and ClassMar.prn), we
can reuse this model file to extract data from the new files without needing to rebuild any of the templates we’'d
already created.

Note that in the current version of Monarch, model files are saved using the .dmod extension. Monarch can read
model files saved in previous versions of Monarch using the .xmod extension, but it cannot save changes to this file
type.

Saving Model Files to a Local Folder

Let's save a model file to see how this works.

STEPS:

1. Select File > Save As H > Model > Computer.

You can save model files to a local folder (i.e., Computer), a web server (Amazon S3), the Altair Server Library,
or to a zip file.

2. Since we opted to save to a local folder in this example, a Save Model dialog displays. Using this dialog,
navigate to the folder in which you want to save your model file and then provide a name for it in the File name
field.

3. Ensure that the option Model Files (*.dmod) option is selected in the Save as Type drop-down.
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M Save Model X
« - 4 <« Public » Public Documents » Altair Monarch » v |0 Search Altair Monarch el
Organize » MNew folder SRS (7]
0 This PC ~ Mame Date modified Type Size
) 3D Objects Data File folder
I Desktop Export File folder
; 23 P : )
B Documents Models 28PM File folder
Projects 28PM File folder
‘ Downloads . X
Reports 5/22/2020 %:03 PM File folder
J& Music
&= Pictures
B videos
22 Windows (C) < >
File name: | Savel )
Save as type: | Model Files (*.dmod) -
~ Hide Folders Cancel

Figure 7-27. The Save Model dialog box.

In the example above, we hamed our model file Savel. The .dmod extension will be automatically added to the
file name once it is saved.

4. Click Save to continue saving your model file.

5. If amodel file with a name identical to the one you supplied in Step 2 is found in the location you specified, you
will be asked to confirm the save operation. Click Yes in the dialog box that displays to continue saving your file.
Note that continuing with the save operation will result in the newer model file replacing the older one.

E)
6. Select File once more and then click Close All Iﬁ to close the Classic.prn report and model.

Saving Model Files to the Altair Monarch Server Library

Monarch allows users to save and access models and projects from Altair Monarch Server via the Altair Monarch
Server Library Browser. Note that this functionality is only available using Altair Server versions 12.5.1 and up.

Follow the steps below to save a model to the Altair Monarch Server Library.

STEPS:

1. Select File > Save As > Project/Model > Altair Monarch Server Library.

2. If you had previously configured an Altair Monarch Server Library in the Options interface and opted to save
models and projects to Altair Monarch Server as the default save behavior, a dialog like that in Figure 7-28
displays.
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Altair Monarch Sérver Library Browser

m Mame T Type Last Medified By T Comment T Last Revision T »
Lessonlockup Model admin 272172024 11:0%02 AM = E
Lessong Meodel | admin 6/6/2024 303:30 AM 5
LessonSEdited Model  admin Import dependencies. 1472023 6:28:23 PM “
lessonBexternallookup Model  admin test /2572023 1:55:23 PM
LessonSwithExternalLookup Model admin test 10/25/2023 2:06:46 PM
Mame: Models w
Cancel Help
Figure 7-28. Saving a model to the Altair Monarch Server Library.
Enter a filename for the model you are saving into the name field and then click Save as new.
The model you have just saved is added to the Models list.
If you wish to revise a pre-existing model in the Models list, select its name from the list and then click Add

Revision.

4. Add a comment if necessary

Save Model n

Comment:

Figure 7-29. Adding a comment to a model saved to Altair Monarch Server.

5. Click OK when you are finished.

More information on Altair Monarch Server is available here.
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Saving Model Files to Amazon S3
Monarch also allows users to save and access models and projects from Amazon S3.

STEPS:

1. Select File > Save As > Model > Web.
A Save as Web File dialog displays.

M Save As Web File - O *

Address: | awss3:// (Amazon §3) ~ awssB:Hl “’

Connect Cancel l [ Help

Figure 7-30. Saving a model file to an Amazon S3 folder.

2. Enter the S3 folder to which you want to save the model file in the text field provided and then select Connect.

Loading Saved Model Files

Now let's load the same report with our new model file.

STEPS:

N
1. Select File > Open - - Report > Computer.
2. In the dialog that displays, Classic.prn.

The Classic.prn report displays in Report view.

- ]
Select File > Open & > \vodel > Computer.

From the dialog box that displays, locate, select, and open Savel.dmod.
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The Report view is updated to reflect the effects of the opened model.

[ ——— | CLASSICAL MUSIC DISTRIBUTORS PAGE 01
10:17 MONTHLY SHIPPING REPORT

W MSR94 FRCM 04/01/10 TO 04/30/10

B Classicprn

CUSTCMER: Betty's Music Store
Muscatine FPlaza
200 Lower Muscatine
Cedar Falls, IA 50613
Usa

» ACCOUNT NUMBER: 11887
®

®»|CONTACT: Betty Yoder

MEDIA QTY DESCRIPTICN LABEL/NC. UNI_ERC AMCUNT
> ORDER NUMBER: 536017 SHIP DATE: 04/10/10
»|CD 4 Bartok, Sonata for Solo Violin MK-42625 B.99 35.96
® 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
» 2 Luening, Electronic Music CD 611 10.19 20.38
= DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
» ORDER NUMBER: 536039 SHIP DATE: 04/21/10
= |CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
® 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92
® 10 Pizzetti, Messa di Reguiem CHAN 8964 9.59 95.%0
> LP 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
® |DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
»05/01/10 CLASSICAL MUSIC DISTRIBUICRS PAGE B2

10:17 MONTHLY SHIPPING REPORT

MSR94 FROM 04/01/10 TO 04/30/10

Figure 7-31. Loading the Classic.prn report and the Savel.dmod model file.

SETTING TEMPLATE COLORS

Monarch includes a function that allow users to clearly differentiate between the various types of templates that may
be created (i.e., Detail, Append, Page Header, Group Footer) via template colors. Template colors allow you to easily
determine what type of template is being used to extract information from a selection. Aside from being able to
choose your own colors, Monarch also provides a pre-determined set of template colors. If you haven't previously set
your template colors yet, we'll do so now.

For this lesson, load Classic.prn and Lessonl.dmod.

Changing Default Colors

Template colors are changed via the Edit Report Colors dialog box.

STEPS:

1. Select Report Design E’ > Report Colors ® to launch the Edit Report Colors dialog.
Several color themes are available for use as template colors:
None shows no color backgrounds in the report after defining templates.
Gray background displays all templates defined in a report in a gray background.

Custom background for each template type assigns select colors for specific template types. This option
is selected by default.
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M Edit Report Colors it

Template coloring

Mone
Gray background
® Custom background for each template type

i s || oo |[comroonr IR e

Show Greenbar

Ok | | Cancel | | Help |

Figure 7-32. The Edit Report Colors dialog.

Let’'s try changing the color for Detail templates.

2. Click directly on the Detail button to launch the color selector. Note that right now, the button is yellow.

M Edit Report Colors it

Template coloring
None
Gray background
® Custom background for each template type

| Pageheader || 4ppend | neBetsibs | Group Footer

| O HEN

ENNEENEEN

BN EEEEERN

EEEEEEERN oK | Cancel | Help
EEEEN

Figure 7-33. The Edit Report Colors dialog displaying the color selector.

3. Select the first color on the first column, first row (#FF8080).

4. Click anywhere on the Edit Report Colors dialog to accept your selection and close the color selector.
The color of the Detail button changes to bright salmon.

5. Select OK to close the dialog box.

A quick look at the Template Editor shows that the Detail template is now a bright salmon color.
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Template Editor ~

Standard Trap «|A W B ® | & - « + Taplinev [¥)ResetTrapline TD ResetFields S# EditField =5 Delste Field
| HEEE
[} (]

Ush

RCCOUNT NUMBER: 11887

CCNTACT: Betty Yoder

MEDIA QTY DESCRIFTICN LABEL/NC. UNT_PRC AMOUNT

ORDER NUMBER: 536017 SHIP DATE: 04/10/10

CRDER NUMBER: 536039 SHIP DATE: 04/21/10

CLASSICAL MUSIC DISTRIBUTORS BAGE 02
10:17 MONTHLY SHIFPING REPORT
SR94 FRCM 04/01/10 TC 04/30/10

Figure 7-34. The Detail template color is updated with your changes.

Resetting Default Colors

Before we proceed to the next lessons, let's change the Detail template color back to its original state.

STEPS:
&

2. Select the Reset to default colors button in the dialog that displays.

1. Onthe Template Editor, click Report Colors once more.
The Detail button now shows the original template color we saw earlier.

3. Click anywhere in the dialog to close the selector and then select OK to close the dialog box.

NAMING FIELDS

When data are extracted from a report, they are arranged in columns that are given generic names. You can change
these names into more meaningful ones to better describe the contents of each column.

Monarch allows you to name fields via three ways:

0 Immediately after highlighting them in the Template Editor using the Field Properties panel
0 Via the Table Design view

0 Via the Field Definition window.

In this section, we’ll explore these options one by one using Classic.prn and Savel.dmod.
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Using the Field Properties Panel

STEPS:

1. In Report view, select Report Design El to view the report (along with the highlighted fields) in Report Design
view.

2. Select one template from the Template Selector (in the following example, we selected the Line Item Detail

template).

Template Editor ~
Standard Trap v|A N R ® g - « -+ Trap Line ~ -5 Reset Trap Line 55 Reset Fields S# Edit Field Delete Field

NEEE

| 4jBartok, Sonata for Solo Violin MK-42625 EEE 35.96
05/01/10 CLASSICAL MUSIC DISTRIBUICRS BAGE 01 -
10:17 MONTHLY SHIFPING REPORT
MSRG4 FRCM 04/01/10 TC 04/30/10

CUSTCMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
Usz

RCCCOUNT NUMBER: 11887

CONTACT: Betty Yoder

MEDIZA QTY DESCRIFTICON LABEL/NC. UNT_PRC REMCUNT

CRDER NOUMBER: 536017 SHIP DATE: 04/10/10

»|CD 4 Bartok, Sonata for Solo Violin ME-42625 B.59 35.98
7 Mozart, Mass in C, K.427 420831-2 5.00 63.00
® 2 Luening, Electronic Music CD 611 10.19 20.38
KD e e T ’
ACCOUNT -
eg_CD  eg_4 eg_Bartok, Sonata for Solo Viol eg_MK-42625 eg 8 99 eg 3596 eg 536017 eg_04/10/10 NUMBER CONTAC
1 D 4 Bartok, Sonata for Solo Violin MK-42625 8.99 35.96 536017 4/10/2010 11887 Betty Yo
2 7 Mozart, Mass in C, K427 420831-2 9.00 63.00 536017 4/10/2010 11887 Betty Yo
3 2 Luening, Electronic Music CD 611 10.19 20.38 536017 4/10/2010 11887 Betty Yo
4 DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.01 536017 4/10/2010 11887 Betty Yo
5 D 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 65.89 536039 4/21/2010 11887 Betty Yo
6 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92 536039 4/21/2010 11887 Betty Yo
7 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90 536039 4/21/2010 11887 Betty Yoo

-

»

Figure 7-35. Viewing the original field names using the Data Preview panel.

3. Click on the highlighted field labeled CD in the Sample Text box and then click on the Field Properties button to
expose the Field Properties panel (remember that we set this panel to auto-hide when we were creating our
detail template at the beginning of this chapter).

All of the details associated with this field display in the Field Properties panel.
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Field Properties v R

Name: eg_CD

Template Width:

Type: [Chamcter Vl
Decimals: 0

Format: [General ™ l

-

Display Width: |3 -

Alignment: l Left v l

|| Copy Value From Previous Record

[ Hidden

< Previous Field | | Next Field >

Figure 7-36. The properties of a field display in the Field Properties panel.

4. In the Name field of the Field Properties panel, delete the current entry and enter Media in its stead. Click the
v button that appears next to the field to accept your changes.

The Data Preview panel is automatically updated to show your changes. Note that the column previously marked
“eg_CD” is now labeled “Media.”

Data Preview

Media |eg_4 eg_Bartok, Sonata for Solo Viol eq MK42625 €0 899 eg 3596 eg 536017 eg 04/10/10 “SSOENY
1| 4 Bartok, Sonata for Solo Violin MK-42625 809 3596 536017 4/10/2010 11887
2 7 Mozart, Mass in C, K.427 4208312 9.00 6300 536017 4/10/2010 11887
3 2 Luening, Electronic Music CD 611 1019 2038 536017 4/10/2010 11887
4| pvp 9 Scarlatti, Stabat Mater SET 462682 500 5391 536017 4/10/2010 11887
5| o 11 Beethoven, Pathetique Sonata, Arau 4201532 509 6580 536039 4/21/2010 11887
6 8 Mendelssohn, War March of the Priests SMK 47502 8.09 7192 536029 4/21/2010 11887
7 10 Pizzetti, Messa di Requiem CHAN 8964 950 9500 536039 4/21/2010 11887
8| P 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74 536039 4/21/2010 11887
9| pvp 6 Gershwin, An American in Paris ACS 8034 599 3594 536039 4/21/2010 11887

‘;m = = L3 i 1 i nt k- Ml st . CRACTY C4 0 0nn CnA CREnic

Figure 7-37. Field properties of the field eg_CD.

5. Repeat Steps 3 and 4 to rename the rest of the fields in the detail template using the following guide:

eg 4 Quantity
eg_Bartok, Sonata for Solo Viol Description
eg_MK-42625 Label Number
eg 8 99 Unit Price
eg_35 96 Amount
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6. Once you've made all of your changes, click Accept v on the Report Design ribbon to save your changes and

close the Template Editor.

Using the Table Design Interface

When Monarch extracts data from a report, the data are placed in a table, which you can view and manipulate in
Table Design view. Similar to the Field Definition window, the Table Design view allows you to change field names
and properties; it also allows you to perform external lookups, specify formula fields, and define filters, sorts, and
address blocks, among others. We'll discuss these functionalities one by one in later chapters. For now, we’'ll focus
on changing field names using the Table Design window.

In this lesson, we’ll rename the rest of the fields extracted from Classic.prn using Table Design view.

STEPS:

1. From the Report interface, select the Table tab and then click Table Design W from the Table ribbon.

The Table Design view presents a list of all of the fields you have trapped and will appear on your table; the
general properties of each field are also displayed.

Design
v % | = Fo— T = ) = vV ¥ B A5 | ?
Accept  Cancel Add  Duplicate o Exemal | Field Input  Formula  Lookup User Edit Fiters  Sorts Address  Functions Help
B e Lookups | List Fields  Fields  Fields  Parameterfields  Fields Blocks
m Name Source Type Format Display Width | Decimals | Size | Alignment | Hidden | Table Verify Results
s 1 ] medi Line ltem Detai Character General 5 Left
2 | Quamiy Line Item Detsil Numeric General 4 0 Right
3| Description Line Item Detsi Character Genersl 9 Lek
4 Label Line Item Detail Character General 12 Left
5 Unit Price Line ltem Detail Numeric General 7 2 Right
6 Amount Line ltem Detail Numeric General 8 2 Right
7 | egs3e017 Order Level Numeric General ] 0 Right
s | eg 041010 Order Level Date/Time Shart Date 11 Left
9 | ACCOUNT NUMBER Account Number Level Numeric General s 0 Right
10 | conTacT Account Number Level Character Genersl 18 Lek
11 eg_05/01/10 Page Header Date/Time Short Date 1 Left
12 eg 01 Page Header Character General 5 Left
Show Template Properties Table Verify Move Up Move Down Print Save To CSV
Data Preview ~
- Unit ACCOUNT n
Media Qu.. Description Label ot Amount eg_536017 eg_04/10/10 “SCONNY conTacT eg_05/01/10 eg_01
1 4 Bartok, Sonata for Solo Violin MK-42625 899 3596 536017 4/10/2010 11887 Betty Yoder 512010 01
2 7 Mozart, Mass in C, K.427 420831-2 S.00 63.00 536017 4/10/2010 11887 Betty Yoder 5/1/2010 01
3 2 Luening, Electronic Music 61 1049 2038 536017 4/10/2010 11887 Betty Yoder sipo ot
4 DVD 9 Scarlatti, Stabat Mater SBT 48282 599 53.91 536017 4/10/2010 11887 Betty Yoder 5/1/2010 01
5 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 65.89 536039 4/21/2010 11887 Betty Yoder 5/1/2010 01
6 8 Mendelssohn, War March of the Priests SMK 47592 889 7182 536039 4/21/2010 11887 Betty Yoder s/12010 01
7 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90 536039 4/21/2010 11887 Betty Yoder 5/1/2010 01
8 P 6 Misc., Moder Trombone Masterpieces ADA 581087 1079 6474 536039 4/21/2010 11887 Betty Yoder s/t o1
9 D 6 Gershin, An American in Paris ACS 8034 589 3584 536039 4/21/2010 11887 Betty Yoder S0 01
10 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 899 5394 536016 4/5/2010 17959 Marvin Mabry s 02
1 1 Schubert, Sonata in e, D566 As-225 2.00 9.00 536016 4/5/2010 17859 Marvin Mabry s
12 3 Mozart, Symphony No.23 in D Co-77884 8.99 2697 536016 4/5/2010 17959 Marvin Mabry 5/1/2010 02
13 6 Schoenberg, Ode to Napoleon CHAN 9116 259 57.54 536016 4/5/2010 17959 Marvin Mabry s 02
14 > 2 Shostakovich, 24 Preludes for piano. CDA 66620 539 10.78 536029 4/14/2010 17959 Marvin Mabry 5/1/2010 02
15 sacD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 86.31 536029 4/14/2010 17959 Marvin Mabry 5/1/2010 02
16 DvD 5 Hoist, 5t. Paul's Suite for Orch. ceT-1020 599 2095 536029 4/14/201 17959 Marvin Mabry s/1/2010 02 .

IMdia - Character - Detail(Lin ftem Detail)

3
Filter: No Fiiter Sor:NoSort  100Rows  100% ———f———+

Figure 7-38. The Table Design interface displays names and properties for all fields.

If you wish to view the properties of the template used to capture afield, simply check the box labeled Show
Template Properties at the lower left-hand corner of the view. You'll also see the now-familiar Data Preview
panel at the bottom left corner of the interface.

2. In the name field, locate the cell with the entry ACCOUNT NUMBER and change it to Account Number by
clicking on the cell and typing over the original entry.

Locate the cell with the entry CONTACT and rename it Contact.

4. Replace the name eg_536017 with Order Number.
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5. Replace the name eg_04/10/10 with Ship Date.
6. Replace the field name eg_05/01/10 with Report Date.

7. Replace the field name eg_01 with Page Number.

m Name
> 1 Media
2 Quantity
3 Description
4 Label
5 Unit Price
6 Amount
7 Order Murmnber
8 Ship Date
g Account Number
10 Contact
n Report Date
12 I Page Number I

Figure 7-39. Renaming fields using the Table Design interface.

8. Click Accept v on the Table Design ribbon to accept your field name definitions and close the view.

The Table Design interfaces closes and you are returned to Table view.

9. Click Autosize Columns *:* on the Table ribbon to fit as much of the cell contents as possible to the column
widths.
Media Quantity Description Label Unit Price Amount  Order Number Ship Date Account Number Contact

1 4 Bartok, Sonata for Solo Violin MK-42625 8.99 35.96 536017 4/10/2010 11887 Betty Yoder
2 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00 536017 4/10/2010 11887 Betty Yoder
3 2 Luening, Electronic Music CD 611 10.19 20.38 536017 4/10/2010 11887 Betty Yoder
4 DVD 9 Scarlatti, Stabat Mater SBT 48282 5.00 53.91 536017  4/10/2010 11887 Betty Yoder
5 (D 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 65.89 536039 4/21/2010 11887 Betty Yoder
6 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92 536039 4/21/2010 11887 Betty Yoder
7 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90 536039 4/21/2010 11887 Betty Yoder
8 P 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74 536039 4/21/2010 11887 Betty Yoder
9 DVD 6 Gershwin, An American in Paris ACS 8034 5.9 35.04 536039 4/21/2010 11887 Betty Yoder
10 co 6 Stravinsky, Dumbarton Oaks Concertoe  SMCD 5120 8.99 53.94 536016 4/5/2010 17959 Marvin Mabry
11 1 Schubert, Sonata in e, D.566 AS-325 9.00 9.00 536016 4/5/2010 17959 Marvin Mabry
12 3 Mozart, Symphony No.23 in D CO-77884 8.99 26.97 536016 4/5/2010 17959 Marvin Mabry
13 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54 536016 4/5/2010 17959 Marvin Mabry
14 D 2 Shostakovich, 24 Preludes for piano. CDA 66620 5.39 10.78 536029 4/14/2010 17959 Marvin Mabry
15 sacD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 86.31 536029 4/14/2010 17959 Marvin Mabry
16 DVD 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.00 20.95 536029 4/14/2010 17959 Marvin Mabry
17 cDo 3 Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 53.94 536020 4/10/2010 10929 Roberto Gil
18 3 Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80 536020 4/10/2010 10929 Roberto Gil
19 6 Messiaen, Quatour pour [a fin de te...  CDC 54933 9.60 57.60 536020 4/10/2010 10929 Roberto Gil
20 SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99 71.92 536020 4/10/2010 10929 Roberto Gil
21 DpvD 9 Schumann, Manfred Overture, Bav SO SBT 48270 5.99 53.91 536020 4/10/2010 10929 Roberto Gil
22 D 10 Milhaud, 3 Rag Caprices, pn. & orch. 7-6569 9.60 96.00 536012 4/1/2010 18635 Alain Lebon
23 5 Strauss, Le bourgeois gentilhomme CDD 448 8.60 48.00 536012 4/1/2010 18635 Alain Lebon
24 5 Scriabin, Preludes, Op. 8 Cy 1123 7.79 38.95 536012 4/1/2010 18635 Alain Lebon
25 6 Rogers, Slaughter on Tenth Avenue CDD 275 9.60 57.60 536012 4/1/2010 18635 Alain Lebon
26 BLU 10 Paganini, 24 Caprices for violin. BLU 120 9,59 95.90 536012 4/1/2010 18635 Alain Lebon
27 DVD 8 Vivaldi, Concertos for Recorder ABTD-1156 5.9 47.92 536012 4/1/2010 18635 Alain Lebon
28 CD -10 Linek, Epiphany Carol SUP 10 4154 5.99 -59.90 536012 4/1/2010 18635 Alain Lebon
29 -7 Casella, Paganiniana, NBC SO AS 510 9.00 -63.00 536012 4/1/2010 18635 Alain Lebon
30 DvVD -11 Lambert, Airs de Courm (1689) HMA 431123 5.99 -65.89 536012 4/1/2010 18635 Alain Lebon
31 cD 3 Huggett, Suite for Accordian & Pn. MVCD 1056 9,59 28.77 536034 4/18/2010 18635 Alain Lebon
32 9 Peterson, Quartet No. 1 for Strings 3-7121-2 4.79 43.11 536034 4/18/2010 18635 Alain Lebon
33 4 Ricci, Crisping e la Comare GR 2095 14.38 57.52 536034 4/18/2010 18635 Alain Lebon
34 4 Selma y Salaverde, Canzoni NE 7041 8.9 35.96 536034 4/18/2010 18635 Alain Lebon
Er . et U _tea i e amnan o nn cnna cnrnar | ainninnan PRy T —

Figure 7-40. The

results of our renaming exercise.
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Using the Field Definition Window

The Field Definition window provides yet another means to rename columns.

The Field Definition window is accessed by:

Selecting a field and then clicking Edit Field =# from the Action bar of the Template Editor
Selecting Input Fields in Table Design view

Double-clicking on any field in Table view

In the latter case, the properties of the field you double-clicked on display first in the field list provided.

The Field Definition window displays. Let's explore this window in detail.

Design
v X = z & E @B = [ o = vV ¥ = ?
Accept  Cancel Add  Duplicate T Extemal  Field Input.  Formula  Lookup Runtime User Edit Filters  Sorts Address  Functions Help
Lookups  List Fields ~ Fields Fields  Parameter Fields Fields Blocks
Report Fields ~ 0 General Template Advanced v
A )
Media Field Properties
Quantity
Name: Media
Description
Label Type: Character v
Unit Price
Format: General ~
Amount
Order Number Display Width: |6 H
SheDes Alignment Left v
Account Number
Hidden
Contact
Report Date
Page Number
Media  Quantity Description Label UnitPrice  Amount  Order Number Ship Date Account Number Contact Report Date Page Number -
1 4 Bartok, Sonata for Solo Violin MK-42625 8.99 35.96 536017 4/10/2010 11887 Betty Yoder 5/1/2010 01
2 7 Mozart, Mass in C, K427 4208312 900 6300 536017 4/10/2010 11887 Betty Yoder 5/1/2010 01
3 2 Luening, Electronic Music CD 611 10.19 20.38 536017 4/10/2010 11887 Betty Yoder 5/1/2010 01
4 DVD 9 Scarlatti, Stabat Mater SBT 48282 599 5391 536017 4/10/2010 11887 Belty Yoder 5/1/2010 01
5 11 Beethoven, Pathetique Sonata, Arau 4201532 599 6589 536039 4/21/2010 11887 Betty Yoder 5/1/2010 01
6 & Mendelssohn, War March of the Priests SMK 47502 899 7192 536039 4/21/2010 11887 Betty Yoder 5/1/2010 if1
7 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90 536039 4/21/2010 11887 Betty Yoder 5/1/2010 01
8 1P 6 Misc., Modem Trombone Masterpieces ADA 581087 1079 6474 536039 4/21/2010 11887 Betty Yoder 5/1/2010 01 -
< 0
Media - Character - Detail (Line ftem Detai) Fiker: No Fiker SortNoSort  100Rows  100% — ——f———+

Figure 7-41. Field properties of the field eg_CD.

The ribbon of the Field Definition window features a Template Name drop-down list from which you can choose any
template whose fields you wish to define. The template name you select from the drop-down box specifies which
template fields are displayed in the Field Selector located on the left-hand panel of the window. If you wish to display
all of the fields from all of the templates simultaneously, simply check the box for Show fields from all templates.

You can select any of the fields from the Template Selector and define properties for them. The Field Definition
view displays the characteristics of a single field in three tabs: General, Template, and Advanced.

The General tab displays the properties of each individual field, such as its name, type, format, and display width.
This tab shows exactly the same content displayed in the Field Properties panel in Report Design view. Thus, if you
wish to rename fields using the Field Definition window, you would do so in this tab.

The Template tab displays the properties of fields in terms of template characteristics, such as whether the field is
properly verified and whether empty cells (fields) in a table should be filled with the corresponding value from the
record immediately preceding it. If you wish to redact some of the data you retrieved, you can also do so using this
tab.

Finally, the Advanced tab displays advanced field properties, which are useful when the field being defined spans
several lines in a report.
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USING THE REPORT INDEX

Now that we've successfully extracted data from a report, let's try using Monarch’s Report Index feature.

The Report Index displays a hierarchy of field values within one or more reports, thereby allowing you to quickly and
easily explore a report and zero-in on the information you are interested in. Using this tree, you can get a bird's eye
view of your report data. When you find the information you desire, you can simply click on the field value to jump to
the corresponding page in the report.

For this exercise, we'll use Classic.prn and Lessonl.dmod.

Setting Up a Report Index

Let’s build a Report Index so that we can see first-hand how helpful it can be.
STEPS:

[ ]
1. Click the Report Index = drop-down button from the Report ribbon and then select Edit Report Index Fields.
The Edit Report Index Fields dialog displays.

M Edit Report Index Fields - O hed

Available Fields: Selected Fields:

Account Number -
Amount
Contact

Clea

Add >>
Description

Label Number << Remove

Media

Order Mumber

Page

Quantity

Renort Nate
The report index fields are shown
above alphabetically, however, their
order in the Report Index window will
be determined by their order of
occurrence in the report data.

[ ok Cancel Help

Figure 7-42. The Edit Report Index Fields dialog.

The fields extracted by the Lessonl model display in the Available Fields list. We can use up to five of these
fields to build our tree.

2. Select the Account Number field and then click the Add >> button. The Account Number field is removed from
the Available Fields list and added to the Selected Fields list.

You can also simply double-click a field in the Available Fields list to add it to the Selected Fields list.

3. Select the Order Number field and then click the Add >> button. The Order Number field is added to the
Selected Fields list.

4. Select the Description field and then click the Add >> button to add it to the Selected Fields list.
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Note that the fields are listed in alphabetical order in the Selected Fields list (see Figure 7-43). Their order in the
actual Report Index hierarchy will be determined by their order in the report data, as we’'ll see shortly.

M Edit Report Index Fields — O X

Available Fields: Selected Fields:

Amount Account Number
Contact == Description

Label Number Crder Number
) Add >>
Media

Page << Remove
CQuantity

Report Date

Ship Date

Unit Price

The report index fields are shown
above alphabetically, however, their
order in the Report Index window will
be determined by their order of
occurrence in the report data.

[ ok Cancel Help

Figure 7-43. Viewing the Selected Fields list.

Now that we’ve configured the tree definition, let's see how the Report Index displays in Report view.
5. Click the OK bhutton to close the Edit Report Index Fields dialog.

Monarch displays the Report Index on the right side of the Table (or Report) window by default. Initially, the tree
is collapsed. You can move the panel by clicking on the panel header and then dragging it anywhere you wish on

File Home Report Table Summary Export ?
B [} fe

= = 0 - Select All P Report Next Report R =

7 & [10] ot v » = ]
Repart T @ Zoom To Fit [£1 Copy Search  Findin P Page [® Next Page E::lj'\i‘( :?:;;ri Fle;(erﬁ oc;?(l\];:s
= Eee E Greenbar e (3 Go To Page Go To Chunk o

~
Report Files =2 . 0 >[05/01710 CLASSTCAL MUSIC DISTRISUTORS PRGE 01 e — R
10:17 MONTHLY SHIPPING REPORT

i p MSR34 FROM 04/01/10 TO 04/30/10 > Classicpmn
B Classicprm

CUSTOMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
USA

» ACCOUNT NUMBER: 11887

*|CONTACT: Betty Yoder

MEDIA QTY DESCRIPTION LABEL/NO. UNT_PRC  AMOUNT
» CRDER NUMBER: 536017 SHIP DATE: 04/10/10
*cD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 35.36

7 Mozart, Mass in €, K.427 420831-2 9.00 63.00

> 2 Luening, Electronic Music CD 611 10.19 20.38
» DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
> CRDER NUMBER: 536039 SHIP DATE: 04/21/10
>cD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
» 8 Mendelsschn, War March of the Priests SMK 47582 £.99 71.82
> 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.30
»LP € Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
» DVD € Gershwin, An American in Paris ACS 8034 5-99 35.94
> 0a/01/10 CTASSTCAT, MISTG NTSTRTRITORS Pacs 63 T

<

Pagel 100% ——d——— +

Figure 7-44. Displaying the Report Index.

6. Expand the Classic.prn tree on the Report Index by clicking on the node () to the left of the label Classic.prn.
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Navigating within Report Index

Monarch provides two modes of navigation within the Report Index, passive navigation and active navigation.
Passive navigation involves expanding or collapsing branches to view underlying items without updating the Report
view display. Active navigation involves highlighting a branch in the tree. Whenever a branch is highlighted, the
Report view is automatically updated to display the corresponding page in the report.

Typically, you will use a combination of passive and active navigation in Report Index, e.g., you would click on the
node ([*) to the left of a branch to expand it (passive navigation), and then, when you find an item of interest to you,
you would click the item to display the corresponding page of the report (active navigation).

Let's perform both modes of navigation within Report Index.

Passive Navigation

STEPS:

1. Inthe Report view, click the node () next to the first account number (i.e., 11887) displayed in the tree, and
then expand all the underlying branches by clicking their nodes ([*). Note that the two order numbers for the
account are nested beneath the account number.

»05/01/10 CLASSICAL MUSIC DISTRIBUTCRS PAGE 01 -

oIt Report Index
10:17 MONTHLY SHIPPING REPORT
MSR94 FROM 04/01/10 TC 04/30/10 v Classicpm -
~ 11887

CUSTOMER: Betty's Music Store v 536017

Muscatine Plaza Bartok, Sonata for Solo Violin

200 Lower Muscatine Mozart, Mass in C, K427

Cedar Falls, IA 50613 N

iy Luening, Electronic Music

Scarlatti, Stabat Mater

~ 536039
Beethoven, Pathetique Sonata, Ara
Mendelssohn, War March of the Pr
Pizzetti, Messa di Requiem

» ACCOUNT NUMBER: 11887
»

®» CONTACT: Betty Yoder

Misc,, Modern Trombone Masterpi

MEDIZ QTY DESCRIPTION LABEL/NC. UNT_PRC  AMOUNT 3
- Gershwin, An American in Paris
= CRDER NUMBER: 536017 SHIP DATE: 04/10/10 » 17958
. > 10929
»CD 4 Bartok, Sonata for Solo Violin ME-42625 8.93 35.96
» 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00 > 18635
= 2 Luening, Electronic Music CD 611 10.19 20.38 > 17658
> 13487
» DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
> 10609
» ORDER WUMBER: 536039 SHIP DATE: D4/21/10 > 12705
> 11433
*»/CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
2 Mendelssohn, War March of the Prisscs SME 47532 8.99 71.92 > 15091
» 10 Pizzetti, Messa di Reguiem CHAN 8964 9.53 95.20 > 18172
> 10073
*LP €6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74 > 15844
» DVD 6 Gershwin, Zn American in Paris ACS 8034 5.99 35.94 > 16284 .
®05/01/10 CTASSTEAT MIISTE NTSTRTRITORS PRGE A% M 3 PPN :
‘ »

Figure 7-45. Using passive navigation in Report Index.

Active Navigation

STEPS:

1. Scroll down to the bottom of the Report Index pane and click the node () next to the last account number (i.e.,
14162). Click on order number 536015. Click on the number itself, not the adjacent node ([).

Note that the report page (Page 19) containing the corresponding data displays in Report view and the data itself
is highlighted.
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B T ReSDignI, [N FOUNTAINS Of Kone TomiT P T
Bl Report Index 1

*» DVD 7 Borodin, In the Steppes of Central Asia 7E13-4-RV 3.59 25.13 -

»05/01/10 CLRSSICAL MUSIC DISTRIBUTORS PAGE 20 Beethoven, Pathetique Sonata, Ara
10:17 MONTHLY SHIPPING REPORT Mendelssohn, War March of the Pr
MSR94 FROM 04/01/10 TC 04/30/10

Pizzetti, Messa di Requiem
Misc., Modern Trombone Masterpi

CUSTOMER: Notas Musicales Gershwin, An American in Paris
Calle del Desea, 80

> 17959
50781 La Paz
Spain > 10029
> 18635
> 17658
> ACCOUNT WOMBER: 14162

K > 13487
» CONTACT: Braulio Sénchez > 10609
> 12705
MEDIA QTY DESCRIPTION LABEL/NO. UNT_PRC  AMOUNT > 1433
> 15001
> ORDER NUMBER: 536015  SHIP DATE: 04/05/10 » 18172
»lcp 9 Bizet, Carmen 2-EXL-11 10.78  87.02 > 10073
> 15844
> BLD 7 liszt, Les Preludes aco e1ss 5.50  €7.13 > 16284
. . > 15403

> LP & Greig, Peer Gynt Suites, 1 & 2 DGG 412 47¢  7.77  62.16
> 19764
» ORDER NUMBER: 536044  SHIP DATE: 04/27/10 > 12014
. > 11860

*CD 8 Schumann, Sym. Etudes for piano. MK-34539 g8.99 71.92
> 18917
> BLD 5 Mozart, Serenaca Notturna 70185 3.5 17.85 v 14162

. . . . > 536015
> DvD 2 Bartok, 4 Dirges, pismo., Hagopian XTC-1012 5.33 10.78
= > 536044 -

Figure 7-46. Using active navigation in Report Index.

2. Expand the 536015 order number branch (either double-click it or click the node ([*)) of the tree to reveal the
individual line items and then select the second one (i.e., Liszt, Les Preludes). The corresponding line in the
Report view is highlighted.

NOTE When exporting a report as a PDF file, the Report Index is used to create a list of PDF
bookmarks for easy navigation.

WORKING WITH PROJECT FILES

Project files save time by reducing the number of steps required to store a previous Monarch session. When you
save a project file, references to the input file(s) and the model file, as well as the active filter, sort order, summary,
and view, are saved. Project files are saved via the File > Save As > Project > <Location> command.

When you have saved your work to a project file and wish to continue your Monarch session (presumably at a later
time), simply open the project file you saved by selecting File > Open > Project > <Location>. Doing so
automatically loads the input file(s) and model you were working with. All objects defined in your previous Monarch
session are also made available.

Project File Limitations

Project files contain only references to a Monarch session’s data source and model file; it does not encapsulate the
data source or model file into the project file. Thus, if you delete, move, or rename the data source or model file
referenced by the project, you will be unable to restore a previous Monarch session by opening the saved project.
This is also true if you move the project file to a system that does not have access to the data source or model file,
giving a project file limited portability beyond the system on which it was created.

When a Monarch session using a database table is saved into a project and the column names of this table are
changed (e.g., using an external application), an attempt to open the project launches the following prompt:
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Monarch

Some fields of the external database have incorrect names.
‘Would you like to correct a datasource or fields?

Yes Mo

Figure 7-47. Opening a project file with a modified table.

Clicking Yes on this dialog launches an error message to describe the issues found:

Maonarch - Error =

The following fields no longer have source columns and will
be automatically deleted when this dialog is accepted:

Last Name

First Mame
Hire Date

Figure 7-48. Errors observed when opening a project file using a table with a modified name.

Clicking OK on this dialog takes you to the Edit Table Properties window, where you can select a new data source
instead and/or modify other table properties.

Design
= [5 — - < = e == o = = 1.—
v X 5 @ = e 5 = ' T W,q o 7Y v =T ?
Accept  Cancel Add  Duplicate T Extenzl  Field Database  Formula  Lookup Runtime User Edit Fites  Sorts Address  Functions Help
5 Lookups  List Fields Fields Ficlds  PorameterFiclds  Fields Blocks
-
Import Fields  Import Filter v
Import Database Fields CAUsers\Public\Documents\Altair Monarch\Data\Beantown.mdb - Accounting | Change Data Source
[EREN Source Name Py Table Window Name
(| | Department Department
(vl |EmpID Emp_ID
[C] | First Name
[V | Gender Gender
(] | Hire_Date
(]| Last Name
| Select All | | DeselectAll | Name Prefis: [ Replace nulls with default values
Data Preview v B
Department Emp_ID Gender
1 [Accounting  [1s00784 ]
2 Accounting 1587390 M
3 Accounting 1596792 M
4 Accounting 1593309 F
5  Accounting 1601562 M
6  Accounting 1508264 F
7 Accounting 1594566 M
8  Accounting 1588940 F
9 F

Accounti ni 1590228

o ——————+

Figure 7-49. The Edit Table Properties window.
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Project Files and Automator

Altair Monarch Server Automator Edition (Automator) is a data conversion solution built for Monarch that uses
existing ASCII or ANSI reports, PDF files, XPS files, ISAM files, Open XML spreadsheets, HTML files, and OLE
DB/ODBC sources, among others, as sources of data. You can import report files into Automator and then export
their data to a variety of formats or an OLE DB or ODBC destination. Automator also allows you to export files to a
Microsoft Office SharePoint Server, FTP site, email destination, or distribution list. In short, Automator lets you
extract, transform, move, and load data faster and more easily than previously possible.

Automator offers far more than just an easy way to automate Monarch. It is an information delivery system, capable
of distributing files over the network and to SharePoint locations. It can email users the files they need, or alert them
that new files are available and where to get them, either over the network or via the Internet. RSS feeds can be
created, integrating with newsreaders or corporate information portals. Thus, users are kept up-to-date on the latest
information and can click to download or view the information via a browser.

Automator makes use of project files to create processes. The project file referred to here is the same project file you
create in Monarch when you save your work, including references all reports used, model(s), export(s), filter and sort
definitions, and the like, to a file with the extension .dprj.

For more information on Automator, click here.
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[8] SPECIAL DATA EXTRACTION
TECHNIQUES

In Chapter 7, we created a table using a report with multiple sort levels, but we didn’t extract the customer information
from the highest sort level. In this chapter, we’ll use Monarch’s address block feature to extract the customer names
and addresses. We'll also familiarize ourselves with Monarch'’s floating trap and multi-column region trapping
features. The lesson topics include:

U Special problems with addresses

Extracting an address block

0 Using the address block feature
0  Using the floating trap type
0  Using the multi-column region trapping feature

To get started, we'll load the Classic.prn report and Lessonl.dmod model file.

File Home Report  Table Summary Export ?
- N (] o
= = [Courierhew  ~[10 ] Bl select Al Previous Report [ Next Report | =
® & = =S S v b 2 %
a =i ; cokma
Report Auto S EEEm D [E] Copy I Previous Page & NextPage Bookmark ‘R"e‘f;rt prcp‘f:) é:x;:s
Z=gm Teite ] Gresnbar ik (. Go To Page Go To Chunk :
~
Report Files. oo v R » 05/01/10 CLASSICAL MUSIC DISTRIBUTCRS PAGE 01 -
10:17 MONTHLY SHIPPING REPCRT
i o MSR94 FROM 04/01/10 TO 04/30/10
B Classicpm
CUSTCMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
Usn
* ACCOUNI NUMBER: 11887
.
*CONTACI: Betty Yoder
MEDIA QTY DESCRIPTION LABEL/NO. UNT_EPRC AMOUNT
= CORDER NUMBER: 536017 SHIP DAIE: 04/10/10
> |CD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 35.96
L 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
> 2 Luening, Electronic Music CD 611 10.1¢9 20.38
*DVD 8 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
» CRDER NUMBER: 536039 SHIP DRTE: 04/21/10
*|CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.8%9
> 8 Mendelssohn, War March of the Priests SMK 47592 g.99 71.82
> 10 Pizzetti, Messa di Reguiem CHAN 8964 8.59 95.80
*LP 6 Misc., Modern Trombone Masterpieces RDR SE1087 10.79 64.74
*DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
»05/01/10 CLASSICAL MUSIC DISIRIBUICRS PBAGE 02

10:17 MONTHLY SHIPPING REPORT
q »

Page1 100% ———F——+

Figure 8-1. The Classic report with the Lesson1l model file.

The customer name and address, account number, and contact name are all at the same sort level in the report.
Generally, we define one append template for each sort level. However, we will need to use a special technique to
extract address fields, and that technique requires a separate template.
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USING ADDRESS BLOCKS

Special Problems with Addresses

Most of the information in reports is contained in fields that are easily located for extraction. However, addresses
present special problems. Some may contain three lines, while others have as many as six or seven. As well, fields
containing state, province, and postal code information are not found at a fixed position on the lines they occupy.
Monarch provides a specialized feature in Table view to solve these data extraction problems easily.

To extract the address fields, Monarch provides the Address Block feature in Table view. The Address Block is
capable of taking a block of text and extracting and categorizing the address information contained within it.

Extracting an Address Block

The procedure for extracting the address fields is similar to extracting other fields. First, we’'ll select a sample address
block, then we'll set a trap to capture all other address blocks throughout the report, and finally, we’'ll highlight the
address fields to extract.

Let’s start by selecting a sample address block from the report.

STEPS:

1. Select Report Design El on the Report ribbon.

2. Click on the line selection area to the left of the line containing CUSTOMER and the first line of the address (i.e.,
Betty’s Music Store).

3. Onthe ribbon of the Report Design view, select the drop-down button for New Template and then select
Append. Ensure that the Trap Type is set to Standard Trap.

The first line of the address block is copied into the Sample Text box of the Template Editor.

Template Editor

Standard Trap <A R B @ |8 - «|=| Trap Line - -5 Reset Trap Line FD Reset Fields E_;EditFieId Delete Field

COSTOMER: Betty's Music Store

05/01/10 CLASSICAL MUSIC DISTRIBUIORS PRAGE 01 -
=110:17 MONTHLY SHIPPING REPORT
» MSR94 FROM 04/01/10 TC 04/30/10

»
=

2 |COSTCMER: Betty's Music Store
Muscatine Plaza

200 Lower Muscatine
Cedar Falls, IA 50613
USR

¥y oYY

Figure 8-2. First line of the address block in the Template Editor.

4. Name this template Address Block.
Type customer in the Trap line above CUSTOMER in the sample line.

6. Highlight the field in the sample line, making sure you allow plenty of space for long address lines throughout the
report.
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Template Editor v

|Standard Trap ~|E f B © B - « - Trap Line ~ -5 Reset Trap Line 55 Reset Fields 5 Edit Field
E& Delete Field

customer

N IRty 's Music Store

05/01/10 CLASSICAL MUSIC DISTRIBUTICRS PAGE 01 a
10:17 MONTHLY SHIPPING REPORT

MSR94 FROM 04/01/10 TO 04/30/10

» CUSTOMEER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
Ush

Figure 8-3. Trapping the first line for the address block.

To capture the whole address block, regardless of the number of lines, we need to use the advanced field
options available in Monarch.

7. Select Edit Field =¥ from the Template Editor's Action bar to launch the Field Properties window.

Design

v x Template Name: 2
Address Block v :
Accept  Cancel Help
Show fields from all templates
- . - - A
Fielchs | iz e e v @ General Template Advanced -
A Iel
1 e Betty's Music Store Field Properties
Name: eq Betty's Music Store
Type: Character v
Format: General v
Display Width: (32 &
Alignment: Left v

Hidden

Filter: No Filter SortMoSort  100Rows  100% ———f———+

Figure 8-4. Field Properties window.

8. In the General tab, change the field name to Customer Full and then click the v button that appears beside
the field.

9. Change the field’s Type setting to Memo.

10. Click the Advanced tab and then, under the End Field On heading, select the Blank Field Values radio button
to terminate the field when a blank line or a series of blank lines is encountered. It is important to note that
Monarch does not require the entire line to be blank, only the column positions occupied by the field.

11. Enter the number of blank field values required to terminate the field, which in this case is 1.

12. Click Accept V
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The address fields in the report are highlighted. Scroll through enough of the report to confirm that all instances
of the address have been captured.

Template Editor ~

Standard Trap v|A N R O e - « - Trap line v -5 Reset Trap Line 55 Reset Fields S# Edit Field

SR Delete Field

customer

sl Pttty "2 Music Store

05/01/10 CLASSICAL MUSIC DISTRIBUTCRS BAGE 01 -
10:17 MCHTHLY SHIPPING REPCRT

MSES4 FRCM 04/01/10 TO 04/30/10

* |CUSTOMER: Betty's Music Store
Mu=scatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
USAR

Figure 8-5. Viewing the trapped address block.

Note that this has correctly captured all of the addresses, even though some have four lines and some have five.
This is the advantage of utilizing Advanced Field properties.

13. Click Accept v to accept the template and close the Editor.

Defining Address Blocks
When you open Table view, you will see that the field has been extracted and is displayed using standard memo field
behavior.

Now we can use the address block feature to extract the data from the block of text we have extracted.
STEPS:

1. In Table view, select Table Design L? from the Table ribbon to launch the Table Design interface and then
click Add > Address Block to begin defining your address block.

The Name and Postal Code Formats tab opens.
Address Blocks ot ~ @ Name and Postal Code Formats  Input Fields Output Fields ~

A
BN Address Block

Name: | Address Block

Expected Postal Code Formats

/| USAZIP and ZIP+4

/| Canada

| Australia/New Zealand

Vi Uk

/| Dublin, Ireland

/| Continental Europe
India
Brazil
6-digit at end of line
3-digit at end of line
2-digit at end of line
1-digit at end of line

Data Preview ~ R
Report Date Page Order... Ship Date Account Number Contact Media  Quantity Description Label Number  Unit Price  Amount Customer Full

1 o1 536017 4/10/2010 11887 Betty Yoder D 4 Bartok, Sonata for Solo Violin MK-42625 8.99 35.95 Betty's Music Store Muscatine Plaz
2 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder 7 Mozart, Mass in G, K.427 4208312 9.00  63.00 Betty's Music Store Muscatine Plaz
3 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder 2 Luening, Electronic Music €D 611 1015 20.38 Betty's Music Store Muscatine Plaz
4 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder DVD 9 Scarlatti, Stabat Mater SBT 48282 599  53.91 Betty's Music Store Muscatine Plaz
5 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder @ 11 Beethoven, Pathetique Sonata, Arau 4201532 599 65.89 Betty's Music Store Muscatine Pla
6 5/1/2010 01 336039 4/21/2010 11887 Betty Yoder 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92 Betty's Music Store Muscatine Plaz
7 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder 10 Pizzetti, Messa di Requiem CHAN 8964 9.59  95.90 Betty's Music Store Muscatine Plaz
8  5/1/2010 01 336039 4/21/2010 11887 Betty Yoder LP 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74 Betty's Music Store Muscatine Plaz®
| v

Figure 8-6. The Address Block Wizard.
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2. Enter Addressl in the Name field and then click the v button that appears beside the field.

Select the Input Fields tab.

In the Available Fields list, select Customer Full and then click the Add >> button to add the field to the
Selected Fields list. This command specifies that our address block will be based on the Customer Full field.

Double-clicking on a field in the Available Fields list also transfers the field to the Selected Fields list.

5. Click the Output Fields tab.
6. Select the Address Line 1 check box.

Replace the Address BlockLinel entry in the Output Field Name field adjacent to the Address Line 1 field with
Customer.

8. Select Address Lines 2 and 3, City, Region, Postal Code, and Country, and rename the fields as follows:

Addressl
Address2
City
State

Zip
Country

9. Click the Accept v button after all the fields have been named.

10. Display the Table view window and then scroll right to display the address fields. You can click Autosize

Columns *3* in the Table view ribbon to display all of the fields properly.
Customer Address1 Address2 City State ZIP Country a

1  Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls IA 50613 usa

2 Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls Ia 50613 usa

3 Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls 1A 50613 usa

4 Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls IA 50613 usa

5  Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Fzlls IA 50613 usa

6  Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls IA 50613 usa

7 Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls IA 50613 usa

8  Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls Ia 50613 usa

9  Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cedar Falls Ia 50613 usa
10 Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 30067 usa
11  Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 20067 Usa
12  Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 30067 usa
13  Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 30067 usa
14  Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 30067 Usa
15  Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 30067 Usa
16 Big Shanty Music 3658 Springs Ferry Suite C-130 Marietta GA 30067 usa
17  Bluegrass Records Hwy 17 at the 9 mile m... Prospect Ky 40059 usa
18 Bluegrass Records Hwy 17 at the 9 mile m... Prospect KY 40039 usa
19 Bluegrass Records Hwy 17 at the 9 mile m... Prospect KY 40039 usa
20 Bluegrass Records Hwy 17 at the 9 mile m... Prospect KY 40059 usa
21  Bluegrass Records Hwy 17 at the 9 mile m... Prospect KY 40059 usa
22 Musique du Monde 170 Rue de la Poste Fleury-les-Aubrais 45400 France
23 Musique du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
24 Musigue du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
25  Musigue du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
26 Musigue du Monde 170 Rue de la Poste Fleury-les-Aubrais 45400 France
27  Musigue du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
28  Musique du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
29  Musique du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
30  Musique du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
31  Musigue du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
32  Musigue du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France
33  Musigue du Monde 170 Rue de |a Poste Fleury-les-Aubrais 45400 France ~
34 Mucinua di Mands 170 Rus de |2 Pacte Flanrv-las-Auhraic 45400 Franra

1

b

Figure 8-7. Sample of extracted addresses in Table view (column widths adjusted to show all seven address fields).

Note that Monarch has extracted all the information contained in the original address block and categorized it
correctly into the defined fields.

The final step in this exercise is to hide the original field we used to extract the address block information,

Customer Full.
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11. Using your mouse, right-click anywhere on the Customer Full field. From the context menu that displays, select
Hide Customer Full.

The table displays once more without the Customer Full field.

NOTE To redisplay hidden fields, right-click on your mouse in Table view and then select the Show
Hidden fields option in the context menu that displays. A list of hidden fields appears.
Select the field to redisplay from this list.

12. Close the lesson and model files without saving any changes.

We will cover hiding fields more thoroughly in the next lesson. As you can see from the table, the Address Block
is a simple but powerful feature, capable of extracting information from addresses around the world.

USING THE AUTO-DEFINE FEATURE IN REPORT
VIEW

Now that we know how Monarch allows you to manually create traps to extract data from a report, let's turn our

attention to the Auto-Define =¥ feature in Report view. This new feature allows you to automatically define detail
traps.

STEPS:

1. Open the Employ.prn report. The report displays in Report view.

File Home Report Table Summary Export ?
= = . - evious Re Repor . =
;’ B Select Al Previous Report Next Report | L. [
Report A “Q Zoom To Fit [T Copy et e Previous Page 3 Next Page Bookmark Report 5 | Shurk
Design Define Bl Greenbar T £ Go To Page Ga o Ghusk ness (e
-

DS eaesastaeEEas RN EVEIVET MAYNARD CORPORATION FAGE 1 5
10:31 ACTIVE EMPLOYEZ REPORT

i L) rupos1

E Employ.prm
FIRSTNAME  LASTHAME STREET cITy STATE ZIP  HIREDATE SEX DEET SALARY
Stephen McPherscn 410 Market St Boston un 02115 06/14/32 M  Data Processing  37800.00
Dennis Bender 624 Holiday Hill Burlington m 01803 11/20/24 M  Shipping 47400.00
Norman Ungermann 1615 Del Terrace Concord wa 01742 05/17/385 M Markecing 33500.00
Brnold Finnley 207 Anglewood Rd Littleton m 01460 05/25/81 M Shipping 39500.00
William Daley 5 Dixwell Blvd Lexington M 02173 01/30/83 M  Accounting 39600.00
Mery Bech  Stancowicz 91 Belment Dr Maynazd 1w 01754 10/11/87 F  Accounting 42600.00
Rebert Tracy 23 Mountain View Meynazd m 01754 12/12/87 M Data Processing  38800.00
Eugene Bradford 888 Centre Park R4  Brookline wa 02146 07/24/35 M Marketing 62300.00
Doug Williams 9 Lawrence St Burlington m 01803 02/26/30 M  Data Processing  52200.00
Francis Lavois 20 Box 1752 Burlington wa 01803 10/26/33 M  Data Brocessing  £0500.00
William Connely 248 Washington St Jamaica Plain MA 02130 03/12/30 M  Marketing 53000.00
Endrew Bass 44 South Park St Fitchburg M 01420 03/18/89 M  Data Processing  43400.00
Howard Lonters 472 North Vincent Revere 1w 02151 04/30/89 M  Shipping 20250.00
Abe Carver 101 Mayflower St Sudbury MR 01776 04/04/31 M Shipping 25500.00
bon Craig 1899 Abilene St Burlington wa 01803 08/14/94 M  Production 37100.00
David Banning 100 Catherine Ave Burlington m 01803 12/18/93 M Marketing 65500.00
Kelly Rosenberg 31 Belvedere Dr Fitchburg M 01420 09/02/87 F  Accounting 41300.00
Teshua Fallon 160th Ct W Sudbury . 01776 01/05/35 M  Marketing 63300.00
Guen Davies 22 Punta Del Este Sudbury M 01776 10/23/83 F  Production 32900.00
oliver Davies & George Dr Westkozo 1w 01581 02/28/85 M Production 28700.00
Paula Mendlessn 89 Lineoln St Boston a 02135 07/18/35 F  Marketing 18040.00
Marlena Evans 799 51 St. NE Lowell wa 01853 06/04/30 F  Data Processing  4£4100.00
Elizabeth  Woodruff 364 East Main Sudbury m 01776 06/23/33 F  Accounting 28500.00
Wayne Sedlinski PO Box 149 Lowell 1w 01853 04/12/81 M  Shipping 39400.00
Georqe Miller 13 Scenic Dr. Millbuzy . 01527 03/18/86 M  Data Processing  35000.00
Barry Johnsten 173 Bolston St Boston a 02172 12/28/286 M Data Brocessing  £4700.00
Liz Chandler 285 Denise 2d Reading w 01867 05/04/84 F  Marketing 528900.00
Teresa leiberman 254 Wilson Ave Carlisie a 01741 07/03/87 F  Markecing 28250.00
bon Kincaid 5 Hye Rd Burlington w 01803 03/04/85 M  Production 37300.00
Joseph Manfretti 24 Collin Ave Carlisie M 01741 08/23/89 M  Marketing 46750.00
gese Aldridge 153 Parker Ave Medfozd 1w 02155 10/13/85 M  Accounting 43000.00
Maaie Horton 2399 Cypress Rd Sudbury 1w 01776 11/05/85 F  Shicping 26300.00 o
. v

Pagel 100% ——4——+

Figure 8-8. The Employ.prn report.
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2. Click Auto-Define E on the Report view toolbar. The Template Editor displays with the trapping results. Note
that the Trap line is automatically filled with trap characters.

Design
Template Name: - - =L s =) = W E‘ =]
M ol bl B ol oA s B
Accept  Cancel - New  Delete Replace  Redact  Clearing | Auto-Define Auto-Define | Multi-Column RunReport | Report Help
Template Role: Templatev Template = Sample Text Sample Text Template v Fields Region Verify Colors
Detail
A
Templates v @ Template Editor ~ | Field Properties v B
i O [swandard Trap B fi B @ & - < » Traplinev [P ResetTrapline 55 ResetFields S Edit Field =
Tl Detail Delete Field Name
7 50 86 52 50 finse 56 8O
Foston E | Tempotewidh
03/31/10 MAYNARD CORPORATION B . .
10:31 ACTIVE EMPLOYEE REPORT s
EMPO81
Decimals:
FIRSTNAME LASTNAME STREET CITY STATE ZIP HIREDATE SEX Format: hd
* Stephen McPherson 410 Market St Boston ME 02115 06/14/92 M
»Dennis Bender 624 Holiday Hill Burlington MB 01803 11/20/9%¢ M Di
» Norman Ungermann 1615 Del Terrace Concord Ma 01742 05/17/85 M
» Arnold Finnley 207 Znglewood Rd Littleton Ma 01460 05/25/81 M . -
»Willian Daley 5 Dizwell Blvd Lexington Ma 02173 01/30/83 M R
»Mary Beth Stancowicz 91 Belmont Dr Maynard Ma 01754 10/11/87 F
» Robert Tracy 23 Mountain View Maynard ME 01754 12/12/87 M Copy Value From Previous Record
®» Eugene Bradford 888 Centre Park Rd Brookline MA 02146 07/24/95 M Hida
» Doug Williams 9 Lawrence St Burlington MB 01803 02/26/90 M ceen
® Francis Lavois PO Box 1752 Burlington ME 01803 10/26/93 M -
4 0 < Previous Field Next Field >
Firstname  Lastname Street ity S.. Zip Hiredate S. Dept Salary
1 [Stephen |McPherson 410 Market St Boston MA 2115 19920614 M Data Processing  37800.00
2 Dennis Bender 624 Holiday Hill Burlington MA 1803 19941120 M Shipping 47400.00
3 MNorman  Ungermann 1615 Del Temace Concord MA 1742 19850517 M Marketing 33500.00
4 Amold Finnley 207 Anglewood Rd Littleton MA 1460 19810525 M Shipping 39500.00
5 Wiliam  Daley 5 Dbawell Bivd Lexington MA 2173 19830130 M Accounting 39600.00
6 MaryBeth Stancowicz 91 Belmont Dr Maynard MA 1754 19871011 F Accounting 42600.00
7 Robert Tracy 23 Mountain View Maynard MA 1754 19871212 M DataProcessing  38800.00
8  Eugene Bradford 888 Centre Park Rd Brookline MA 2146 19950724 M Marketing 62300.00
9 Doug Williams 9 Lawrence St Burlington MA 1803 19900226 M Data Processing  52200.00 |
“ » -
Firstname - Character - Detail Detsil Paget 100 ————+

Figure 8-9. The Template Editor window showing the results of an Auto-Define trapping operation.

3. Scroll down to view the highlighted lines.

Monarch analyzes the detail line we selected as our sample and selects all the other lines in the report that have
the same format.

USING THE AUTO-DEFINE TRAP FEATURE IN
REPORT DESIGN VIEW

Now that we've seen how Monarch allows you to manually create traps to extract data from a report, let's turn our
mp
attention to the Auto-Define Trap “W feature. This new feature allows you to automatically define traps.

One way we can explore just how effective this tool can be is to use it on the report we were just working with. Using
the Employ.prn report, we can compare the auto-define trapping process with the manual trapping procedure we just
performed.

There are three important things to consider when using the auto-define trap feature:
0O  When selecting your sample line (Step 3 below), it is important to select a line that best represents the bulk of the
lines in the report, since Monarch will trap all the lines that feature formatting that matches your sample line.

-

0 After you have selected the Auto-Define Trap “% putton (Step 4 below), be sure to examine more than just one
or two pages of the report. If you fail to do so, you may overlook lines of the report that you wanted to capture but
Monarch failed to trap due to some anomaly in them.

0 Lines left unchecked (Step 6 below) in the Auto-Define Trap window will not be trapped by Monarch, so be sure
to select the check boxes of all of the lines you want trapped.
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STEPS:

1.

4.

Open the Employ.prn report. The report displays in Report view.

File Home Report Table Summary Export
=4 Select Al Next Report | e r.‘-.
= H
Report uts @ Zoom To Fit [] Copy ceoh Fndn [ Next Page . Fff;f DI .{573 c?'.f.:.:;
Design Define El Greenbar Table (. Go To Page GoTo Chunk R
~
Report Files o s v 0| [03/31/10 MAYNARD CORECRATION PAGE 1 -
10:31 ACTIVE EMPLOYEE REEORT
i L) lmupoe1
E Employ.pm
FIRSTHAME  LASTNAME STREET CITY STATE ZIP HIREDATE SEX DEPT SALARY
Stephen McPherson 410 Market St Boston MB 02115 06/14/82 M  Data Processing  37800.00
Dennis Bender 624 Holiday Hill Burlington M 01803 11/20/84 M  Shipping 47400.00
Norman Ungermann 1615 Del Terrace Concord MR 01742 05/17/85 M Marketing 33500.00
Arnold Finnley 207 Englewood Rd Littleton MR 01460 05/25/81 M Shipping 39500.00
William Daley 5 Dixwell Blvd Lexington MR 02173 01/30/83 M  RAccounting 39600.00
Mary Bech Stancowicz 91 Belmont Dr Maynard MB 01754 10/11/87 F  Accounting 42600.00
Robert Tracy 23 Mountain View Maynard M 01754 12/12/87 M  Data Processing  38800.00
Eugene Bradford 288 Centre Park R4 Brookline MR 02146 07/24/85 M Marketing 62300.00
Doug Williams 9 Lawrence St Burlington M 01803 02/26/80 M  Data Processing  52200.00
Francis Lavois PO Box 1752 Burlington MR 01803 10/26/83 M  Data Processing  40500.00
William Connely 248 Washington St Jamaica Plain MR 02130 03/12/30 M  Marketing 53000.00
Endrew Bass 44 South Park St Fitchburg ME 01420 03/18/8% M  Data Processing  43400.00
Howard Loniere 472 North Vincent Revere MB 02151 04/30/8% M  Shipping 40250.00
2be Carver 101 Mayflower St Sudbury M 01776 04/04/81 M  Shipping 25500.00
Don Craig 1898 Rbilens St Burlington MR 01803 08/14/94 M  Production 37100.00
David Banning 100 Catherine Ave Burlington MR 01803 12/18/93 M  Marketing 65500.00
Kelly Rosenberg 31 Belvedere Dr Fitchburg ME 01420 09/02/87 F  Accounting 41300.00
\Joshua Fallon 160th Ct W Sudbury M 01776 01/05/85 M  Marketing 63300.00
Guen Davies 22 Punta Del Este Sudbury MB 01776 10/23/83 F  Production 32900.00
Oliver Davies 2 George Dr Westboro M 01581 02/28/85 M  Production 28700.00
Paula Mendleson 89 Lincoln St Boston M 02135 07/18/85 F  Marketing 48040.00
Marlenz Evans 798 51 St. NE Lowsll MR 01853 06/04/80 F  Data Processing  44100.00
Elizabeth Woodruff 364 East Main Sudbury MR 01776 06/23/93 F  Accounting 48500.00
Wayne Sedlinski PO Box 149 Lowell ME 01853 04/12/81 M  Shipping 39400.00
George Miller 13 Scenic Dr. Millbury M 01527 03/18/86 M  Data Processing  35000.00
Barry Johnston 173 Bolston St Boston M 02172 12/28/86 M  Data Processing  44700.00
Liz Chandler 255 Denise Rd Reading MR 01867 05/04/84 F  Markesting 52200.00
Teresa Leiberman 254 Wilson Ave Carlisle M 01741 07/03/87 F  Marketing 48250.00
Don Kincaid 9 Nys Rd Burlington MR 01803 03/04/85 M  Production 37300.00
Joseph Manfretti 24 Collin Ave Carlisle MR 01741 08/23/8% M  Marketing 46750.00
\Jeft Aldridge 153 Parker Ave Medford ME 02155 10/13/85 M  Accounting 43000.00
F Shivping 26300.00 M

Magaie Horton 2399 Cvpress Rd Sudburv MR 01776 11/05/85
.

Pagel 100% —————+

Figure 8-10. The Employ.prn report.

Select Report Design l to activate the Report Design interface.

Click on the line selection area to the left of the detail line (e.g., the one containing Stephen McPherson) and

then select New Template > Detail. Ensure that the Trap Type is set to Standard Trap.

Template Editor

w
AR f B O 8 - « - Trap Line ~ -5 Reset Trap Line 55 Reset Fields Edit Field Delete Field
Stephen McPherson 410 Market 5t Boston MA 02115 06/14/92 M Data Processing

®03/31/10 MAYNARD CCRPORATICN a

»10:31 ACTIVE EMPLOYEE REPORT

*EMPO81

»

=

= FIRSTHAME LASTNAME STREET CITY STATE ZIP HIREDATE SEX DEFT

2 |Stephen McPherson 410 Market St Boston MR 02115 0&/14/92 M Data Processing

®Dennis Bender 624 Holiday Hill Burlington MA 01803 11/20/94 M Shipping

® Norman Ungermann 1615 Del Terrace Concord MR 01742 05/17/85 M Marketing

2 Arnold Finnley 207 Anglewood Rd Littleton MR 01480 05/25/81 M Shipping

2William Daley 5 Dixrwell Blwd Lerxington MR 02173 01/30/83 M Accounting

® Mary Beth Stancowicz %91 Belmont Dr Maynard M 01754 10/11/87 F Accounting

® Robert Tracy 23 Mountain View Maynard MR 01754 12/12/87 M Data Processing

2 Fugene Bradford 888 Centre Park Rd Brookline MR 02146 07/24/95 M Marketing

= Doug Williams % Lawrence 5t Burlington MR 01803 02/26/90 M Data Processing

Figure 8-11. Selecting the detail line.

Click Auto-Define Trap “¥ on the toolbar. The Auto-Define Trap window displays.
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Design

v % g da CE 2

Accept  Cancel First Previous Next Last Help
~
Line Target Text

1 [ e MEYRERD CORFORARTICH FAGE 1 a
2 [ a2 ACTIVE EMPLOYEE REPORT
3 [] rueos1
4
s
€ [[] rrmsmmaME  rasmie STREET oIty SIATE ZIF  HIREDATE SEX DEFT SHLERY
7 [ Stephen McPherson 410 Market St Eostan MR 02115 06/14/92 M  Data Processing  37800.00
8 [ Demmiz Bender £24 Holiday Hill Burlingtaon MR 01802 11/30/94 M Shipping 47400.00
¢ [ Fomman Ungermann 1615 Del Terrace Concozd MR 01742 05/17/85 M Marketing aasoo. 00
1 [y] Eemeld Finnley 207 Anglewsod Rd Littleton ey 01460 05/35/81 ¥ Shipping ass00_ 00
11 [] William Daley 5 Dixwell Blud Lexingten ey 02173 01/30/83 M Accounting ase00. 00
12 [g] Mary Beth Stancowicz 81 Belment Dr Maynazd ey 01754 10/11/87 F  Accounting 4260000
13 [ff] Rebezs Tracy 23 Mountain View Maynard MR 01754 13/13/87 M Data Processing  38800.00
12 [ Eugene Bradford BEA Centze Park Bd  Ercokline MR 02146 07/3%/95 M Marketing £2300. 00
15 [J] Doug Willizms 9 Lomzence ot Berrimgten = 01803 03/36/0 M  Dasa Frocessimg 5330000
16 [] Francis Lawois PO Box 1752 Burlingten ME 01802 10/26/33 M Data Processing  40500.00
17 ] William Connely 248 Washington St Jamaica Plain MA 02130 03/13/30 ¥  Markesing 5300000
18 [] Endzew Bass 44 Scuth Park St Fitchburg -y 01420 03/18/8% M Data Processing  43400.00
18 [] Howazs Loniers 472 Norch Vincent Reveze -y 02151 04/30/8% ¥  Shipping 40250. 00
0[] E== Carver 101 Mayflower St Sudbury -y 01776 04/04/91 M Jhipping 23500. 00
1 [ Dem Craig 1888 Ebilene St Burlingtaon MR 01802 08/14/94 M Production a7100.00
22 [f] Dawid Banning 100 Catherine Ave Burlingtaon MR 01802 13/18/93 M Marketing £5500.00
33 [ Eelly Rosemberg 31 Beluedeze Dr Fitchbnzg Iy 01430 09/03/87 F  Accounting 41300 00
24 [J] Jeshua Fallon 1€0th Ct W Sudbury -y 01776 01/03/95 M Markering £2200.00
5[] Gwen Davies 22 Punta Del Este Sudbury -y 01776 10/33/83 F  Production 22800.00
26 [y] Oliwes Dawies 8 Geozge Dr Westbozo MR 01581 03/38/85 M Production 28700. 00
27 [f] Eaula Mendleson 88 Lincoln St Eoztan MR 02135 07/18/85 F  Marketing 48040.00
28 [ Mazlena Evans 793 51 St. XE Lowell MR 01853 06/04/30 F  Data Processing  44100.00
28 [g] Elizsbeth Woodruff 264 East Main Sudbury ey 01776 06/23/33 F  Accounting 4850000
3 [| Wagne Sedlinski PO Box 148 Lowell ME 01853 04/13/31 ¥ Shipping 2840000
31 [y] Geozae Miller 13 Scenic Dr. Millbury ey 01527 08/16/86 M Data Processing  25000.00
2 [g] Bamy Johnston 173 Bolston St Bostan -y 02172 13/38/86€ M Data Processing  44700.00
2 [ L= Chandler 235 Denize Bd Reading -y 01867 03/04/84 F  Markering s8300. 00
35 [f] Tesesa Leibermsn 354 Wilson Ave Carlisle = 01741 07/08/87 T  Markebing 2835000
35 [f] Dem Rincaid 3 Nye Rd Burlington ey 01803 03/04/85 M  Production a7ann. oo
3 [ To=eph Manfretti 24 Collin Auve Carlisle ey 01741 08/23/3%9 M Markesing 4675000
27 [g] Tes= Aldridge 133 Parker Ave Medford -y 02155 10/13/85 M Accounting 42000.00
28 [] Magmie Horron 2288 Cypress Bd Sudbury -y 01776 11/05/85 F  Shipping 26200.00
3% [7] Anne Barchol 343 Boulten St Ercckfield ML 02157 11/18/83 F i 42800.00 |

Filter: No Filter SortNoSort o7Rows 100% — —f———+

Figure 8-12. The Auto-Define Trap window.

5. Scroll down to view the highlighted lines. Monarch analyzes the detail line we selected as our sample, and
selects all the other lines in the report that have the same format.

Note, however, that the auto-define trap feature has failed to select all of the detail lines.

14 3‘ Eugene Bradford 888 Centre Park Rd Brookline MR 032146 07/34/95 M Marketing €2300.00
15 Fi Doug Williams S Lawrence 3t Burlington ME 01803 03/36/30 M Data Processin 5232300.00
| 16 ] Francis Lavois PO Box 1752 Burlington MA 01803 10/26/593 M Data Processing 40500.00
T ; WIllzam Tonnely TH WeSHingtomn oF Tam=ics Plain  BX LA =20 R e ¥ = TaTEecing 240 g
18 ? Andrew Bas== 44 Jouth Park 3t Fitchburg MA 01430 03/18/8% M Data Processing 43400.00
1g ? Howard Loniere 472 Horth Vincent Revere MA 02151 04/30/8% M Shipping 40250.00
an ? Abe Carwer 101 Mayflower 3t Sudbury HA 01776 04/04/31 M Shipping 25500.00
21 7 Don Craig 18%% Abilene= 3t Burlington MR 91803 08/14/5%4 M Producticn 37100.00
22 7 Dawid Banning 100 Catherine AZve Burlington MR 01803 12/18/%93 M Marketing E5500.00
23 7 Felly Ro=enberg 31 Beluvedere Dx Fitchburg MR 01420 08/02/87 F Accounting 41300.00
24 Jos=hua Fallon 1€0th Ct W Sudbury MA 01776 O01/05/95 M Harketing €3300.00
as Cwen Davies 22 Punta Del E=te Sudbury MA 01776 1023783 F Producticn 32500.00
2E Oliger Davies 8 George Dr We=tboro MR 01581 02/28/85 M Froduction 38700.00
a7 l Paula Hendleson B% Lincoln 3t Eo=ton MA 02135 07/18/85 F Harketing 48040.00
28 3 Marlena Evans 79% 51 3t. HE Lowell MR 01853 O06€/04/%0 F Data Processing 44100.00
i !é Elizabeth Woodruff 3€4 East Main Sudbury MA 01776 06/33/93 F Accounting 48500. 00
ao Wayne Sedlinski PO Box 14% Lowell MA 01853 0413791 M Shipping 3540 1}
aT : TECIge TIITer T ocenzc DT. WITIEGTY oy ulm_ﬂ'm-ﬂ'ﬂ'la T ProcessSing T
aa 7 Bazzy John=ton 173 Bolston 3t Boston MA 02172 12/28/8€ M Data Processing 44700.00
a3 ? Liz Chandlexr 255 Denise Rd Reading HA 01867 05/04/84 F Harketing S8500.00

Figure 8-13. Viewing detail lines that haven’t been trapped.

This is because, while the detail line we selected as our sample contained a street address that begins with a
number (e.g., “410 Market Street”), a few of the street addresses in Employ.prn begin with a letter, as in “PO Box
1752”. When comparing the sample line with all the detalil lines in the report, the auto-define trap feature opted
not to trap any lines with such a discrepancy.
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Note that, on the first page of the report, there are two detail lines which weren’t trapped. We obviously want
these detail lines to be trapped, however, as well as any that may exist on other pages of the report. Fortunately,
the Auto-Define Trap window provides an easy way to ensure that they are selected.

4. Select the check boxes for the two detail lines whose street addresses are PO box numbers (see Rows 16 and
30). Note that the text color for these two detail lines changes from black to red. This is simply to notify us that
the lines don't perfectly match the sample detail line.

14 [J| Eugene Bradfozd B85 Cemtze Pazk Rd Ezockline ME 03146 07/24/85 M Mazketing €2300.00
15 [J] Doug Williams S Lawzence 3t Burlington ME 01803 02/26/%0 M Data Processing  53200.00
18 Francis= Lawois= PC Box 1752 Eurlington ME 01802 10/26/%3 M Data Processing  40500.00
17 [ William Conncly 248 Washington St Jamaica Plaim MA 02130 03/12/%0 M Mazketing 53000.00
18 [ Endrew Ba==s 44 3outh Fark 3t Fitchburg ME 01430 03/18/8% M Data Processing  43400.00
18 [J] Howard Lonieze 472 North Vincent Rewers ME 02151 04/30/88 M Shipping 40350.00
20 [J] BEke Cazrwez 101 Mayflower St Fudbuzy MR 01776 04/04/%1 M Shipping 25500.00
21 [y] Dem Craig 1855 Ebilene 3t Burlington ME 01803 08/14/%2 M Production 3710000
2z David Bamning 100 Catherine Aue Burlington ME 01803 12/18/%3 M Marketing €5500._00
23 [ Eelly Ho=enkerg 31 Eelweder= D= Fitchburg ME 01420 0%/03/87 F Zccounting 4130000
24 [J] Joshua Fallcn 160th Ct W Sudbuzy ME 01776 01/05/35 M Mazketing €3300.00
as [J] Gwen Dawics 22 Funta Del Este Sudbury ME 01776 10/33/83 F Production 32300.00
26 [J] Oliwer Dawies= g Geczge Dz We=tbozc ME 01581 02/28/85 M Producticn 28700.00
27 [ Faula Mendlescn 8% Linceln 3t Eoston ME 031as 07/18/85 F Marketing 4804000
28 [ Marlema Evans 783 51 3t. NE Lowell ME 01853 06/04/%0 F Data Processing  44100.00
2 [J] Elizabeth Woodruff 364 Ea=t Main Fudkury ME 01776 0&/23/%3 F Zccounting 4850000
W [ Wayne Sedlinaki EC Box 143 Lawell ME 01853 04/12/9%1 M Shipping 23400.00
a1 [J] George Miller 13 3cenic Dr. Millbury ME 01537 03/18/86 M Data Processing  25000.00
a2 [y] Bazzy John=ton 173 Bolstom 3t Bo=ton ME 02172 12/28/86 M Data Processing  44700.00

Figure 8-14. Selecting the additional detail lines.

5. Click the Apply Changes < button. This tells Monarch to additionally trap any lines that match the format of
the newly selected ones. The additional detail lines we selected are now highlighted.

= - - -
13 Robezt Tracy 23 Mountain View Maynazd ME 01754 12/13/87 M Data Processing  38800.00
12 Engene Bradford 888 Centze Fack Rd Brockline ME 03146 07/34/85 M Marketing €2300.00
15 Doug Williams S Lawrence 3t Burlington ME 01803 02/36/30 M Data Processing  52300.00
16 Franci= Lawoi= FO Box 1752 Burlington ME 01803 10/26/33 M Data Processing  £0500.00
17 William Connely 248 Washingtom 3t Jamaica Flain MR 02130 03/13/80 M Marketing 53000.00
18 Endrew Ea== 44 Jouth Fark 3t Fitchburg ME 01420 03/18/85 M Data Processing  £3400.00
18 Howazd Lonieze 472 Horth Vincent Reveze ME 02151 04/30/85 M Shipping 40250.00
20 Ebe Caruver 101 Mayflower 3t Sudbuzy ME 01776 04/04/81 M Shipping 25500.00
a1 Den Craig 185% Ebilene 3t Burlington ME 01803 08/14/34 M Froduction 27100.00
2z Dawid Banning 100 Catherine Bue Burlington ME 01803 12/18/33 M Marketing €5500.00
22 Felly Ro=enbezg 21 Belwedeze Dz Fitchburg ME 01420 08/03/87 F Zccounting 41300.00
22 Jo=hua Fallon 160th Ct W Sudbuzy ME 01776 01/05/85 M Marketing €3300.00
2s Gwen Davies 22 Fumta Del E=te Sudbuzy ME 01776 10/33/83 F Froduction 22500.00
26 Oliver Davies 8 Geczge Dr We=tbozro ME 01581 02/38/85 M Froduction 28700.00
a7 Paula Mendle=cn 82 Linccln 3t Eo=ton ME 02135 07/18/85 F Marketing 48040.00
28 Marlena Evans= 728 51 S=. NE Lowsll ME 01853 06/04/80 F Data Proces=ing  24100.00
as Elizaketh Wocdzuff 264 Ea=t Main Sudbuzy ME 01776 0€/23/83 F Zccounting 48500.00
20 Wayne= Sedlinaki PO Box 142 Lowsll ME 01853 04/13/81 M Fhipping 35400.00
a1 Geczge Millez 12 3cenic D=. Millkbury ME 01537 03/18/86 M Data Proces=ing  25000.00
22 Barzy John=ton 173 Bcl=tom 3t Eo=ton ME 03172 12/28/8€ M Data Proces=ing  24700.00
23 Liz Chandlez 255 Deni=e Bd Reading ME 01867 05/04/84 F Marketing S8200.00

Figure 8-15. Viewing the result of the recalculation.

Although we could check the other pages of the report for detail lines which haven’t been trapped, let's see if the
detail lines we've selected are sufficient.

6. Click the Accept v button to close the window, and then scroll down to make sure that all of the detail lines
have been successfully trapped.
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Template Editor ~

E AR o g8 - + =+ Trap Line v -f) Reset Trap Line 55 Reset Fields Edit Field Delete Field
A 5BRE BRE BREAE BABMA BABNNNNN ARH/NE/HN BA 8asi
Stephen McFPherson 410 Market St Boston MR 02115 06/14/92 M Data Processing
* Norman TUngermann 1615 Del Terrace Concord MR 01742 05/17/85 M Marketing a
*Arnold Finnley 207 Anglewood Rd Littleton ME 01460 05/25/81 M Shipping
*William Daley 5 Dixwell Blwd Lexington MR 02173 01/30/83 M Accounting
* Mary Beth Stancowicz 91 Belmont Dr Maynard ME 01754 10/11/87 F Accounting
* Robert Tracy 23 Mountain View Maynard MR 01754 12/12/87 M Data Processing
* Eugene Bradford 888 Centre Park Rd Brookline MR 02146 07/24/95 M Marketing
* Do Williams 9 Lawrence St Burlington MZ 01803 02/26/90 M Data Processimn
I > Francis Lavois PO Box 1752 Burlington ME 01803 10/26/93 M Data Processing I
*William Connely 248 Washington S5t Jamaica Plain ME 02130 03/12/90 M Marketing
= Andrew Bass 44 South Park S5t Fitchburg MR 01420 03/18/8%9 M Data Processing
* Howard Loniere 472 North Vincent Revere MR 02151 04/30/88 M Shipping
* Rbe Carver 101 Mayflower St Sudbury ME 01776 04/04/91 M Shipping
= Don Craig 1899 Abilene St Burlington MR 01803 08/14/94 M Production
* David Banning 100 Catherine Awve Burlington ME 01803 12/18/93 M Marketing
> Helly Rosenberg 31 Belwvedere Dr Fitchburg MR 01420 08/02/87 F Accounting
* | Joshua Fallon 160th Ct W Sudbury MR 01776 01/05/85 M Marketing
* Gwen Davies 22 Punta Del Este Sudbury ME 01776 10/23/83 F Production
»0liver Davies 8 George Dr Westboro ME 01581 02/28/85 M Production
* Paula Mendleson 89 Lincoln 5t Boston ME 02135 07/18/85 F Marketing
* Marlena Evans 799 51 5t. KE Lowell MR 01853 06/04/90 F Data Processing
*Elizabeth Woodruff 364 Fast Main Sudbury MR 01776 06/23/093 F Accounting
| * Wayne Sedlinski PO Box 149 Lowell M2 01853 04/12/91 M Shipping |
*George Miller 13 5Scenic Dr. Millbury Mz 01527 03/18/86 M Data Processing
* Barry Johnston 173 Bolston S5t Boston ME 02172 12/28/86 M Data Processing
3Liz Chandler 255 Denise Rd Reading MR 01867 05/04/84 F Marketing =

Figure 8-16. Scrolling the report to make sure all the detail lines have been trapped.

Note that the Trap line is automatically filled with trap characters.

USING FLOATING TRAPS

In addition to the address block feature, Monarch has another special data extraction feature called the Floating trap
type. Let's take a few moments to learn about this powerful feature.

In many reports, particular fields of data, such as names and addresses, occur in consistent locations (i.e., they begin
at the same horizontal position throughout the report). For example, in the following report, note how all of the first
names begin at the same horizontal position, as do all of the last names, streets, cities, etc.

FIRSTNAME LASTHEME STREET CITY STATE ZIP HIREDATE SEX DEET SRLRRY
Stephen McFherson 410 Market S5t Boston MR 02115 06/14/92 M Data Processing 37800.00
Dennis Bender 624 Holiday Hill Burlington MR 01803 11/20/94 M Shipping 47400.00
Norman Ungermann 1615 Del Terrace Concord MR 01742 05/17/8B5 M Marketing 33500.00
Ernold Finnley 207 Anglewood Rd Littleton MR 01460 O5/25/81 M Shipping 39500.00
William Daley 5 Dixwell Blwvd Lexington MR 02173 01/30/83 M Bccounting 39600.00
Mary Beth Stancowicz 91 Belmont Dr Maynard MR 01754 10/11/87 F Rccounting 42600.00
Robert Tracy 23 Mountain View Maynard MR 01754 12712787 M Data Processing 3BB00.00
Eugene Bradford EEE Centre Park Rd Brookline MR 02146 07/24/95 M Marketing 62300.00
Doug Williams 9 Lawrence 5t Burlington MR 01803 02/26/90 M Data Processing 52200.00
Francis Lavois EC Box 1752 Burlington MR 01803 10/26/93 M Data Processing 40500.00
William Connely Z48 Washington 5t Jamaica Flain MR 02130 O03/12/90 M Marketing 53000.00
Endrew Bass 44 South Park St Fitchburg MR 01420 03/18/89 M Data Processing 43400.00
Howard Loniere 472 North Vincent Revere MR 02151 04/30/89 M Shipping 40250.00
Zioe Carver 101 Mayflower 5t Sudbury MR 01776 04/04/91 M Shipping 25500.00
Don Craig 1899 Akilene St Burlington MR 01803 0B/14/9¢4 M Broduction 37100.00
David Banning 100 Catherine Rve Burlington MR 01803 12718793 M Marketing 65500.00

Figure 8-17. A report showing consistent data placement, as is typical of many reports.

Because of the consistent placement of data within the report, defining a trap to capture each occurrence of any one

of these fields would be quite easy. With some reports, however, a standard trap won’'t work because data placement
within them is irregular rather than consistent.

In the following report, for example, note how the occurrences of the date/time field ("[23/Aug/2008...") begin at
different horizontal positions.
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ezvl-30pppl87.
ezvl-30pppl87.
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epix.
epix.
epix.
epix.
epix.
epix.
epix.
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net
net
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ACE55931.ipt.aol.com -
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202.112.36.1%6 - -
v400.inktomi.com - -

[23/Rug/2010:
[23/BAug/2010:
[23/Rug/2010:
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[23/Rug/2010:
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01:
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o1

[23/Bug/2010:01:18:
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01:
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01:
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14:45 -0400) "GET fexpress/search l.htm
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-0400]

/ HITB/1.0"™ 200 S581(
fimages/pin.gif HTTI
Jimages/Bannerlogo.c
fimages/current.gif
fimg/rdot.gif HITE/!
Jimages/find.gif HTI
/images/newdiscuss.¢
Jimages/spot.gif HTI
/search/index.html

$14:51 -0400] "GET /express/125x30_snpcar
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ts.txt HITE/1.0" 404

Figure 8-18. A report showing inconsistent placement of the date/time data.

In reports such as this, a standard trap will not work. Fortunately, Monarch includes a special trap called the floating
trap, which can successfully extract data from many log files, reports and HTML files in which the data placement is
not fixed.

Using the Floating Trap to Capture Lines

To familiarize ourselves with the floating trap, let's open the above report and create a floating trap to capture the
date/time fields it contains.

Click in the line selection area to highlight the first detail line in the report and then select New Template >

-

14:

-

40
140
143
143
:43
143
143
144
145
14

Trap Line ~

-0400]

-0400]
-0400)

"GET

"GET
"GET
-0400] "GET
-0400]
-0400]
-0400]
-0400]
-0400]

-0400)

"GET
"GET
"GET
"GET
"GET
"GET

-‘E) Reset Trap Line

55 Reset Fields Edit Field

J/ HTTBE/1.0"™ 200 5810 "wysiwyg://navbar.

/ HITB/1.0" 200 5810 "wysiwyg://navbar.d
/images/pin.gif HTTBE/1.0" 200 231 "http
Jimages/BannerLogo.gif HTTE/1.0" 200 24
Jimages/current.gif HTTE/1.0" 200 12682
Jimg/xdot.gif HTTB/1.0" 200 43 "http://
/images/find.gif HTTP/1.0" 200 1221 "ht
/images/newdiscuss.gif HITE/1.0" 200 89
/images/spot.gif HTTP/1.0" 200 1241 "ht
Jsearch/index.html HTTE/1.0" 200 98& "h

1:14:45 -0400] "GET /express/search l.htm HITP/1.1" 304 - "-"
1:14:51 -0400] "GET /express/125x30_snpcom.gif HTTE/1.1" 304

1:14:4%9 -0400]

"GET /img/anim thumbtack.gif HTTP/1.1" 304 - "

& -0400] "GET Iexpress!searcth.htm HTTE/1.0" 200 3821 "-" "M
2 -0400] "GET !img!anim_thumbtack.gif HTTE/1.0™ 200 &514 "htt

"GET /robot

s.txt HTTE/1.0™ 404 204 "-" "Slurp/2.0-

STEPS:
1. Open the Weblog.prn report and select the first line.
2. Select Report Design IET, to launch the Report Design interface.
3.
Detail. From the Trap Type drop-down, select Floating Trap.
Template Editor
|F|::|ating Trap V| A N R O 0 -
Delete Field
kzvl—30ppp187.epix.net - - [23/Rug/2010:01
»|ezvl-30pppl87.epix.net - - [23/Aug/2010:01
®»ezvl-30pppl87.epix.net - - [23/Aug/2010:01
®»|ezvl-30ppple7.epix.net - - [23/Rug/2010:01
®|lezvl-30pppl87.epix.net - - [23/Rug/2010:01
®»|lezvl-30pppl87.epix.net - - [23/Rug/2010:01
»|2zvl-30ppple7.epix.net - - [23/Aug/2010:01
®»|2zvl-30ppplE7.epix.net - - [23/Aug/2010:01
®»|ezvl-30pppl87.epix.net - - [23/Aug/2010:01
®lezvl-30pppl87.epix.net - - [23/RAug/2010:01:
» RCE55931.ipt.aol.com - - [23/Bug/2010:0
» BC855931.ipt.aol.com — - [23/Aug/2010:0
»RCB55931.ipt.aol.com — - [23/Aug/2010:0
»|202.112.36.196 - - [23/Aug/2010:01:18:1
®202.112.36.196 - - [23/Aug/2010:01:18:2
®|y400.inktoni.com - — [23/RAug/2010:01:159:41 -0400]
Figure 8-19. Highlighting the first detail line in the report.
4.

In the Trap line, enter a left bracket directly above the left bracket in the Sample Text line, as in the following

figure.
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Template Editor ~

|F|:Jating Trap <A N R O | & - « - Trap Line v -‘E) Reset Trap Line 55 Reset Fields Edit Field
Delete Field
1

ezvl-30pppl87.epix.net - - [23/Aug/2010:01:13:40 -0400] "GET / HITBE/1.0" 200 5810 "wysiwyg://navbar.l
»|ezvl-30ppplaT7.epix.net - - [23/Aug/2010:01:13:40 -0400] "GET / HTTP/1.0" 200 5810 "wysiwyg://navbar./s
»|ezvl-30pppl8T7.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images,/pin.gif HTTE/1.0"™ 200 231 "http
»|ezvl-30pppl8T7.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images/BannerLogo.gif HTTE/1.0™ 200 24
»|ezvl-30pppl8T7.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images/current.gif HTTE/1.0" 200 1262
»|ezvl-30ppplaT7.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /img/xdot.gif HTTE/1.0" 200 43 "http://|
»|ezvl-30pppl87.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images,/find.gif HTTP/1.0" 200 1221 "ht
»|ezvl-30pppla7.epix.net - - [23/Aug/2010:01:13:44 -0400] "GET /images,/newdiscuss.gif HTTE/1.0™ 200 89
»|ezvl-30pppl87.epix.net - - [23/Aug/2010:01:13:45 -0400] "GET /images,/spot.gif HTTP/1.0" 200 1241 "ht
»|ezvl-30pppl87.epix.net - - [23/Aug/2010:01:14:14 -0400] "GET /szearch/index.html HTTPE/1.0" 200 996 "h
»ACB55931.ipt.aocl.com - - [23/Aug/2010:01:14:45 -0400] "GET /empress/search 1.htm HTTBE/1.1" 304 - "7
»ACA55931.ipt.aocl.com - - [23/Aug/2010:01:14:51 -0400] "GET /empress/125x30_ snpcom.gif HTTE/1.1" 304
»ACR55931.ipt.aol.com - - [23/Aug/2010:01:14:49 -0400] "GET fimg!anim_thumbtack.gif HTTE/1.1" 304 - 7|
»202.112.36.196 - - [23/Aug/2010:01:18:16 -0400] "GET fexpress,-’search_l.htm HTTE/1.0" 200 3821 "-7 "M
»202.112.36.196 - - [23/Aug/2010:01:18:22 -0400] "GET fimgfanim_thumbt.ack.gif HTTE/1.0™ 200 6514 "htt
®|y400.inktomi.com — - [23/Aug/2010:01:19:41 -0400] "GET /robot=.txt HTTE/1.0" 404 204 "-" "Slurp/2.0

Figure 8-20. Entering a left bracket in the Trap box.

In the Sample Text line, highlight the date/time field.

Scroll down through the report. Notice that all of the date/time fields are now highlighted, indicating that they will
be successfully captured.

The floating trap works by looking across the lines to find the trap characters horizontally, rather than vertically,
as in a standard trap. The trap then uses the characters to decide when fields can possibly start and finish. The
field we have chosen to trap has a fixed width, but we will explore fields that have variable widths later in the
lesson. In this example, we have only defined that the field should begin after the bracket character; we could
also define a close bracket to dictate where the field ends.

Template Editor v

|FloatingTrap V| A N B o a8 - « - Trap Line ~ -5 Reset Trap Line 55 Reset Fields :=j'EditFieId
5% Delete Field
[

ezvl-30pppl87.epix.net — — [PRIECLIEIIUELEEEED -0400] "GET / HTTE/1.0" 200 5810 "wysiwyg://navbar.[§
2 |ezwl-30pppl87.epix.net - — [23/2ug/2010:01:13:40 -0400] "GET / HTTP/1.0" 200 5810 "wysiwyg://navbar./a
2 |ezvl-30pppl87.epix.net - — [23/Bug/2010:01:13:43 -0400] "GET /images/pin.gif HTITPES1.0" 200 231 "httpg
®|ezvl-30pppl87.epix.net - — [23/Bug/2010:01:13:43 -0400] "GET /images/BannerLogo.gif HTTE/1.0" 200 24
®»|lezvl-30pppl87.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images/current.gif HTTE/1.0" 200 1262
®»|lezvl-30pppl87.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /img/xdot.gif HTTE/1.0" 200 43 "http://
®»|lezvl-30pppl87.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images/find.gif HTTE/1.0" 200 1221 "ht
»|ezvl-30pppl8T7.epix.net - — [23/RAug/2010:01:13:44 -0400] "GET /images/newdiscuss.gif HTTE/1.0" 200 B9
»|jezvl-30pppl87.epix.net - — [23/RAug/2010:01:13:45 -0400] "GET /images/spot.gif HTTE/1.0" 200 1241 "ht
»|ezvl-30ppple87.epix.net - — [23/Aug/2010:01:14:14 -0400] "GET /search/index.html HITE/1.0™ 200 996 "h
*ACE55931.ipt.acl.com - - [23/Aug/2010:01:14:45 -0400] "GET /express/search_l.htm HTTE/1.1" 304 - "-"
#ACE55931.ipt.aocl.com - - [23/Aug/2010:01:14:51 -0400] "GET /express/125x30_snpcom.gif HITE/1.1" 304
*»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:49 -0400] "GET /img/anim thumbtack.gif HITP/1.1" 304 - "
»202.112.36.196 - - [23/RAug/2010:01:18:16 -0400] "GET fexpress/search_1l.htm HTTPF/1.0" 200 3821 "-" "M
»|202.112.36.196 - - [23/RAug/2010:01:18:22 -0400] "GET /img/anim thumbtack.gif HITP/1.0" 200 &514 "htt
®y400.inktomi.com - - [23/Aug/2010:01:19:41 -0400] "GET /robots.txt HTITE/1.0" 404 204 "-" "Slurp/2.0-

Figure 8-21. Previewing the template again. Note that all of the date/time fields are now highlighted.

In the Name field of the Field Properties panel, enter Date/Time to name the field and then click the v button
that appears below the field.

On the Template Editor, replace Detail in the Template Name field with Date/Time to name the template, and
then click the Accept v button. Monarch closes the Template Editor and returns to Report view.

Select the Table tab to view the Date/Time information in Table view. Scroll downward and note that all 916
date/time fields within the report have been successfully extracted.
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Fle ~ Home  Report  Table  Summary  Export ?

7 SelectAll | iter e o R ~ 8 8
‘Q Zoom To Fit [E] Coy R Show Field F

Table 1] Copy o Search  Goto  Findin Rebuild el et

Z=E ¥4 Autosize Columns Gy s Data View
Home  Repontvien  [[NUNTINESY v
Tables 2 DatefTime 5
i O 8 Tmgznio 2423
Main 890 23/Aug/2010:12:42:28

891 23/Aug/2010:12:44:41
892 23/Aug/2010:12:45:53
893 23/Aug/2010:12:48:58
894 23/Aug/2010:12:40:36
895 23/Aug/2010:12:49:
896 23/Aug/2010:12:40:37
897 23/Aug/2010:12:49:51
898 23/Aug/2010:12:54:16

899 23/Aug/2010:12:54:17
900 23/Aug/2010:12:54:18
01 23/Aug/2010:13:03:38
902 | 23/Aug/2010:13:03:38
903 23/Aug/2010:13:03:38
S04 23/Aug/2010:13:03:38
905 23/Aug/2010:13:03:39
906 | 23/Aug/2010:13:03:37
907 | 23/Aug/2010:13:03:41
908 | 23/Aug/2010:13:03:41
909 23/Aug/2010:13:04:11
910 23/Aug/2010:13:04:12
911 23/Aug/2010:13:03:36
912 23/Aug/2010:13:04:50
913 | 23/Aug/2010:13:
914 | 23/Aug/2010:13:10:

913 23/Aug/2010:13:10:44

916 | 23/Aug/2010:13:10:47 -
e »

Dste/Time - Character - Detsil [Date/Time) Filter: Mo Filter Sort NoSort  916Rows  100% — ——#—— +

Figure 8-22. Viewing the Date/Time table (scrolled to the bottom).

Now that we’ve seen how the floating trap can define lines where the trap character appears, let's explore
another one of its capabilities.

Using the Floating Trap to Define Fields

In addition to defining lines that contain the trap character, the floating trap can be used to define the width of variable
length fields. If we return to our Weblog.prn report, we can see how this works.

STEPS:

1. Select the Report tab and then click Report Design E’ to launch the Template Editor.

We now want to extract the data from the first field, which has a variable width. In order to do this, we can use a
trap character to tell Monarch where the field begins and ends. Since this field is left justified, we only need to be
concerned with where the field ends.

2. Position the cursor in the Trap line after .net, click the Blank Trap 8 button and then highlight the text in the
sample line as in Figure 8-23.

Template Editor ~

Floating Trap | A 0 R O g - « - Trap Line v -5 Reset Trap Line 55 Reset Fields S# Edit Field S Delete Field
B

[

- - (B ECCIELECEERFEREY —0400] "GET / HTTP/1.0" 200 5810 "wysiwyg://navbar.outef]
»|ezvl-30pppleT7.epix.net - - [23/RAug/2010:01:13:40 -0400] "GET / HITE/1.0" 200 5810 "wysiwyg://navbar.outels
#|ezvl-30pppleT7.epix.net - - [23/RAug/2010:01:13:43 -0400] "GET /images/pin.gif HTTE/1.0" 200 231 "http://w
#»|ezvl-30pppleT7.epix.net - - [23/RAug/2010:01:13:43 -0400] "GET /images/BannerlLogo.gif HTTE/1.0" 200 2401 "
#|ezvl-30pppleT7.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /images/current.gif HTTE/1.0"™ 200 1262 "htt]
#»|ezvl-30pppleT7.epix.net - - [23/Aug/2010:01:13:43 -0400] "GET /img/xdot.gif HTTE/1.0" 200 43 "http://www.
#ezvl-30pppl87.epix.net - - [23/Rug/2010:01:13:43 -0400] "GET /images/find.gif HTTE/1.0" 200 1221 "http:/|
#»|ezvl-30pppleT7.epix.net - - [23/RAug/2010:01:13:44 -0400] "GET /images/newdiscuss.gif HTTE/1.0" 200 £93 "h
#|ezvl-30pppleT7.epix.net - - [23/Aug/2010:01:13:45 -0400] "GET /images/spot.gif HTTE/1.0" 200 1241 "http:/
#|ezvl-30pppleT7.epix.net - - [23/RAug/2010:01:14:14 -0400] "GET /search/index.html HTTE/1.0" 200 956 "http:
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:45 -0400] "GET /express/search_ l.htm HTTP/1.1" 304 - "-" "Mo
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:51 -0400] "GET /express/125x30_snpcom.gif HTTE/1.1" 304 - "h
» ACB55931.ipt.aol.com - - [23/Aug/2010:01:14:49 -0400] "GET /img/anim thumbtack.gif HTTE/1.1" 304 - "http
»(202.112.36.196 - - [23/Aug/2010:01:18:16 -0400] "GET fexpressfsearch_l.htn: HTITP/1.0"™ 200 3821 "-" "Mozille

Figure 8-23. Floating Trap with the blank trap added.
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Note the results in the Report view portion of the window.

Template Editor ~

Floating Trap «| A 0 R O g - « - Trapline -5 Reset Trap Line 5 Reset Fields S Edit Field S Delete Field

& [

- - TR ECEERFERED -0400] "GET / HTTP/1.0" 200 5810 "wysiwyg://navbar.cutef]
» |ezvl-30pppl87.epix.net - - [23/RAug/2010:01:13:45 -0400] "GET /images/spot.gif HTTE/1.0" 200 1241 "http:/[&
#|ezgvl-30pppleT7.epix.net - - [23/Rug/2010:01:14:14 -0400] "GET /search/index.html HTTP/1.0" 200 996 "http:
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:45 -0400] "GET /express/search l.htm HTTE/1.1" 304 - "-" "Mo
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:51 -0400] "GET /express/125x30_snpcom.gif HTTP/1.1" 304 - "h
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:49 -0400] "GET fimgﬁanim_thumbtack.gif HTTE/1.1™ 304 - "http
»(202.112.36.196 - - [23/Rug/2010:01:18:16 -0400] "GET fexpressfsearch_l.htm HTTE/1.0™ 200 3821 "-" "Mozil
»(202.112.36.196 - - [23/Rug/2010:01:18:22 -0400] "GET fimgfanim_thumbtack.gif HTTE/1.0™ 200 6514 "http://
»|y400.inktoni.com - - [23/Aug/2010:01:19:41 -0400] "GET /robots.txt HTTP/1.0™ 404 204 "-" "Slurp/2.0-Kite
»|y400.inktoni.com - - [23/Aug/2010:01:19:42 -0400] "GET / HTTP/1.0" 200 5810 "-" "Slurp/2.0-KiteHourly (s
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/Rug/2010:01:25:26 -0400] "GET / HTITE/1.0" 200 |
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/R2ug/2010:01:25:29 -0400] "GET /main.css HITE/1
» PPPa28-Resale_Vancouver_ Bc2-2R1238.saturn.bbn.com - - [23/Aug/2010:01:25:35 -0400] "GET /images/BannerLo
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/2ug/2010:01:25:36 -0400] "GET /images/pin.gif
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/2ug/2010:01:25:36 -0400] "GET /images/current.

» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/2ug/2010:01:25:36 -0400] "GET /img/xdot.gif HT
» PPPa28-Resale Vancouver Bc2-2R1238.=saturn.bbn.com - - [23/2ug/2010:01:25:36 -0400] "GET /images/find.gif|Q

B T R S T S T R, R B I R S S B -0 LS SO U T

Figure 8-24. Floating trap with variable width fields.

As you can see, the fields have been highlighted and the highlighting has shrunk to accommodate any field
shorter than the fields we originally selected. There are some longer fields, however (e.g., “PPPa28-
Resale_Vancouver"), in which the field is wider than the highlighting. This would result in an incomplete
extraction of data. To rectify this, we need to manually specify the length of this field.

3. Click the newly defined field eg_ezvl-30ppp187_epix_net in the Sample Text box and then select Edit Field to
display its general properties in the Field Properties window.

4. Click the Template tab.
On the Template Width field in Field Properties, enter 60 and then click enter.

6. Press Accept v (on the Ribbon) to accept the sizes then view the result.

Note that all of the data is now trapped correctly.

Template Editor ~

EfiR oo 8 - < » Taplinev [ ResetTrapline T ResetFields S EditField Ix Delete Field

& [

- - [EEVECTTELEUEREEEREY -0400] "GET / HTTP/1.0" 200 5810 "wysiwyg://navbar.cutefl
#|ezvl-30pppleT7.epix.net - - [23/RAug/2010:01:13:45 -0400] "GET /images/spot.gif HTTE/1.0" 200 1241 "http://&
®|lezvl-30pppl87.epix.net - - [23/Aug/2010:01:14:14 -0400] "GET /=earch/index.html HTTE/1.0" 200 99§ "http:
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:45 -0400] "GET /express/search l.htm HTTP/1.1" 304 - "-" "Mo
»AC855931.ipt.aol.com - - [23/Aug/2010:01:14:51 -0400] "GET /express/125x30_ snpcom.gif HITE/1.1" 304 - "h
»|AC855931.ipt.aol.com - - [23/Aug/2010:01:14:49 -0400] "GET fimgfanim_thumbtack.gif HITE/1.1" 304 - "http
»(202.112.36.196 - - [23/Aug/2010:01:18:16 -0400] "GET fexpressfsearch_l.htm HTTE/1.0™ 200 3821 "-" "Mozil
»(202.112.36.196 - - [23/Aug/2010:01:18:22 -0400] "GET /img/anim thumbtack.gif HTTBE/1.0" 200 6514 "http://
®»|y400.inktomi.com - - [23/Aug/2010:01:19:41 -0400] "GET /Iobots?txt HTTE/1.0" 404 204 "-" "Slurp/2.0-Kite
»|y400.inktomi.com - - [23/Aug/2010:01:19:42 -0400] "GET / HTITP/1.0" 200 5810 "-" "Slurp/2.0-KiteHourly (s!
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/Rug/2010:01:25:26 -0400] "GET / HTTE/1.0" 200
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/Rug/2010:01:25:29 -0400] "GET /main.css HTTE/1
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/Rug/2010:01:25:35 -0400] "GET /images/BannerLo
» PPPa28-Resale Vancouver Bec2-2R1238.saturn.bbn.com - - [23/Aug/2010:01:25:36 -0400] "GET /images/pin.gif
3PPPa23—Resale:VancouveI:Bc2—2R1233.satuIn.bbn.com - - [23/Aug/2010:01:25:36 -0400] "GET /images/current.

» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/Rug/2010:01:25:36 -0400] "GET /img/xdot.gif HT
» PPPa28-Resale Vancouver Bc2-2R1238.saturn.bbn.com - - [23/2ug/2010:01:25:36 -0400] "GET /images/find.gif|Q

B S T T S = S, R R—— P - S S - R 1=r L S SR PR

3

Figure 8-25. Viewing the finished floating trap.

-
7. Select the Accept v button to return to the Report view and then select File > Close All |rr. to reset the
Monarch session. Select No when prompted to save changes to the model.
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USING MULTI-COLUMN REGION TRAPS

When working with Monarch, you may occasionally encounter a report that has a layout similar to that of a
newspaper, i.e., one with multiple, adjacent columns of data on each page. For example, the following report contains
a list of composers, numbered 1 through 90, and the list is broken into three columns, each containing thirty names.

05/01/10 CLASSICAL MUSIC DISTRIBUICRS PAGE 01
10:17 ANNUAL SUMMARY
MSES4 MOST PCPULAR CCOMPCSERS BY CUSTCMER

CUSTCMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
Usx

ACCOUNT NUMBER: 11887

CONTACT: Betty Yoder

PACHELBEL, J. 1 MOZRERT, W.A 31 WEELEKES, T. 6l
GRIEG, E. 2 GERSHWIN, G. 32 GINASTERZ, R, 62
HOLST, G. 3 CHOPIN, F. 33 BRIDGE, F. 63
CEFF, C. 4 MUSSCRGSKY, M. 34 BYRD, W. 64
SCHUMANN, R. 5 RACHMANINCV, 5. 35 SWEELINCE, J.P 65
LISZT, F. 6 BRIZN, H. 36 MACHRUT, G.d 66
BACH, J.5 7 SCR, F. 37 LUZZASCHI, L. a7
PAGANINI, H. & RHEINBERGER, J.G 38 DES PREZ, J. 68
HANDEL, G.F 9 ANGELD, G. 39 BIBER, H.I 3]
BERLICZ, H. 10 EMESCO, G. 40 BRITTIEN, BE. 70
SAINT-SRENS, C. 11 MCMPCU, F. 41 DAVIES, P.M 71
SHOSTAKOVICH, D. 12 ISRRC, H. 42 BAVEL, M. 72
RIMSKEY-KCORSAKOV, N. 13 HINDEMITH, P. 43 ADRMS, J. 73
BEETHOVEN, L.v 14 SCLER, P.2 44 JANEQUIN, C. 74
BEERNSTEIN, L. 15 CARULLI, F. 45 RRMERU, J.F 75
TCHAIKOVSEY, P.I 1& SCELSI, G. 46 VERDI, G. T8
WAGNER, R. 17 SESSICNS, E. 47 BOCCHERINI, L. 77
BELHMS, J. 12 PENDERECKI, K. 48 JOPLIN, S. 78
DWCRRE, A. 1% NCHNO, L. 49 HARRISON, L. 78

Figure 8-26. Viewing areport with multiple columns.

To handle such reports, Monarch includes a Multi-column region (MCR) trapping feature which you can use to trap
the data in multiple columns via only one template.

Extracting data via the MCR trapping feature consists of three simple steps. First, you define the multi-column region
via the Multi-Column Region Definition window, then you create a template to extract the desired data from the report,
and finally you specify the vertical boundaries (i.e., beginning and ending points) for the columns.

Let's open a multi-column report and extract data from it via the MCR trapping feature.
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STEPS:

1. Open the Composers.prn report.

05/01/10 CLASSICAL MUSIC DISTRIBUTORS BRAGE 01
10:17 ANNUAL SUMMARY
MSES4 MOST FOPULAR CCMPCSERS BY CUSTOMER

CUSTCMER: Betty's Music Store
Muscatine Flaza
200 Lower Muscatine
Cedar Falls, I& 50613
Usa

RCCOUNT NUMBER: 11887

CONTACT: Betty Yoder

PACHELBEL, J. 1 MOZART, W.A 31 WEELKES, T. 61
GRIEG, E. Z GERSHWIN, G. 3Z GINASTERA, A. 8z
HOLST, G. 3 CHCPIN, F. 33 BRIDGE, F. 63
CEFF, C. 4 MUSSORGSEY, M. 34 BYRD, W. 64
SCHUMANN, ER. 5 RACHMANINOW, 5. 35 SWEELINCE, J.P 65
LISZT, F. & BRIAN, H. 36 MACHAUT, G.d 6&
BACH, J.5 T S5CR, F. 37 LUZEZASCHI, L. a7
PAGANINI, H. & RHEINBERGER, J.G 38 DES PREZ, J. 6t
HANDEL, G.F 8 ANGELO, G. 3% BIBER, H.I L]
BERLICZ, H. 10 ENESCO, G. 40 BRITTEN, B. T0
SARINT-SAENS, C. 11 MCMPOU, F. 41 DAVIES, FP.M T1
SHOSTRAKOVICH, D. 1z ISRRC, H. 4Z RAVEL, M. TZ
RIMSKY-HORSAKOV, H. 13 HINDEMITH, P. 43 RDEMS, J. T3
BEETHOVEN, L.w 14 SCLER, P.A 44 JANEQUIN, C. T4
BERNSTEIN, L. 15 CARULLI, F. 45 RAMEAU, J.F 75
TCHAIKCOVSEY, P.I 16 SCELSI, G. 46 VERDI, G. Ta
WAGHNER, E. 17 SESSICNS, R. 47 BOCCHERINI, L. 77
BRALHMS, J. 18 PENDERECKI, K. 48 JOPLIN, S. 78
DVORLE, 4. 13 NOHO, L. 49 HARRISCH, L. 7e

Figure 8-27. The multi-column Composers report.

This report contains the same list of composers we saw a moment ago. Composers.prn lists the names of ninety
composers, arranged in three columns of thirty names, and ranked in order of popularity (1 = most popular, 90 =
least popular) for each customer.

Now that our multi-column report is open, let’s define the multi-column region.

2. Select the first line of the report, select Report Design E’ from the Report ribbon, and then click Multi-Column
Region W on the Report Design interface.
The Multi-Column Region (MCR) Definition window displays.

3. Select Enable MCR to activate the window.
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CONTACT: Betty Yoder
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GRIEG, E. 2 GERSHWIN, G. 32 GINASTERA, A. 62
HOLST, G. 3 CHOPIN, F. 3% BRIDGE, F. &3
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SCHUMANN, R. 5 RACHMANINOV, 5. 35 SWEELINCE, J.P 85
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HANDEL, G.F 9 ANGELO, G. 39 BIBER, H.I €9
BERLIOZ, H. 10 ENESCO, G. 40 BRITTEN, B. 70
SAINI-SAENS, C. 11 MCMPOU, F. 41 DAVIES, P.M 71
SHOSTAKOVICH, D. 12 ISAAC, H. 42 RAVEL, M. 72
RIMSKY-KORSRKOV, H. 13 HINDEMITH, P. 43 RDRMS, J. 73
BEETHOVEN, L.v 14 SOLER, P.A 44 JANEQUIN, C. T4
BERNSTEIN, L. 15 CARULLI, F. 45 RAMERU, J.P 75
TCHAIKOVSKY, P.I 1§ SCELSI, G. 46 VERDI, G. TE
WAGNER, R. 17 SESSICNS, R. 47 BOCCHERINI, L. 77
BRRHMS, J. 18 PENDERECKI,; K. 48 JOPLIN, 5. 3
DVORRK, &. 13 NONC, L. 49 HARRISON, L. 79 ad
1 ]

Pagel 100% ——H——+

Figure 8-28. The Multi-Column Region Definition window with a checked Multi-Column Region is active box.

A series of red, vertical broken lines — or column indicators — appears over the report to indicate where the
columns currently are.

Now we need to examine the report to determine the number of columns we want the multi-column region to
contain. This number should obviously equal the number of columns in the report which, in this case, is three.

4. Enter 3 in the Number of Columns box.

The number of columns you specified determines the number of column indicators that appear. Since we entered
3 in the Number of Columns box, three column indicators have appeared, as displayed in Figure 8-29.
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14 SCLER, P.A 44 JANEQUIN, C. T4
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TCHATKOVSKY, P.I 16 SCELSI, G. 46 VERDI, G. 76
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4 3

Pagel 100 ——f— +

Figure 8-29. Viewing the column indicators.

Next, we need to specify a left margin for the leftmost column, i.e., specify the position where we want the
leftmost column to begin. Since the text in the leftmost column begins at the left edge of the report, the current
setting of 1 is the one we want, so we can leave it as is.

NOTE If the text in the leftmost column began one space in from the left edge of the report, then
we would enter 2 in the Left Position of First Column box. If the text began two spaces in
from the edge of the report, we would enter 3 and so on.

Now we need to adjust the width of the column indicators to match the width of the data columns in the report.
5. In the Width of Each Column box, adjust the value until you obtain the correct width. For this report it is 29.

The column indicators move to the left to reflect the change to the column width. Note that all three columns of
composer names and ranking numbers now fall within the column indicators (scroll down to see this, if
necessary).
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WAGNER, R. 17 SESSICNS, R. 47 BOCCHERINI, L. 77
BRAHMS, J. 1% PENDERECKI, K. 48 JOPLIN, S. 78
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Page1 100% ———F— +

Figure 8-30. Viewing the column indicators in the Report view.

6. Click Accept v to accept the current MCR settings and close the window.

The Report Design displays with the column indicators still displayed on the report.

Template Editor

05/01/10

10:17

MSR94 M
CUSTCMER: Betty's Music Store

Muscatine Plaza
200 Lower Muscatine

Cedar Falls, IR 508

TSR
ACCOUNT WUMBER: 11887
CONTACT: Betty Yodexr
PARCHELBEL, J. 1
GRIEG, E. 2
HOLST, G. 3
CREF, C. 4
SCHUMAZNN, R 5
LISIT, F &
BACH, J.85 T
PAGANINI, H. 8
HAWNDEL, G.F ]
BERLIOZ, H. 10
SRINT-SRENS, C. 11
SHOSTAKCOVICH, D. iz
RIMSKY-KORSAKOV, N. 13

BEETHCVEN, L.v

CLASSICAL MUSIC DISTRIEBUTORS
ANNUAL SUMMARY
OST POPULAR COMPOSERS BY CUST

BERNSTEIN, L.

13
MOZRRT, W.A 31
CERSHWIN, G. 32
CHOPIN, F. 33
MUSSORGSKY, M. 34
RACHMANINGV, S. 35
BRIZN, H. 36
SOR, F. 37
RHEINBERGER, J.G 38
RNGELO, G. 39
ENESCO, G. 40
MOMPOU, F. 41
TSmAC, H. 42
HINDEMITH, P. 43
SOLER, P.R 44
CARULLI, F. 45

OMER

WEELKES, T.
GINASTERL, &.
ERIDGE, F.
EYRD, W.
SWEELINCK, J.P
MACHAUT, G.d
LUZZASCHI, L.
DES PREZ, J.
BIBER, H.I
BRITTEN, B.
DRVIES, P.M
RAVEL, M.
BDREMS, J.
JENEQUTN, C.
REMERT, J.P

PAGE 01

Figure 8-31. Viewing the column indicators in the Report view.

Now that we have determined the necessary number of columns, and have specified their width and the starting
position of the leftmost column, we're ready to define a template to extract the data.
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Creating a Template to Trap Multi-Column Data

The process of trapping data in a multi-column region report is the same as that for any other report. The first step is
to select a template sample.

STEPS:

1. Ensuring that you are in the Report Design interface, click on the line selection area to select the top line of
composer names (i.e., the one beginning with PACHELBEL, J.), select the drop-down button for New Template,
and then select Detail. Ensure that the Trap Type is set to Standard Trap.

Note that the Multicolumn Design Mode button is selected in the Template Editor.

Your screen should look as in Figure 8-32.

Template Editor ~

Standard Trap A R R @ g - + =+ Trap Line » [Multicolumn Design Mode -'5 Reset Trap Line FD Reset Fields Edit Field
Delete Field

[PLCHELEEL, J. 1

*(05/01/10 CLASSICAL MUSIC DISTRIBUIORS: PAGE 01 -
»110:17 ANNUAL SUMMARY
» MSR94 MOST POPULRR COMPOSERS BY CUSTOMER

»
»

® |CUSTOMER: Betty's Music Store
Muscatine Plaza

200 Lower Muscatine
Cedar Falls, IA 50613
USSR

MCCOUNT WUMBER: 11887

¥ WM M ¥ ¥ Y NN

CONTIACT: Betty Yoder

»

= PACHELEEL, J. 1 MOZART, W.A 31 WEELKES, T. &1

= |GRIEG, E. 2 GERSHWIN, G. 32 GINASTERA, A. 62

* HOLST, G. 3 CHCOPIN, F. 33 BRIDGE, F. &3

®|ORFF, C. 4 MUSSORGSKY, M. 34 BYRD, W. 64

» SCHUMANN, R. 5 RACHMAWNINOWV, 5. 35 SWEELINCE, J.P 65

»|LISZT, F. 6 BRIAN, H. 36 MACHRUT, G.d &8

® BACH, J.5 7 SCR, F. 37 LUZZASCHI, L. a7

® PLGANINI, N. & RHEINBERGER, J.G 38 DE5 PREZ, J. 68

®» HANDEL, G.F 9 BRNGELC, G. 395 BIBER, H.I 69 o
10 FNESCN An BRDITTEMN B e 11

® BERITIOT M
a4

Figure 8-32. Selecting the top line of composers.

2. In the Trap line, place the cursor above the “P” of Pachelbel in the Sample Text line, then click the Alpha Trap

button.

3. Inthe Trap Line, place the cursor above the “1” in the Sample Text line, then click the Numeric trap button.
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Template Editor ~

Standard Trap «| A B B ® | & - <« =+ Tapline v Multicolumn Design Mode| [ Reset Trap Line 55 Reset Fields Edit Field
% Delete Field
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o5/01/10 CLASSICAL MUSIC DISTRIBUTCRS: PAGE 01

10:17 BNNUZL SUMMARY
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CUSTCMER: Betty's Music Storel
Muscatine FPlaza
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Usa

ACCOUNT NUMBER: 11887

CONTACT: Betty Yoder

#» PACHELBEL, J. 1 MCOZART, W.R 31 WEELKES, T. 61
*GRIEG, E. 2 GERSHWIN, G. 32 GINASTERA, A. 62
* HOLST, G. 3 CHOPIN, F. 33 BRIDGE, F. 63
*|ORFF, C. 4 MUSSORGSKY, M. 34 BYRD, W. 64
*|SCHUMANN, R. 5 RACHMANINOV, S. 35 SWEELINCK, J.P 65
*LISZT, F. & BRIAN, H. 36 MACHAUT, G.d 66
*BACH, J.5 7 SOR, F. 37 LUZZASCHI, L. &7
» PAGANINI, N. & RHEINBERGER, J.G 38 DES PREZ, J. 68
* HANDEL, G.F 9 ANGELO, G. 39 BIBER, H.I 69
=

Figure 8-33. Viewing the results of the non-blank and numeric traps.

4. In the Sample Text line, highlight the composer name and then highlight the number 1.

NOTE When highlighting the composer’'s name, extend the highlight well beyond the end of the
name, as some of the composers’ names are longer than the one in the Sample Text line.
Likewise, when highlighting the number “1”, be sure to begin the highlight at least one space
before the number, as the numbers extend into the double digits. See Figure 8-34 for an
example of how you should highlight the fields.

Template Editor s
Standard Trap «|A B B © | & - « + TrapLline v Multicolumn Design Mode [ Reset Trap Line 50 Reset Fields S¢ Edit Field

SR Delete Field

& g
]
os5/01/10 CLASSICAL MUSIC DISIRIBUICRS! PAGE 01
10:17 ANNUAL SUMMARY
SR94 OST POPULAR COMPCSERS BY CUSTOMER

CUSTCMER: Betty's Music Store
Muscatine Flaza
200 Lower Muscatine;
Cedar Falls, IR 50&13
ush

BCCOUNT NUMBER: 11887

CONTACT: Betty Yoder

* PACHELBEL, J. 1 MOZART, W.A 31 WEELKES, T. 61
*|GRIEG, E. 2 GERSHWIN, G. 32 GINASTERA, A. 62
= HOLST, G. 3 CHOPIN, F. 33 BRIDGE, F. 63
= ORFF, C. 4 MUSSORGSKY, M. 34 BYRD, W. 64
*|SCHUMANN, R. 5 RACHMANINCV, S. 35 SWEELINCEKE, J.P 65
= LISZT, F. 6 BRIAN, H. 36 MACHRUT, G.d 66
=BACH, J.5 7 SCR, F. 37 LUZZASCHI, L. 67
= PAGANINI, N. 8 RHEINBERGER, J.G 38 DES PREZ, J. 68
= HANDEL, G.F 8 ANGELC, G. 39 BIBER, H.I 69
=

Figure 8-34. Highlighting the fields.
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10.
11.

Select the number 1 in the Sample Text box to display its general properties in the Field Properties panel.

Type Rank in the Name field and then click the v button that appears below the field.

Select the text PACHELBEL, J in the Sample Text box to display its general properties in the Field Properties
panel.

Rename this field Composers and then click v to accept your field name definition.

Click Accept v to save your template definitions.

05/01/10 CLASSICAL MUSIC DISTRIEBUIORS BAGE 01 -
10:17 BNNUAL SUMMARY
MSR54 MOST PCPULAR CCOMPCSERS BY CUSTOMER

CUSTCMER: Betty's Music Store!
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
TSR

ACCOUNT NUMBER: 11887

CCHTACT: Betty Yoder

* PACHELBEL, J. 1 MOZART, W.AR 31 WEELKES, T. 61
* GRIEG, E. 2 GERSHWIN, G. 32 GINASTERZ, A 62
= HOLST, G. 3 CHOPIN, F. 33 BRIDGE, F. 63
* ORFF, C. 4 MUSSORGSKY, M. 34 BYRD, W. 64
» SCHUMANN, R. 5 RACHMANWINOV, S. 35 SWEELINCK, J.F 65
*LISZT, F. 6 BRIAN, H. 36 MACHRUT, G.d 66
= BACH, J.5 7 SOR, F. 37 LUZZASCHI, L. 67
» PAGANINI, N. & RHEINBERGER, J.G 38 DES PREZ, J. 68
* HANDEL, G.F 9 ANGELC, G. 3% BIBER, H.I 63
» BERLIOZ, H. 10 ENWESCO, G. 40 BRITTEN, B. 70
* SATNT-SAENS, C. 11 MCMPCU, F. 41 DAVIES, P.M 71
= SHOSTAKOVICH, D. 12 ISARC, H. 42 RRVEL, M. 72
* RIMSKY-KCRSAKOV, N. 13 HINDEMITH, P. 43 RADREMS, J. 73
= BEETHOVEN, L.V 14 SOLER, P.R 44 JRNEQUIN, C. 74
= BERNSTEIN, L. 15 CARULLI, F. 45 RAMERU, J.P 75
* TCHAIKOVSKY, P.I 16 SCELSI, G. 46 NERDI, G. 76
* WAGNER, R. 17 SESSIONS, R. 47 BOCCHERINI, L. 77
* BRAHMS, J. 18 PENDERECKI, K. 48 JOPLIN, 5. 78 -

1 »

Figure 8-35. Viewing the results of the Composers template in the Report view.

Now let’s create an append template to extract the contact data from the report. This template will also help us
specify our vertical boundaries for the MCR, which we will discuss in the next lesson.

Select Report Design E, to activate the Report Design interface.

Click in the line selection area to highlight the first contact line (i.e., the line containing CUSTOMER: Betty’s
Music Store), select the drop-down button for New Template, and then select Append. Ensure that the Trap
Type is set to Standard Trap.

Altair Monarch 2024.1 Learning Guide 212



Template Editor ~

Standard Trap <A N R O | & - + =+ Trap Line » Multicolumn Design Mode L‘{.J Reset Trap Line 55 Reset Fields Edit Field
% Delete Field

|cUSTOMER: Betty's Music Store a

»[05/01/10 CLASSICAL MUSIC DISTRIBUTICRS: BAGE 01

*10:17 ANNUAL SUMMARY

= MSRS4 MOST POPULAR COMPOSERS BY CUSTOMER

=

=

* CUSTOMER: Betty's Music Store

= Muscatine Plaza

b 200 Lower Muscatine

® Cedar Falls, IA 50613

» Usa

»

»

* ACCOUNT NUMBER: 11887

»

2 |CONTACT: Betty Yoder

=

=

» PRCHELBEL, J. 1 MOZRRT, W.RE 31 WEELKES, T. 61
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Figure 8-36. Selecting the template sample.

12. To create the trap, type customer in the Trap line above “CUSTOMER” in the sample line and then highlight
Betty’s Music Store in the sample line. Be sure to extend the highlight well beyond the end of the last name, as
in Figure 8-37.

Template Editor ~

Standard Trap v|A N R O® | &8 - « + Trap Line v Multicolumn Design Mode :6 Reset Trap Line 50 Reset Fields S Edit Field
S Delete Field

|cu5t,crner
[eiilif: Pl e cty' = Music Store a
05/01/10 CLASSICEL MUSIC DISTRIBUTCRS! BAGE 01

10:17 RNNURL SUMMRRY
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Figure 8-37. Highlighting the Contact field.

13. Rename the field eg_Betty’s Music Store to Contact in the Field Properties panel and then click the v button
to accept your changes.

14. Rename the template Contact and then click the Accept v button to accept your changes. You are returned
to Report view and fields corresponding to the Contact template you have just defined are highlighted.

If we wanted to, we could now create additional append templates to capture more information from the report,
such as “CUSTOMER” and “ACCOUNT NUMBER” fields. Instead, let's move on and learn how to specify vertical
boundaries for the MCR.

Altair Monarch 2024.1 Learning Guide 213



NOTE As an example of a model file that contains additional append templates, Monarch includes
a Composers.xmod file in the Monarch Models folder.

Specifying Vertical Boundaries for the MCR

So far, we have configured the column indicators to the correct width and have created a detail template that extracts
the composer’'s names and rank numbers from the report. We also created a Contact append template, which will be
helpful to us when specifying vertical boundaries for the multi-column region.

NOTE When we specify vertical boundaries for the MCR, we must specify the top and bottom
boundaries for the columns within it.

STEPS:

1. Select Report Design El to activate the Report Design interface.

2. Onthe Report Design ribbon, select Multi-Column Region W to display the Multi-Column Region Definition
window.

3. Select the Start after > Template radio button option and then ensure that Contact is selected from the
Template drop-down list. A horizontal broken line appears at the top of the composer columns, just below the
“CONTACT” line. This line indicates the top boundary of the multi-column region. Everything above this line will
be excluded from the MCR.

Design
Startafter: () Top of page 2
’ ® W Number of columns: S ® Template |Contact - !
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* SHOSTAKOVICH, D. 12 ISAAC, H. 42 RAVEL, M. 7z
» RIMSKY-KORSAKOV, N. 13 HINDEMITH, P. 43 RDAMS, J. 3
» BEETHOVEN, L.v 14 SCLER, B.A 44 JANEQUIN, C. T4
» BERNSTEIN, L. 15 CARULLI, F. 45 RRMERU, J.P 75
* TCHAIKOVSKY, P.I 16 SCELSI, G. 46 VERDI, G. 76
» WAGHER, R. 17 SESSIONS, R. 47 BOCCHERINI, L. 77
» BRRHMS, J. 18 PENDERECKI, K. 48 JOPLIN, 5. 78
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Ll v
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Figure 8-38. Viewing the top boundary of the MCR (just below the CONTACT line).
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4. Scroll down through the report to locate the bottom boundary of the multi-column region.

Note that the current bottom boundary setting for the MCR is Stop at > Bottom of page. Notice that the bottom
boundary of the MCR occurs just after the end of the columns on Page 1 and before the beginning of Page 2, as
specified by the current bottom boundary setting. This boundary will suit our purposes as is, so we don’t need to
adjust it.

Design

Startafter. () Top of page )

" x W Number of columns: 3 - ®) Template |Contact = 0

Accept  Cancel |Enable (SO e ToXEE T | Stopat @ Bottom of page Help

MCR Width of each column: 2 3 Template | Detail * | or bottom of page
Columns (horizontal) Boundaries (vertical) ~

[SIBELIUS, J. 20 MUFFAT, G. 50 MARCELLO, A. 80 2
»ELGAR, E. 21 LOTTI, &. 51 XINLCCH, W. 81
» MAHLER, G. 22 PARTCH, H. 52 THOMSON, V. 82
»|STRAVINSKY, I. 23 FALLA, M.d 53 CILEA, F. 83
> DEBUSSY, C. 24 PUCCINI, G. 54 KODALY, Z. 84
» STRAUSS, J.I 25 WILDER, A. 55 REGER, M. g5
» VIVALDI, A. 26 VAINBERG, M. 56 HEBDEN, J. 86
> MENDELSSCHN, F. 27 FAURE, G. 57 PHILIPS, P. 87
> BARTOK, B. 28 GESUALDO, D.C 58 MUNDY, W. &8
> VAUGHAN WILLIAMS, R. 29 BRYARS, G. 59 LOCKE, M. 83
> HAYDN, F.J 30 HOIBY, L. 60 SCHUTZ, H. 20

osjoi/ig T CIASSICAL MUSIC DISTRIBUTOGRS =7 PAGE 02

10:17 ANNUAL SUMMARY

MSR94 MOST POPULAR COMPOSERS BY CUSTOMER

> CUSTOMER: Big Shanty Music
3658 Springs Ferry
Suite C-130
Marietta, GA 30067
usa

ACCCOUNT NUMBER: 17859

CONTACT: Marvin Mabry

» DEBUSSY, C. 1 MAHLER, G. 31 ZELENEA, J.D 61
®[LISZT, F. 2 HAYDN, F.J 32 D'INDY, V. 62
= BARTOK, B. 3 BRAHMS, J. 33 MACQUE, G.D 63
* STRAVINSKY, I. 4 PAGANINI, N. 34 SCRIABIN, A. 64
» VAUGHAN WILLIAMS, R. 5 SIBELIUS, J. 35 HEBENSTREIT, P. 65
» RACHMANTHCV, 5. 6 HARTMANN, K.A 36 JOPLIN, 5. 66
* SHOSTAKOVICH, D. 7 ROUSSEL, A. 37 PARRY, C.H 67 |
4 3

Page1 100 ——F— +

Figure 8-39. Viewing the bottom boundary of the MCR.

Now that you've seen how helpful templates can be when specifying the top and bottom boundary settings of the
MCR, keep this in mind, as you can create blank traps solely for this purpose.

5. Click Accept v twice, once to save the current MCR settings and then a second time save the current
template settings.
Monarch redisplays the Report view.
Let’'s view the trapped data in Table view.

6. Select the Table tab to display the extracted data in Table view.

7. Select Autosize Columns "#* to view all of the fields properly.

Monarch displays the extracted data in the Table view.
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Home  Report View m v

Composers Rank Contact :
N ) 1 Befty's Music Store
Main 2  GRIEG, E 2 Befty's Music Store

3 HOLST, G. 3 Betty's Music Store
4  ORFF, C. 4 Befty's Music Store
5 SCHUMANN, R. 5 Betty's Music Store
6  LISZT, F. 6 Betty's Music Store
7 BACH, 1S 7 Betty's Music Store
8 PAGANINL, N. 8 Betty's Music Store
g9 HANDEL, G.F 9 Betty's Music Store
10 BERLIOZ, H. 10 Betty's Music Store
11  SAINT-SAENS, C. 11 Betty's Music Store
12 SHOSTAKOVICH, D. 12 Betty's Music Store
13 RIMSKY-KORSAKOV, N. 13 Betty's Music Store
14  BEETHOVEN, Lv 14 Betty's Music Store
15 BERNSTEIN, L. 15 Betty's Music Store
16  TCHAIKOVSKY, P.I 16 Betty's Music Store
17  WAGNER, R. 17 Betty's Music Store
18 BRAHMS, 1. 18 Betty's Music Store
19 DVORAK, A. 19 Betty's Music Store
20 SIBELIUS, 1. 20 Betty's Music Store
21  ELGAR, E. 21 Betty's Music Store
22 MAHLER, G. 22 Betty's Music Store
23 STRAVINSKY, 1. 23 Betty's Music Store
24 DEBUSSY, C. 24 Betty's Music Store
25 STRAUSS, 1.I 25 Betty's Music Store
26 VIVALDI, A 26 Betty's Music Store
27  MENDELSSOHN, F. 27 Betty's Music Store
28 BARTOK, B. 28 Betty's Music Store
29 VAUGHAN WILLIAMS, R. 29 Beftty's Music Store
30 HAYDN, FJ 30 Betty's Music Store -

‘ »

Figure 8-40. Viewing the extracted data in the Table view (column widths adjusted to show column names).

At this point, you can either save your work or close the report and model.

USING REGULAR EXPRESSION TRAPS

Recall that earlier in Chapter 8, we attempted to trap the Ship Date line but also picked up unwanted data, i.e., the
Return Authorization and Received fields. We rectified this issue by creating an exact trap. We then showed how we
can avoid this issue by using an exclusion trap. We could also have created a regular expression trap. Regular
expression traps allow sophisticated Monarch users a high level of flexibility when creating templates because this
type of trap automatically considers variable spaces between fields of interest. Thus, this trap can be very useful
when field positions change on a page or when field positions change with respect to other fields.

All of the traps we have described thus far may be translated into a regular expression trap, and the first step of
creating such a trap involves selecting a line with fields we want to trap. Similar to all of the previous traps/templates
we created, a detail trap must be created before append, header, or footer traps.

Let's trap the Customer line of Classic.prn using a regular expression trap.

STEPS:

1. Open Classic.prn and Lessonl.dmod.

2. Select Report Design, choose the line containing the text CUSTOMER as the sample text, and then select New
Template > Append.

Rename this template as Customer.
From the Trap Type drop-down, select Regular Expression Trap.

Select Ignore Case from the Options drop-down that displays on the Action toolbar when the regular expression
trap type is selected.

6. In the trap line, type in the following: customer:\s*(?<customer>[A-Z].¥)

The trap we have just created instructs Monarch to look for a line marked “customer:” ignoring case and with any
number of spaces following it and then select all of the text following this marker provided that the first character
of the text to be captured begins with any character from A to Z.
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Template Editor ~

|Regu|ar Expression Trap '| Options ¥ <« —+ Trap Line ~ :5 Reset Trap Line £ Reset Fields Edit Field Z=x Delete Field
| customer:\s*(?<customer>[A-Z].*))

|cUusToMER: Betty's Music Store [ ]
[‘:5!01;‘10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01

10:17 MONTHLY SHIFPING REFPORT
SR94 FRCM 04/01/10 TC 04/30/10

COSTOMER: Betty's Music Store
Muscatine Plaza
200 Lower Muscatine
Cedar Falls, IA 50613
Ush

WCCOUNT NUMBER: 11887

CCHTACT: Betty Yoder

Figure 8-41. Creating a Regular Expression trap.

Note that Betty’s Music Store is highlighted as though we have selected it as a field.

7. Right-click on Betty’s Music Store in the sample text line and select Create a field from this capture >
customer.

The Customer field is created

Template Editor v

Reset Fislds Edit Field § Delete Field

3

|Regu|ar Expression Trap ~| Options » < =  Trap Line « :5 Reset Trap Line

| customer:\s*( ?<customer>[A-Z].*)

(sifaelin: Pl et ty's Music Store [ ]
05/01/10 CLASSICAL MUSIC DISTRIBUTORS PAGE 01

10:17 MONTHLY SHIPPING REPORT

SR94 FROM 04/01/10 TO 04/30/10

*» COSTOMER: Betty's Music Store
Muscatine Plaza

200 Lower Muscatine
Cedar Falls, IA 50613
Usn

ACCOUNT NUMBER: 11887

CCONTACT: Betty Yoder

Data Preview
customer Report Date Page Order... Ship Date Account Number Contact Media  Quantity Descript

1 Betty's Music Store 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder 4 Bartok, &

2 Betty's Music Store 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder 7 Mozart,

3 Betty's Music Store 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder 2 Luening

4 Betty's Music Store 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder DVD 9 Scarlatti

5 Betty's Music Store 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder co 11 Beethov

6 Betty's Music Store 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder g Mendels

7 Betty's Music Store 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder 10 Pizzetti,

& Betty's Music Store 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder LP 6 Misc., M
X0 ]

Figure 8-42. Data preview of the newly created Customer field.

Note that regardless of the length of the customer name, the field is always captured correctly.
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Template Editor

Regular Expression Trap | Options~ « - Trap Line v :5 Reset Trap Line 55 Reset Fields Edit Field 5% Delete Field

| customer:\s*(?<customer>[A-Z].*)

[l PRt ty's Music Store| [ |
05/01/10 CLASSICAL MUSIC DISTRIBUTORS BAGE 08

10:17 MONTHLY SHIPPING REPORT

MSR94 FROM 04/01/10 TO 04/30/10

*(CUSTCMER: Die Melodie
Einkaufszentrum am Petrus
General-Schwarz-Strabe 23
31005 Bremen

Germany

(RCCOUNT NUMBER: 13487

Data Preview
customer Report Date  Page Ship Date Account Number Contact

33 Musique du Monde 5/1/2010 04 536034 4/18/2010 18635 Alain Lebon 4 Ricd, Cr
34  Musique du Monde 5/1/2010 04 526034 4/18/2010 18635 Alain Lebon 4 Selmay
35 Fandangos Records 5/1/2010 05 536045 4/28/2010 17658 Lionel Sampson cD 6 Kodaly,
36 Fandangos Records 5/1/2010 05 536045 4/28/2010 17658 Lionel Sampson 10 Gibbons,
37 Fandangos Records 5/1/2010 05 536045 4/28/2010 17658 Lionel Sampson 11 Dvorak,
38 Fandangos Records 5/1/2010 05 526045 4/28/2010 17658 Lionel Sampson 3 Elgar, Tl
39 Fandangos Records 5/1/2010 05 336045 4/28/2010 17658 Lionel Sampson DVD 2 Handel,
40 Die Melodie 5/1/2010 06 536028 4/14/2010 13487 Thomas Kurze co 6 Syberg,
41 Die Melodie 5/1/2010 06 536028 4/14/2010 13487 Thomas Kurze 1
‘\ Min Maladi [ -FEWLT:E N ne CREND _AliAlndn 0 b e - —r

Figure 8-43. The customer name “Die Melodie” is captured correctly even though we did not specify how large the

field length should be.

USING EXCLUSION TRAPS

Monarch offers a solution for instances where you may wish to exclude specific lines from being picked up by a

previously defined template. To address this issue, you can create an exclusion template.

STEPS:

1.

Open the Classic.prn report and go to page 4.

Note that this page includes details for a return authorization as well as the received date.

CRDER NUMBER: 536012 SHIF DATE: 04/01/10
CcD 10 Milhaud, 3 Rag Caprices, pn. & orch. Z-656%9 S.60 86.00
5 Strauss, Le bourgeois gentilhomme CDD 448 9.80 48.00
& Scriabin, Preludesz, Cp. 8 CY 1123 7.78 38.45
& Rogers, Slaughter on Tenth Avenue CDD 275 9.60 57.60
BLU 10 Paganini, 24 Caprices for wviolin. BLU 120 9.59 85.90
DVD 8 WViwvaldi, Concertos for Recorder ABTD-115& 5.88 47.82
RETURN AUTHCRIZATICN: RAGO0Z1 RECEIVED: 04/10/10
CD -10 Linek, Epiphany Carol SUP 10 4154 5.8%9 (59.30)
-7 Casella, Paganiniana, NBC 50 &5 510 9.00 (63.00)
oDWVD -11 Lambert, 2Zirs de Courm (16839) HMA 431123 5.89 (65.89)
CRDER NUMBER: 536034 SHIP DATE: 04/18/10
cD 3 Huggett, Suite for Accordian & Pn. MVCD 1056 9.59 28.77
S Peterson, Quartet No. 1 for Strings I-T121-2 4.7%9 43,11
1

Figure 8-44. Page 4 of the Classic.prn report includes Return Authorization entries.
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If we were to trap the order numbers using an exact trap (e.g., a colon), the return authorization will also be
picked up. When we trapped the order number line in a previous exercise, we used an exact trap and specified
that all order numbers beginning with 5 must be captured. But what happens when the order number begins with
a 3 or a4? Let’s use an exclusion template to address this issue.

2. Click on the line containing the return authorization entry and then select Report Design.
Select New Template > Exclusion. Ensure that the Trap Type is set to Standard Trap.

4. On the trap line, click on the position right above the first letter of the word “Return” and then type in return. Note
the change to the report shown below.

Template Editor ~

|Standard Trap V| AW RO | 8 - « —+ Trap Line ~ -'5 Reset Trap Line
return
RETU1RN AUTHORIZATICN: RA6021 RECEIVED: 04/10/10
5 Scriabin, Preludes, Cp. 8 CY 1123 T7.7%8 38.95 -
& Rogers, Slaughter on Tenth Avenue CDD 275 9.60 57.60
BLO 10 Paganini, 24 Caprices for wviolin. BLU 120 9.5% 85.90
DVD 8 WViwvaldi, Concertos for Recorder ABTD-1156 5.599 47.82
*®
cD -10 Linek, Epiphany Carol SUP 10 4154 5.99 (59.80)
-7 Casella, Paganiniana, NBC 50 AS 510 g5.00 (63.00)
DVD -11 Lambert, Airs de Courm (1689) HME 431123 5.89 (65.89)
CRDER NUMBER: 536034 SHIP DATE: 04/18/10

Figure 8-45. Excluding Return Authorization entries with an exclusion trap.

5. Select Accept.

The template we have just defined instructs Monarch to not pick up data from lines marked with “return” at
position 7. In Report view, the Return Authorization line is marked as follows:

* CRDER NUMBER: 536012 SHIP DATE: 04/01/10
> |CD 10 Milhaud, 2 Rag Caprices, pn. & orch. Z-6569 .80 896.00
= 5 Strauss, Le bourgeois gentilhomme CDD 448 9.60 48 .00
» 5 Scriabin, Preludes, Op. 8 CY 1123 7.7% 38.95
» 6 PRogers, Slaughter on Tenth Avenue CDD 275 9.680 57.60
* BLU 10 Paganini, 24 Caprices for wiolin. BLU 120 Zic EE] 95 .50
= DVD 8 WViwvaldi, Concertos for Recorder ABTD-1154 EoZis) 47.52
BETURN AUTHORIZATION: RAGDZ1 RECEIVED: 04/10/10
= CD -10 Linek, Epiphany Carol SUP 10 4154 Bl (5%.590)
®» -7 Casella, Paganiniana, NBC SO AS 510 .00 {62.00)
» DVD -11 Lambert, Airs de Courm (1&89) HMZ 431123 5.99 (65.89)
» CRDER NUMBER: 536034 SHIP DATE: 04/1B/10
*CD 3 Huggett, Suite for Accordian & Pn. MVCD 1056 Zio EE] 28.77
» 8§ Peterson, Quartet No. 1 for Strings 3-7121-2 4.79 43.11
# 4 Ricci, Crispino e la Comare GR 2085 14.38 57.52
» 4 Selma y Salaverde, Canzoni NE 7041 8.59 35.5948

Figure 8-46. Report view showing markings of an exclusion template.

You can now trap the Order Number line using a semi-colon if you wish.
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USING START AND END REGION TRAPS

A Start Region trap identifies a line in a report where all other types of trapping (e.g., detail traps, append traps)
should begin. Correspondingly, an End Region trap identifies a line in a report where other types of trapping should
end. These trap features may be used in combination to specify a section (or similar sections) of a report containing
data that should be further trapped.

Start/End Region traps generally make use of exact-match traps to specify at which line of a report trapping should
begin/end. Only one Start and one End Region trap may be created in a model/project.

NOTE Start and End Region traps are not generally used to specify sections that should not be
trapped. In this case, exclusion traps should be used.

In the following example, we'll create start and end traps spanning the first 10 entries of a patient report and then
extract the patient name and service code from these entries.

STEPS:

1. Open the report file Patient.prn.

2. In Report Design view, choose the line in the report beginning with “Michael Canton” as the sample text and then
select Start Region from the New Template drop-down.

3. Create the trap shown below.

Template Editor v

|StandardTrap V| AR RO | 8 - < =+ Trap Line ~ -‘E) Reset Trap Line
michael cantoﬂ
Hichael Canton A0028 Son had Funny Bone Surgery
* -
®
*
e
*
x
*
* Michael Canton a00zs8 S5on had Funny Bone Surgery
RR 1 Box 22 and Minor attitude problem
Elmberry MC 63343 BILL: 1838.39
Charles Bergan Co543 Came to pay bill &
8501 Moody Park got =ick
Cwver Park K5 66212 BILL: 7985.12

Figure 8-47. Establishing a Start Region trap.

Note that guillemets mark the first instance of “Michael” in the report and that all other lines before this one are
marked with an X.

Because the entry “Michael Eagan” in page 2 of this report, we can’t simply use the trap “Michael.” Otherwise,
data beginning from this line and continuing downward would also be captured.
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4. Click to the left of the line beginning with “St Louis MO” so that the line is selected and then choose End Region
from the New Template drop-down.

5. Create the trap shown below.

Template Editor v

|Stam:|ardTrap '| AN RO | B8 - « » Trapline v ¥y Reset Trap Line
ISt Loui.3|
|5t Louis MO &311s BILL: 2400.07 [ ]
Fairmont WV 26554 BILL: 92.00
Loui=z Mc Nally cCo440 Daughter has stomach
PO Box 2893 full of Tootsie Rolls
Bramwell WV 24715 BILL: 238.80
Furt Grady AD179 Dog was hysteriecal
Rt 1 Box 241
Sparrows VA 24124 BILL: 176.00
Leo Masterson A0187 Tests for chest hair
8 Hickory Trail
Thomaz HNC 27360 BILL: 241.78
Richard Waite AD195 Family had two needs
3525 Halliday food & money
* |5t Louis MO 63118 BILL: 2400.07
*
X|CT
*
XE

Figure 8-48. Data preview of the newly created Customer field.

Note that guillemets appear to the left of the line marked “St Louis MO” and that all other lines after this one are
marked with an X.

6. Click on the first line of the report marked “Michael Canton” once more and then select Detail from the New
Template Region.

7. Create the trap shown below.

Template Editor v

|StandardTrap '| AR RO | B - « > Trapline v ¥y Reset Trap Line

£ Reset Fields =/ Edit Field

=% Delete Fisld

| REEEEER

II-Iichael Canton AOODZ2B Son had Funny Bone Surgery .
XL; ------------------------------------------------------------------------------
* Michael Canton AQ028 S5on had Funny Bone Surgery

RR 1 Box 22 and Minor attitude problem

Elmberry MC 63343 BILL: 1838.39
#|Charles Bergan C0543 Came to pay bill &

8501 Moody Park got =ick

COver Park K5 66212 BILL: 7855.12
#Eric Dryson ROD32 Hang nail extraction

119 Washington 5t

Cleveland CH 45215 BILL: 18z.00
#|Jim Handley AO048 Daughter had grape juice

R 2 Box 389 stain on upper lip

Figure 8-49. Trapping specific patient information.

8. Highlight the fields Michael Canton and A0028. Extend these fields to ensure that all of the names are correctly
captured.

9. Click Accept to finish trapping and then select the Table tab.
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The trapped data display as follows.

File Home  Report  Table  Summary  Export

g e e B ot B O
Row Report Data View

Design

¥4 Autosize Columns

Home  Report View m

Show Field Freeze
Contents. Panes ~

Tables q eg_Michael Canton eg_A0D28
0

il 1 [Michael Canton ] Aao2s

Main 2 Charles Bergan C0543
3 Eric Dryson ADO32
4 Jim Handley A0048
5 Marshall Briar ADD82
6  Henry Thornton ADO96
7  Louis Mc Nally C0440
8  Kurt Grady AD179
9 Leo Masterson AD187
10 Richard Waite AD195
11 Michael Canton AD0O28
12 Charles Bergan C0543
13 Eric Dryson ADO32
14 Jim Handley A0048
15 Marshall Briar ADD82
16 Henry Thornton AD096
17  Louis Mc Nally co
18 Kurt Grady AD179
19 Leo Masterson AD187
20 Richard Waite AD195

|eg_Michsel Canton - Character - Detail (Detail)

Filter: No Fifter Sort: No Sort

20 Rows.

b

tom —————+

Figure 8-50. The results of the present trapping operation.
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[9] WORKING IN TABLE VIEW

Since you've learned how to create several templates for and extract data from a report in the previous lesson, let's
see how you can work between the Report and Table views.

This lesson will show you the basics of navigating and working in the Table view. Later lessons describe how to use
Monarch’s built-in expressions to calculate new fields, create filters, and create sort definitions in the Table view.

When analyzing data in Table view, you may want to refer to the actual report to verify whether or not the captured
information is correct. You may also want to refer to the Table view, when in the Report view, to obtain a summary of
the information relevant to a specific record. The ability to switch between Report view and Table view with ease will
certainly benefit your working experience with Monarch.

To start, open the Classic.prn report and the Lessonl.dmod model.

GETTING TO KNOW TABLE VIEW

The Table View Interface

Let’s take a minute to explore what you can find in the Table view interface.

File Home Report Table Summary Export ?
74 Blseectan i pier ah i R ~ ‘8 H

“Q Zoom To Fit [0 Coy Show Field  Freeze
P=ED ¥t Autosize Columns o R Data View

Home  Reportview  [NOVENESY v
Page Order.. Ship Date Account Number Contact Media  Quantity Description Label Number ~ UnitPrice  Amount ~
[o0)
0

1 1 |01 536017 4/10/2010 11887 Befty Yoder 4 Bartok, Sonata for Selo Violin MK-42625 8.99 35.96
2 0 536017 4/10/2010 11887 Betty Yoder 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
Main 3 0 536017 4/10/2010 11887 Betty Yoder 2 Luening, Electronic Music CD 611 10.19 20.38
4 01 536017 4/10/2010 11887 Betty Yoder DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 5391
5 01 536039 4/21/2010 11887 Betty Yoder [e0) 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 65.89
6 01 536039 4/21/2010 11887 Betty Yoder 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92
7 0 536039 4/21/2010 11887 Betty Yoder 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90
8 01 536039 4/21/2010 11887 Betty Yoder L 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
9 0 536039 4/21/2010 11887 Betty Yoder DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
10 02 536016 4/5/2010 17959 Marvin Mabry ) 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 8.99 53.94
1 02 536016 4/5/2010 17959 Marvin Mabry 1 Schubert, Sonata in e, D.566 AS-325 9.00 9.00
12 02 536016 4/5/2010 17959 Marvin Mabry 3 Mozart, Symphony No.23 in D C0-77884 899 2607
13 02 536016 4/5/2010 17959 Marvin Mabry 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
14 02 536029 4/14/2010 17959 Marvin Mabry (0] 2 Shostakovich, 24 Preludes for piano. CDA 66620 5.39 10.78
15 02 536029 4/14/2010 17959 Marvin Mabry SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 86.31
16 02 536029 4/14/2010 17959 Marvin Mabry DVD 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.99 29.95
17 03 536020 4/10/2010 10929 Roberto Gil [e0) 3 Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 53.94
18 03 536020 4/10/2010 10929 Roberto Gil 3 Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80
19 03 536020 4/10/2010 10929 Roberto Gil 6 Messiaen, Quatour pour la fin de temps CDC 54935 9.60 57.60
20 03 536020 4/10/2010 10929 Roberto Gil SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99 71.92
21 03 536020 4/10/2010 10929 Roberto Gil DVD 9 Schumann, Manfred Overture, Bav SO SBT 48270 5.99 53.91
22 04 536012 4/1/2010 18635 Alain Lebon [o) 10 Milhaud, 3 Rag Caprices, pn. & orch. 7-6569 9.60 96,00
B M4 536012 4/1/2010 18635 Alzin Lebon S5 Strauss, Le bourgeois gentilhomme CDD 448 9.60 48.00
24 04 536012 4/1/2010 18635 Alain Lebon 5 Seriabin, Preludes, Op. 8 Cy 1123 7.79 38.95
25 04 536012 4/1/2010 18635 Alzin Lebon 6 Rogers, Slaughter on Tenth Avenue CDD 275 9.60 57.60
26 04 536012 4/1/2010 18635 Alain Lebon BLU 10 Paganini, 24 Caprices for violin. BLU 120 9.59 95.90
7 4 536012 4/1/2010 18635 Alain Lebon DvD 8 Vivaldi, Concertos for Recorder ABTD-1156 5.99 47.92
28 04 536012 4/1/2010 18635 Alain Lebon @ -10 Linek, Epiphany Carol SUP 10 4154 5.99 -59.90
29 M 536012 4/1/2010 18635 Alain Lebon -7 Casella, Paganiniana, NBC SO AS 510 9.00 -63.00
30 04 536012 4/1/2010 18635 Alain Lebon DVD -11 Lambert, Airs de Courm (1689) HMA 431123 599 -6589 ~
‘ »
Report Date - Date/Time - Page Hesder (Pags Headr) Filter- No Filtzr Sort:No Sort 149 Rows 100% — ———————+

Figure 9-1. An open table in Table view.

The Table interface is divided into three distinct areas. The Table ribbon is located on the top-most portion of the
interface and spans the entire width of the screen. This ribbon will allow you to perform many of the table functions
made available by Monarch. The Table Selector displays as a panel on the left-hand side of the interface, and the
actual table is displayed on the right-hand portion of the interface.

Right-clicking on the Table selector displays a context menu that will allow you to perform the following operations:

0 Perform a quick export - This export operation uses the default file extension and values specified in Export
Settings and presents the Create Export dialog with all elements prefilled
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Rebuild the table

Add an external lookup to a table
Print a table

Quick print a table

Preview a table before printing
View model information

View project information

View the model audit trail

I I 0 I I A N N

View the project audit trail

The Table View Ribbon

The following table summarizes the functions of each of the buttons in the Table ribbon.

Use this button...

@ Table Design
Tahoma = £ont Style
g« .

Font Size

‘Q' Zoom to Fit

¥z1 Autosize Columns

Select All
E:l Copy

d'b Search

Ne P T Active Filter

Mo Sort - .
Active Sort

biit Go to Row
@- Find in Report

~
&/ Rebuild Data View

“B show Field Contents

A Freeze Panes
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Launch the Table Design interface

Select a font style

Select a font size

Set the zoom level to fit all fields on screen

Resize columns in a table

Select all of the records in the table
Copy records in the table

Search for a specific record in the table
Select a filter to apply to the table
Select a sort to apply to the table

Locate a specific row or column in a table

Find the line in the report from which the value in a table
row was obtained

Recalculate the table. This can be useful if you use
external lookups and wish to check for the most current
data.

Show the contents of memo fields

Freeze specific columns and/or rows while scrolling
through a table
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The Table View Context Menu

Right-clicking on any column in Table view reveals a menu that will allow you to quickly do the following:
0O  Copy text (with/without headers) O Rename a field

Hide a field

Show hidden fields

Create a new calculated field

Copy with formatting (with/without headers)
Search for a specific record

Go to a specific row

Go to a specific column Apply afilter or sort
Find a specific record in a report Print the table
Autosize columns Launch print preview

Adjust column widths Export the table

O 00 000 Do
O 00 0O o000 o

Launch the Field Properties window Launch a specific tab of the Table Design view

GETTING TO KNOW TABLE DESIGN VIEW

The Table Design Interface

The Table Design interface allows you to actively work with your data to obtain the information you need using the
fields you extracted in a report. This interface initially shows you a list of all of the fields you extracted, as well as their
properties, and a ribbon from which you can select several tools to further build your data table.

Design
v % = P — T > 2 Y ¥ B A &
Accept  Cancel Add  Duplicate T External | Field Input  Formula  Lookup Runtime User Edit Filters  Sorts Address  Functions Help
- seeE Lookups | List Fields  Fields Fields  Parameter Fields Fields Blocks
~
Name Source Type Format Display Width | Decimals | Size | Alignment | Hidden | Table Verify Results
» Report Date Page Header Dste/Time Short Date 10 Left
2 Page Page Header Character General 4 Left
3 Order Number Order Number Level Numeric General 5 0 Right
4 Ship Date Order Number Level Date/Time Short Date 10 Left
5 Account Number Account Number Level Numeric General 14 0 Right
5 Contact Account Number Level Character General 19 Left
7 Media Line Item Detail Character General 5 Left
H Quantity Line Item Detail Numeric General 7 0 Right
9 Description Line Item Detail Character General 39 Left
10| Label Number Line Item Detail Character General 12 Left
1 Unit Price Line Item Detail Numeric General s 2 Right
12| Amount Line Item Detail Numeric General 7 2 Right
Show Template Properties Table Verify Move Up Move Down Print Save To CSV
o — T . R
Report Date Page Order... Ship Date Account Number Contact Media  Quantity Description Label Number ~ Unit Price  Amount -
1 [5/1/2010 |01 536017 4/10/2010 11887 Betty Yoder o] 4 Bartok, Sonata for Solo Violin MK-42625 899 3596
2 512010 01 536017 4/10/2010 11867 Betty Yoder 7 Mozart, Mass in C, K.427 420831-2 9.00  63.00
3 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder 2 Luening, Electronic Music CD 611 1019 2038
4 5/1/2010 01 536017 4/10/2010 11867 Betty Yoder DVD 9 Scarlatti, Stabat Mater SBT 48282 599 5381
5 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder [} 11 Beethoven, Pathetique Sonata, Arau 4201532 599 6589
6 5/1/2010 01 536039 4/21/2010 11867 Betty Yoder 8 Mendelssohn, War March of the Priests SMK 47592 899 7192
7 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder 10  Pizzetti, Messa di Requiem CHAN 8964 953 9500
8 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder LP 6 Misc., Modern Trombone Masterpieces ADA 581087 1079 6474 E
4 »
Report Date - Date/Time - Page Header (Page Header) Filter- No Filter Sort NoSort 100 Rows  100% — ——f———— +

Figure 9-2. The Table Design interface.

At the bottom of the Table Design interface is a Data Preview panel, which functions exactly like the Data Preview of
the Template Editor. This panel will show you how your Table view is going to look once changes made using the
Table Design interface have been applied.
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The Table Design Ribbon

The following table summarizes the functions of each of the buttons in the Table Design ribbon.

Use this button...

¥ Accept
x Cancel

Add

+

=

Duplicate

Delete

External Lookups

e

Field List

]l

Input Fields

Database fields

K0

Formula Fields

ﬁ Lookup Fields

ﬁ Runtime Parameter Fields
53 User Edit Fields

v Filters

l"- Sorts

= Address Blocks

ﬁ‘ Functions

= Help
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Accept the new template or changes to an existing
template

Cancel the new template or changes to an existing
template

Add a new field to the table. This table could be a
formula field, a lookup field, a runtime field, etc.

Duplicate the summary

Delete a selected field

Add an external lookup to the table
Display the field list

Display the properties of each input field

Display the properties of each database field. This
button only displays when a database table is opened.

Add a formula field to the table

Add a lookup field to the table

Add a runtime parameter field to the table
Add a user-edited field to the table

Add a filter definition to the table

Add a sort definition to the table

Extract data from addresses

Add a field function to the table

Launch the Help file
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NAVIGATING THROUGH A TABLE

Finding Information in a Table

While working with Monarch, you may need to locate information in Table view. You can easily do this if the report is
short enough using the scroll bars. Classic.prn, for example, spans only 149 rows, so you might opt to use the scroll
bar to search for information in this report. However, what if the report spans 1,376 lines? How would you search
these lines to locate a single record? Monarch presents an easy way to do this via the Search box, which may be
accessed by clicking Search on the Table ribbon.

The search options for Table view varies significantly from the search options for Report view in that the former
includes a search option for expressions.

| ‘ Find Next Search Up Wrap Match Case Expression Search X

Figure 9-3. The Search panel for Table view.

Since we already know how to do basic keyword searches, let's try searching through Table view using the
Expression Builder. Before we do so, ensure that the first field of the first column is selected, signaling the
beginning of the table.

STEPS:

1. In Table view, select Search d'b from the ribbon so that the Search box displays at the top of the table.
2. Check the box for Expression Search.

3. Let’s search for all records with amounts of greater than or equal to 100. In the search box, type in Amount
>=100 and then click Find Next.

Record 49 in Table view is highlighted. If you scroll all the way to the right of this record, you will see that it has a
total amount of 307.20. A quick look through all other amounts preceding Record 49 shows no other record with
an amount greater than or equal to 100.

Amount>=100 | Find Next Search Up Wrap Match Case +*| Expressicn Search X

. Account Number Order. Customer ShipDate  Media Quantity Desaiption Label Number  Unit Price  Amount -
42 13487 536028 Thomas Kurze 4/14/2010 P 4 Krebs, Chorale Preludes for Organ CHR 74565 5.99 23.96
43 13487 536042 Thomas Kurze 4/24/2010 CD 10 Schumann, Frauenliebe und leben CAS 10209 7.79 77.90
44 13487 536042 Thomas Kurze 4/24/2010 9 Hakim, Suite for Harpsichord CM 20016-16 9.59 86.31
45 13487 536042 Thomas Kurze 4/24/2010 9 Janacek, Jealousy Overture CHAN 9080 9.59 86.31
46 13487 536042 Thomas Kurze 4/24/2010 9 Seeger, Diaphonic Suite 999-116 7.79 70.11
47 13487 536042 Thomas Kurze 4/24/2010  SACD 9 Tippett, The Mask of Time for Qrch. 64111 9.59 86.31
48 10609 536027 Bill Saxman 4/14/2010 D 10 Krenek, Jonny spielt auf, V. St. Orch. 0OVC 8048 6.59 65.90
49 536027 Bill Saxman 4/14/2010 & Misc., The Art of Periman, Ttzhak, vn. 4-ZDMZ-64617 3840  307.20
50 10609 536027 Bill Saxman 4/14/2010  BLU 10 Barber, Adagio for Strings, NZSO KIC 7243 7.79 77.90
51 10609 536027 Bill Saxman 4/14/2010 DVD 5 Britten, War Requiem 2-DBTD 2032 11.98 59.90
52 10609 536031 Bill Saxman 4/15/2010 CD 8 Beethoven, 3rd Sym, Karajan, Berlin 419049-2 GGA 9.00 72.00
53 10609 536031 Bill Saxman 4/15/2010 4 Stravinsky, Pulcinella, Bernstein, NYPO MK-44709 8.99 35.96
54 10609 536031 Bill Saxman 4/15/2010 LP 9 Misc.,Modern Trombone Masterpieces ADA 581087 4.79 43.11
55) 12705 536018 Lidia Resado 4/10/2010 cD 2 Mozart, Symphony in D, K.202 CD-80186 6.59 13.18
36 12705 536018 Lidia Resado 4/10/2010 8 Ravel, Daphnis et Chloe 425997 5.99 47.92
57 12705 536025 Lidia Rosado 4/13/2010 D 2 Handel, Il pastor fido{opera) 2-HCD12912 10.78 21.56
58 12705 536025 Lidia Rosado 4/13/2010 2 Milhaud, Pastorale for Ob. & Bsn. CHAN 6536 9.59 19.18
59 12705 536025 Lidia Rosado 4/13/2010 9 Koday, Marosszek Dances 2-KPT 32153 9.58 86.22
60 12705 536025 Lidia Rosado 4/13/2010 9 Foss, Capricio for cello and piano KIC 7070 4.79 43.11

Figure 9-4. Record 49 is highlighted, signifying the first record for which the expression Amount >= 100 is true as a
search parameter.

4. Click Find Next once more.

This time, Record 78 is highlighted, signifying the second record with an Amount value greater than or equal to
100.

5. Close the Search box by clicking the Close X icon located to the right of the Search box.
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Displaying the Source of a Record

To locate the source of Record 28, we'll use the Find in Report @ button.

STEPS:

1. From the top of the table, scroll down until Row 28 is visible.

Notice that Record (Row) 28 has a value of —59.90 entered in the Amount column.

2. Inthe Table ribbon, select Find in Report Eﬁ

The Report view displays, showing the report for Record 28 in the table. The line from which the detail fields

were extracted is highlighted (see Figure 9-5).

» 6 Rogers, Slaughter on Tenth Avenus CDD 275 S.80

» BLO 10 Paganini, 24 Caprices for wiolin. BLO 120 9.59

= DVD 8 WViwaldi, Concertos for Recorder ABTD-115& Eio =)
RETURN AUTHCRIZATICH: RA6021 RECEIVED: 04/10/10

= |CD -10 Linek, Epiphany Carol SUP 10 4154 CICH

» —7 Casella, Paganiniana, HBC S0 AS 510 5.00

» VD -11 Lambert, Airs de Courm (1&689) HMZ 431123 GITieE

@ CRDER WNUMEBER: 536034 SHIF DATE: 04/18/10

= |CD 3 Huggett, Suite for Accordianm & Pn. MVCD 1056 2o 52

® % Peterson, Quartet HNo. 1 for Strings 3-7121-2 e T

i
85.

47.

(59.
(83,

(85.

60
80

9z

a0)
00)

8.77
3.11

Figure 9-5. The details for Record 28 in the Table view are located in the Report view.

NOTE

Using the Find in Table lf?d‘ Button

You can also locate the record number (table record) of any item within a report, along with
pertinent information regarding the item (the amount of information you can obtain depends
on the templates you've set up) from the Report view. To do so, click on the detail item of

interest in the Report view and then select Find in Table l:?l‘ from the Report ribbon. Table
view displays the record number, as well as other information, for the detail item.
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Changing Fonts and Font Sizes

As in Report view, Monarch allows you to change the font and font size used to display tables on screen.

STEPS:

1. To change the font, in the Table ribbon, click the drop-down " button on the Font Style box.

Sylfaen -~
Tahoma
Times New Roman |
Trebuchet MS |
Verdana

Yu Gothic

Yu Gothic Light

Yu Gothic Medium

Yu Gothic Ul

¥u Gothic Ul Light

Yu Gothic Ul Semibold

Yu Gothic Ul Semilight

R
T

Figure 9-6. Changing font styles.

2. Select the Trebuchet MS font from the list.

The font style is changed throughout the entire report.

You may also change font size in order to zoom in or zoom out on the table. Experiment with the font size until you
find the size you like best.

STEPS:

1. Click the drop-down '~ button on the Font Size box.

Tahoma Vlg |V|

@ Zoom To Fit 6

¥4 Autosize Columns

- . g

sort View Iagm 10
. 1
12
13

14

15

16

17

18

19

20

[T |

Figure 9-7. Changing font sizes.
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Font sizes vary depending on the font style selected. If the size you want isn’'t available, use the font list to select
another font.

2. To change the font size to match the table width to the display width, from the Table ribbon, select Autosize
Columns *:*.

This selects the font size that matches the table width to the display width so that you can view the entire width of
the table, or as much of it as possible, on screen.

If the table is too wide to fit on screen even at the smallest available font size, Monarch will select the smallest
font size to fit as much of the table width as possible in the available display area.

FORMATTING FIELDS

As we've seen, Monarch automatically formats the data as it builds the table. The column width is also set for each
field to display the widest field value. You can override these automatic assignments, and you can make several
other format adjustments, as discussed in the next few sections.

You will learn how to:
0 Fill empty cells

0O Adjust field widths
0 Move fields

0 Hide fields

For this lesson, ensure that Classic.prn and Lessonl.dmod are open in Monarch and that you are viewing the Table
interface.

Filling Empty Cells

Sometimes the report data includes “assumed dittos.” An example would be the Media column sample shown in
Figure 9-8.

Media Quantity Description Label Number Unit Price Amount
CD 4 Bartok, Sonata for Solo Vielin MK-42625 8.99 35.96
7 Mozart, Mass in C, K.427 420831-2 9.00 63.00

2 Luening, Electronic Music CD 611 10.19 20.38

DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 33.91
CcD 11  Beethoven, Pathetique Sonata, Arau 420153-2 5.99 65.80
8 Mendelssohn, War March of the Priests SMEK 47592 £8.99 71.92

10 Pizzetti, Messa di Requiem CHAN 8964 9,59 95.90

LP & Misc., Modern Trombone Masterpieces ADA 381087 10.79 64,74
DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
cD 6 Stravinsky, Dumbarton Ozks Concerto SMCD 5120 8.99 53.94

Figure 9-8. An assumed ditto in the Report view.

In this list, the media identifier “CD” obviously applies to the first three entries in the list, rather than just the first entry,
even though it is only shown explicitly in the first entry. When these entries appear in the table (Records 1-3 in Table
view), the “CD” is missing from the last two entries.

Monarch has an easy solution to this.
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STEPS:
1. In Table view, double-click on the Media field to display its properties via the Field Definition window.

2. Select the Template tab of the Field Definition window to display the template properties of the Media field.

3. Check the box for Empty Cells: Copy value from previous record and then click Accept v to close the Field
Definition window.

The table is rebuilt and Monarch fills in the blank cells in the Media field.

Account Number Order... Customer Ship Date Media | Quantity Description Label Number  Unit Price  Amount
1 536017 Betty Yoder 4/10/2010 | cD 4 Bartok, Sonata for Solo Violin MK-42625 839 3595
2 11887 536017 Betty Yoder 4/10/2010 cD 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
3 11887 536017 Betty Yoder 4/10/2010 | CD 2 Luening, Electronic Music CD 611 10.19 20.38
4 11887 536017 Befty Yoder 4/10/2010 DvVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
5 11887 536039 Betty Yoder 4/21/2010 | CD 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 65.89
1] 11887 536039 Betty Yoder 4/21/2010 | CD 8 Mendelssohn, War March of the Priests SMK 47592 B.99 71.92
7 11867 536039 Betty Yoder 4/21/2010 cD 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.50
8 11887 536039 Betty Yoder 4/21/2010 | LP 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
9 11887 536039 Betty Yoder 4/21/2010 | DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
10 17959 536016 Marvin Mabry 4/5/2010 cD 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 8.99 53.94
11 17959 536016 Marvin Mabry 4/5/2010 cD 1 Schubert, Sonata in e, D.566 AS-335 9.00 9.00
12 17959 536016 Marvin Mabry 4/5/2010 co 3 Mozart, Symphony No.23 in D CO-77884 8.99 26.97
13 17959 536016 Marvin Mabry 4/5/2010 D 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
14 17959 536029 Marvin Mabry 4/14/2010 | CD 2 Shostakovich, 24 Preludes for piano. CDA 66620 5.39 10.78
15 17959 536029 Marvin Mabry 4/14/2010 | SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 86.31
16 17959 536029 Marvin Mabry 4/14/2010 VD 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.99 20.95
17 10929 536020 Roberto Gil 4/10/2010 cD 3 Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 53.94
18 10929 536020 Roberto Gil 4/10/2010 cD 3 Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80
19 10929 536020 Roberto Gil 4/10/2010 | CD 6 Messiaen, Quatour pour la fin de temps CDC 54935 9.60 57.60
20 10929 536020 Roberto Gil 4/10/2010 SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99 71.92

Figure 9-9. Blank cells are no longer present in the field.

Adjusting Field Widths

When you view a table, the columns may sometimes not be wide enough to display the entire field name. When this
happens, the field name will appear truncated. In other instances, even when the field values are not truncated, the
columns may appear too close together.

Account Number| Order... |Customer Ship Date Media  Quantity] Description Label Number  Unit Price  Amount
1 11887| 536017 |Betty Yoder 4/10/2010 CcD 4l Bartok, Sonata for Solo Violin MK-42625 8.99 35.96
2 11887| 536017 |Betty Yoder 4/10/2010 co 7] Mozart, Mass in C, K.427 420831-2 9.00 63.00
3 11887| 536017 |Betty Yoder 4/10/2010 co 2| Luening, Electronic Music CD 611 10.19 20.38
4 11887| 536017 |Betty Yoder 4/10/2010 DVD 9| Scarlatti, Stabat Mater SBT 48282 5.99 53.01
5 11887| 536039 |Betty Yoder 4/21/2010 CD 11§ Beethoven, Pathetique Sonata, Arau [420153-2 5.99 65.89
G 11867| 536039 |Betty Yoder 4/(21/2010 cD 8 Mendelssohn, War March of the Pr... |SMK 47532 8.99 71.92
7 11887| 5360390 |Betty Yoder 4/21/2010 CcD 10| Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90
8 11887| 536039 |Betty Yoder 4/21/2010 LP 6| Misc., Modern Trombone Masterpi_. |ADA 581087 10.79 64.74
9 11887| 536039 |Betty Yoder 4/21/2010 DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
10 17959| 536016 |Marvin Mabry 4(5/2010 D 6| Stravinsky, Dumbarton Oaks Conc... |SMCD 5120 8.99 53.54
11 17958] 536016 |Marvin Mabry 4/5/2010 cD 1| Schubert, Sonata in e, D.566 AS-325 9.00 9.00
12 17959| 536016 |Marvin Mabry 4/5/2010 cD 3| Mozart, Symphony MNo.23in D CO-77884 8.99 26.97
13 17959| 536016 |Marvin Mabry 4/5/2010 cD 6| Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
14 17959| 536029 |Marvin Mabry 4/14/2010 CD 2| Shostakovich, 24 Preludes for piano. |CDA 66620 5.39 10.78
13 17959| 536029 |Marvin Mabry 4/14/2010 SACD 9| Balakirev,Symphony no. 1 ENTPD 4110 9.59 86.31
16 17959| 536029 |Marvin Mabry 4/14/2010 DVD 5| Holst, St. Paul's Suite for Orch. CBT-1020 5.99 29.95
17 10929| 536020 |Roberto Gil 4/10/2010 cD 3| Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 53.94
18 10929| 536020 |Roberto Gil 4(10/2010 cD 3| Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80

Figure 9-10. The widths of the fields Order Number and Description are too narrow.

In the figure above, for example, the field width for the Order Number column is so narrow that the field name is
truncated and the field width for the Description field is so narrow that the individual records (rows) are truncated.

You can resize field widths to properly display field names and records via four ways:
0 Using the Field Definitions window
In the Field Definition window, select the field whose width you want to increase and then increase the number

shown in the Display Width box in the General tab that displays. Select Accept v twice when you are done to
apply your changes.
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0 Using the mouse

Move the mouse pointer to the right edge of the relevant field title. The mouse pointer will become a resizing
handle, which you can drag left or right to resize the field.

0 Using the Autosize Columns *=* button

The use of this button resizes all fields to match the widest field value or the field name, whichever is wider.

If you reduce the width of a character field or a date field to less than the length of a field value, the field value is
truncated on screen. If you reduce the width of a numeric field to less than the width of a field value, the field
value is truncated as well.

0 Using the Column Widths functionality

Right-clicking on a field produces a menu from which you can choose “Column Widths” and then three other
options for resizing the width of a field.

You can either:
Set the column size to the width of the widest column label, or
Set the column size to the width of the widest data value, or

Set the column size to the width of a specific field

NOTE The column width setting affects only the appearance of the data on screen and in printed
output. It does not affect the underlying data.

Ordering Fields

Table fields may be ordered any way you wish by dragging and dropping a field or several fields into a new location in
the table or using the Move Up/Move Down buttons in Table Design view.

Hiding Fields

Frequently, you may want some data hidden from view but not deleted from the table.

NOTE Hidden table fields are not available for export and copy operations.

For example, the Report Date and Page fields contain useful information, but you may not want them visible while
working with data from the other fields. Let’s hide these fields. To do so:

STEPS:

1. In Table view, click anywhere on the Report date field.
2. Using your mouse, right-click and then select Hide from the context menu that displays.
The field is immediately hidden.
3. Repeat Steps 1 and 2 to hide the Page field. The selected fields are now hidden (see Figure 9-11).
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File Home Report Table Summary Export ?

Table S{Zecnlchy {81 Copy Actve Sort: Search  Goto  Findin Rebuild Shon feld  freeze
C=mm ¥t Autosize Columns Row  Report Data View
A
Home Report View m v
Tables ot v I Order... Ship Date Account Number Contact Media  Quantity Description Label Number ~ UnitPrice  Amount -
n fs) 1 536017 4/10/2010 11887 Betty Yoder @ 4 Bartok, Senata for Solo Violin MK-42625 8.99 35.96
2 536017 4/10/2010 11887 Betty Yoder (o)) 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
Main 3 536017 4/10/2010 11887 Betty Yoder @ 2 Luening, Electronic Music CD 611 10.19 20.38
4 536017 4/10/2010 11887 Betty Yoder DvD 9 Scarlatti, Stabat Mater SBT 48282 5.99 3391
5 536039 4/21/2010 11887 Betty Yoder @ 11 Beethoven, Pathetique Senata, Arau 4201532 5.99 65.89
6 536039 4/21/2010 11887 Betty Yoder @ 8 Mendelssohn, War March of the Priests SMK 47532 8.99 71.92
7 536039 4/21/2010 11887 Betty Yoder e} 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 95.90
8 536039 4/21/2010 11887 Betty Yoder LP 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 64.74
9 536039 4/21/2010 11887 Betty Yoder DvD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94
10 536016 4/5/2010 17959 Marvin Mabry @ 6 Stravinsky, Dumbarten Ozks Concerto SMCD 5120 8.99 53.94
11 536016 4/5/2010 17953 Marvin Mabry e} 1 Schubert, Sonata in e, D.566 AS-325 5.00 5.00
12 536016 4/5/2010 17959 Marvin Mabry @ 3 Mozart, Symphony Ne.23 in D CO-77884 8.99 26.97
13 536016 4/5/2010 17953 Marvin Mabry (] 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
14 536029 4/14/2010 17959 Marvin Mabry @ 2 Shostakevich, 24 Preludes for piano. CDA 66620 5.39 10.78
15 536029 4/14/2010 17953 Marvin Mabry SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 86.31
16 536029 4/14/2010 17959 Marvin Mabry DvD 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.99 28.95
17 536020 4/10/2010 10929 Roberto Gil (] 3 Faure, 28 Songs, Stulzmann RCA 61420-2 17.98 53.94
18 536020 4/10/2010 10929 Roberto Gil e} 3 Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80
19 536020 4/10/2010 10929 Roberto Gil (] 6 Messiaen, Quatour pour la fin de temps CDC 54935 9.60 57.60
20 536020 4/10/2010 10929 Roberto Gil SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99 71.92
21 536020 4/10/2010 10929 Roberto Gil DVD 9 Schumann, Manfred Overture, Bav SO SBT 48270 5.99 53.91
22 538012 4/1/2010 18635 Alain Lebon o) 10 Milhaud, 3 Rag Caprices, pn. & orch. 7-6560 9.60  96.00
23 536012 4/1/2010 18635 Alain Lebon (o] 5 Strauss, Le bourgeois gentilhomme CDD 448 9.60 48.00
24 536012 4/1/2010 18635 Alain Lebon (] 5 Scriabin, Preludes, Op. 8 Cy 1123 7.79 3895
25 536012 4/1/2010 18635 Alain Lebon (o] 6 Rogers, Slaughter on Tenth Avenue CDD 275 9.60 57.60
26 536012 4/1/2010 18635 Alain Lebon BLU 10 Paganini, 24 Caprices for violin. BLU 120 9.59 95.90
27 536012 4/1/2010 18635 Alain Lebon DvD 8 Vivaldi, Concertos for Recorder ABTD-1156 5.99 47.92
28 536012 4/1/2010 18635 Alain Lebon (] -10 Linek, Epiphany Carol SUP 10 4154 5.99 -59.90
29 536012 4/1/2010 18635 Alain Lebon (o] -7 Casella, Paganiniana, NBC SO AS 510 9.00 -63.00
30 536012 4/1/2010 18635 Alain Lebon DvD -11 Lambert, Airs de Courm (1689) HMA 431123 5.99 -65.89 -
‘ »
Repor: Date - Datw/Time - Page Header (Page Header] Filter: N Filier Sorc Mo Sort  149Rows  100% — ——f————+

Figure 9-11. The Report Date and Page fields are now hidden.

ASSIGNING FIELD TYPES

When Monarch builds a table, it automatically assigns a field type to each field based on the first instance of that field
in the report. If Monarch finds a number when it first extracts a field, for example, it assigns the numeric format.
Usually, the first instance of a field is representative of other instances; when it is not, however, you must manually
override the assigned format to assign the proper format.

You can set fields to have one of the following formats:
0 Character

0 Numeric

0 Date/Time

o Memo

When Monarch assigns an incorrect field format, you can change the setting to a more appropriate one using either
the Field Definition window or the Table Design interface.

0O  Using the Field Definitions window

Double-click on the field of interest in Table view. In the Field Definitions window that displays, select the
appropriate field type from the Type drop-down field in the General tab.

0 Using the Table Design view
On Table view, select Table Design L? Select the field whose format type you wish to change from the list that

displays and then click its corresponding cell under the column Type. A drop-down button displays to the right of
the cell. Use this drop-down to select a new field type.

At this point, you can either save your work or simply close the report and model you opened.
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CREATING HEADERS AND FOOTERS

Creating a Page Header

Monarch allows you to add a descriptive title to the top of each printed page via the Header Layout settings of the
Page Setup dialog.

A page header is divided into three sections, Left, Center, and Right, all of which represent locations in which you
may want to add information. You can dynamically add information to the page header, including page numbers, the
print date and time, the names of the active filter and sort, as well as the first value of any field in the table. You can
also add any text you wish and even specify the font to use in the header.

Before we begin, ensure that you have the Classic.prn report and Lessonl.dmod model open and that you are in
Table view.

STEPS:

1. Select File > Page Setup 5"\5

Note that because you have both a report and a table open in the current Monarch session, the Page Setup
dialog slightly differs from the dialog we saw in Chapter 6.

M Page Setup - [m] X
Views -« QL Preferences v
N
e Margins (inches; Export Pagination
X Report gins (i ) P 9
iX Table )
Top: | 050 Paper Size:
Letter (8.5 x 11 in) W
Bottom: | 0.50
Lef: | 050 Orientation:
® Portrait
Right: | 0.50 Landscape

Apply to all Views Apply to all Views

| oK Cancel Help

Figure 9-12. Adding a page header to the printout.

2. Onthe left-hand side of the dialog, select Table from the list of available views.

The Page Setup dialog displays page options available for Table view.
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© ® N o u

11.

12.
13.

M Page Setup - O *

Preferences  Header layout Footer layout ~
i I o ) o
% Margins (inches) Options Export Pagination
i Report
X Table
Top: | 0.50 | Show Gridlines Paper Size:
Bottom: | 0.50 +| Show Column Titles Letter (85x11in) h
+*| Show Row Numbers o R
Left: | 0.50 rientation:
® Portrait
Right: | 0.50 Landscape
Apply to all Views Apply to all Views Apply to all Views

| 0K Cancel Help

Figure 9-13. Page preferences for Table view.

Select the Header Layout tab.
Double click on the first cell of the column labeled Left.

A menu options arrow displays on the cell.

M Page Setup _ O %
. | Footer layout "
A Jol .

X Report Page Header Apply to all Views

g?‘ Teble Left Center Right

Use custom font

Font Tahoma e Bold
Size 10 - Italic
Text Color |l 2000000 v Underline

‘ OK Cancel Help

Figure 9-14. Adding a page header to the printout.

Click the arrow that appears and then select Date from the options that display.
Double-click on the first row of the column labeled Center.

Type Classical Music Distributors into the cell.

Double-click on the first row of the column labeled Right.

Click the arrow on the cell and then select Page Number from the options that display.
Double-click on the second row of the column labeled Left.

Type Report: followed by a space, and then click the arrow on the cell. Select Input Name from the options that
display.

Double-click on the third and last row of the column labeled Left.

Type Model: followed by a space, and then click the arrow on the cell. Select Model File Name from the options
that display.
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Figure 9-15 shows how the Page Header section of your Page Setup dialog should look when you are finished.

M Page Setup

Views

w O Preferences WRlEhEgETGING Footer layout

— O >

A o
g Report

Page Header

Apply to all Views

X Table Left Center Right
&[Date] Classical Music Distributors &[Page]
Report: &[Input]
Model: &[Model]
Use custom font
Font Tahoma - Bold
Size 10 - Italic
Text Color |[ll 000000 v Underline
w Cancel Help
Figure 9-15. A fully set up page header.
14. Click OK to accept your changes and close the Page Setup dialog.
oy
15. To view your new header, select File > Print '==! > Print Preview.
M Print Preview - Table: Main o B R
& & - - HP Ik Tank 310 series - | NorthAmerical etter -
5/26/2020 Classical Music Distributors 1
Report: Classic.prn
Model: Lesson1.dmod
Report Date Page Order_. Ship Date Account Number Contact Media = Quantity
1 5/1/2010 01 536017 4/10/2010 11867 Betty Yoder o5} 4
2 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder [} 7
3 5/1/2010 01 536017 4/10/2010 11887 Betty Yoder [} 2
4 5/1j2000 01 536017 4/10/2010 11867 Betty Yoder DVD ]
5 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder [} 11
6 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder [} 8 L
7 5/1/2000 01 536039 4/21/2010 11867 Betty Yoder o5} 10
8 5/1/2010 01 536039 4/21/2010 11887 Betty Yoder L 3
9 5/1/2010 01 536039 4/21/2010 11887 Befty Yoder DVD 5
10 5/1/2010 02 536016 4/5/2010 17959 Marvin Mabry [} 3 L
11 5/1/2010 02 536016 4/5/2010 17959 Marvin Mabry [} 1
12 5/1/2010 02 536016 4/5/2010 17959 Marvin Mabry [} 3
13 5/1/2010 02 536016 4/5/2010 17959 Marvin Mabry [} 3
14 512010 02 536029 4/14/2010 17959 Marvin Mabry [} 2
15 5/1/2010 02 536029 4/14/2010 17959 Marvin Mabry SACD 9
16 5/1/2010 02 536029 4/14/2010 17959 Marvin Mabry DVD 5
17 5/1/2010 03 536020 4/10/2010 10929 Roberto Gil [} 3
18 5/1/2010 03 536020 4/10/2010 10929 Roberto Gil o5} 3
19 5/1/2010 03 536020 4/10/2010 10929 Roberto Gil [} 3
20 5/1/2010 03 536020 4/10/2010 10929 Roberto Gil SACD 8
21 5/1/2010 03 536020 4/10/2010 10929 Roberto Gil DVD ]
22 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon [} 10
23 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon [} 5
24 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon [} 5
25 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon [} 6
26 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon BLU 10
27 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon DVD 8
28 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon [} -10
29 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon o5} 7
30 5/1/2010 04 536012 4/1/2010 18635 Alain Lebon DVD -11
31 5/1/2010 04 536034 4/18/2010 18635 Alain Lebon [} 3
32 5/1/2010 04 536034 4/18/2010 18635 Alain Lebon o5}
33 5/1/2010 04 536034 4/18/2010 18635 Alain Lebon [}
34 5/1/2010 04 536034 4/18/2010 18635 Alain Lebon [} -
Page 1 of6 4 & 100%

Figure 9-16. A fully set up page header.
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NOTE If your table is wider than it is long, you may wish to change your paper orientation to

landscape. To do so, select the Paper Orientation ] icon on the Print Preview window
and then select Landscape.

Creating a Page Footer

Creating a page footer is no different from creating a page header except that, this time, your definition appears at the
foot of the page. Select Footer Layout from the Page Setup dialog to format a page footer for your table.

PRINTING TABLE DATA

In this lesson, you will learn how to print and copy data from Table view.

This chapter assumes you are familiar with importing and viewing report files, creating data extraction templates and
working in the Table view.

Adjusting Page Setup Options

Several page setup options are provided, and you can use these options to establish margins, add a page header to
each page, print column titles and row numbers, and print the grid lines that you see on-screen.

To edit the page setup options, we’'ll use the Page Setup dialog.

STEPS:

a
1. Select File, and then click Page Setup =§- . The Page Setup dialog displays.
2. Onthe left-hand side of the dialog, select Table from the list of available views.

The Page Setup dialog displays page options available for Table view.

M Page Setup _ O %
Preferences  Header layout Footer layout v
A 0o o 7 7
X Report Margins (inches) Options Export Pagination
Zann EPO!
X Table
Top: | 0.50 | Show Gridlines Paper Size:
Bottom: | 0.50 | Show Column Titles Lefter (85 x 11 in) =
¥/ Show Row Numbers X .
Left: | 0.50 Crientation:
® Portrait
Right: | 0.50

Landscape

Apply to all Views Apply to all Views Apply to all Views

‘. oK Cancel Help

Figure 9-17. The Page Setup dialog.
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The tab shows the current margin settings and print options for the table.

3. Ensure that the Show Row Numbers box is unchecked to deactivate row numbers in our printout. Click OK
when you are finished setting up your page options.

Printing Table Data

The table is usually much wider than the report as Monarch combines fields from various levels in the report to create
each row of the table. When Monarch prints data from the table, it prints as many fields as will fit across the page. If
all of the fields will not fit on a single page, the remaining fields are wrapped to the next page. The amount of
information that will fit on each page is determined by several factors:

0  The font size has a dramatic effect on the amount of data that fits on each page. To fit all the fields across the
page, you may need to select a smaller font size.

0 The Paper orientation setting specifies the direction that text will print. For wide tables, set the paper orientation
to Landscape to print the text sideways on the page.

0 Margins affect how close text is allowed to print to the edge of the page. You can use the margins to make small
adjustments to the amount of text that will fit on each page.

Monarch lets you print just the data you need. You can print the entire table or any selection from the table. Let's
select and print the first page of the report.

STEPS:

1. Select File, and then click on the arrow of the Print '!‘ menu. Select Print from the options that display.
The Print dialog displays.

= Print d
General
Select Printer
@& Brother DCP-T520W Printer M Microsoft XPS Documen
= Fax M OneMote for Windows 1(

™ Microsoft Print to PDF
< >

Status: Ready Preferences
Location: hitp://192.168.254 17980 WebServices/Devi

Comment: Find Printer...

Page Range

s Al Mumber of copies: |1 3:

" {

" Pages: 7

2 3 2 3
Enter either a single page number or a single 1 1

page range. For example, 512

Prirrt Cancel | |

Figure 9-18. The Print dialog.

2. Select the printer you would like to use to print the first page of the report if it has not been selected yet. In the
above screenshot, for example, the printer Brother DCP-T520W Printer was selected.
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3. In the Page Range section, select the button for Pages, and then type the number 1 in the box beside it.

4. Choose Print to print the page.
The first page of the report is printed.

COPYING DATA TO OTHER APPLICATIONS

You can use the Windows clipboard to copy table data to other applications. When you copy data to the clipboard,

Monarch creates both a text image and a worksheet image (with separate rows and columns). When you

subsequently paste the data to another application, the application selects the format it needs.

Let's copy the records for Betty’s Music Store to your spreadsheet.

STEPS:

1. Return to Table view.

2. Select the first 9 records in the table by clicking down on the row selector to the left of Record 1, then dragging

down to Record 9.

Select Copy from the Table ribbon.

4. Launch your spreadsheet. If you don't have a spreadsheet, just follow along in the tutorial.

5. Position the cell pointer where you want the data to appear and use your spreadsheet's Paste command to
paste the data. For some spreadsheet applications, you may need to use the Paste Special > Text command.

6. Adjust the column fields as necessary to view all of the data.

Bookl - Excel
File Home Insert Draw Page Layout Formulas Data Review View Help ACROBAT £ Search =
fﬂ rs Calibri -1 - General - [l Conditional Farmatting = B Insert ~ > - QV' g
> |:| - $ -9% 9 | EEromatasTable~ T Delete ~ | I~ O~ y
aste — eas
< L [5Z Cell Styles - I Format~ | & -
Clipboard Font 71 Alignment | Number Styles Cells Editing Ideas ~
F32 2 Fe v
A E D E F G -
1 |Betty's Music Store CD 4 Bartok, Sonata for Solo violin 8.99 35.96
2 |Betty's Music Store CD 7 Mozart, Massin C, K.427 9 63
3 |Betty's Music Store CcD 2 Luening, Electronic Music 10.19 20.38
4 |Betty's Music Store DVD 9 Scarlatti, Stabat Mater 5.99 53.91
5 |Betty's Music Store CcD 11 Beethoven, Pathetique Sonata, Arau 5.99 65.89
6 |Betty's Music Store CcD 8 Mendelssohn, War March of the Priests 8.99 71.92
7 |Betty's Music Store cD 10 Pizzetti, Messa di Requiem 3.39 95.9
8 |Betty's Music Store LP 6 Misc., Modern Trombone Masterpieces 10.79 64.74
9 |Betty's Music Store DvVD 6 Gershwin, An American in Paris 5.95 35.94
10
11
12
13
14 -
Sheetl (@] [ 3
L) i) & = 1 00
Figure 9-19. Pasting to a spreadsheet.
7. Adjust column widths and cell formats in your spreadsheet as necessary.
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NOTE Monarch does not set the column widths automatically because this might alter an existing
worksheet's column widths when the data is pasted. If the spreadsheet that you are pasting
into is empty, you may prefer to export the data using the Export command. When data is
exported, the column widths are set appropriately for the data.

8. Exit your spreadsheet without saving it.

REDACTING FIELDS

The redaction feature provides a way to remove private or sensitive data from a report. A simple form of redaction
involves overstriking the sensitive data with “X”s. More advanced forms involve replacing the sensitive data with
“pseudo” data, i.e., values which are similar in form but have no relation to the actual data. For example, suppose a
report contains Social Security numbers. It would be difficult to publish an analysis of this report without
compromising the privacy of the SSNs involved. Monarch’s SSN redaction capability solves this problem by replacing
the actual SSNs with “pseudo” SSNs — 9 digit numbers that look like Social Security numbers but are actually just
patterns of digits. The cleansed data may then be analyzed and published without fear of compromise.

Redacting a Single Field

To define redaction for any report field, simply choose the desired type of redaction from the Redaction dropdown
located on the Template tab of the report field editor, as shown below. Choose None if no redaction is desired. Newly
created report fields always start with redaction set to None.

Report Fields oo ~ I General REGLEICE Advanced

W
DraeaE Template Field Properties
Page <
B e Template Width: |5 -

Ship Date

&) Account Number Verify: | Left side

Contact +| Right side

Media | Type

& Quantity

{5 Description Empty Cells: Copy Value From Previous Record
Label Number
Uniit Price Redaction: [None V]

-1 Amount |Nune |

X-over text

X-over non-blanks
X-over digits

X-over digits except last 4
Replace with blanks

.. Consistent alias text

Data Preview o
Report Date Page Order... Ship Datg Account Numb Consistent alias digits

1 (5/1/2010 01 536017 4/10/201 118! Pseudo bank card number
2 5/1/2010 01 536017 4/10/201 1181 pseudo SSN

‘3 5/1/2010 01 536017 4/10/201 1181 Pseudo NHS number

Figure 9-20. Specifying aredaction format for a single field.
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Redacting an Entire Model

It is possible to enable or disable the report field redactions across the entire model, via a checkbox on the Options >
Input page as shown below. When this box is checked, each report field is redacted (or not) according to its specific
redaction setting. When this box is not checked, then report field redactions are disabled, so each report field
behaves as if its redaction was set to None. It should be noted that this setting affects only redactions specified for
report fields — it has no effect on the behavior of any redaction functions used in calculated field expressions.

The figure below, for example, shows the redaction properties for all models to be applied in the current Monarch
session.

Options

v X ©~= g o 0 & il

Accept  Cancel Folders Input View Export  Clipboard  Security  Altair Monarch
Server Library

Input

Fields Text Files Excel Files Trapping Language Options AutoDefine

Dates

Format: | M/D/Y v
Range for 2-digit years: | 1950 | - | 2049

Extraction patterns. Check all that apply.

| Date
Date followed by Time
Time
Time followed by Date

Numbers
Decimal Character: (@ Period Comma

Text
Trim leading and trailing spaces from Character and Memo fields.

Redaction

+’| Enable redaction of report fields.

X-Over Character | X
Use random overstrike lengths for X-Over Text (further obfuscates underlying data values)

Make these the default settings

Figure 9-21. Specifying redaction for an entire model.
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[10] WORKING WITH SORTS

In this chapter, you will learn how to sort data in Table view. The lesson topics include:
0O  Sorting the table

Creating a sort definition

Sorting on multiple fields

Duplicating a sort order definition

0O 0 0 O

Restoring the original sort order
This chapter assumes that you are familiar with importing and viewing report files and working in Table view.

When you extract data from a report file, the information is arranged in the Table view in the order that it appears in
the report but you may want to view, print, or export the data in another order. Sorting allows you to re-order the table
to suit your needs.

To sort the data in the Table view, you create a sort order definition, which specifies the parameters for sorting. The
sort order definition includes the fields to sort on, the sort order for each field (ascending or descending), and the
hierarchy for the sort. You can create multiple sort order definitions and switch between them to see different views of
your data.

To start this lesson, load Monarch and open the Classic.prn and Lesson2.dmod.

CREATING A SORT ORDER DEFINITION

The Classic report is sorted by Customer and Ship Date. When the report data are extracted and assembled as
records in the Table view, the records appear in the same order. Records for Betty’s Music Store appear first, then
records for Big Shanty Music, and so on. Within each customer, the records are sorted by ship dates. While this sort
order is useful, you may want to view the data in another order. Let’s sort the table based on the Description field.

To sort the table, you use the Sort Order Definition window to create a sort definition.

STEPS:

1. Select Table Design L? from the ribbon to launch the Table Design interface and then click Add > Sort 1'-
from the Table Design ribbon.
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The Sort Order Definition window displays.

Design
v % = & = & E @B\ T | &) Y v & B A ?
Accept  Cancel Add Duplicate Delete External Field Input  Formula  Lookup Runtime User Edit Filters | Sarts Address  Functions Help
v Lockups List Fields Fields Fields Parameter Fields Fields Blocks
~
Ll o
_ Name:  Sort Make this the active sort
I Sort
Available Fields: Selected Fields:
Amount Field Order
Customer =
Description
Media Add >>
Quantity
Ship Date
Unit Price iafemose
Right click on 2 sort field to
change its order or position.
Data Preview v R
Customer Ship Date Media  Quantity Description Unit Price Amount -
1 |Betty's Music Store 4/10/2010 (3] 4 Bartok, Sonata for Solo Violin 8.99 3596
2 Betty's Music Store 4/10/2010 €D 7 Mozart, Mass in C, K.427 9.00  63.00
3 Betty's Music Store 4/10/2010 D 2 Luening, Electronic Music 10.19 2038
4 Betty's Music Store 4/10/2010 DvD 9 Scarlatti, Stabat Mater 5.99 53.91
5  Betty's Music Store 4/21/2010 D 11 Beethoven, Pathetique Sonata, Arau 599 6589
6  Betty's Music Store 421/2010 (D 8 Mendelssohn, War March of the Priests 8.99 7192
7  Betty's Music Store 4/21/2010 D 10 Pizzetti, Messa di Requiem 9.59  95.90
8  Betty's Music Store 4/21/2010 P 6 Misc., Modern Trombone Masterpieces 10.79 6474 -
a »
Customer - Character - Append (Customer Level) Filter: No Flter Sort:Sort 100 Rows  100% ———fF————+

Figure 10-1. The Sort Order Definition window.

From this window, you can create multiple sort definitions and switch between them to see different views of the
table.

The Available Fields box displays the fields from the table. The Selected Fields box displays the fields used in
the sort definition, from highest sort level to lowest. To add a field to the definition, select the field from the Fields
box, then click Add >>. To remove a field, select the field from the Selected Fields box, then click << Remove.

2. Type Product Description into the Name box then select the v icon that displays next to the field.

NOTE Sort definition names may be up to 31 characters in length and may contain uppercase and
lowercase characters, spaces, and punctuation. However, periods (.), exclamation points (!),
accent graves ('), and brackets ([ ]) may not appear in any part of the name. As well, names
may not begin with spaces. If a name is entered with leading spaces, the name is accepted
but the leading spaces are trimmed.

3. Select the Description field from the Available Fields box, and then click the Add >> button.

The Description field appears in the Selected Fields box. When a field is moved to the Selected Fields box, its
initial sort order is Ascending. To change the sort order of a field, right-click on the field to display a context menu
and select Change Order from the menu. Since we want to sort the field values in ascending order, we'll leave
the sort order as it appears.

4. Choose Accept v to accept the sort definition and close the Sort Order Definition window.

On the Table ribbon, select the drop-down button of the Active Sort box and then select Product Description.
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The data in the Table view are rearranged according to the Product Description sort order.

File Home Report Table Summary Export ?
& Dokt | e i | o6 v B 3 B

G Zoom To Fit [F] Copy Show Field ~ Freeze
D=y | Product Description e e Comtents  Panes~

¥4 Autosize Columns

Home  Report View m v

Tables v 1 Customer Ship Date Media  Quantity Description Unit Price. Amount -
1A o 1  The Glass Harmonica 4/22/2010  CD 8 Argento, Postcard from Morocco 20.38  163.04
2 The Glass Harmonica 4/22/2010  BLU 1 Bach, Chorale Preludes, Biggs 959  9.59
Main 3 The Glass Harmonica 4/22/2010 D 1 Bach, Fantasia in G for Organ 6.59 6.59
4 Spinning Records 4f28/2010 (D 9 Bach, Sonatas & Partitas for violin. 9.60 8640
5  Big Shanty Music 4/14/2010  SACD 9 Balakirev,Symphony no. 1 959 8631
6  Hope's Sweet Notes 4/14/2010  BLU 10 Barber, Adagio for Strings, NZSO 779 77.90
7 Reiner's Symphonic Sounds  4/28/2010  DVD 2 Barber, Essay no. 3 for Orch, 539 1078
8  Notas Musicales 4/27/2010  DVD 2 Bartok, 4 Dirges, piano., Hagopian 539 1078
9 Betty's Music Store 4/10/2010  CD 4 Bartok, Sonata for Solo Violin 8.99 3596
10  Die Harmonie 4/18/2010 D 3 Baur, 3 Toccatas for Accordion 779 2337
11 Hope's Sweet Notes 4/15/2010  CD 8 Beethoven, 3rd Sym, Karajan, Berlin 9.00 72.00
12  Betty's Music Store 4/21/2010 €D 11 Beethoven, Pathetique Sonata, Arau 599 6589
13  Musique Royale 4/18/2010 P & Bemstein, West Side Story 899 5304
14 Notas Musicales 4/5/2010 o 9 Bizet, Carmen 10.78  97.02
15  Spinning Records 4/28/2010 DVD 6 Bliss, Masks for Piano 5099 3504
16  The King's Place 4/21/2010  DVD 7 Borodin, In the Steppes of Central Asia 350 2513
17 Mo Town Tunes 4/1/2010 (o) 6 Brahms, Chorale Preludes for Organ 9.59 57.54
18  Spinning Records 4/4/2010 for] 4 Brahms,Sonata for 2 pianos 779 3116
19 Hope's Sweet Notes 4/14/2010 DVD 5 Britten, War Requiem 1198 50.00
20  The Record Store 4/20/2010 (D 3 Bruch, Concerto in d, violin. 779 2337
21 Musique Royale 4/13/2010 CD 6 Cage, Music of Changes 899 53.94
22 Musique du Monde 4/10/2010 €D -7 Casella, Paganiniana, NBC SO 9.00 -63.00
23 Musique Royale 4/18/2010 (D 4 Chopin, 24 Etudes, Wild 899 3506
24  Reiner's Symphonic Sounds  4/22/2010 (D 7 chopin, 4 Scherzos for piano 539 37.73
25  Classic Exchange 4/15/2010  CD 9 Copland, Songs, DeGaetani, Smit 539 4851
26 Spinning Records 4/28/2010 DVD 9 Copland, The Tender Land Suite 500 5301
27  Das Piano 4f28/2010 (D 9 Couperin, Harpsichord Music 779 70.11
28  Classic Exchange 4/15/2010  CD 7 Cowell, Adagio for vc & Thunderstick 5.99 4193
20 Reiner's Symphonic Sounds  4/22/2010  CD 11 Debussy, Preludes for Piano 770 8560

30  Die Harmonie 4/18/2010 (D 2 Desprez, Missa de Beata Virgine 7.79 1558 .
21 Dminnr'c Cumnhanic Camde 413103018 10 = Minhnomd Vare a2 Maran: Dhume s=n amac

. v
Customer - Character - Append [Customer Level) Filter: No Filter Sort Product Description  149Rows  100% — —8#———+

Figure 10-2. Table view sorted by the Description field values.

SORTING ON MULTIPLE FIELDS

In the previous section, we sorted the table on a single field. Monarch also lets you sort on multiple fields. Let's sort
the table again, this time on two fields, Media (in ascending order) and Amount (in descending order).

STEPS:

1. Launch the Sort Definition window once more by selecting Table Design L? > Add > Sort.

2. Type Descending Sales by Media in the Name box of the Sort Order Definition window that displays and then
select the v icon that appears next to this field.

3. Move the Media and Amount fields to the Selected Fields list.

Let's change the sort order of the Amount field to sort the values in descending order (largest values to smallest
value).

4. Right-click on the Amount field, then select Change Order from the context menu.

If you don’t provide a name, Monarch will attempt to name the sort definition using the name of the first sort field
you specified, in this case, Media. If this name is already in use by another sort definition, you will be prompted
to enter a name.

5. Choose Accept v in the Table Design ribbon to accept the sort definition and close the Sort Order Definition
window.

6. In Table view, click on the drop-down button of the Active Sort box and then select Descending Sales by
Media.
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The data in the Table view are sorted, first by Media and then by Amount. The Amount field values for each
media type are sorted in descending order.

File Home Report Table Summary Export ?
B Eem D | B | o e wi B o | B =
& Zoom To Fit [0] Copy - Show Field Freeze
SE".‘*‘ Active Sort: | Descending Sales by Media v SEED GRzm ;‘”" 3 Rebuild Gy e
= Autosize Calumns = FEE Data View

Home  Report View m v

Tables — ——) Customer ShipDate  Media  Quantity Description Unit Price Amount -
N ) 1  Musique du Monde 4/1/2010 BLU 10 Paganini, 24 Caprices for violin. 959 9590
2 Hope's Sweet Notes 4/14/2010  BLU 10 Barber, Adagio for Strings, NZSO 779  77.90
Main 3 Notas Musicales 4/5/2010 BLU 7 Liszt, Les Preludes 9.59 67.13
4 The Record Store 4/20/2010  BLU 3 Mozart, Le nozze di Figaro, Opera 500 17.97
5 Notas Musicales 4/27/2010 BLU 5 Mozart, Serenata Notturna 359 1795
6  The Glass Harmonica 4/22/2010  BLU 1 Bach, Chorale Preludes, Biggs 9.59 959
7 Hope's Sweet Notes 4/14/2010  CD @ Misc., The At of Perlman, Itzhak, vn. 3840 307.20
8  The Glass Harmonica 4/22/2010 D 8 Argento, Postcard from Morocco 2038 163.04
9 Musique Royale 4/7/2010 o] 4 Glass, Einstein on the Beach 35.95 143.80
10 Reiner's Symphonic Seunds  4/12/2010  CD 9 Puccini, Madame Butterfly (opera) 15.58 140.22
11  Musique Royale 4/18/2010 (D 7 Haydn, Paris Symphonies 17.98 125.86
12  Das Piano 4/28/2010 (D 9 MacDowell, Sonata tragica in g 1198 107.62
13 Spinning Records 4/28/2010  CD 11 Misc., Nova Schola Gregoriana 9.59 10549
14 Notas Musicales 4/5/2010 D 9 Bizet, Carmen 1078 97.02
15  Musique du Monde 4/1/2010 (o) 10 Milhaud, 3 Rag Caprices, pn. & orch. 9.60  96.00
16  Betty's Music Store 4/21/2010  CD 10 Pizzetti, Messa di Requiem 9.59 9590
17  Musique Royale 4/19/2010  CD 10 Ives, Robert Browning Overture 0.57 9570
18  Spinning Records 4/28/2010 (D 9 Bach, Sonatas & Partitas for violin. 9.60 8640
19 Chez Rudy 4/18/2010  CD 4 Monteverdi, L'Orfeo 21.58  86.32
20  Die Melodie 4f24/2010 (D 9 Hakim, Suite for Harpsichord 9.59 8631
21  Die Melodie 4/24/2010 (D 9 Janacek, Jealousy Overture 959 8631
22 canciones 4/13/2010 CD 9 Koday, Marosszek Dances 9.58 8622
23 Reiner's Symphonic Sounds  4/22/2010 (D 11 Debussy, Preludes for Piano 779 85.69
24 The Record Store 4/25/2010  CD 9 Granados, Capricho Espanol, piano. 890 80.01
25  Fandangos Records 4/28/2010 o 10 Gibbons, Instrumental & Vocal Music 7.79 7790
26 Die Melodie 4/24/2010 D 10 Schumann, Frauenliebe und leben 779 7790
27 Hope's Sweet Notes 4/15/2010  CD @ Beethoven, 3rd Sym, Karajan, Berlin 0.00 7200
28  Betty's Music Store 4/21/2010 (] 8 Mendelssohn, War March of the Priests 899 7192
29 Notas Musicales 4/27/2010 D 8 Schumann, Sym. Etudes for piano. 899 7192

30  Die Melodie 4f24/2010 (D 9 Seeger, Diaphonic Suite 779 70.11 .
2 Fancinnne amerainrn 0 Talnmann 17 Cambacine far \finfin T s

1 v
Customer - Character - Append (Customer Level) Filter: No Filter Sort: Descending Sales by Media 149 Rows  100% — ——f——— +

Figure 10-3. Table view sorted by ascending Media and descending Amount.

RESTORING THE ORIGINAL TABLE ORDER

You can turn off sorting and restore the original record order by simply selecting the No Sort option in the Active Sort
drop-down.

File Home Report Table Summary Export ?
E4 Select Al pctive Fiter: (o Fitter . B (e} =]
i @ Zoom To Fit [] Copy Active Sott. | Ng Sort B Search  Goto  Findin Rebuild S =
E=m ¥4 Autosize Columns Row  Report Data View
~
Home >
Tables - Customer ShipDate  Media Quantity Description Unit Price Amount -
1 1 Befty's Music Store 4/10/2010 D 4 Bartok, Sonata for Solo Violin 899  33.96
2 Betty's Music Store 4/10/2010 €D 7 Mozart, Mass in €, K.427 9.00  63.00
Main 3 Betty's Music Store 4/10/2010 €D 2 Luening, Electronic Music 1019 2038
4 Betty's Music Store 4/10/2010 DVD 9 Scarlatti, Stabat Mater 599 53.91
5  Betty's Music Store 4[21/2010 €D 11 Beethoven, Pathetique Sonata, Arau 509 65.89
6  Betty's Music Store 4/21/2010 (D 8 Mendelssohn, War March of the Priests 899 7192
7 Betty's Music Store 421/2010  CD 10 Pizzetti, Messa di Requiem 9.59  95.90
8  Befty's Music Store 4/21j2010  LP 6 Misc., Modern Trombone Masterpieces 1079 6474
9 Betty's Music Store 4/21/2010  DVD 6 Gershwin, An American in Paris 5.99 3594
10  Big Shanty Music 4/5/2010 [o) 6 Stravinsky, Dumbarton Oaks Concerto 809 53.94
11  Big Shanty Music 4/5/2010 D 1 Schubert, Sonata in e, D.566 9.00 9.00
12  Big Shanty Music 4/5/2010 @ 3 Mozart, Symphony No.23 in D 809  26.97
13 Big Shanty Music 4/5/2010 [o) 6 Schoenberg, Ode to Napoleon 9.59 5754
14  Big Shanty Music 4/14/2010  CD 2 Shostakovich, 24 Preludes for piano. 539 1078
15  Big Shanty Music 4/14/2010  SACD 9 Balakirev,Sympheny no. 1 9.59 8631
16  Big Shanty Music 4/14/2010  DVD 5 Holst, St. Paul's Suite for Orch. 5.99 20.95
17  Bluegrass Records 4/10/2010  CD 3 Faure, 28 Songs, Stulzmann 17.98  53.94
18  Bluegrass Records 4/10/2010 D 3 Takemitsu, Music of Takemitsu 3.60 10.80
19  Bluegrass Records 4/10/2010 €D 6 Maessiaen, Quatour pour la fin de temps 9.60 57.60
20  Bluegrass Records 4/10/2010  SACD 8 Strauss, Ein Heldenleben, Op.40 809 7192
21 Bluegrass Records 4/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO 599 5391
22 Musique du Monde 4/1/2010 [o) 10 Milhaud, 3 Rag Caprices, pn. & orch. 9.60  96.00
23 Musique du Monde 4/1/2010 [o) 5 Strauss, Le bourgeois gentilhomme 9.60 48.00
24 Musique du Monde 4/1/2010 [o) 5 Scriabin, Preludes, Op. B 779 3895
25  Musique du Monde 4/1/2010 [o) 6 Rogers, Slaughter on Tenth Avenue 9.60  57.60
26  Musigue du Monde 4/1/2010  BLU 10 Paganini, 24 Caprices for viglin. 9.50  05.90
27  Musique du Monde 4/1/2010 DVD 8 Vivaldi, Concertos for Recorder 599  47.92
28 Musique du Monde 4/10/2010 D -10 Linek, Epiphany Carol 599 -59.90
29  Musigue du Monde 4/10/2010 €D -7 Casella, Paganiniana, NBC SO 2.00 -63.00
30  Musique du Monde 4/10/2010  DVD -11 Lambert, Airs de Courm (1689) 5.09 -65.89 -
21 Mucinnn A Mondn amomasnen 2 Lhimnntt Cuitn frr Accardian 9. N am 077
‘ »
KCustomer - Character - Append (Customer Level) Filter: No Fifter Sort:MoSort 140Rows  100% ——————+

Figure 10-4. The original table order displays when the No Sort is applied to the table.
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DUPLICATING SORTS

You may want to create a new sort that closely resembles a sort you previously defined. An easy way to do this is by
using the Duplicate E‘ button. To duplicate a sort, simply select the sort you want to duplicate from the Sort list and

then select Duplicate @ from the Table Design ribbon. The duplicated sort appears on the Sort list; this sort will
have the name of the sort you duplicated and a number appended to it. Select this sort to display its properties in the

Sort Definition window and make further revisions to it. Select Accept v when you are finished to accept and save
your new sort definition.
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[11] WORKING WITH FILTERS

In this chapter, you will learn how to use a filter to display a subset of the table data. The lesson topics include:
0O Adiscussion of what a filter is

Creating a filter expression

Testing a filter expression

Using functions

Restoring the original table data

[ R R

Working with value-based filters

This chapter assumes that you are familiar with opening reports, creating a data extraction template, and working in
Monarch’s Table view.

There are several types of filters you can create:
0 Value-based filters

Value-based filters offer simple filters that are typically used to obtain records with only one or two specifications.
In Classic.prn, for example, you could use a value-based filter to return details for records with descriptions of
“Mozart” and “Chopin.” Creating a value based filter entails identification of a single field on which your filter will
be based, and then specifying the exact value(s) of the filter.

0  Formula-based filters

Formula-based filters, in their simplest form, function very much like value-based filters. However, formula-based
filters offer increased filter-making versatility. Working with Classic.prn again, let's say you want to filter a table
for all CD sales amounting to $50.00 and above. Using a value-based filter here is out of the question because
only one field name can be specified with such filters. The filter you want to create specifies conditions for two
fields, Media and Amount. Here, a formula-based filter would be more appropriate.

0  Compound filters Compound filters function as extensions of formula-based filters, and help you create longer
filters with two or more component filters.

To start the lesson, load Monarch, open Classic.prn and Lesson3.dmod, and then launch Table view.

Home Report View m ~
Tables n Customer Ship Date  Media  Quantity Description Label Number Unit Price Amount -
0

0 1 20100410 CD 4 Bartok, Sonata for Solo Violin MK-42625 8.99 3596
2 Betty's Music Store 20100410  CD 7 Mogzart, Mass in C, K.427 420831-2 9.00 63.00
Main 3 Befty's Music Store 20100410 CD 2 Luening, Electronic Music CD 611 1019 2038
4 Betty's Music Store 20100410 DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99  53.91
5 Betty's Music Store 20100421  CD 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 6589
6 Betty's Music Store 20100421  CD 8 Mendelssohn, War March of the Priests SMK 47592 8.99 7192
7 Betty's Music Store 20100421 CD 10 Pizzefti, Messa di Requiem CHAN 8964 9.59  95.90
Betty's Music Store 20100421  LP 6 Misc., Modern Trombone Masterpieces ADA 581087 1079 6474
9 Betty's Music Store 20100421 DVD 6 Gershwin, An American in Paris ACS 8034 5.99 3594
10  Big Shanty Music 20100405 CD 6 Stravinsky, Dumbarton Ozaks Concerto SMCD 5120 899 5394
11  Big Shanty Music 20100405 CD 1 Schubert, Sonata in e, D.566 AS-325 9.00 9.00
12 Big Shanty Music 20100405  CD 3 Mozart, Symphony No.23 in D CO-77884 8.99 2697
13 Big Shanty Music 20100405 CD 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
14  Big Shanty Music 20100414  CD 2 Shostakevich, 24 Preludes fer piano. CDA 66620 539 1078
15  Big Shanty Music 20100414 SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 8631
16  Big Shanty Music 20100414 DVD 5 Holst, St. Paul's Suite for Orch. CBT-1020 599 29.55
17  Bluegrass Records 20100410  CD 3 Faure, 28 Songs, Stulzmann RCA 61429-2 1798 53.54
18  Bluegrass Records 20100410  CD 3 Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80
19 Bluegrass Records 20100410  CD 6 Messizen, Quatour pour la fin de temps CDC 54935 9.60 57.60
20  Bluegrass Records 20100410  SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99 71.92
21 Bluegrass Records 20100410 DVD 9 Schumann, Manfred Querture, Bav SO SBT 48270 5.99  53.91
22 Musique du Monde 20100401 CD 10 Milhaud, 3 Rag Caprices, pn. & orch. Z-6569 9.60 96.00
23 Musique du Monde 20100401 CD 5 Strauss, Le bourgeois gentilhomme CDD 448 9.60  48.00
24  Musique du Monde 20100401  CD 5 Scriabin, Preludes, Op. 8 CY 1123 779 3895
25  Musigue du Monde 20100401  CD 6 Rogers, Slaughter on Tenth Avenue CDD 275 960 57.60
26  Musique du Monde 20100401 BLU 10 Paganini, 24 Caprices for violin. BLU 120 9.59  95.90
27  Musique du Monde 20100401  DVD 8 Vivaldi, Concertos for Recorder ABTD-1156 5.99 4792
28 Musique du Monde 20100410 CD -10 Linek, Epiphany Carol SUP 10 4154 5.9 -59.90
29  Musique du Monde 20100410 CD -7 Casella, Paganiniana, NBC SO AS 510 9.00 -63.00
30  Musique du Monde 20100410 DVD -11 Lambert, Airs de Courm (1689) HMA 431123 5.99 -65.89
31  Musique du Monde 20100418 CD 3 Huggett, Suite for Accordian & Pn. MVCD 1056 959 2877 v
] »
Customer - Character - Append (Customer Level) Filter: No Filter Sort NoSort  140Rows  100% — ——f—+

Figure 11-1. Extracted data displayed in Table view.
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The table in Figure 11-1 lists transactions for distributors of classical music recordings. Transactions are included for
each customer and are broken down by media types, including CDs, LPs, DVDs, SACDs and Blu-ray discs. In all,
there are 149 records in the table.

By applying a filter, you can select only those records that interest you and filter out the rest. Let's use a filter to view
only the records for a particular customer, i.e., Big Shanty Music.

CREATING VALUE-BASED FILTERS

To filter table data, you create a filter expression via the Filter Definition window. In the following exercise, we will
create a value-based filter such that only records for the customer “Big Shanty Music” are returned.

STEPS:
1. From the ribbon of Table view, select Table Design L? to launch the Table Design interface and then click Add
> Filter > Value Based Filter.

The Value-Based Filter Definition window displays.

Design

v % = @ z & =E = =T T T = ¥ ¥ B A ?
Accept  Cancel Add Duplicate Delete External Field Input Formula Lookup Runtime User Edit Filters Sorts Address Functions Help
- Lookups List Fields Fields Fields Parameter Fields Fields Blocks
-
Filters ~ B EEELRETEE Advanced v
il ‘ £ Filter Name: | Filter Comment v Make this the active filter
Y Fitter

Row Selection:
Field: ~ || Import values filtered by... ~
Include rows where the field value
matches one of the selected values.

®
Value

Include rows where the field value does
not match any of the selected values,

Remove selected rows Include rows where the field value is null
or empty.

Figure 11-2. The Value-Based Filter Definition window.

Let's take a moment to study the Value-Based Filter Definition window. The panel on the left-hand side of the
window is a Filter Selector. This panel is particularly useful if you want to modify an existing filter, for example,
and you have several filters defined. The Value-Based Filter Definition window contains two tabs that help you
define your filter. At the bottom of the window, the Data Preview button shows you what your table will look like if
the filter you've just defined is applied to it.

In the Field Values tab of the Filter Definition window, several options display, each of which can help you create
your filter.

Let's say you are creating a filter where only records for Fandangos Records and Musique Royale are to display.
You would then select Customer from the Field drop-down list and specify values for Fandangos Records and
Musique Royale. In the Row Selection section, you can specify whether to display all records for either
Fandangos Records or Musique Royale or display all records that are not by Fandangos Records or Musique
Royale (i.e., all records except those from Fandangos Records and Musique Royale will display). You can also
select whether records with blank customer names will display in your table after the filter is applied.

The Value box displays the type of values you must enter for the selected field. For example, when you select
the field Quantity, all of the values to be entered into the field must be of the type Numeric. When you select the
field type Description, all of the values to be entered into the Value field must be of the type Character. If you
enter a character string into the Value field for a numeric field, the filter will not be created.
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The Import values filtered by... drop-down list allows you to easily select field values for the Value box,
including values you entered for previous filters. When you click on this box, a list of previously created filters
displays, including the “No Filter” option. Clicking on any option on the list and then selecting the Add Rows
button automatically adds all available values for the selected field name. Again, values to be entered must
match the type of field you selected. When you select the No Filter option and then click Add Rows, all possible
values for that field display in the Value box. You may delete values added to the box by clicking on the value
and then selecting the Delete button.

In the Advanced tab, you can find options that allow you to either display all rows (records) that fit the filter
description you specified or limit the display to a certain number of rows.

In the Field Values tab, enter Big Shanty Music in the Filter Name box and then select v .

In the Field drop-list, select Customer.

Double-click the first cell in the Value box and then enter Big Shanty Music.

ag > D

Ensure that the radio button for Include rows where the field value matches one of the selected values is
selected.

Click Accept v to save the details of the filter you specified and close the filter definition window.

IS

In Table view, select the drop-down button of the Active Filter field and then select Big Shanty Music.

The table is rebuilt to show only those records from Big Shanty Music.

& Ty e ] e s B g | = @
The | N ZomTof: [0 Copy tve o [No Sor T sewh Goto Fndin e | S IRY RO
Design ¥4 Autosize Columns e Data View
~
Tables s v L Customer Ship Date  Media Quantity Description Label Number Unit Price Amount -
1 o 1 20100405 CD 6 Stravinsky, Dumbarton Ozks Concerto SMCD 5120 8.99 53.94
2 Big Shanty Music 20100405 D 1 Schubert, Sonata in e, D.566 AS-325 9.00  8.00
Main 3 Big Shanty Music 20100405 D 3 Mozart, Symphony No.23 in D C0-77884 899 2697
4 Big Shanty Music 20100405 D & Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
5 Big Shanty Music 20100414 (D 2 Shestzkovich, 24 Preludes for piano. CDA 66620 539  10.78
6 Big Shanty Music 20100414  SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.59 8631
7 Big Shanty Music 20100414  DVD 5 Holst, St. Paul's Suite for Orch CBT-1020 599  29.95

Figure 11-3. The Table data with a filter applied to it. Only those records for Big Shanty Music display.

You have successfully created a value-based filter.

CREATING FORMULA-BASED FILTERS

To display only transactions amounting to US$100.00 and above, we’'ll use the following expression:
Amount>=100

To build the expression above, which is a formula-based one, you could type the expression as it appears above, or
you could build it by inserting components from the list boxes.

STEPS:

1. From the Table Design ribbon, select Add > Filter > Formula-Based Filter.

2. In the Filter Name box, enter Sales >=100 and then select v to accept this name.
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NOTE Filter definition names may be up to 31 characters in length and may contain uppercase and
lowercase characters, spaces, and punctuation marks. However, periods (.), exclamation
points (!), accent graves ('), and brackets ([ ]) may not appear in any part of the name. As
well, names may not begin with spaces. If a name is entered with leading spaces, the name
is accepted but the leading spaces are trimmed.

3. Double-click Amount from the Fields list
“Amount” displays on the Expression box.

4. Double-click the greater than or equal to (>=) sign from the Operators list.
The greater than or equal to sign is added to the expression.

5. Click on the Expression box right after the operator “>=" and then type in 100.

6. Select the Accept v icon that displays in the Expression box to accept your formula.

7. Check the Data Preview panel.
All of the records that display should have amounts greater than or equal to 100. Note, however, that the Data
Preview only shows the first 100 records extracted from a report, or first 100 rows imported from a database, so
depending on the data, you may not see rows affected by the filter in the Data Preview.
Select Accept v in the Filter Definition ribbon to save your new filter and close the Table Design interface.
In Table view, select the drop-down button of the Active Filter box and then choose the filter Sales >=100.

The table displays only those transactions amounting to US$100.00 or greater (see Figure 11-4).

54 | | = s} a @
Table @ Zoom To Fit ] Copy Active 5o Mo 5ot . Search Goto  Findin = 5|me Field ;reeze
F=m »34 Autosize Columns |—‘ Ran Repart Data View antents anesr
~
Tables ~ 1 Customer Ship Date  Media  Quantity Description Label Number Unit Price Amount -
o 0 1 20100414 CD 8 Misc., The Art of Periman, Ttzhak, wn. 4-7DMZ-64617 3840 307.20
2 Das Piano 20100428 CD 9 MacDowel, Sonata tragica in g NRPR 2202/3 11.98 107.82
Main 3 Das Piano 20100428 SACD 9 Messiaen, Oeseaux exotiques M2K44762 17.98 161.82
4 Reiner's Symphonic Sounds 20100412 CD 9 Puccini, Madame Butterfly (opera) CDCB-47959 1558 140.22
5 Spinning Records 20100428 CD 11 Misc., Nova Schola Gregoriana ARN 68094 9.59 10549
6 Musigue Royzle 20100407 CD 4 Glass, Einstein on the Beach 14K-38875 3595 143.80
7 Musigue Royzle 20100419 CD 7 Haydn, Paris Symphonies SM2K 47550 17.98  125.86
& The Glass Harmonica 20100422 CD 8 Argento, Postcard from Morocco CRI 2-614 2038 163.04
9 The King's Place 20100414 SACD 11 Pachelbel, Kanon MK-42478 9.59 10549

Figure 11-4. The Table view showing all transactions amounting to or over $100.00.

CREATING COMPOUND FILTERS

Compound filters allow you to create longer, more-complicated filters composed of previously created ones. Let's
create a compound filter using the value- and formula-based ones we specified earlier.

If you wanted to create a filter that will return all records from Big Shanty Music AND all records with transaction
amounts greater than or equal to US$ 100.00, you could create a formula-based filter such as the following:

Customer="Big Shanty Music”. AND.Amount>=100

If you wanted to create a filter that will return all records from Big Shanty Music OR all records with transaction
amounts greater than or equal to US$ 100.00, you would create the following formula-based filter:

Customer="Big Shanty Music”.OR.Amount>=100
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While you can create either of the filters this way, selecting fields, operators, and values, as well as determining the
correct way to link individual filter expressions may be a tedious task. Here, Monarch allows you to create compound
filters whose components you can simply select from a list.

The following steps will show you how to create a compound filter that will return all records that are either by Big
Shanty Music or have amounts greater than or equal to US$ 100.00.

STEPS:

1. From the Table Design ribbon, select Add > Filter > Compound Filter.

In the Filter Name field, enter Big Shanty Music and Sales>=100 then select v.

3. Select Big Shanty Music from the Available filters box by clicking on it and then move it to the Component filters
box by clicking Add>>.

4. Repeat Step 3 to move the filter Sales>=100 to the Component filters box.
In the Select rows that satisfy section, select the radio button for any one of the component filters.

This selection instructs Monarch to display records that have either Big Shanty Music as the customer or
transaction amounts greater than or equal to US$100.00.

If you select all of the component filters, only those records that are by Big Shanty Music and have sales
amounts greater than or equal to US$100.00 will display in the Table view. Of course, in this case, no records
will display because none of Big Shanty Music’s sales amount to over US$100.00.

Note that the component filters, as well as the type of link (AND/OR), display in the Component filter expression
box. In the present example, the component filter expression should read: [Big Shanty Music] OR
[Sales>=100].

6. Click Accept v in the Filter Definition ribbon to accept your new filter definition.

7. From the Active Filter drop-down, select the filter Big Shanty Music and Sales>=100.

The table is rebuilt and your filter is applied.

File Home Report Table Summary Export ?
4 Sl e T B | o | F @
Design Sidl Mutosize Gakimas Row Report Data View
A
(LT Table View X v
Tables ~ R Customer Ship Date  Media  Quantity Description Label Number Unit Price Amount -
1 ° 1 20100405 €D 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 899 5394
2 Big Shanty Music 20100405 CD 1 Schubert, Sonata in &, D.566 A5-325 2.00 9.0
Main 3 Big Shanty Music 20100405 D 3 Mozart, Symphony No.23 in D co-77884 899 2697
4 Big Shanty Music 20100405 €D 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 5754
5 Big Shanty Music 20100414 CD 2 shostakovich, 24 Preludes for piano. CDA 66620 539 1078
6  Big Shanty Music 20100414 SACD 9 Balzkirev,Sympheny no. 1 ENTPD 4110 9.59 8631
7 Big Shanty Music 20100414  DVD S Holst, St. Paul's Suite for Orch CBT-1020 599  29.95
8  Hope's Sweet Notes 20100414 CD & Misc,, The Art of Periman, Itzhak, vn. 4-ZDMZ-64617 3840 307.20
9 DasPiano 20100428 D 9 MacDowel, Sonata tragica in @ NRPR 2202/3 1198 107.82
10 Das Piano 20100428 SACD 9 Messiaen, Oeseaux exotiques M2K-44762 17.08 16182
11 Reiner's Symphonic Sounds 20100412 CD 9 Puccini, Madame Butterfly (opera) CDCB-47959 1558 14022
12 Spinning Records 20100428 CD 11 Misc., Nova Schola Gregoriana ARN 68094 9.5 105.49
13 Musique Royale 20100407 CD 4 Glass, Einstein on the Beach M4K-38875 3595 143.80
14 Musique Royale 20100419 (D 7 Haydn, Paris Symphonies SM2ZK 47550 17.98 125.86
15 The Glass Harmonica 20100422 CD 8 Argento, Postcard from Morocco CRI 2-614 2038 163.04
16 TheKing's Place 20100414 SACD 11 Pachelbel, Kanon MK-42478 9.59 10549

Figure 11-5. The resulting compound filter.
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USING FUNCTIONS IN FILTERS

Monarch provides a host of functions you can use in your filter expressions. For example, to display only shipments
of symphony recordings, you can use the expression:

Instr("Symphony",[Description])

The Instr() function searches a field for the occurrence of a string. In the above example, the expression returns only
those records where the word “Symphony” appears anywhere in the Description field. The brackets surrounding the
Description field name are required, as this field name is longer than 10 characters.

File Home Report Table Summary Export ?
54 et acove it [runcoon Fite 1] R o ‘B A
Q7 To Fit [Cafe
Table R 1 Copy Active Sort: | No Sort ~ =E O [k Cahre S'Smfnid ;;:e:i
Design (B A @S Row Report Data View
~
Tables o v Customer Ship Date  Media Quantity Description Label Number Unit Price Amount -
i 0 1 |Big Shanty Music 20100405 CD 3 Mozart, Symphony No.23 in D CO-77884 8.99 2697
2 Big Shanty Music 20100414  SACD 9 Balakirev,Symphony no. 1 ENTPD 4110 9.50 8631
Main 3 Canciones 20100410 CD 2 Mozart, Symphony in D, K.202 CD-80186 659 13.18
4 Spinning Records 20100404 P 2 Dvorak, New World Symphony LON 255 781 599 11.98
5 Musique Royale 20100413 LP 2 Mahler, Symphony No. 2 DGG 427 262 1316 2632
6 The Glass Harmonica 20100422  SACD 7 Sibelius, Symphony No. 5, Op.82 478637 9.60 67.20

Figure 11-6. Using a filter to display Symphony recordings.

Monarch supports over 70 functions. The Monarch Help file contains detailed information about each function,
including examples of their use in filter expressions. Monarch also includes a host of user-defined functions. You can
create your own functions to provide an easy way to store and use complex expressions, and these functions can be
shared to other co-workers who use Monarch.

RESTORING THE ORIGINAL TABLE ORDER

You can turn off filtering and re-display all of the table data by selecting the No Filter option in the Filters menu.
Simply select the Active Filter drop-down button and then select No Filter to disable all filters.
Table view displays all of the original table data extracted by Lesson3.dmod from Classic.prn.

At this point, you can opt to either save your work or simply close the report and model files you opened for this
lesson. For the rest of this chapter, we do not need to save our work.

DUPLICATING FILTERS

You may want to create a new filter that closely resembles a filter you previously defined. An easy way to do this is by
(+)
using the Duplicate El button. To duplicate a filter, simply select the filter you want to duplicate from the Filters list

and then select Duplicate @ from the Table Design ribbon. The duplicated filter appears on the Filters list; this filter
will have the name of the filter you duplicated and a number appended to it. Select this filter to display its properties in
the Filter Definition window and make further revisions to it. Select Accept when you are finished to accept and save
your new filter definition.
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[12] WORKING WITH CALCULATED
FIELDS

In this chapter, you will learn how to calculate new fields from the data in the Table view. The lesson topics include:
0O Adiscussion of what a calculated field is

O Creating a calculated field

0 Making comparisons

0 Hiding and deleting calculated fields

This chapter assumes that you are familiar with opening reports, creating a data extraction template, and working in
the Monarch’s Table view.

A calculated field is a field whose value is derived from other fields in the same record. Calculated fields can be
used to perform a variety of tasks, including arithmetical computations, concatenating character fields, and extracting
information from a field. You can create and save multiple calculated fields. Once a calculated field is created, you
can use itin filter, sort and summary definitions and copy, print and export it along with other fields.

You can create several types of calculated fields in Monarch via the Table Design interface. These fields include:
0  Formula-based

To create a formula-based calculated field, you create a calculated field expression. A calculated field expression
is a formula that returns a value to a calculated field.

0  Runtime Parameter

Runtime parameter calculated fields are very much like formula-based ones. The major difference between them
is that runtime parameter calculated fields do not contain a formula, just a simple string, number or date value.
The user is prompted to supply values for each runtime parameter when the model is loaded.

O Lookup

A lookup calculated field provides a convenient "table lookup" where the value of a designated input field is
checked against a lookup table. They can be useful in avoiding the long and complicated IF statements that can
occur in formula-based calculated fields.

0 User-edited

A user-edited calculated field is special in that it allows the user to enter text to annotate rows in the table or
enter corrections for bad data.
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To start this lesson, we'll load Monarch and open Classic.prn and Lesson9.dmod. Switch to Table view when done.
File Home Report Table Summary Export ?

574 SelectAll | ive Fiter: [No Fer 0 oes o R IS g ‘a
Q¢ Zoom To Fit [£] Copy - ShowField  Freeze
Design No Sort Row Report o Vi Contents Panes

¥4 Autosize Columns

A~
Home  Report View v
Tables o v Account Number Customer Ship Date Media Qty Description Amount -
i 0 1 Betty's Music Store 4/10/2010  CD 4 Bartok, Sonata for Solo Violin 35.96

2 11887 Betty's Music Store 4/10/2010 o) 7 Mozart, Mass in C, K427 63.00
Main 3 11887 Betty's Music Store 4/10/2010 €D 2 Luening, Electronic Music 2038
4 11887 Betty's Music Store 4/10/2010 DVD 9 Scarlatti, Stabat Mater 53.91
5 11887 Betty's Music Store 4/21/2010 CD 11 Besthoven, Pathetigue Sonata, Arau 65.80
6 11887 Betty's Music Store 4/21/2010  CD 8 Mendelssohn, War March of the Priests 71.82
7 11887 Betty's Music Store 4/21/2010  CD 10 Pizzetti, Messa di Requiem 95.90
8 11887 Betty's Music Store 4/21/2010  LP 6 Misc,, Modern Trombone Masterpieces 64.74
9 11887 Betty's Music Store 4/21/2010  DVD 6 Gershwin, An American in Paris 35.84
10 17959 Big Shanty Music 4/3/2010 (6] 6 Stravinsky, Dumbarten Ozks Concerto 53.94
1 17959 Big Shanty Music 4/5/2010 €D 1 Schubert, Sonata in e, D.566 9.00
12 17959 Big Shanty Music 4/3/2010 (6] 3 Mozart, Sympheny No.23 in D 26.97
13 17959 Big Shanty Music 4/5/2010 €D 6 Schoenberg, Ode to Napoleon 57.54
14 17959 Big Shanty Music 4/14/2010  CD 2 Shostakovich, 24 Preludes for piano. 10.78
15 17959 Big Shanty Music 4/14/2010  SACD 9 Balakirev,S5ymphony na. 1 8631
16 17959 Big Shanty Music 4/14/2010  DVD 5 Holst, St. Paul's Suite for Orch. 29.95
17 10929 Bluegrass Records 4/10/2010 CD 3 Faure, 28 Songs, Stulzmann 53.94
18 10929 Bluegrass Records 4/10/2010 CD 3 Takemitsu, Music of Takemitsu 10.80
19 10929 Bluegrass Records 4/10/2010 CD 6 Messizen, Quatour pour Iz fin de temps 57.60
20 10920 Bluegrass Records 4/10/2010  SACD @ Strauss, Ein Heldenleben, Op.40 7192
21 10929 Bluegrass Records 4/10/2010 DVD 9 Schumann, Manfred Overture, Bav SO 53.91
22 18635 Musique du Monde 4/1/2010 D 10 Milhaud, 3 Rag Caprices, pn. & orch. 96.00
23 18635 Musique du Monde 4/1/2010 o)) 5 Strauss, Le bourgeois gentilhomme 48.00
24 18635 Musique du Monde 4/1/2010 D 5 Scriabin, Preludes, Op. & 38.95
25 18635 Musique du Monde 4/1/2010 o)) 6 Rogers, Slaughter on Tenth Avenue 57.60
26 18635 Musique du Monde 4/1/2010  BLU 10 Paganini, 24 Caprices for violin. 95,90
27 18635 Musique du Monde 4/1/2010 DVD 8 Vivaldi, Concertos for Recorder 47.92
28 18635 Musique du Monde 4/10/2010 €D -10 Linek, Epiphany Carol -50.90
29 18635 Musique du Monde 4/10/2010 €D -7 Casella, Paganiniana, NBC SO -63.00
30 18635 Musique du Monde 4/10/2010  DVD 11 Lambert, Airs de Courm (1689) -65.80
31 18635 Musique du Monde 4/18/2010 €D 3 Huggett, Suite for Accordian & Pn. 28.77 -
. »
Account Number - Numeric - Append (Account Number Level) Filter: No Filter Sort NoSort  149Rows  100% — ——f——+

Figure 12-1. Extracted data displayed in the Table view.

The table in Figure 12-1 lists transactions for distributors of classical music recordings. We've extracted the detail
information for each transaction along with the customer name and account number.

By creating calculated fields, we can derive new information from the table data. For example, we can create a new
field that calculates a 20% discount for all transactions. Let’s give this a try.

CREATING A FORMULA FIELD

In the previous lesson, we created a filter using a formula expression. We’'ll apply the same concept in this lesson to
add a new column to our table.

STEPS:
1. Select Table Design L? to activate the Table Design interface and then click Add > Formula Field =z from

the Table Design ribbon.

The Formula Fields Definition window displays.
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Design

v % = @ 5 & E
Accept  Cancel Add Duplicate Delete External  Field
v Lookups List
Formula Fields ~ I General Formula
L P
55 Formula Field Field Properties
Name: Formula Field
Type: Character
Size: 0 5
Format: General
Display Width: (20 &
Alignment; Left
Hidden
Data Preview
Account Number Customer Order Number  Ship Date
1 11887 | Betty's Music Store 336017 4/10/2010
2 11887 Betty's Music Store 536017 4/10/2010
3 11887 Betty's Music Store 536017 4/10/2010
4 11887 Betty's Music Store 536017 4/10/2010
5 11887 Betty's Music Store 536039 4/21/2010
6 11887 Betty's Music Store 336039 4/21/2010
7 11887 Betty's Music Store 536039 4/21/2010
8 11887 Betty's Music Store 336039 4/21/2010
9 11887 Betty's Music Store 536039 4/21/2010
10 17959 Big Shanty Music 536016 4/5/2010
4

ccaunt Number - Numeric - Append {Account Number Level)

Media
D
(s0]
co
DVD
co
D
[#»)
LP
DVD
(]

Input
Fields

Formula  Lookup Runtime
Figlds Fislds  Parameter Fields

Oty Description
4 Bartok, Sonata for Solo Violin
7 Mozart, Mass in €, K.427
2 Luening, Electronic Music
9 Scarlatti, Stabat Mater

11 Beethoven, Pathetique Sonata, Arau
8 Mendelssohn, War March of the Priests

10 Pizzetti, Messa di Requiem

6 Misc., Modern Trombone Masterpieces
6 Gershwin, An American in Paris
6 Stravinsky, Dumbarton Oaks Concerto

2 v ¥ = K
User Edit Filters Sorts Address. Functions
Fields Blocks

Label Number UnitPrice. Amount Formula Field

MK-42625 8.99 35.96 null

420831-2 9.00 63.00 null

CD 611 10.19 20.38 null

SBT 48282 5.99 53.91 null

420153-2 5.89 65.89 null

SMK 47592 8.99 71.92 null

CHAN 8964 9.59 95.90 null

ADA 581087 10.79 64.74 null

ACS 8034 5.99 35.94 null

SMCD 5120 8.99 53.94 null

2

Help

Q

Filter: No Filter Sort No St 100Rows 100 — ————+

Figure 12-2. The Formula Field Definition window.

In the General tab of the window, enter Discount in the Name box and then select the v icon to accept this

name. This name will display as the field name when the results of our calculation definition are shown in Table

Field names may be up to 62 characters in length and may contain uppercase and

lowercase characters, spaces, and punctuation marks. However, periods (.), exclamation
points (1), accent graves (°), and brackets ([ ]) may not appear in any part of the name. As
well, names may not begin with spaces or underscores (). If a name is entered with leading
spaces, the name is accepted but the leading spaces are trimmed.

Since this expression will result in a numeric value, we need to set the appropriate formatting for the field.

From the Type drop-down list, select Numeric.

To define a calculated field, you build a calculated field expression that returns a value to the field. The
calculated field expression appears in the Expression box near the bottom of the Formula tab. Several list boxes
display the field names from the table, arithmetic and logical operators, and functions that you can use in your

To calculate a 20% discount for all transactions, we’ll use the expression,

To build this expression, you could type the expression as it appears above, or you could build it by inserting
components from the list boxes. Let’s start by inserting the Amount field.

2.
view.
NOTE
Enter 2 in the Decimals box.
5. Select the Formula tab.
calculated field expressions.
Amount*0.2
6.
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Double-click on the Amount field in the Fields box.
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The Amount field is inserted in the Expression box. Double-clicking an item also inserts it into the box
automatically.

7. From the Operators list, double-click the multiplication sign (*) so that it is added to the Expression box.

8. Click on the space beside the * in the Expression box, type 0.2, and then click Apply V
The Data Preview tab should show a new field containing values obtained from the expression we defined.

9. Choose Accept v in the Formula Field Definition ribbon to accept the calculated field definition and close the
window.

A new field name, labeled Discount, is added to the end (far right) of the table.

File Home Report Table Summary Export ?

& Bscect Al | e o v B O s =

@ Zoom To Fit [ ¢q Show Field Fi
¥4 Autosize Columns " eport Data View

Design
Home  Report View m v

Tables s v Account Number Customer Ship Date Media Qty Description Amount Discount -
1 fe) 1 11887 Betty's Music Store 4/10/2010 (o] 4 Bartok, Sonata for Solo Violin 35.96 7.19
2 11887 Betty's Music Store 4/10/2010  CD 7 Mozart, Mass in C, K.427 63.00 12.60
Main 3 11887 Betty's Music Store 4/10/2010  CD 2 Luening, Electronic Music 20.38 4.08
4 11887 Betty's Music Store 4/10/2010  DVD 9 Scarlatti, Stabat Mater 53.91 10.78
5 11887 Betty's Music Store 4/21/2010 (D 11 Beethoven, Pathetique Sonata, Arau 65.89 13.18
6 11887 Betty's Music Store 4/21/2010  CD 8 Mendelssohn, War March of the Priests 71.92 14.38
7 11887 Betty's Music Store 4/21/2010  CD 10 Pizzetti, Messa di Requiem 95.90 19.18
8 11887 Betty's Music Store 4/21/2010  LP 6 Misc.,, Modern Trombone Masterpieces 64.74 12.95
9 11887 Betty's Music Store 4/21/2010  DVD 6 Gershwin, An American in Paris 35.94 7.19
10 17959 Big Shanty Music 4/5/2010 (o)) 6 Stravinsky, Dumbarton Ozks Concerto 53.94 10.79
1 17950 Big Shanty Music 4/5/2010 (D 1 Schubert, Sonata in &, D.566 2.00 1.80
12 17959 Big Shanty Music 4/5/2010 (o)) 3 Mozart, Symphony No.23 in D 26.97 5.39
13 17950 Big Shanty Music 4/5/2010 (D 6 Schoenberg, Ode to Napoleon 57.54 11.51
14 17959 Big Shanty Music 4/14/2010 D 2 Shostakovich, 24 Preludes for piano. 10.78 216
15 17950 Big Shanty Music 4/14/2010  SACD 9 Balakirev,Symphony no. 1 86.31 17.26
16 17959 Big Shanty Music 4/14/2010 DVD 5 Holst, St. Paul's Suite for Orch, 29.95 5.99
17 10929 Bluegrass Records 4/10/2010 (D 3 Faure, 28 Songs, Stulzmann 53.04 10.79
18 10929 Bluegrass Records 4/10/2010 (] 3 Takemitsu, Music of Takemitsu 10.80 2.16
19 10929 Bluegrass Records 4/10/2010 (D 6 Messiaen, Quatour pour Iz fin de temps 57.60 1152
20 10929 Bluegrass Records 4/10/2010  SACD 8 Strauss, Ein Heldenleben, Op.40 71.92 14.38
pal 10929 Bluegrass Records 4/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO 53.91 10.78
2 18635 Musique du Monde 4/1/2010 ) 10 Milhaud, 3 Rag Caprices, pn. & orch. 96.00 19.20
= 18635 Musigue du Monde 4/1/2010 (o] 5 Strauss, Le bourgeois gentilhomme 48.00 9.60
24 18635 Musique du Monde 4/1/2010 ) 5 Scriabin, Preludes, Op. & 38.05 7.79
25 18635 Musigue du Monde 4/1/2010 c© 6 Rogers, Slaughter on Tenth Avenue 57.60 11.52
26 18635 Musique du Monde 4/1/2010 BLU 10 Paganini, 24 Caprices for violin. 95.90 19.18
27 18635 Musigue du Monde 4/1/2010 DvD 8 Vivaldi, Concertos for Recorder 47.92 9.58
28 18635 Musique du Monde 4/10/2010 (D -10 Linek, Epiphany Carol -59.90 -11.98
29 18635 Musigue du Monde 4/10/2010 CD -7 Casell, Paganiniana, NBC SO -63.00 -12.60
30 18635 Musique du Monde 4/10/2010  DVD 11 Lambert, Airs de Courm (1689) -65.89 -13.18

31 18635 Musigue du Monde 4/18/2010 CD 3 Huggett, Suite for Accordian & Pn. 28.77 5.75 -

‘ »
Customer - Character - Append (Customer Level) Filter: No Filter Sort NoSort 140 Rows  100% — ——f——— +

Figure 12-3. Table view with Discount calculated field.

CREATING A USER-EDITED FIELD

Creating User-Edited Fields

Let’s create a user-edited field and see what it can do to a table. Note that user-defined fields are only saved in
project files, not model files.

STEPS:

1. Select Table Design L? to activate the Table Design interface and then click Add > User Edit Field from the
Table Design ribbon.

The User-Edited Field Definition window displays.
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User Edit Fields. << v I .
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User Edit Fisld Field Properties
Name: User Edit Field
Type: | cheracter
Size:
Format: | General
Display Wigth:
Alignment: |Lett
[] Hidden
Data Preview ~ 1
Account Number Customer Order Number ~ Ship Date  Media Qty Description Label Number Unit Price Amount Discount User Edit Field
1 11887 ] Betty's Music Store 536017 4/10/2010 D 4 Bartok, Sonata for Solo Violin MK-42625 899 3596 7.19
2 11887 Betty's Music Store 536017 4/10/2010 D 7 Mozart, Mass in C, K427 4208312 9.00  63.00 12.60
3 11887 Betty's Music Store 536017 4/10/2010 D 2 Luening, Electronic Music D 611 1019 2038 4.8
4 11887 Betty's Music Store 536017 4/10/2010  DVD 9 Scarlatti, Stabat Mater SBT 48262 599 5391 1078
5 11887 Betty's Music Store 536039 4/21/2010 D 11 Beethoven, Pathetique Sonata, Arau 4201532 599 6580 1318
6 11887 Betty's Music Store 536039 4/21/2010 D 8 Mendelssohn, War March of the Priests SMK 47592 899 7102 1438
7 11887 Betty's Music Store 536039 4/21/2000 @ 10 Pizzetti, Messa di Requiem CHAN 8964 959 9590 19.18
[ 11887 Betty's Music Store 536039 4f21/2000 1P & Misc., Modern Trombone Masterpieces ADA 581087 1079 6474 1295
\Account Number - Numeric - Append (Account Number Level) Fifter: No Fiter Sort NoSort 100 Rows _ 100% — ——f———— +

Figure 12-4. The User-Edited Field Definition window.

Table view displays the new field to the far right of the table.

Change the Display Width of the field to 40 and then click Accept v to save your field.

In the General tab, enter the name Comments and then click the v icon that displays to accept this name.

File Home Report Table Summary Export ?
T4 T | o & i R s 8
Table “Q Zoom To Fit [£] Copy o Search  Goto  Findin ] Show Field
T=ga ¥4 Autosize Calumns Row Report Data View Contents Fanee~
~
Home Report View m ~
Tables o T | Account Number Customer ship Date Media Qty Description Amount Discount Comments -
= o) 1 11887 Betty's Music Store 4/10/2010  CD 4 Bartok, Sonata for Solo Violin 35.96 7.19
) 2 4/10/2010  CD 7 Mozart, Mass in C, K.427 63.00 12.60
Main 3 4/10/2010  cD 2 Luening, Electronic Music 20.38 4.08
4 4/10/2010  DVD 9 Scarlatti, Stabat Mater 53.91 10.78
5 4/21/2010 D 11 Beethoven, Pathetique Sonata, Arau 65.89 13.18
6 11887 Betty's Music Store 4/21j2010 D 8 Mendelssohn, War March of the Priests 7192 14.38
7 11887 Betty's Music Store 4/21/2010 €D 10 Pizzetti, Messa di Requiem 95.90 19.18
8 11887 Betty's Music Store 4/21/2010 P 6 Misc., Modern Trombone Masterpieces 64.74 12.95
9 11887 Betty's Music Store 4/21/2010  DVD 6 Gershwin, An American in Paris. 35.94 7.19
10 17959 Big Shanty Music 4/5/2010 co 6 Stravinsky, Dumbarton Ozks Concerto 53.94 10.79
1 17959 Big Shanty Music 452010 €D 1 Schubert, Sonata in e, D.566 9.00 1.80
12 17959 Big Shanty Music 4/5/2010 €D 3 Mozart, Symphony No.23 in D 26.97 539
13 17959 Big Shanty Music 4/5/2010 €D 6 Schoenberg, Ode to Napoleon 57.54 11.51
14 17959 Big Shanty Music 4/14/2010 CD 2 Shostakovich, 24 Preludes for piano. 10.78 2.16
15 17959 Big Shanty Music 4/14/2010  SACD 9 Balakirev,Symphony no. 1 86.31 17.26
16 17959 Big Shanty Music 4/14/2010  DVD 5 Holst, St. Paul's Suite for Orch. 29.95 5.99
17 10929 Bluegrass Records 4/10/2010 €D 3 Faure, 28 Songs, Stulzmann 53.94 10.79
18 10929 Bluegrass Records 4/10/2010  CD 3 Takemitsu, Music of Takemitsu 10.80 2.16
19 10929 Bluegrass Records 4/10/2010 €D 6 Messizen, Quatour pour Iz fin de temps 57.60 11.52
20 10929 Bluegrass Records 4/10/2010  SACD 8 Strauss, Ein Heldenleben, Op.40 7192 14.38
21 10929 Bluegrass Records 4/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO 53.91 10.78
F7] 18635 Musique du Monde 4/1/2010 €D 10 Milhaud, 3 Rag Caprices, pn. & orch. 96.00 19.20
n 18635 Musique du Monde 4/1/2010 €D 5 Strauss, Le bourgeois gentilhomme 48,00 9.60
2% 18635 Musique du Monde 4/1/2010 CD 5 Scriabin, Preludes, Op. 8 28.95 7.79
25 18635 Musique du Monde 4/1/2010 €D 6 Rogers, Slaughter on Tenth Avenue 57.60 11.52
26 18635 Musique du Monde 4/1/2010  BLU 10 Paganini, 24 Caprices for violin. 95.90 19.18
27 18635 Musique du Monde 4/1/2010 DvD 8 Vivaldi, Concertos for Recorder 47.92 9.58
28 18635 Musique du Monde 4/10/2010 €D -10 Linek, Epiphany Carol -59.90 -11.98
29 18635 Musique du Monde 4/10/2010 D -7 Casella, Paganiniana, NBC SO -63.00 -12.60
30 18635 Musigue du Monde 4/10/2010  DVD -11 Lambert, Airs de Courm (1689) -65.89 -13.18
31 18635 Musique du Monde 4/18/2010 €D 3 Huggett, Suite for Accordian & Pn. 28.77 575 -
1 »
Description - Character - Detail (Line [tem Detail) Filter: No Filter Sorz MoSort  149Rows  100% ———#———+
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Using User-Edited Fields

STEPS:

1.

Double-click on the first cell of the Comments field (Row 1).

Note that the interface changes and the cell you selected becomes editable.

Design

v

Apply

Account Number Customer ShipDate  Media Qty Description Amount |
1 11887 Betty's Music Store 4/10/2010  CD 4 Bartok, Sonata for Solo Violin 35.96
2 11887 Betty's Music Store 4/10/2010  CD 7 Mozart, Mass in C, K427 63.00
3 11887 Betty's Music Store 4/10/2010 (D 2 Luening, Electronic Music 20.38
4 11887 Betty’s Music Store 4/10/2010  DVD 9 Scarlatti, Stabat Mater 53.91 3
5 11887 Betty's Music Store 4/21/2010 (ov) 11 Beethoven, Pathetique Sonata, Arau 65.89 13.18
6 11887 Betty's Music Store 4/21/2010 (ov] 8 Mendelssohn, War March of the Priests 71.92 14.38
7 11887 Betty's Music Store 4/21/2010  CD 10 Pizzetti, Messa di Requiem 95.90 19.18
8 11887 Betty's Music Store 4/21/2010  LP 6 Misc., Modern Trombone Masterpieces 64.74 12.95
9 11887 Betty's Music Store 4/21/2010  DVD 6 Gershwin, An American in Paris 35.94 7.19
10 17959 Big Shanty Music 4/5/2010 (o] 6 Stravinsky, Dumbarton Ozks Concerto 53.94 1079
11 17959 Big Shanty Music 4/5/2010 o 1 Schubert, Sonata in &, D.566 9.00 1.80
12 17959 Big Shanty Music 4/5/2010 o 3 Mozart, Symphony No.23 in D 26.97 539
13 17959 Big Shanty Music 4/5/2010 (o] 6 Schoenberg, Gde to Napoleon 57.54 1151
14 17959 Big Shanty Music 4/14/2010 €D 2 Shostakovich, 24 Preludes for piano. 1078 216
15 17959 Big Shanty Music 4/14/2010  SACD 9 Balakirev,Symphony no. 1 86.31 17.26
16 17959 Big Shanty Music 4/14/2010  DVD 5 Holst, St. Paul's Suite for Orch. 29.95 5.99
17 10929 Bluegrass Records 4/10/2010 D 3 Faure, 26 Songs, Stulzmann 53.94 1079
18 10929 Bluegrass Records 4/10/2010  CD 3 Takemitsu, Music of Takemitsu 10.80 2.16
19 10929 Bluegrass Records 4/10/2010 (os) 6 Messiaen, Quatour pour |3 fin de temps 57.60 11.52
20 10929 Bluegrass Records 4/10/2010 SACD 8 Strauss, Ein Heldenleben, Op.40 71.92 14.38
21 10929 Bluegrass Records 4/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO 53.91 10.78
22 18635 Musique du Monde 4/1/2010 o] 10 Milhaud, 3 Rag Caprices, pn. & orch. 95.00 19.20
23 18635 Musigue du Monde 4/1/2010 (o] 5 Strauss, Le bourgeois gentilhomme 48.00 9.60
24 18635 Musigue du Monde 4/1/2010 (o] 5 Scriabin, Preludes, Op. 8 38.05 7.79
25 18635 Musique du Monde 4/1/2010 o 6 Rogers, Slaughter on Tenth Avenue 57.60 11.52
26 18635 Musique du Monde 4/1/2010 BLU 10 Paganini, 24 Caprices for violin. 95.90 19.18
27 18635 Musique du Monde 4/1/2010 DVD 8 Vivaldi, Concertos for Recorder 47.92 9.58
28 18635 Musique du Monde 4/10/2010 (D -10 Linek, Epiphany Carol -59.90 -11.98
29 18635 Musique du Monde 4/10/2010  CD -7 Casella, Paganiniana, NBC SO -63.00 -12.60
30 18635 Musique du Monde 4/10/2010  DVD -11 Lambert, Airs de Courm (1689) -65.89 -13.18
31 18635 Musigue du Monde 4/18/2010  CD 3 Huggett, Suite for Accordian & Pn. 28.77 5.75
32 18635 Musique du Monde 4/18/2010 (D 9 Peterson, Quartet No. 1 for Strings 43.11 8.62
33 18635 Musique du Monde 4/18/2010 (D 4 Ricci, Crispino e la Comare
‘Comments - Character - Calculated: User-edited Fiter- No Filter Sort No Sort  149Rows  100% — —f——— +
Figure 12-6. Activating the user-defined field.
In the cell, type in “New delivery 10/2024” and then click Apply.
The table is refreshed and the text you added displays.
File Home Report Table Summary Export ?
B SelectAl | it o IS’ G a
Table @ Zoom To Fit [£] Copy o, Search  Goto  Findin Rebuild Show Field Freeze
=50 Autosize Columns Eos feec Data View Contents Fones
Home Report View m
Fim v Account Number Customer ipDate  Media Qty Description Amount Discourft Comments
\T\ o) 1 11887 | Betty's Music Store 4/10/2010  CD 4 Bartok, Sonata for Solo Violin 35.96 7.1p New delivery 10/2024
- 2 11887 Betty's Music Store 4/10/2010  CD 7 Mozart, Mass in C, K.427 63.00 12.
Main 3 11887 Befty's Music Store 4/10/2010  CD 2 Luening, Electronic Music 20.38 4.08
4 11887 Befty's Music Store 4/10/2010  DVD 9 Scarlatti, Stabat Mater 53.91 10.78
5 11887 Betty's Music Store 4/21/2010  CD 11 Beethoven, Pathetique Sonata, Arau 65.89 13.18
6 11887 Betty's Music Store 4/21/2010 D 8 Mendelssohn, War March of the Priests. 71.92 14.38
7 11887 Betty's Music Store 4/21/2010  CD 10 Pizzetti, Messa di Requiem 95.90 19.18
8 11887 Betty's Music Store 4/21/2010 P 6 Misc., Modern Trombone Masterpieces 64.74 12.95
9 11887 Betfy's Music Store 4/21/2010 DVD & Gershwin, An American in Paris 35.94 7.19
10 17959 Big Shanty Music 4/3/2010 o] & Stravinsky, Dumbarton Ozks Concerto 53.94 10.79
1 17959 Big Shanty Music 4/5/2010 o 1 Schubert, Sonata in &, D.566 9.00 1.80
12 17959 Big Shanty Music 4/5/2010 o 3 Mozart, Symphony No.23 in D 26.97 5.39
13 17959 Big Shanty Music 4/5/2010 o 6 Schoenberg, Ode to Napoleon 57.54 11.51
14 17959 Big Shanty Music 4/14/2010  CD 2 Shostakovich, 24 Preludes for piano. 10.78 2.16
15 17959 Big Shanty Music 4/14/2010  SACD 9 Balakirev,Sympheny no. 1 86.31 17.26
16 17959 Big Shanty Music 4/14/2010  DVD 5 Holst, St. Paul's Suite for Orch. 20.95 5.99
17 10929 Bluegrass Records 4/10/2010 o 3 Faure, 28 Songs, Stulzmann 53.94 10.79
18 10929 Bluegrass Records 4/10/2010 o 3 Takemitsu, Music of Takemitsu 10.80 2.16
19 10929 Bluegrass Records 4/10/2010  CD 6 Messiaen, Quatour pour |z fin de temps 57.60 11.52
20 10929 Bluegrass Records 4/10/2010  SACD 8 Strauss, Ein Heldenleben, Op.40 71.92 14.38
21 10929 Bluegrass Records 4/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO 53.01 10.78
22 18635 Musique du Monde 4/1/2010 o] 10 Milhaud, 3 Rag Caprices, pn. & orch. 96.00 19.20
3 18635 Musique du Monde 4/1/2010 o 5 Strauss, Le bourgeois gentilhomme 48.00 9.60
24 18635 Musique du Monde 4/1/2010 o 5 Seriabin, Preludes, Op. 8 38.95 7.79
25 18635 Musique du Monde 4/1/2010 D 6 Rogers, Slaughter on Tenth Avenue 57.60 11.52
26 18635 Musique du Monde 4/1/2010 BLU 10 Paganini, 24 Caprices for violin. 95.90 19.18
27 18635 Musique du Monde 4/1/2010 ovVD 8 Vivaldi, Concertos for Recorder 47.92 9.58
28 18635 Musique du Monde 4/10/2010  CD -10 Linek, Epiphany Carol -59.90 -11.98
29 18635 Musique du Monde 4/10/2010  CD -7 Casella, Paganiniana, NBC SO -63.00 -12.60
30 18635 Musique du Monde 4/10/2010 DVD -11 Lambert, Airs de Courm {1689) -65.89 -13.18
31 18635 Musique du Monde 4/18/2010 o 3 Huagett, Suite for Accordian & Pn. 2877 575 A
] ,
Account Number - Numeric - Append [Account Number Level) Filter: No Filter Sort No Sort 149 Rows  100% — ——f————— +

Figure 12-7. The results of modifying a user-define field.
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MAKING COMPARISONS

In the previous section, we created a calculated field using a simple arithmetical expression. Monarch lets you create
more complex expressions involving comparisons. Let's use this feature to calculate a discount only for sales
amounts of US$75.00 or more. Rather than create a new calculated field, we’'ll edit an existing calculated field to
apply our new discount strategy.

STEPS:

1. Select Table Design E’ and then click Formula Fields on the ribbon that displays to launch the Formula Field
window once more.

2. Select Discount from the Formula Field selector and then click on the Formula tab to display its properties.

To apply the discount only for sales amounts of US$75.00 or more, we'll use the IF() function in our calculated
field expression:

If(Amount>=75,Amount*0.2,0)

In plain English, this expression reads, “If the Amount field contains a value of 75 or greater, use the first
expression (Amount*0.2) to calculate a discount, otherwise, use the second expression (0) to show no discount.”

3. Enter the calculated field expression above into the Expression box so that it reads as shown in Figure 12-8 and
then click the Apply v icon that displays subsequently.

_li

If (Amount>=75, Amount*0.2, 0) -

Figure 12-8. The modified Discount calculated field definition.

4. Click Accept v in the Formula Field Definition ribbon to accept the new calculated field definition and close the
window. The field is recalculated to show a discount only for transactions with an amount of $75.00 or more.

Home  Report View m v

Tables wrtsssinsss sy v Account Number Customer Ship Date Media Qty Description Amount Discount | Comments. -
0 ol Betty's Music Store 4/10/2010 D 4 Bartok, Sonata for Solo Violin 35.96 0.00| New delivery 10/2024
2 11887 Betty's Music Store 4/10/2010 (] 7 Mozart, Mass in C, K427 63.00 0.00
Main 3 11887 Betty's Music Store 4/10/2010 CD 2 Luening, Electronic Music 2038 0.00
4 11887 Betty's Music Store 4/10/2010 ovD 9 Scarlatti, Stabat Mater 53.91 0.00
5 11887 Betty's Music Store 4/21/2010 €D 11 Beethoven, Pathetique Sonata, Arau 65.89 0.00
6 11887 Betty's Music Store 4/21/2010 (] 8 Mendelssohn, War March of the Priests 71.92 0.00
7 11887 Betty's Music Store 4{21/2010 (o] 10 Pizzetti, Messa di Requiem 95.90 19.18/
8 11887 Befty's Music Store 4/21/2010  LP 6 Misc., Modern Trombone Masterpieces 64.74 0.00
9 11887 Betty's Music Store 4/21/2010 DVD 6 Gershwin, An American in Paris 35.94 0.00
10 17959 Big Shanty Music 4/5/2010 (D & Stravinsky, Dumbarton Oaks Concerto 53.04 0.00
11 17959 Big Shanty Music 4f5/2010 (D 1 Schubert, Sonata in e, D.566 9.00 0.00
12 17959 Big Shanty Music 4f5/2010 @ 3 Mozart, Symphony Ne.23 in D 26.97 0.00
13 17959 Big Shanty Music 4/5/2010 €D 6 Schoenberg, Ode to Napoleon 57.54 0.00
14 17959 Big Shanty Music 4/14/2010 €D 2 Shostakovich, 24 Preludes for piano. 10.78 0.00
15 17959 Big Shanty Music 414/2010  SACD 9 Balakirev,Symphony no. 1 86.31 17.26
16 17959 Big Shanty Music 4{14/2010 ovD 5 Holst, St. Paul's Suite for Orch. 29.95 0.00
17 10929 Bluegrass Records 4/10/2010 €D 3 Faure, 28 Songs, Stulzmann 53.94 0.00
18 10929 Bluegrass Records 4/10/2010 (] 3 Takemitsu, Music of Takemitsu 10.80 0.00
19 10929 Bluegrass Records 4/10/2010 D 6 Messiaen, Quatour pour [a fin de temps 57.60 0.00
20 10929 Bluegrass Records 4/10/2010  SACD 8 Strauss, Ein Heldenleben, 0p.40 71.92 0.00
21 10929 Bluegrass Records 4/10/2010 DVD 9 Schumann, Manfred Overture, Bav SO 53.91 0.00
2 18635 Musique du Monde 4/1/2010 €D 10 Milhaud, 3 Rag Caprices, pn. & orch. 96.00 19.20
23 18635 Musique du Monde 4/1/2010 €D 5 Strauss, Le hourgeois gentilhomme 48,00 0.00
24 18635 Musique du Monde 4/1/2010 D 5 Scriabin, Preludes, Op. 8 38.95 0.00
25 18635 Musique du Monde 4/1/2010 €D & Rogers, Slaughter on Tenth Avenue 57.60 0.00
26 18635 Musique du Monde 4/1/2010  BLU 10 Paganini, 24 Caprices for violin. 95.90 19.18
27 18635 Musique du Monde 4/1/2010 DvD 8 Vivaldi, Concertos for Recorder 47.92 0.00
28 18635 Musique du Monde 4/10/2010 €D -10 Linek, Epiphany Carol -59.90 0.00
29 18635 Musique du Monde 4/10/2010 €D -7 Casella, Paganiniana, NBC 50 -63.00 0.00
30 18635 Musique du Monde 4/10/2010  DVD 11 Lambert, Airs de Courm (1689) -65.89 0.00
31 18635 Musique du Monde 4/18/2010 €D 3 Huggett, Suite for Accordian & Pn. 28.77 0.00 -
‘ »

Figure 12-9. Updated Discount field.
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Now let's use another Monarch feature to suppress the zero values so that our discount values will appear more
prominent.

5. Select the Home tab, and then click Options °D

The Options window displays.

This window includes several options that control the way data appear in Monarch.
6. Select View to display the View options.

Options

v % @

@ O & i WMoY & 2 2

Accept  Cancel Folders Input View Export  Clipboard  Security  Altair Monarch Time Advanced Cache  Themes Help
Server Library Intervals
View
Data Values Data Preview
Suppress zero values | Automatically Refresh Data Preview
Display null values as: | null | Show Fields From All Templates in Report Design

Show (100 v | rows in data preview

Default Row Height

Other Options
Lines in column title row: 1w
+| Show Splash Screen
Lines in data rows: 1
Graphics

Use software rendering

Figure 12-10. The View Options window.

7. Check the Suppress zero values box.

8. Delete any value indicated in the Display null values as box.

9. Click Accept v in the Options ribbon to close the window and apply your settings to the table data.
The table displays with zero values suppressed.

Home  Report View m v

Tables e o o v 0 Account Number Customer Ship Date Mediz Qty Desription Amount Discount Comments -
T ol Betty's Music Store 4/10/2010 €D 4 Bartok, Sonata for Sola Violin 35.96 New delivery 10/2024
2 11887 Betty's Music Store 4/10/2010 cD 7 Mozart, Mass in C, K.427 63.00
Main 3 11887 Betty's Music Store 4/10/2010  CD 2 Luening, Electronic Music 20.38
4 11887 Betty's Music Store 4/10/2010  DVD 9 Scarlatti, Stabat Mater 53.91
5 11887 Betty's Music Store 4/21/2010 D 11 Beethoven, Pathetique Sonata, Arau 65.80
6 11887 Betty's Music Store 4/21/2010 D 8 Mendelssohn, War March of the Priests 71.82
7 11887 Befty's Music Store 4/21/2010 o 10 Pizzetti, Messa di Requiem 95.90 19.18
8 11887 Betty's Music Store 4/21/2010 P 6 Misc,, Modern Trombone Masterpieces 64.74
9 11887 Betty's Music Store 4/21/2010  DVD 6 Gershwin, An American in Paris 35.94
10 17959 Big Shanty Music 4/5/2010 (o) 6 Stravinsky, Dumbarton Oaks Concerto 53.94
1 17959 Big Shanty Music 4/5/2010 D 1 Schubert, Sonata in e, D.566 9.00
12 17959 Big Shanty Music 4/5/2010 D 3 Mozart, Symphony No.23 in D 26.97
13 17959 Big Shanty Music 4/s/2010 o 6 Schoenberg, Ode to Napoleon 57.54
14 17959 Big Shanty Music 4/14/2010  CD 2 Shostakovich, 24 Preludes for pizno. 10.78
15 17959 Big Shanty Music 4/14/2010  SACD 9 Balakirev,Symphony no. 1 86.31 17.26
16 17959 Big Shanty Music 4/14/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29.95
17 10929 Bluegrass Records 4/10/2010 D 3 Faure, 28 Songs, Stulzmann 53.94
18 10929 Bluegrass Records 4/10/2010 D 3 Takemitsu, Music of Takemitsu 10.80
19 10929 Bluegrass Records 4/10/2010  CD 6 Messizen, Quatour pour la fin de temps 57.60
20 10929 Bluegrass Records 4/10/2010  SACD 8 Strauss, Ein Heldenleben, 0p.40 71.82
21 10929 Bluegrass Records 4/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO 53.91
n 18635 Musique du Monde 4/1/2010 D 10 Milhaud, 3 Rag Caprices, pn. & orch. 96.00 19.20
3 18635 Musique du Monde 4/1/2010 o 5 Strauss, Le bourgeois gentilhomme 48.00
24 18635 Musique du Monde 4/1/2010 o 5 Scriabin, Preludes, Op. 8 38.95
25 18635 Musique du Monde 4/1/2010 D & Rogers, Slaughter on Tenth Avenue 57.60
26 18635 Musique du Monde 4/1/2010  BLU 10 Paganini, 24 Caprices for violin. 95.90 19.18
27 18635 Musique du Monde 4/1/2010 DVD 8 Vivaldi, Concertos for Recorder 47.92
28 18635 Musique du Monde 4/10/2010 D -10 Linek, Epiphany Carol -59.90
29 18635 Musique du Monde 4/10/2010 CD -7 Casella, Paganiniana, NBC SO -63.00
30 18635 Musique du Monde 4/10/2010  DVD -11 Lambert, Airs de Courm (1689) -65.80
31 18635 Musique du Monde 4/18/2010 D 3 Huggett, Suite for Accordian & Pn. 28.77 ~
‘ »

Figure 12-11. Zero values suppressed.
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At this point, you can opt to either save your work or simply close the report and model files you opened for this
lesson. For now, simply close all open files.

REDACTION FUNCTIONS

Monarch supports a set of redaction functions for use in calculated field expressions. These functions appear in the
Redaction section in the Functions list box of the formula editor, as shown below. See the Monarch Help file for more
information on these functions.

Redaction e
RedactBankNumber()

RedactDigitsWithConsistentAlias()

RedactMHS()

RedactSSMN{)

RedactStrikeout(,)

RedactStrikecutDigits(,)

RedactTextWithConsistentAlias()

Figure 12-12. Several redaction functions are available in the formula editor.

REGEX FUNCTIONS

Besides redaction functions, Monarch also supports a number of Regex functions. The Monarch Help file contains
more information on these functions.

All Functions Bt
RedactTextWithConsistentilias() -
RegexExtract(,)
RegexlsMatch()

RegexReplace(,)
RegexSplit(,)

Replace(,)
Right()
Roundf(} -

Figure 12-13. Regex functions available in the formula editor.
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HIDING AND DELETING CALCULATED FIELDS

You can temporarily turn off the display of a calculated field by hiding it. Monarch will still re-calculate the hidden field
while you make other changes to the table. However, if your calculated field expression is computationally intensive,
this can slow down the display of the table.

Of course, you can get rid of a calculated field altogether by deleting it altogether. When you delete a calculated field,
the field is removed from the table and the calculated field definition is deleted.

To delete a calculated field, launch the Formula Field Definition window, and then select the name of the calculated
field you wish to delete. Select Delete from the ribbon. Be careful to select the correct field name — Monarch has no
undo facility for deleted objects.

DUPLICATING CALCULATED FIELDS

You may want to create a new calculated field that closely resembles a calculated field you previously defined. An
(+)
easy way to do this is by using the Duplicate El button. To duplicate a calculated field, simply select the calculated

field you want to duplicate from the Calculated Fields list and then select Duplicate 4 from the Table Design
ribbon. The duplicated calculated field appears on the Calculated Fields list; this calculated field will have the name of
the field you duplicated and a number appended to it. Select this calculated field to display its properties in the
Calculated Field Definition window and make further revisions to it. Select Accept when you are finished to accept
and save your new calculated field definition.
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[13] WORKING WITH MULTIPLE
INSTANCES OF A REPORT

In the previous chapters, we've worked with only one report at a time. In this chapter, you will learn how to open and
analyze data from multiple reports. The lesson topics include:

0O  Analyzing data from a series of reports

Opening multiple instances of a report

0  Extracting data
0 Working in the Table view
0 Creating a summary to analyze data from multiple reports

In most organizations, reports are run on a regular basis -- typically weekly or monthly. Each instance of a report
contains information about a specific period of time.

In addition to producing a new report each week or month, some organizations produce a separate report for each
department, division or region. For example, a retailer might divide its market into four distinct regions: Northeast,
Central, South and West. A monthly sales report is generated for each region.

ES e

Figure 13-1. Each report includes information for a specific region.

Each instance of the report contains useful sales information for a single region, but it does not tell you how a
particular product is selling nationally. For that, you will need to analyze data from all four regions. With Monarch, you
can open all four regional reports and create a summary showing sales of the product within each region with a grand
total for all four regions. The resulting summary might look like Figure 13-2.

PRODUCT REGION AMOUNT
1 M17 Mtn Bike Central 94266
2 Mortheast 94954
3 South 83782
4 West 100937
5 |Total | 373939

Figure 13-2. Comparing product sales across four regions.

By analyzing data from all four regional sales reports, you can compare sales results for each region. Since each
sales report is generated on a monthly basis, our analysis compares sales for only a single month. We can add
another dimension by opening several monthly sales reports for each region. Figure 13-3 compares sales results by
region broken down by month for a three-month period.
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PRODUCT REGION 19960501 19960601 19960701 Total
1 M17 Min Bike  Central 94266 92024 03043 281133
2 Northeast 94954 96322 03452 284728
3 South 83782 85625 86883 256290
4 West 100937 97349 99750 298036
5 373939 372220 374028 1120187

Figure 13-3. Comparing product sales across four regions for a three-month period.

To create this summary, we opened a total of 12 reports — 3 monthly reports for each of 4 regions (see Figure 13-4).

april April April April
MNortheast Central South W est

Manfl | Manfl Ma',' _ Ma','
Martheast Central South Wi e st

June_ June June June
Mortheast Central South West

Figure 13-4. Each report contains information for a specific region and time period.

As we've seen, each report contains only a piece of the overall puzzle. However, taken together, these same reports
can reveal a wealth of information about your business.

In the previous chapters, you've become familiar with the Classic.prn report. Classic.prn is a periodic report produced
on a monthly basis. Each report contains shipments of classical music recordings for a single month. For this lesson,
we've provided three instances of the Classic report representing shipments for the months of January, February, and
March.

When you load a model file or create a new model, Monarch applies the model parameters to all open reports. Data
extracted from each report is concatenated in the Table view.

NOTE Although you can open multiple report files at the same time, Monarch allows you to open
only a single model file. The model file is automatically applied to all open reports. Thus, all
reports must have the same format. For example, although the shipping reports used in this
lesson all contain different data, they all share the same structure. You cannot extract data
from two different types of reports at the same time.

Let's get started by opening ClassJan.prn, ClassFeb.prn, and ClassMar.prn as well as Lesson5.dmod. Go on to
Table View and select Autosize Columns ** to maximize your view all of the fields.
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WORKING IN TABLE VIEW

Working with data from multiple reports is virtually the same as working with data from a single report. You can view,
sort, filter, export and print the data just as though it were extracted from a single report. There are, however, a few
differences that should be examined.

Sorting

Initially, the data are arranged in the order that the report files were opened. Since we opened the January report first,
the January records appear first in the table followed by February and then March. This initial order has no particular
relevance. In fact, it may not be desirable at all. By arranging the records this way, Monarch may be violating the
natural sort order of the reports. For example, each of our shipping reports is sorted by customer and then by ship
date. By concatenating the records from all three reports, we’'ve added a higher sort level. Now the data are sorted by
period (month) and then, within months, by customer and ship date. Let’s restore the original sort order found in the
reports.

STEPS:

1. From the Table ribbon, select Table Design L? to launch the Table Design interface and then click Add > Sort
The Sort Order Definition window displays.

Design

v % 5 A s & m T W o 2 YV ¥ m A ?
External Field Input Formula Lookup Runtime User Edit Filters Sorts Address Functions Help
Lookups List Fields Fields Fields Parameter Fields Fields Blocks

Accept  Cancel Add Duplicate Delete

Sorts v R SortProperties .
(] L

= Name: | Sort Make this the active sort
JF sort

Available Fields: Selected Fields:

Amount Field Order
Customer Clear
Description
Label Number Add >>
Media
Quantity
Report Date
Ship Date
Unit Price

<< Remaove

Right click on a sort field to
change its order or position,

Report Date  Customer Ship Date Media Quantity Description Label Number Unit Price Amount -
1 Betty's Music Store 1/10/2010 €D 4 Bartok, Sonata for Solo Violin MK-42625 899 3506
2 2/1f2010 Betty's Music Store 1/10/2010 (2] 7 Mozart, Mass in C, K.427 420831-2 9.00  63.00
3 2/1/2010 Betty's Music Store 1/10/2010 €D 2 Luening, Electronic Music CD 611 1019 2038
4 2/1/2010 Betty's Music Store 1/10/2010  DVD 9 Scarlatti, Stabat Mater SBT 48282 599 5391
5 2/1/2010 Betty's Music Store 1/21/2010 D 11 Beethoven, Pathetique Sonata, Arau 420153-2 599 6589
6 2/1/2010 Betty's Music Store 1/21/2010  CD 8 Mendelssohn, War March of the Priests SMK 47592 B899 7192
7 2/1/2010 Betty's Music Store 1/21/2010 €D 10 Pizzetti, Messa di Requiem CHAN 8964 959 95.90
8 2/1/2010 Betty's Music Store 1/21/2010 P 6 Misc., Modern Trombone Masterpieces ADA 581087 1079 6474
9 2/1/2010 Betty's Music Store 1/21/2010  DVD 6 Gershwin, An American in Paris ACS 8034 589 3594

:O 2/1/2010 Bluearass Records 1/10/2010 __ CD 3 _Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 33.94 5 _

Report Date - Date/Time - Page Header (Page Header) Filtsr: No Flter Sor=Sort  100Rows  100% — —f——————+

Figure 13-5. The Sort Order Definition window.

2. Type Original Sort Order in the Name box and then click the v icon that displays next to this field to accept
your name.
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Select the Customer field from the Available Fields box then click the Add >> button.
Select the Ship Date field from the Available Fields box then click the Add >> button.

5. Select Accept v in the Sort Definition ribbon to accept your changes.
6. Once back in Table view, select Original Sort Order from the Active Sort drop-down list.

7. Select Autosize Columns *2* from the Table tab to view all the fields properly.

The table is rebuilt, sorted by customer and then by ship date.
File Home Report  Table Summary Export ?

. R = o | = =
Q Zoom To Fit 7] Copy - j ShowField  Fresze

Ei= Active Sort: - Search  Goto  Findin Rebuild

Desion | Original Sort Order o B ) Contents Pomesv

¥4 Autosize Columns

Home  Reportvien  [[URTIRE v
Report Date  Customer ShipDate  Media  Quantity Description Label Number Unit Price  Amount -
(oy)
)

H 1 Betty's Music Store 1/10/2010 4 Bartok, Sonata for Solo Violin MK-42625 899 3596
2 212010 Befty's Music Store 1/10/2010 (D 7 Mozart, Mass in C, K.427 420831-2 9.00 63.00
Main 3 2/1/2010 Betty’s Music Store 1/10/2010 D 2 Luening, Electronic Music D 611 1019 2038
4 212010 Befty's Music Store 1/10/2010 DVD 9 Scarlatti, Stabat Mater SBT 48282 599 5391
5 2/1/2010 Betty's Music Store 1/21/2010 D 11 Besthoven, Pathetique Sonata, Arau 420153-2 500 6580
6  2/1/2010 Betty's Music Store 1/21/2010 (o] 8 Mendelssohn, War March of the Priests SMK 47592 899 7192
7 2172010 Befty's Music Store 1212010 (D 10 Pizzefti, Messa di Requiem CHAN 8964 9.59  95.90
8  2/1/2010 Befty's Music Store 1/21/2010 L 6 Misc., Modern Trombone Masterpieces ADA 581087 10.79 6474
9 2/1/2010 Betty's Music Store 1/21/2010 DvD 6 Gershwin, An American in Paris ACS 8034 589 3594
10 4/1/2010 Betty's Music Store 3/4/2010 (D 6 Schoenberg, Ode to Napoleon CHAN 9116 050 57.54
11 4/1/2010 Betty's Music Store 3/4/2010 o)) 2 Shostakovich, 24 Preludes for piano. CDA 66620 539 1078
12 4/1/2010 Befty's Music Store 3/4/2010 D 3 Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 53.94
13 4/1/2010 Betty's Music Store 3/42010 D 1 Haydn, Mass in d, “Nelson Mass" 26560 0.60  0.60
14 4/1/2010 Betty's Music Store 3/4/2010 o] 6 Schubert, Marche militaire in D TROY 069 1020 6120
15 4/1/2010 Betty's Music Store 3/4/2010 BLU 1 Nietzsche, Piano Music BLU 85513 5.99 5.99
16  4/1/2010 Betty's Music Store 3/4/2010 DVD 2 Handel, Royal Fireworks Music, Previn 4XG-60276 599 1198
17 4/1/2010 Betty's Music Store 3/4/2010 DVD 5 Britten, War Requiem 2-DBTD 2032 1138 53.90
18  3/1/2010 Big Shanty Music 2/4/2010 o)) 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 899 53.94
19 3/1/2010 Big Shanty Music 2/4/2010 o) 1 Schubert, Sonata in e, D.566 A5-325 9.00  9.00
20 3/1/2010 Big Shanty Music 2/42010 D 3 Mozart, Symphony No.23 in D Co-77884 899 2697
21 3(1/2010 Big Shanty Music 2/4/2010 o)) 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59 57.54
22 | 3(1/2010 Big Shanty Music 2/13/2010 (D 2 Shostakovich, 24 Preludes for piano. CDA 66620 539 1078
2 3/1/2010 Big Shanty Music 2/13/2010  SACD 9 Balakirev, Symphony no. 1 ENTPD 4110 0.50 8631
24 | 3/1/2010 Big Shanty Music 2/13/2010 DVD 5 Holst, St. Paul's Suite for Orch CBT-1020 599 2395
25 1 2/1/2010 Bluegrass Records 1/10/2000 D 3 Faure, 28 Songs, Stulzmann RCA 61429-2 17.98 5394
26 2/1/2010 Bluegrass Records 1/10/2010 (o] 3 Takemitsu, Music of Takemitsu SMK 53473 3.60 10.80
27 | 2/1/2010 Bluegrass Records 1/10/2010 D 6 Messiaen, Quatour pour la fin de temps €DC 54935 9.60 57.60
28 2/1/2010 Bluegrass Records 1/10/2010  SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 899 7192
29 2/1/2010 Bluegrass Records 1/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO SBT 48270 599 5391
30 4/1/2010 Bluegrass Records 3/10/2010 €D 7 Hanson, Lament for Beowulf DE 3150 500 4103
31 4/1/2010 Bluegrass Records 3/10/2010 €D 4 Chopin, 24 Etudes, Wild 77 899 3596
32 4/1/2010 Bluegrass Records 3/10/2010  SACD 2 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 899 17.98
33 4/1/2010 Bluegrass Records 3/10/2010  SACD 3 Besthoven, 3rd Sym, Karajan, Berlin 410049-2 BLU 0.00 27.00
34 4/1/2010 Bluegrass Records 3/10/2010 DVD 3 Saint-Saens, Danse macabre ACS 8058 590 17.07 -
‘ »
fl=port Dats - Date/Time - Page Header (Pags Header) Filter: No Fifter Sort- Original Sort Order 272 Rows  100% — —f——— +

Figure 13-6. Original Sort Order sorts all of the data extracted from all three open reports.

By using Customer as the first sort field, Monarch groups all the records from each customer together,
regardless of which report each record was extracted from (note the highlighted ship dates for Betty’s Music
Store which range from January 10th through March 4th - spanning all three reports).

Identifying the Source of Each Record

There are times when you will need to know from which report each record is extracted. You may want to apply a
filter that excludes some or all of the records from one or more reports or create a summary that generates subtotals
broken down by period. In either case, Monarch will need to be able to identify the source report for each record.

Sometimes, this information is available within the reports. In our shipping reports, each page header contains the
date the report was printed. By extracting this information as a field, you can easily identify the source of each record.
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02/01/10 | MUSIC DISTRIBUTORS
' MONTHLY SHIPPING REFORT
m%ll FROM 01/004°10 TO 01531710
lD3fEIl.’1EI i JSIC PISTRIBUTORS PAGE 03
Tﬂm_l MONTHLY SHIPPING REPCRT
M5RI4 FROM 02/01/10 T¢ 02/28/10
04/01/10 I MUSIC |DISTREBUTORS PRGE D4
T MONTHLY| SHIPPING REPORT
MERI4 FROM 03/P1/10 T0 03/p1/10
101 |02/01/2010
CUSTOMER: Fandangos Records 102 |02/01/2010
555 Elissbeth 1530 02;{]1‘{2010
San Antonio, TH 78250
ush 104 |02/01/2010
105 [02/01/2010 |
RCCOUNT NUMBER: 17658 106
107 |03/01/2010
CONTACT: Lionel Sampson 108 03/01/2010
109 |03/01/2010
MEDIA ¢TY DESCRIPTICN LABEL/No.  UNT_§ 110 |03/01/2010
RETURN AUTHORIZATION: RAS045 RECEIVED: 03/10/10 Lt
112 |04/01/2010
cD -4 Dvorak, Vanda oOverture, Elovsk PO a 0420 51.113,004/01/2010
ovD -2 Cowell, Adagio for wc & Thunderstick TP 685-1 5 114 D‘HUI}'ZDIO
115 |04/01/2010
ORDER NUMBER: 3536249 SHIF DATE: 03/26/10
<96
[s41] 9 Seeger, Diaphonic Suite 999-116 7.79 70.11 fE 04
2 Handel, Il pastor fido{opera) 2-HCD12912 10.78 21.56
2 Brahms, Chorale Preludes for Organ CHAN-8410 9.59 19.18
O04/01/10 CLASSICAL MUSIC DISTRIBUTORS PRGE D5
10:17 MONTHLY SHIPPING REPORT
M5SR4 FROM 03/01/10 TO 03/31/10

17658
17658
17658
17658
17658
17658
17658
17658
17658
17658
17658
17658
17658
17658
17658

Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records
Fandangos Records

01/28/2010
01/28/2010
01/28/2010
01/28/2010
01/28/2010
02/04/2010
02/27/2010
02/27/2010
02/27/2010
02/27/2010
03/10/2010
03/10/2010
03/26/2010
03/26/2010
03/26/2010

Figure 13-7. The report run date is included in the page header.

For reports that lack a run date or other unique identifying information, Monarch provides a pair of functions - File()

and ID() - that you can use to identify the source of each record.

The File() Function

The File() function returns the path and filename of the report file from which each record was extracted. For

example, for records extracted from the ClassJan.prn file, the File() function would return the value
"C:\Reports\ClassJan.prn”, assuming that ClassJan.prn is located in the \Reports folder on drive C.

Let’'s create a calculated field using the File() function.

STEPS:

1. From the Table ribbon, select Table Design W to launch the Table Design interface and then click Add >

Formula Field.

The Formula Field Definition window displays.

o g kM WD

7. Select the Apply v icon that appears in the Expression box to save the newly defined field and then click

Accept

Enter 65 in the Size box.
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From the Type drop-down list, select Character.

in the window’s ribbon to close it.

Enter 60 in the Display Width box and then select the Formula tab.

Double-click on the File() function from the Functions list so that it is added to the Expression box.

In the Name box, type Filename and then click the ¥ icon that displays beside the field to accept your name.
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The new field is added to the end of the table.

Home  Report View M

Tables
A P
Main

L@ NG AW e

10
1
12
13

15
16
17
18
19

21
2
23
24
25
26
27

29
30
k|
32
3

Quantity

ENNIEIES

1

®

10

=

W MBS O ®meWWm e Mo WL o NN G LWL NS o

Description

Bartok, Sonata for Solo Vielin

Mozart, Mass in C, K.427

Luening, Electronic Music

Scarlatti, Stabat Mater

Beethoven, Pathetique Sonata, Arau
Mendelssohn, War March of the Priests
Pizzetti, Messa di Requiem

Misc., Modern Trombone Masterpieces
Gershwin, An American in Paris
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Faure, 28 Songs, Stulzmann

Haydn, Mass in d, “Nelson Mass™
Schubert, Marche rein D
Nietzsche, Piano Music

Handel, Royal Fireworks Music, Previn
Britten, War Requiem

Stravinsky, Dumbarton Oaks Concerto
Schubert, Sonata in e, D.566

Mozart, Symphony No.23 in D
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Balakirev, Symphony no. 1

Holst, St. Paul's Suite for Orch.

Faure, 28 Songs, Stulzmann
Takemitsu, Music of Takemitsu
Messizen, Quatour pour la fin de temps
Strauss, Ein Heldenleben, Op.40
Schumann, Manfred Overture, Bav SO
Hanson, Lament for Beowulf

Chopin, 24 Etudes, wild

Strauss, Ein Heldenleben, Op.40
Beethoven, 3rd Sym, Karajan, Berlin
Saint-Saens, Danse macabre

Label Number
MK-42625
420831-2

CD 611

SBT 48282
420153-2
SMK 47592
CHAN 8964
ADA 581087
ACS 8034
CHAN 9116
CDA 66620
RCA 61428-2
26560

TROY 069
BLU 85513
4XG-60276
2-DBTD 2032
SMCD 5120
AS-325
CO-77884
CHAN 9116
CDA 66620
ENTPD 4110
CBT-1020
RCA 61428-2
SMK 53473
CDC 54935
SMSACD-5036
SBT 48270
DE 3150
77
SMSACD-5036
419049-2 BLU
ACS 8058

Unit Price
8.99
2.00

10.19
5.99
5.99
8.99
9.59

10.79
5.99
9.59
5.39

17.98
9.60

10.20
5.99
5.99

11.98
8.99
9.00
8.99
9.59
5.39
9.59
5.99

17.98
3.60
9.60
8.99
5.99
5.99
8.99
8.99
9.00
5.99

Amount|
35.96|
63.00]
20.38|
53.91
65.89]
71.92|
95.90|
64.74]
35.94|
57.54|
10.78
53.94]

9.60
61.20]

5.99
11.98
59.90|
53.94|

9.00
26.97|
57.54|
10.78
86.31
29.95]
53.94]
10.80
57.60]
71.92|
53.091
41.93
35.96|
17.98
27.00|
17.97

Filename

C:\Users\Public\Documents\Altair Monarch\Reports\ClassJan.prm
C:\Users\Public\Documents\Altair Monarch!\Reports\ClassJan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassJan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\Classlan.prn
C:\Users\Public\Documents\Altair Monarch!\Reports\ClassJan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\Classlan.pm
C:\Users\Public\Documents\Altair Monarch\Reports\Classlan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassJan.prm
C:\Users\Public\Documents\Altair Monarch\Reports\Classlan.pm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.pm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar. prm
C:\Users\Public\Documents\Altair Monarch\Reporis\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassFeb.pm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassFeb.pm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassFeb.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassFeb.prn
C:\Users\Public\Documents\Altair Monarch\Reporis\ClassFeb.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassFeb.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassFeb.pm
C:\Users\Public\Documents\Altair Monarch\Reperts\ClassJan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassJan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\Classlan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassJan.prn
C:\Users\Public\Documents\Altair Monarch\Reports\Classlan.pm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar. prm
C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.prn

C:\Users\Public\Documents\Altair Monarch\Reports\ClassMar.pr

Figure 13-8. The Filename field, including the path.

For each record, the Filename field returns the entire path and filename of the report from which the record was

extracted. Let’s use another function to reduce the field values to only the file name.

STEPS:

A w DN PE

Rsplit(File(),2,"\",1)

Set the Display Width of the Filename field to 12.

Type the following expression into the Expression box instead:

Launch the Formula Field Definition window by selecting Table Design L? > Formula Fields.

Select the Formula tab and then delete the expression File() from the Expression by using your keyboard.

This expression separates the path from the filename and returns the filename by itself.

5. Click Apply v to save your newly defined field and then select Accept v in the window ribbon to close it.

Now the Filename field displays only the name of each report file.
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Home  Report View m ~

Tables v ate  Customer Ship Date Media  Quantity Description Label Number Unit Price Amount | Filename -
1 o) 1 Betty's Music Store 1/10/2010 <D 4 Bartok, Sonata for Solo Violin MK-42625 8.99  35.96|Classlan.prn
2 Betty's Music Store 1/10/2010 €D 7 Mozart, Mass in C, K.427 420831-2 9.00  63.00|Class)an.prn
Main 3 Betty's Music Store 1/10/2010 €D 2 Luening, Electronic Music D 611 1019 20.38|ClassJan.pm
4 Betty's Music Store 1/10/2010  DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99  53.91|Class)an.prn
5 Betty's Music Store 1/21/2010 €D 11 Beethoven, Pathetique Sonata, Arau 420153-2 5.99 6589 |Classian.pm
6 Betty's Music Store 1212010 €D 8 Mendelssohn, War March of the Priests SMK 47592 8.99  71.92|Class)an.prn
7 Betty's Music Store 1/21/2010 €D 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 9590 |Classlan.pm
8 Betty's Music Store 1/21/2010 P 6 Misc.,, Modern Trombone Masterpieces ADA 581087 10.79  64.74|Class)an.pm
= Betty's Music Store 1/21/2010 DVD 6 Gershwin, An American in Paris ACS 8034 5.99  35.94|Classlan.prn
10 Betty's Music Store 3/4/2010 €D 6 Schoenberg, Ode to Napoleon CHAN 9116 0.50  57.54|ClassMar.pm
11 Betty's Music Store 3/4/2010 [h) 2 Shostakovich, 24 Preludes for piano. CDA 66620 539  10.78|ClassMar.pm
12 Betty's Music Store 3/4/2000 €D 3 Faure, 28 Songs, Stulzmann RCA 61429-2 17.98  53.94|ClassMar.pm
13 Betty's Music Store 3/4/2010 [h) 1 Haydn, Mass in d, "Nelson Mass" 26560 9.60  9.60 |ClassMar.pm
14 Betty's Music Store 3/4/2010 cb 6 Schubert, Marche militaire in D TROY 068 10.20  61.20 | ClassMar.pm
13 Betty's Music Store 3/4/2010 BLU 1 Nietzsche, Piano Music BLU 85513 5.99 5.99 | ClassMar.pm
16 Betty's Music Store 3/4/2010  DVD 2 Handel, Royal Fireworks Music, Previn ANG-60276 599  11.98|ClassMar.pm
17 Betty's Music Store 3/4/2010 DVD 5 Britten, War Regquiem 2-DBTD 2032 11.98  59.90 | ClassMar.pm
18 Big Shanty Music 2/4/2010 €D 6 Stravinsky, Dumbarton Oaks Concerta SMCD 5120 8.99  53.94|ClassFeb.prn
19 Big Shanty Music 2/4/2010 [h) 1 Schubert, Sonata in e, D.566 A5-325 9.00  9.00 |ClassFeb.pm
20 Big Shanty Music 2/4/2010 €D 3 Mozart, Symphony No.23 in D Co-77884 8.99  26.97|ClassFeb.prn
21 Big Shanty Music 2/4/2010 [) 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59  57.54|ClassFeb.pm
2 Big Shanty Music 2/13/2010 €D 2 Shostakovich, 24 Preludes for piano. CDA 66620 539  10.78|ClassFeb.prn
23 Big Shanty Music 2/13/2010  SACD 9 Balakirev, Symphony no. 1 ENTPD 4110 9.59  86.31|ClassFeb.pm
24 Big Shanty Music 2/13/2010  DVD 5 Holst, St. Paul's Suite for Orch. CBT-1020 5.99  29.95|ClassFeb.prn
25 Bluegrass Records 1/10/2010 €D 3 Faure, 28 Songs, Stulzmann RCA 61423-2 17.98  53.94|Classlan.pm
26 Bluegrass Records 1/10/2010 €D 3 Takemitsu, Music of Takemitsu SMK 53473 3.60  10.80|Class)an.prn
27 Bluegrass Records 1/10/2010 €D 6 Messiaen, Quatour pour la fin de temps CDC 54935 9.60  57.60 |ClassJan.pm
28 Bluegrass Records 1/10/2010  SACD 8 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99  71.92|Classlan.pm
29 Bluegrass Records 1/10/2010  DVD 9 Schumann, Manfred Overture, Bav SO SBT 48270 5.99  53.91|Classlan.pm
30 Bluegrass Records 3/10/2010 €D 7 Hanson, Lament for Beowulf DE 3150 5.99  41.93|ClassMar.pm
31 Bluegrass Records 3/10/2010 €D 4 Chopin, 24 Etudes, Wild w77 899 3596 |ClassMar.pm
32 Bluegrass Records 3/10/2010  SACD 2 Strauss, Ein Heldenleben, Op.40 SMSACD-5036 8.99  17.98|ClassMar.prm
13 Bluegrass Records 3/10/2010  SACD 3 Beethoven, 3rd Sym, Karajan, Berlin 419049-2 BLU 9.00  27.00|ClassMar.pm
34 Bluegrass Records 3/10/2010  DVD 3 Saint-Saens, Danse macabre ACS 8058 5.99  17.97|ClassMarpm  |™
1 ¥

Figure 13-9. The Filename field, excluding the path.

The ID() Function

The ID function assigns a numeric designation to each report at the time the report is opened. The first report opened
is assigned 1, the second 2 and so on. If a report is subsequently closed, the list of designations is collapsed to fill
any gap in the assigned numbers. Let's create another calculated field using this function.

STEPS:

1. From the Table ribbon, select Table Design to launch the Table Design interface and then click Add > Formula
Field.

The Formula Field Definition window displays.

2. In the Name box, type File ID, select v , and then select Numeric from the Type drop-down list.
Select the Formula tab.

4. Double-click on the ID() function from the Functions list so that it is added to the Expression box.

5. Click Apply v to save your newly defined field and then select Accept v to close the Formula Field
Definition window.

The File ID field displays as a new column in the table.
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Home  Report View m

Tables B L TSR v Ship Date
1 1/10/2010

i Pl 1/10/2010

Main 3 1/10/2010
4 1/10/2010
5 1/21/2010
6 1/21/2010
7 1/21/2010
8 1/21/2010
9 1/21/2010
10 3/4/2010
11 3/4/2010
12 3/4/2010
13 3/4/2010
14 3/4/2010
15 3/4/2010
16 3/4/2010
17 3/4/2010
18 2/4/2010
19 2/4/2010
20 2/4/2010
21 2/4/2010
2 2/13/2010
23 2/13/2010
24 2/13/2010
25 1/10/2010
26 1/10/2010
27 1/10/2010
28 1/10/2010
29 1/10/2010
30 3/10/2010
31 3/10/2010
32 3/10/2010
33 3/10/2010
2] 3/10/2010

Media
D
o
D
DvVD
D
o
D
[
DvD
o
D
o
D
o
BLU
DvVD
DvD

DVD

Quantity

4
7

[
oS e ine N

Lot M B 00 B L U e N B W G N e e W N e

Description
Bartok, Sonata for Solo Violin

Mozart, Mass in C, K.427

Luening, Electronic Music

Scarlatti, Stabat Mater

Beethoven, Pathetique Sonata, Arau
Mendelssohn, War March of the Priests
Pizzetti, Messa di Reguiem

Misc., Modern Trombone Masterpieces
Gershwin, An American in Paris
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Faure, 28 Songs, Stulzmann

Haydn, Mass in d, "Nelson Mass™
Schubert, Marche militaire in D
Nietzsche, Piano Music

Handel, Royal Fireworks Music, Previn
Britten, War Requiem

Stravinsky, Dumbarton Ozks Concerto
Schubert, Senata in e, D.566

Mozart, Symphony No.23 in D
Schoenberg, Ode to Napoleon
Shoestakovich, 24 Preludes for piano.
Balakirev, Symphony no. 1

Holst, St. Paul’s Suite for Orch.

Faure, 28 Songs, Stulzmann
Takemitsu, Music of Takemitsu
Messizen, Quatour pour I fin de temps
Strauss, Ein Heldenleben, Op.40
Schumann, Manfred Overture, Bav SO
Hanson, Lament for Beowulf

Chepin, 24 Etudes, Wild

Strauss, Ein Heldenleben, 0p.40
Beethoven, 3rd Sym, Karajan, Berlin
Saint-Saens, Danse macabre

Label Number
MK-42625
420831-2

CD 611

SBT 48282
420153-2
SMK 47592
CHAN 8964
ADA 581087
ACS 8034
CHAN 9116
CDA 66620
RCA 61429-2
26560

TROY 069
BLU 85513
AXG-60276
2-DBTD 2032
SMCD 5120
A5-325
CO-77884
CHAN 9116
CDA 66620
ENTPD 4110
CBT-1020
RCA 61429-2
SMK 53473
CDC 54935
SMSACD-5036
SBT 48270
DE 3150
77
SMSACD-5036
419049-2 BLU
ACS 8058

Unit Price Amount

9.00
10.19
5.99
5.99
8.99
9.5
10.79
5.99
9.59
5.39
17.98
9.60
10.20
5.99
5.99
11.98
8.99
9.00
8.99
9.5
5.39
9.5
5.99
17.98
3.60
9.60
8.99
5.99
5.99
8.99
8.99
9.00
5.99

35.96
63.00
20.38
53.91
65.89
71.92
95.90
64.74
35.94
57.54
10.78
53.94

9.60
61.20

5.99
11.98
59.90
53.94

9.00
26.97
57.54
10.78
86.31
29.95
53.94
10.80
57.60
71.92
53.91
41.93
35.96
17.98
27.00
17.97

Filename

Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
ClassMar.pm
ClassMar.pm
ClassMar.prm
ClassMar.pm
ClassMar.pm
ClassMar.pm
ClassMar.pm
ClassMar.pm
ClassFeb.pm
ClassFeb.pm
ClassFeb.prm
ClassFeb.pm
ClassFeb.prm
ClassFeb.pm
ClassFeb.prm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
Classlan.pm
ClassMar.pr
ClassMar.pm
ClassMar.prn
ClassMar.pm
ClassMar.prn

File ID

3

Tl W e e e e 0 R R R R R W W W L W W LD W e e e e e e e e e

Figure 13-10. The Filename and File ID fields.

Since ClassJan.prn was the first report we opened, it is assigned 1. ClassFeb.prn was the second report opened,
so it is assigned 2 and ClassMar.prn is assigned 3. By opening the reports in another order, we could change the
designations. You can use the ID function to order records in the table or in a summary based on the order in
which you open the files, rather than alphabetically by file name.
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[14] EXTRACTING MULTIPLE-LINE
FIELDS

In many reports, the majority of fields are single line fields - character, numeric and date fields that occupy space on
a single line. However, some reports contain large fields that span multiple lines. These multiple line fields are
variously known as comment fields, description fields, memo fields, text blocks or word wrapped fields. In this
chapter, you'll learn how to extract a multiple line field from a report and work with it in Monarch.

To get started, load Monarch and open the Homes.prn report and Lesson6.dmod model file.

File Home Report Table Summary Export ?
==l E Select Al as Previous Report Next Report | T:= r.‘-.
Report e @ Zoom To Fit [£] Copy Search  Find in Previous Page G Next Page Bookmark ;?:;u;rt Prup::s Dc&?g:s
Design Define B Greenbar iR {3, Go To Page EeTo B o
~
Home m v
[—— PPl 05/08/10 MERRTMACK VALLEY REALTORS ASSOCIATION Page 01 -
T p RET#: 31 NEW PROPERTY LISTINGS
Gy 05/02/10 - 05/08/10
E Homespm
»| Date Listed: 05/03/10 MLS §: 24543
» Listed By: Harvest Homes Realtors

*»|Co-Broke Fee: 3%
»

» Price: $319,000 Assessment: $324,000

» Town: Tyngsboro Rate: 17.17

» Style: Colonial Book: 1420

> Address: 34 Spring Street Page: 347

» Est Bge: 6 Taxes: 53846

»

» Lot Size: 60,000 Color: White Fuel: Gas

» Basement: Full Rocms: 7 Hot Water: Gas

» Garags: 2 Bedrooms: 3 Water: Town

»| other Bldg: No Baths: 2.5 Sewage: Town

»

» Remarks: Formal, fireplaced dining room. Large family room off
gourmet kitchen. Hardwood floors throughout. Master
bedroom has cathedral ceiling with loft and skylight.

Sun deck overlecking large rolling lawn on 1.5 acre
wooded lot in gquiet country setting. Easy access to
route 3, only minutes to New Hampshire.
»| Date Listed: 05/03/10 MLS §: 24614

» Listed By: Northran Real Estate
*»|Co-Broke Fee: 3%
»

» Price: §$213,000 Assessment: $231,000
» Town: Chelmsford Rate: 16.87
> Stule: Garrison Rook: 1141 M

q b

Paget 100% ——h——+

Figure 14-1. The Homes real estate report contains new property listings.

Homes.prn is a weekly real estate report describing properties that were offered for sale during the previous week.
For each property, the report includes the address, style, price, listing broker and numerous other points of interest to
prospective buyers. Chief among these is a description of the property provided by the listing broker. The Remarks
field is typical of multiple line fields found in many reports. Each instance of the field contains several lines of
descriptive text - some of the descriptions are only a few lines long and several are as many as nine lines.

The Lesson6 model contains a detail template that captures several fields from each property listing. The first line of
the multiple line Remarks field is included in the template, but that field is not yet captured. We'll capture the Remarks
field together to illustrate how to capture a multiple line field.
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CAPTURI

NG A MULTIPLE-LINE FIELD

To capture a multiple-line field, you need to tell Monarch where the field begins and ends. Typically, locating the
beginning of a multiple line field is easy - most multiple line fields begin at an absolute offset from the first line of the
template. Locating the end of a multiple line field is sometimes more difficult. Since the number of lines in the field
often varies, you can't tell Monarch how big the field is in absolute terms. Instead, you must describe some
characteristic that is common to the end of the field. For example, the field may end when a blank line is reached or
when another field is encountered. Monarch includes these and several more options that you can use to indicate
where your multiple line field ends.

STEPS:

1. Select Report Design E’ to switch to the Report Design view.

The Template Editor displays, showing several lines of the detail template. In this

contains a total of

Template Editor

|Standard Trap

Date Listed:
Date Listed:

Listed By:
Co-Broke Fee:

Price:

05/08/10
RET#: 321

Date Listed:
Listed By:
Co-Broke Fee:

Price:
Town:
Style:
ZLddress:
Est Rge:

Lot Size:
Basement:
Garage:

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥

4

16 lines.

V| E 0 R o g - « =+ Trapline v [¥)ResetTrap line 5O ResetFields S# Edit Field
05/03/98 MLS #: 4543
3%

52159, 000 Lssessment: $224,000
MERRTMACE VALLEY REALTORS ASSCCIATICN Page 01
NEW PROPERTY LISTINGS
05/02/10 - 05/08/10
05/03/10 ML3 §: 24543
Harvest Homes Realtors
3%
$31%,000 Lszessment: $324,000
Tyngsboro Rate: 17.17
Colonial Book: 1420
34 Spring Strest Page: 347
3 Taxes: S$3846
60,000 Color: White Fuel: Gas
Full Rooms: 7 Hot Water: Gas
2 Bedrooms: 3 Water: Town

example, the detail template

3

Realtor MLS Number Town Style Rooms Bedrooms Baths Price
1 |Harvest Homes Realtors 24543 Tyngsboro  Colonial 7 3 2.5 315000
2 MNorthran Real Estate 24614 Chelmsford  Garrison 6 2 1.5 219000
3 1. Miller Realty 24737 Billerica Split Entry 7 & 1.5 229900
4 J&J Realty 24739 Dracut Condo 4 2 1.0 169000
5 Terrace Realtors 24775 Tewksbury  Ranch 6 3 1.5 219900
6 1. Miller Realty 24820 Billerica Ranch ] 3 1.5 254900

-

-

Figure 14-2. The Sample Text box displays several sample lines.

We can scroll the template sample text to view the remaining sample lines. The last line of the template contains
the beginning of the Remarks field. Let’s scroll down until that line is displayed.

2. Scroll down in the Sample Text box until the Remarks field is visible, as in Figure 14-3.

Altair Monarch 2024.1

Learning Guide

272



Template Editor ~

|Standard Trap «|A il B ® | ® - <« » Traplinev [¥)ResetTrapLline 5D ResetFields S# EditField = Delste Field
I Date Listed:
Basement: Full Rooms : Hot Water: Gas
Garage: 2 Bedrooms: Water: Town
Other Bldg: No Baths=: Sewage: Town
Remarks: Formal, fireplaced dining room. Large family room off

Figure 14-3. The last template sample line represents the beginning of the Remarks field.

Let’s also scroll the report to display the first instance of the Remarks field. Having this field displayed on screen
will provide valuable feedback during the capture process.

3. Use the vertical scroll bar on the right side of the Template Editor (the lower of the two vertical scroll bars that are
visible on screen) to scroll down so that the Remarks field is fully visible on screen, as shown in Figure 14-4.

Template Editor v
|Standard Trap v| A il B ® | ® - « » Tapline~ [¥)ResetTrapline T ResetFields S# EditField =5 Delete Field
I Date Listed:

Basement: Full Rooms : Hot Water: Gas
Garage: 2 Bedrooms: Water: Town
Other Bldg: No Baths: Sewage: Town

Remarks: Formal, fireplaced dining room. Large family room off

*» Lot Size: 60,000 Color: White Fuel: Gas

» Basement: Full Rooms: 7 Hot Water: Gas

- Garage: 2 Bedrooms: 3 Water: Town

»| Other Bldg: No Baths: 2.5 Sewage: Town

*

* Remarks: Formal, fireplaced dining room. Large family room off

gourmet kitchen. Hardwood floors throughout. Master
bedroom has cathedral ceiling with loft and skylight.
Sun deck overlooking large rolling lawn on 1.5 acre
wooded lot in gquiet country setting. Easy access to
route 32, only minutes to New Hampshire.

#» Date Listed: 05/03/10 ML3 §: 24614

» Listed By: Northran Real Estate

*|Co-Broke Fee: 3%

*

» Frice: $215,6 000 Assessment: $231,000

Figure 14-4. Displaying the multiple line Remarks field in the Report view to provide feedback.

Now we’re ready to capture the multiple-line Remarks field.

4. In the Sample Text line, use the mouse or the keyboard to highlight only the first line of the Remarks field.
Highlight this entire line, making sure to extend several spaces toward the right to capture all of the data for all of
the records in the report.

The field highlight should look like that shown in Figure 14-5.

Template Editor v

|Standard Trap v| A il B ® | ® - « » Tapline~ [¥)ResetTrapline T ResetFields S# EditField Sk Delete Field
I Date Listed:
Basement: Full Rooms : Hot Water: Gas
Garage: 2 Bedrooms: Water: Town
Other Bldg: No Baths: Sewage: Town
2ES P Formal, fireplaced dining room. Large family room off

Figure 14-5. The last template sample line represents the beginning of the Remarks field.

Altair Monarch 2024.1 Learning Guide 273



Note that the first line of the field in the report is now highlighted.

Template Editor ~

|Standard Trap V| A N R o e - « - Trap Line v -5 Reset Trap Line 55 Reset Fields S# Edit Field Sx Delete Field
Date Listed:
Basement: Full Rooms: [ Hot Water: Gas a
Garage: 2 Bedrooms: Ej Water: Town
Other Bldg: No Baths: Sewage: Town
E Y Sl Formal, fireplaced dining room. Large family room off -
*» Lot Size: 60,000 Color: White Fuel: Gas a
* Basement: Full Rooms: 7 Hot Water: Gas
- Garage: 2 Bedrooms: 3 Water: Town
»| Other Bldg: No Baths: 2.5 Sewage: Town
*
* Remarks: Formal, fireplaced dining room. Large family room off
gourmet kitchen. Hardwood floors throughout. Master
bedroom has cathedral ceiling with loft and skylight.
Sun deck overlooking large rolling lawn on 1.5 acre
wooded lot in gquiet country setting. Easy access to
route 3, only minutes to New Hampshire.
»| Date Listed: 05/03/10 MLS #: 24614
» Listed By: Northran Real Estate
*Co-Broke Fee: 3%
*
» Price: $213,000 Lszessment: $231,000 e

4 3

Figure 14-6. The Sample Text box displays several template sample lines.

You might be wondering why we highlighted only the first line of the field. Why not highlight the entire field? For a
multiple line field, we must indicate the horizontal size of the field and the vertical size. The horizontal size is
indicated by highlighting the first line of the field. However, the vertical size cannot be indicated by highlighting
multiple lines because the number of lines occupied by each instance of the field varies. What would be correct
for the first instance of the field may be incorrect for the others. To indicate the vertical size of a multiple line field,
we must tell Monarch where the field begins and where it ends. To do this, we’ll use the Field Definition window.

=

5. Select Edit Field =" on the Action bar of the Template Editor.

The Field Definition window appears, showing all of the fields defined for the Detail template. Note that at the
bottom of the list of fields, the field name eg_Formal, fireplaced dining ro... may be found. This is the field we
are extracting in the current lesson.

6. Select the field eg_Formal, fireplaced dining ro... to display its properties. Rename this field Remarks and
then select V
7. Click the Advanced tab.
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Design

v

Accept  Cancel

Fields

A

E Realtor

] MLS Mumber
Town

Style

] Rooms

E Bedrooms

fe.] eg_Formal, fireplaced dining ro

Template Name: 2
Detail v "
Help

Show fields from all templates

v & General Template [[TRSSEY

o
Start Field On

®) Line number 16
String:

Preceding string:

anywhere in previous line

in current line

After last defined field in template

End Field On

Fields always end on a new template or HTML markup line. There can be an

additional stop condition as follows:

® Line count: |1 >

Nonblank preceding string of |1

Blank field values: |1
End of left justification.

Any template hit

Reset

characters

By default, fields start and end on a specific line number. Use the other
conditions above for text containing varying start lines or paragraphs.

20Rows 100% ——F——+

Filter: No Filter Sort: Mo Sort

Figure 14-7. The Advanced tab.

The Advanced tab includes options for indicating the beginning and ending locations of the field. Let's begin by

examining each of the Start Field On options. These options tell Monarch how to locate the beginning of a

multiple line field. The Start Field On options are:

Line Number

The Line Number option indicates that the first line of the field begins at an absolute offset from the top of
the template. The line number represented by this setting is determined by the position of the field highlight
in the template sample. Since we painted the first line of the Remarks field at Line Number 16, this option
displays as Line Number 16.

NOTE

String

The String option indicates that the first line of the field begins on the next line down from (i.e., the line
below) a line containing a string. This option is particularly useful when trapping HTML data. To use this

The Line Number option is almost always the correct choice for indicating the beginning of a
multiple line field. The only time the Line Number option would not be the correct choice is
when the multiple line field begins after another multiple line field. In this case, the first
multiple line field, if it contains a varying number of lines, would cause the beginning

position of the second multiple line field to vary (see Figure 14-8). Only then would you need
to employ one of the other Start Field On options.

option, enter the string in the adjacent box.

Altair Monarch 2024.1 Learning Guide

275



e Preceding String

The Preceding String option indicates that the first line of the field begins to the right of a string, such as a
label. To use this option, you simply enter the string in the adjacent box. Figure 14-8 shows a modified
version of the Homes report where the Remarks field falls after another multiple line field, the Directions
field. Here the Line number option would not work because the varying length of the Directions field would
cause the beginning of the Remarks field to bob up and down. In this case, the preceding string option could
be used by entering the label "Remarks:" (without the quotation marks).

Lot Size: 60,000 Color: White Fuel: Cas
Buzement: Full Pooms: § Hot Water: OCas
Carwge: & Bedrooms: 3 Wuter: Town
Ozher E1 Mo Baths: 2.5 Lewage: Town
lMirections: Tike route 3 north to exit 34 (Sutton road). AR end of
ramp take a left. At first set of Tights, take a right
onto Spring street. ond white house on left.
Remrks: Form, fireplaced dining I‘Dl;- Large family room of f
H;;m Hardwood floors throughout, I-h.ru
rw- has cathedral cei -ﬂ:h Toft and
Sun deck owerlooking Taurge Tawn on 1.
wooded Tot in gquiet ma' . [Easy I.Wl“ L]
route 3, only minutes to re.
Oate Listed: 050401 HLL #: 24778
Listed By: Tarrace Realtors
Co-Broke Fos:
Frice: B30 900 Assesement: 22 500
: Tandegbury Pare; 16, 35
teyle: Banch Book: 1924
Addeass: 103 Jason STeeet Fage: 57
Est Age: LT Tawes; $o003
Lot Size: 42,000 Color: Elue Fuel: 011
Bugement: Full Rooms: @ Hot Wamer: 011
Carage: 1 Bodeooms: 3 Wrer: Municipal
fichar Bldg: Mo Baths: 1.5 Sarang
Mrections: Tuke route 995 to axit 38 (route 3B). South on 3 w
first zat of VTights, ®Right onto Tuplor Driwe, Afcer
wproximealy & miles, you'll cross o st of Fuilroad
tncksl. M';qr nﬂmn:m;;:u rvg: !I'h:c 'Iirlc1
ente Jugon STreeT. '‘or Morthean Ben] estate § ,
on Taft, « gﬂlﬂ leneht
wachions feld
Bemrks:  Top north Teskgbury neighborbood, Center 180a Kivchen
with duck of? room. Cuthedral cetlings in fumily Zppeats before
room and mETer bedroom,  Upduted P Remarks field.
wlectrica) systems, Full acre
within sinutes of routes 995 93,
Figure 14-8. Offset of Remarks field varies due to preceding multiple line Directions field.

o After Last Defined Field in Template

The After Last Defined Field option indicates that the first line of the field begins two lines below a previous
multiple line field. Figure 14-9 is an excerpt from Figure 14-8, except this time there is no identifying label
next to the Remarks field. In this case, you could use the After Last Defined Field option to indicate that the
Remarks field begins immediately after the Directions field. To do this, you must also capture the Directions
field so Monarch will know where it ends.

Lot Size: 60,000 Color: \hite Fuel: Cas
Basement: Full Rooms: ¥ Hot Water: Cas
Carage: 2 Bedrooms: 3 Water: Town
Other Bldg: MNo Baths: 2.5 Sevage: Town
Take route 3 north to exit 34 At end of

m Teft. Axﬂmmof'lidm muigm
a
MSpringstmt nd white house on 1

For-l ﬂw dining room. hm family room off

Hardwood floors throughout. Master

roo- has cathedral ceiling vlth Joft and skylight.
Sun deck overlooking large n‘l'l'lng Tawn on 1.5 acre

wooded Tot in quiet country setti Easy access to

route 3, only mnutes to New hnz'l

No label exsts for Remarks held.

Figure 14-9. Use After Last Defined Field if no label exists to mark the beginning of the second multiple line field.
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Since the Remarks field always begins on the same line in the template (Line Number 16), we'll use the Line
Number option to indicate where the field starts. Line Number is the default option, so it's already selected.

Next, we need to indicate where the multiple line field ends. To do this, we’'ll select an End Field On option.
The End Field On options tell Monarch how to locate the end of a multiple line field. Let's examine each
option.

Line Count

The Line Count option terminates a multiple line field after a fixed number of lines. This option should be
used only when every instance of the field has the same number of lines. This won’t do for our Remarks
field, as each instance contains a different number of lines.

Nonblank Preceding String of

The Nonblank Preceding String option terminates a multiple line field when any nonblank character appears
within a specified number of columns to the left of the field. Typically, the character is part of a label that
appears to the left of a subsequent field. As an example, let's suppose our fictitious Directions field
appeared immediately after the Remarks field rather than before (see Figure 14-10). With no blank line to
separate the fields, it is difficult to determine where the Remarks field ends, but we can find the label
"Directions:" preceding the first line of the Directions field. We can use this label to terminate the Remarks
field by selecting the Nonblank Preceding String of option and specifying 3 or more columns.

Monarch will look for any nonblank character in these columns, terminating the field when it encounters the
colon (:) in the "Directions:" label.

Lot Sdze: 0,000 Color: hite Fuel: Cas

Bagament : Full Rooms: Hot Whter: Cas
Garage: 2 Bedrooms: 3 Water: Town
Otherr B'I-!g: 5] Baths: 2.3 Sewaige - Town

Ram ks Form, ﬁmﬂuﬂ dining rocm, hm family room u»f‘l"

Hurdwood 11cors throughout. Histe
m- has cathadral cailieg rlth Tof't and i:r'llj\t

Sun deck owerlooking Targe r1710g Tawn on 1.5 wore
weoded 1ot in quiet country fetting. Eugy wccess to
route 3, only minutes T Kew l:.u;g'l

Directiong: Take Foute 3 MOFEh o XSt 74 (SULCon poud). AT end of
Famp takd a Tefr. A first g of Tights, mike 3 right
onte Spring street. Ind white house on lefe.

Date Ligted: 050401 MLS H: P4TTS
Listed By: Domta Hill, Terrace Realtars
Co-Broke Fee: K
Price: 319,900 Azsessment: EL2F W00
Towri:  Tewksbury Pate: 16 25
Style:  Ranch Book: 1934
Address: 103 Jason Street Page: &F
Est Age: 17 Tanes: R003
Lot Size; 42,000 Color: Blus Fual: od1
Easament; Full Rooms : & Hot Water:  (d1
Garage: 1 Budrooms: 3 Wutar:  Municipal
Othepr E1dg: Mo Baths: 1.5 Saenge:  Town
Ramarks: Top no Tawksbury naighborteed, Contar 15la kitchan

whh M off dining recm, Cathedral ceil in family
rotm und mater badroom, Upduted heating, plumbing and
elecerica] systems. Full ur:':.rlﬂ COUNTEY Satring
within simutes of rostes

Dirgctions:  Také route 495 1o Iili'! = o(roure 3. South on 38 to

Firge et of T6ghta. Right eete Tuylor Drive. After -
ipproximeely 2 miles, pou'l] crose & st of radlroad Hm held
tracks, After railroad tracks take your First Teft N o

o gtm Street. Lok for Morthran Real estate sign Diections fekd
o |&FE.

Figure 14-10. Use Nonblank Preceding String to terminate a field when another field is encountered.

The Nonblank Preceding String option cannot be used to indicate the end of the Remarks field in the report
that we are using for this lesson because there is no label in an appropriate position near the end of the
Remarks field.

Blank Field Values

The Blank Field Values option terminates a multiple line field when Monarch encounters a single blank line
or a pair of blank lines. Monarch does not require the entire line to be blank, only the column positions
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immediately under the field. Since our Remarks field is always followed by a blank line, this option is a good
choice.

In the case of a large text block containing multiple paragraphs, like the one shown in Figure 14-11, you
would indicate 2 blank lines - to prevent Monarch from terminating the field when it encounters the blank line
that falls between the first and second paragraphs.

Note that using two blank lines to terminate a multiple line field is possible only when the entire text block is
followed by at least two blank lines, as is the case in our example below.

Lot Size: 65,000 Color:  White Fuel: Gas
Bazement: Full Rooms: & Hot Water: OGas
Garage: 3 Bedrooms: 4 Water: Town
Other Bldg: Ho Bathz: E.5 Sewage:  Town

Remarks: Jerome Bailey Foster designed YH17l4iamsburg colondal din
impeccable condition. EBrick floored foyer, gourmet
kitchen with breakfast nook owerlooking gardens, 1st
floor den, 3 season porch, fireplaced mester suite with
Jacuzzi bath and walk-in clasets, fireplaced recreation
room, walk-up attic suitable for expansion, heated
in-ground pool. Separate pool house with sauna.
Located in Mashoba Hi1ls with conwvenient access o all
Mmjor routes.

Hote: “Walley Real Estate will be holding a reservations-
only open house on August 17th, 1995 from 11:30am to &:00pm.
Brokers with prospectiwe clients are asked to muke their
rezearvations no later than sugust 10th. Refreshments and

a buffet Tunch will be sarwved.

End of Left Justification

This option terminates a multiple line field when Monarch encounters a line with a blank in the first column
position of the field or any nonblank character in the column immediately preceding the field. Either condition
indicates that left justification within the field has ended. This option is useful for capturing left aligned text
blocks. However, if the text block contains a blank line, such as that found between paragraphs, Monarch
will consider the blank line an end to left justification and will therefore terminate the field. Although this
option could be used to terminate the Remarks field, the Blank Fields option is preferable as it better
describes the way that the field is actually terminated.

Any Template Hit

This option terminates a multiple line field only when Monarch encounters another template, including
another instance of the template in which the multiple line field resides. Monarch will also terminate a
multiple line field after it extends two pages. The field will be terminated on the second page where the page
break character (ASCII 12) is encountered. This prevents a field from continuing without end if the selected
End Field On action is not appropriate to end the field.

This option should be used only when none of the other End Field On options are suitable. By employing the
minimum actions, you might capture more data than is actually occupied by the field.

NOTE The minimum actions described above are always enforced by Monarch, even when the
Any Template Hit option is not selected. Select this option only when none of the other
options would apply.

From our review of each of the End Field On options, we find that either the Blank Field Values option or the End
of Left Justification option will properly terminate the field. We recommend using the Blank Field Values option in
such cases, since it is more descriptive of how the field ends.
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8. Select the Blank Field Values option to indicate to Monarch that the field will end when a blank line is
encountered. The default value is 1, which tells Monarch that the field should end as soon as 1 blank line is
found.

9. Select Accept v to accept your changes and close the window.

Note that Monarch has correctly highlighted the first instance of the Remarks field.

Template Editor ~
|Stam:|ardTrap ~| A fl B ® | ® - « > Taplinev [¥)ResetTrapline 5D ResetFields S# Edit Field Sy Delete Field
I Date Listed:

Basement: Full Rooms : Hot Water: Gas
Garage: 2 Bedrooms: Water: Town
Other Bldg: No Baths: Sewage: Town

EE Y L Formal, fireplaced dining room. Large family room off

» Other Bldg: No Baths: 2.5 Sewage: Town

*

» Remarks: Formal, fireplaced dining room. Large family room off

gourmet kitchen. Hardwood floors throughout. Master
bedroom has cathedral ceiling with loft and skylight.
Sun deck overlooking large rolling lawn on 1.5 acre
wooded lot in quiet country setting. Easy access to
route 3, only minutes to New Hampshire.

» Date Listed: 05/03/10 MLE §: 24614

» Listed By: Northran Real Estate

*Co-Broke Fee: 3%

Data Preview

Realtor MLS Number Town Style Rooms Bedrooms Baths Price eg_Formal, fireplaced dining ro
1 |Harvest Homes Realtors 24543 Tyngsboro Colonial 7 3 2.5 319000 Formal, fireplaced dining room. Lar
2 MNorthran Real Estate 24614 Chelmsford  Garrison 6 3 1.5 219000 Large bright eat-in kitchen, hardwo
3 1. Miller Realty 24737 Billerica Split Entry 7 3 1.5 229900 Large country kitchen with walk in p
4 18] Realty 24739 Dracut Condo 4 2 1.0 169000 Top floor unit. Spacious living room
5 Terrace Realtors 24775 Tewksbury  Ranch 6 3 1.5 219900 Top north Tewksbury neighborhood
6 1. Miller Realty 24820 Billerica Ranch 2] 3 1.5 254900 Recenﬂy remodeled kitchen with all
&

Figure 14-12. Testing the multiple line field definition.

Let's double check the field definition by inspecting several more instances of the multiple-line field.
10. Scroll down in the report to the next Remarks field.

Note that the second instance of the Remarks field is also correctly highlighted.

Template Editor v

|Standard Trap ~| A @ B ¢ | ® - « » Taplinev [ ResetTrapline 5O ResetFields S# Edit Field i Delete Field
I Date Listed:
Basement: Full Rooms: Hot Water: Gas
Garage: 2 Bedrooms: Water: Town
Other Bldg: No Baths: Sewage: Town
Y Ll Formal, fireplaced dining room. Large family room off
» Basement: Full Rooms: 6 Hot Water: Elec
* Garage: 1 Bedrooms: 3 Water: Municipal
- Other Bldg: No Baths: 1.5 Sewage: Septic
£
» Remarks: Large bright eat—-in kitchen, hardwood floors, fireplaced
family room, 1/2 acre level lot. Well maintained, zoned
light industrial, close to routes 3 and 4595 and schools.
211 appliances stay.
os/oe /1o T MERRIMACE VALLEY REALTORS Associarron 7 Page 02
RET#: 31 NEW PRCPERTY LISTINGS

Figure 14-13. Double checking the multiple line field definition.
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11. Select Accept v to accept your changes and close the Template Editor.

DISPLAYING A MULTIPLE-LINE FIELD IN TABLE
VIEW

Now that we are satisfied that the multiple line field is captured properly, we’'ll extract the field and display it in the
Table view.
STEPS:

1. Select the Table tab to display the extracted data in Table view.

The table displays, and the Remarks field is found at the far right.

File Home Report Table Summary Export ?
E# S o A i Q ~ = £
“Q Zoom To Fit [E] Co N Show Field Freeze
P=m ¥4 Autosize Columns. fo Eepas Data View

Home  Report View m v

Tables oo v R Realtor MLS Number Town Style Rooms Bedrooms Baths  Price Remarks -
Harvest Homes Realtors 24543 Tyngsboro  Colonial 2.5 319000 Formal, fireplaced dining room. Large family room off gourmet kitchen...

1 7 3

o O3 orthran Real Estate 24614 Chelmsford  Garrison 6 3 15 219000 Large bright eat-in kitchen, hardwood floors, fireplaced family room, 1f._

Main 3 1. Miller Realty 24737 Billericz split Entry 7 3 1.5 229900 Large country kitchen with walk in pantry, 1/2 bath with laundry hook-
4 18] Realty 24739 Dracut Condo 4 2 1.0 169000 Top floor unit. Spacious living reom with cathedral ceiling and sliders o
5 Terrace Realtors 24775 Tewksbury  Ranch 6 3 1.5 219900 Top north Tewksbury neighborhood. Center isle kitchen with deck off d._
6 1. Miller Realty 24820 Billerica Ranch 8 3 1.5 254900 Recently remodeled kitchen with all new cabinets and appliances. Cath
7  Em Street Realty 24834 Westford Garrison 7 3 2.5 369900 Attached family room and two car garage with loft. Exceptional floor pl
8 Crowe Real Estate 24867 Chelmsford  Colonial 8 3 25 289000 Fireplace, cathedral ceiling in family room and master bedroom, balcon.
9 valley Real Estate 24889 Westford Cape 12 7 4.0 529000 6500 square feet of living space includes au pair suite, wine cellar, wet
10 showboat Realty 24908 Lowell Colonial 6 3 1.5 279900 Center entrance to grand foyer, balconies off master bedroom and pari...
11 Thomas, Inc. 24917 Dracut Cape 8 4 1.5 375000 Horse farm on 17 acres. House has attached garage, formal, fireplaced.
12 ). Miller Realty 24932 Billericz split Entry 8 4 1.5 264900 Numerous updates: eat-in kitchen with oak cabinets, dining room with...
13 Valley Real Estate 24967 Westford Colonial 15 6 4.0 775000 Contemporary styling, sunraom with spa, au-pair suite, greenhouse bre
14 Woods Realty 24992 Lowell Condo 4 2 1.5 189000 Penthouse unit in renovated mill building overlooks downtown Lowell a...
15 Northran Real Estate 25013 Chelmsford  Townhouse 5 2 15 205000 4-levels with garage, family room with corner fireplace, cathedral ceilin
16 Newell Properties 25047 Tewksbury  Colonial 7 3 2.5 329000 French doors leading from dining room to patio garden. Fireplaced mas.
17 Elm Street Realty 23053 Westford Saltbox 8 3 2.5 369000 Custom built by master craftsman. Huge kitchen with fireplace, custom...
18 Woods Realty 25079 Lowell Victorian ) 4 25 399000 Lovely entrance foyer and staircase, 9 plus rooms including 3 fireplaces
19 Showboat Realty 23087 Lowell Townhouse 6 3 1.5 210000 Three stories of living space plus garage and partial basement. Beame...
20 J&J Realty 25091 Dracut Cape 8 4 2.5 419000 2700 square foot expanded cape. 1st floor master bedroom with cathe
21 showboat Realty 25110 Lowell Condo 4 2 1.0 159000 First floor garden style condo with oak kitchen, low fees, pool and tenni...
22 Newell Properties 25134 Tewksbury  Cape 10 5 2.5 489000 Contemporary design. White gourmet kitchen with hardwood floors, lar
23 Harvest Homes Realtors 25142 Tyngsboro  Colonial 7 3 2.5 329000 Large bright kitchen with cathedral ceiling, skylight and walk-in pantry.
24 ], Miller Realty 25159 Billerica Colonial 8 4 25 419000 Elegantly styled 3400 square foot Colonial on 2 acre lot adjacent to Lan
25 . Miller Realty 25177 Billerica Split Entry 10 4 2.5 299300 Recently remodeled kitchen with oak cabinets and center island. Dinin
26 Newell Properties 25198 Tewksbury  Ranch 14 5 3.5 389000 Hardwood floors, cathedral ceilings in family room and master bedroom. -
27 Valley Real Estate 25226 Westford Contemporary 8 4 2.5 429000 Open floor plan, spacious 16x30 family room with solarium window and
28 Town Homes Real Fstate 25232 Tyngsboro  Townhouse 6 3 15 224000 Large, bright kitchen with center isle, dining room with slider to 6x12 d_
29 Valley Real Estate 25257 Westford Colonial 8 4 25 619000 Jerome Bailey Foster designed Williamsburg colonial in impeccable cond -
‘ »

Reaitor - Character - Detail (Detail) Fitsr Mo Fiter Sorc Mo Sot 29 Rows  100% — —f———+

Figure 14-14. Displaying the Remarks field in the Table view.

The initial field type assigned to the Remarks field is character with a data length of 254 - the maximum data
length for a character field. The column width is set to the field's template width, which in this case is 62
characters.

These default settings are appropriate for multiple line fields that extract a small amount of data, i.e., when the
largest field value is less than the 254-character maximum for a character field. For multiple line fields that
extract large blocks of text, however, such as our Remarks field, the 254-character limit will cause some of the
field values to be truncated and the display settings don'’t let us see very much of each field value on screen.
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MEMO FIELDS

To accommodate multiple line fields that contain more than 254 characters, Monarch includes support for memo
fields which can handle up to 65,536 characters (64KB).

Let's change the field type of the Remarks field to Memo.

STEPS:

1. Select Table Design to launch the Table Design interface.

2. In the field list that displays, locate the row for Remarks and then change its type to Memo.

3. Select Accept v to accept your changes and return to Table view.
The Remarks field is redisplayed as a memo field.
To view more information for each memo field, you'll have to adjust the height of each row.

4. In the left hand side of the Table view, click on the border between Rows 1 and 2, then drag down to expand the
height of the rows to at least six lines.

Even using a row height of 6 lines, we still may not be able to see all of the text in some of the Remarks fields.
To view more information, we could increase the width of the field, but this may still not allow us to view the
entire contents of each cell. Although we could adjust the row height again (Monarch allows a maximum row
height of 12 lines), let's try something new instead. Let's give Monarch’s Show Field Contents feature a try,
which displays the entire contents of a cell.

5. Select Show Field Contents "B from the Table ribbon.

Monarch opens a small window at the top of the display. This window, called the Field Contents window, displays
the entire contents of the selected table cell. Initially, the window height is only a few lines, but you can increase
the height to show more lines and you can scroll within the window to view the entire contents of a cell.

File Home Report Table summary Export

& e I e e o B O s @
Q' Zoom To Fit [£] Coy Show Field Fi
Design Row Report Data View

¥4 Autosize Columns

Home Table View X hd

T oo o oo ~ % | Formal, fireplaced dining room. Large family room off gourmet kitchen. Hardwood floors throughout. Master bedroom has cathedral ceiling with loft and skylight. Sun deck overlooking large
] L Realtor MLS Number Town Style Rooms Bedrooms Baths  Price Remarks .

1
E Main

Formal, fireplaced dining room. Large family room off gourmet kitchen
Hardwood floors throughout. Master bedroom has cathedral ceiling with

319000 | Ioft and skylight. Sun deck overlooking large rolling lawn on 1.5 acre
wiooded lot in quiet country setting. Easy access to route 3, only minutes
to New Hampshire.

@

Harvest Homes Realtors 24543 Tyngshoro  Colonial 7 3 2.

Large bright eat-in kitchen, hardwood floors, fireplaced family room, 1/2
219000 acre level lot. Well maintained, zoned light industrial, close to routes 3
and 495 and schools. All appliances stay.

tn

Northran Real Estate 24614 Chelmsford  Garrison 6 3 1.

Large country kitchen with walk in pantry, 1/2 bath with laundry hook-
ups. Located in 2 well established neighborhood with a 1/4 acre private
yard. Walking distance to commuter train, schools and town center. No
WD or Refrigerator. Motivated seller.

n

1. Miller Realty 24737 Billerica Split Entry 7 3 1.5 229900

Top floor unit. Spacious living reom with cathedral ceiling and sliders

1650n0 Onto deck.  Attic space can be converted to loft above living room.  Fully
applianced eat-in itchen, private laundry 2nd storage. Near New
Hampshire border.

J8J Realty 24739 Dracut Condo 4 2 1.0

Top north Tewksbury neighborhood. Center isle kitchen with deck off

219900 9ining room. Cathedral cellings in family room and master bedroom.
Updated heating, plumbing and electrical systems. Full acre quiet
country setting within minutes of routes 495 and @3.

tn

Terrace Realtors 24775 Tewksbury ~ Ranch 6 3 1.

Recently remodeled kitchen with all new cabinets and appliances.
Cathedral ceilings in living room and master bedroom. Finished -
. »

Remarks - Memo - Detail (Detail) Filter: No Filter SorcNoSort  20Rows  100% ———#%———+

Figure 14-15. The Field Contents window displays the entire contents of the selected cell.

As you move the cell pointer from cell to cell in Table view, the Field Contents window will display the contents of
the selected cell. You can try this by using the down arrow key on the keyboard to scroll through the Remarks
field cells.
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USING MEMO FIELDS

Monarch does not allow a memo field to be used in a sort or summary definition. If you intend to include the field in a
sort or summary definition, you must leave the field type set to Character, or on rare occasions, change it to Numeric
or Date. In addition, there are differences in the way a memo field is exported and printed versus a character,
numeric or date field. These differences may or may not provide the results you expect or want. We'll touch on the
export and print issues later in this lesson.

Using Memo Fields in Calculated Field and Filter Expressions

As stated above, you cannot use a memo field in a sort or summary definition. However, you can use a memo field as
part of a calculated field expression. By creating a calculated field, you can extract a subset of the memo field that
you can then use in a sort or summary definition.

You can also use a memo field in a filter expression. We'll illustrate this using the Remarks field. Let's suppose the
Real Estate agent has a client interested in purchasing a new home and, among the client’'s other criteria, she wants
a home with a fireplace. Some of the property descriptions mention a fireplace and others do not. You could manually
review all of the Remarks cells in the table to find the ones that mention a fireplace, but this is a tedious process,
especially if there are hundreds of homes for sale.

To find out which homes have a fireplace, you can create a filter that will search the entire Remarks field and return
only those records where a fireplace is mentioned.

STEPS:

1. Onthe Table ribbon, select Template Design E’ > Add > Filter > Formula based. The Filter Definition
window displays.
Type Homes with a Fireplace in the Filter Name box and then select V_
Type Instr("fireplace" ,Remarks)>0 in the Expression box.
The Instr() function will return the character position of the word "fireplace" in the Remarks field. By setting the
filter to >0, we are capturing all cases where it appears anywhere in the description text.

4. Choose Apply v to accept your filter and then close the Filter Definition window by clicking Accept v

Monarch applies the filter, which returns 19 records. That may still be more property descriptions than you want
to read through, so let's narrow the choices by adding to the filter definition. While we’re already supposing, let's
further suppose that the client refuses to live in any town other than Tewksbury.

5. Select Template Design E’ > Filters v tool and then click on the Homes with a Fireplace filter from the
Filter Selector to display its properties.

6. Add .And.Town="Tewksbury" to the filter expression. The entire expression should now read:

Instr("fireplace",Remarks)>0.And. Town="Tewksbury"

Expression

Instr("fireplace”, Remarks) >0.And. Town="Tewksbury" -

Figure 14-16. Viewing the edited filter expression.
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7. Choose Apply v to accept your filter and then close the Filter Definition window by clicking Accept v in the
window’s ribbon.

8. Select the Homes with a Fireplace filter from the Active Filter drop-down list.

This time Monarch returns only three records representing homes with fireplaces in the town of Tewksbury. Let's
use the Display Source of Record feature to browse the original descriptions in the report.

Realtor MLS Number Town Style Rooms Bedrooms Baths Price Remarks

French doors leading from dining room to patio garden. Fireplaced
master bedroom with private deck. Exqguisite master bath with cathedral

Newell Properties 25047 Tewksbury  Colonial 7 3 2.5 329000 ceiling and skylight. Finished basement with recreation room, wet bar
and Jacuzzi. Located in private neighborhood with tennis courts and lake
access,

%

Contemporary design. White gourmet kitchen with hardwood floors,
large fireplaced formal dining room, central airfvacuum, security system.

Newell Properties 25134 Tewksbury  Cape 10 5 2.5 489000 Separate pool house with gunite pool, horse barn and attached in-law
apartment with full kitchen. Located on 5.7 private acres in north
Tewkshury near route 495. Subdivision possibilities.

Hardwood floors, cathedral ceilings in family room and master bedroom,
bright kitchen with pantry. Atrium doors to wrap-around deck. In-

Newell Properties 25198 Tewksbury  Ranch 14 5 3.5 389000 ground pool. Large attached in-law apartment with full kitchen,
fireplaced family room, 2 bedrooms and 1.5 baths. Three wooded acres
in secluded north Tewksbury neighborhood near route 495 and 38.

Figure 14-17. Memo fields used in filter expressions.

9. Click on any cell in the first row of the table.

10. Select the Find in Report @ button from the Table ribbon.

Monarch displays the associated property listing in the Report view.

Home m Table View v
Report Files. .1 cathedral ceiling with skylight and loft in master -

0 0 bedroom. Central air. Condo fees include in-ground
pool, tennis courts, basketball, clubhouse facilities.
E Homespm Close to routes 3 and 495.
»| Date Listed: 05/08/10 MLS §: 25047

» Listed By: Newell Properties
» Co-Broke Fee: 3%

»
» Price: $32%,000 ZAssessment: $319,000
» Town: Tewksbury Rate: 16.35
» style: Colonial Book: 1934
» Zddress: 2 Stevens Street Page: 783
» Est Age: B Taxes: $3580
»
» Lot Size: 30,000 Color: wWhite/Brick Fuel: Gas
» Basement: Full Rooms: 7 Hot Water: Gas
» Garage: 2 Bedrooms: 3 Water: Municipal
»| Other Bldg: No Baths: 2.5 Sewage: Town
»
» Remarks: French doors leading from dining room to patio garden.
Fireplaced master bedroom with private deck. Exquisite
master bath with cathedral ceiling and skylight.
Finished basement with recreation room, wet bar and
Jacuzzi. Located in private neighborhood with tennis
courts and lake access.
05/08/10 MERRIMACK VALLEY REALTORS ASSCCIATION Page 09
RrEPTH: 31 NEW PROPERTY LISTINGS =

] »

Figure 14-18. Displaying the source of a multiple line field.

You may repeat Steps 8-9 to view each of the other property listings. In Step 8, click any cell in the second row
to display the second listing or any cell in the third row to view the third listing.
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PRINTING MEMO FIELDS

When you print a memo field, Monarch treats the field as though it were a character field: it prints only that portion of
the field that is visible in the Table view. This produces a print image that reflects the data you see on screen. To print
the entire contents of a memo field, you can export the table to a text file, and then use a text editor or a word
processor to print the file.

At this point, you can either save your work or simply close the report and model files you opened for this lesson.
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[15] SUMMARIES

In this chapter, you will learn how to use the Summary window to analyze data from the table. The lesson topics
include:

0O Adiscussion of what a summary is
Creating a summary

Suppressing duplicate values

Adding subtotals and blank lines

Adding measure calculations

Adding item fields

Collapsing and expanding a summary
Specifying summary design preferences

Creating a quick summary

0O 000D 00 0 O

Copying, printing, and exporting summaries

This chapter assumes that you are familiar with importing and viewing report files, creating data extraction templates
and working in the Table view.

A summary tabulates information for selected fields and presents the results in a one- or two-dimensional matrix. For
example, the summary shown below show sales totals for a fictional distributor of classical music recordings, first
broken down by customer, then by media.

1 Betty's Music Store CcD 353.05
2 DvD £89.85
3 LP 64.74
4 Subtotal Betty's Music Store 507.64
5

6 Big Shanty Music cD 158.23
7 DvD 29.95
8 SACD 86.31
9 Subtotal Big Shanty Music 274.49
10

11 Bluegrass Records cD 122.34
12 DvVD 53.91
13 SACD 71.92
14 Subtotal Bluegrass Records 248.17
15

16 Canciones CcD 379.14
17 Subtotal Canciones 379.14
18

19  Chez Rudy cD 273.51
20 LP 44.95
21 Subtotal Chez Rudy 320.46

Figure 15-1. Sales by customer and media.

Altair Monarch 2024.1 Learning Guide 285



1 286.44

2 CD 5403.11
3 DVD 612.01
4 LP 475.57
3 SACD 579.05

Figure 15-2. Sales by media type.

The summaries shown above tabulate information about a single key field. In the first summary, the key field is the
Customer field and in the second summary the key field is the Media field. The field that is tabulated (or summed) is
called a measure. In both summaries shown above, the Amount field is used as the measure.

Although only a single key field and a single measure are required, a summary may be quite complex, including
multiple key fields and measures. Each measure can be used to calculate a variety of information about your data,
including the sum total, average, percent of total, minimum, maximum, standard deviation, and variance. Monarch
also provides a count function that can be used as a measure. Rather than performing a calculation on a selected
measure, the count function counts the number of records for each key.

For example, the summary in Figure 15-3 includes both the Customer and Media fields as key fields, and the count
function and Amount field as measures. Separate Amount calculations are used to break down total sales versus
average sales.

1 Betty's Music Store CD 42 353.05 58.84
2 DVD 15 89.85 44.93
3 LP 6 64.74 64.74
4 Big Shanty Music CD 18 158.23 31.65
3 DvD 5 29.95 29.95
6 SACD Q 86.31 86.31
7 Bluegrass Records CcD 12 122.34 40.78
8 DvVD 9 53.91 53.91
9 SACD 8 71.92 71.92
10 Canciones CcD 55 379.14 42,13
11 Chez Rudy CD 31 275.51 39.36
12 LP 5 44.95 44.95
13 Classic Exchange CcD 32 209.08 41.82
14 Das Piano CD 23 225.93 75.31
15 oDvVD 7 41.93 41.93
16 LP 11 111.46 55.73
17 SACD Q 161.82 161.82

Figure 15-3. Sales broken down by customer and media type. The Quantity column displays the number of items sold and
the Amount and AVG(Amount) columns display the total sales and average sales (partial summary shown).

A summary can also include item fields that expand the summary to show individual transactions. ltem fields provide
an advantage over viewing individual transactions in the Table view because you can use the summary to break
down subtotals.

The summary in Figure 15-4 includes the Customer and Media fields as key fields and the Quantity and Description
fields as item fields. This summary displays individual transactions for each media type within each customer.
Subtotals are generated for each customer.
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Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store
Betty's Music Store

Subtotal Betty's Music Store

Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music
Big Shanty Music

Subtotal Big Shanty Music

Bluegrass Records
Bluegrass Records
Bluegrass Records
Bluegrass Records
Bluegrass Records

Subtotal Bluegrass Records

CcD
CD
CD
CD
cD
CD
DVD
oDvD
LP

CD
cD
CD
CD
CcD
ovD
SACD

CcD
CD
CD
DVD
SACD

=BT Y- Y- Uy SR
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Luening, Electronic Music

Bartok, Sonata for Solo Violin

Mozart, Mass in C, K.427
Mendelssohn, War March of the Priests
Pizzetti, Messa di Requiem

Beethoven, Pathetique Sonata, Arau
Gershwin, An American in Paris
Scarlatti, Stabat Mater

Misc., Modern Trombone Masterpieces

Schubert, Sonata in e, D.566
Shostakovich, 24 Preludes for piano.
Mozart, Symphony No.23 in D
Schoenberg, Ode to Napoleon
Stravinsky, Dumbarton Oaks Concerto
Haolst, St. Paul's Suite for Orch.
Balakirev,Symphony no. 1

Faure, 28 Songs, Stulzmann
Takemitsu, Music of Takemitsu
Messiaen, Quatour pour la fin de temps
Schumann, Manfred Overture, Bav SO
Strauss, Ein Heldenleben, Op.40

20.38
35.96
63.00
71.92
95.90
65.89
35.04
53.91
64.74

507.64

9.00
10.78
26.97
57.54
53.94
29.85
86.31

274.49

53.94
10.80
57.60
53.91
71.92

248,17

Figure 15-4. Item fields are used to display individual transactions (partial summary shown).

The Summary View Interface

The Summary View interface is similar to the Report and Table view interfaces; it includes a ribbon, the Summary

selector, and the Summary window.
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P=gn ¥t Autosize Columns
Home Report View Table View
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Mozart, Mass in C, K.427
Mendelssohn, War March of the Priests
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Beethoven, Pathetique Sonata, Arau
Gershwin, An American in Paris
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35.96
63.00
71.92
95.90
65.89
35.94
53.91
64.74
507.64

9.00
10.78
26.97
57.54
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28.95
86.31

274.49
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10.80
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53.91
71.92
248.17
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189 Rows.
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Figure 15-5. The Summary view interface
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The Summary View Context Menu

Right-clicking on the Summary selector displays a context menu that will allow you to perform the following

operations:

0O Perform a quick export - This export operation uses
the default file extension and values specified in
Export Settings and presents the Create Export

dialog with all elements prefilled

Rename a summary

Edit a summary (via the Summary Design

interface)

O  Duplicate a summary

Rebuild a summary (if a specific summary is

selected)

a
a
a
a
a
a
a
a

Rebuild all summaries

Print a summary

Quick print a summary

Preview a summary before printing

Move a summary to the top of the selector
Move a summary up one position

Move a summary down one position

Move a summary to the bottom of the selector

Similarly, right-clicking in Summary view displays a context menu that will allow you to:

0O  Copy text (with/without headers)
Copy with formatting (with/without headers)

O 0O 0O o0 0 D

Autosize columns

Search for a record

Adjust column widths

Find a specific value in the table

Go to a specific row in the summary

Go to a specific column in the summary

a
a
a
a
a
a
a

Display field properties
Set the active measure
Set a summary filter
Print the table

Launch Print Preview
Export the summary

Launch the Summary Design interface

To start this lesson, load Monarch and open Classic.prn and Lesson7.dmod. Go on to Table view and select
Autosize Columns *3* from the ribbon to maximize your view of all the fields.

File Home Report Table summary Export ?
54 SelectAl |\ i i oo i R o a Y
Table T 1] Copy fEFoE Search  Goto  Findin Rebuild Showfield  fresze
T=zm +i4 Autosize Columns Row  Report Dsta View anten ness
~
Home  Report View m v
Report Date _ Order Number  Ship Date Account Number Contact Customer Address 1 Address 2 City ~
T ol 1 536017 4/10/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
2 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
Main 3 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
4 512010 538017 4/10/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
5 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
6 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
7 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Cec
8 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Ce
9 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store Muscatine Plaza 200 Lower Muscatine Ce
10 512010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 3638 Springs Ferry Suite C-130 Mal
1 512010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 3638 Springs Ferry Suite C-130 Mal
12 512010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 3638 Springs Ferry Suite C-130 Mal
13 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 3658 Springs Ferry Suite C-130 Mal
14 512010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 3638 Springs Ferry Suite C-130 Mal
15 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 3658 Springs Ferry Suite C-130 Mal
16 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 3638 Springs Ferry Suite C-130 Mal
17 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records Hwy 17 3t the 9 mile marker Pro
18 5/1/2010 536020 4/10/2010 10929 Roberto Gl Bluegrass Records Hwy 17 t the 9 mile marker Pro
19 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records Hwy 17 3t the 9 mile marker Pro
20 5/1/2010 536020 4/10/2010 10929 Roberto Gl Bluegrass Records Hwy 17 at the 9 mile marker Pro
21 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records Hwy 17 3t the 9 mile marker Pro
2 5/1/2010 536012 4/1/2010 18635 Alzin Lebon Musique du Monde 170 Rue de |2 Poste Flet
23 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 170 Rue de |2 Poste Flet
24 5/1/2010 536012 4/1/2010 18635 Alzin Lebon Musique du Monde 170 Rue de |2 Poste Flet
25 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 170 Rue de |2 Poste Flet
26 5/1/2010 536012 4/1/2010 18635 Alzin Lebon Musique du Monde 170 Rue de |2 Poste Flet
27 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 170 Rue de |2 Poste Flet
28 5/1/2010  RA6D21 4/10/2010 18635 Alzin Lebon Musique du Monde 170 Rue de |2 Poste Flet
20 5/1/2010  RAG021 4/10/2010 18635 Alain Lebon Musique du Monde 170 Rue de |2 Poste Flet
30 5/1/2010  RA6021 4/10/2010 18635 Alain Lebon Musique du Monde 170 Rue de |2 Poste Fler=

Report Date - Date/Time - Page Hesder (Page Header)

Filter- No Filter Sort NoSort 149 Rows _ 100% — ——H&———+

Figure 15-6. Extracted data displayed in the Table view.
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By creating summaries, we can analyze the data to reveal trends and relationships that would otherwise remain
buried. Let's create a simple summary that tabulates sales quantities and totals for each media type (CDs, SACDs,
DVDs, etc.) within each customer.

CREATING A SUMMARY

To create a summary, you select key fields and measures.

Key fields are used to define the summary matrix. For example, the summary in Figure 15-1 uses the Customer field
as the key field. Monarch examines the field and creates a list of all unique values found within the field (e.g., Betty’s
Music Store, Big Shanty Music, etc.), then uses these values to create the summary matrix.

Measures are numeric fields that are summed for each unique key field value. For example, in Figure 15-1 the
Amount field is broken down into separate totals for each customer. Monarch also provides a count function that can
be used as a measure. Rather than calculating a result for a specific field, the count function simply counts the
number of records that match each for each key field value (for example, there may be 10 records for Betty’s Music
Store and 8 for Big Shanty Music, etc.).

Let's begin by creating a summary that displays sales broken down by customer and media type. We’'ll use the
Customer and Media fields as the key fields and the Amount field as the measure.

STEPS:

1. Select the Summary tab and then click Summary Design > Add Summary ﬁ'
Design interface.

to activate the Summary

Design

7 o i N ?

v X B R & * + -

Accept  Cancel Add Duplicate Delete Definition  Add / Remove Al Keys ltems  Measures Page Help
Summary  Summary  Summary Fields Fields Setup

SUMMAaFries 500

7
1 el Summary Properties

B Summary
Name: Summary

Apply Filter: Defaut Filter v
Default style: AsBbCeDd Edit
e [ | o
Insert total line
Label: Style: | AaBbCeDe Edit

Insert |0 blank lines before total line. Apply label style to measure columns

Comment:

oow ———————+

Figure 15-7. The Summary Definition window.
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The following table summarizes the functions of each of the buttons in the Summary Design ribbon.

LV 4 Accent Accept the new template or changes to an
P existing template
“ Saee] Cancel the new template or changes to an

existing template

Add a new summary
Add summary

_ Duplicate a summary
Duplicate summary

Delete the selected summary
Delete summary

Add or modify a summary definition.
Definition

Add or remove key, measure, and item fields
Add/Remove fields

Display the properties of all of the fields

o GB AP R o 4T X% 2

All fields

Display the properties of all key fields
Keys

Display the properties of all measure fields
Items

Display the properties of all item fields
Measures

BN Launch the Page Setup window

imnn Page setup

Launch the Help file
= Help

2. In the Name field, type in Summaryl and then click the adjacent ¥ icon that appears to accept this name.

3. Select Add/Remove Fields to begin specifying your key, measure, and item fields.

ADDING KEY FIELDS AND MEASURES

Let's get right to adding key fields and measures by clicking on the + Add/Remove Fields button. The
Add/Remove Fields command displays a list of the fields that are available for use in a summary definition. This list
includes all the fields available in Table view except for memo fields. To add a field to the summary definition, you
select the field from the Table Field box, and then click the appropriate button (Key, Item, or Measure) to add the
field to the corresponding box at the right. Our summary requires the Customer and Media fields as key fields, so let's
select those fields.

STEPS:

1. Select Customer from the list of available fields, and then select Add Key.
Customer displays in the Key Field list.

2. Select Media from the list of available table fields and then select Add Key.
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Now, both Customer and Media display in the Key Field list.

Maove Up Move Dow
Key Field Sorting Layout Matching
Customer Asc Down All values
Media Asc Down All values

Figure 15-8. Specified key fields.

Several properties are assigned to each field, as you can see from the entries in the corresponding subtabs in
the Key screen. For now, we'll accept these default properties. (We'll explore the properties for Key fields, Item
fields, and Measures later in this lesson and in the next lesson.)

The next step is to select the measures that we want to include in our summary definition. Since we want our
summary to tabulate sales totals, we'll select the Amount field as a measure.

Select Amount from the list, and then click Add Measure.

Amount displays in the Measure Field list.

Mave Up Move Dow Count
Measure Calculation
Amount SUM({[Amount])

Figure 15-9. The specified measure.

We have just finished specifying our key and measure fields.

SELECTING FILTERS TO APPLY IN SUMMARIES

When you create a summary definition, you may assign a filter to limit the records available to the summary. The
Apply Filter box, which is accessed by selecting the Definition button on the Summary Design ribbon, provides
several filtering options.

a

You may select a filter to apply when building the summary. The filter you select is applied to the data only to
build the summatry. It is not applied to Table view and it does not limit the data available to other summaries.
When building and displaying the summary, the filter overrides any filter that you may have applied in the Table
view - it is not applied along with the active table filter.

You may select No Filter. The No Filter option turns off filtering for the summary. The summary is built using all
records. This option, like the previous option, overrides any filter that you may have applied in the Table view.

You may select Default Filter. The Default Filter option applies the filter that is currently applied to the Table
view. This option uses only the records that are available to the Table view at the time the summary is built. If
you switch the filter that is applied to the Table view or modify its definition, the summary is recalculated to reflect
the changes.

We want to use all records to build our summary, so we'll use the default value of No filter to turn off filtering for this
summary.
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SUPPRESSING DUPLICATE VALUES

Most report writers include a facility to suppress duplicate values for selected fields. Suppressing duplicate values
reduces the amount of visual clutter in a report and helps to emphasize details. Monarch also includes this facility,
allowing you to suppress duplicate values for any key field in a summary (except for the rightmost key field, which
never contains duplicate values).

Let's suppress duplicate values for the Customer key field.

STEPS:

1. Select the Keys button from the Summary Design ribbon.
A list of specified key fields as well as their corresponding properties displays.

The Keys screen includes several subtabs that organize key field properties into logical groups. The Layout
subtab includes key field properties that determine how the key field is displayed, including an option to suppress
duplicate values.

2. Select the field Customer from the Key Field selector and then click the Layout subtab.

Locate the drop-down box for Orientation > Down, click the drop-down arrow, and then select Suppress
duplicates.

3. Click Accept Y o accept the changes made to your summary.

The summary is rebuilt, and duplicate customer names are removed.

Home Report View Table View Summary View

Summary Definitions ~ R

1 fo) 1 |Betty's Music St... |CD 353.05
2 DvVD 89.85

& Summary 3 Lp 64.74
4  Big Shanty Music CD 158.23
= DvVD 29.95
6 SACD 86.31
7 Bluegrass Recor... CD 122.34
8 DvVD 53.91
9 SACD 71.92
10 Canciones cD 379.14
11 Chez Rudy cD 275.51
12 LP 44.95
13 Classic Exchange CD 209.08
14 Das Piano cD 225.93
115 ovD 41.93
16 LP 111.46
17 SACD 161.82
18 Die Harmonie cD 100.04
19 DvVD 64.46
20 Die Melodie cD 362.56
21 LP 23.96
22 SACD 86.31
23 Fandangos Rec... CD 213.90
24 ovD 11.98
25 Hope's Sweet N... BLU 77.90
26 cD 481.06
27 DvVD 59.90
28 LP 43.11
28 Mo Town Tunes CD 211.03
30 DvVD 23.96

Figure 15-10. Duplicate values removed from the Customer column.
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ADDING SUBTOTALS AND BLANK LINES

You can add subtotals and blank lines to a summary after each logical group of information. Subtotal lines and blank
lines are added whenever the value of the selected key field changes. To illustrate this, let's add subtotals for each
customer and add blank lines to separate each customer group.

STEPS:

Select Summary Design > Keys.
Select the Customer key and then click the Layout subtab.
Under the “After each key value change” heading, check the Insert subtotal line check box.

Select 1 from the “Insert n blank line(s) after each key value change” field drop-down list.

o M w NPk

Click Accept v 1o accept the changes made to your summary.

The summary is rebuilt. A subtotal line and a blank line are added directly underneath each customer group.

Home Report View Table View Summary View

Summary Definitions

N L

1 (Betty's Music St... |CD 353.05
2 DvD 89.85
& Summary 3 LP 64.74
4 Subtotal Betty's Music Store 507.64
5
6 Big Shanty Music CD 158.23
7 oDVD 29.95
8 SACD 86.31
9  Subtotal Big Shanty Music 274.49
10
11 Bluegrass Recor... CD 122.34
12 DvD 53.91
13 SACD 71.92
14 Subtotal Bluegrass Records 248.17
15
16 Canciones CcD 379.14
17 Subtotal Canciones 379.14
18
19 Chez Rudy CcD 275.51
20 LP 44,95
21 Subtotal Chez Rudy 320.46
22
23 (lassic Exchange CD 209.08
24 Subtotal Classic Exchange 209.08
25
26 Das Piano CD 225.93
27 DvD 41.93
28 LP 111.46
29 SACD 161.82
30 Subtotal Das Piano 541.14

Figure 15-11. Subtotals are displayed for each customer. Blank lines separate each customer group.

ADDING MEASURE CALCULATIONS

Our summary report breaks out sales totals for each media type and each customer. While this is useful, you may
want to perform other analyses on the data. Monarch supports several calculations you can perform when building a
summary.

For each measure you include in your summary definition, you can calculate the total, average, percent of total,
minimum or maximum value, standard deviation, or variance. To perform multiple calculations, you add multiple
copies of a measure to the summary definition, one for each calculation you want to perform. In addition to the
measure calculations, a count function is included that you can use to tabulate the number of records matching each
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set of key field values and a special ratio calculation option that divides subtotals for one field by subtotals for another
field.

Let’'s edit the summary definition to add the percent of total sales calculation for the Amount measure.

STEPS:

1. Select Summary Design > Add/Remove Fields.

2. Select Amount from the list of available fields that displays, and then click Add Measure.
This adds a new Amount field to the Measures screen.
Select the Measures button from the Summary Design ribbon.

4. Select this new Amount field (the second one on the list) and then click the Formula subtab.

Measures ~ B General Calaringand Limits ~
i £ Fields e e R A Operators ittt i FURCHONS o e b
= Amount Account Number - Add All aggregations =
= Amount Amount - Subtract Aval) -
Discount ; E::;‘:‘y Count(*)
Quantity 0 Parentheses CountPct(*)
Unit Price [} Brackets for enclosing long fi CountSubPct(*)
~* Comment Cum()
CumCount{*)
1 ¥ CumCountPct{*) -
_Ii
SUM{ [Emount] } -

Figure 15-12. The new Amount subtab showing the Formula options.

5. Delete SUM ([Amount]) from the Expression field, and then enter PCT([Amount]) instead. Click the Apply v
icon that displays in the field when you are finished.

Measures ~ I General Colering and Limits ~
il L Fields = Operators o Functions =
L
= Amount Account Number + Add All aggregations v
= Amount Amount - Subtract Avgl) -
® Multiph
Discount . Py Count(*)
/ Divide
.
Quantity 0 Parentheses CountPct(*)
Unit Price 1 Brackets for enclosing long fi | CountSubPct(*)
= Comment Cum()
CumCount(*)
1 ¥ CumCountPct(*) -
—
PCT]{ [Amount] } o

Pctifield) Returns the group sum as a percentage of the total sum.

Figure 15-13. Entering a new expression.
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6. Select the General subtab.
Note that Amount is suggested as the column title. Let's modify this title to read %Amount.

7. Click on the Use default title check box to deselect this option (the check mark should be removed).
When the Use Default Title option is unselected, the Title box is activated.

8. Type %Amount in the Title box.

9. Under Display Settings, click on the Custom radio button.

10. Select Percentage from the Format drop-down list.

11. Specify a Decimals setting of 1.

12. Click Accept ¥ in the ribbon to accept your changes and close the Summary Definition window.

The summary is rebuilt with the new %Amount measure.

Home Report View Table View Summary View X
Summary Definitions v g Customer  Meda  Amount  SAmount
1 0O 1  Betty's Music Store cD 353.05 4.8%
2 DvD B89.85 1.2%
& Summary 3 Lp 64.74 0.9%
2 Sales by Media 4 Subtotal Betty's Music Store 507.64 6.9%
& Sales by Customer and Media o
] 6  Big Shanty Music cD 158.23 2.2%
& Sales by Customer and Media_2 7 oVD 20.95 0.4%
8 SACD B86.31 1.2%
9  Subtotal Big Shanty Music 274.49 3.7%
10
11 Bluegrass Records cD 122.34 1.7%
12 oDvD 53.91 0.7%
13 SACD 71.92 1.0%
14 Subtotal Bluegrass Records 248.17 3.4%
15
16 Canciones CcD 379.14 5.2%
17 Subtotal Canciones 379.14 5.2%
18
19  Chez Rudy CcD 275.51 3.7%
20 LP 44.95 0.6%
21 Subtotal Chez Rudy 320.46 4.4%
22
23 Classic Exchange cD 209.08 2.8%
24  Subtotal Classic Exchange 209.08 2.8%

Figure 15-14. Summary with a %Amount calculation.

ADDING ITEM FIELDS

Item fields are optional fields that you can use to expand a summary to show individual transactions. Item fields
provide an advantage over viewing individual transactions in Table view because you can use the summary to break
down subtotals.

Let's add the Quantity and Description fields to our summary definition as item fields.

STEPS:

1. Select Summary Design > Add/Remove Fields.

2. Select Quantity from the Table Fields list that displays, and then select Add Item.
3. Select Description from the Table Fields list and then select Add Item.
4

Choose Accept ¥ in the ribbon to accept the modified summary definition.
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Monarch rebuilds the summary and displays the item fields.

Home Report View Table View Summarj.' View X

Summary Definitions : 1

i ol 1 CD Bartok, Sonata for Solo Violin 35.96 0.5%
2 D Beethoven, Pathetique Sonata, Arau 65.89 0.9%

& Summary 3 D Luening, Electronic Music 20.38 0.3%
4 D Mendelssohn, War March of the Priests 71.92 1.0%
5 CcD Mozart, Mass in C, K.427 63.00 0.9%
6 D Pizzetti, Messa di Requiem 95.90 1.3%
7 DVD Gershwin, An American in Paris 35.94 0.5%
8 DvVD Scarlatti, Stabat Mater 53.91 0.7%
9 LP Misc., Modern Trombone Masterpieces 64.74 0.9%
10 Subtotal Betty's Music Stare 507.64 6.9%
11
12 Big Shanty Music D Mozart, Symphony No.23 in D 26.97 0.4%
13 CcD Schoenberg, Ode to Napoleon 57.54 0.8%
14 cD Schubert, Sonata in e, D.566 9.00 0.1%
15 D Shostakovich, 24 Preludes for piano. 10.78 0.1%
16 cD Stravinsky, Dumbarton Oaks Concerto 53.94 0.7%
17 DVD Holst, St. Paul's Suite for Orch. 29.95 0.4%
18 SACD Balakirev,Symphony no. 1 86.31 1.2%
19  Subtotal Big Shanty Music 274.49 3.7%
20
21 Bluegrass Records cD Faure, 28 Songs, Stulzmann 53.94 0.7%
22 D Messiaen, Quatour pour Ia fin de temps 57.60 0.8%
23 <D Takemitsu, Music of Takemitsu 10.80 0.1%
24 DVD Schumann, Manfred Overture, Bav SO 53.91 0.7%
25 SACD Strauss, Ein Heldenleben, Op.40 71.92 1.0%
26  Subtotal Bluegrass Records 248.17 3.4%

Figure 15-15. A newly constructed summary showing item fields.

COLLAPSING AND EXPANDING A SUMMARY

Expanding or collapsing (referred to as drilling down or drilling up) a summary provides a quick way of exploring
summary data.

0 Collapsing (Drilling up)

Reduces the level of detail in the summary, revealing higher level information. To collapse a summary, Monarch
removes the rightmost key field from the summary, then re-calculates and re-displays the summary.

0 Expanding (Drilling down)

Restores the previously removed key fields to the summary display. When item fields are included as part of the
summary definition, you view the item fields by drilling down the itemized level.

Let’s start by drilling up to hide the item fields we added to our summary definition.

STEPS:

1.  From the Summary View ribbon, select Drill Up =

The item fields are removed, restoring the summary to its initial state.

2. Click Drill Up =~ once more.

Monarch further collapses the summary by removing a key field; in this case, the Media field. The collapsed
version of the summary shows sales broken down by customer.

Altair Monarch 2024.1 Learning Guide 296



Home Report View Table View Summary View

Summary Definitions -

A fe) 1 |[Betty's Music Store 507.64 6.9%
2 Big Shanty Music 274.49 3.7%
& Summary 3  Bluegrass Records 248.17 3.4%
4 Canciones 379.14 5.2%
5  Chez Rudy 320.46 4.4%
6 Classic Exchange 209.08 2.8%
7 Das Piano 541.14 7.4%
8 Die Harmenie 164.50 2.2%
9 Die Melodie 472.83 6.4%
10 Fandangos Records 225.88 3.1%
11 Hope's Sweet Notes 661.97 9.0%
12 Mo Town Tunes 234.99 3.2%
13 Musigue du Monde 360.94 4.9%
14 Musique Royale 595.43 8.1%
15 Motas Musicales 326.96 4.4%
16 Reiner's Symphonic Sou... 462,52 6.3%
17 Spinning Records 419.49 5.7%
18 The Glass Harmonica 288.35 3.9%
19 The King's Place 333.64 4.5%
20 The Record Store 328.56 4.5%

Figure 15-16. After drilling up twice, the summary breaks out totals only by customer.

3. Select Drill Down *° from the Summary View ribbon.
The summary is restored to its original state. Let's expand the summary even further to once again view the item
fields we added.

4. Click Drill Down ¥° once more.

The summary is expanded to display the item fields. At this itemized level, each line in the summary
corresponds to an individual transaction from the Classic report.

Home Report View Table View m

Summary Definitions ~ 1

1 ol 1 D Bartok, Sonata for Solo Vielin 35.96 0.5%
2 cD Beethoven, Pathetique Sonata, Arau 65.89 0.9%

8 Summary 3 D Luening, Electronic Musi 20.38 0.3%

g, Electronic Music

o cD Mendelssohn, War March of the Priests 71.92 1.0%
& <D Mozart, Mass in C, K.427 63.00 0.9%
6 CcD Pizzetti, Messa di Requiem 95.90 1.3%
7 DVD Gershwin, An American in Paris 35.94 0.5%
8 DVD Scarlatti, Stabat Mater 53.91 0.7%
9 LP Misc., Modern Trombone Masterpieces 64.74 0.9%
10  Subtotal Betty's Music Store 507.64 6.9%
11
12 Big Shanty Music CcD Mozart, Symphony No.23 in D 26.97 0.4%
13 cD Schoenberg, Ode to Napoleon 57.54 0.8%
14 D Schubert, Sonata in e, D.566 9.00 0.1%
15 CcD Shostakovich, 24 Preludes for piano. 10.78 0.1%
16 D Stravinsky, Dumbarton Oaks Concerto 53.94 0.7%
17 oDvD Holst, St. Paul's Suite for Orch. 29.95 0.4%
18 SACD Balakirev,Symphony no. 1 86.31 1.2%
19 Subtotal Big Shanty Music 274.49 3.7%
20
21  Bluegrass Records D Faure, 28 Songs, Stulzmann 53.94 0.7%
22 cD Messiaen, Quatour pour |a fin de temps 57.60 0.8%
23 D Takemitsu, Music of Takemitsu 10.80 0.1%
24 DvD Schumann, Manfred Overture, Bav SO 53.91 0.7%
25 SACD Strauss, Ein Heldenleben, Op.40 71.92 1.0%
26 Subtotal Bluegrass Records 248.17 3.4%

Figure 15-17. Completely expanded, the summary displays individual transactions (partial summary shown).
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COPYING AND PRINTING SUMMARIES

You can copy summary data to other applications or print it. You perform these operations in the Summary window
the same way you perform them in Report view or Table view.

DUPLICATING SUMMARIES

You may want to create a new summary that closely resembles a summary you previously defined. An easy way to
do this is by using the Duplicate @ button. To duplicate a summary, simply select the summary you want to

duplicate from the Summary list and then select Duplicate a from the Summary Design ribbon. The duplicated
summary appears on the Summary list; this summary will have the name of the summary you duplicated and a
number appended to it. Select this summary to display its properties in the Summary Definition window and make
further revisions to it. Select Accept when you are finished to accept and save your new summary definition.
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[16] ADVANCED SUMMARY
CAPABILITIES

In the previous chapter, you learned how to define a summary report using Monarch’s Summary window. In this
chapter, you'll continue your tour of the Summary window and learn how to create more advanced summary reports
to reveal more information about your data. The lesson topics include:

0 Displaying key field values across
0 Sorting a summary

0 Creating atop 10 analysis

0 Specifying key field values

This chapter assumes that you have completed Chapter 15 and are familiar with the process of creating a summary
definition.

To start these lessons, we'll load Monarch and open Classic.prn and Lesson8.dmod. Go on and display Summary
view.

SUMMARY DISPLAYS

Summaries can be configured to show various details. The following sections outline the steps to do so.

Displaying Key Field Values Across

When more than one key field is included in a summary report, the values for the first key field are repeated (see the
values for the Customer field in the preceding illustration). This can sometimes make for a crowded feel and does not
offer the most efficient method of displaying data.

While you could suppress duplicate values to provide a cleaner summary display, the summary still requires a large
number of rows on screen. With only 20 customers represented in our summary, the summary extends 95 rows, or
about two pages.

To provide a more compact summary display, Monarch allows you to display the values for the rightmost key field (in
this case, Media) across the top of the summary, creating a two dimensional matrix. This format, sometimes referred
to as a crosstab summary, allows for quick comparisons of multiple data groups.

For summaries like the one we've created, this format provides an ideal solution since it displays the entire summary
matrix on screen at one time. Let’'s see how this works.

STEPS:

1. Ensure that the Sales by Media summary is highlighted in the Summary selector.
2. Select Summary Design > Keys and then select Media from the Key Fields selector to display its properties.
3. Select the Layout subtab, select the Across (row) radio button, and then choose Accept ¥ from the ribbon.

The summary is rebuilt with the Media values spread across the top row.
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Customer BLU cD DVD LP SACD  SUM({Amount)

1 |Betty‘5 Music Store -—- 353.05 89.85 64.74 --- 507.64
2 Big Shanty Music - 158.23 29.95 - 86.31 274.49
3 Bluegrass Records - 122.34 53.91 - 71.92 248.17
4  Canciones --- 379.14 - - --- 379.14
5 Chez Rudy - 275.51 - 44.95 --- 320.46
6 Classic Exchange -— 209.08 — - - 209.08
7 Das Piano - 225.93 41.93 111.46 161.82 541.14
8 Die Harmonie - 100.04 64.46 - --- 164.50
9 Die Melodie -—- 362.56 - 23.96 86.31 472.83
10 Fandangos Records - 213.90 11.98 - --- 225.88
11 Hope's Sweet Notes 77.90 481.06 59.90 43.11 --- 661.97
12 Mo Town Tunes --- 211.03 23.96 - --- 234.99
13 Musique du Monde 95.90 283.01 -17.97 -— - 360.94
14 Musique Royale --- 515.17 - 80.26 - 595.43
15 Notas Musicales 85.08 168.94 10.78 62.16 --- 326.96
16 Reiner's Symphonic Sounds - 361.29 68.28 32.95 - 462.52
17 Spinning Records -— 317.66 89.85 11.98 - 419.49
18 The Glass Harmonica 9.59 211.56 -— - 67.20 288.35
19 The King's Place -—- 203.02 25.13 - 105.49 333.64
20 The Record Store 17.97 250.59 60.00 -— - 328.56
21 Summary 286.44 5403.11 612.01 475.57 579.05 7356.18

Figure 16-1. Summary with customer values displayed down and media values displayed across.

Displaying Null Values

For some media types, such as BLU (Blu-ray discs) and LP (Long Play albums), no sales have been made to certain
customers. For example, see the “---" strings in the BLU column for the first ten customers. In this case, it would be
incorrect to display a zero value in the summary report, since zero might suggest that some amount of sales were
made to this customer.

For example, consider the case where a customer places an order for several DVDs and in the same period returns
several previously purchased DVDs. If the total purchase price of the returned media equals the price of the new
media, the value for this customer would be zero, indicating a net purchase of zero. However, if the customer never
placed any orders for digital compact cassettes, a zero would not be appropriate. In this case, the value of “---”
indicates that no sales or returns have been recorded for this media type.

By default, Monarch displays null values as the string “(null)”, but you can specify another string, or even a blank
string, to represent null values if you like. You might find the string “(null)” a bit distracting when you'’re viewing this
type of summary report, so let's change the default string to something else.

STEPS:

1. Select Home and then click the Options oﬁ button to launch the Options window.
2. Select the View button from the Options ribbon to display the View options.
From this screen, you can set several options that affect the way data is displayed on screen in Monarch.

3. Click in the Display null values as edit box, change the “(null)” string to “***”, and then click Accept ¥ in the
window’s ribbon.

The Sales by Media summary is redisplayed using the string you specified.
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Customer
1 [Betty's Music Store
2 Big Shanty Music
3 Bluegrass Records
4 Canciones
5
6
7
8

Chez Rudy
Classic Exchange
Das Piano
Die Harmonie
9  Die Melodie
10 Fandangos Records
11 Hope's Sweet Notes
12 Mo Town Tunes
13 Musigue du Monde
14 Musique Royale
15 Notas Musicales
16 Reiner's Symphonic Sounds
17 Spinning Records
18 The Glass Harmonica
19 The King's Place
20 The Record Store
21 Summary

9.59

HEE

17.97

286.44

CD
353.05
158.23
122.34
379.14
275.51
209.08
225.93
100.04
362.56
213.90
481.06
211.03
283.01
515.17
168.94
361.29
317.66
211.56
203.02
250.59

5403.11

DVD
89.85
29.95

53.91
xEE

EEE

41.93
64.46
KR
11.98
59.90
23.96
-17.97
EEE
10.78
68.28
89.85
EEE
25.13
60.00
612.01

SACD
e
86.31

71.92
EE

67.20
105.49
HEE

579.05

SUM(Amount)
507.64
274.49
248.17
379.14
320.46
209.08
541.14
164.50
472.83
225.88
661.97
234.99
360.94
595.43
326.96
462.52
419.49
288.35
333.64
328.56

7356.18

Figure 16-2. Null values represented by *.

4. Return the previous null value before moving forward with the lesson.

Adjusting Column Widths

Sometimes, you can avoid scrolling altogether by reducing the column widths in a summary so that all of the
information fits on screen. When Monarch builds a summary, it sets the column widths wide enough to handle large
numbers, such as 1,000,000.00. If the resulting columns are wider than you need to display your summary data, you

can adjust them to fit more columns on screen.

NOTES

Column Widths for Across Keys

All of the columns generated from an across key field (in this case the CD, BLU, LP, DVD,
and SACD) columns are based on the column width of the measure. To set the column
widths, either use the mouse as described below or double-click on the measure (the last
column of the summary) and use the Measure window to change the width of the measure.

All columns related to the key field will snap to the width assigned to the measure.

You can use the mouse to set column widths. Using the mouse is less precise than using
the window, however, requiring you to estimate the column width. To use the mouse to set a
column width, position the mouse cursor at the right edge of the column title. The mouse
cursor changes to a resizing handle. Click down and drag left or right until the column title is

the desired width.
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Freezing Panes

When you spread key values across the top of the summary matrix, the summary often becomes wider than the
display width, especially if you are using a 640 x 480 display. Scrolling right to view more information often removes
the most important information from the display, i.e., the highest-level key fields, in this case the Customer field. To
prevent columns from scrolling off screen, you can use Monarch’s Freeze Panes command. Let's freeze the
Customer column and then scroll right to view the rest of the summary columns.

STEPS:

1. Ensure that the Sales by Media summary is highlighted in the Summary selector.

2. Click on the column heading BLU so the entire column is highlighted.

3. Select Freeze Panes - from the Summary view ribbon.

The Freeze Panes command acts just like the same named command in Microsoft Excel: it locks all rows above
the cell pointer and all columns to the left of the cell pointer so that they remain on screen when you scroll the
rest of the summary. This command also works in the Table view, and is retained in Excel file exports.

4. Click on the arrow on the right side of the horizontal scroll bar to scroll right.
Note that the Customer column remains visible while you scroll.
5. Use the arrow at the left edge of the scroll bar to scroll back to the left.

6. Select the drop-down button of the Freeze Panes tool and then select Unfreeze Panes . to unfreeze the
Customer column.

Viewing Other Measures

You may have noticed that our summary displays only a single measure calculation, even though it displayed two
measures when we started this lesson.

When you elect to display values for a key field across the top of the summary, Monarch forms a two-dimensional
matrix that displays a single measure at a time by default. To display results for a different measure, you can select it
from the Active Measure drop-down list on the Summary window. This list displays the names for all measures
included in the summary definition. When you select a measure from this list, the summary is redisplayed to show the
results calculated for that field.

STEPS:

1. Ensure that the Sales by Media summary is highlighted in the Summary selector.

2. Onthe Summary view ribbon, click the drop-down arrow of the Active Measure list box. This box currently
displays “Amount.”

port Table Summary Export
¥ - Selact All d,b piiz I::l Active Measure [Amount |'|

o = ) Amount

o Fit [£] Copy Seach Goto  Findin DrilUp 3,

e Columns Row Table meun

[ All, by key

All, by measure
Summary View >

Figure 16-3. The Active Measure drop-down list in the Summary tab.

3. Select %Amount from the list of available measures.
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1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21

Customer

[Betty's Music Store

Big Shanty Music
Bluegrass Records
Canciones

Chez Rudy

Classic Exchange
Das Piano

Die Harmonie

Die Melodie
Fandangos Records
Hope's Sweet Notes
Mo Town Tunes
Musique du Monde
Musique Royale
Notas Musicales
Reiner's Symphonic Sounds
Spinning Records
The Glass Harmonica
The King's Place

The Record Store
Summary

0.13
0.24
3.89

YAmount
6.90
3.73
3.37
5.15
4.36
2.84
7.36
2.24
6.43
3.07
9.00
3.19
4.91
8.09
4.44
6.29
5.70
3.92
4.54
4.47

100.00

Figure 16-4. Viewing the %Amount measure.

The summary is re-displayed to show media sales as a percentage of total sales. Note that the Summary line at the

bottom of the summary displays the percentages represented by each media type across all customers and the
rightmost column represents percentages for by each customer across all media types.

Displaying Multiple Measures in Across Key Summaries

Monarch allows you to display multiple measures in across key summaries. Let’s try doing this.

STEPS:

1. Ensure that the Sales by Media summary is selected.

2. Click the drop-down arrow on the Active Measure drop-down list and select All, by Key.

Monarch displays both of the measures grouped by key.
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21

Customer

Big Shanty Music
Bluegrass Records
Candiones

Chez Rudy

Classic Exchange
Das Piano

Die Harmonie

Die Melodie
Fandangos Records
Hope's Sweet Notes
Mo Town Tunes
Musique du Monde
Musique Royale
Notas Musicales
Reiner's Symphonic Sounds
Spinning Records
The Glass Harmonica
The King's Place
The Record Store
Summary

BLU

SUM({Amount) %Amount

9.59
17.97
286.44

0.13

0.24
3.89

cD DVD
SUM(Amount) %Amount SUM(Amount)
353.05 4.80 89.85
158.23 2.15 29.95
122.34 1.66 53.91
379.14 5.15 -—
275.51 3.75 -
209.08 2.84 -
225.93 3.07 41.93
100.04 1.36 64.46
362.56 4.93 -
213.90 2.91 11.98
481.06 6.54 59.90
211.03 2.87 23.96
283.01 3.85 17.97
515.17 7.00 -
168.94 2.30 10.78
361.29 4.91 68.28
217.66 4.32 89.85
211.56 2.88 -
203.02 2.76 25.13
250.59 341 60.00
5403.11 73.45 612.01

%Amount
1.22
0.41
0.73

0.57
0.88
0.16
0.81
0.33
-0.24

0.15

LP
SUM(Amount)
64.74

SACD
%Amount  SUM({Amount)
0.88 -
- 86.31
- 71.92
0.61 -
1.52 161.82
0.33 86.31
0.59 -
1.09 -
0.85 -
0.45 -
0.16 -
- 67.20
- 105.49
6.46 579.05

Total

%Amount SUM{Amount) %Amount
- 507.64 6.90
1.17 274.49 3.73
0.98 248.17 3.37
- 379.14 5.15
- 320.46 4.36
- 209.08 2.84
2.20 541.14 7.36
- 164.50 2.24
117 472.83 6.43
- 225.88 3.07
- 661.97 9.00
- 234.99 3.19
- 260.94 4.91
- 595.43 8.09
- 326.96 4.44
- 462.52 6.29
- 419.49 5.70
0.91 288.35 3.92
1.43 333.64 4.54
- 328.56 4.47
7.87 7356.18 100.00

Figure 16-5. Displaying both measures grouped by key.

You may have to adjust the font size to 10 to reasonably view all the columns.

We can also choose to view all of the measures grouped by measure.

3. Click the drop-down arrow on the Summary tab’s Active Measure list box and select All, by Measure.

Monarch displays both measures grouped by measure.

1
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Customer

| Betty's Music Store

Big Shanty Music
Bluegrass Records
Canciones

Chez Rudy

Classic Exchange
Das Piano

Die Harmonie

Die Melodie
Fandangos Records
Hope's Sweet Notes
Mo Town Tunes
Musique du Monde
Musigue Royale
Notas Musicales

Reiner's Symphonic Sounds -

Spinning Records
The Glass Harmonica
The King's Place
The Record Store
summary

9.59

17.97
286.44

cD
353.05
158.23
122.34
379.14
275.51
209.08
225.93
100.04
362.56
213.90
481.06
211.03
283.01
515.17
168.94
361.29
317.66
211.56
203.02
250.59
5403...

SUM(Amount)
DvD LP
B89.85 64.74
28.95 -
53.91 -
- 44.95
41.93 111.46
64.46 -
-—  23.96
11.98 -
59.90 43.11
23.96 -
-17.97 -
-—  80.26
10.78 62.16
68.28 32.95
89.85 11.98
25.13 -
60.00 -

612.01 475.57

SACD
86.31
71.92

67.20
105.49

579.05

Total
507.64
274.49
248.17
379.14
320.46
209.08
541.14
164.50
472.83
225.88
661.97
234.99
360.94
585.43
326.96
462.52
419.49
288.35
333.64
328.56
7356...

cD
4.80
2.15
1.66
5.15
3.75
2.84
3.07
1.36
4.93
2.91
6.54
2.87
3.85
7.00
2.30
4.91
4.32
2.88
2.76
3.41
73.45

YeAmount
DvD
1.22
0.41
0.73

Total
6.90
3.73
3.37
5.15
4.36
2.84
7.36
2.24
6.43
3.07
9.00
3.19
4.91
8.09
4.44
6.29
5.70
3.92
4.54
4.47

100.00

Figure 16-6. Displaying both measures grouped by measure.

Let’s return to our across key summary with only one measure.

4. Click the drop-down arrow on the Active Measure list box and select %Amount and restore the font size to 12.
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SORTING A SUMMARY

When you define a summary, Monarch initially displays the key field values in ascending alphabetical order. You can
see this in the summary in Figure 16-1. Here, the Customer values are displayed starting with Betty’s Music Store,
proceeding to The Record Store. The same holds true for the values of the Media field (BLU, CD, DVD, LP, SACD).

If the initial display order is not what you want, you can modify the order for any key field using the Keys window.
Let's change the sort order for the Customer key field to sort the customer field values in descending order.

STEPS:

1. Ensure that the Sales by Media summary is selected.

2. Double-click on the Customer column to display the properties of this field. The Keys screen is focused.
3. Click on the Sorting subtab.

4. Under the Direction heading, select the Descending radio button, and then choose Accept v

The summary is redisplayed sorted in descending order by customer.

Customer BLU cD ovD LP SACD %eAmount
1 [The Record Store | 0.24 3.41 0.82 4.47
2  The King's Place - 2.76 0.34 - 1.43 4.54
3  The Glass Harmonica 0.13 2.88 - --- 0.91 3.92
4 Spinning Records - 4.32 1.22 0.16 - 5.70
5  Reiner's Symphonic Sounds - 4,91 0.93 0.45 - 6.29
B Motas Musicales 1.16 2.30 0.15 0.B5 - 4.44
7 Musigue Royale - 7.00 - 1.09 - 8.09
8 Musique du Monde 1.30 3.85 -0.24 --- --- 4.91
9 Mo Town Tunes - 2.87 0.33 - - 3.19
10 Hope's Sweet Notes 1.06 6.54 0.81 0.59 - 9.00
11 Fandangos Records - 2.91 0.16 --- --- 3.07
12  Die Melodie --- 4.93 --- 0.33 1.17 6.43
13 Die Harmonie - 1.36 0.88 - - 2.24
14 Das Piano - 3.07 0.57 1.52 2.20 7.36
15 Classic Exchange - 2.84 - - - 2.84
16 Chez Rudy - 3.75 - 0.61 - 4.36
17 Canciones - 5.15 - - - 5.15
18 Bluegrass Records - 1.66 0.73 - 0.98 3.37
19 Big Shanty Music - 2.15 0.41 - 1.17 3.73
20 Betty's Music Store - 4.80 1.22 n.88 - 6.90
21 Summary 3.89 73.45 8.32 6.46 7.87 100.00

Figure 16-7. Sorting a key field.

SORTING BY MEASURE VALUES

Monarch can also sort a summary based on the values of a measure. Let's use this feature to sort our customers
from largest to smallest. First, we'll select the SUM(Amount) measure calculation to show sales totals for each
customer.

STEPS:

1. Ensure that the Sales by Media summary is selected.

2. Select Amount from the Active Measure drop-down list located on the Summary view ribbon.
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Now we'll sort the Customer key field values based on the values of the SUM(Amount) field. This has the effect
of ranking customers by sales totals. We’'ll sort in descending order to rank customer sales from largest to
smallest.

Double-click on the Customer column to display the properties of this field.
4. Click on the Sorting subtab of the Customer field.
5. Under the Sort By heading, select the Measure radio button.
The SUM(Amount) field is already selected as the measure to sort on.
6. Ensure that the Descending option is selected.
7. Choose Accept v

The summary is redisplayed with customers sorted in descending order by sales totals. Note that Hope’s Sweet
Notes appears first because it has the largest total sales amount of any customer (661.97), followed by Musique
Royale with a sales total of 595.43, and so on.

Customer BLU cD DVD LP SACD  SUM(Amount)
1 [Hope's Sweet Notes | 77.90 481.06 59.90 43.11 661.97
2  Musique Royale --- 515.17 --- 80.26 - 595.43
3 Das Piano --- 225.93 41.93 111.46 161.82 541.14
4 Betty's Music Store - 353.05 89.85 64.74 - 507.64
5 Die Melodie --- 362.56 - 23.96 86.31 472.83
6 Reiner's Symphonic Sounds - 361.29 68.28 32.95 - 462.52
7 Spinning Records - 317.66 89.85 11.98 - 419.49
8 Canciones - 379.14 --- - - 379.14
9  Musique du Monde 95.90 283.01 -17.97 - - 360.94
10 The King's Place --- 203.02 25.13 --- 105.49 333.64
11 The Record Store 17.97 250.59 60.00 - - 328.56
12 Motas Musicales 85.08 168.94 10.78 62.16 - 326.96
13 Chez Rudy --- 275.51 - 44.95 - 320.46
14 The Glass Harmonica 9.59 211.56 - - 67.20 288.35
15 Big Shanty Music --- 158.23 29.95 --- 86.31 274.49
16 Bluegrass Records - 122.34 53.91 - 71.92 248.17
17 Mo Town Tunes - 211.03 23.96 - - 234.99
18 Fandangos Records - 213.90 11.98 - - 225.88
19 Classic Exchange - 209.08 - - - 209.08
20  Die Harmonie --- 100.04 64.46 - - 164.50
21 Summary 286.44 5403.11 612.01 475.57 579.05 7356.18

Figure 16-8. Sorting a key field based on the values of a measure.

Let’s also sort the Media field values in the same manner. The result should show the media type with the largest
overall sales first, followed by the second largest in terms of sales, etc.

8. Double click on any cell in the Customer column once more.
Select the Media field and then click on the Sorting subtab.
10. Select the Measure radio button under the Sort By heading.

The SUM(Amount) field is already selected as the measure to sort on, but the sort order is set to Ascending.
We’'ll change this to Descending in order to display the media type with the largest sales first.

11. Select the Descending radio button under the Direction heading, and then choose Accept v

The summary is redisplayed with customers sorted in descending order by sales totals and Media types also
sorted in descending order by sales totals.
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Customer cD DVD SACD LP BLU  SUM(Amount)

1 |H0pe‘s Sweet Notes 481.06 59.90 - 43.11 77.90 661.97
2 Musigue Royale 515.17 - --- 80.26 - 595.43
3 Das Piano 225.93 41.93 161.82 111.46 - 541.14
4 Betty's Music Store 353.05 89.85 - 64.74 - 507.64
5 Die Melodie 362.56 --- 86.31 23.96 - 472.83
6 Reiner's Symphonic Sounds 361.29 68.28 - 32.95 - 462.52
7 Spinning Records 317.66 89.85 - 11.98 - 419.49
8 Canciones 379.14 - - - - 379.14
9  Musique du Monde 283.01 -17.97 - - 95.90 360.94
10 The King's Place 203.02 25.13 105.49 - - 333.64
11 The Record Store 250.59 60.00 - - 17.97 328.56
12 Motas Musicales 168.94 10.78 - 62.16 85.08 326.96
13 Chez Rudy 275.51 --- - 44.95 - 320.46
14 The Glass Harmonica 211.56 - 67.20 - 9.59 288.35
15 Big Shanty Music 158.23 29.95 86.31 - - 274.49
16 Bluegrass Records 122.34 53.91 71.92 - - 248.17
17 Mo Town Tunes 211.03 23.96 - - - 234.99
18 Fandangos Records 213.90 11.98 - - - 225.88
19 Classic Exchange 209.08 - - - - 209.08
20 Die Harmonie 100.04 64.46 -- - - 164.50
21 Summary 5403.11 612.01 579.05 475.57 286.44 7356.18

Figure 16-9. Sorting both Customers and Media types by sales totals.

Note that CD appears first because it has the largest total sales amount across all customers (5403.11), followed
by DVD with a sales total of 612.01, and so on. The sales totals appear in the Summary row at the bottom of the
summary report.

RESTORING THE KEY FIELD DIRECTION

So far, we've shown how to create a crosstab summary that displays the values for a single key field across the top
row, forming a two-dimensional matrix. This format is useful for displaying a lot of information, but it may not be ideal
for all summary reports. With Monarch, you can switch between this format and a more traditional report format,
choosing the appropriate format for your data and viewing requirements. Let’s reset the Media field to display its
values down rather than across.

STEPS:

1. Ensure that the Sales by Media summary is selected.

2. Double-click anywhere on the Customer column to display the properties of the Key fields.
3. Click on the Media field and then select the Layout subtab.

4. Under the Orientation heading, select the Down radio button.

o

Now, let's suppress duplicate values in the Customer column to give a summary report a nicer look.
Select the Customer field and then click on the Layout subtab.

From the Key values drop-down box, select Suppress Duplicates and then select Accept v
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The summary is redisplayed suppressing duplicate customer names.

Customer Media Amount ZcAmount
1 Hope's Sweet Motes cD 481.06 6.54
2 BLU 77.90 1.06
3 DVD 59.90 0.81
4 LP 43.11 0.59
3  Subtotal 661.97 9.00
6
7  Musigue Royale cD 515.17 7.00
8 LP 80.26 1.09
9  Subtotal 595.43 8.09
10
11 Das Piano cD 225.93 3.07
12 SACD 161.82 2.20
13 LP 111.46 1.52
14 DVD 41.93 0.57
15 Subtotal 541.14 7.36
16
17 Betty's Music Store cD 353.05 4.80
18 DVD 89.85 1.22
19 LP 64.74 0.88
20 Subtotal 507.64 6.90
21
22 Die Melodie cD 362.56 4.93
23 SACD B86.31 1.17
24 LP 23.96 0.33
25 Subtotal 472.83 6.43

Figure 16-10. Restoring the summary to a more traditional display format.

Notice that the summary is still sorted in the same manner, with customer groups sorted in descending order by
sales amounts (entire summary groups are sorted based on the subtotal values for each group). Within each
customer, the media types are also sorted in descending order by sales. In this format (with no key field
displayed across), the summary can display both the SUM(Amount) and %(Amount) measure calculations at the
same time.

TOP N ANALYSIS

Top n analysis, typically referred to as Top 10 Analysis, is a common tool provided by data analysis applications.
You can create a top n analysis or bottom n analysis of your summary data by first sorting the data in the appropriate
order and then by selecting the first n values, whether n is 10, 3 or some other number. These values then represent
either the top n or the bottom n analysis. Let's see how this works.

We'll create a top 3 analysis from our sales summary that shows the top three customers in terms of sales. All other
customers will be represented using a single summary label, “All Others.” To create our top 3 analysis, we start by
sorting the customers in descending order by sales totals. This places the top performing customers at the top of the
summary display. We've already applied this sort in our previous discussion on sorting. Next, we need to indicate that
we want to see only the first three customers (the three customers with the largest sales totals).

STEPS:

1. Ensure that the Sales by Media summary is selected.

2. Double-click on the Customer field to display the properties of the Key fields.
3. Select the Matching subtab for the Customer field.
4

Select the First N Values option and enter 3 in the box (this is the box labeled Count of distinct values as
sorted).
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Under the Accumulator for values after the First N heading, ensure that All Others is entered into the Label field.
Select the Media field.
7. Inthe Layout subtab, select the Across orientation and then click Accept v

The summary is rebuilt to show only the top three customers. All other customers are grouped together and
represented by the “All Others” label.

Customer cD DVD SACD LP BLU SUM{Amount)
1 [Hope's Sweet Notes | 481.06 59.90 43.11 77.90 661.97
2 Musigue Royale 515.17 - - 80.26 - 5395.43
3 Das Piano 225.93 41.93 161.82 111.46 - 541.14
4 all Others 4180.95 510.18 417.23 240.74 208.54 5557.64
3 Summary 5403.11 612.01 579.05 475.57 286.44 7356.18

Figure 16-11. A Top 3 analysis showing the top performing customers in terms of total sales.

You can easily modify this summary to show the bottom 3 customers in terms of sales totals by sorting the customer
key field in ascending order. Likewise, you can increase or decrease the number of customers that you explicitly
break down for analysis by increasing or decreasing the value in the Customer field’s First n Values option.

A top n analysis can be defined at any level in the summary. Within each customer, you can define a top 3 analysis of
each media type by sorting the media type in descending order and then selecting the First n Values option for the
Media key field and entering the desired number in its spin box.

SPECIFYING KEY FIELD VALUES

While performing a top n analysis is useful when you want to determine which items (customers, salespeople, etc.)
are the top performers, sometimes you already know which items you want to look at, whether they are the top
performers or otherwise. For example, suppose you want to focus on just the digital media types (compact discs,
digital versatile discs, and LPs). You could do this by creating a filter in the Table view with the filter expression:

Media="CD".Or.Media="DVD".Or.Media="LP"
You could also write this expression as:
Media.In.(“CD”, “DVD”, “LP”)

By applying the filter to the summary definition, the summary would display information about only the digital media
types. However, Monarch provides an easier and, in some cases, more powerful method of achieving this result. For
each key field, you can define a list of all values you want to use when building the summary. Further, you can
accumulate all values not in your list as a single key value (a feature not available if you use a filter). To demonstrate
how this works, let’s create a list of values to use for the Media field.

STEPS:

1. Ensure that the Sales by Media summary is selected.
2. Double-click on the Customer field to display the properties of the Key fields.
3. Select the Media field and then navigate to the Matching subtab.
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Easure expression

Media

=

First N values

Values from table

Figure 16-12. Displaying the Matching subtab of the Media tab.

Check the Values from table option.
Click the Add button.
All unique values found within the Media field (BLU, CD, DVD, LP, and SACD) are displayed.

®) Values from table

Add Fimish Remove

Click to sort values 4| Click to sort values
cD

OWVD

LP

SACD

ELU

Figure 16-13. Specifying sorting values.

Select CD from the Key Values list, and then click the Add button to add this value to the Specified or Upper
Limit Values list.

Repeat Step 5to add the DVD and LP values to the Specified or Upper Limit Values list.
The selected values appear in the subtab’s Click to sort values list.

Click the Finish button to close the Key Values list.

Let's accumulate the old media types (BLU and SACD) under a separate heading.

Ensure that the Display box under the Accumulator for unmapped values heading is selected.

10. Type All Others in the Label box, and then choose Accept v
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Monarch rebuilds the summary using only the selected media types. The two media types not specified (BLU
and SACD) are combined under the label All Others.

Customer cD DVD LP All Others  SUM{Amount)
1 [Hope's Sweet Notes | 481.06 59.90 43.11 77.90 661.97
2 Musique Royale 515.17 - 80.26 - 595.43
3 Das Piano 225.93 41.93 111.46 161.82 541.14
4 All Others 4180.95 510.18 240.74 625.77 5557.64
2> Summary 5403.11 612.01 475.57 865.49 7356.18

Figure 16-14. Using specified values to break down specific digital media types versus all other media types.

SORTING BY KEY FIELD VALUES

Once you have specified key field values, you can sort the summary data by either the specified values themselves
(i.e., their names) or by their order in the Specified or Upper Limit Values list on the Matching subtab. To do so,
select the Key Field radio button on the Sorting tab, and then choose either the Field Value option (to order the data
by the field value names) or the Position in values table option (to order the data by their position in the Specified or
Upper Limit Values list).

NOTE The Position in values table option is not available if the Values from table option on the
Matching tab has not been chosen.

UPPER LIMIT VALUES

While the Values from table option lets you select the exact values you want to use in your summary, sometimes you
want to group values into ranges, such as weekly or monthly periods. This capability is provided via the Upper Limit
Values option. This option lets you define an upper limit for each range of values. An example of this can be seen in
the Sales by Ship Date summary.

STEPS:

1. Click onthe Sales By Ship Date summary in the Summary Selector.

2. Select Autosize Columns "** from the Summary tab to maximize your view of all of the fields.

The Sales by Ship Date summary displays. This summary breaks out sales for all customers across four weekly
periods during the month of April 2010. We created this summary by using the dates 04/07/2010, 04/14/2010,
04/21/2010, and 04/28/2010 to define the ending dates for each weekly period.
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Customer
1 [Betty's Music Store
2 Big Shanty Music
3 Bluegrass Records
4  Canciones

3 Chez Rudy
[
7
]
2

Classic Exchange
Das Piano
Die Harmonie
Die Melodie
10 Fandangos Records
11 Hope's Sweet Notes
12 Mo Town Tunes
13 Musigue du Monde
14  Musique Royale
15 Notas Musicales
16 Reiner's Symphonic Sounds
17 Spinning Records
18 The Glass Harmonica
19 The King's Place
20 The Record Store
21 Summary

4/7/2010

147.45

1246.52

4/14/2010
173.25
127.04
248.17
231.17

209.66

1651.67

4/21/2010
334.39

123.98
186.45
2156.65

4/28/2010  SUM{Amount)
- 507.64

- 274.49

- 248.17

- 379.14

- 320.46

- 200.08
541.14 541.14
- 164.50
406.94 472.83
225.88 225.88
- 661.97

- 234.99

- 360.94

- 595.43
100.65 326.96
268.40 462.52
327.87 419.49
288.35 288.35
- 333.64
142.11 328.56
2301.34 7356.18

Figure 16-15. Using upper limit values to break down ship dates into weekly periods.

SUMMARY LIMIT VALUES

Another way to analyze summary data is to set a limit against a measure. This feature works somewhat like a filter
that is applied after the summary is built. For example, the Sales >=400 summary displays only those customers for

which totals sales exceed 399.00.

STEPS:

1. Click onthe Sales >=400 summary in the Summary selector.

The Sales >= 400 summary displays. This summary breaks out only those customers for which total sales are at
least 400.00 (There are seven such customers). All other customers are grouped together under an “All Others”

label.
Customer BLU CcD DvD LP SACD SUM{Amount)
1 [Betty's Music Store | 353.05 B89.85 §4.74 507.64
2 Das Piano - 225.93 41.93 111.46 161.82 541.14
3 Die Melodie — 362.56 -— 23.96 86.31 472.83
4 Hope's Sweet Notes 77.90 481.06 56.90 43.11 - 661.97
3 Musigque Royale — 515.17 -— 80.26 — 595.43
6 Reiner's Symphonic Sounds - 361.20 68.28 32.95 - 462.52
7  Spinning Records — 317.66 89.85 11.98 — 419.49
8 Al Others 208.54 2786.39 262.20 107.11 330.92 3695.16
9 Summary 286.44 3403.11 612.01 475.57 579.05 7356.18
Figure 16-16. Using Summary Limit Values to break down large customers.
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Figure 16-17. Specifying summary limits.

To create this summary, simply double-click on the Customer field, and then select the Matching subtab of the
Customer field. Select the Measure Limit radio button. Choose the SUM(Amount) field, the “>=" operator, and

enter 400 in the adjacent field.
At this point, you can either save your work or simply close the report and model files you opened for this lesson.
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[17] EXPORTING OPERATIONS

A key feature of Monarch is that you can export input files, as well as extracted data, into a number of file formats.
This lesson will discuss how to export:

0O Reports

0 Tables

0 Summaries

Reports may be exported as .txt and .pdf files, while tables and summaries may be exported to a wider variety of
formats, including .csv, .xls, .xIsx, .mdb, .dbase, .accdb, .htm, and .xml, among others.

If your Monarch license is for Monarch Complete, you can export tables and summaries to the Tableau data (.csv),
Tableau Hyper/Server (.hyper), and QlikView QVX (.qvx) formats. Tables may also be exported as a SAPExport or
SAP Transport File Format V5 (.xpt) files.

We'll begin by loading the Classic.prn report file and the Lesson8.dmod model file.

EXPORTING REPORTS

Monarch allows you to export data from the Report window specifically into a TXT or PDF file. When exporting to a
PDF file, if you have configured the Report Index, the tree definition will provide the bookmarks in the PDF file.

Let’s try exporting the Classic.prn file to a PDF file.

STEPS:

1. Select the Export tab to display Export view.

File Home Report Table Summary Export ?
» g
Export Select All Clear Clear Create Run
Design Exports  Selected Jobs  Job List Export  Exporis
~

Home Report View Summary View v
N £ Export Name View Export Target

O RS 5 00 0 5 s s wsons w0

Clear Results

1% ——h—+

Figure 17-1. The Export view interface.

The Export interface is divided into several panels. To the left of the interface is an Export Selector. The right-
hand side shows to smaller panels arranged one on top of another. The top panel shows the Export Job List.
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Any export selected from the Export Selector and added to this panel becomes a job. The bottom panel shows
the Export Results. Each time you run an export/job, the results of the export process are added to this panel

The following table summarizes the functions of each of the buttons in Export view.

Launch the Export Design interface

r” Export Design

M=) Select all defined exports
Select All Exports

4

Clear all selected jobs
8 Clear Selected Jobs J

& ) Clear the job list
‘= Clear Job List

= Create a new export
+ Create Export

= Run Export Run the export

2. Select Create Export to begin defining your export. The Create Export dialog displays.
M Create Export *

= + #  Edit Advanced Options

Export Location: C\Users\Public\Documents\Altair Monarch\Export

File Name:
[ I3
Source View: Export File Type:
|l] o B Auto-detect from file name
Table | Microsoft Excel XLS (*xs)
B Report || Microsoft Excel XLSX (*xlsx)
& Sales By Media || Microsoft Excel XLSM (*.xlsm)
& Sales By Ship Date || Microsoft Access MDB (*mdb)
& Sales »= 400 | Microsoft Access ACCDB (*.accdb)
A Redaction Alias Map .| dBase (*.dbf)
4] Delimited Text (*.csv)
Export Cptions

When output files exist:

.Overwrile file v

|‘ Close ] | Help

Figure 17-2. The Create Export dialog.

Let's take a look at this dialog. The File Name field allows you to specify the file name to which the export should
be saved. Most of the dialog is divided into two panels, the Source View panel and the Export File Type panel.
The Source View panel allows you to select a view or parts of views (in the case of summaries) to export, and
the Export File Type panel allows you to select a file type in which to save the export.

3. Enter the file name Exportl in the File Name field.
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4.  From the Source View panel, select Report.

Note that the entries in the Export File Type panel change to reflect the different file types to which you can save
the export.

M Create Export

[ Run This Export + Add to Project #  Edit Advanced Options

Export Location: C:\Users\Public\Documentsh\Altair Monarch\Export\Export]

File Name:
Export1 =
Source View: Export File Type:
N Lo B Auto-detect from file name
Table | Text (")
E Report [£] Adobe PDF (=.pdf)
& Sales By Media
# Sales By Ship Date
& Sales »= 400

Redaction Alias Map

Export Options
When output files exist:

Overwrite file v

Close Help

Figure 17-3. The options in the Export File Type panel show the file types to which you can save the report when
exported.

5. Select Adobe PDF (*.pdf) from the Export File Type panel.
For this exercise, let's choose to password-protect the PDF file.
6. Click on the button Edit Advanced Options.

The dialog closes and the Export Design view displays. A PDF Output panel displays on the right side of the
view.
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Design

e

v % P a » 2

Accept  Cancel Add  Duplicate  Delete Help
Export Export Export

[Export=JEiE e ~ 1 [Bepoit iV iew e o e TEER T 3 osmsr st g i 5 B 5 35 ) 20 i) st s s g v B
i e
M Eport] Export Name Qutput File
Export1 Export Location: C:\Users\Public\Documents\Altair Monarch\Export
\Exportl.pdf
Selected Reports [All] File Name:
| Classic.prn C:\Users\Public\DocumentshAltair Monarch\Export\Export.pdf =
Export File Type:  |Adobe PDF (".pdf) v
When output files exist Export Lacale
Overwrite file v Use current system locale ~
Encryption
Require a password to open the document Open Password
Restrict access to document contents Permissions Password
| Printing allowed
| Content extraction allowed
| Editing allowed
+| Annotation (comments) allowed

Encryption Type:

oo ——F—+

Figure 17-4. Advanced options made available when exporting a report to a PDF file.

7. Add a password to your PDF file by checking the box for Require a password to open the document and then
clicking the Open Password button.

8. Provide and confirm the password to use to open the exported PDF file.

If you would like to restrict access to the content of the exported report, you may do so by checking the Restrict
access to document contents box and then selecting which actions you want to permit. You can even specify a
password to allow these actions to be executed by clicking the Permissions Password button.

9. Select Accept to save the export.
The Export Design view closes and you are brought to Export view.
Let’s try running our export now.

10. Double-click on Exportl in the Exports Selector panel so that it is added to the Export Job List. Click on this
export in the job list panel.

11. Select the Run Exports [ button from the Export ribbon.
The export runs and the results are displayed on the Export Results panel.

Export Results ~

Bunning export job Exportl

Export job Exportl:
20 records written to C\Users\Public\Documents\Altair Monarch\ExporthExport1.pdf
Export time: 00:00:01.5

Total time: 00:00:02.0

Clear Results

Figure 17-5. The Export Results panel shows the results of each export run. This export was successfully completed.
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To view the exported file, click on the export link provided. Doing so copies the path indicated, and you can use
your mouse to paste this path into your file explorer to navigate to the location of the file.

The default folder for exported files is specified in the Options window (typically in
C:\Users\Public\Documents\Altair Monarch\Export).

Since we opted to password-protect our PDF file, you will be asked to supply the password you specified before
your file can be opened.

= Menu {R Yy Exportlpdf(SECURED) X | + Creste

Alltools  Edit  Convert

E-Sign

“ 05/01/10

10:17
&, MSRI4
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MEDIZ QTY

cD 4

7

2

DVD k]

CD 11

8

10

LE® 6

DVD 6
850xT11.00in

Find text ortools Q (=] @ E @-

CLASSICAL MUSIC DISTRIBUTORS
MONTHLY SHIPPING REPORT
FROM 04/01/10 To 04/30/10

Betty's Music Store
Muscatine Plaza

200 Lowesr Muscatine
Cedar Falls, Iz 50613
UsSh

ACCOUNT NUMBER: 11887

Betty Yoder

DESCRIPTION

ORDER NUMBER: 536017
Bartck, Scnata for Solo Violin
Mozart, Mass in C, K.427
Luening, Electronic Music
Scarlatti, Stabat Mater

ORDER NUMBER: 5360359
Besthoven, Pathstigue Sonata, Arau
Mendeslssohn, War March of the Priests
Pizzetti, Messa di Requiem

Misc., Modern Trombone Masterpieces

Gershwin, An American in Paris

SHIP DATE:

3HIP DATE:

LABEL/NO.
04/10/10
ME-42625
420831-2
D 611
SBT 48282
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420153-2
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Figure 17-6. The PDF file includes all 20 records of Classic.prn.

Before proceeding with the rest of the lesson, return to Export view and then select Clear Job List. All of the

jobs added to the job list are run every time you select the Run Exports button. Since we are only interested in
showing the results of individual exports at this time, we’'ll need to clear the Export Job List so that previous jobs
are not run together with new jobs.

While it is not required that you do so, you may also clear the Export Results panel by selecting the Clear

Results button.
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EXPORTING TABLES

This time, we’'ll try exporting the table we extracted using the templates defined in the Lesson8.dmod model file.

STEPS:

1. Select Create Export from the Export ribbon.

2. Enter Export2 in the File Name field of the Create Export dialog that displays.

NOTE The export file name (the name of the file to which you will export data) and the export name
that displays in the Export Selector have no relation. You can choose to export to any file
name you wish. The Export Selector will create export names in the order in which the
export was created beginning from Exportl.

3. Ensure that Table is selected in the Source View panel and then select Microsoft Excel XLSX (*.xIsx) from the
Export File Type panel.

4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the name Tablel here.

NOTE For Excel files, “Table Name” corresponds to a Worksheet name or Named Range, and
Named Ranges must begin with a letter or underscore, must not be "C”/“c” or “R”/“r", cannot
contain spaces, and must not be the same as a cell reference, e.g., R1C1, Al, Z$100, etc.,
or any other Excel built-in names or objects in the workbook.

5. Select the Add to Project button located at the top of the Create Export dialog.
You are returned to the Export interface. Note that Export2 has been added to the Export Selector.
Let’'s run this export and check our results.

6. Double-click on Export2 from the Export Selector so that it is added to the Export Job List.

7. Select Export2 from the job list and then click the Run Exports button on the Export ribbon.

Export Results v R

Running export job Export?

Export job ExportZ: Clear Results
149 records written to Ch\Users\Public\Documents\Altair Monarch\Export\Export2 sdsx
1 column header row written
Export time: 00:00:00.7

Total time: 00:00:01.6

Figure 17-7. The Export Results panel indicates that the export was successfully run.

Altair Monarch 2024.1 Learning Guide 319



To view the file to which your table was exported, as in the previous lesson, click on the export link provided. Use
your mouse to paste the copied path into your file explorer to navigate to the location of the file. Select the file to

open it.
File Home Insert Page Layout Formulas Data Review View Automate Help Acrobat | Comments |
fﬁ A A = % [l conditional Formatting % p @, @
Paste B~ onr  aignment Numper 24 FormatasTable v Cells  Editing Add-ins | Analyze  Create PDF  Create PDF and
v & e e e @ Cell Styles ~ e e Data and Share link Share via Outlook
Cipboard 5 Styles Sensitivity | Add-ins Adobe Acrobat ~
A2 v i S~ 512010 ~
A B [« D E F G H I J K a
1 W‘Glﬂer Number ‘Shp Date ‘ Account Number Contact Customer ‘Posta\ Code |Country |Meda‘ Quanﬂy‘l)escrpmn ‘ I
2 [5/1/2010 ﬁ36017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA (o] 4 Bartok, Sonata for Selo Vioiin
3 5/1/2010 %536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA co 7 Mozart, Mass in C, K.427
4 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store %0613 UsA cD 2 Luening, Electronic Music
5 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA DVD 9 Scarlatti, Stabat Mater
5 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 UsA [e} 11 Beethoven, Pathetique Sonata, Arau
7 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store %0613 UsA cD 8 Mendelssohn, War March of the Priests
8 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA cD 10 Pizzetti, Messa di Requiem
9 5/1/2010 "536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA LP 6 Misc., Modern Trombone Masterpieces
10 |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA DvVD 6 Gershwin, An American in Paris
11 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA (o] 6 Stravinsky, Dumbarton Oaks Concerto
12 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music "30067 USA (o] 1 Schubert, Sonata in e, D.566
13 5/1/2010 536016 4/5/2010 17959 Marvin Mabry ~ Big Shanty Music 30067 UsA [e} 3 Mozart, Symphony No.23 in D
14 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA (o] 6 Schoenberg, Ode to Napoleon
15 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA D 2 Shostakovich, 24 Preludes for piano
16 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music "30067 USA SACD 9 Balakirev,Symphony no. 1
17 |5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA DvVD 5 Holst, St. Paul's Suite for Orch.
18 5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records 40059 USA cD 3 Faure, 28 Songs, Stulzmann
19 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records "40059 UsA cD 3 Takemitsu, Music of Takemitsu
20 5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records "40059 USA D 6 Messiaen, Quatour pour la fin de temps
21 5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records 40059 UsA SACD 8 Strauss, Ein Heldenleben, Op.40
22 5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records 40059 USA DVD 9 Schumann, Manfred Overture, Bav SO v
< > Tablel + : e >
Ready [® 3% Accessibility: Good to go 22 M -———+ 100%

Figure 17-8. The exported table. Note that the table is named Tablel, as specified in the Create Export dialog.

As usual, clear the job list before proceeding to the next lesson.

EXPORTING SUMMARIES

The Lesson8.dmod model includes three summaries. Since we can create more than one summary in a single
Monarch session, aside from specifying an export name and export file type, we’'ll also have to specify which of these
summaries to export. You can only export one summary at a time. If you wish to export another summary to the same
file name, you'll have to add this summary as a new table to the file. Let’s look at how we do this in the following
example.

Exporting a Single Summary

STEPS:

1. Select Create Export from the Export ribbon.
2. Enter Export3 in the File Name field of the Create Export dialog that displays.

3. Ensure that the summary Sales by Ship Date is selected in the Source View panel and then select Microsoft
Excel XLS (*.xIs) from the Export File Type panel.

4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the name SalesbyShipDate
here. Note that table names cannot contain spaces.

5. Select the Edit Advanced Options button located on the upper right-hand corner of the dialog.
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The Export Design interface is activated.

Design

v ® ? a 2 2

Accept  Cancel Add Duplicate  Delete Help
Export Export Export
~
i 0 General Advanced v
™ Exportl Export Name
W Export2 Output File
B Exports Eport3

Export Location: C:\Users\Public\Documents\Altair Monarch\Export

Summary Options \Export3.xls

File Name:
Automatic Naming

Ci\Users\Public\Documents\Altair Monarch\Export\Export3 xis =
by Files by Tables
Summary: Sales By Ship Date v
Export File Type: | Microsoft Excel XLS (“ads) v
Drill State: Most detailed @ Current
Measure: Active measure or measure grouping v Export Options
Each distinct value of the first key makes Toble Name:
Split: a separate file or table. .
SalesbyShipDate
Select Filter: | No Filter v Show Tables
When output files exist: When output tables exist:
SortOrder: | No Sort ~ Qverwrite file v Overwrite table v

0% —————+

Figure 17-9. Advanced Export options for summaries.

The left-hand panel of the Export Design view provides a host of summary options. You can:
Choose another summary to export using the Summary drop-down
Specify a drill state (assuming that you had either drilled up or drilled down on the summary)
Specify an active measure to apply to the summary prior to export
Split the summary into distinct files or tables according to key values
Apply afilter to the summary (this option is deactivated if the summary includes no filters)
Apply a sort order to the summary (this option is deactivated if the summary includes no sorts)

Note that the options you choose to apply to your summary may result in more than one exported file, and you
can choose how these files are to be named (i.e., either by file name or by table name).

In the present case, for example, choosing the option All measures as separate exports will require you to
choose whether the measure title should be applied as individual tables or individual file names. In the former
case, you create one file with two tables named according to the measure title. In the latter case, you create two
files named according to the measure title.

The right-hand panel of the Export Design view provides your usual export options, including the folder/filename
to save your export to, the file format to apply, what tables should be named, etc.

Note that when specifying a file name in which to export your summary, you must ensure that the file extension
indicated matches the file type selected in the Export File Type drop-down.

6. For this lesson, let's use the default summary options as export parameters.

7. Inthe Export Options section of the Export Design view, ensure that Overwrite file is selected as a When
output files exist option.

8. Click the Accept button to save the export you've just defined.

You will be returned to the Export interface when you do so. Note that Export3 has been added to the Export
Selector.
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Let’s run this export and check our results.
9. Double-click on Export3 from the Export Selector so that it is added to the Export Job List.
10. Select Export3 from the job list and then click the Run Exports button on the Export ribbon.

When successfully exported, the summary can be viewed as follows.

File  Home Insert Page Layout Formulas Data Review View Automate Help Acrobat |52 Comments |
fl'j A E % [l Conditional Formatting ~ @ p ii_j E}
Clipboard Font Alignment = Number @ Format as Table ~ Cells Editing Adobe
M v M M [iZ Cell Styles ~ v v Acrobat ~
Styles Sensitivity | Add-ins ~
Al v Jx~ Customer ~
A B C D E F G H J -

1 Customer | 4/7/2010 4/14/2010 4/21/2010 4/28/2010  SUM(Amount)

2 Betty's Music Store — 173.25 334.39 — 507.64

3 Big Shanty Music 147.45 127.04 —] 274.49

4 Bluegrass Records — 248.17 — — 248.17

5 Canciones — 231.17 147.97 - 379.14

6 Chez Rudy 320.46 — 320.46

7 Classic Exchange — 209.08 — 209.08

g Das Piano — 54114 541.14

9 Die Harmonie — - 164.50 - 164.50

10 |Die Melodie — 65.89 — 406.94 472.83

11 Fandangos Records — 225.88 225.88

12 Hope's Sweet Notes — 510.90 151.07 - 661.97

13 Mo Town Tunes 234.99 — 234.99

14 Musique du Monde 384.37 -188.79 165.36 — 360.94

15 |Musique Royale 161.78 80.26 353.39 - 595.43

16 |Notas Musicales 226.31 - — 100.65 326.96

17 Reiner's Symphonic Sounds — 194.12 — 268.40 462.52

18 Spinning Records 91.62 327.87 419.49

19 The Glass Harmonica — —] 288.35 288.35

20 The King's Place — 209.66 123.98 — 333.64

21 The Record Store — 186.45 142.11 328.56

22 Summary 1246.52 1651.67 2156.65 2301.34 7356.18

23

24

25

26

27

28

29

30 v

< > SalesbyShipDate + | >

Ready @ ﬁ;Attess\b\hty: Unavailable ﬁ E - ——h——+ 100%

Figure 17-10. The exported summary.

Clear the job list before proceeding to the next lesson.

Adding a Summary to an Export File

Now we’ll add another summary to the Export3.xls export file.

STEPS:

1. Select Create Export from the Export ribbon.
Enter Export3.xls in the File Name field of the Create Export dialog that displays.

3. This time, select Sales >=400 from the Source View panel and then select Microsoft Excel XLS (*.xls) from the
Export File Type panel.

4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the name
SalesOf400Above here. Note that table names cannot contain spaces.

5. In the Export Options section located at the lower left-hand corner of the dialog, expand the When output files
exist options and then select Add data to file.
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6. Adrop-down box for When output tables exist options appears. Select Add data to table.
Select the Add to Project button located at the top of the dialog.

You are returned to the Export interface when you do so. Note that the export you've just defined displays as
Export 4 in the Export Selector because it is the fourth export you defined.

8. Double-click on Export4 from the Export Selector so that it is added to the Export Job List.
9. Select Export4 from the job list and then click the Run Exports button in the Export ribbon.

Export Results «

Running expaort job Exportd

Export job Exportd:
9 records written to CiUsers\Public\Documents\Altair Monarch\Export
Export time: 00:00:00.9

Total time: 00:00:01.6

Clear Results

Figure 17-11. The Export Results panel indicates that the export was successfully run.

When the exported file is opened, the table SalesByShipDate displays as the first table of the file. A second
table, SalesOf400Above, is also added to the file. Select this table to view its results.

File Home |Insert Pagelayout Formulas Data Review View Automate Help Acrobat \‘D Comments |
f’lj E % [EH Conditional Formatting + @ /(D @ E‘}
Clipboard Font Alignment  Number @ Format as Table ~ Cells Editing Adobe
v v v v i Cell Styles v v v Acrobat v
Styles Sensitivity ~ Add-ins ~
Al v Jfx~ Customer -~
| A B C D E F G H J -
1 Customer [ 4/7/2010| 4/14/2010 4/21/2010 4/28/2010]  SUM(Amount)|
2 Betty's Music Store - 173.25 334.39 — 507.64
3 Big Shanty Music 147.45 127.04 — 274.49
4 Bluegrass Records — 248.17 — 248.17
5 Canciones — 231.17 147.97 -— 379.14
6 Chez Rudy — — 320.46 — 320.46
7 Classic Exchange — — 209.08 — 209.08
g Das Piano — 541.14 541.14
g Die Harmonie - — 164.50 — 164.50
10 Die Melodie — 65.89 — 406.94 472.83
11 Fandangos Records — — — 225.88 225.88
12 Hope's Sweet Notes - 510.90 151.07 — 661.97
13 Mo Town Tunes 234.99 — — — 234.99
14 Musique du Monde 384.37 -188.79 165.36 —] 360.94
15 Musique Royale 161.78 80.26 353.39 — 595.43
16 Motas Musicales 226.31 — — 100.65 326.96
17 Rener's Symphonic Sounds — 194.12 — 268.40 462.52.
18 Spinning Records 91.62 — — 327.87 419.49
19 The Glass Harmonica — — — 288.35 288.35
20 The King's Place — 209.66 123.98 —] 333.64
21 The Record Store — - 186.45 142.11 328.56
22 |Summary 1246.52 1651.67 2156.65 2301.34 7356.18
23
24
25
26
27
28
29
30 v
< SalesbyShipDate  SalesOf400Above + P4 O >
Ready [® W Accessibility: Unavailable H B -—a—+ 100%

Figure 17-12. The exported file showing two tables.
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File Home Insert Page layout Formulas Data Review View Automate Help Acrobat |L_—‘Comments\

flj _A % [l Conditional Formatting ~ E /O &y E}

Clipboard Font Alignment = Number @ Format as Table - Cells Editing Adobe
v v v v [iZ Cell Styles v v M Acrobat ~
Styles Sensitivity | Add-ins ~
Al Vo Jx~ Customer o
A B C D E F G H -
1 Customer \ BLU D DVD LP SACD‘ SUM(Amount)\
2 Betty's Music Store - 353.05 89.85 64.74 — 507.64
3 Das Pano — 225.93 41.93 111.46 161.82 541.14
4 Die Melodie — 362.56 -— 23.96 86.31 472.83
5 Hope's Sweet Notes 77.90 481.06. 59.90 43.11 — 661.97
6 Musique Royale - 515.17 - 80.26 — 595.43
7 Reiner's Symphonic Sounds - 361.29 68.28 32.95 - 462.52
g Spinning Records — 317.66 89.85 11.98 — 419.49
9 Al Others 208.54 2786.39 262.20 107.11 330.92 3695.16'
10 |Summary 286.44 5403.11 612.01 475.57 579.05 7356.18
11 |Betty's Music Store - 353.05 89.85 64.74 — 507.64
12 Das Piano - 225.93 41.93 111.46 161.82 541.14
13 Die Melodie — 362.56 — 23.96 86.31 472.83
14 Hope's Sweet Notes 77.90 481.06 59.90 43.11 — 661.97
15 Musique Royale - 515.17 — 80.26 — 595.43
16 Reiner's Symphonic Sounds — 361.29 68.28 32.95 — 462.52
17 |Spinning Records - 317.66 89.85 11.98 — 419.49
18 Al Others 208.54 2786.39 262.20 107.11 330.92 3695.16
19 Summary 286.44 5403.11 612.01 475.57 579.05 7356.18'
20
21
22
23
24
25
26
27
28
29
2 v
< 2 SalesbyShipDate ~ SalesOf400Above + i >
Ready [® T Accessibility: Unavailable i3] I -+ 100%

Figure 17-13. The SalesOf400Above table displays the data in the Sales>=400 summary.

EXPORTING REDACTION ALIAS MAPS

As Monarch processes a report/model which involves consistent alias replacement redactions, it generates a
redaction alias map for each such redaction. The map expresses the relation between the un-redacted and the
redacted values for that particular type of redaction (e.g., “Consistent alias text”), and for that particular build. Since
the redacted values are generated based (at least partly) on random numbers, the specific aliases recorded in a map
will change from build to build, even if Monarch is run against the exact same report and model.

Monarch automatically discards its redaction alias maps when doing a Close All or when exiting. However, in some
circumstances, it may be desirable to export a redaction alias map so that it may be archived or used by some
downstream process. Monarch provides for exporting redaction alias maps as simple delimited text files.

To export a redaction alias map, launch the Create Export dialog and then dialog select Redaction Alias Map under
Source View. Notice that when this view is selected, the only option under Export File Type is Delimited Text.
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M Create Export *
L #  Edit Advanced Options

Export Location: C:\Users\Public\Documentsh\Altair Monarch\Export

File Name:
1=
Source View: Export File Type:
|1| o B Auto-detect from file name
Table 4] Delimited Text (*.csv)
B Report

& Sales By Media
# Sales By Ship Date

Sales >= 400
A Redaction Alias Map

Export Options

When output files exist:

| Overwrite file v |

Redaction Map Type :

| Consistent alias text ~ |

| Close | | Help

Figure 17-14. Exporting a redaction alias map.

Use this dialog to specify your desired output file name and the particular Redaction Map Type you wish to export, as
shown below.

M Create Export X
L #  Edit Advanced Options

Export Location: C:\Users\Public\Documents\Altair Monarch\Export

File Name:

Source View: Export File Type:
N 0o M Auto-detect from file name

Table &) Delimited Text (*.csv)
Report

Sales By Media

Sales By Ship Date

L. T

Sales == 400

&

Redaction Alias Map

Export Options

When output files exist:

| Overwrite file v |

Redaction Map Type:

Consistent alias text |

| Consistent alias text |

Consistent alias digits |

o
o
b
rn

Help
Pseudo bank card number

| Pseudo SSN
Pseudo NHS number

Figure 17-15. Selecting a redaction map type.
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The Redaction Map Types listed in the dropdown box correspond directly to the five distinct types of consistent alias
replacement redactions available.

When you run this export, the redaction alias map of the selected type is exported to the specified output file as
delimited text using the delimiter and string quoting mechanism common to all delimited text exports (see the “For
Delimited Text Files” settings of the Text Files tab under Options > Export). The exported map file consists of just
two columns: the first contains the un-redacted values, and the second contains the corresponding redacted values.

For example, the first few lines of an export of a “Consistent alias text” map might look like this:
"1000-2000-3000-4000", "5w7wiwowywkwzwxeg80"

"alpha","uuuuu”

"beta”,"9999"

"gamma”,"uuuuz"

"delta","uuuuo”

"epsilon","0o000000"

"The Quick Brown Fox Jumps Over The Lazy Dog","0hOh4hOhohvhphnjOamnbueevrjgphdmjm3fts86bgg"

"7235-5311-6745-2225", "zwiwiw swww5wo9kuooz"

EXPORTING TO TABLEAU SERVER

Tableau Server, by Tableau Software®, is an online solution for sharing, distributing, and collaborating on content
created in Tableau or exported to Tableau Data Extract form. Monarch offers a simple solution to allow data extracted
in the application to be exported to Tableau Server quickly and seamlessly.

STEPS:

1. Create an export via Export Design and select Tableau Hyper as the export file type.
2. Check the box for Publish to Tableau Server.
3. Select Edit Advanced Options.

The information you entered to access Tableau Server in the Security tab of the Options window displays. If you
did not provide the necessary information in this tab, you can do so now.

+| Publish To Tableau Server
Data Source Name: Path to TABCMD:

CA\Program Files\Tableau\Tableau Server\ &

Site: Server address:
monarchexport 129.63.65.0

Publish Type: Username:
Overwrite Data Source e Adam

Password:

Use password file

dekk i dkk

Proxy address:

Figure 17-16. Specifying Tableau Server connection settings.
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NOTE You can skip this step if you have specified Tableau Server connection settings in the
Security tab of the Options window.

4. Enter a data source name into the field provided and select a publish type.

Overwrite Data Source - This option will erase the existing data source and replace it with a new one
containing the newly exported data.

Replace Data - This option will erase all previous data in the data source and replace it with the newly
exported data.

Append Data - This option will append the newly exported data to the data in the existing data source.

5. Select Accept when you are finished to close Export Design view and add your newly defined export to the
Export selector in Export view.

6. Run the export as usual.

Exports to Tableau Server via Monarch Classic are discussed in greater detail here.

DUPLICATING EXPORTS

You may want to create a new export that closely resembles an export you previously defined. An easy way to do this
(+)
is by using the Duplicate ﬁ button. To duplicate an export, simply select the export you want to duplicate from the

Export list and then select Duplicate @ from the Export Design ribbon. The duplicated export appears on the
Export list; this export will have the name of the export you duplicated and a nhumber appended to it. Select this export
to display its properties in the Export Definition window and make further revisions to it. Select Accept when you are
finished to accept and save your new export definition.
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[18] IMPORTING DATA FROM HTML,
WEB FILES, AND EXTERNAL
DATABASES

This chapter, and the ones that follow, deal with advanced capabilities found in Monarch.

For most of its history, Monarch has been the leading report mining tool available in the market, allowing access to
data buried in computer generated reports. Monarch transforms static report data into live data that you can explore,
analyze, and export to other applications. While its ability to re-deploy data locked inside reports has been the major
factor distinguishing Monarch technology from other data access technologies, Monarch also includes powerful data
manipulation, analysis, and transformation tools that potentially make it valuable for use with other data sources.

Monarch reads report files and data from database files, spreadsheet files, delimited text files, HTML, ODBC
databases, PDF and XPS files, and provides report extraction, data manipulation, analysis, and transformation
capabilities. As well, data access from additional sources, including dBase, MS-Excel, and MS-Access files, OLE DB
and ODBC compatible data sources, such as SQL Server, Oracle, DB2, MySQL, and others, is possible.

In this chapter, you will learn how to import data from an external data source to begin a Monarch session. You will
also learn how to import HTML and web files into Monarch. The lesson topics include:

Accessing database data with Monarch
Importing data from an external database
Adjusting fields

Storing import parameters in a model file
Storing import parameters in a project file

Importing data from an HTML file

0O 0 0O 0O 0 O

Importing data from a Web file

IMPORTING DATA FROM AN EXTERNAL
DATABASE

To illustrate Monarch’s database import capability, we'll import data from an MS-Access database file called
Employ.mdb. This file contains information about the employees of a fictitious company. We'll use Monarch to open
the file and import data from its Employee Roster database table.

STEPS:

1. Ensure that Monarch is up and running.
2. Select File > Open > Database > Computer.

The Open Database File dialog displays. This dialog allows you to select the data source, either a data file from
a local or network drive or an OLE DB/ODBC data source, such as a SQL Server, Oracle, or other OLE
DB/ODBC compatible database server.
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M Open Database File *

N <« Public Documents » Altair Monarch » Data v O Search Data 2
Organize + MNew folder == ~ [N 0
[ This PC A [ MName Date modified Type Size
:j 3D Objects Beantown 5/11/2020 11:03 AM Microsoft Access ... 14
I Desktop Customer 5/11/2020 11:03 AM Microsoft Access ... 14
Documents Employ 5/11/2020 11:03 AM Microsoft Access ... 14
Payroll 5/11/2020 11:03 AM Microsoft Access ... 1
; Downloads
J5 Music
[&] Pictures
m Videos
i Windows (C)
- Recovery Image (
= Yum (F1 g = 2
File name: || v| | Anfiles ) v|
| Open | | Cancel |

Figure 18-1. The Open Database File dialog.

Monarch can import data from the following local file formats:

MS Access 2003 and earlier MDB

MS Access 2007, 2010, 2013 ACCDB

MS Excel 5.0, 8.0 XLS

MS Excel 2007, 2010, 2013 XLSX, XLSM
dBASE I, 1v, 5.0 DBF

Delimited text files CSV, TAB, ASC
HTML HTM, HTML, ASP
PDF files 10,11,1.2,13,14,15,16 PDF

XPS 1.0 XPS

If you wanted to import from an OLE DB-compatible database (and you have the driver installed), you would
select the OLE DB option, instead of Computer, and then choose whether to import data via the Data Link
Wizard or a Data Link File. Note that OLE DB is usually faster than ODBC, so if you have a choice of
connections to your database, choose OLE DB. If you have existing projects and models that use ODBC, then
you may want to change the connection method to benefit from enhanced performance.

If you wanted to import data from an ODBC compatible database you would select the ODBC connection
option, and then use the Select an ODBC Data Source dialog that displays to select the ODBC data source
name (DSN) that connects to your ODBC data source. Monarch can import data from ODBC data sources for
which you have established an ODBC Data Source Name definition (referred to as a DSN). Monarch does not
create a DSN for you — you must create a DSN using the Windows Control Panel ODBC Data Sources applet or
a similar utility.

Open the Employ.mdb file from the Altair Monarch\Data folder.
4. Click the Open button to open the data source.

Monarch displays the path to the Employ.mdb file in the dialog’'s Data Source box.
5. Click the Select Table button to launch the Select Table dialog.
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The Select Table dialog displays all of the database tables and queries that are available within the selected
database. This list does not include system tables or queries, which hold information about the database
structure.

M Select Table — O X

Table Name
+ [] Employes Roster

Select Cancel Help

Figure 18-2. The Select Table dialog.

Our sample Employ.mdb database file holds only a single database table, called Employee Roster.

6. Check the box for Employee Roster. Expanding the node * beside the table name displays all of the fields
associated with the selected table.

M Select Table - O x

Table Name

= Employee Roster

Column Name | Data Type

» | Department Character
Last Name Character
First Name Character

Employee ID Character

Hire Date Date/Time
Gender Character
Net Income MNumeric

|. Select Cancel Help

Figure 18-3. Fields associated with the selected table.

7. Click Select to close the dialog.

Altair Monarch 2024.1 Learning Guide 330



NOTE If you wanted to apply a filter to the data, you could do so by selecting the Apply Filter ?

button located on the upper right-hand corner of the dialog box to launch the Filters menu.

The right side of the File screen reflects the selections you have made.

@ Open a document Database
Recent Documents Data Source - Access.
Open E‘,‘
C:\Users\Public\Documents\Altair Monarch\Data\Employ.mdb v
Save g Al fiketypes Computer Table:

Open any supported file.
— Select Table Employee Roster
ave As Re

port

Open one or more PDF or Text reports. Include password

Page Setup...

Archive Modek:

Open ZIP and GZIP archives —
| . Open Model ~ v

Database
Import data from CSV, Excel, Access, ODBC and
OLE DB.

B
=
g

Close All

_ Project
Close Open a project.
Model

Open s medel. (Ciri=0)

Help

- Define and Import Data Import Data Help
Exit Monarch Classic

Figure 18-4. Reviewing table(s) to open from a database.

The Model field allows you to specify a model file to apply to the database. Applying a model to a database is
similar to applying a model to a report. The model holds parameters that indicate which fields to extract from the
database, along with field properties for each field and filter, sort, calculated field, and summary definitions, if
any.

8. Select Import Data to bring your data into Table view.

File Home Report Table Summary Export ?
54 S| e 4 i o~ ‘8 a
S @ Zoom To Fit [£] Copy

Design

ShowField  Freeze
¥4 Autosize Columns . G Data View

TS sseesmamsenmemnm O 0 Department Last Name First Name Employee ID Hire Date Gender Net Income -
A O 1 [Acountng | Aldridge Jeff 1502784 10051013 M 62000
Main 2 Accounting Daley ‘william 1587390 19930130 M 58480
3 Accounting Georges ‘William 1596792 20050604 M 58480
4 Accounting Gluck Anna 1593309 20000312 F 62380
5 Accounting Jacebson Doug 1601562 19981026 M 70050
6  Accounting Marshall Alana 1598264 20031118 F 42750
7 Accounting Martins Wayne 1594566 20010412 M 62900
8  Accounting Poretsky Teresa 1588940 19960104 F 60690
9 Accounting Rosenberg Kelly 1590228 15970902 F 60690
10 Accounting Russo Paula 1586498 19930105 F 42750
11 Accounting Stancowicz Mary Beth 1593599 19971011 F 62380
12 Accounting Woodruff Elizabeth 1600325 20030623 F 70050
13 Data Processing Bass Andrew 1593211 19990318 M 63420
14 Data Processing Bittner Herb 1597596 20050318 M 54450
15 Data Processing Bittner Martha 1604193 20011218 F 81490
16 Data Processing Condon James 1597266 20050604 M 81490
17 Data Processing Condon Roberta 1590086 19950228 F 63420
18 Data Processing Curtis Neil 1599507 20020814 M 81490
19 Data Processing Evans Marlena 1592913 20000604 F 64330
20 Data Processing Finn Amold 1594470 20010224 M 60560
21 Data Processing Horton Alice 1598482 19970930 F 58350
22 Data Processing Howard Rae Ann 1588939 19960104 F 60560
23 Data Processing Hubbard Lynn 1593319 19950630 F 54450
24 Data Processing Isenberg Gwen 1594545 19990430 F 52500
25 Data Processing Johnston Barry 1601801 19961228 M 65110
26 Data Processing Kelley Mary Beth 1593184 20000312 F 58350
27  Data Processing Lavois Francis 1603243 20031026 M 59650
28 Data Processing Matuso Linda 1587769 19931203 F 64330
29 Data Processing Matuso Mitzi 1592711 19951013 F 62250
30 Data Processing McPherson Stephen 1596204 20020614 M 56140 -
] »
Department - Character - Database: Department Filter: No Filter SorzNo Sort 100 Rows  100% — ——f——— +

Figure 18-5. An excerpt of the table we opened via an Open Database operation.
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9. If you want to define how the fields of the table should be displayed in table view, in Step 8, choose Define and
Import Data instead of Import Data.

Design
— 4 — — - — = — = B |
= = — s = 5 5 5 F B
v % = 5y E ® T 1 = =V
Accept  Cancel Add Duplicate Delete Database  External Field Database  Formula  Lookup Runtime User Edit Filters  Sorts . "
W . Lookups List Fields Fields Fields Parameter Fields Figlds
~
Import Fields [N egIg ~
Import Database Fields CAUsers\Public\Documents\Altair Monarch\Data\Employ.mdb - Employee Roster | Change Data Source
v| | Department Department
v| | Employee ID Employee ID
v First Name First Name
v| | Gender Gender
~| | Hire Date Hire Date
v Last Name Last Name
~| | NetIncome Net Income
Select All Deselect All Name Prefix: Replace nulls with default values
T e I S 1
Department Last Name First Name Employee 1D Hire Date Gender Net Income
1 [Accounting | aldridge Jeff 1502784 19951013 [0 62900
2 Accounting Daley William 1587390 19930130 [ 58480
3 Accounting Georges William 1595792 20050604 [ 58480
4 Accounting Gluck Anna 1593309 20000312 F 62380
5 Accounting Jacobson Doug 1601562 19981026 M 70050
6  Accounting Marshall Aana 1598264 20031118 F 42750
7 Accounting Martins. Wayne 1594566 20010412 M 62900
&  Accounting Poretsky Teresa 1588940 19950104 F 60690
‘n Accounting Baconhoro Wl 1500778 10070000 c ENEDN. 5 =
Department - Character - Database: Depantment Filter: No Fiter SortNoSom 100Rows  100% ———f————+

Figure 18-6. When you select Define and Import Data, the Edit Table Properties screen displays.

In the Edit Table Properties screen that displays, two tabs may be observed: one to specify which database
fields you want to import and another to specify a filter to apply. By default, all of the fields are selected for
importation. Note also that import fields and filter definitions are only saved in project files.

You can manually edit the way import column names will appear in Table view by clicking on the appropriate
cells under the Table Window Name column in the Import Fields tab.

You can also add a name prefix to one or more of the import column names. To do so, however, you must enter
the prefix in the Name Prefix box before selecting any of the columns to import. After specifying the prefix, you
can then either click the Select All button or select individual columns via their check boxes. The names for the
columns you chose to import will then be displayed, preceded by the name prefix (e.g., if you specified a Name
Prefix of “Test”, for example, the import column name for the “Department” source column would be
“TestDepartment.”

10. Since we want to import all fields, leave the default settings as they are and click Accept v
Monarch launches Table view and_populates it with data imported from the Employ.mdb file’'s Employee Roster

table. Select Autosize Columns *3* to display the fields properly.
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File Home Report Table Summary Export
Table ‘@ Zoom To Fit [] Copy P Search  Goto  Findin Rebuild Ty =
Tz=gm ¥4 Autosize Columns HCE Data View
~
Home v
Tables - o B Department Last Name First Name Employee ID Hire Date Gender Net Income =
i O 1 [Accounting | mldridge Jeff 1592784 19951013 M 62900
Main 2 Accounting Daley ‘William 1587390 19930130 M 58480
3 Accounting Georges ‘William 1596792 20050604 M 58480
4 Accounting Gluck Anna 1593309 20000312 F 62380
5 Accounting Jacebson Doug 1601562 19981026 M 70050
6 Accounting Marshall Alana 1598264 20031118 F 42750
7  Accounting Martins Wayne 1594566 20010412 M 62900
8  Accounting Poretsky Teresa 1588940 18960104 F 60690
9 Accounting Rosenberg Kelly 1590228 18970902 F 60690
10 Accounting Russo Paula 1586498 19930105 F 42750
11 Accounting Stancowicz Mary Beth 1593599 19971011 F 62380
12 Accounting Woodruff Elizabeth 1600325 20030623 F 70050
13 Data Processing Bass Andrew 1593211 19990318 M 63420
14 Data Processing Bittner Herb 1597596 20050318 M 54450
15 Data Processing Bittner Martha 1604193 20011218 F 81490
16 Data Processing Condon James 1597266 20050604 M 81490
17 Data Processing Condon Roberta 1590086 19950228 F 63420
18 Data Processing Curtis Neil 1599507 20020814 M 81490
19 Data Processing Evans Marlena 1592913 20000604 F 64330
20 Data Processing Finn Amold 1594470 20010224 M 60560
21 Data Processing Horton Alice 1598482 19970930 F 58350
22 Data Processing Howard Rae Ann 1588939 19960104 F 60560
23 Data Processing Hubbard Lynn 1593319 19950630 F 54450
24 Data Processing Isenberg Gwen 1594545 19950430 F 52500
25 Data Processing Johnston Barry 1601801 19961228 M 65110
26 Data Processing Kelley Mary Beth 1593184 20000312 F 58350
27 Data Processing Lavois Francis 1603243 20031026 M 59650
28  Data Processing Matuso Linda 1587769 19931203 F 64330
29 Data Processing Matuso Mitzi 1592711 19951013 F 62250
30 Data Processing McPherson Stephen 1596204 20020614 M 56140 -
] »
Department - Charscter - Database: Department Filter: No Filter Sor=NoSort 100Rows  100% ——f—————+

Figure 18-7. Monarch’s Table view is populated with the data

NOTE

imported from Employ.mdb — Employee Roster.

The Table view may be initially populated using data extracted from report files or using

data imported from an external database. You cannot draw data from both sources at the
same time to populate the table. If you start a Monarch session by opening a report file, you
will not be allowed to import data from an external database in that Monarch session.
Conversely, if you start a Monarch session by importing data from an external database,
you will not be allowed to open any report files in that Monarch session. These two means

of initially populating Monarch’s Table view
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WORKING WITH THE ALTAIR ODBC DRIVERS

The Altair ODBC Drivers are very similar to the Altair Data Connectors in that both connector types allow you to
access data from a number of database types. The Altair ODBC drivers support access to, among others, the
following database types:

0O Amazon EMR Hive 0  Hortonworks Hive 0  SharePoint
O  Amazon Redshift O HubSpot O ServiceNow
0 Cassandra a  Informix 0 Snowflake
O Cloudera CDH Hive O MapR Hive 0O  SparkSQL
0 Cloudera Impala o MySQL 0 SQL Azure
O DB2 O  Netsuite O  SQL Server
0O  Google BigQuery O OLEDB 0 Sybase

O  Greenplum 0 Oracle 0O  Sybase IQ
0 Hadoop Hive O PostgreSQL O Teradata

Despite their similarities, however, marked differences between these connector types may be observed. The ODBC
Drivers are configured “outside” of Monarch through the ODBC Data Source Administrator, whereas the Data
Connectors are configured within Data Prep Studio. Whereas the connection settings for the Data Connectors must
be specified each time a new database table is to be added to Data Prep Studio, the ODBC drivers are configured
only once and can be applied any number of times to a Monarch session thereafter.

Because of these differences, you may want to think about what you aim to achieve when you access an Oracle
database, for example. For instances where you only require quick and dirty data prep operations, working with the
Data Connectors in Data Prep Studio may be a good choice. If you wish to establish continuous access to a
database, however, setting up the ODBC Drivers may be a better strategy.

Setting Up the Altair ODBC Drivers

The Altair ODBC Drivers are stored in C:\Program Files\Common Files\Altair\Drivers.

Similar to Data Prep Studio, connecting to any of the database types supported in Monarch requires some
information, including host name, server name, user ID, password, and database name, among others. Which
information you need will depend on the database to which you are attempting to connect. If you wish to use any of
the data connectors, contact your database administrator to obtain the necessary connection details.

This section describes how to set up the Altair ODBC Drivers. As a typical example, this guide will demonstrate how
to set up the ODBC Driver for Cloudera Impala.

STEPS:

1. Select Start > Control Panel > System and Security > Administrative Tools > ODBC Data Sources
(bitness). Here, “bitness” corresponds to the bitness you selected when Monarch was installed.
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The ODBC Data Source Administrator dialog displays.
; QODBC Data Source Administrator (64-bit) s

User DSN  System DSM  File DSN  Drivers  Tracing  Connection Pocling  About

User Data Sources:

Mame  Platform  Driver Add...

Remave

Corfigure...

.. An ODBC User data source stores information about how to connect to the indicated data provider. A
E; User data source is only visible to you, and can only be used on the cument machine.

Cancel Aoy Help

Figure 18-8. The ODBC Data Source Administrator dialog.

2. Select Add.

3. From the Create New Data Source dialog that displays, select, for example, Altair Impala Wire Protocol and
then click Finish.

Create Mew Data Source *

Select a driver for which you want to set up a data source.

L Name Vers ™
Altair Google BigQuery 8.00
it Altair Greenplum Wire Protocal .00
Altair Impala Wire Protocol 710
Altair Informix Wire Protocol a.00
Altair MySGL Wire Protocol 8.00
Altair Oracle Wire Protocol a.00
Altair Postgre SQL Wire Protocol 8.00 v
( P n;n

< Back Cancel

Figure 18-9. Selecting an ODBC driver to set up an ODBC data source connection.
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The ODBC Impala Wire Protocol Driver Setup dialog displays.
ODBC Impala Wire Protocol Driver Setup ? >

General  Advanced Securty About

Data Source Name: || | Help
Description: | |
Host Name: | |
Porthumber: [21050 |
Database Name: [defautt |

Test Connect Cancel Apply

Figure 18-10. The ODBC Impala Wire Protocol Driver Setup dialog.

4. Provide a data source name so that you can easily identify this driver from a list.
Type in the host name and the database name you wish to gain access to.

Select Test Connect to check whether you have the credentials necessary to access the database you named

in Step 4.
Legon to Impala *
Host Name: [___ I
Port Number: [21050 | Cancel
Database: |default |
Help
User Name: | |
Paszswaord: | |

Figure 18-11. Testing a Cloudera Impala database connection.

7. Enter your user name and password into the appropriate fields.
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8. Click OK.

If the connection is successful, the following message displays.

Test Connect *

Connection established!

Figure 18-12. A successful ODBC connection.

9. Select OK on the ODBC Impala Wire Protocol Driver Setup dialog.
;‘ ODBC Data Source Administrator (64-bit) =

User DSN  System DSN  File DSN  Drivers  Tracing  Connection Pooling  About

User Data Sources:

Name Platform  Driver | Add... |
Cloudera Impala gL Altair Impala Wire Protocol
‘ Remove |
‘ Configurs... |

An ODBC User data source stores information about how to connect to the indicated data provider. A
; User data source is only visible to you and can only be used on this computer.

OK || Cancel | Apply Help

Figure 18-13. The ODBC driver you have just set up is added to the list of allows user data sources in the ODBC Data
Source Administrator dialog.

Drivers for Establishing Connections to ODBC Data Sources

The following table lists the ODBC drivers available in Monarch for establishing connections to ODBC data sources.

Amazon EMR Hive Altair Apache Hive Wire Protocol
Amazon Redshift Altair Amazon Redshift Wire Protocol
Cassandra Altair Apache Cassandra

Cloudera CDH Hive Altair Apache Hive Wire Protocol
Cloudera Impala Altair Impala Wire Protocol

DB2 Altair DB2 Wire Protocol
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Google BigQuery Altair Google BigQuery

Greenplum Altair Greenplum Wire Protocol
Hadoop Hive Altair Apache Hive Wire Protocol
Hortonworks Hive Altair Apache Hive Wire Protocol
HubSpot Altair Autonomous REST Connector
Informix Altair Informix Wire Protocol

MapR Hive Altair Apache Hive Wire Protocol
MySQL Altair MySQL Wire Protocol / Devart ODBC Driver for MySQL
Netsuite Devart ODBC Driver for NetSuite
Oracle Altair Oracle Wire Protocol
PostgreSQL Altair PostgreSQL Wire Protocol
SharePoint Altair SharePoint

ServiceNow Altair Autonomous REST Connector
Snowflake Altair Snowflake

SparkSQL Altair Apache SparkSQL

SQL Azure Altair SQL Server Wire Protocol
SQL Server Altair SQL Server Wire Protocol
Sybase Altair Sybase Wire Protocol

Sybase 1Q Altair Sybase 1Q Wire Protocol
Teradata Altair Teradata

Connecting to a Database Using the ODBC Drivers

Assuming that you have set up all of the ODBC drivers you need, you can now begin importing data into Monarch.

STEPS:

1. Select File > Open > Database > ODBC.
The Select an ODBC Data Source dialog displays.
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M Select an ODBC Data Source

Data Source Mame Type Driver Description
Cloudera Impala User Alltair Impala Wire Protocol

Use Trusted Connection (Windows Authentication)
Login 1D:

Password:

OK Cancel Help

Figure 18-14. The Select an ODBC Data Source dialog.

Select Cloudera Impala from the list of data source names that displays and then enter an appropriate Login ID
and password to connect to this database type.

If connection to the database is successful, the Open Database dialog displays and you can select tables as
described in Importing Data from an External Database.

Database
Data Source - Odbe
=
‘ODBC;DSN=Cloudera Impala;UID=cloudera b
Computer Table:
| Select Table |
‘P
- +| Include password R
Web
Maodel:
[ Open Model ~ | A
e
CODEC
e
OLE DB
Help

- Define and Import Data Import Data

Figure 18-15. The Open Database dialog confirms successful Cloudera Impala connection.

For more information and updates on the Altair ODBC drivers, click here.
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WORKING WITH DATABASES

Once you have imported data into the Table view, you can sort, filter, and export the data, create new calculated
fields, and use the data in the Summary window where you can create summary reports that perform analyses on the
data. In short, you can do anything with imported data that you can do with data extracted from a report file.

Typically, the first thing that you'll want to do when importing data is to inspect each field to ensure that its column
width, type and other properties are set correctly. After adjusting the column widths, you should briefly inspect each
field to ensure that Monarch has established the appropriate field type, whether character, numeric, date, or memo.
When importing data, Monarch sets the type for each field according to its type in the source database. However,
only a subset of the field types available in many database applications is supported, so it maps subtypes to the
corresponding base type.

For example, MS Access supports several numeric field types, including Byte, Integer, Long Integer, Single, Double,
etc. Monarch supports only Numeric, with General, Thousands, Currency, Percentage, and Time Span formats that
determine how a number is represented on screen. When you import a numeric field from an MDB file, Monarch will
always set the field type to Numeric and will assign to it a format type of General.

You should inspect each numeric field to ensure that its type and other properties are set appropriately. In
Employ.mdb, which we loaded into Classic as the first lesson in this chapter, the Net Income field is the only numeric
field in our imported data set. Let’s inspect this field’s properties.

Setting Field Properties

STEPS:

1. Double-click on the Net Income field to display its properties via the Field Properties window.

Design

= - <1 = b = ol = = =
v % = e 5 E = T | B =V ¥ B A ?
Accept  Cancel Add  Duplicate Delete Datsbase  Extenal  Field Database|  Formula  Lookup Runtime User Edit Fiters  Sorts Address  Functions Help
= s Lookups  List Fields Fields Fields  Parameter Fields Ficlds Blocks
~
Database Fields v 1 [EEEY Advanced v
i £ -
& Department Field Properties
8 Last Name
= Name: Net |
S8 First Name: e eincome
£2 Employee ID Type: Numeric v
8 Hire Date -
- Decimals: L
8 Gender
T8 Net Income Format: General v
Display Width: |20 =
Alignment: Right v
Hidden
Data Preview v R
Department Last Name: First Name Employee ID Hire Date Gender Net Income =
1 [Accounting ] Aldridge Jeff 1502784 19951013 [ 62900
2 Accounting Daley William 1587390 19930130 [ 58480
3 Accounting Georges william 1596792 20050604 M 58480
4 Accounting Gluck Anna 1593309 20000312 F 62380
5 Accounting Jacobson Doug 1601562 19981026 M 70050
6 Accounting Marshall Alznz 1598264 20031118 F 42750
7 Accounting Marting Wayne 1504566 20010412 M 62900
&  Accounting Poretsky Teresa 1568940 19960104 F 60690
9 Accounting Rosenbera Kelly 1590228, 19970902 3 60690 -
Kl 3
Depariment - Charscter - Datsbase: Department Filter: No Filter Sort NoSort 100 Rows  100% ———f#————+

Figure 18-16. Field properties for the Net Income field.

Note that the decimal setting of this field is set to 0 (zero) and that its format setting is set to General. Let's
change the field format to Thousands and the decimals to 2. While we're here, let's change the name of this field
to something more intuitive.

2. Change the field name to Salary and then click the ¥ putton adjacent to this field.
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3. Click the drop-down button on the Format list to display the available field formats.

Note that Monarch displays only numeric field formats. For fields imported from a database, Monarch does not
allow you to change the base field type (from Numeric to Character for example).

4. Select Thousands as the new field format.
5. Change the Decimals setting to 2.
6. Click the Accept button to accept the changes to the field properties.

The Table is updated to reflect the changes.

Department Last Name First Name Employee 1D Hire Date Gender Salary
1 [Accountng | Aldridge Jeff 1502784 10951013 M 62,900.00
2 Accounting Daley William 1587390 19930130 M 58,480.00
3 Accounting Georges William 1596792 20050604 M 58,480.00
4 Accounting Gluck Anna 1593309 20000312 F 62,380.00
3 Accounting Jacobson Doug 1601562 15981026 M 70,050.00
6  Accounting Marshall Alana 1598264 20031118 F 42,750.00
7 Accounting Martins Wayne 1594566 20010412 M 62,900.00
8  Accounting Poretsky Teresa 1588940 19960104 F 60,690.00
9  Accounting Rosenberg Kelhy 1590228 19970902 F 60,690.00
10 Accounting Russo Paula 1586498 19930105 F 42,750.00
11 Accounting Stancowicz Mary Beth 1593599 19971011 F 62,380.00
12 Accounting Woodruff Elizabeth 1600325 20030623 F 70,050.00
13 Data Processing Bass Andrew 1593211 19980318 M 63,420.00
14 Data Processing Bittner Herb 1597596 20050318 M 54,450.00
15 Data Processing Bittner Martha 1604193 20011218 F 81,490.00
16 Data Processing Condon James 1597266 20050604 M 81,490.00
17  Data Processing Condon Roberta 1590086 19950228 F 63,420.00
18 Data Processing Curtis Neil 1599507 20020814 M 81,490.00
19 Data Processing Evans Marlena 1592913 20000604 F 64,330.00
20 Data Processing Finn Arnold 1594470 20010224 M 60,560.00
21 Data Processing Horton Alice 1598482 19970930 F 58,350.00
22 Data Processing Howard Rae Ann 1588939 19960104 F 60,560.00
23 Data Processing Hubbard Lynn 1593319 19950630 F 54,450.00
24 Data Processing Isenberg Gwen 1594545 19990430 F 52,500.00
25 Data Processing Johnston Barry 1601801 19961228 M 65,110.00
26  Data Processing Kelley Mary Beth 1593184 20000312 F 58,350.00
27 Data Processing Lavois Francis 1603242 20031026 M 59,650.00
28 Data Processing Matuso Linda 1587769 19931203 F 64,330.00
28 Data Processing Matuso Mitzi 1592711 19951013 F 62,250.00
30 Data Processing McPherson Stephen 1596204 20020614 M 56,140.00

Figure 18-17. Salary field adjusted.

Setting Delimited Text Properties

The following settings may be modified when working with delimited text files imported as databases.

0O  First row contains column names — Check this box to indicate that the first row of the file contains column
names

0 Delimiter character — Specifies the delimiter (i.e., comma, tab, semicolon, pipe, space, other) used in the file to
separate values

0 Quoted values may contain embedded line breaks — Check this box if values may run beyond one line (i.e.,
the value includes a line break)

0O Text qualifier — Specifies what character is used (i.e., double quote, single quote, none) to enclose values.
When Monarch encounters this qualifier in a line, all of the text following this character and preceding its next
instance is imported as one value, regardless of the delimiter used (see Note below).

Character set — Specifies the type of encoding to use when interpreting data

Lines to skip at start — The number indicated in this box instructs Monarch to skip n lines before beginning data
import
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NOTE Delimiter vs. Qualifier Example

If the delimiter is a comma (,) and the text qualifier is a double quotation mark ("), "Boston,
Massachusetts" is imported into one cell as “Boston, Massachusetts.” By contrast, if no
character or the single quotation mark (') is specified as the text qualifier, "Boston,
Massachusetts" is imported into two adjacent cells as "Boston" and "Massachusetts."

Storing Import Parameters in Project Files

After making adjustments to the imported fields, it's a good idea to save your changes to a Monarch project file.
Project files store both the input file(s) and the model file, including the original names of each imported field, as well
as the Monarch field name and properties you assigned. By opening project files, Monarch preserves the work you
did in this session. Let’'s save our work to a project file and then reload the session.

STEPS:

Select File and then click on the arrow of the Save As %,j menu.

Select Project, and then type Import in the File name box of the Save Project dialog that displays. Leave the
Save as type field as is.

Click the Save button to save the model file.

Select File and then click Exit Monarch to exit the Monarch session.

Opening Project Files

Now let’s restart Monarch and import the data along with the model file.

STEPS:

1.

Select the Monarch item from the Windows Start menu.
Select File > Open > Project.
In the Open Project dialog that displays, select Import.dprj.

Monarch displays the imported data and model files in Table view. Note that the table presents as in Figure 18-
17, which indicates that the field definitions we specified in the saved model have been applied to the open
database.

Select File and then click Close All. Select No when asked if you would like to save changes made to the model
file.
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IMPORTING DATA FROM AN HTML FILE

One of the features that distinguishes Monarch from other is its ability to utilize HTML files. With Monarch, you can
import an HTML file and then create templates to extract data from it just as you would with a typical report.

When you import an HTML file, Monarch parses it into a “Monarch-friendly” format and adds markup you may find
helpful when trapping fields.

NOTE Monarch is best suited to work with dynamically generated HTML pages, such as those
resulting from database queries.

Let’'s explore Monarch’s HTML capabilities.

STEPS:

1. Select File, click on the arrow of the Open menu, and then select Report to display the Open Report dialog.
2. From the Files of type drop-down list, select HTML files (*.htm;*.html;*.asp; *.aspx).
3. Select the Airlines.htm file, and then click the Open button.

Monarch parses the HTML file and displays it in the Report view. Note the markup that Monarch has added (e.g.,
"<Table-00..."). This markup can be used when trapping fields.

File Home Report Table Summary Export ?
. (] T~
= = [Couriernew — ~[10 ~ Select All Previous Report Next Report =
L;l R ourier New [10 4] clect an revious Repor ext Repo | | =] W
Report Auto “Gr Zoom To Fit [£] Copy Search  Findin Previous Page [ Next Page s::lgu‘ﬂ ‘R:dpgt pr[;rlirp‘) (E;%Q:S
Design Define B Greenbar e £, Go To Page EnToEmT S
A
[ Fepor View % | v
Report Files v B L i o o -
— <TABLE=000 NEST=01 ROW=000 COL=00 ID=0001>
[E)] £| |soston, MA (B0S) to Manchester, England (MAN)
.~ Fares wvalid for travel through October 2008
[ Ailines.htm 1ad f

<TABLE=001 NEST=02 ROW=001 COL=01 ID=0002>

03>
Round-Trip
04>

Independent Airways

33

offe:

Page1 0% ———h— +

Figure 18-18. Viewing the Airlines.htm file.

Airlines.htm is a list of flights from Boston, MA to Manchester, England. It contains information such as the price
of the flights, the airline providing them, and their earliest and latest travel and return dates.

Let’'s scroll down the report and look for an appropriate line with which to create a detail template. Remember, a
detail template is used for extracting information from the lowest report level.
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Notice that for each flight listed, the Latest Return information is the last given. This should do for our detail
template, so let's begin by trapping the Latest Return information.

4. Select the Report Design E’ button to launch the Report Design interface.

5. Locate one of the Latest Return lines in the report. In the line selection area to the left of it, click and drag so
that the Latest Return line and the two lines below it are highlighted.

NOTE You can easily locate the Latest Return information via the Search function of Monarch.

6. Select New Template > Detail to activate the Template Editor.

Template Editor v

|StandardTrap A 0 B o | & - + = Trap Line v -'5 Reset Trap Line £ Reset Fields §EditF|'eId Delete Field
|
Latest Return: -
<TABLE=004 NEST=03 ROW=005 CCL=02 ID=0021>
[ months -
> -
* <TABLE=000 NEST=01 ROW=000 COL=00 ID=0001>
® Boston, MA (BOS) to Manchester, England (MAN)
#* Fares walid for trawvel through Cctober 2008
* <TABLE=001 NEST=02 ROW=001 COL=01 ID=0002>
2
k2
* <TABLE=002 NE5T=02 ROW=000 COL=00 ID=0003>
*0SD 276.00 ( Plus applicable charges *} Round-Trip
> T E=003 NEST=02 ROW=000 COL=00 ID=0004>
k2
2T 2
k2
3 < T3 02
k2
® |- 2 ROW=000 COL=0 007>
®»
* |<TABLE=003 NWNEST=02 ROW=000 COL=0C ID=0 B>
®»
# |<TABLE=003 NEST=02 RCW=001 CCL=01 ID=0 9 =
‘B »

Figure 18-19. Highlighting the Latest Return information.

7. Rename this template Latest Return.

8. Inthe Trap line, type Latest Return: directly above its occurrence in the Sample Text box, then highlight the
latest return information (e.g., "1 months") in the Sample Text box. Extend the highlight by one more character to
include instances of two-digit months.

Template Editor >

|Standard Trap v| AN E O | 8 - « -+ Trap Line v -f) Reset Trap Line 50 Reset Fields S# Edit Field Delete Field

latest return:

Latest Return: -
<TRBLE=004 NEST=03 ROW=005 CCL=02 ID=0021>

-

Figure 18-20. Specifying trap characters and highlighting a field.

The newly defined field’s properties (i.e., those of eg_1 months) display in the Field Properties panel.
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10.
11.

12.
13.
14.

15.
16.

Field Properties ~

Mame: eg_1 months

Template Width: |9 -

Type: Character ™
Decimals: 0
Format: General »

a

Display Width: |11 -
Alignment: Left hd

Copy Value From Previous Record

Hidden

< Previous Field Next Field >

Figure 18-21. The Field Properties panel of the field eg_1 months.

Type Latest Return in the Name field of this panel and then click the ¥ putton that displays next to this field to
accept your changes. Click the Accept % icon in the window ribbon to save your changes.

The Template Editor closes and the Report view displays. Scroll down the report and note that all instances of
the Latest Return information are now highlighted.

Now that we've defined our detail template, let's define some append templates to capture additional information
from the HTML file.

Click Report Design E’ once more.

Scroll down the report until you come to one of the price lines (e.g., USD 276.00), and then click in the line
selection area to highlight it.

Select New Templates > Append to activate the Template Editor.
Replace Append 1 with Price in the Template Name field of the Template Editor.

In the Trap line, type USD directly above its occurrence in the Sample Text box, and then highlight the price in
the Sample Text box.

Template Editor >

|StandardTrap v| E 0N R O 8 - « » Traplinev [¥)ResetTrapline 5D ResetFields S Edit Field 5% Delete Field

usd
USD el ( Plus applicable charges *) Round-Trip

Figure 18-22. Trapping the Price field.

The properties of this newly defined field display in the Field Properties panel.
Type Price in the Name field, and then click v 1o accept your changes.
Click Accept v

The Template Editor closes and the Report view displays. Scroll down the report and note that all instances of
the flight price information are highlighted.

Let's see how the information we’'ve trapped will look in Table view.
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17. Select the Table tab and then click Autosize Columns *2* to view all of the fields properly.

Monarch displays the two fields we've trapped as columns in the Table view.

Latest Return Price

1 1 months
2 291.00 1 months
3] 296.00 1 months
4 296.00 1 months
5 311.00 1 months
6 311.00 1 months
7 326.00 1 months
8 327.00 1 months
9 327.00 1 months
10 336.00 1 months
11 336.00 1 months
12 341.00 1 months
13 356.00 1 months
14 372.00 1 months
15 372.00 1 months
16 385.00 1 months
17 392.00 2 months
18 397.00 1 months
19 457.00 3 months
20 457.00 6 months

Figure 18-23. Viewing the fields in the Table view.

18. Return to Report view.

Using the same techniques that we used to trap the Latest Return and Price fields, try trapping some of the other
fields in the HTML file (e.g., Earliest Return, Earliest Travel, Latest Travel, etc.).

When you've finished trapping as many fields as you want to, view them in the Table view to see how successful
you are.

IMPORTING DATA FROM A WEB FILE

You can import web-based data sources in Monarch. To do so, simply select File > Open > Report > Web to launch
the Open Web File dialog.

M Open Web File - O ®

Address: | hitpe/¥ (HTTP GET) * || hitpe// ¥
httpe/f (HTTP GET)

https:// (Secured HTTP GET)
http:// (WebDAV) Connect Cancel l [ Help
https:/ (WebDAV)

ftp:// (File Transfer Protocol)
sftpi/f (Secure FTP)

awss3y/ (Amazon 53)

Figure 18-24. Opening a web file in Monarch.

The Open Web File dialog allows you to select a file protocol (e.g., http://, https://, ftp://, etc.) from a drop-down menu
and enter the name of the file to open in the adjacent text box. Tooltips are provided for each protocol as a guide. The
drop-down button located to the right of the filename text box enables you to access recently opened web files.
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[19] CREATING EXTERNAL
LOOKUPS

In this chapter, we’ll discuss external lookups, which allow you to add columns from an external database to the
Monarch table. The lesson topics include:

O Adiscussion of what an external lookup is

Creating an external lookup from a report

0 Storing lookup parameters in a model file
0 Creating a lookup from two different reports
0 Creating a lookup from two external databases

WHAT IS AN EXTERNAL LOOKUP?

An external lookup (in technical terms, a left outer join) combines information from two or more tables into a single
table. External lookups are both powerful and easy to use. In Monarch, a lookup can be used to link two or more
database sources together or to link a report to one or more database sources.

As an example, consider the tables on the following page. The first table lists employees in the Marketing department
of afictional company. This table includes each employee’s name and the city where he or she lives. The second
table lists employee compensation. Both tables share a common column, called Emp_ID, designating a unique ID
assigned to each employee. From the Marketing table, you could create a lookup, based on the Emp_ID column, to
the Compensation table to find the salary and bonus for each employee in the Marketing department.

Marketing Table

Emp_ID Dept Lastname Firstname City
1597429 Marketing April Anne Worcester
1607768 Marketing Banning David Burlington
1593642 Marketing Bartholemew Anne Brookfield
1605798 Marketing Bradford Eugene Brookline
1588509 Marketing Carlson Stephen Boston

Compensation Table

Emp_ID Salary Bonus
1587390 38,480.00 200.00
1588509 49,452.00 5,000.00
1593642 42,640.00 4,000.00
1596792 38,480.00 200.00
1597429 55,900.00 5,000.00
1604375 48,620.00 500.00
1605798 67,990.00 8,500.00
1607768 72,150.00 10,000.00

Figure 19-1. Marketing and Compensation tables with a common Emp_ID column.
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To link data from two tables, you start by defining a lookup between the tables. A lookup connects the tables based
on one or more columns that appear in both tables. These columns, referred to as link columns, must include at
least some values that are common to both tables. In our example, the Emp_ID column would be suitable as a link
column, as it contains values that are common to both the Marketing and Compensation tables.

To link these two tables, you would start with the Marketing table, and then create a lookup to the Compensation
table on the Emp_ID column. Then you select the Salary and Bonus columns to add to the Marketing table. The
resulting table is shown in Figure 19-2.

Marketing Table

Emp_ID Dept Lastname Firstname  City Salary Bonus
1597429 Marketing  April Anne Worcester 55,900.00  5,000.00
1607768 Marketing  Banning David Burlington 72,150.00 10,000.00
1593642  Marketing  Bartholemew  Anne Brookfield 42,640.00  4,000.00
1605798 Marketing  Bradford Eugene Brookline 67,990.00 8,500.00
1588509  Marketing  Carlson Stephen Boston 49,452.00  5,000.00

Figure 19-2. Marketing Employees table with Salary and Bonus columns linked from Compensation table.

Note that only those records from the Compensation table that have corresponding Emp_ID values in the Marketing

table are included in the resulting table. Since the lookup was initiated from the Marketing table, only the records that
appear in the Marketing table are included. Records in the Compensation table that have no corresponding Emp_ID

values in the Marketing table are ignored.

This behavior is unique to a lookup. In other types of joins, records from both tables are combined, with the resulting
table having at least one record for each record in the contributing tables. Monarch doesn’t support these types of
joins, so no new records are added when joining data in Monarch.

To begin this lesson, open the Orders.prn report file and load the Lesson9.dmod model file. Go on and view the
table of extracted data.

File Home Report Table Summary Export ?

54 B sclect Al | e it & iz RO eSS

“Qr Zoom To Fit [ o _ f ShowField  Freeze
Table o Active Sort Search  Goto  Findin Rebuild Contents  Panes~
¥4 Autosize Columns = Epor =i ez

Design
Home  ReportView m v
Account Number Customer Ship Date  Media Qty Description Amount -
0

N 1 Big Shanty Music 2/4/2010 (D 6 Stravinsky, Dumbarton Ozks Concerto 53.94
2 17959 Big Shanty Music 2/4/2010 o 1 Schubert, Sonata in e, D.566 9.00

Main 3 17959 Big Shanty Music 2/4/2010  CD 3 Mozart, Symphony No.23 in D 26.97
a 17959 Big Shanty Music 2/4/2010 61 6 Schoenberg, Ode to Napoleon 57.54
5 17959 Big Shanty Music 2/13/2010 CD 2 Shostakovich, 24 Preludes for piano. 10.78
6 17959 Big Shanty Music 2/13/2010  SACD 9 Balakirev, Symphony no. 1 86.21
7 17959 Big Shanty Music 2/13/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29.95
8 18635 Classics and Jazz 2/1/2010 [#3) 7 Sibelius, Tapiola, 0p.112, Ashkenazy 41.93
9 18635 Classics and Jazz 2/1/2010 50 8 Argento, Postcard from Morocco 163.04
10 18635 Classics and Jazz 2/1/2010 o) 1 Bach, Fantasia in G for Organ 6.59
11 18635 Classics and Jazz 2/1/2010 LP 2 Desprez, Missa de Beata Virgine 15.58
12 18635 Classics and Jazz 2/17/2010 CD 2 Reich, Music for Pieces of Wood 17.98
13 18635 Classics and Jazz 2/17/2010 CD 4 Glass, Einstein on the Beach 143.80
14 18635 Classics and Jazz 2/17/2010 CD 6 Cage, Music of Changes 53.94
15 18635 Classics and Jazz 2/17/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29.95
16 17658 Fandangos Records 2/4/2010 BLU -6 Beethoven, Pathetique Sonata, Arau -35.04
17 17658 Fandangos Records 2/27/2010 CD 7 Chopin, 4 Scherzos for piano 37.73
18 17658 Fandangos Records 2/27/2010 D 3 Salieri, Falstaff, Opera in 3 acts 48.48
19 17658 Fandangos Records 2/27/2010 CD 4 Brahms, Sonata for 2 pianos 3L16
20 17658 Fandangos Records 2/27j2010  DVD 4 Tartini, Conc. in G, fl & strs, Galway 23.96
21 10609 Hope's Sweet Notes 2/13/2010 €D 10 Krenek, Jonny spielt auf, V. St. Orch. 65.90
22 10609 Hope's Sweet Notes 2/13/2010  CD 8 Misc., The Art of Periman, Ttzhak, vn. 307.20
23 10609 Hope's Sweet Notes 2/13/2010  BLU 10 Barber, Adagio for Strings, NZSO 77.90
24 10609 Hope's Sweet Notes 2/13/2010  DVD 5 Britten, War Requiem 59.90
25 10609 Hope's Sweet Notes 2/14/2010  CD 8 Beethoven, 3rd Sym, Karajan, Berlin 72.00
26 10609 Hope's Sweet Notes 2/14/2010  CD 4 Stravinsky, Puldinella, Bernstein, NYPO 35.06
27 10609 Hope's Sweet Notes 2/14/2010 P 9 Misc.,, Modern Trombone Masterpieces 43.11
28 11433 Classic Exchange 2/14/2010 €D 6 Reich, The Desert Man, Brooklyn PO 32.34
29 11433 Classic Exchange 2/14/2010 (D 7 Cowell, Adagio for vc & Thunderstick 41.93
30 11433 Classic Exchange 2/14/2010 €D 9 Copland, Songs, DeGaetani, Smit 48.51
31 11433 Classic Exchange 2/14/2010  CD 7 Rimsky-Korsakov, At the Tomb 62.03 -
‘ v

| ccount Number - Numeric - Append (Account Number Level) Fiter: No Filter SortNo Sort  91Rows  100% — —f—— +

Figure 19-3. The Orders.prn report does not include customer address information.
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CREATING AN EXTERNAL LOOKUP FROM A
REPORT

To illustrate Monarch’s database linking capability, we’'ll provide a simple example that starts with a slightly modified
version of our familiar Classic report file; this report is called Orders.prn. We'll apply a model file to extract data from
the report into the Table view, and then we’ll create a lookup to an external database to add several columns to the

table.

Orders.prn is a modified version of Classic.prn. Since you're familiar with Classic.prn, you'll notice that we've
removed the address information below each customer name. For the sake of this lesson, let's imagine that the report
is always produced using only the customer name and that the customer addresses reside in a corporate database.
After extracting data from the report using a standard Monarch model file, we'll use a lookup to retrieve the customer
addresses from the database.

The Table view includes all of the columns that we've extracted from the report, including each customer's name and
account number. We'll use the Account Number column to link to the Customer.mdb database, which holds the
customer addresses.

STEPS:
1. Select Table Design from the Table ribbon and then click Add > External Lookup E". The Open Database
dialog displays. This dialog is similar to the Open Database dialog we used in Chapter 18.

M Open Database X

Data Source -
Er_1

Computer Table:

‘ Select Table

Include password

O

210,

Import Data Cancel Help

Figure 19-4. The Open Database dialog.

2. Click Computer.
The Open Database File dialog appears.
3. Select the Customer.mdb file.
4. Click the Open button to select the data source.
Monarch displays the path to the Customer.mdb file in the Data Source box.
5. Click the Select Table button to display the Select Table dialog box.

This dialog shows all of the database tables and queries that are available within the selected database. The list
does not include system tables or queries that hold information about the database structure.

Altair Monarch 2024.1 Learning Guide 349



M Select Table

Table Name

+ | [] Customer

Select

Cancel ] |

Help

Figure 19-5. The Select Table dialog displays the Customer screen.

Our sample Customer.mdb database file holds only a single database table, called Customer.

6. Ensure that the box for Customer is checked. If you wish, you can also expand the ™' node beside the table
name to see all of the fields that make up the table. Click Select when you are done to apply your selection and
close the Select Table dialog.

7. Click the Import Data button on the Open Database dialog.

The dialog closes and you are transferred to the External Lookup Field Definition window.

Design
= 5 p— = = = = = — =
X = QA = M s & = ] Y #z |V | B A ?
Accept  Cancel Add Duplicate Delete External Field Input  Formula  Lockup Runtime User Edit Filters  Sorts Address  Functions Help
v Lookups List Fields Fields Fields  Parameter Fields Fields Blocks
~
Data Sources i v [ |[ERCUEIIESENN SRR External Lookup Filter ~
L .
External Lockup Fields
B External Lookup
Name | External Lookup
| Change Data Source | CAUsers\Public\Documents\Altair Monarch\Data\C - Customer
O Acct_Num Numeric Acct_Num
O Address 1 Character Address 1
O Address 2 Character Address 2
O City Character City
O State Character State
(] Zip Numeric Zip
Select All Deselect Al Name Prefix:
Replace nulls with default values >
Data Preview iitii s it i wow
Account Number Customer Order Number  Ship Date Media Qty Description Label Number Unit Price Amount
1 17959] Big Shanty Music 536118 2/4/2000  CD 6 Stravinsky, Dumbarton Oaks Concerto SMCD 5120 899  53.94
2 17959 Big Shanty Music 536118 2/4/2010 €D 1 Schubert, Sonata in e, D.566 AS-325 9.00 9.00
3 17959 Big Shanty Music 536118 2/4/2010 €D 3 Mozart, Symphony No.23 in D Co-77884 899  26.97
4 17959 Big Shanty Music 536118 2/4/2000  CD 6 Schoenberg, Ode to Napoleon CHAN 9116 9.59  57.54

Account Number - Numeric - Append (Account Number Level)

Filter: No Fiter SortNoSort 91 Rows _ 100% — ——f——+

Figure 19-6. The Row Definition screen.
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10.
11.

The External Lookup Field Definition window displays a Linking Columns Assignment screen. We'll use this
screen to establish an external lookup between the external database and Monarch.

Check the Linking Column box for Acct_Num.

The Acct_Num column in Customer.mdb and Account Number column in your extracted table are actually the
same column. Each column holds the unique account number assigned to each customer. The column names
are not required to be the same, but they must be of the same type (character, numeric, or date), and they must
contain matching values that can be used to create a relationship between the two tables.

In the first row of the Table Window Name column, use the drop-down provided to ensure that Account Number
is selected.

The Select column allows you to choose with columns from the database to import into Monarch (i.e., the linked
columns). This screen lists the names of all columns that are available in the selected database table or view.
Since we want to import the entire address for each customer, we’ll make sure all of the available columns
selected.

Default names, taken from the source columns, are assigned to the import columns and are displayed under the
Table Window Name heading. These are the names that will be assigned to the columns when you import them
into Monarch.

If you wish to change the way the name of any of the fields in Customer.mdb displays in Table view, you may do
so in the Table Window name column. If you want to apply an import filter to the data, you may also do so by
clicking on the External Lookup Filter tab and then specifying a filter expression in the screen that displays.

For now, we’'ll simply link the appropriate columns in our table and database.
Name this lookup Lookupl.
Click the Accept % putton to close the window.

Your table is rebuilt and new address columns are added to it. Monarch links the external database table to the
Monarch table, adding the selected columns to the Table view as linked columns.

Account Number Customer Ship Date Media Qty Description Amount Address 1 Address 2 City State =
1 Big Shanty Music 34/2010 D 6 Stravinsky, Dumbarton Oaks Concerto 53.94 3658 Springs Ferry Suite C-130 Marietta GA
2 17959 Big Shanty Music 2/4/2010 cD 1 Schubert, Sonata in e, D.566 9.00 3658 Springs Ferry Suite C-130 Marietta GA
3 17959 Big Shanty Music 2/4/2010 D 3 Mozart, Symphony No.23 in D 26.97 3658 Springs Ferry Suite C-130 Marietta GA
4 17959 Big Shanty Music 2/4/2010 D 6 Schoenberg, Ode to Napoleon 57.54 3658 Springs Ferry Suite C-130 Marietta GA
5 17959 Big Shanty Music 2/13/2010 CD 2 Shostakovich, 24 Preludes for piano. 10.78 3658 Springs Ferry Suite C-130 Marietta GA
6 17959 Big Shanty Music 2/13/2010  SACD 9 Balakirev, Symphony no. 1 86.31 3658 Springs Ferry Suite C-130 Marietta GA
7 17959 Big Shanty Music 2/13/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29,95 3658 Springs Ferry Suite C-130 Marietta GA
8 18635 Classics and Jazz 2/1/2010 cD 7 Sibelius, Tapiola, Op.112, Ashkenazy 41.93 170 Rue de Iz Poste Fleury-les-Aubrais
] 18635 Classics and Jazz 2{1/2010 cD & Argento, Postcard from Morocco 163.04 170 Rue de |z Poste Fleury-les-Aubrais
10 18635 Classics and Jazz 2/1/2010 cD 1 Bach, Fantasia in G for Organ 6.59 170 Rue de |z Poste Fleury-les-Aubrais
11 18635 Classics and Jazz 2{1/2010 Lp 2 Desprez, Missa de Beata Virgine 15.58 170 Rue de |3 Poste Fleury-les-Aubrais
12 18635 Classics and Jazz 2{17/2010 D 2 Reich, Music for Pieces of Wood 17.98 170 Rue de |a Poste Fleury-les-Aubrais
13 18635 Classics and Jazz 2/17[2010 CD 4 Glass, Einstein on the Beach 143.80 170 Rue de |z Poste Fleury-les-Aubrais
14 18635 Classics and Jazz 2{17/2010 CD 6 Cage, Music of Changes 53.94 170 Rue de |a Poste Fleury-les-Aubrais
15 18635 Classics and Jazz 2/17/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29.95 170 Rue de |z Poste Fleury-les-Aubrais
16 17658 Fandangos Records 2/4/2010 BLU -6 Beethoven, Pathetique Sonata, Arau -35.94 555 Elisabeth San Antonio TX
17 17658 Fandangos Records 2/27/2010 D 7 Chopin, 4 Scherzos for piano 37.73 555 Elisabeth San Antonio TX
18 17658 Fandangos Records 2{27/2010 (D 3 Salieri, Falstaff, Opera in 3 acts 48.48 555 Elisabeth San Antonio ™
19 17658 Fandangos Records 2272010 CD 4 Brahms, Sonata for 2 pianos 31.16 555 Elisabeth San Antonio T
20 17658 Fandangos Records 2{27/2010 DVD 4 Tartini, Conc. in G, fl & strs, Galway 23.95 555 Elisabeth San Antonio ™
21 10609 Hope's Sweet Notes 2/13/2010 (D 10 Krenek, Jonny spielt auf, V. St. Orch. 65.90 B0O East Danforth Hope AR
22 10609 Hope's Sweet Notes 2/13/2010 CD 8 Misc., The Art of Perlman, Itzhak, vn. 307.20 800 East Danforth Hope AR
23 10609 Hope's Sweet Notes 2/13/2010 BLU 10 Barber, Adagio for Strings, NZSO 77.90 800 East Danforth Hope AR
24 10609 Hope's Sweet Notes 2/13/2010 DVD 5 Britten, War Requiem 59.90 B00 East Danforth Hope AR
25 10609 Hope's Sweet Notes 2/14/2010 D 8 Beethoven, 3rd Sym, Karajan, Berlin 72,00 800 East Danforth Hope AR
26 10609 Hope's Sweet Notes 2/14/2010 D 4 Stravinsky, Pulcinella, Bernstein, NYPO 35.96 800 East Danforth Hope AR
27 10609 Hope's Sweet Notes 2/14/2010 LP 9 Misc., Modern Trombone Masterpieces 43.11 800 East Danforth Hope AR
28 11433 Classic Exchange 2/14/2010 CD 6 Reich, The Desert Man, Brooklyn PO 32.34 57 Market Street Cork
29 11433 Classic Exchange 2/14/2010 CD 7 Cowell, Adagio for vc & Thunderstick 41.93 57 Market Street Cork
30 11433 Classic Exchange 2/14/2010 CD 9 Copland, Songs, DeGaetani, Smit 48.51 57 Market Street Cork
31 11433 Classic Exchange 2/14/2010 (D 7 Rimsky-Korsakov, At the Tomb 62.93 57 Market Street Cork
32 11433 Classic Exchange 2{14/2010 D 3 Purcell, Birthday Ode for Mary TT 23.37 57 Market Street Cork -

4 »

Figure 19-7. The table is rebuilt to include fields from the Customer.mdb database.
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NOTE

You can manually edit the import column names by double-clicking on them. You can also
add a name prefix to one or more of the import column names. To do so, however, you must

enter the prefix in the Name Prefix box of the External Lookup Field Definition window
before selecting any of the columns to import. After specifying the prefix, you can then

either click the Select All button or select individual columns via their check boxes. The
names for the columns you chose to import will then be displayed, preceded by the name
prefix (e.g., if you specified a Name Prefix of “Test”, for example, the import column name

for the “Address 1” source column would be “TestAddress 1.”

12. Scroll right to view the linked columns.

@ N OB W e
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12
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15
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24
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28
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by Music
by Music
by Music
ty Music
by Music
bty Music
ind Jazz
ind Jazz
ind Jazz
and Jazz
and Jazz
ind Jazz
ind Jazz
ind Jazz
25 Records
35 Records
35 Records
35 Records
35 Records
neet Notes
neet Notes
Neet Notes
Neet Notes
weet Notes
weet Notes
neet Notes
«change
«change
«change
«change
«change

Ship Date
2/4/2010

2/4/2010

2/4/2010

2/4/2010

2/13/2010
2/13/2010
2/13/2010
2/1/2010

2[1/2010

2[1/2010

2/1/2010

2/17/2010
2/17/2010
2/17/2010
2/17/2010
2/4/2010

2/27/2010
2/27/2010
2/27/2010
2/27/2010
2/13/2010
2[13/2010
2/13/2010
2/13/2010
2/14/2010
2/14/2010
2/14/2010
2[14/2010
2/14/2010
2[14/2010
2/14/2010
2/14/2010

Media Qty
o 6
co 1
o 3
co 6
co 2
SACD 9
DVD 5
co 7
co 8
co 1
LP 2
o 2
co 4
co 6
DvVD 5
BLU 6
o 7
o 3
co 4
DvVD 4
co 0
co 8
BLU 0
DVD 5
co 8
co 4
LP 9
co 6
co 7
co 9
co 7
o 3

-

=

Description

Stravinsky, Dumbarton Oaks Concerto
Schubert, Sonata in &, D.566

Mozart, Symphony No.23 in D
Schoenberg, Ode to Napoleon
Shostakovich, 24 Preludes for piano.
Balzkirev, Symphony no. 1

Haolst, St. Paul's Suite for Orch.
Sibelius, Tapiola, Op.112, Ashkenazy
Argento, Postcard from Morocco
Bach, Fantasia in G for Organ
Desprez, Missa de Beatz Virgine
Reich, Music for Pieces of Wood
Glass, Einstein on the Beach

Cage, Music of Changes

Holst, St. Paul's Suite for Orch.
Beethoven, Pathetique Sonata, Arau
Chopin, 4 Scherzos for piano

Salieri, Falstaff, Opera in 3 acts
Brahms, Sonata for 2 pianos

Tartini, Conc. in G, fl & strs, Galway
Krenek, Jonny spielt auf, V. St. Orch.
Misc., The Art of Periman, Itzhak, vn.
Barber, Adagio for Strings, NZSO
Britten, War Requiem

Beethoven, 3rd Sym, Karajan, Berlin
Stravinsky, Pulcinella, Bernstein, NYPO
Misc., Modern Trombone Masterpieces
Reich, The Desert Man, Brooklyn PO
Cowell, Adagio for v & Thunderstick
Copland, Songs, DeGaetani, Smit
Rimsky-Korsakov, At the Tomb

Purcell, Birthday Qde for Mary 1T

Amount
53.94
9.00
26.97
57.54
10.78
86.31
29.95
41.93
163.04
6.59
15.58
17.08
143.80
53.94
29.95
-33.94
37.73
48.48
3116
23.96
65.90
307.20
77.90
59.90
72.00
35.96
43.11
32.34
41.93
48.51
62.93
23.37

Address 1

3658 Springs Ferry
3658 Springs Ferry
3658 Springs Ferry
3658 Springs Ferry
3658 Springs Ferry
3658 Springs Ferry
3658 Springs Ferry
170 Rue de |3 Poste
170 Rue de la Poste
170 Rue de la Poste
170 Rue de |a Poste
170 Rue de |a Poste
170 Rue de |a Poste
170 Rue de |a Poste
170 Rue de la Poste
555 Elisabeth

555 Elisabeth

555 Elisabeth

555 Elisabeth

555 Elisabeth

800 East Danforth
800 East Danforth
B00 East Danforth
B00 East Danforth
BOO East Danforth
BOO East Danforth
B0O East Danforth
57 Market Street
57 Market Street
57 Market Street
57 Market Street
57 Market Street

Address 2

Suite C-130
Suite C-130
Suite C-130
Suite C-130
Suite C-130
Suite C-130
Suite C-130

City

Marietta

Marietta

Marietta

Marietta

Marietta

Marietta

Marietta
Fleury-les-Aubrais
Fleury-les-Aubrais
Fleury-les-Aubrais
Fleury-les-Aubrais
Fleury-les-Aubrais
Fleury-les-Aubrais
Fleury-les-Aubrais
Fleury-les-Aubrais
San Antonio

San Antonio

San Antonio

San Antonio

San Antonio

Hope

Hope

Hope

Hope

Hope

Hope

Hope

Cork

Cork

Cork

Cork

Cork

T

22222228

Zip

30067
30067
30067
30067
30067
30067
30067
45400
45400
45400
45400
45400
45400
45400
45400
78250
78250
78250
78250
78250
71801
71801
71801
71801
71801
71801
71801
null

null

null

null

null

Figure 19-8. The customer address columns are added to each record in the Monarch table.

You can use linked fields just like any other fields in Monarch. Linked fields can be used in filter, sort, calculated
field, and summary definitions and can be printed or exported along with fields that you extract from a report.

Note that in this example, the External Lookup table displays below the Main database table and that Data Prep
Studio can only open the Main table.
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STORING LOOKUP PARAMETERS IN A MODEL
FILE

Lookup parameters can be saved in a Monarch model file along with other information about your Monarch session.
When you load the model file, the lookup parameters are used to re-establish the lookup with the external database.

Storing lookup parameters in a model file is easy. You simply save the model file. That’s all there is to it. The model
file records the name of the lookup database along with the fields used to establish the lookup and the fields you
linked to the Monarch table. By applying the model in a future Monarch session, Monarch preserves the work you did
in this session. Let’'s save a model file and then reload the session using the model.

STEPS:

1. Select File > Save As ﬂ > Model.
The Save Model dialog appears.

2. Type Lookup in the File name box of the dialog (the .dmod extension is automatically added) and then click the
Save button to save the model file.

3. Select File and then click Close All to end the current Monarch session.

CREATING A LOOKUP FROM TWO DIFFERENT
REPORTS

While Monarch’s linking capability is very useful if you happen to have access to a database that includes the
information you need, what if your data resides in two different reports? You may have already guessed the answer:
Using Monarch’s export capability, you can create a database file from one report, start a new Monarch session to
extract data from the second report, and then create a lookup to the exported database file. While this involves a two-
pass approach, it's relatively easy to do.

Let's imagine that we don’t have access to the database of customer address information that we used in the
previous example. Instead, we have the Orders.prn report and another report called Customer.prn that lists all of our
customers. Let's use Monarch to link information from these two reports.

Using a Report to Create a Lookup File

We'll start by opening the Customer report, applying a model to extract the customer address and account number
fields, and then exporting these fields to a database file. We'll use this file as a lookup file, which we'll link to the
Orders.prn report.

STEPS:

1. Open the Customer.prn report file as well as the Customer.dmod model file.

2. Select the Table tab and then click Autosize Columns *=* to maximize your view of all of the columns in the

table.
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Acct_Num Address 1 Address 2 City State Zip
1 11887 Muscatine Plaza 200 Lower Muscatine Cedar Falls IA 50613
2 17959 3658 Springs Ferry Suite C-130 Marietta GA 30067
3 10929 Hwy 17 at the 9 mile marke Prospect KY 40059
4 18635 170 Rue de la Poste Fleury-les-Aubrais 45400
5 17658 555 Elisabeth San Antonio TX 78250
6 13487 Einkaufszentrum am Petrus  General-Schwarz-Strae 23 Bremen 31005
7 10609 800 East Danforth Hope AR 71801
8 12705 Paseo de las Palmeras Montevideo 11600
9 11433 57 Market Street Cork null
10 15091 1 Rue du Rivage Tomblaine 54510
11 18172 Goldgasse 6 Wiesbaden 66007
12 10073 1709 Arbor Parkway Ypsilanty MI 48197
13 15844 Jacob Obrechtstraat 22a Amsterdam null
14 16284 363 Park St. Chicago IL 60602
15 15403 12 Duke Street Estover Plymouth Devon null
16 19764 214 Rue de la Station Neuvy-le-Roi 37370
17 12014 197 Putnam Street Philadelphia PA 19107
18 11860 GeorgstraBe 21 Hannover 30045
19 18917 214 Railroad Avenue Nashville ™ 37215
20 14162 Calle del Desea, 80 La Paz 50781

Figure 19-9. Customer address fields extracted from report.

The Table view includes all of the columns that we've extracted from the report, including each customer’s name,
account number, and address. Now we’'ll export the table to a database file.

Select the Export tab and then click Create Export l-;.-. to launch the Create Export dialog.

4. Specify a filename of LookupSource.

5. Ensure that Table is selected in the Source View panel and then select Microsoft Access MDB (*.mdb) as the
Export File Type.

6. Type CustomerAddresses in the Table Name field and then click the Run this export button located on the
upper left-hand corner of the dialog.

A progress dialog displays. Monarch displays the following message box when the export is finished.

M Export Results - O H

Running export job Exportl
Export job Export1:
20 records written to C:\Users\PublichDocuments\Altair Monarch
ExportilockupSource.mdb
Export time: 00:00:02.3
Total ime: 00:00:02.3

- Close

Figure 19-10. The message box that displays after successfully completing the export.

You have just created a lookup file.
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Linking to the Lookup File

Now that the first report has been exported to a database file, it's time to load the second report and link to it.

STEPS:

1. Close all of the open files in Monarch and then open the Orders.prn report and the Lesson9.dmod model file.
Select No when asked if changes to Customer.dmod or the project should be saved.

2. Select the Table tab and then click Autosize Columns *=* to maximize your view of the data in the table.

Account Number Customer Ship Date Media Qty Description Amount
1 Big Shanty Music /42010 D 6 Stravinsky, Dumbarton Ozks Concerto 53.94
2 17959 Big Shanty Music 2/4/2010 CcD 1 Schubert, Sonata in g, D.566 9.00
3 17959 Big Shanty Music 2/4/2010 CcD 3 Mozart, Symphony No.23 in D 26.97
4 17959 Big Shanty Music 2/4/2010 CcD 6 Schoenberg, Ode to Napoleon 57.54
5 17959 Big Shanty Music 2{13/2010 CD 2 Shostakovich, 24 Preludes for piano. 10.78
6 17959 Big Shanty Music 2/13/2010  SACD 9 Balakirev, Symphony no. 1 86.31
7 17959 Big Shanty Music 2/13/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29,95
8 18635 Classics and Jazz 2/1/2010 cD 7 Sibelius, Tapiola, Op.112, Ashkenazy 41,93
9 18635 Classics and Jazz 2/1/2010 cD 8 Argento, Postcard from Morocco 163.04
10 18635 Classics and Jazz 2/1/2010 cD 1 Bach, Fantasia in G for Organ 6.59
11 18635 Classics and Jazz 2/1/2010 LP 2 Desprez, Missa de Beata Virgine 15.58
12 18635 Classics and Jazz 2{17/2010 CD 2 Reich, Music for Pieces of Wood 17.98
13 18635 Classics and Jazz 2/17/2010 cD 4 (lass, Einstein on the Beach 143,80
14 18635 Classics and Jazz 2{17/2010 CD 6 Cage, Music of Changes 53.94
15 18635 Classics and Jazz 2/17/2010 DVD 5 Holst, St. Paul's Suite for Orch. 29.95
16 17658 Fandangos Records 2/4/2010 BLU -6 Beethoven, Pathetique Sonata, Arau -35.94
17 17658 Fandangos Records 2(27/2010 CD 7 Chopin, 4 Scherzos for piano 37.73
18 17658 Fandangos Records 2(27/2010 CD 3 Salieri, Falstaff, Opera in 3 acts 48.48
19 17658 Fandangos Records 2(27/2010 CD 4 Brahms, Sonata for 2 pianos 31.16
20 17658 Fandangos Records 2/27/2010 DVD 4 Tartini, Conc. in G, fl & strs, Galway 23.96
21 10609 Hope's Sweet Motes 2/13/2010 CD 10 Krenek, Jonny spielt auf, V. St. Orch. 65.90
22 10609 Hope's Sweet Notes 2/13/2010 CD 8 Misc., The Art of Perlman, Itzhak, vn. 307.20
23 10609 Hope's Sweet Notes 2/13/2010 BLU 10 Barber, Adagio for Strings, NZSQO 77.90
24 10609 Hope's Sweet Notes 2/13/2010 DVD 5 Britten, War Reguiem 59.90

Figure 19-11. Data extracted from the Orders.prn report.

Now we'’re ready to link to the database file we created and pull in the address information for each customer.
Select Table Design > Add > External Lookup > Computer.

4. In the Open Database File dialog, select the LookupSource.mdb file from the Altair Monarch\Export folder then
click the Open button.

Monarch displays the path to the LookupSource.mdb file in the Data Source box.

5. Click the Select Table button and check the box for CustomerAddresses from the dialog that displays. Click
Select when you are done.

Select Import Data to close the Open Database dialog and launch the External Lookup Field Definition window.
Check the Linking Column box for Acct_Num.

In the first row of the Table Window Name column, ensure that Account Number is selected.

© ® N o

Click the Select All button to instruct Monarch to show all lookup fields in the resulting table.
10. Name this lookup Lookup2.
11. Select Accept v apply your changes and close the window.

Monarch links the CustomerAddresses table to the Monarch table, adding the address columns to the Table view
as linked columns. You may need to scroll to the right to view the address columns.
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Ship Date Media Qty Description Amount Address 1 Address 2 City State Zip -
1 Music 2/4/2010 cD 6 Stravinsky, Dumbarton Ozks Concerto 53.94 3658 Springs Ferry Suite C-130 Marietta GA 30067
2 Music 2/4/2010 cD 1 Schubert, Sonata in e, D.566 5.00 3658 Springs Ferry Suite C-130 Marietta GA 30067
3 Music 2{4/2010 D 3 Mozart, Symphony No.23 in D 26.97 3658 Springs Ferry  Suite C-130 Marietta GA 30067
4 Music 2/4/2010 D 6 Schoenberg, Ode to Napoleon 57.54 3658 Springs Ferry  Suite C-130 Marietta GA 30067
5 Music 2/13/2010 (D 2 Shostakovich, 24 Preludes for piano. 10.78 3658 Springs Ferry  Suite C-130 Marietta GA 30067
6 Music 2/13/2010  SACD 9 Balakirev, Symphony no. 1 86.31 3658 Springs Ferry  Suite C-130 Marietta GA 30067
7 Music 2/13/2010 DVD 5 Holst, St. Paul's Suite for Orch. 28.95 3658 Springs Ferry  Suite C-130 Marietta GA 30067
8 1Jazmz 2/1/2010 D 7 Sibelius, Tapiola, Op.112, Ashkenazy 41.93 170 Rue de |a Poste Fleury-les-Aubrais 45400
9 1lazz 2/1/2010 D 8 Argento, Postcard from Morocco 163.04 170 Rue de la Poste Fleury-les-Aubrais 45400
10 1 Jazz 2/1/2010 D 1 Bach, Fantasia in G for Organ 6.59 170 Rue de |z Poste Fleury-les-Aubrais 45400
11 {Jazz 2/1/2010 LP 2 Desprez, Missa de Beata Virgine 15.58 170 Rue de la Poste Fleury-les-Aubrais 45400
12 {Jazz 2/17/2010 cD 2 Reich, Music for Pieces of Wood 17.98 170 Rue de la Poste Fleury-les-Aubrais 45400
13 1Jazz 2/17/2010 CD 4 Glass, Einstein on the Beach 143.80 170 Rue de |z Poste Fleury-les-Aubrais 45400
14 1Jazz 2/17/2010 CD 6 Cage, Music of Changes 53.84 170 Rue de |a Poste Fleury-les-Aubrais 45400
15 1Jazz 2/17/2010 DVD 5 Haolst, 5t. Paul's Suite for Orch. 28.95 170 Rue de |a Poste Fleury-les-Aubrais 45400
16 Records 2/4/2010 BLU -6 Beethoven, Pathetique Sonata, Arau -35.94 555 Elisabeth San Antonio X 78250
17 Records 2/27/2010 CD 7 Chopin, 4 Scherzos for piano 37.73 555 Elisabeth San Antonio ™ 78250
18 Records 2/27/2010 CD 3 Salieri, Falstaff, Opera in 3 acts 48.48 555 Elisabeth San Antonio ™ 78250
19 Records 2/27/2010 (D 4 Brahms, Sonata for 2 pianos 31.16 555 Elisabeth San Antonio X 78250
20 Records 2(27/2010 DVD 4 Tartini, Conc. in G, fl & strs, Galway 23.96 553 Elisabeth San Antonio X 78250
21 et Motes 2/13/2010 cD 10 Krenek, Jonny spielt auf, V. St. Orch. 65.90 800 East Danforth Hope AR 71801
22 et Motes 2/13/2010 cD 8 Misc., The Art of Perlman, Itzhak, vn. 307.20 800 East Danforth Hope AR 71801
23 et Notes 2/13/2010 BLU 10 Barber, Adagio for Strings, NZSO 77.80 800 East Danforth Hope AR 71801
24 et Notes 2/13/2010 DVD 5 Britten, War Requiem 59.90 800 East Danforth Hope AR 71801

Figure 19-12. Customer addresses linked to Orders.prn report data (column widths autosized).

We started with two disparate reports and ended with data from both reports linked together in the Table view.

12. Select File, and then click Close All to reset the Monarch session. Select No when prompted to save changes to
the model.

CREATING A LOOKUP FROM TWO EXTERNAL
DATABASES

In the previous sections, we demonstrated how you can link data from an external database to data extracted from a
report. This is useful when a single report doesn'’t include all of the data you need, but you can also use Monarch to
combine data from two databases, without ever loading a report file.

To see how this process works, let’s return to the example from the beginning of this lesson. In that example, we
showed how you could link fields from an employee compensation table to an employee roster table.

The employee roster table is called Marketing since it stores information only about employees in the Marketing
department. The employee compensation table is called Compensation. This table stores salary and bonus
information for all employees for the entire company.

Importing Database Data

We'll start by importing data from the Marketing table. This table resides in the Beantown.mdb file (the name of our
fictional company is Bean Town Investments). The compensation table resides in a file called Payroll.mdb. We'll
create a lookup to this table in order to add the Salary and Bonus field for each employee.

STEPS:

1. Select File, click on the arrow of the Open menu, and then select Database > Computer.
The Open Database File dialog displays.

2. Select the Beantown.mdb file from the Altair Monarch\Data folder and then click Open.
Monarch displays the path to the Beantown.mdb file in the Data Source box.

3. Click the Select Table button and, in the Select Table dialog that displays, choose Marketing. Click Select when
you are done to close the dialog.
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4. Select Import Data to bring your data into Table view.

Monarch opens Table view and populates it with data imported from the Beantown.mdb file’s Marketing table.

Department Last Name First Name Emp_ID Hire Date Gender
1 April Anne 1597429 19931023 F
2 Marketing Banning David 1607768 20031218 M
3 Marketing Bartholemew Anng 1593642 19931118 F
4 Marketing Bradford Eugene 1605798 20050724 M
5 Marketing Carlson Stephen 1588509 19950304 M
6  Marketing Carpenter Rae Ann 1598699 19950630 F
7 Marketing Chandler Liz 1588291 19940504 F
8  Marketing Cohen Danny 1595028 19971212 M
9 Marketing Connely William 1593726 20000312 M
10 Marketing Desmarais Jeff 1593219 20010404 M
11 Marketing Fallon Joshua 1596297 20050105 M
12 Marketing Hampsted Armstrong 1593898 19990318 M
13 Marketing Hendrickson Robert 1589538 19960902 M
14  Marketing Hill Francis 1606310 19970930 F
15 Marketing Horgan Maggie 1598135 20040228 F
16 Marketing Ingles George 1589165 19960502 M
17  Marketing Leiberman Teresa 1590496 19970703 F
18  Marketing Manfretti Joseph 1598740 19990823 M
18 Marketing Marshall Alex 1597890 19931023 M
20 Marketing Mendleson Paula 1593345 19950718 F
21 Marketing Palentier Joshua 1593374 19950718 M
22 Marketing Pappas Julie 1598131 19960820 F
23 Marketing Pascurelli Mary 1586229 19920403 F
24 Marketing Stratton Marlena 1599780 20040614 F
25 Marketing Ungermann Morman 1500227 19950517 M
26  Marketing Valensuela George 1595576 19950430 M

Figure 19-13. Monarch’s Table view is populated with the data imported from Beantown.mdb, Marketing table.

Linking Database Data

Now we'll link to the Compensation table to add the salary and bonus information for each employee.

STEPS:

1. Select Table Design > Add > External Lookup > Computer.

2. In the Open Database File dialog, select the Payroll.mdb file from the Altair Monarch\Data folder, and then click
the Open button.

Monarch displays the path to the Payroll.mdb file in the dialog’s Data Source box.
3. Click the Select Table button.

The resulting dialog displays all of the database tables and queries that are available within the selected
database. Check the Compensation table box and then click Select.

4. Click Import Data to close the Open Database dialog and launch the External Lookup Field Definition window.
In the Linking Columns Assignment screen, check the Linking Column box for Emp_ID.
In the first row of the Table Window Name column, ensure that Emp_ID is selected.
This setting indicates that Emp_ID in the Payroll table should match Emp_ID in the Marketing table.

7. Ensure that both the Salary and Bonus fields are selected in the Select column.

8. Name this lookup Lookup3.

9. Click the Accept v button to apply your settings and close the External Lookup Field Definition window.

Monarch links the external database table to the Monarch table, adding the selected columns to the Table view
as linked columns.

Altair Monarch 2024.1 Learning Guide 357



Department Last Name First Name Emp_ID Hire Date Gender Bonus Salary

1 April Anne 1597429 19931023 F 25200 75900
2 Marketing Bznning David 1607768 20031218 M 32400 92150
3 Marketing Bartholemew Anne 1593642 19931118 F 19200 62640
4 Marketing Bradford Eugene 1605798 20050724 M 30600 87990
5 Marketing Carlson Stephen 1588509 19950304 M 22200 69452
6  Marketing Carpenter Rae Ann 1598699 19950630 F 31200 89290
7 Marketing Chandler Liz 1588291 19940504 F 28500 83570
8  Marketing Cohen Danny 1595028 19971212 M 19800 63940
9 Marketing Connely William 1593726 20000312 M 25200 65900
10 Marketing Desmarais Jeff 1593219 20010404 M 13800 40550
11 Marketing Fallon Joshua 1596297 20050105 M 31200 79290
12 Marketing Hampstad Armstrong 1593808 19990318 M 26100 68240
13 Marketing Hendrickson Robert 1589538 19960902 M 21600 57775
14  Marketing Hill Francis 1606310 19970930 F 32400 82150
15 Marketing Horgan Maggie 1598135 20040228 F 27600 71100
16 Marketing Ingles George 1589165 19960502 M 19200 52510
17  Marketing Leiberman Teresa 1590405 19970703 F 22500 59725
18 Marketing Manfretti Joseph 1598740 19990823 M 21600 57775
18  Marketing Marshall Alex 1597890 19931023 M 26100 68240
20 Marketing Mendleson Paula 1593345 19950718 F 22200 59452
21  Marketing Palentier Joshua 1593374 19950718 M 22500 59725
22  Marketing Pappas Julie 1598131 19960820 F 30600 77990
23 Marketing Pascurelli Mary 1586229 19920403 F 27600 71100
24 Marketing Stratton Marlena 1599780 20040614 F 28500 73570
25 Marketing Ungermann Morman 1500227 19950517 M 13800 40550
26  Marketing Valensuela George 1595576 19950430 M 19200 52510

Figure 19-14. Salary and Bonus information are added to each record in the Monarch table.

10. Select File, click on the arrow of the Save As !j menu, and then select Model.

11. Type Compensation in the File name box of the Save Model As dialog box that displays, and then click the
Save button to save the model file.

12. Select File and then click Exit Monarch.
NOTE If prompted to save changes to the project file, select No.

The model file stores the lookup parameters along with the import parameters. However, the model file does not
store the name of the import database. To restore the session, use the Open Database dialog to select the
Beantown.mdb file and the Compensation model.

Note that on the Dataset selection screen, you may select any of the three employee roster tables (Accounting,
Data Processing, or Marketing). The model will work equally well regardless of which table you select. That's
why the data source is not stored in the model file -- the model can be used with any compatible data source.
This is similar to how models store information about a report. The report name is not stored in the model so that
the model can be used with multiple reports as long as the reports all have a compatible format.
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[20] USING DIGITAL SIGNATURES

This chapter introduces a Monarch feature designed to authenticate files, thereby enhancing security. Here, you will
learn about digital signatures. The chapter assumes you are familiar with exporting Table or Summary data into XLSX
or XLSM formats.

Note that this feature is only available in Monarch Classic and Monarch Complete.

What are digital signatures? Digital signatures are used to authenticate files (i.e., the Excel files that are produced via
Monarch Export) by using computer cryptography. Digital signatures help to establish the following assurances:

0 Authenticity - The digital signature helps to assure that the signer is who he or she claims to be.

0 Integrity - The digital signature helps to assure that the content has not been changed or tampered with since it
was digitally signed.

0O Non-repudiation - The digital signature helps to prove to all parties the origin of the signed content. "Repudiation”
refers to the act of a signer's denying any association with the signed content.

To make these assurances, the content creator must digitally sign the content by using a signature that satisfies the
following criteria:

0  The digital signature is valid.

0 The certificate associated with the digital signature is current (not expired).
O  The signing person or organization, known as the publisher, is trusted.
a

The certificate associated with the digital signature is issued to the signing publisher by a reputable certificate
authority (CA).

To start, let’'s open the Classic.prn report and Lesson8.dmod model.

File Home Report Table Summary Export ?
- . [ o
= = 10 ~ Bl selectan Next Report | =
2 & [0] E o R L W
Report i @ Zoom To Fit [F] Copy Sy [ Next Page Bookmark :?:‘;:;rl P’Dpl'fli'a Ocm;:s
T Teitz [E] Greenbar ALl (. Go To Page Go To Chunk o
~
[ Report View X RV v
Report Files .. 05/01/10 CLASSICAL MUSIC DISTRIBUTORS BAGE 01 -
— 10:17 MONTHLY SHIPPING REPORT
N L MSR94 FROM 04/01/10 TO 04/30/10
H Classicprn
» CUSTCMER: Betty's Music Store
» Muscatine Plaza
= 200 Lower Muscatine
» Cedar Falls, IA 50613
UsE
» ACCOUNT NUMBER: 11887
s
» CONIACT: Betty Yoder
MEDIA QTY DESCRIPTICN LABEL/NO. UNT_PRC AMOUNT
» ORDER NUMBER: 536017 SHIP DATE: 04/10/10
=CD 4 Bartok, Sonata for Solo Violin ME-42625 g.99 35.9¢
7 Mozart, Mass in C, K.427 420831-2 8.00 63.00
» 2 Luening, Electronic Music CD 611 10.19 20.38
» DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
» ORDER NUMBER: 536038 SHIP DRTE: 04/21/10
*CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
» 8 Mendelssohn, War March of the Priests SMK 47592 8.99 71.92
» 10 Pizzetti, Messa di Requiem CHAN 8964 9.59 895.90
*>LP € Misc., Modern Trombone Masterpieces RDA SEL1087 10.79 64.74

» DVD 6 Gershwin, An American in Paris ACS 8034 5.99 35.94 S
- R

Pagel  f00% ——f——— +

Figure 20-1. Loading the Classic.prn report and Lesson8.dmod model.
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ADDING DIGITAL SIGNATURES TO AN EXCEL
FILE

STEPS:

1. Select the Table tab.

The Table view for the report displays. Select Autosize Columns ¥21 from the Table tab to view all the data
properly.
File Home Report Table Summary Export ?
24 Bl | e o6 v B QO B @

“Q* Zoom To Fit [£] Coy Show Field Freeze
Design Row Report Data View

»2¢ Autosize Columns

Home  Report View M v

1 Report Date  Order Number  Ship Date Account Number Contact Customer Postal Code  Country Media  Quantity -
o 1 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 usa o 4
2 5/1/2010 536017 4{10/2010 11887 Betty Yoder Betty's Music Store 50613 USA co 7
Main 3 5/1/2010 536017 4/10/2010 11887 Beftty Yoder Betty's Music Store 50613 usA o) 2
4 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 usA DVD 9
5 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA co 11
6 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA co 8
7 5/1f2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 Usa o 10
8 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 Usa Lp 6
9  5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA DVD 6
10 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA o 6
11 s5/1/2010 536016 4/5/2010 17958 Marvin Mabry Big Shanty Music 30067 UsA (5} 1
12 s5/1/2010 536016 4/5/2010 17958 Marvin Mabry Big Shanty Music 30067 UsA (5} 3
13 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA o) 6
14 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA o) 2
15 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA SACD 9
16 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA DVD 5
17  5/1f2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 usA o) 3
18 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 usA o) 3
19 s5/1/2010 536020 4{10/2010 10929 Roberto Gil Bluegrass Records 40059 USA co 6
20 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 USA SACD 8
21 s/1f2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 UsA DvD 9
22 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France o 10
23 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France co 5
24 5[/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France co 5
25 s/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France co 6
26 s/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France BLU 10
27 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France DVD 8
28 5/1/2010 RAGD2L 4/10/2010 18635 Alain Lebon Musigue du Monde 45400 France @ -10
29 s/1/2010 RA6021 4{10/2010 18635 Alain Lebon Musique du Monde 45400 France co -7
30 s/1/2010 RAB021 4{10/2010 18635 Alain Lebon Musique du Monde 45400 France DvD -1
31 5/1/2010 536034 4/18/2010 18635 Alzin Lebon Musique du Monde 45400 France cD 3
32 s5/1/2010 536034 4{18/2010 18635 Alain Lebon Musique du Monde 45400 France co 9|,
P e —— —— - — o - = :
Report Date - Date/Time - Page Header (Page Header) Filter: No Filter Sort Mo Ssort 148 Rows  100% — ——fF——— +

Figure 20-2. The Table view for Classic.prn report and Lesson8.dmod model.

2. Select the Export tab and then click the Create Export button.
The Create Export dialog displays.
In the File name box, enter Digitall.

4. Ensure that Table is selected in the Source View box and then select Microsoft Excel XLSX (*.xIsx) from the
Export File Type box.

5. Name the table DigiCert in the Table Name box.
6. Click the Edit Advanced Options button to launch the Export Design view.
7. Click the Advanced tab of the Excel Output panel.

The Excel Advanced Features options of the view display.
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10.

11.
12.

13.

Design

R

v X P & P 2

Accept  Cancel Add  Duplicate  Delete Help
Export Bport  Export

Exports. v B Table View BN Excel Output =
A 0 (SR Advanced ~
® Export] Export Name

Document Options
Exportl

Security: Digital Signature Certificate... v
Filtering
) Filter: Add AutoFilter drop down lists to column labels in the Table
Select Filter:
o Fitey e Pivot: Include Pivat Table sheet

The filter will be applied to the table during export. When sheet with prvot table eists: | Skip table i

Sorting Fields | Options

Sort Order: Report Filter New.. v| Column Labels New... v

No Sort v

The sort order will be applied to the table during export.

Row Labels New.. v| Values New... v

w0 ——F——+

Figure 20-3. The Excel Advanced features panel in Export Design view.

Check the Digital Signature box.

When you do this, the Certificate drop-down list is activated. This list contains options that allow you to select
where the digital certificate you are applying is located. Let's say that your digital certificate is stored in the same
machine in which Monarch is installed.

Select Change to Certificate from File from the Certificate drop-down list.

Select the digital certificate you wish to apply to the export, and then click OK.

Depending on the settings of your digital signature, you may or may not be asked to set a password for the
certificate. If prompted to do so, simply provide one.

Click Accept v when you are finished to close the Export Design view and return to Export view.

Run the export you have just defined. Refer to Chapter 17 — Exporting Operations of this Learning Guide if
necessary.

Select File, and then click Exit Monarch. Select No when prompted to save changes to the model and the
project.

VIEWING DIGITAL SIGNATURES

Digital signatures display when you open the spreadsheet containing the certificate. Let’'s do this.

STEPS:

1. Launch your spreadsheet. If you don’'t have a spreadsheet, just follow along.

2. Select File, and then click Open.

3. Navigate to your Monarch Exports folder (typically in C:\Users\Public\Documents\Altair Monarch\Export), and

then open the Digitall.xIsx worksheet.
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The worksheet displays in your screen.

File Home Insert Page Layout Formulas Data Review View Automate Help Acrobat | & Comments |
@ MARKED AS FINAL An author has marked this workbook as final to discourage editing. | Edit Anyway ‘ X
Al ~ ﬁc ~  ReportDate ~
A B c D E F G H I J K a
1 Report Date |Drder Number ‘Shp Date ‘ Account Number Contact Customer |Pnstal Code  Country ‘Meda‘ Quanmy‘DescrpDon
2 5/1/2010 "536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA o] 4 Bartok, Sonata for Solo Violin
3 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 usA [e5] 7 Mozart, Mass in C, K.427
4 5/1/2010 %36017 4/10/2010 11887 Betty Yoder Betty's Music Store %0613 USA ] 2 Luening, Electronic Music
5 |5/1/2010 36017 4/10/2010 11887 Betty Yoder Betty's Music Store %0613 USA DVD 9 Scarlatti, Stabat Mater
5 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store %0613 UsSA D 11 Beethoven, Pathetique Sonata, Arau
7 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store %0613 usa D 8 Mendelssohn, War March of the Priests
g 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store %0613 usa D 10 Pizzetti, Messa di Requiem
9 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA LP 6 Misc., Modern Trombone Masterpieces
10 |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA DvD 6 Gershwin, An American in Paris
11 |5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA (o5} 6 Stravinsky, Dumbarton Oaks Concerto
12 |5/1/2010 %36016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA ] 1 Schubert, Sonata in e, D.566
13 |5/1/2010 %36016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA D 3 Mozart, Symphony No.23 in D
14 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA D 6 Schoenberg, Ode to Napoleon
15 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA ()] 2 Shostakovich, 24 Preludes for piano
16 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA SACD 9 Balakirev, Symphony no. 1
17 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA DVD 5 Holst, St. Paul's Suite for Orch.
18 5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records "0059 USA D 3 Faure, 28 Songs, Stulzmann
19 |5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records "40059 USA en] 3 Takemitsu, Music of Takemitsu
20 5/1/2010 %36020 4/10/2010 10929 Roberto Gi Bluegrass Records 0059 USA ] 6 Messiaen, Quatour pour la fin de temps
21 5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records "40059 USA SACD 8 Strauss, Ein Heldenleben, Op.40
22 |5/1/2010 536020 4/10/2010 10929 Roberto Gi Bluegrass Records "40059 UsA DVD 9 Schumann, Manfred Overture, Bav 5O
23 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde "45400 France ()] 10 Mihaud, 3 Rag Caprices, pn. & orch.
24 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde "45400 France D S Strauss, Le bourgeois gentihomme
25 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde "45400 France (9)) 5 Scriabin, Preludes, Op. 8
26 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde "45400 France D 6 Rogers, Slaughter on Tenth Avenue
27 5/1/2010 "536012 4/1/2010 18635 Alain Lebon Musique du Monde "45400 France BLU 10 Paganini, 24 Caprices for violin. v
< > DigiCert + I | >
Ready [B @ 1% Accessibility: Good to go H -+ 100%

Figure 20-4. The exported table with a digital signature.

Note the following features of the file that are not present in ordinary worksheets or workbooks: An alert with an
Edit Anyway button displays on the upper portion of the table to warn you that the workbook has been marked
final to discourage editing.

Should you choose to click Edit Anyway to continue editing the workbook, the following dialog displays:

X

Microsoft E

| Editing will remove the signatures in this workbook. Do you want to continue?

Yes Mo

Figure 20-5. Selecting Yes removes any digital signatures applied to the workbook.

Selecting Yes on the dialog removes any digital signature applied to the workbook.

As well, on the lower left-hand corner of the workbook, you will find a certificate icon. Hovering on this icon with
your mouse Yields a callout that informs you that a digital signature has been applied to the workbook.

27 |3/1f 2010 530ULL 4 1) 2ULU
< > DigiCert L

Ready [‘Q 55 ﬁ",AccessibiIit}': Good to go

[This document contains signatures.]

Figure 20-6. The digital signature callout.
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If you click on this icon, a list of all digital signatures applied to the workbook display on the right-hand side of the
workbook. You can hover on any of these signatures to display a drop-down button that, upon clicking, will allow
you to view the properties of that signature.

File Home Insert Pagelayout Formulas Data Review View Automate Help Acrobat | = Comments |
@ MARKED AS FINAL An author has marked this workbook as final to discourage editing. | Edit Anyway | x
AL ~ i fx~ ReportDate ~
A B c D E F G H I ] al
1 IReportT‘Order Number |Shp Date ‘ Account Number Contact Customer ‘Posta\ Code | Country ‘Med»a‘ Quanﬂy‘Des! Slg natures vooX
2 |5/1/2010 7536017 4/10/2010 11887 Betty Yoder Betty's Music Store %0613 USA (@) 4 Bart( Valid signatures:
3 |5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA D 7 Moz: 9 .
4 |5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store %0613 USA )] 2 Luen icanto 10/15/2024 |'
5 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 UsA DVD 9 Scarl
6 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 usa D 11 Beet Signature Details...
7 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA (@] 8 Meni
g [5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA o] 10 Pizze Remove Signature
9 |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA LP 6 Misc —
10 |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 UsA DVD 6 Gers
11 |5/1/2010 36016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA (@) 6 Stray
12 |5/1/2010 36016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA D 1 Schu
13 |5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA (e)] 3 Moz:
14 |5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 0067 USA (e 6 Scho
15 |5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 0067 usa D 2 Shos
16 |5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA SACD 9 Balal
17 |5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA DvD 5 Holst
18 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 USA [«)] 3 Faur
19 |5/1/2010 536020 4/10/2010 10929 Roberto Gl Bluegrass Records 40059 USA w 3 Take
20 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 usA [«5] 6 Mest
21 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 0039 USA SACD 8 Strat
27 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 UsA DVD 9 5chu
23 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 15400 France D 10 Mihz . .
- This document is signed.
24 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France D 5 Strat Py eilEte ds
25 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France D 5 Scria document will invalidate the
26 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France [e) 6 Roge digital signatures.
27 |5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France BLU 10Pagz | eam more about signatures in
<« > DigiCert i P — »  Officedocuments.
Ready [ B8 T2 Accessibility: Goodto go i) ———h—+ 100%

Figure 20-7. A list of digital signatures displayed on the right-hand side of the workbook.

4. Close the spreadsheet.
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[21] USING PIVOT TABLES

In the previous chapter, you learned about a special Monarch feature you can use to increase the security and
authenticity of your report: digital signatures.

In this chapter, you will learn about another special Monarch feature: pivot tables. Pivot tables are interactive tables
within Monarch that allow you to further manipulate and view data. They can only be created for XLSX files; they
cannot be created for XLS files. If you are using a version of Excel earlier than 2007, you can download the Microsoft
Office Compatibility Pack from Microsoft, which will allow Excel 2000 and higher to open XLSX files.

The option to create a Pivot Table is not available for a Summary export, since pivot Tables use tabular “raw” data as
a source, not summarized data. Monarch will export the table data as a worksheet and the pivot table as a separate
worksheet, which refers to the exported data.

Let's again start by loading the Classic.prn report and the Lesson8.dmod model files.

File Home Report Table Summary Export ?
. . o
= = 10 - ) setect A Previous Report Next Report | &
IE_l E [10 -] B &b P xt Repr = ]
Report Auto Sy rE T (] Copy Gt il Previous Page & Next Page Bookmark :K:dp:(rt prl:p:? C(’:x;:s
Design Define Bl Greenbar B 0, Go To Page T o
~
Home m Table View v
Report Files « 1 i 05/01/10 CLASSICAL MUSIC DISTRIBUTCRS BAGE 01 a
— 10:17 MONTHLY SHIPPING REPORT
A MSRG4 FROM 04/01/10 TO 04/30/10
E Classicpn

» CUSTOMER: Betty's Music Store
» Muscatine Plaza

> 200 Lower Muscatine
> Cedar Falls, IA 50613
usa

» RCCOUNT NUMBER: 11887
»

2 CONTACT: Betty Yoder

MEDIR QIY DESCRIPTICN LABEL/NC. UNT_PRC  AMOUNT
» ORDER NUMBER: 536017 SHIP DATE: 04/10/10

»CD 4 Bartok, Sonata for Solo Violin ME-42625 8.99 35.98
» 7 Mozart, Mass in C, K.427 420831-2 5.00 63.00
= 2 Luening, Electronic Music CD 611 10.19 20.38
> DVD 9 Scarlatti, Stabat Mater SBT 48282 5.99 53.91
> ORDER NUMBER: 536033 SHIP DATE: 04/21/10

=CD 11 Beethoven, Pathetigue Sonata, Arau 420153-2 5.99 65.89
» & Mendelssohn, War March of the Priests SMK 47592 g.22 71.92
» 10 Pizzetti, Messa di Requiem CHAN 8964 g.52 95.20
*LP 6 Misc., Modern Trombone Masterpieces ADA SE1087 10.79 64.74
» DVD € Gershwin, An American in Paris ACS 8034 5.99 35.94 =

1 »

Pagel 100w ——&———+

Figure 21-1. Loading the Classic.prn report and Lesson8.dmod model.

ADDING PIVOT TABLES TO AN EXCEL FILE

STEPS:

1. Select the Table tab.
The Table view for the report displays. Select Autosize Columns L5 from the Table tab to view all the data
properly.
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File Home Report Table Summary Export ?
Bosehl | e o6 v B g B A
e Q Zoom To Fit [] Copy Aetive Sort Search  Goto  Findin Rebuild S’C“g;";‘f ;:;Z;E-
E=gm ¥4 Autosize Columns. Row Report Data View
~
Home Report View m v
Report Date  Order Number  Ship Date Account Number Contact Customer Postal Code  Country Media Quantity =~
o 1 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 usa o] 4
2 5/1f2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 usA o) 7
Main 3 5/1/2010 536017 4{10/2010 11887 Betty Yoder Betty's Music Store 50613 USA co 2
4 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA DvD 9
5  5/1f2010 536039 4/21/2010 11887 Befty Yoder Betty's Music Store 50613 UsA (o] 11
6 5/1/2010 536039 4/21/2010 11887 Befty Yoder Betty's Music Store 50613 UsA (o] g
7 5/1f2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA co 10
8 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA Lp 6
9 s5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 Usa DvD 6
10 5/1/2010 536016 4/5/2010 17958 Marvin Mabry Big Shanty Music 30067 UsA (5} 6
11 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 Usa o 1
12 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA o) 3
13 5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA o 6
14 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 UsA o 2
15  5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 usA SACD 9
16 5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 usA DVD 5
17 s5/1/2010 536020 4{10/2010 10929 Roberto Gil Bluegrass Records 40059 USA co 3
18  s5/1/2010 536020 4{10/2010 10929 Raoberto Gil Bluegrass Records 40059 USA co 3
19 5/1f2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 UsA (o] 6
20 s/1f2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 UsA SACD g
21 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 40059 USA DVD 9
22 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France co 10
23 s/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France o 5
24 s/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France o 5
25  5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France cb 6
26 5/1/2010 536012 4/1/2010 18635 Alain Lebon Musique du Monde 45400 France BLU 10
27 s/1/2010 536012 4{1/2010 18635 Alain Lebon Musique du Monde 45400 France DvD 8
28 s5/1/2010 RAB021 4{10/2010 18635 Alain Lebon Musique du Monde 45400 France co -10
29  5/1/2010 RA6021 4/10/2010 18635 Alzin Lebon Musique du Monde 45400 France cD 7
30 5/1/2010 RA6021 4/10/2010 18635 Alzin Lebon Musique du Monde 45400 France DvD -1
31 s/1/2010 536034 4{18/2010 18635 Alain Lebon Musique du Monde 45400 France co 3
32 5/1/2010 536034 4/18/2010 18635 Alzin Lebon Musique du Monde 45400 France D 9| -
P e ST e wr— e T - = ;
Report Date - Date/Time - Page Header (Page Header) Filter: No Filter Sort Mo Sort 149 Rows 1006 — ——fF— +

Figure 21-2. The Table view for Classic.prn report and Lesson8.dmod model.

2. Select the Export tab and then click the Create Export button.
The Create Export dialog displays.

In the File name box, enter Pivotl.

4. Ensure that Table is selected in the Source View box and then select Microsoft Excel XLSX (*.xIsx) from the

Export File Type box.
5. Name the table PivoTable in the Table Name box.
6. Click the Edit Advanced Options button to launch the Export Design view.
7. Click the Advanced tab of the Excel Output panel.

The Excel Advanced Features options of the view display.

8. Check the Include Pivot Table sheet box to activate the pivot table definition options.
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10.

11.

12.

13.

14.
15.

Design

v 8 P B 2 ?

Accept  Cancel Add Duplicate  Delete Help
Export Export Expart
~
Exports v 1| Table View PO Eccel Output n
W o) General [ERRIE] v
B Export] Export Name
Document Options
Export1
. Security: Digital Signature Certificate... v
Filtering
Filter: Add AutoFilter drop down lists to column labels in the Table
Select Filter:
Liolkiey v Pivot: ¥ Include Pivot Table sheet

The filter will be applied to the table during export. When sheet with pivot table exists: | Skip table b

Sorting Fields | Options
Sort Order: Report Filter New.. v| Column Labels New.. v
No Sort v

The sort order will be applied to the table during export.

Row Labels New.. v| Values New.. ~

10 ——FH——+

Figure 21-3. The Excel Advanced features panel in Export Design view.

Select Overwrite table from the When sheet with pivot table exists drop-down.

Click on the Options tab that displays and then enter PivotTable into the Pivot Table name field. You may leave
the other settings in this tab as they are for now. Note that pivot table names must conform to the table-naming
guidelines described earlier in this guide.

Click the Fields tab, click on the New drop-down list of the Row Labels field and then select (double-click)
Customer.

In the Column Labels field, select the New drop-down button, and then select (double-click) Media from the list
that displays.

In the Values field, select the New drop-down button, and then select the values Amount and Unit Price from
the list that displays.

Note that when you do so, an additional entry (e.g., VALUES_HEADER ) is added to the Values field. This
additional entry simply indicates that the separate fields of Amount and Unit Price will have their own headings in
the resulting worksheet.

Use the sorting button that displays beside each pivot field or value to specify a display order (i.e., ascending or
descending).
Select Accept v when you are finished to close Export Design view and return to Export view.

Run the export you have just defined. Refer to Chapter 17 — Exporting Operations of this Learning Guide if
necessary.
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VIEWING A PIVOT TABLE

STEPS:
, .
1. Launch your spreadsheet. If you don't have a spreadsheet, simply follow along.
2. Select File, and then click Open.
3. Navigate to your Monarch Exports folder (typically in C:\Users\Public\Documents\Altair Monarch\Export) and
then open the Pivotl.xIsx worksheet.
The worksheet displays in your screen.
File Home Insert Pagelayout Formulas Data Review View Automate Help Acrobat | = Comments |
Tahoma ~||9 A4 o) Conditional Formatting v =
ﬁ”] & oms_ | - ,‘ L E A= /O E_j B B
Paste E@ h = A Alignment = Number @ Format as Table ~ Cells | Editing Add-ins  Analyze Create PDF  Create PDF and
v v he A M M [ Cell Styles v M M Data and Share link Share via Outlook
Clipboard % Font [ Styles Sensitivity | Add-ins Adobe Acrobat ~
Al v ﬁc ~ ReportDate ~
A B € D E F G H 1 J K a
1 Report Date |0rder Number |Shp Date ‘ Account Number Contact Customer |Pnsta\ Code | Country ‘Medal Quantty‘[)escrpmn
2 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA o 4 Bartok, Sonata for Solo Violin
3 |5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA o) 7 Mozart, Mass in C, K.427
4 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 USA o) 2 Luening, Electronic Music
5 5/1/2010 536017 4/10/2010 11887 Betty Yoder Betty's Music Store 50613 UsA DVD 9 Scarlatti, Stabat Mater
6 |5/1/2010 36039 4/21/2010 11887 Betty Yoder Betty's Music Store %0613 USA [e5] 11 Beethoven, Pathetique Sonata, Arau
7 5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA [e0) 8 Mendelssohn, War March of the Priests
g |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA [e) 10 Pizzettj, Messa di Requiem
g |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 0613 USA LP 6 Misc., Modern Trombone Masterpieces
10 |5/1/2010 536039 4/21/2010 11887 Betty Yoder Betty's Music Store 50613 USA DVD 6 Gershwin, An American in Paris
11 [5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 0067 USA @ 6 Stravinsky, Dumbarton Oaks Concerto
12 |5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA o) 1 Schubert, Sonata in e, D.566
13 |5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA o) 3 Mozart, Symphony No.23 in D
14 |5/1/2010 536016 4/5/2010 17959 Marvin Mabry Big Shanty Music 30067 USA (€] 6 Schoenberg, Ode to Napoleon
15 |5/1/2010 36029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA [e5] 2 Shostakovich, 24 Preludes for piano
16 [5/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music %0067 UsA SACD 9 Balakirev, Symphony no. 1
17 |3/1/2010 536029 4/14/2010 17959 Marvin Mabry Big Shanty Music 30067 USA DvD 5 Holst, St. Paul's Suite for Orch.
18 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records "0059 USA D 3 Faure, 28 Songs, Stuzmann
19 5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records "30059 USA D 3 Takemitsu, Music of Takemitsu
20 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records "40059 USA D 6 Messiaen, Quatour pour la fin de temps
21 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 0059 USA SACD 8 Strauss, Ein Heldenleben, Op.40
22 |5/1/2010 536020 4/10/2010 10929 Roberto Gil Bluegrass Records 740039 USA DvD 9 Schumann, Manfred Overture, Bav SO vl
< 0 PivoTable  pivotTable + R »
Ready [ 3o Accessibility: Investigate ::1] 0 -— -+ 100%
Figure 21-4. The exported Pivotl worksheet.
The PivoTable tab shows an Excel file version of the Classic.prn table.
4. Click on the PivotTablel tab.
The pivot table displays on your spreadsheet.
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File Home Insert Pagelayout Formulas Data Review View Automate Help Acrobat |DComments\

Ifl'j S; ) |calibri ~[1 ~| z % &l conditional Formatting ~ @ /O E}’ @

Paste B I U~ A A pignment Number [ FormatasTable v Cells  Editing Add-ins | Analyze  Create PDF  Create PDF and
v He &0 A ~ i [iZ Cell Styles ~ > e Data and Share link Share via Outlook
Clipboard & Font & Styles Sensitivity  Add-ins Adobe Acrobat ~
AL v i fi~ ~
A B C D E F G H | J A
1
2
3 Column Labels | ~
4 cD bvD LP SACD BLU
5 |Row Labels ~ |Sum of Amount  Sum of Unit Price Sum of Amount Sum of Unit Price Sum of Amount Sum of Unit Price Sum of Amount Sum of Unit Price Sum of Amour
6 |Betty's Music Store 353.05 52.75 89.85 11.98 64.74 10.79
7 | Big Shanty Music 158.23 41.96 29.95 5.99 86.31 9.59
8 | Bluegrass Records 122.34 31.18 53.91 5.99 71.92 8.99
9 |Musique du Monde 283.01 89.33 -17.97 11.98 95
10 |Fandangos Records 213.9 28.16 11.98 5.99
11 | Die Melodie 362.56 46.74 23.96 5.99 86.31 9.59
12 |Hope's Sweet Notes 481.06 62.98 59.9 11.98 43.11 4.79 77
13 |Canciones 379.14 66.49
14 | Classic Exchange 209.08 33.55
15 | Chez Rudy 275.51 ©5.85 44.95 8.99
16 | Das Piano 225.93 29.37 41.93 5.99 111.46 25.17 161.82 17.98
17 |Mo Town Tunes 211.03 44.36 23.96 5.99
18 | The Record Store 250.59 48.57 60 6 17.¢
19 | Reiner's Symphonic Sounds 361.29 50.93 68.28 17.37 32.95 6.59
20 |Spinning Records 317.66 49.73 89.85 11.98 11.98 5.99
21 |Musique Royale 515.17 96.46 80.26 22.15
22 | The Glass Harmonica 211.56 32.96 67.2 9.6 ot
23 | Die Harmonie 100.04 34.15 ©04.46 12.74 v
<2 PivoTable ~ PivotTable + HE | >
Ready [@ 9% Accessibility: Investigate B F —-— 83—+ 100%

Figure 21-5. The exported Pivotl worksheet.

For more information regarding pivot tables, you may access the Monarch Help file by selecting File, clicking on

the drop-down button of the Help o menu, and then select Help Topics from the options that display.

WORKING WITH PIVOT TABLES

When we selected pivot table fields in the earlier part of this chapter, we were specifying settings similar to those
used when creating a summary. For example, the Row Labels specify down keys, the Column Labels specify across
keys, and the Values specify measures.

Clicking on the drop-down buttons on either the Row Labels or Column Labels fields displays a set of options that
allow you to sort and filter your data.
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paste 2 = A" pignment | Number A Format as Table ¥ Cells  Editing Add-ins  Analyze | Create PDF  Create PDF and
v A - v e [iZ cell Styles ~ e v Data and Share link Share via Outlook

Clipboard Font & Styles Sensitivity | Add-ins Adobe Acrobat ~

Al ~ S v
A B € D E F G H J o

Ty ]
2
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4 4] sortAtoz DVD LP SACD BLU
5 R, Spm of Unit Price Sum of Amount Sum of Unit Price Sum of Amount Sum of Unit Price Sum of Amount Sum of Unit Price Sum of Amour
s |sl Al sotzon 52.75 89.85 11.98 64.74 10.79
7 B More Sort Options... 41.96 29.95 5.99 86.31 9.59
8 8l 31.18 53191 5.99 71.92 8.99
*P M v 89.33 -17.97 11.98 95
100 Label Filters > 2516) LD 239
11 [Of 46.74 23.96 5.99 86.31 9.59
12 | Value Filters > 62.98 59.9 11.98 43.11 4.79 77
13 |G 66.49

- Search
14 (c} 33.55
15 [ i (Select Al 65.85 44,95 8.99
16 [D| D 29.37 41.93 5.99 111.46 25.17 161.82 17.98
17 M pve 44.36 23.96 5.99
18 |t L 48.57 60 6 172
19 E SACD 50.93 68.28 17.37 32.95 6.59

Fl BLU . - : : :
20 sy 49.73 89.85 11.98 11.98 5.99
21 M 96.46 80.26 22.15
22 i 32.96 67.2 9.6 2.3
23 [D| 34.15 64.46 12.74
24 i 39.53 25813 3.59 105.49 9.59
25 IN| 19.77 10.78 5.39 62.16 .77 85.(
26 G| 964.82 612.01 122.96 475.57 98.23 579.05 65.34 286.¢
27 v

\ Cancel | + 4 L

Reaky b :::] - —a—+ 100%

Figure 21-6. Options for sorting and filtering pivot table data.

To display the unit prices and amounts for only the media types DVD and BLU, for example, simply click on the drop-
down button of Column Labels, deselect the boxes for CD, LP, and SACD, and then click OK. When you do this, the
Select All checkbox is automatically deselected.

A new table is rebuilt and displayed in your spreadsheet.

File Home Insert Pagelayout Formulas Data Review View Automate Help Acrobat ‘F‘ CommemsJ
I’_"—\'llj X kCaIlbn HHA 'J = % [ conditional Formatting ﬁ /C) ®E E} al
e B BT U~ A AT ioiment | Number | FFA Format as Table ¥ Cells  Editing Add-ins | Analyze  CreatePDF  Create PDF and
- s - O A e e [ Cell Styles ~ d v Data and Share link Share via Outlook
Clipboard Font & Styles Sensitivity  Add-ins Adobe Acrobat ~
Al ~ S v
A B € D E F G H a

1
2
3 Column Labels
4 DVD BLU Total Sum of Amount Total Sum of Unit Price
5 Row Labels B Sum of Amount  Sum of Unit Price Sum of Amount Sum of Unit Price
6 Betty's Music Store 89.85 11.98 89.85 11.98
7 Big Shanty Music 29.95 5.99 29.95 5.99
& Bluegrass Records 53.91 5.99 53.91 5.99
9 Musique du Monde -17.97 11.98 95.9 9.59 77.93 21.57
10 Fandangos Records 11.98 5.99 11.98 5.99
11 Hope's Sweet Notes 59.9 11.98 77.9 7.79 137.8 19.77
12 Das Piano 41.93 5.99 41.93 5.99
13 |Mo Town Tunes 23.96 5.99 23.96 5.99
14 The Record Store 60 6 17.97 5.99 77.97 11.99
15 |Reiner's Symphonic Sounds 68.28 17.37 68.28 17.37
16 |Spinning Records 89.85 11.98 89.85 11.98
17 The Glass Harmonica 9.59 9.59 9.59 9.59
18 |Die Harmonie 64.46 12.74 64.46 12.74
19 |The King's Place 25.13 3.59 25.13 3.59
20 |Notas 10.78 5.39 85.08 13.18 95.86 18.57
21 Grand Total 612.01 122.96 286.44 46.14 898.45 169.1
22
22 v

< PivoTable | PivotTable aF L} »
Ready [® 3% Accessibility: Investigate i3] Ml ——8——+ 100%

Figure 21-7. The new pivot table showing
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[22] WORKING WITH ASIAN (CJK)
CHARACTER SETS

Displaying fullwidth characters (e.g., Chinese/Japanese/Korean, or CJK, characters) is more complex than displaying
standard fixed-width single byte character set (SBCS) characters. This stems from the fact that fullwidth characters
usually take up nearly twice as much horizontal space in pixels to display. Due to the grid-like nature of Monarch’s
unigue trapping process, Monarch requires that all characters are rendered with the same amount of screen space in
order for characters to align vertically. This requirement causes issues when SBCS and fullwidth characters are
present on the same report.

Notice the indeterminate alignment of these lines:

Test 123459
HARERIZ VT ETF
Now observe the grid-like alignment of these lines:

Testd1l 2345
AR & TF

As you can see in the first example, the characters do not line up in any meaningful way. Thus, it is impossible to
create a template that traps consistently in this situation. By contrast, in the second example, each character takes up
the same amount of space, thereby giving us a grid-like 1-to-1 alignment and making it possible to trap data with
predictable results. This is the fundamental challenge that Fullwidth Character Mode addresses.

Working with Asian Character sets may be easily accomplished by specifying four settings:
0O Fullwidth Character Mode

0 Fallback Asian fonts

0 Date/Time format
a

Ignore Character Width

SETTING FULLWIDTH CHARACTER MODE

The Fullwidth Character Mode setting toggles Fullwidth Character Mode on and off. While on, all characters will be
rendered in the same horizontal space as a Kaniji glyph.

Most fonts do not contain glyphs for every character from every language. This issue is addressed by a fallback
architecture that renders unknown characters in standard fonts known to contain those characters. The result is text
that is drawn in multiple fonts as needed on a per-character basis.

To enable this setting, select Start > Options > Input > Language Options and then select the On button for

Fullwidth Character Mode. Click Accept v to save your settings when you are finished.
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Options

v X ®m 0 &@E oo O & W O BmOoY & ¥ 2

Accept  Cancel Folders Input View Export  Clipboard  Security  Altair Monarch Time Advanced  Cache  Themes Help
Server Library Intervals
~
Input
Fields Text Files Excel Files Trapping JELLIELIXOIITLY AutoDefine v

Fallback Asian Fonts

Default Japanese Font:

MS Gaothic b
Default Simplified Chinese Font:
NSimSun b

Default Traditional Chinese Font:

v

Fullwidth Character Mode

® On Off

Make these the default settings Restore from default settings

wow ———+

Figure 22-1. Setting Fullwidth Character Mode on via the Options window.

NOTE All other settings for dealing with Japanese input files are applicable only when this setting
is enabled.

SETTING FALLBACK ASIAN FONTS

In the same window, the Fallback Asian Fonts setting allows the user to select which fonts will be used to render
unknown characters in the event of a fallback. Japanese, Simplified Chinese, and Traditional Chinese options are
available.

SETTING THE DATE/TIME FORMAT

The most commonly used date format in Japan is yyyy/mm/dd, and the Japanese characters for “year,” “month,” and
“day” are inserted usually between numerals. Thus, in the Japanese format, the date December 21, 2013 is
presented as:

2013122218

Users trapping the fields of Japanese input files can compel Monarch to convert dates/times into one of two
Japanese formats by selecting the appropriate format from the Field Properties panel that displays when a field is
defined.
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Field Properties

I

MName: Japanese Date

-

Template Width: |8 -

Type: Date/Time v

Decimals: 0

Format: [Japanese Date V]
. ) General

Display Width: Short Date

Alignment: Long Date

Short Date & Time
Copy Value Fr Long Date & Time

Hidden M€
Japanese Date
< Previod .Iapanelse Era Date

W

Figure 22-2. Specifying the Japanese date format via the Field Properties panel.

Dates and times may be converted to:
0 Japanese date — This setting converts dates/times into the standard Japanese format.

0O Japanese eradate — This setting converts dates/times into the standard Japanese format but also inserts the
current era prior to the actual date.

SETTING THE IGNORE CHARACTER WIDTH
OPTION

Asian reports sometimes use “fullwidth” or “wide” Latin characters. Monarch allows users to ignore the distinction
between standard (or “narrow”) and wide Latin characters while searching a report, table, or summary. This option in
enabled via the Ignore Character Width setting.

When users opt to ignore character widths, the string “WUMEER” would return search hits for both “HUMEEER” and “
HOMEBER”,

Likewise, the string “I T M B E E” would return search hits forboth “¥ T M E E R” and “HUMEER”,
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Note that in the above example, “¥ U M B E R”is using the wide characters for N, U, M, B, E, and R. This
distinction is made to clarify that the text is not simply a string with spaces between characters.

To set this option, assuming you have an open report in Report View, select the Search d.b button in the Report
ribbon and then tick the checkbox for Ignore Character Width that appears on the Search panel that displays.

Home Report View X hd
? —_—

= number | Find Next Search Up Wrap Match Case +| Ignore Character Width X
H

»05/01/10 CLASSICAL MUSIC DISTRIBUTORS a
& 10:17 MONTHLY SHIPPING REPORT

Figure 22-3. Setting the Ignore Character Width option.
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CONCLUSION

Congratulations! You have just completed all the lessons in the Monarch Learning Guide. We hope you have found

them to be a helpful introduction to Monarch’s capabilities.

For additional information not covered in the Learning Guide, we suggest you thoroughly explore Monarch’s help
?

system. To do so, select File, click on the drop-down button of the Help = menu, and then select Help Topics from

the main menu. You may also click the Help ? button on any dialog within Monarch to access context-sensitive
help.

Updated documentation is available here.

Technical assistance is available to registered Monarch owners. Refer to the Appendix C - Contacting Technical
Support section of the Monarch Help file for more information.
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CONTACT US

GET IN TOUCH

We'd love to hear from you. Here’s how you can reach us.

SALES CONTACT INFORMATION
USA: +1 800 445 3311
International: + 1 978 441 2200

Email: sales@altair.com

SUPPORT CONTACT INFORMATION

Customer Portal: https://altair.com/customer-support
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